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Customer Service Management
Last updated: July 26, 2018
Last updated: July 26, 2018

Use the Customer Service Management (CSM) applications to provide your customers with
multiple methods of engagement and collaboration, omni-channel communication, product
knowledge and notifications, quick response to questions and issues, and efficient case
resolution.

These applications provide the core of the customer service solution:

Customer Service Management

The Customer Service Management application enables you to provide service and support
for your external customers through communication channels such as web, email, chat,
telephone, and social media. Use the personalized self-service web portal to provide
information and assistance. Create cases as needed and automatically route cases to
available customer service agents with the required skills, availability, and location. Connect
customer service agents to other departments to assist with case resolution.

Communities

The Communities application enables you to connect, engage and collaborate with your
employees, customers, partners and prospects. Users can get quick responses to their
issues by posting questions, reviewing blogs or videos, and searching for previous
discussions. Users can also subscribe to forums and topics and provide feedback on
content they find useful.

These applications integrate with Customer Service Management and Communities to
provide additional customer information and support:

• The Field Service Management application helps organizations manage work tasks of any
kind that need to be performed on location. Use Field Service Management to match tasks
to agents based on agent skills, geographic territory assignments, and available inventory.
Agents complete assigned tasks and then record the details, including travel and work
time.

• The Knowledge Management application enables the sharing of information in knowledge
bases. These knowledge bases contain articles that provide users with information such as
self-help, troubleshooting, and task resolution. Knowledge Management supports
processes for creating, categorizing, reviewing, and approving articles. Users can search
and browse articles as well as provide feedback.

• The Planned Maintenance application works with Service Management applications to help
organizations manage regular, preventive maintenance of their assets. Customers can use
maintenance plans to automatically create work orders or facilities requests.

• The Notify application allows you to integrate with the Twilio telephony service to manage
phone calls and SMS messages from within your instance.

• OpenFrame provides a communication frame that customers can use to integrate
telephony systems into the Now Platform. The OpenFrame API can be used to
communicate between the Now Platform and the domain opened in the OpenFrame
window.
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Using guided setup to implement the CSM applications

Guided setup for Customer Service Management, Field Service Management, and
Communities provides a sequence of tasks that help you configure these applications on
your ServiceNow instance. To open guided setup, navigate to:

• Customer Service > Administration > Guided Setup
• Field Service > Administration > Guided Setup
• Community > Administration > Guided Setup

For more information about using the guided setup interface, see Using guided setup.

August 6, 2018 ©2018 ServiceNow. All rights reserved. 4

ServiceNow | Customer Service Management

https://docs.servicenow.com/bundle/london-platform-administration/page/administer/core-configuration/concept/guided-setup.html


Customer Service Management
Last updated: July 26, 2018
Last updated: July 26, 2018

The ServiceNow® Customer Service Management application enables you to provide service
and support for your external customers through communication channels such as web,
email, chat, telephone, and social media. Create cases as needed and route cases to
available customer service agents with the necessary skill sets.

Explore

• Customer Service case
management

• Integration with other
applications

• Customer Service optional
features

• Domain separation

Set up

• Activate Customer Service
Management

• Activate additional plugins for
Customer Service
Management

• Set up customer information
• Set up communication

channels

Administer

• Create rules to route and
assign cases

• Limit knowledge base access
to internal users

• Track and analyze Customer
Service case data

Use

• Create and resolve cases
• Special handling notes
• Agent calendar
• Assignment workbench
• Major issue management
• Case and account escalation

Develop

• Components installed with
Customer Service
Management

• Components installed with
additional plugins for
Customer Service
Management

• openFrameAPI

Troubleshoot and get help

• Ask or answer questions in the
Customer Service
Management community

• Search the HI knowledge base
for known error articles

• Contact ServiceNow Support

Customer Service case management
Last updated: July 26, 2018
Last updated: July 26, 2018

External customers can reach out to your organization for assistance. Customer service
agents receive these communications and work with customers to answer questions and
resolve issues, creating cases as needed.

Customer Service cases

The case is the primary entity of the Customer Service Management application. An agent
creates a new case to identify a customer's question or issue and to track the activities
related to resolving the issue. An agent also uses a case to track communication to and
from the customer, including the communication channels being used.

Case activities

Case activities include any action that is taken to resolve an issue. This can include phone
calls or emails, knowledge base research, conversations with subject matter experts, and
dispatch requests to field service agents, as well as other activities.
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Case form

From the Case form, an agent can associate and store the related information, such as the
customer's name, phone number, and company; account information; product and asset
information; service contract and entitlement details, and any associated service level
agreements (SLAs).

There are several key features to a case.

• Communication between an agent and the customer or an agent and other employees
within the organization. Details of all internal and external communication are recorded on
the Case form.

• Any additional tasks that result from a case, such as a work order. Tasks are tracked from a
related list on the Case form. These tasks may be internal to the organization or they may
involve the customer.

• Information from the case that can be included in the knowledge base and used to help
resolve other cases.

Case routing

The Customer Service Management application enables you to route cases to available
customer service agents with the necessary skill sets. Agents can make use of response
templates and search tools to search the knowledge base and community and provide
timely, informative responses to customers.

Customer Service homepage

The Service Manager homepage provides reports and analytics on customer service case
data. Using a combination of platform reporting capabilities and the Performance Analytics
tool, these reports enable you to drill down and sort or view data in a variety of ways.

Using guided setup to implement Customer Service
Management

Customer Service Management guided setup provides a sequence of tasks that help you to
configure Customer Service Management on your ServiceNow instance. To open Customer
Service Management guided setup, navigate to Customer Service > Administration > Guided
Setup. For more information about using the guided setup interface, see Using guided
setup.

Activate Customer Service Management
Last updated: July 26, 2018
Last updated: July 26, 2018

You can activate the Customer Service Management plugin (com.sn_customerservice) if you
have the admin role. This plugin includes demo data and activates related plugins if they are
not already active.

Before you begin

Role required: admin

About this task
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The Customer Service Management plugin activates these related plugins if they are not
already active.

Plugins for Customer Service Management
Plugin Description
Assessment
[com.snc.assessment_core]

Provides assessments, surveys, and ratings.

Asset Management
[com.snc.asset_management]

Manage assets, consumables, and software
licenses.

Assignment Workbench
[com.snc.assignment_workbench]

Enables users to assign tasks to individual agents
based on configurable criteria, such as availability
and matching skills.

Connect Support
[com.glide.connect.support]

Enables chat in a support queue.

Anonymous Connect Support
[com.glide.connect.anonymous_support]

Enables consumers to chat with consumer
service agents from the Consumer Service Portal
without logging in.

Connect Support Routing
[com.glide.connect.support.routing]

Enables the routing of Connect Support requests
to the appropriate chat queue.

Customer Service Social Integration
[com.sn_cs_social]

Adds the necessary data schema changes for
social integration scenarios.

Openframe
[com.sn_openframe]

An interface used to integrate external
communication systems with the Now Platform.
This plugin provides a UI frame that is accessible
and available anywhere within ServiceNow
application screens.
The Customer Service Management application
uses a combination of Computer Telephony
Integration (CTI) and OpenFrame to provide
phone support for customers.

Process Flow Formatter
[com.snc.process_flow_formatter]

Displays a diagram of the process flow for a form.

Resource Matching Engine
[com.snc.matching_rule]

Provides a tool for rule-based task-to-resource
matching.

Skills Management
[com.snc.skills_management]

Implements user and user group skills; based on
the same principle as roles management with the
mechanism of inheritance between user groups
and users.

Special Handling Notes
[com.sn_shn]

Activates the Special Handling Notes application,
which enables users to quickly view brief
messages about records. These notes can be
displayed in an embedded list or related list on a
record form or in a pop-up window.

This plugin is installed with the Customer Service
Management and Field Service Management
applications. To use special handling notes with
other tables:
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Plugin Description
• Configure the table and any related fields to use

special handling notes.
• Configure the form to show special handling

notes.

State Flows
[com.snc.state_flows]

Customize transitions from one state to another
in tables derived from the Task [task] table and
configure the system to perform work during
transitions to specific states.

Task Activities
[com.snc.task_activity]

Enables support for activities on task tables.

Procedure

1. Navigate to System Definition > Plugins.
2. Find and click the plugin name.
3. On the System Plugin form, review the plugin details and then click the Activate/

Upgrade related link.

If the plugin depends on other plugins, these plugins are listed along with their
activation status.

If the plugin has optional features that depend on other plugins, those plugins are listed
under Some files will not be loaded because these plugins are inactive. The optional
features are not installed until the listed plugins are installed (before or after the
installation of the current plugin).

4. (Optional) If available, select the Load demo data check box.

Some plugins include demo data—Sample records that are designed to illustrate plugin
features for common use cases. Loading demo data is a good practice when you first
activate the plugin on a development or test instance.

You can also load demo data after the plugin is activated by clicking the Load Demo
Data Only related link on the System Plugin form.

5. Click Activate.

What to do next

You can activate a number of related plugins after activating the Customer Service
Management plugin (com.sn_customerservice). For details, see Additional plugins for
Customer Service Management.

• Additional plugins for Customer Service Management

After Customer Service Management is activated, you can activate additional plugins that
provide demo data and enable a variety of features.

• Customer Service Management for Orders

This feature adds support for orders and order line items to the Customer Service
Management application.

August 6, 2018 ©2018 ServiceNow. All rights reserved. 8

ServiceNow | Customer Service Management



Additional plugins for Customer Service Management

Last updated: July 26, 2018
Last updated: July 26, 2018

After Customer Service Management is activated, you can activate additional plugins that
provide demo data and enable a variety of features.

You must have the admin role to activate these additional plugins. For details, see Activate a
plugin.

Plugin Description
Customer Service Management Demo Data
[com.snc.customerservice.demo]

This plugin provides demo data for the Customer
Service Management application.

Customer Service Management for Orders
(com.snc.csm.order)

This plugin extends Customer Service
Management to support order-related issues by
integrating with order management systems to
create and resolve customer requests.

Consumer Service Portal
[com.glide.service-portal.consumer-portal]

This plugin enables the Consumer Service Portal.

The Consumer Service Portal plugin activates
these related plugins if they are not already
active.

• Anonymous Connect Support
(com.glide.connect.anonymous_support)

Customer Service Portal
[com.glide.service-portal.customer-portal]

This plugin enables the Customer Service Portal,
a version of the web portal based on the Service
Portal application.

The Customer Service Portal plugin activates
these related plugins if they are not already
active.

• Service Portal Social QA (com.glide.service-
portal.sqanda)

CTI Softphone
(com.snc.cti)

This plugin enables Twilio integration using the
Notify application and OpenFrame to provide
softphone functions and call center capabilities,
including making, receiving, and transferring
phone calls.

The CTI Softphone plugin activates these related
plugins if they are not already active.

• Resource Matching Engine
(com.snc.matching_rule): Provides a tool for
rule-based task-to-resource matching.

• Notify (com.snc.notify): Provides platform
features for workflow-driven voice calls,
conference calls, and SMS messages.

• Notify - Twilio Driver (com.snc.notify.twilio):
Provides Notify support for the Twilio product;
requires a separate contract with Twilio for
SMS/Voice capabilities.
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Plugin Description
• Openframe (com.sn_openframe): Provides an

interface that can be used to integrate external
communication systems with the Now Platform.

Customer Service CTI Demo Data
(com.snc.customerservice_cti_demo)

This plugin provides demo data for the CTI
Softphone application.

Customer Service with Field Service Management
(com.snc.csm_fsm_integration)

This plugin provides an integration between the
Customer Service Management and Field Service
Management applications. Customers and
consumers can view case-related work orders
from the Customer Service and Consumer Service
Portals. In the Field Service Management
application, users can view account and contact
information on work orders and work order tasks.

Connect Support
(com.glide.connect.support)

This plugin provides the chat feature in a
customer support queue.

Anonymous Connect Support
(com.glide.connect_anonymous_support)

Plugin to enable access and properties for
Anonymous Connect Support.

Connect Support Routing
com.glide.connect.support.routing)

Plugin to enable processor for routing Connect
Support requests to the appropriate chat queue.

Case Assignment Workbench Demo
(com.snc.case_assignment_workbench_demo)

Demo data for the intelligent agent
recommendation through dynamic matching
rules/criteria.

Incident Assignment Workbench Demo
(com.snc.incident_assignment_workbench_demo)

Intelligent agent recommendation through
dynamic matching rules/criteria.

Knowledge Product Entitlements
(com.snc.kb_product_entitlements)

This plugin enables customer service
administrators to restrict customer access to
designated knowledge bases and knowledge
articles on the customer self-service portal.
This plugin adds the Knowledge Product
Entitlements menu to the application navigator.

Performance Analytics - Content Pack - Customer
Service
(com.sn_customerservice_pa)

This plugin provides Performance Analytics
content for the Customer Service Management
application. You must install the plugin to view
the Cost Information tab on the Executive
dashboard.

Note:  You can activate Performance
Analytics solutions on instances
that do not have Performance
Analytics to evaluate the
functionality. However, to collect
scores for indicators you must
license Performance Analytics.

Performance Analytics - Content Pack - Customer
Service (New)

This plugin provides Performance Analytics
knowledge performance indicators (KPIs) for the
Customer Service Management application.
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Plugin Description
(com.snc.pa.customer_service) Note:  You can activate Performance

Analytics solutions on instances
that do not have Performance
Analytics premium to evaluate
the functionality. However, to
collect scores for indicators you
must license Performance
Analytics premium.

Performance Analytics - Context Sensitive
Analytics for Customer Service
(com.snc.pa.cs.context_sensitive_analytics)

This plugin provides the ability to open context
sensitive dashboards in customer service forms
based on UI actions.

Note:  You can activate Performance
Analytics solutions on instances
that do not have Performance
Analytics to evaluate the
functionality. However, to collect
scores for indicators you must
license Performance Analytics.

Self Service Password Reset
(com.snc.password_reset)

This plugin allows locally authenticated users to
request a temporary password if they forget their
current one. Customer contacts can request a
new password from the customer self-service
portal.
The Self Service Password Reset plugin activates
the Password Reset plugin
(com.glideapp.password_reset) if it is not already
active.

Targeted Communications
(com.sn_publications)

This plugin activates the Targeted
Communications application, which provides a
tool for publishing and distributing content and
articles to both internal and external customers.
This plugin adds the Targeted Communications
menu to the application navigator and the
Publications link to the customer portal header.

Targeted Communications Demo Data
(com.snc.publications_demo)

This plugin provides demo data for the Targeted
Communications application.

Customer Service Management for Orders

Last updated: July 26, 2018
Last updated: July 26, 2018

This feature adds support for orders and order line items to the Customer Service
Management application.

Customer Service Management for Orders enables customers and consumers to do the
following through a self-service portal:

• View orders
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• View and create cases for orders
• Contact a customer service agent to report an issue

Customer service agents can respond to customer and consumer requests and create cases
for orders.

Plugins

To add support for orders to the Customer Service Management application, activate the
Customer Service Management for Orders plugin (com.snc.csm.order). This plugin requires
the Customer Service plugin (com.sn_customerservice).

This plugin adds the following modules to the Customer Service menu:

• Orders: displays a list of customer orders. Click an order to display the Order form.
• Order Line Items: displays a list of the individual items within each order in the Orders list.

Click an item to display the Order Line Item form.

Creating a case for an order

When creating a case from the Customer or Consumer Service Portals, the end user can
select the type of case to create. Based on the selection, the Create Case form includes
fields specific to the selected case type.

• Create Product Case: includes the Asset and Product fields.
• Create Order Case: includes the Order field.

Create Case link

When creating a case from the Customer Service Management application, the customer
service agent can select the type of case to create:

• Product: opens a new Case form for a product that includes the Product and Asset fields.
• Order: opens a new Case form for an order that includes the Order field.

Tables installed with Customer Service Management for
Orders

Customer Service Management for Orders adds the following tables.

Table Description
Orders
[csm_order]

Stores the orders associated with an account and
contact or with a consumer.

Order Line Items Stores the individual line items within orders.
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Table Description
[csm_order_line_item]

Order Cases
[csm_order_case]

Stores information about customer service cases
related to orders.

Order Case Line
[csm_order_case_line]

Stores information about customer services cases
related to orders and order line items.

Integration with other applications
Last updated: July 26, 2018
Last updated: July 26, 2018

Integrate the Customer Service Management application with Field Service Management
and Financial Management.

• Integration with Field Service Management

The Customer Service with Field Service Management plugin
(com.snc.csm_fsm_integration) provides an integration between the Customer Service
Management and Field Service Management applications.

• Integration with Financial Management

Plugins for Customer Service Management and Field Service Management provide an
integration with the Financial Management application as well as dashboards and reports.

Integration with Field Service Management

Last updated: July 26, 2018
Last updated: July 26, 2018

The Customer Service with Field Service Management plugin
(com.snc.csm_fsm_integration) provides an integration between the Customer Service
Management and Field Service Management applications.

Users can view account and contact information on work orders and work order tasks in the
Field Service Management application. Customers and consumers can view case-related
work orders from the Customer Service and Consumer Service Portals.

When an agent creates a work order from a customer service case, the work order and task
forms include case-related information such as the account and contact.

When a customer or a consumer views a case from either the Customer or Consumer
Service Portals, they can view the details of any work orders and tasks related to the case.

Changes to the Field Service Management application

In the Field Service Management application, this integration adds the following fields to the
Work Order form. These fields are visible in the Case view. To display these fields, right-click
the Work Order form header and select View > Case.

• Account
• Consumer

August 6, 2018 ©2018 ServiceNow. All rights reserved. 13

ServiceNow | Customer Service Management



• Contact
• Asset
• Partner
• Partner Contact

Updating the Account field on the Work order form also updates the Company field.
Updating the Contact field on the Work Order form updates the Caller field.

Changes to the Customer Service Management application

In the Customer Service Management application, this integration adds the Work Orders link
to the Customer Service Portal and Consumer Service Portal headers. Click this link to view
a list of work orders, including the work order number, priority, state, and short description.
The work orders displayed in this list on the Customer Service Portal depend on the
customer role: customer, customer admin, partner, or partner admin.

Click a work order in this list to display the work order details.

Known Limitations

There is no synchronization between the Work Order form and the associated Case form. If
information changes on the Case form, it does not get updated on the Work Order form.

Integration with Financial Management

Last updated: July 26, 2018
Last updated: July 26, 2018

Plugins for Customer Service Management and Field Service Management provide an
integration with the Financial Management application as well as dashboards and reports.

The Financial Management application enables you to allocate, track, and report on
expenses in your organization. When the Financial Management application allocates an
expense, it breaks down the expense into detailed amounts of money called allocations.
These allocations can be associated with specific segments and accounts for a specific cost
model. The integration with Financial Management provides cost allocations for Customer
Service Management and Field Service Management.

Use these cost allocations on the Financial Management workbench, which provides
financial administrators with a graphical interface to allocate expenses. Access the
workbench through the Cost Transparency > Workbench module.

Plugins

Two different plugins, one for Customer Service Management and one for Field Service
Management, enable the integration with Financial Management. These plugins also add
dashboards based on cost allocations.

• Performance Analytics - Content Pack - Financial Management for Customer Service
plugin (com.snc.pa.fm.csm).

• Performance Analytics - Content Pack - Financial Management for Field Service
Management plugin (com.snc.pa.fm.fsm)
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Note:  The Performance Analytics - Content Pack - Financial Management for
Customer Service plugin includes demo data for FY16: Q1 through FY17: Q2.
The Performance Analytics - Content Pack - Financial Management for Field
Service Management plugin does not include demo data.

Cost models

A cost model is a set of rules, methods, and metrics that determines the allocation of
expenses. Select cost models on the Data Definitions tab of the Financial Management
workbench.

For Customer Service Management, the integration with Financial Management provides
these cost models:

• CSM Allocation Model for Cust Account: allocates expenses for individual B2B customer
accounts.

• CSM Allocation Model for Channels: allocates expenses for communication channels.

For Field Service Management, the integration with Financial Management provides this cost
model:

• FSM Allocation Model for Company: allocates expenses for companies.

Segment hierarchy

All accounts in the chart of accounts belong to segments which are structured in a hierarchy.
This hierarchy enables the roll-up of expenses from lower-level accounts and segments to
higher-level accounts and segments.

• CSM Allocation Model for Cust Account uses this segment hierarchy: Assignment Group >
Product > Customer Account.

• CSM Allocation Model for Channels uses this segment hierarchy: Assignment Group >
Product > Channels.

• FSM Allocation Model for Company uses this segment hierarchy: Assignment Group >
Product > Company.

Account buckets

Use account buckets to categorize cleansed expenses before assigning them to accounts
and segments. Account buckets can be organized in parent-child relationships so that
several child buckets can refer to a single parent bucket.

The Customer Support and Field Service Support account buckets include:

• Facilities
• IT Chargeback
• Payroll and Labor Expenses
• Professional Fees & Services
• Supplies
• Training
• Other expenses
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Allocation metrics

Allocation metrics are rules that you can create and use to split an allocation based on
dimensions such as:

• Number of Customer Service cases: allocate expenses to a product based on the number
of cases closed in a fiscal period.

• Total Customer Service case resolution time: allocate expenses to a product based on the
total hours worked on cases closed in a fiscal period.

• Number of Field Service work order tasks: allocates expenses to a product based on the
number of work order tasks completed in a fiscal period.

• Total work order completion time: allocates expenses to a product based on the total
hours worked on tasks completed in a fiscal period.

For Customer Service Management, the integration with Financial Management provides
these allocation metrics:

• CSM Allocate to Assignment Groups by Headcount
• CSM Allocate to Product by # Cases
• CSM Allocate to Product by Case Time Worked Duration
• CSM Rollup from AssgGrp to Product by # Cases
• CSM Rollup from AssgGrp to Product by Case Time Worked Duration
• CSM Rollup from Product to Account by # Cases
• CSM Rollup from Product to Account by Case Time Worked Duration

For Field Service Management, the integration with Financial Management provides these
allocation metrics:

• FSM Allocate to Assignment Groups by Headcount
• FSM Allocate to Product by # Work Orders
• FSM Rollup from Product to Company by # Work Orders

User roles

These roles can access the Financial Management workbench (Cost Transparency >
Workbench):

• cost_transparency_analyst
• cost_transparency_admin
• financial_mgmt_user
• financial_mgmt_admin

Dashboards and reports

The Performance Analytics - Content Pack - Financial Management for Customer Service
and Performance Analytics - Content Pack - Financial Management for Field Service
Management plugins provide the following dashboards:

• CSM Financials Dashboard
• FSM Financials Dashboard

Navigate to Performance Analytics > Dashboards and select the desired dashboard from the
Dashboard menu.
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Related Topics

• Financial Management

• Financial Management Workbench

Set up customer information
Last updated: July 26, 2018
Last updated: July 26, 2018

An overview of the tasks involved in setting up customer information.

Before you begin

Role required: admin

Procedure

1. Set up associated entities.
The customer service case is the primary entity of the Customer Service Management
application and is used to track and resolve customer questions or issues. Customer
information is linked to a case using associated entities such as accounts, assets, and
service contracts. This provides the customer service agent with easy access to the
information necessary to resolve customer issues.

• Create an account.
• Create a contact.
• Create a service contract.
• Create an entitlement.
• Associate an entitlement with an entity.
• Create an asset.
• Create a product model.
• Define an SLA.
• Create a consumer record.

2. Set up customer relationships.
You can establish different types of customer relationships to make account and asset
management easy and flexible.

• Use a bi-directional account relationship to establish a relationship between two
accounts.

Create an account relationship type.
Create an account relationship record based on an account relationship type.

• Use a hierarchical account relationship to create a parent-child relationship between
two or more accounts.

Create an account hierarchy.
• Use a contact relationship to add a contact from a third account to either of the

accounts in an established account relationship.
Create a contact relationship.

3. Set up account teams.
Create teams to support customer accounts by creating specific support roles and then
assigning employees to those roles.

• Create a responsibility definition.
• Assign a team member to an account.

4. Set up asset contact relationships.
To limit access to an asset, create an asset contact relationship and assign the asset to
one or more customer contacts. Then enable the associated property to restrict access
to the asset information to the assigned contacts.
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• Assign a primary contact to an asset.
• Assign additional contacts to an asset.
• Enable the asset contact relationship property.

Note:  The customer administrator can also assign a contact to an asset from
the customer portal.

• Set up associated entities

The Customer Service Management application uses several associated entities, or
reference entities, to link customer information with a customer service case.

• Set up customer relationships

The Customer Service Management application provides the ability to establish different
types of relationships between partners, customers, and contacts.

• Set up account teams

Account teams are made up of employees who fulfill specific jobs or roles for a particular
account.

• Set up asset contact relationships

Assign an asset to a customer contact who is responsible for managing that asset.

Set up associated entities

Last updated: July 26, 2018
Last updated: July 26, 2018

The Customer Service Management application uses several associated entities, or reference
entities, to link customer information with a customer service case.

The customer service case is the primary entity of the Customer Service Management
application and is used to track and resolve customer questions or issues. Customer
information is linked to a case using associated entities such as accounts, assets, and service
contracts. This provides the customer service agent with easy access to the information
necessary to resolve customer issues.

• Customer information

Customer information includes the account and contact information for a customer or
partner.

• Contracts and entitlements

Contracts and entitlements define the type of support that a customer receives.

• Products and assets

Products and assets identify the product models and individual product instances owned
by a customer.

• Service level agreements

A service level agreement (SLA) is a record that specifies the time within which service
must be provided.

• Consumer information
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Consumer information includes the name, phone number, and one or more addresses for
a consumer.

Customer information

Last updated: July 26, 2018
Last updated: July 26, 2018

Customer information includes the account and contact information for a customer or
partner.

An account is a supported external customer and the Account form stores the customer's
information, including the company name, contact names, addresses, phone numbers, and
web and email addresses. An account can be a customer account, a partner account, or
both.

A contact is a user who is an employee of an account. A contact record stores information
about a contact, such as the name, phone number, email and web address. An account can
have multiple contacts but a contact can be associated with only one account. A contact
can have one or more associated assets and service contracts. A contact can also have a
user ID and can log in to the customer portal.

An account can have one or more associated assets, service contracts, entitlements, and
SLAs. An account can also be associated with the following entities:

• case
• contact
• service contract
• entitlement
• asset

A partner is a supported external customer that, in turn, sells to and supports one or more
customers. A partner account record stores information about a partner's company, similar
to a customer account. On a partner account record, the Partner field is enabled. A partner
can report and manage cases on behalf of customers. A partner can also be a customer.

Create a customer or partner account

Use this procedure to create either a customer or partner account.

Before you begin

Role required: sn_customerservice_agent, sn_customerservice_manager, or admin

Procedure

1. Do one of the following:
• To create a customer account, navigate to Customer Service > Customer >

Accounts.
• To create a partner account, navigate to Customer Service > Customer > Partners.

2. Click New.
3. Fill in the fields on the Account form, as appropriate.
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Account form
Field Definition
Name The name of the company.

Number The automatically generated account number
for this customer.

Primary Contact The name of a user who is the main contact for
this company.

Parent Account The parent account for this account. Use this
field to create an account hierarchy.

Registration Code A unique code for this account. The customer
administrator can provide this code to
customers for use when requesting a login on
the customer portal. The registration code
provides a method for validating the customer
and the company before the login request is
granted.
Enter an alphanumeric code in this field or click
the Generate Code icon to generate a unique
code.

Customer Denotes this account as a customer, as
opposed to a partner. If creating a customer
account, this field is enabled by default.

Partner Denotes this account as a partner. A partner
can report and manage cases on behalf of
customers. A partner can also be a customer. If
creating a partner account, this field is enabled
by default.

Website The web address for the company.

Phone The phone number for the company.

Street The street address of the company.

City The city in which the company is located.

State/Province The state or province in which the company is
located.

Zip/Postal code The zip code or postal code for the company.

Country The country in which the company is located

Notes Any additional information about the company.

4. Click Submit.

Import customer account information

After importing customer account information, update the
com.snc.cs_base.last.generated.code.tree.path property with the correct account code
value.

The com.snc.cs_base.last.generated.code.tree.path system property stores the Account
Code value for the most recently created customer account in the Account
(customer_account) table.

When you create a new customer account record, the system uses this property to
determine a unique account code value for the account. The property is then updated with

August 6, 2018 ©2018 ServiceNow. All rights reserved. 20

ServiceNow | Customer Service Management



this latest assigned value so that the next account code value can be set as a unique value
for the next account record insert.

The value of the com.snc.cs_base.last.generated.code.tree.path property must match the
value of the Account Code field for the last inserted customer account record. When you
create customer account records by importing data from other sources or instances, these
values can get out of sync. If these values do not match, the system generates an error upon
creation of the next new record in the Account table:

java.sql.BatchUpdateException: Duplicate entry for key account_path

To fix this error:

1. Determine the account code for the last created account.
2. Navigate to the System Property [sys_properties] table.
3. Set the com.snc.cs_base.last.generated.code.tree.path property to that value.

Create a contact

Use this procedure to create contact information for an account.

Before you begin

Role required: sn_customerservice_manager, admin

About this task

A contact is a user in the system. If you create a contact, that person is also added to the
User list.

Procedure

1. Navigate to Customer Service > Customer > Contacts.
2. Click New.
3. Enter the requested contact information, such as the name, email address, and phone

number.
4. Enter the name of the contact's company in the Account field.
5. Select the Timezone.
6. Select a Notification setting.
7. Click Submit.

Create additional account addresses

An account can have multiple addresses, such as a main address as well as shipping and
billing addresses.

Before you begin

Role required: sn_customerservice_manager or admin

About this task

The main address is stored in fields on the Account form and in the Addresses related list.
Shipping and billing addresses are created and stored in the Addresses related list.
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When you fill in the address fields on the Account form and click Submit, this information is
added to the Addresses related list as the main address. Any changes made to these fields
are also updated in the related list.

Note:  An account can have only one main address.

All addresses for an account are stored in the Addresses related list. New addresses can be
created from this related list by clicking New and filling in the fields on the Location form,
including the address type.

Procedure

1. Navigate to Customer Service > Customer > Accounts.
2. Click the number of the desired account.
3. In the Addresses related list, click New.
4. Fill in the fields on the Location form.
5. Select an address Type: Billing, Main, or Shipping.

An account can have multiple billing and shipping addresses but can have only one main
address.

6. Click Submit.

Contracts and entitlements

Last updated: July 26, 2018
Last updated: July 26, 2018

Contracts and entitlements define the type of support that a customer receives.

Service contracts

A service contract record stores information about the type of support that is provided to a
designated company. A contract can include a company and contact and the specific assets
that are covered. A contract can also include multiple service entitlements and SLAs.

The Customer Service Management application leverages the existing ServiceNow Contract
application to create and maintain service contracts. The Customer Service Management
application uses the Contract form and adds the Company field so customer service agents
can quickly see the company associated with a contract.

Entitlements

An entitlement defines the type of support that a customer receives and the supported
communication channels for a customer. An entitlement can be associated with a product,
an asset, an account, or a contract.

An entitlement check is performed when a case is opened. This check takes into
consideration the existing cases for the specific account, product, asset, and service
contract. Entitlements can have associated workflows that drive recommended activities for
a case.

Entitlements are counted using two types of units: cases and hours. Entitlements can also
be tracked on a per unit basis. The Unit field on the Service Entitlement form defines the unit
type. The Total Units field defines the total number of cases or hours available for this
entitlement and the Remaining Units field tracks the number of units remaining.
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These counters are active if the Per Unit field is enabled and are updated whenever a case
for a product, asset, company, or contract that has an associated entitlement is closed.

Keep these guidelines in mind as you create entitlements.

• Product entitlements: when creating an entitlement for a product, select the product from
the Product field. If you select only a product and not a company, contract, or asset, this
creates a generic entitlement and the entitlement counter fields cannot be used.

• Asset entitlements: when creating an entitlement for an asset, select a company first and
then the only assets that are shown are those belonging to that company.

• Contract entitlements: when creating an entitlement for a contract, select the contract and
then the assets that are covered as a contract line item. The resulting contract entitlement
is valid for the assets listed within that contract.

Create a service contract

Create a service contract for a customer account.

Before you begin

Role required: sn_customerservice_manager or admin

Procedure

1. Navigate to Customer Service > Contracts > Service Contracts.
2. Click New.
3. Fill in the fields on the Contract form, as appropriate.

Contract form
Field Definition
Number The automatically created contract number.

Account The name of the company associated with this
contract.

Contract administrator The individual who is responsible for managing
the contract.

Approver The user who approves or rejects the contract.

Contract number The number assigned to the contract by the
customer.

State The current state of the contract:
• Draft
• Active
• Expired
• Canceled

Starts The date that the contract starts.

Ends The date that the contract ends.

Short description A brief description of the contract.

4. Click Submit.
You can also click Submit For Review to place the contract in the Draft state and send
an email to the Approver to review the contract.
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Approve a service contract

Approve a service contract for a customer account.

Before you begin

Role required: sn_customerservice_manager or admin

Procedure

1. Navigate to Self-Service > My Approvals.
2. Select a contract for review from the Approvals list that has a state of Requested.
3. Review the contract details in the summary at the bottom of the approval form.
4. Add review comments to the Comments field.
5. Click one of the following:

Option Description

Approve The review state changes to Approved on the
Approvals list.

Reject The review state changes to Rejected on the
Approvals list. If you reject a contract, you
must enter a rejection reason in the Comments
field.

Create an entitlement for a customer service entity

Create an entitlement for a customer service entity.

Before you begin

Role required: sn_customerservice_manager or admin

Procedure

1. Navigate to Customer Service > Contracts > Entitlements.
You can also create an entitlement from the Entitlements related list on the Account and
Contract forms.

2. Click New at the top of the Entitlements list.
3. Fill in the fields on the Entitlement form.

Service Entitlement form
Field Definition
Name The name of the entitlement.

Product The product model associated with this
entitlement.

Account The name of the account associated with this
entitlement.

Contract The contract number associated with this
entitlement .

Asset The asset tag number or the serial number of
the asset associated with this entitlement.
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Field Definition
Active Check this box to enable the entitlement.

Active entitlements are available for selection
when creating a new case.

Channel One or more communication channels
associated with this entitlement.

• Email
• Web
• Phone
• Chat

Business hours The schedule associated with this entitlement.

Start date The start date for this entitlement.

End date The end date for this entitlement.

Total Units The total number of units designated for this
entitlement. This field is active if the Per unit
check box is enabled.

Remaining Units The number of available units that are
remaining for this entitlement. This field is
active if the Per unit check box is enabled. This
field is updated when a case associated with
this entitlement is closed.

Unit The type of unit being measured for this
entitlement: Cases or Hours.

Per unit Select this check box to enable unit counters. If
enabled, the Total Units and Remaining Units
fields are activated.

4. Click Submit.

Associate an entitlement with an entity

Associate an entitlement with a customer service entity such as an account, contract, asset,
or product.

Before you begin

Role required: admin

Procedure

1. Navigate to Customer Service > Contracts > Entitlements.
2. Select an entitlement from the Entitlements list.
3. Click the lookup icon to the right of one of the Product, Account, Contract, or Asset

fields.
4. Select the desired entity from the list.

Note:  If you select an entity in more than one of the fields listed above, the
selections available in subsequent fields are filtered by the selections
already made.

5. Click Update.

Products and assets

Last updated: July 26, 2018
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Last updated: July 26, 2018

Products and assets identify the product models and individual product instances owned by
a customer.

With the Customer Service Management application, you can configure product models and
assets.

A product is a good or a service that a company sells to and supports for their customers. A
product has specific features or components which determine the agents best qualified to
provide support. A product model is a specific version or configuration of a product. A
product can be installed at a customer site or in-house with access provided on a
subscription basis.

An asset is a specific product instance that is supported for a customer. Assets can have
serial numbers or asset tag numbers and can be allocated to individual accounts or to a
contact within an account. Assets can also have associated support contracts.

Customer Service Management leverages the Asset application to create and maintain
assets.

Create a product model

Create a record for a type of product that your company sells and supports.

Before you begin

Role required: admin

Procedure

1. Navigate to Customer Service > Products > Product Models.
2. Click New.
3. Select the type of product model to create:

• Application Model
• Consumable Model
• Contract Model
• Software Model
• Bundle
• Consumable
• Contract
• Facility
• Hardware
• Software

4. Fill in the fields for the selected product model, as appropriate
See Model form fields for field descriptions.

5. Click Submit.

Create an asset

Create a record for a specific instance of a product.

Before you begin

Role required: sn_customerservice_manager or admin
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Procedure

1. Navigate to Customer Service > Products > Assets.
2. Click New.
3. Select the type of asset to create:

• Hardware
• Software License
• Consumable
• License
• Facility

4. Fill in the fields for the selected asset type, as appropriate.

Asset record fields
Field Description
Display name Name of the asset as it appears in record lists.

Automatically set when asset is created, based
on Asset Tag and Model fields.

Model category Model grouping of the asset. Based on the
model category selected, the asset can be
linked to a configuration item.

Model Specific product model of the asset.

Configuration Item CI automatically created when this asset is
created. The name that appears in this field is
based on Model category and Model. Point to

the reference icon ( ) to see the
configuration item details inherited from the
asset record.

Quantity Number of items this asset represents. An asset
always has a quantity of one unless one or
more of these points are true.

• It is a consumable. Quantity is unrestricted
because consumables are tracked in
groups.

• It is pre-allocated. Quantity is unrestricted
when Model category and Model are
defined and Substate is set to Pre-
allocated.

• It has no model and no model category.

General tab

Asset tag Alphanumeric information assigned by your
organization to help track the asset.

State Current state of the asset, such as On order or
In use.

Stockroom Current stockroom in which the asset is
physically located.

Reserved for Person for whom the asset has been ordered.
This field is visible when the asset state is On
Order.

Assigned to Person using or primarily responsible for this
item. This field is visible when the asset state is
In Use.
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Field Description
Managed by Person who maintains the asset. This can be

different from the person in the Owned by field.

Owned by Person who has financial ownership of the
asset. This can be different from the person in
the Managed by field.

Parent Parent asset of the asset. For example, a
monitor or peripheral can have a workstation as
their parent asset. When a parent link is
defined, the fields related to assignment and
state of the child assets is set to read-only and
are populated based on the parent assignment
and state fields. For more information, see
Creating Bundled Models.

Class Asset group, for example, base, hardware,
license, or consumable.

Serial number Serial number of this asset.

Substate Current substate of the asset. The available
substate settings depend on the state selected.
For example, the Retired state contains the
Substate options Disposed, Sold, Donated, and
Vendor credit.

Location Current physical location of the asset.

Department Department to which the asset belongs.

Company Company or organization to which this asset
belongs.

Assigned Date on which the asset was assigned to a user.

Installed Date on which the asset was installed.

Comments Information about the asset that would be
helpful for others to know.

Financial tab

PO number Purchase order under which the asset was
purchased.

Order received Date on which the asset was received.

Request line Requested item to which the asset is linked.

Purchase order line Purchase order line item to which the asset is
linked.

Receiving line Receiving slip line to which the asset is linked.

Invoice number Invoice under which the asset was billed.

Cost Price at which the asset was purchased.

Vendor Vendor from which the asset was purchased.
For assets automatically created from purchase
orders in Procurement, the default value of the
Vendor field is the vendor specified on the
purchase order.

Purchased Date on which the asset was purchased.

Ordered Date on which the asset was ordered.
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Field Description
Opened Date on which the requested item record was

opened. The system automatically populates
the field when a request line is specified.

GL account General ledger account number with which the
asset is associated.

Cost center Group financially responsible for the asset.

Acquisition method How the asset was acquired. Base system
choices are Purchase, Lease, Rental, and Loan.
For assets automatically created from purchase
orders in Procurement, the default value is
Purchase

Expenditure type The type of expenditure.
• Capex: Capital expenditure is a one-time

expenditure, where the value is realized
over the years. For example, a photocopier.

• Opex: Operational expenditure is an on-
going expenditure. For example, toners for
the photocopier.

Disposal tab

Disposal reason Text explaining why the asset is being retired.

Beneficiary Organization that receives the asset when it is
retired.

Resale price Value of the asset when it is retired. For
example, if the asset is donated, the value used
when reporting taxes.

Scheduled retirement Scheduled date on which the asset is retired.

Retired date Actual date on which the asset was retired.

Depreciation tab

Depreciation Depreciation method that is applied. Base
system choices are Declining Balance and
Straight Line. The depreciation value is
defaulted from the associated Model.

Depreciation effective date Date on which the specified depreciation
method begins.

Salvage value Estimated value of an asset at the end of its
useful life. This value must be less than or equal
to the Cost of the asset.

Residual date [Read-only] Number of days that have passed
since the Depreciation effective date.

Residual value [Read-only] Value in the Cost field with the
depreciation method applied.

Covered by Fixed Asset List of all fixed assets that contain the asset. To
add the asset to another fixed asset, double-
click in the Fixed asset column, click the

reference lookup icon ( ), select an asset, and
click the green check mark.

Contracts tab
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Field Description
Lease contract Name of the lease contract that applies to the

asset.

Warranty expiration Expiration date of the asset warranty.

Support group Group managing the contract covering the
asset.

Supported by Person managing the contract covering the
asset.

Entitlements tab (available for hardware assets)

Hardware Entitlements Software asset license entitlements associated
to the asset.

Device Entitlements tab (available for software assets)

Allocated condition Condition that a configuration item must satisfy
to be granted entitlement for this license
(available for software entitlements).

Device Entitlements Software license entitlements associated to the
asset.

User Entitlements tab (available for software assets)

Assigned condition Condition that a user item must satisfy to be
granted entitlement for this license (available
for software entitlements).

User Entitlements User license entitlements associated to the
asset.

Activities tab

Work notes Work notes are updated for the following
cases:

• Updates to Assigned To, Managed To State,
Substate, and Reserved fields of asset. The
columns for these fields are audited by
default and any update is recorded in the
work notes.

• Work notes for hardware and software
assets are updated when asset is received
by a purchase order and transfer order.
These work notes help in tracking life cycle
of the asset.

Related links

Calculate Depreciation Click to calculate the depreciation amount and
residual value.

Delete Assets Only Click to delete the assets and not the
associated CI.

5. Click Submit.

Service level agreements

Last updated: July 26, 2018
Last updated: July 26, 2018

A service level agreement (SLA) is a record that specifies the time within which service must
be provided.
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The Customer Service Management application uses the standard ServiceNow SLA with
customer service cases. An SLA can be attached to a service contract, to a company, and to
a product and can be configured to start, pause, and stop based on any customer service
case attributes.

Define an SLA for a customer service case

The system administrator can define a new service level agreement (SLA) for a customer
service case.

Before you begin

Role required: admin

Procedure

1. Navigate to Customer Service > Cases > All.
2. Select the desired case from the Cases list.
3. From the SLAs related list, click New.
4. Fill in the fields on the Task SLA form.
5. Click Submit.

Consumer information

Last updated: July 26, 2018
Last updated: July 26, 2018

Consumer information includes the name, phone number, and one or more addresses for a
consumer.

Create a consumer record

Consumer service agents and managers can create a consumer record from the Customer
Service Management application.

Before you begin

Role required: sn_customerservice.consumer_agent, sn_customerservice_manager or admin

Procedure

1. Navigate to Customer Service > Customer > Consumers
2. Click New.
3. Fill in the fields on the Consumer form as necessary.
4. Fill in the fields on the Primary Address tab.

A consumer can have multiple addresses but only one primary address. The primary
address is stored in the Primary Address tab on the Consumer form and in the
Addresses related list.

5. If desired, set any of the fields on the Preferences tab.
6. Click Submit.

The record is added to the Consumers table (csm_consumer). The primary address is
added to the Addresses related list and the Primary field is set to true.
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Create additional consumer addresses

Consumers can have multiple addresses, including one primary address.

Before you begin

Role required: sn_customerservice.consumer_agent, sn_customerservice_manager, or admin

About this task

The primary address is stored in the Primary Address tab on the Consumer form and in the
Addresses related list. Additional addresses, such as billing and shipping addresses, are
created and stored in the Addresses related list.

When you fill in the fields in the Primary Address tab and click Submit, this information is
added to the Addresses related list as the primary address. Any changes made to the
primary address are updated in both places.

For the primary address, the Primary field is set to true. For other addresses in the list, this
field is set to false. A consumer can have only one primary address.

Procedure

1. Navigate to Customer Service > Customer > Consumers.
2. Click the number of the desired consumer.
3. In the Addresses related list, click New.
4. Fill in the fields on the Location form.
5. To denote this address as the primary address for the consumer, enable the Primary

check box.
A consumer can have multiple addresses but only one primary address.

6. Click Submit.

Set up customer relationships

Last updated: July 26, 2018
Last updated: July 26, 2018

The Customer Service Management application provides the ability to establish different
types of relationships between partners, customers, and contacts.

These relationships make account and asset management easy and flexible. The following
types of customer service relationships are available.

Customer service relationships
RelationshipDescriptionBenefit
Bi-
directional
account
relationship

Create
a
relationship
between
two
customer
accounts
or
between
a
partner

An account relationship allows partner account contacts with the partner role or the partner
administrator role to create and manage cases for their partner account.
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RelationshipDescriptionBenefit
account
and
a
customer
account.

Account
hierarchy
Create
a
parent-
child
relationship
between
accounts.

An account hierarchy allows an account contact with the customer administrator role to manage the
child accounts.

Contact
relationship
Add
a
contact
from
a
third
account
to
either
of
the
accounts
in
an
account
relationship.

A contact relationship allows a contact with the customer role or customer administrator role to
manage the account for which the contact relationship has been established.

• Bi-directional account relationships

Create account relationships between two customer accounts or between a partner
account and a customer account.

• Account hierarchy

Use the account hierarchy feature to create a parent-child relationship between accounts.

• Contact relationships

Use a contact relationship to add a contact from a different account to either of the
accounts in an established account relationship.

Bi-directional account relationships

Last updated: July 26, 2018
Last updated: July 26, 2018

Create account relationships between two customer accounts or between a partner account
and a customer account.

The system administrator can create account relationships by:

• Defining the types of relationships that exist between your partners and customers.
• Using these defined relationship types to create relationship records between selected

accounts.
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Once an account relationship record is created, it can be viewed on the Account form for
either account in the Account Relationships related list.

For relationships between a partner account and a customer account, partner account
contacts with the partner role or the partner administrator role can create and manage
cases for their customer accounts.

• Account relationship types

An account relationship is based on a defined account relationship type. Users with the
system administrator role can define two types of relationships: partner-to-account and
account-to-account.

• Account relationship records

Once an account relationship type has been defined, users with the customer service
manager role can use it to create relationship records between specific accounts or
partners.

Last updated: July 26, 2018
Last updated: July 26, 2018

An account relationship is based on a defined account relationship type. Users with the
system administrator role can define two types of relationships: partner-to-account and
account-to-account.

There is one default account relationship type provided for partner accounts. The system
administrator can create additional account relationship types by defining the following
information:

• A unique name that identifies the relationship type.
• The type of source account, either an account or a partner.
• The type of target account, either an account or a partner.
• The relationship name between the source account and the target account.
• The reverse relationship name between the target account and the source account.

Account Relationship Type form

The system administrator can also update and delete account relationship types.

Create an account relationship type

Create an account relationship type by defining the types of source and target accounts and
providing a name for the relationship between these accounts.

Before you begin
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Role required: admin

Procedure

1. Navigate to Customer Service > Administration > Account Relationship Types.
2. Click New.
3. Fill in the fields on the Account Relationship Type form.

Account Relationship Type form fields
Field Definition
Relationship type A unique name that identifies the type of

relationship. For example, Service Provider.

From The type of source account for this relationship
type; can be either an account or a partner.

Relationship A text field where you can name the
relationship from the source account to the
target account. For example, Service provider
for.

To The type of target account for this relationship
type; can be either an account or a partner.

Reverse relationship A text field where you can name the reverse
relationship from the target account to the
source account. For example, Customer of.

Active Sets the account relationship type as active or
inactive. Active account relationship types can
be used to create account relationship records.
An account relationship type can be set to
inactive at any time.

4. Click Submit.
The new account relationship type appears on the Account Relationship Types list.

Edit an account relationship type

Edit an existing account relationship type by changing the types of source and target
accounts and the name of the relationship between these accounts.

Before you begin

Role required: admin

About this task

When updating an existing account relationship type, if that account relationship type is
currently being used by any account relationship records, then the Relationship and Reverse
relationship fields in those records are automatically updated.

Procedure

1. Navigate to Customer Service > Administration > Account Relationship Types.
2. Select a relationship type from the Account Relationship Types list.
3. Make the desired changes to the fields on the Account Relationship Type form.
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Account Relationship Type form fields
Field Definition
Relationship type A unique name that identifies the type of

relationship. For example, Service Provider.

From The type of source account for this relationship
type; can be either an account or a partner.

Relationship A text field where you can name the
relationship from the source account to the
target account. For example, Service provider
for.

To The type of target account for this relationship
type; can be either an account or a partner.

Reverse relationship A text field where you can name the reverse
relationship from the target account to the
source account. For example, Customer of.

Active Sets the account relationship type as active or
inactive. Active account relationship types can
be used to create account relationship records.
An account relationship type can be set to
inactive at any time.

4. Click Update.

Delete an account relationship type

Delete an account relationship type.

Before you begin

Role required: admin

About this task

If there are no account relationship records that use the account relationship type, then it is
simply deleted.

If there are active account relationship records that use the account relationship type, an
attempt to delete that relationship type results in a warning message. Deleting an account
relationship type also deletes the relationship records based on that type.

Note:  Account relationship types can be set to inactive at any time.

Procedure

1. Navigate to Customer Service > Administration > Account Relationship Types.
2. Select a relationship type from the Account Relationship Types list.
3. Click Delete.
4. Click Delete again in the confirmation pop-up window.

Last updated: July 26, 2018
Last updated: July 26, 2018
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Once an account relationship type has been defined, users with the customer service
manager role can use it to create relationship records between specific accounts or partners.

An account relationship record includes the following information:

• A source account, selected in the Account From field.
• A target account, selected in the Account To field.
• The account relationship type that this relationship record is based on.
• The relationship and the reverse relationship of the selected accounts.

Once a relationship record has been created, you can see the relationship from either
account:

• The relationship (Account From > Account To) appears in the Account Relationships
related list on the source account record.

• The reverse relationship (Account To > Account From) appears in the Account
Relationships related list on the target account record.

Select the account relationship record from either account to see the Account Relationship
form.

Account Relationship form

The system administrator and the customer service manager can create and delete account
relationship records as well as view all relationship records based on a specific account
relationship type.

When a relationship is deleted, the reverse relationship is also deleted.

View account relationship records

View the account relationship records that use a specific account relationship type.

Before you begin

Role required: sn_customerservice_agent, sn_customerservice_manager, or admin
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About this task

This information appears as a related list on the Account Relationship Type form. This list
shows the source account (Account From field) and the target account (Account To field)
for each account relationship record.

Procedure

1. Navigate to Customer Service > Administration > Account Relationship Types.
2. From the Account Relationship Types related list, select a relationship type.

The account relationship records that use the selected account relationship type appear
in the Account Relationships related list.

Create an account relationship record

Create an account relationship record by selecting the account relationship type and then
selecting the accounts.

Before you begin

Role required: sn_customerservice_manager or admin

About this task

The system administrator can create a relationship record for an account from the Account
Relationships related list on the Account Relationship Type form.

The customer service manager and the system administrator can create a relationship
record for an account from the Account Relationships related list on the account or partner
record.

Procedure

1. Navigate to Customer Service > Customer > Accounts or Partners.
2. Select an account.
3. From the Account Relationships related list, click New.
4. Fill in the fields on the Account Relationship form.

Account Relationship form fields
Field Definition
Account From The source account for this relationship. If you

are creating the relationship from an account or
partner record, this field is automatically filled
in; otherwise, make a selection from the
Accounts list.

Relationship Type Select the account relationship type for this
record. If you are creating the record from an
Account Relationship Type form, this field is
automatically filled in. Otherwise, make a
selection from the Account Relationship Types
list, which shows all active account relationship
types.

Account To The target account for this relationship.

5. Click Submit.
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Once a relationship record has been created, it appears in two places:
• The relationship appears in the Account Relationships related list on the source

account record.
• The reverse relationship appears in the Account Relationships related list on the

target account record.

Delete an account relationship record

Deleting a relationship record for an account also deletes the reverse relationship record.

Before you begin

Role required: sn_customerservice_manager or admin

About this task

The system administrator can delete a relationship record for an account from the Account
Relationships related list on the Account Relationship Type form.

The customer service manager and the system administrator can delete a relationship
record for an account from the Account Relationships related list on the account or partner
record.

Note:  Deleting a relationship record does not have any impact on customer service
cases that refer to the relationship record.

Procedure

1. Navigate to Customer Service > Customer > Accounts or Partners.
2. Select an account.
3. From the Account Relationships related list, select the relationship record.
4. Click Delete.
5. Click Delete again in the confirmation pop-up window.

Account hierarchy

Last updated: July 26, 2018
Last updated: July 26, 2018

Use the account hierarchy feature to create a parent-child relationship between accounts.

An account hierarchy represents the legal entity structure of the accounts and their
relationships. It also represents an account's customers, assets, and service entitlements.

Creating an account hierarchy allows customer administrators to do the following for all of
the accounts in the hierarchy:

• View and create cases
• View assets and users
• View and manage contacts

It also enables contacts of the parent account to access all of the child accounts.

The system administrator can define the hierarchy between accounts by selecting the parent
in the Parent Account field on the Account form for the child account. If this field is not filled
in, the account is a top-level account.

August 6, 2018 ©2018 ServiceNow. All rights reserved. 39

ServiceNow | Customer Service Management



After the account hierarchy has been defined, it is displayed in a tree map on the Account
form for the parent account. If a parent account is updated or deleted, the hierarchy for any
child accounts is also updated.

Account hierarchy tree map

Create an account hierarchy

Create a parent-child relationship between two accounts.

Before you begin

Role required: admin

Procedure

1. Navigate to Customer Service > Customer > Accounts.
2. Select the desired child account.
3. Select the parent for this account in the Parent Account field.
4. Click Update.

The account hierarchy is displayed in a tree map on the Account form for the parent
account.

Contact relationships

Last updated: July 26, 2018
Last updated: July 26, 2018

Use a contact relationship to add a contact from a different account to either of the
accounts in an established account relationship.

A contact relationship allows a contact with the customer role or customer administrator
role to manage the account for which the contact relationship has been established. These
contacts can view information and perform actions on behalf of the accounts, such as
creating or updating cases from the customer portal.

When you create a contact relationship, you select a user from the Contact field. This field
displays the contacts from:

• Both accounts in the account relationship
• All accounts in the account hierarchy

August 6, 2018 ©2018 ServiceNow. All rights reserved. 40

ServiceNow | Customer Service Management



When creating a contact relationship, the responsibilities available for selection are those
responsibility definitions created with a type of Contact. An account can have one unique
combination of a contact and a responsibility.

Customer service managers can create and delete contact relationships for accounts.
Managers and agents can view a list of contact relationships for an account.

Contacts appear in the Contact Relationships related list on the Account form.

Create a contact relationship for an account

Create a contact relationship for an account by selecting a contact and then assigning a
responsibility to that contact.

Before you begin

Role required: sn_customerservice_manager or admin

Procedure

1. Navigate to Customer Service > Customer > Accounts or Partners.
2. Select an account.
3. In the Contact Relationships related list, click New.
4. Fill in the fields on the Contact Relationship form.

Contact Relationship form fields
Field Definition
Account The account to which the contact is assigned.

This field is automatically filled in.

Contact The customer contact selected to fulfill the role
or responsibility.
The Contacts list includes contacts from any
related partner or account as well as contacts
from the account hierarchy.

Responsibility The role or responsibility selected for this
customer contact.

5. Click Submit.
The contact name, account, and responsibility are added to the Contact Relationships
related list.

Delete a contact relationship for an account

Delete a contact relationship for an account if the relationship is no longer necessary or
valid.

Before you begin

Role required: sn_customerservice_manager or admin

Procedure

1. Navigate to Customer Service > Customer > Accounts or Partners.
2. Select an account.
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3. Select the tab for the Contact Relationships related list.
4. Select the check box to the left of the contact relationship.
5. Select Delete from the Actions dropdown list.
6. Click Delete on the confirmation pop-up window.

View contact relationships for an account

View a list of the contact relationships that have been created for an account.

Before you begin

Role required: sn_customerservice_agent, sn_customerservice_manager, or admin

Procedure

1. Navigate to Customer Service > Customer > Accounts or Partners.
2. Select an account.
3. Select the tab for the Contact Relationships related list.

Set up account teams

Last updated: July 26, 2018
Last updated: July 26, 2018

Account teams are made up of employees who fulfill specific jobs or roles for a particular
account.

The system administrator creates the roles, or responsibility definitions, for the tasks or
functions needed to support customer accounts. Two types of roles can be created: one for
a user and one for a contact. Once the roles are created, the customer service manager can
use these roles to do the following:

• Build an account team by selecting an account and then selecting roles and assigning
them to employees.

• Add contact relationships to an account by selecting an account and then selecting roles
and assigning them to contacts.

Once the roles are created, the customer service manager can build an account team by
selecting roles and assigning them to employees for that specific account.

Create a responsibility definition

Define a role or responsibility needed to support an account.

Before you begin

Role required: admin

Procedure

1. Navigate to Customer Service > Administration > Responsibility Definitions.
2. Click New.
3. Fill in the fields on the Responsibility Definition form.
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Responsibility Definition form fields
Field Definition
Name The name of the role or responsibility.

Unique Select this check box if this role should only be
assigned to one employee. Enabling this check
box prevents the creation of duplicate entries
for a role.

Type The type of role:
• Select User if this role should be performed

by an employee. When assigning this role,
the list of available users comes from the
Users [sys_users] table.

• Select Contact if this role should be
performed by a customer contact. When
assigning this role, the list of available users
comes from the Contacts
[customer_contact] table.

4. Click Submit.

Delete a responsibility definition

Delete a role or responsibility from the Responsibility Definitions list.

Before you begin

Role required: admin

About this task

The system administrator can delete a role only if there are no entries for that role.

Procedure

1. Navigate to Customer Service > Administration > Responsibility Definitions.
2. Select the desired role from the Responsibility Definitions list.
3. Click Delete.
4. Click Delete on the confirmation pop-up window.

Assign a team member to an account

Assign a team member to an account by selecting the employee and the employee's role or
responsibility.

Before you begin

Role required: sn_customerservice_manager or admin

About this task

The system administrator can assign a team member to an account from the Account Team
Members related list on the Responsibility Definition form.
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The customer service manager can assign a team member to an account from the Account
Team Members related list on the account or partner record.

Procedure

1. Navigate to Customer Service > Customer > Accounts or Partners.
2. Select an account.
3. From the Account Team Members related list, click New.
4. Fill in the fields on the Account Team Member form.

Account Team Member form fields
Field Definition
Account The account to which the user is assigned. If

you are assigning a user from an account or
partner record, this field is automatically filled
in; otherwise, make a selection from the
Accounts list.

Responsibility The role or responsibility selected for this
employee.

User The employee selected to fulfill the role or
responsibility.

5. Click Submit.

View team members assigned to an account

View the team members for a specific account.

Before you begin

Role required: sn_customerservice_agent, sn_customerservice_manager, or admin

Procedure

1. Navigate to Customer Service > Customer > Accounts or Partners.
2. Select an account.
3. Select the Account Team Members related list.

This list displays the employees who have been assigned to the team as well as their
responsibilities.

View users assigned to a specific role

View a list of users who have been assigned to account teams to fulfill a specific role.

Before you begin

Role required: admin

Procedure

1. Navigate to Customer Service > Administration > Responsibility Definitions.
2. Select the desired role from the Responsibility Definitions list.

The users who have been assigned to this role are displayed in the Account Team
Members related list on the Responsibility Definition form.
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Set up asset contact relationships

Last updated: July 26, 2018
Last updated: July 26, 2018

Assign an asset to a customer contact who is responsible for managing that asset.

Account and partner contacts can see all of the assets related to an account. To limit access
to an asset, you can create an asset contact relationship and assign the asset to one or more
contacts. Then you can enable the associated property to restrict access to the asset
information to the assigned contacts.

The system administrator can add a primary contact to an asset by selecting a user in the
Primary Contact field on the Asset form. This field references the Contacts table and is
filtered by the asset’s account.

The system administrator can also create relationships with additional contacts from the
Asset Contacts related list on the Asset form. When you create an asset contact relationship,
you can select contacts from:

• The account that the asset belongs to.
• The partner of the account that the asset belongs to.
• Any contacts added to these accounts using contact relationships.

After adding contacts to an asset, enable the related property to limit access. When
enabled, the following access is limited from the customer portal:

• When a user clicks My Assets, the list shows only those assets for which the user is a
contact.

• When a user clicks Create Case, the Asset field on the Create Case form shows only those
assets for which the user is a contact.

Assign a primary contact to an asset

Users with the system administrator role can assign a primary contact to an asset.

Before you begin

Role required: admin

Procedure

1. Navigate to Customer Service > Products > Assets.
2. Click the desired asset.
3. Select a Primary Contact.

This field references the Contacts [customer_contact] table and is filtered by the
account selected in the Account field.

4. Click Update.
The contact is added to the Asset Contacts related list on the asset form.

Assign a contact to an asset

Users with the system administrator role can assign a contact to an asset.

Before you begin
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Role required: admin

About this task

Users with the sn_customerservice.customer_admin can also assign a contact to an asset
from the Customer Service Portal.

Procedure

1. Navigate to Customer Service > Products > Assets.
2. Click the desired asset.
3. Click New in the Asset Contacts related list.

This displays a new Asset Contact form. The Asset field displays the selected asset and
is read-only.

4. Select a Contact.
The contacts available for selection are the contacts from the asset's account.

5. Click Submit.
The contact is added to the Asset Contacts related list.

Enable the asset contact relationship property

Limit access to asset information to the assigned contacts by enabling the associated
property.

Before you begin

Role required: admin

Procedure

1. Navigate to Customer Service > Administration > Properties.
2. Enable the Restrict Assets based on Contacts assigned to the assets property.
3. Click Save.

Set up communication channels
Last updated: July 26, 2018
Last updated: July 26, 2018

An overview of the tasks involved in setting up communication channels.

Before you begin

Role required: admin

About this task

Customers interact with customer service agents using several different communication
channels, including web, email, chat, phone, and social media. Each channel requires some
setup and configuration.

Procedure
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1. Set up the desired Customer Service web channel. This is a web interface that your
company can use to provide information and support to customers.

• Two versions of the customer portal are available: the Customer Service Portal,
which is based on the Service Portal application and requires the Customer Service
Portal plugin (com.glide.service-portal.customer-portal), and the customer portal,
which is based on the Content Management System and is included with Customer
Service Management.

• The Consumer Service Portal is a web interface that your company can use to
provide information and support to consumers. This portal is also based on the
Service Portal application and requires the Consumer Service Portal plugin
(com.glide.service-portal.consumer-portal).

2. Set up the Customer Service email channel.
Using the email communication channel, customers can send emails to create new cases
and update current cases as well as receive email updates from customer service agents
as cases progress. Customer Service Management uses the Email Accounts application
to create and maintain email accounts. Create multiple incoming email addresses that
customers can use to communicate with customer service agents. One outgoing email
address can also be created.

• Set email communication channel properties.
• Configure one or more email addresses.
• Configure an email address for a product.
• Configure an email subject line prefix.

3. Set up the Customer Service chat channel.
The chat communication channel uses the Connect Support feature to provide chat
capability from the Customer Service Portal and Consumer Service Portal. You can also
enable Virtual Agent to create or use predefined chatbot topics (conversations) for your
users.

• Configure the customer service chat queue.
• Add an agent to the chat support assignment group.
• Activate Virtual Agent for CSM

4. Set up the Customer Service phone channel.
External customers can also reach out to customer service agents using the phone
communication channel. Customer Service Management uses both Computer Telephony
Integration (CTI) and OpenFrame to provide phone support for customers, as well as the
Notify application and the Twilio Voice product.

OpenFrame is included with Customer Service Management. The CTI Softphone plugin
(com.snc.cti) and the Customer Service CTI Demo Data
(com.snc.customerservice_cti_demo) plugin must be activated separately. The Notify
plugin (com.snc.notify) is activated as part of the CTI Softphone plugin.

• Set up the phone communication channel.
• Associate a phone number with a workflow.
• Create an OpenFrame configuration.

5. Set up the social media integration feature to support case resolution through social
media channels.

• Create a social media profile for an account, contact, or consumer.
• Create a social media log entry for a case.

• Customer service web channel

Customers can use a web-based portal to search for information about a question or
issue or to request assistance from a customer service agent.

• Customer service email channel

August 6, 2018 ©2018 ServiceNow. All rights reserved. 47

ServiceNow | Customer Service Management

https://docs.servicenow.com/bundle/london-customer-service-management/page/product/customer-service-management/task/../../../administer/notification/task/t_ConfigureAnEmailAccount.html


Customers can send emails to create new cases and update current cases. They can also
receive email updates from customer service agents as cases progress.

• Customer service chat channel

Customers can use the chat channel to communicate with a customer service agent.

• Customer service phone channel

External customers can reach out to customer service agents by phone.

• Social media integration

Support case resolution through social media communication channels.

Customer service web channel

Last updated: July 26, 2018
Last updated: July 26, 2018

Customers can use a web-based portal to search for information about a question or issue
or to request assistance from a customer service agent.

The customer portal is a web interface that your company can use to provide information
and support to customers. The default portal provides a basic format to interact with users.
Customize the portal and employ the components that meet your customer needs. It
includes the following features:

• A header with links for different customer or consumer activities.
• A search feature that customers or consumers can use to search for information from

several repositories.
• Links to information sources such as the knowledge base, the user community, and

customer support.

Different versions of the customer portal are available:

• The customer portal is based on the Content Management System (CMS) and is available
with the Customer Service Management application.

• The Customer Service Portal is based on Service Portal and requires the Customer Service
Portal plugin (com.glide.service-portal.customer-portal).

• The Consumer Service Portal is also based on the Service Portal and provides self-service
capability to consumers. It requires the Consumer Service Portal plugin (com.glide.service-
portal.consumer-portal).

• Customer portal

The customer portal is a web interface based on the ServiceNow Content Management
System (CMS).

• Customer Service Portal

The Customer Service Portal is a web interface that is based on the ServiceNow Service
Portal application.

• Consumer Service Portal

The Consumer Service Portal is a web interface that your company can use to provide
information and support to consumers.

• Web-based portal features
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The web-based portal home pages have several useful features including a header with
links, a search feature, and information sources such as the knowledge base and
community.

• Limit knowledge base access to internal users

Access to the information in a knowledge base can be limited to internal users.

Related Concepts

• Content Management System

• Service Portal

Customer portal

Last updated: July 26, 2018
Last updated: July 26, 2018

The customer portal is a web interface based on the ServiceNow Content Management
System (CMS).

Use the customer portal to provide information and support to your customers.

Note:  The Customer Service Portal, which is based on the ServiceNow Service
Portal, is also available.

Customer portal

Customers can use the portal to:
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• Search the knowledge base for information that is relevant to an issue.
• Engage the community, reach out to other users, and ask questions.
• Create a case for an issue or a problem.
• View and manage current user-created cases.
• View asset and product information.
• View or update information in their user profile.
• Update notification preferences.
• Change a password or request a new password.

In addition, customer administrators can also use the portal to:

• Create a new contact.
• Create a login for a new contact.
• Enable or disable a contact login.
• Reset a password for a contact.
• Assign a user role to a contact.
• Assign a contact to an asset.
• View and update customer contact information.
• Approve registration requests.

Customizing the customer portal

To customize this portal, navigate to Content Management > Sites and click Customer
Service. See Content Management System for more information about creating a custom
interface.

Related Concepts

• Content Management System

• Customer Service Portal

Customer Service Portal

Last updated: July 26, 2018
Last updated: July 26, 2018

The Customer Service Portal is a web interface that is based on the ServiceNow Service
Portal application.

Use the Customer Service Portal to provide information and support to your customers.

Note:  A version of the portal based on the ServiceNow Content Management
System (CMS) is also available.
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Customer Service Portal

The Customer Service Portal includes much of the same functionality available on the CMS
version of the customer portal and adds several features.

The Customer Service Portal header includes the Notification link.

• Click this link to list the items that require action in a dropdown menu. These items can
include cases awaiting additional information, resolved cases awaiting customer response,
portal registration requests, and unread publications.

• Click an item in the list to display the information for that particular item. For example,
clicking a registration request displays the Approval form.

• Click View all notifications to display the Notification page, which lists the items that
require action by category.

The Customer Service Portal header includes the Live Chat link which customers can click to
open a chat window.

Registration requests appear under the Notification link.

Access profile information for the currently logged in user by clicking the user name and
selecting Profile.

Log out by clicking the user name and selecting Logout.
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Customizing the Customer Service Portal

To customize this portal, navigate to Service Portal > Portals and click Customer Service
Portal. See Service Portal for more information about creating a custom interface.

Related Concepts

• Content Management System

• Customer portal

Consumer Service Portal

Last updated: July 26, 2018
Last updated: July 26, 2018

The Consumer Service Portal is a web interface that your company can use to provide
information and support to consumers.

The Consumer Service Portal is based on the ServiceNow Service Portal application.
Consumers can use the portal to search for information, get their questions answered by
other registered members, or request assistance from a customer service agent.

Consumer Service Portal

From the Consumer Service Portal, consumers can:

• Search for information, browse knowledge articles, and engage with the community.
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• Start a chat session with a customer service agent
• Register, create a login, and create a user profile.

After registering and logging in to the Consumer Service Portal, consumers can:

• Edit user profile information and change passwords.
• Register new products and view a list of currently registered products.
• Contact a consumer service agent about a question or issue.
• Create cases and view a list of current cases.
• Accept or reject proposed case solutions.

Customizing the Consumer Service Portal

To customize this portal, navigate to Service Portal > Portals and click Consumer Service
Portal. See Service Portal for more information about creating a custom interface.

Web-based portal features

Last updated: July 26, 2018
Last updated: July 26, 2018

The web-based portal home pages have several useful features including a header with links,
a search feature, and information sources such as the knowledge base and community.

Customer Service Portal header

The header on the Customer Service Portal home page includes several useful customer
links.

Customer Service Portal header
Item Description
Create Case Opens a Create Case form.

If the Customer Service Management for Orders
plugin (com.snc.csm.order) is installed, customers
can choose to create cases for products or
orders.

Cases Opens a list of cases belonging to the current
user.

For users with the sn_customerservice.customer
or sn_customerservice.customer_admin roles, this
list includes the following columns:

• Case
• Product
• Priority
• State
• Updated

For users with the sn_customerservice.partner or
sn_customerservice.partner_admin roles, the
Account column is also displayed.

Assets Opens a list of assets belonging to the current
user's account.
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Item Description
Contacts Opens a list of contacts belonging to the current

user's account. This item is available in the header
with the sn_customerservice.customer_admin
and sn_customerservice.partner_admin roles.

Approvals Opens a list of registration requests. This item is
available in the header for users with the
sn_customerservice.customer_admin role.

Publications Opens a list of publications available for
customers. This item is available in the header
when the Targeted Communications plugin
(com.sn_publications) is activated.

Notifications Lists the items that require action in a dropdown
menu, including cases awaiting additional
information, resolved cases awaiting customer
response, portal registration requests, and unread
publications. This link appears only when
customer action is required.

Live Chat Initiates a chat session with a customer service
agent.

[Current user name] Provides a menu with the following options:

• Profile:
• Logout: logs out the current customer.

Redirects to the contact information for the
current user.

Consumer Service Portal header

The header on the Customer Service Portal home page includes several useful customer
links.

Consumer Service Portal header
Item Description
Get Help Opens a form in which the consumer can enter a

subject, select a product, and submit a request
for assistance.

Cases Displays a list of cases belonging to the current
consumer. This list includes the following
columns:

• Number
• Short description
• Priority
• State
• Updated

Products Provides a menu with the following options:

• Register Product: opens a form for registering a
new product.

• My Products: displays a list of products
belonging to the consumer.

August 6, 2018 ©2018 ServiceNow. All rights reserved. 54

ServiceNow | Customer Service Management



Item Description
Publications Opens a list of publications available for

consumers. This item is available in the header
when the Targeted Communications plugin
(com.sn_publications) is activated.

Live Chat Initiates a chat session with a customer service
agent.

[Current consumer name] Provides a menu with the following options:

• Profile: opens the user profile form.
• Logout: logs out the current consumer.

Portal search

Customers and consumers can use the search feature on the web-based portal home page
to search for information related to one or more keywords. The search feature is located
directly below the portal header. Enter one or more keywords in the search field and click
Search or press the Enter key. The search results page returns information from several
sources, including the knowledge base and the community.

For the Customer Service Portal, the search results can also include related cases. The cases
returned in the search results depend on the user role.

Role Cases Returned
sn_customerservice.customer Cases created by this user, as well as cases

created on behalf of this user by the customer
administrator, partner, or partner administrator.

sn_customerservice.customer_admin Cases created by this user, cases created on
behalf of this user by the partner administrator,
and cases related to this user's account.

sn_customerservice.partner Cases created by this user, as well as cases
created on behalf of this user by the partner
administrator. Results also include any related
cases belonging to this partner's customer
accounts.

sn_customerservice.partner_admin Cases created by this user, cases created for the
partner's account, and any related cases
belonging to this partner's customer account.

Portal information sources

The main section of the web-based portal home page provides information from, and links
to, the knowledge base, the community, and the customer support organization.

The Knowledge section displays a list of the top knowledge articles. Click an article to
display the information or click the section header to access the Knowledge home page.
From here, you can select a knowledge base category and browse the related articles.

The Ask the Community section displays trending community topics. Click a topic to display
the information or click the section header to post a question to the community.

The Get Help section displays a list of the most viewed articles. Click an article to display the
information or click the section header to create a new case.
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Note:  By default, the information in the knowledge base is available to internal and
external users. If necessary, access to knowledge base topics can be limited
to internal users.

Limit knowledge base access to internal users

Last updated: July 26, 2018
Last updated: July 26, 2018

Access to the information in a knowledge base can be limited to internal users.

Before you begin

Role required: admin

About this task

The articles in a knowledge base are available to both internal users , such as customer
service agents, and to external users (customers and partners). If the articles in a knowledge
base are intended for internal users only, the system administrator can restrict access by
customizing the knowledge base form.

Procedure

1. Navigate to Knowledge > Administration > Knowledge Bases.
2. Click the desired knowledge base.
3. Right-click the form header and select Configure > Related Lists.
4. Select Cannot Contribute from the Available column and move it to the Selected

column.
5. Click Save.
6. On the selected knowledge base form, click the Cannot Contribute related list.
7. Click Edit.
8. Click All Customer Contacts in the left column and move it to the right column.
9. Click Save.

Customer service email channel

Last updated: July 26, 2018
Last updated: July 26, 2018

Customers can send emails to create new cases and update current cases. They can also
receive email updates from customer service agents as cases progress.

Setting up the email channel

Customer Service Management uses the Email Accounts application to create and maintain
email accounts. The system administrator can create multiple incoming email addresses that
customers can use to communicate with customer service agents. The system administrator
can also create one outgoing email address.

After the incoming and outgoing email addresses are created, the system administrator can
set these properties for the email communication channel:

• Establish one of the incoming email addresses to automatically create a case.
• Enable a prefix to include in the subject line of an email to any of the incoming email

addresses that automatically creates a case.
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• Create cases for customers who are not currently in the system.

The system administrator can also create a channel configuration to associate any of the
incoming email addresses with specific products.

Creating, viewing, and updating cases

Customers can create a new case by sending an email to a designated address. They can
also create a new case for a specific product by sending an email to a designated address
and including the product name in the subject line. Or, if a channel configuration has been
created, customers can send an email to a designated address regardless of the information
included in the subject line.

After submitting a case, the customer receives a confirmation email with the assigned case
number and a link to the Case form. When an agent updates a case, the customer receives
an email with the details.

Customers can update an existing case in the following ways:

• By replying directly to an email from a customer service agent.
• By creating an email and including the Case: prefix followed by the case number in the

subject line. For example, Case:CS0000011.

Note:  If the case number in the subject line is incorrect, a new case is created.

Accepting and rejecting solutions

When an agent proposes a solution to a case, the customer receives an email with
instructions for accepting or rejecting the solution. The customer can reply and include
Accept or Reject in the first line of the email, or the customer can click the Accept or Reject
link in the email.

When an agent closes a case, two emails are sent to the customer: the first states that the
case has been closed and the second provides a link to a customer satisfaction survey.

Note:  If a customer accepts a solution or closes a case from the Customer Service
Portal, they are automatically routed to the survey. They do not receive the
survey email.

• Configure an email address for a product

Users with the system administrator role can configure an email address that creates a
case for a specific product.

• Configure an email subject line prefix

Users with the system administrator role can configure a prefix to include in an email
subject line that creates a case.

• Customer service email properties

Users with the system administrator role can set several properties for the Customer
Service Management email communication channel.
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Related Concepts

• Email accounts

Configure an email address for a product

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the system administrator role can configure an email address that creates a case
for a specific product.

Before you begin

Role required: admin

About this task

Create a configuration that links a product to a specific email address. This configuration is
created in the Channel Configuration (sn_customer_service_channel_config) table.

Procedure

1. Navigate to Customer Service > Administration > Channels.
2. Click New.
3. Fill in the fields, as appropriate.

Channel Configurations form
Field Description
Name The name of the email configuration.

Channel Type This field displays the Email configuration type.

Product The product model associated with this email
configuration.

Active The check box to activate the email
configuration.

Email address The email address for this configuration. Enter
one of the incoming email addresses that the
system administrator created using the Email
Accounts application.

4. Click Submit.

Configure an email subject line prefix

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the system administrator role can configure a prefix to include in an email subject
line that creates a case.

Before you begin

Role required: admin
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Procedure

1. Navigate to Customer Service > Administration > Properties.
2. In the Email subject prefix format for new case field, enter the prefix.

The default prefix is Case:.
3. Click Save.

Customer service email properties

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the system administrator role can set several properties for the Customer Service
Management email communication channel.

After creating the incoming and outgoing email addresses that customers use to
communicate with customer service agents, the system administrator can set the following
email-specific properties. Navigate to Customer Service > Administration > Properties to
access these properties.

Customer Service Management email properties
Property Definition
Case email address
[glide.cs.email.case_queue_address]

One of the incoming email addresses that
automatically creates a customer service case.
For incoming email, the system checks the
address to see if it matches the address in the
Case email address property. If yes, the system
creates a customer service case. If it does not
match, or if this property is not set, the system
then checks the Email subject prefix format for
new case property.

Email subject prefix format for new case
[glide.cs.email.new_case_prefix]

The prefix included in the subject line of an email
to any of the incoming email addresses that
automatically creates a customer service case.
Case: is the default prefix.

Create case for non matched user
[sn_customerservice.email.create_case_for_non_matched_user]

Enable the creation of new customer service
cases when emails are received from users with
email addresses that do not currently exist in the
system.

Customer service chat channel

Last updated: July 26, 2018
Last updated: July 26, 2018

Customers can use the chat channel to communicate with a customer service agent.

The chat communication channel uses the ServiceNow Connect Support feature to provide
chat capability. You can also enable Virtual Agent to create or use predefined chatbot topics
(conversations) for your users. The user always has the option of switching to a live agent.

The Customer Service Portal and Consumer Service Portal include a chat icon that
customers can click to open a chat window and start a discussion with a customer service
agent.
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The chat request from the customer is either routed to a virtual agent or to an available
agent with the required skill set. The agent can respond to the customer and, if necessary,
create a new case or link the discussion to an existing case.

Agents must be added to the Customer Service chat support assignment group before they
can receive chat requests. This assignment group is used by the Customer Service chat
queue to route the chat requests.

If a case is created as the result of a chat, the customer can find the case by clicking My
Cases on the customer service portal and viewing the case list. The customer service agent
can also link a chat discussion to an existing case. Details from the chat discussion are
copied to the case form and appear in the Activity field.

For more information, see Connect Support and Activate Virtual Agent for CSM.

• Configure the customer service chat queue

Define the customer service agents, default chat messages, schedule, and escalation path
for the customer service chat queue.

• Add an agent to the chat support assignment group

Agents must be added to the chat support assignment group before they can receive
chat requests. This assignment group is used by the Customer Service Management chat
communication channel to route chat requests.

• Activate Virtual Agent for CSM

Activate Virtual Agent for CSM to use the predefined Customer Service Virtual Agent
topics (chatbot conversations) designed to help your customers complete common self-
service tasks.

• Customer Service Virtual Agent conversations

Use the prebuilt Customer Service Virtual Agent chatbot conversations designed to help
your customers complete common self-service tasks, such as getting help with a product
or checking the status of a case.

Configure the customer service chat queue

Last updated: July 26, 2018
Last updated: July 26, 2018

Define the customer service agents, default chat messages, schedule, and escalation path
for the customer service chat queue.

Before you begin

Role required: admin

About this task

The Customer Service Management chat communication channel uses the ServiceNow
Connect Support feature.
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Set up chat queue

Procedure

1. Navigate to Collaborate > Administration > Queues.
2. Select Customer Service from the Chat Queues list.
3. Fill in the fields, as appropriate.

Chat Queue form
Field Description
Name Name of the queue.

Active Not used in Connect.

Assignment group User group that contains the support staff for
the queue. Any user in the group can view the
queue in the Connect sidebar and accept chats.
No other users can access the queue. This field
must be populated.

Average wait time Average time it takes for an agent to accept a
chat in the queue. This value is automatically
calculated. Do not manually edit.

Confirm problem Not used in Connect.

Escalate to Different queue to which an agent can escalate
a chat. For example, there is a queue for high
priority support chats. When a queue is defined
in this field, agents can access the Escalate
option in conversations.

Initial agent response Message that users see when an agent accepts
their chat. For example, Thank you for
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Field Description
contacting support. We are looking into your
question now and will be with you shortly.

Not available Message that users see when they attempt to
start a chat outside the defined queue
Schedule. You can use HTML to format the
message and include links or media.

Question Initial phrase that users see when they start a
new chat in the queue. For example, How can I
help you?

Schedule Schedule that defines when the queue is
available. Leave the field blank to make the
queue available all the time. Users cannot start
a new conversation in the queue outside the
schedule hours.

4. Click Submit.

Related Concepts

• Connect Support

Add an agent to the chat support assignment group

Last updated: July 26, 2018
Last updated: July 26, 2018

Agents must be added to the chat support assignment group before they can receive chat
requests. This assignment group is used by the Customer Service Management chat
communication channel to route chat requests.

Before you begin

Role required: sn_customerservice_manager or admin

Procedure

1. Navigate to User Administration > Groups.
2. Select Customer Service Support.
3. In the Group Members related list, click Edit.
4. Select the agents that you want to receive chat requests, and move them to the

Customer Service Support group members list.
5. Click Save.

Related Concepts

• Connect Support

Activate Virtual Agent for CSM

Last updated: July 26, 2018
Last updated: July 26, 2018
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Activate Virtual Agent for CSM to use the predefined Customer Service Virtual Agent topics
(chatbot conversations) designed to help your customers complete common self-service
tasks.

Before you begin

The Virtual Agent plugin (com.glide.cs.chatbot) must be activated. If Virtual Agent is not
currently activated, contact ServiceNow to activate it.

Role required: admin

Procedure

Activate the Customer Service Virtual Agent Conversations plugin
(com.sn_csm.virtualagent) to access the predefined Customer Service topics.

Customer Service Virtual Agent conversations

Last updated: July 26, 2018
Last updated: July 26, 2018

Use the prebuilt Customer Service Virtual Agent chatbot conversations designed to help
your customers complete common self-service tasks, such as getting help with a product or
checking the status of a case.

A conversation topic defines the dialog between the Virtual Agent (chat support bot) and
the user to accomplish a specific goal. The information exchanged during the conversation
flow (user inputs and bot responses) enables the chatbot to fulfill a user request or assist a
user in completing a task.

Virtual Agent must be activated before you can use the Customer Service Virtual Agent
conversation topics.

1. Review the Customer Service topics in Virtual Agent Designer. This step requires the
virtual_agent_admin role.

2. To use any of the CSM topics, publish them in Virtual Agent Designer so that your users
can run the topics in your chat support client. This step requires the
virtual_agent_admin role.

The predefined Customer Service topics include:

• Check Case Status
• Get Help with a Product
• Get Help with an Order

For details on creating your own chatbot topics, see Virtual Agent Designer.

Check Case Status

With this topic, the user can check the status of a case by searching for the case number or
short description or selecting a case from a list. The chatbot displays information about the
case, including:

• Case number (click the link to display the case details in the Customer Service Portal or
Consumer Service Portal)

• State
• Priority
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• The product and asset or the order number
• Short description
• The last comment added to the case

The user can add comments or attach files to the case. The user can also ask to chat with a
live agent.

Get Help with a Product

With this topic, the user can create a case for a product by entering one or more keywords
about a question or issue. The chatbot returns a list of related knowledge articles and the
user can check if any of the information is helpful. If not, user can create a case for a product
with a short description. The user can associate the case with a product and asset, provide
comments, and attach files. The user can also ask to chat with a live agent.

Note:  If the Communities (com.sn_communities) plugin is activated, the chatbot
can also return a list of answered Community questions.

Get Help with an Order

With this topic, the user can create a case for an order by entering one or more keywords
about the order or by selecting the order from a list. The chatbot returns a list of related
Knowledge articles and the user can check if any of the information is helpful. If not, the user
can create a case for an order with a short description. The user can provide comments and
attach files. The user can also ask to chat with a live agent.

Note:  If the Communities (com.sn_communities) plugin is activated, the chatbot
can also return a list of answered Community questions.

Related Topics

• Virtual Agent

• Virtual Agent Designer

Customer service phone channel

Last updated: July 26, 2018
Last updated: July 26, 2018

External customers can reach out to customer service agents by phone.

The Customer Service Management application uses both Computer Telephony Integration
(CTI) and OpenFrame to provide phone support for customers.

CTI provides a way to integrate the Now Platform with the VoIP telephony provider Twilio to
support inbound and outbound calls, enabling users to exchange and collect information.
With this integration, customer service agents can place and accept calls from customers,
quickly identify customers and account information, and capture case-related information.

Note:  The CTI integration with the Twilio Voice product requires activation of the
Notify plugin.

OpenFrame is a tool that enables CTI capability with third-party telephony service providers.
OpenFrame provides a communication frame that agents use to place and receive customer
calls.
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• Phone installation and configuration

Before the phone communication channel between customer service agents and external
customers can be used, the Notify, CTI Softphone, Customer Service Management, and
Openframe plugins must be activated and configured, and a Twilio Voice account must be
set up.

• Computer telephony integration (CTI) overview

Computer Telephony Integration (CTI) enables the Customer Service application to
support inbound and outbound telephone calls.

• OpenFrame overview

OpenFrame provides a communication frame that customer service agents use to place
and receive customer calls.

Related Concepts

• Notify

Phone installation and configuration

Last updated: July 26, 2018
Last updated: July 26, 2018

Before the phone communication channel between customer service agents and external
customers can be used, the Notify, CTI Softphone, Customer Service Management, and
Openframe plugins must be activated and configured, and a Twilio Voice account must be
set up.

Before you begin

Role required: admin

Procedure

1. Activate the Notify plugin (com.snc.notify).
2. Set up a Twilio Voice account.

You can create an account at https://www.twilio.com.
3. Configure Notify to use the Twilio Voice service.
4. Activate the CTI Softphone plugin (com.snc.cti).

If you want to load the demo data for CTI Softphone, you must also activate the
Customer Service CTI Demo Data plugin (com.snc.customerservice_cti_demo). This
demo data includes sample workflows.

5. Activate the Customer Service plugin (com.sn_customerservice).
6. Activate the Openframe plugin (com.sn_openframe).

Activating the Customer Service Management plugin automatically activates the
Openframe plugin.

7. Create an OpenFrame configuration or use the default CTI configuration by enabling the
Default field.

Computer telephony integration (CTI) overview

Last updated: July 26, 2018
Last updated: July 26, 2018
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Computer Telephony Integration (CTI) enables the Customer Service application to support
inbound and outbound telephone calls.

The CTI Softphone plugin enables softphone functions and call center capabilities. This
plugin provides integration between the ServiceNow platform and the Twilio Voice service
using the Notify application. This plugin can be activated any time after activating Notify.

The CTI Softphone plugin includes one OpenFrame configuration, called CTI. This
configuration specifies the necessary OpenFrame window settings as well as the URL to be
launched within OpenFrame.

Note:  The included CTI configuration does not have the Default field enabled. You
must enable this field to use the CTI configuration as the default.

Customer service agents can do the following with CTI:

• Make an outgoing call to a phone number.
• Receive an incoming call from a phone number or from another user within the system.
• Transfer a call to another user within the system.
• Place a call on hold or on mute.
• Set their availability status.

CTI does not require any specific user role except the OpenFrame user
(sn_openframe_user) role. Roles are based on the application using CTI.

• CTI integration with the Case form

Activating the CTI Softphone plugin enables call-related features on the Case form.

• CTI integration with case routing

An incoming call from a customer contact or a consumer can be routed to an available
customer service agent.

• CTI integration with tasks

The CTI Softphone component can be integrated with other task entities on the Now
Platform.

• Associate a phone number with a workflow

You can associate a Notify phone number with a workflow.

Last updated: July 26, 2018
Last updated: July 26, 2018

Activating the CTI Softphone plugin enables call-related features on the Case form.

The customer service or consumer service agent can use the phone icon next to the Contact
and Consumer fields on the Case form to make a phone call. The phone icon appears next to
these fields if the entity record has at least one phone field (ph_number) and at least one of
those phone fields contains a phone number.

The phone icon is a reference contribution that can be added to any reference field by
modifying the dictionary and adding the following attribute:
ref_contributions=show_phone_customer_service.

For more information, see Configure the related incidents icon.
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Click the phone icon to place a call to a consumer or a contact.

• If only one phone field is populated, a call is placed to that number.
• If more than one phone field is populated, a dialog box displays the available numbers.

Click the desired number to place the call and close the dialog box.

Select Phone Number dialog box

Incoming and outgoing calls are logged in the Phone Log [sn_openframe_phone_log] table.
Call details are recorded in the Activity field on the Case form and in the Phone related list.

Last updated: July 26, 2018
Last updated: July 26, 2018

An incoming call from a customer contact or a consumer can be routed to an available
customer service agent.

Similar to the other communication channels, incoming calls from customer contacts and
consumers can be routed to a specific agent by using matching rules. If an agent is not
available, the call can be placed in a queue. After the agent is free, the matching call in the
queue with the longest wait time is rerouted to the agent.

Case routing is enabled as an activity in a workflow. In the Call Center demo workflow
(available with the Customer Service CTI Demo Data plugin), a call is forwarded to an agent
after the caller either creates a new case or enters a valid number for an existing case.

If no agents are available, the call goes into a queue and remains there until an agent
becomes available. If a call is in the queue for longer than 10 minutes, it is forwarded to voice
mail and the caller is asked to leave a message.

Related Concepts

• Notify workflow activities

Related Reference

• Create rules to route and assign customer service cases

Last updated: July 26, 2018
Last updated: July 26, 2018

The CTI Softphone component can be integrated with other task entities on the Now
Platform.

A workflow can be implemented to operate on the Incident table.

Note:  The Call Center for Incident Management workflow, a demo workflow, is
available with the Customer Service CTI Demo Data plugin.
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Incoming or outgoing calls are logged in the Phone Log [sn_openframe_phone_log] table.
The call logs also appear in the activity history of the task.

Last updated: July 26, 2018
Last updated: July 26, 2018

You can associate a Notify phone number with a workflow.

Before you begin

You must create a Twilio Voice account and configure Notify with Twilio Voice before you
can associate a phone number with a number group and workflow.

A number group allows you to group Notify phone numbers and then share workflows
across grouped numbers. For each number group, you can specify a workflow for incoming
and outgoing calls.

The CTI Softphone demo data includes these sample workflows:

• Call Center, for use with the Customer Service Management application
• Call Center for Incident Management

The Call Center workflow uses several Notify workflow activities that determine workflow
functionality. Each activity performs a different task, such as playing a message greeting or
creating a list of user input options. Activities can succeed or fail, which can result in actions
performed by other activities.

You can use the default Call Center workflow or modify this work flow as needed.

Role required: admin

Procedure

1. Navigate to Notify > Numbers.
2. From the Notify Phone Numbers list, click the phone number that you want to edit.
3. Select a Notify Group that uses the incoming call workflow that you want to handle this

phone number.
The CTIDemo group uses the Call Center workflow for incoming calls.

4. Click Update.

Related Tasks

• Configure Notify with the Twilio service

Related Concepts

• Numbers and number groups

• Notify workflow activities

OpenFrame overview

Last updated: July 26, 2018
Last updated: July 26, 2018
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OpenFrame provides a communication frame that customer service agents use to place and
receive customer calls.

Communication partners can use OpenFrame to integrate telephony systems into the Now
Platform. The OpenFrame API can be used to communicate between the Now Platform and
the domain opened in the OpenFrame window.

OpenFrame has these components:

• TopFrame, a ServiceNow application.
• OpenFrame API, which gets sourced from the partner application. This API communicates

with TopFrame and controls the OpenFrame visual features. The location of the API is
https://[servicenow instance]/scripts/openframe/1.0.1/openFrameAPI.min.js. This minified
version includes other needed libraries and should be used for integration. For API
reference, you can use the un-minified version: https://[servicenow instance]/scripts/
openframe/1.0.1/openFrameAPI.js. This version cannot be used directly for integration
purposes.

OpenFrame provides a window that users can:

• Access by clicking the phone icon in the ServiceNow banner frame or next to the Contact
or Consumer fields on the Case form. This icon is configurable by users with the admin
role. For more information, see CTI integration with the Case form.

• Hide by clicking the X in the OpenFrame window header. The window remains on top of
other forms or pages until hidden.

• Move by clicking the window header and dragging to a new location.

Users with the admin role can use the OpenFrame configuration to specify the OpenFrame
window settings. This configuration stores information about the OpenFrame window,
including the height and width, as well as the icon, title, and subtitle to use in the window
header.

Users with the admin role can also select user groups for an OpenFrame configuration.
Access to the configuration is limited to the users with the openframe user role that belong
to the selected groups.

• Create an OpenFrame configuration

This configuration specifies the OpenFrame window settings as well as the URL to be
launched within OpenFrame.

• Answer an incoming call

Use the OpenFrame window to answer an incoming call.

• Make an outgoing call

Use the OpenFrame window to make an outgoing call.

• Transfer a call

After accepting an incoming call, a customer service agent can transfer a call to another
agent.

• Set agent call status

Customer service agents can set their current call status.

• openFrameAPI - Global
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OpenFrame is an omni-present frame that communication partners can use to integrate
their systems into the ServiceNow platform.

Related Concepts

• openFrameAPI - Global

Last updated: July 26, 2018
Last updated: July 26, 2018

This configuration specifies the OpenFrame window settings as well as the URL to be
launched within OpenFrame.

Before you begin

Role required: admin

About this task

As part of the OpenFrame configuration, users with the admin role can select one or more
user groups. Access to the configuration is limited to the users that have the openframe user
role and that belong to the selected groups.

Procedure

1. Navigate to System Properties > OpenFrame to display the OpenFrame Configurations
list.

2. Click New.
3. Fill in the fields, as appropriate.

OpenFrame Configuration form
Field Description
Name The name of the OpenFrame configuration.

Title The title that appears in the OpenFrame
window header.

Subtitle The subtitle that appears in the OpenFrame
window header.

Order The order number for the configuration.

If users have multiple OpenFrame
configurations, they can only access the
configuration with the lowest order number.

Note:  When upgrading, the Order
field for the existing default
OpenFrame configuration is set
to 1.

User Group The user groups selected for this configuration.
Access to this configuration is limited to the
users that have the openframe user role and
that belong to the selected groups.

August 6, 2018 ©2018 ServiceNow. All rights reserved. 70

ServiceNow | Customer Service Management



Field Description

Note:  If you do not select any groups,
the configuration is available to
all users with the openframe
user role.

URL The URL to be launched within OpenFrame.
This URL can be an absolute path or a path
that is relative to the ServiceNow instance.

Active Denotes this configuration as active.

Width The width of the OpenFrame window.

Height The height of the OpenFrame window, not
including the OpenFrame header height.

Icon Class The class of icons used for the OpenFrame
window (retina-icons.css).

Title Icon The icon displayed on the OpenFrame window
header.

Configuration Can be used to store any JSON encoded string.

Note:  Several fields on the OpenFrame Configuration form can also be set by
using the OpenFrame API. These fields include: Title, Subtitle, Width,
Height, and Title Icon.

4. Click Submit.

Related Concepts

• openFrameAPI - Global

Last updated: July 26, 2018
Last updated: July 26, 2018

Use the OpenFrame window to answer an incoming call.

Before you begin

Role required: sn_customerservice_agent, sn_customerservice.consumer_agent,
sn_open_frame, or admin

About this task

The OpenFrame window displays the incoming call, including the phone number and the
customer contact or consumer information.

Procedure

1. Click Accept.
2. When the call is finished, click End.

Last updated: July 26, 2018
Last updated: July 26, 2018
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Use the OpenFrame window to make an outgoing call.

Before you begin

Role required: sn_customerservice_agent, sn_customerservice.consumer_agent,
sn_open_frame, or admin

Procedure

1. Do one of the following:

Option Description

Click the phone icon in the banner frame. Enter the phone number in the Number field
and click Call.

Click the phone icon next to the Contact or
Consumerfields on the Case form.

Customer contacts and consumers can have
multiple phone numbers.

• If only one phone field is populated, a call
is placed to that number.

• If more than one phone field is populated,
a dialog box displays the available
numbers. Click the desired number to
place the call and close the dialog box.

2. When finished with the call, click End.

Last updated: July 26, 2018
Last updated: July 26, 2018

After accepting an incoming call, a customer service agent can transfer a call to another
agent.

Before you begin

Role required: sn_customerservice_agent, sn_customerservice.consumer_agent,
sn_open_frame, or admin

Procedure

1. Answer an incoming call.
2. Click Transfer.
3. Select an agent from the drop-down list.
4. Click Call.

Last updated: July 26, 2018
Last updated: July 26, 2018

Customer service agents can set their current call status.

Before you begin

Role required: sn_customerservice_agent, sn_customerservice.consumer_agent,
sn_open_frame, or admin

Procedure
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1. Click the phone icon in the banner frame.
2. Select your availability.

Option Description

Available The agent is available to take a call.

Not Available The agent is not available to take a call.

Busy The agent is currently on a call with a
customer.

Wrap Up The agent is updating case information after
completing a call.
After completing a call and the subsequent
wrap up, an agent must manually change the
status from Wrap Up to Available.

Last updated: July 26, 2018
Last updated: July 26, 2018

OpenFrame is an omni-present frame that communication partners can use to integrate
their systems into the ServiceNow platform.

One of the core requirements is the ability to connect and serve code from different
domains that can connect seamlessly with partner subsystems. This cross domain
connection is required to keep connections and callbacks registered into communication
systems without any cross domain issues.

OpenFrame has two significant parts: one that lives in the ServiceNow application (referred
to as TopFrame) and this API that is sourced from the partner application. This API has the
necessary methods to communicate with TopFrame and control the visual features of the
OpenFrame.

openFrameAPI - init(Object config, function successCallback,
function failureCallback)

Initialize OpenFrame, must be the first method called.

This method initializes communication to TopFrame and initializes any visual elements
passed in the config parameter.

Parameters
Name Type Description
config Object An object of key value pairs. The

possible keys are height, width,
title, subTitle, and titleIcon. All
keys are optional.

successCallback function The callback function used if the
init method succeeds. The
openframe configuration stored
in the system is passed as a
parameter to the callback
function.
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Name Type Description
failureCallback function The callback function used if the

init method fails.

Returns
Type Description
void

var config = {
height: 300,
width: 200
}
function handleCommunicationEvent(context) {
console.log("Communication from Topframe", context);
}
function initSuccess(snConfig) {
console.log("openframe configuration",snConfig);
//register for communication event from TopFrame
openFrameAPI.subscribe(openFrameAPI.EVENTS.COMMUNICATION_EVENT,
handleCommunicationEvent);
}
function initFailure(error) {
console.log("OpenFrame init failed..", error);
}
openFrameAPI.init(config, initSuccess, initFailure);

openFrameAPI - show()

Makes the OpenFrame visible in the TopFrame.

Parameters
Name Type Description
None

Returns
Type Description
void

openFrameAPI.show()

openFrameAPI - hide()

Hides the OpenFrame in the TopFrame.

Parameters
Name Type Description
None
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Returns
Type Description
void

openFrameAPI.hide()

openFrameAPI - isVisible(function callback)

Checks to see if the OpenFrame is visible in the TopFrame.

Parameters
Name Type Description
callback function The callback function receives a

parameter with a value of true
or false. True if OpenFrame is
visible and false if not visible.

Returns
Type Description
void

function callback(isVisible) {
console.log(isVisible)
}
openFrameAPI.isVisible(callback)

openFrameAPI - setTitle(String title)

Sets the OpenFrame title.

Parameters
Name Type Description
title String A string of 256 or fewer

characters.

Returns
Type Description
void

openFrameAPI.setTitle('Incoming Call');

openFrameAPI - setSubtitle(String subTitle)

Sets the OpenFrame subtitle.
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Parameters
Name Type Description
subTitle String A string of 256 or fewer

characters.

Returns
Type Description
void

openFrameAPI.setSubtitle('+18888888888');

openFrameAPI - setSize(Number width, Number height)

Sets the OpenFrame size.

Parameters
Name Type Description
width Number Should be greater than zero.

height Number Should be greater than zero.

Returns
Type Description
void

openFrameAPI.setSize(300, 370);

openFrameAPI - setTitleIcon(Object icon)

Sets the OpenFrame's title icon.

Parameters
Name Type Description
icon Object Object of key value pairs. Keys

include imageURL, imageTitle,
and any other context needed.

Returns
Type Description
void

openFrameAPI.setTitleIcon({imageURL:'/my/image/path.png', imageTitle:'mute', id:101});
openFrameAPI.setTitleIcon({imageURL:'https://mydomian.com/image/path.png',
imageTitle:'mute', id:101});

openFrameAPI - setIcons(Array icons)

The OpenFrame header can include icons that are placed next to the close icon.

August 6, 2018 ©2018 ServiceNow. All rights reserved. 76

ServiceNow | Customer Service Management



Parameters
Name Type Description
icons Array A list of icon configurations,

where each icon configuration is
an object with key values
imageURL, imageTitle, and any
other needed context.

Returns
Type Description
void

openFrameAPI.setIcons([{imageURL:'https://mydomian.com/image/mute.png',
imageTitle:'mute', id:101}, {imageURL:'https://mydomian.com/image/hold.png',
imageTitle:'hold', id:102}]);

openFrameAPI - subscribe(openFrameAPIEVENT event,
function eventCallback)

Subscribes to the event.

These events are available.

• openframe_icon_clicked -- this event occurs when any icon other than the close icon is
clicked on the OpenFrame footer. The callback receives the icon object as a parameter.
This event replaces openframe_header_icon_clicked.

• openframe_header_icon_clicked -- this event occurs when any icon other than the close
icon is clicked on the OpenFrame header. The callback receives the icon object as a
parameter. This event works but should be replaced with openframe_icon_clicked.

• openframe_shown -- this event occurs when the OpenFrame is shown.
• openframe_hidden -- this event occurs when the OpenFrame is hidden.
• openframe_before_destroy -- this event occurs before the TopFrame is unloaded.
• openframe_communication -- this event is application specific and can be customized.
• openframe_communication_failure -- this event occurs when communication to TopFrame

fails.

The openframe_header_icon_clicked is split into two events:

• openframe_icon_clicked: this event occurs when any icon other than the close icon is
clicked on the OpenFrame. The callback receives the icon object as a parameter.

• openframe_title_icon_clicked: this event occurs when the title icon is clicked on the
OpenFrame. The callback receives the titleIcon object as a parameter.

Note:  The openframe_icon_clicked event replaces openframe_header_icon_clicked,
which works currently but will be removed in a future release. Until then, you
can subscribe to either one but not both at the same time as it may execute
the callback function twice. For example, if you are using
openframe_header_icon_clicked, plan to change the code and subscribe to
openframe_icon_clicked and/or openframe_title_icon_clicked based on your
use case.
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Parameters
Name Type Description
event openFrameAPIEVENT One of the available events.

eventCallback function The method called when the
specified event occurs.

Returns
Type Description
void

function handleIconClick(context) {
console.log("Icon was clicked", context);
}
openFrameAPI.subscribe(openFrameAPI.EVENTS.ICON_CLICKED, handleIconClick);

openFrameAPI - openServiceNowForm(Object details)

Opens a form URL in TopFrame.

Parameters
Name Type Description
details Object An object of key value pairs. The

possible keys are

• entity, the table name
• query, an encoded query

string

Returns
Type Description
void

openFrameAPI.openServiceNowForm({entity:'incident', query:'sys_id=1234567'});

openFrameAPI - openServiceNowList(Object details)

Opens a list URL in TopFrame.

Parameters
Name Type Description
details Object An object of key value pairs. The

possible keys are

• entity, the table name
• query, an encoded query

string
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Returns
Type Description
void

openFrameAPI.openServiceNowList({entity:'incident', query:'active=true'});

openFrameAPI - version()

Returns the OpenFrame API version.

Parameters
Name Type Description
None

Returns
Type Description
String The OpenFrame API version

var version = openFrameAPI.version();

console.log("API version " + version);

openFrameAPI - openCustomURL(String details)

Opens a custom URL in TopFrame.

Parameters
Name Type Description
Url String A string of 2083 or fewer

characters.

Returns
Type Description
void

openFrameAPI.openCustomURL('10_cool_things.do');

Social media integration

Last updated: July 26, 2018
Last updated: July 26, 2018

Support case resolution through social media communication channels.

When working with customers or consumers to create and resolve cases, agents can select
Social as the communication channel and add a social profile to the Case form. Any
communication with customers or consumers that takes place through social media is
recorded on the Case form in the Social Logs related list.

Customer service managers can create one or more social profiles for a user by recording a
user's social profile information on a specific social media channel such as Twitter or
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Facebook. Managers can create social profiles for accounts, contacts, and consumers from
the Social Profiles related list on the entity form. Agents have read-only access to these
profiles.

Integration with Customer Service Management

The social media communication channel is integrated with the following Customer Service
Management forms: Case, Account, Contact, and Consumer.

On the Case form, the Channel field includes the Social option. Selecting this option adds
the Social Profile field to the Case form, in which you can select a specific social media
channel. The Social Logs related list captures the details of social media conversations.

The Account, Contact, and Consumer forms include the Social Profiles related list. Customer
service managers can create one or more profiles for each of these entities.

Plugins

The Customer Service Social Integration plugin (com.sn_cs_social) is activated as part of the
Customer Service Management plugin.

Tables

The Customer Service Social Media plugin adds the following tables.

Table Description
Social Channels
[sn_app_cs_social_social_channel]

Stores the social channels, which are brought in
by the social integration tool.

Social Profiles
[sn_app_cs_social_social_profile]

Stores the social profiles created for each
customer contact or consumer.

Social Logs
[sn_app_cs_social_social_log]

Stores the details of social media conversations
related to cases.

• Create a social media profile

Users with the customer service manager role can create a social media profile for an
account, contact, or consumer.

• Create a social media log entry

Users with the customer service manager role can create a social media log entry for a
case.

Create a social media profile

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the customer service manager role can create a social media profile for an
account, contact, or consumer.

Before you begin
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Role required: sn_customerservice_manager or admin

Procedure

1. Navigate to the Social Profiles related list on the desired entity form: Account, Contact,
or Consumer.

2. Click New.
3. Fill in the fields on the Social Profile form, as appropriate.

Field Definition
Channel The social media channel for this profile. For

example, Twitter or Facebook.

Social ID The user's name or handle for the selected
social media channel.

Contact If created from the Contact form, this field
displays the name of the contact.

Consumer If created from the Consumer form, this field
displays the name of the consumer.

Account If created from the Account form, this field
displays the name of the account.

Profile URL The link to the user's social media account.

4. Click Submit.

Create a social media log entry

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the customer service manager role can create a social media log entry for a case.

Before you begin

Role required: sn_customerservice_manager or admin

About this task

Only a manager or administrator can create an entry on the Social Logs related list, if
necessary. The entries on this list are typically populated by the social integration tool.

Procedure

1. Navigate to the desired Case form.
2. From the Social Logs related list, click New.
3. Fill in the fields on the Social Log form, as appropriate.

Field Definition
Social Profile The social profile for the customer contact or

consumer.

Agent The agent participating in the conversation.

Social URL The URL for the social conversation. Clicking
this URL opens the conversation in a new tab.

Document The related case number.
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Field Definition
Message The details of the conversation.

4. Click Submit.

Create rules to route and assign customer service cases
Last updated: July 26, 2018
Last updated: July 26, 2018

The case routing feature uses matching rules and assignment rules to identify customer
service cases that meet certain conditions and then route those cases to customer service
agents.

Create one or more matching rules that establish specific conditions that a case must meet
before it can be routed to an agent. Then use an assignment rule to route those cases to
agents based on product knowledge and availability. You can also invoke the
MatchingRuleProcessor API to execute the matching rules and return a list of users
(sys_ids).

Matching Rules

Matching rules are based on two defined sets of conditions, one that identifies specific case
attributes and another that identifies the agent resources best suited to handle cases with
these attributes. Matching rules are created using the Matching Rule form.

To identify case attributes, select a table that stores the task type (for example, the Case
table) and then use a condition builder to create one or more conditions that a case must
meet before being routed. For example, you can build conditions for a specific account and
product or for a specific product and priority level.

To identify an agent resource, use one of the following resource matching methods:

• Simple: select the resource name from a list of users.
• Advanced: build conditions that filter the available agent resources. These conditions can

be based on user role, agent group, specific skills, work load, or agent availability.
• Scripted: create a customized script to identify agent resources.

Another resource matching method, Selection Criteria, can be used to create a matching
rule with selected matching criteria for use with the assignment workbench.

Assignment Rules

Use assignment rules to automatically assign task to users and groups. Create an
assignment rule for a matching rule by clicking the Create assignment rule related link on the
Matching Rule form. When the matching rule conditions are met, a case can be routed to a
user or a group using the assignment rule. The assignment rule is applied only if the task is
not already assigned to another user or group.

Note:  Matching rules and assignment rules are independent records with no
synchronization. If you make a change in the Applies to component of the
matching rule, it is not reflected in the assignment rule

When you create an assignment rule, you select the following:
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• The table for the task type and the conditions that must be met before the task is
assigned.

• The user or the group to which the task is assigned.

Alternately, you can create a script to further customize the assignment rule.

• Create a matching rule for case routing

Create a matching rule for a customer service case that identifies the case attributes as
well as the agent resources.

• Create an assignment rule for case routing

Create a rule that assigns those cases that meet the matching rule criteria to a customer
service agent.

• Invoke the MatchingRuleProcessor API

After you create one or more matching rules, you can invoke the MatchingRuleProcessor
API and run the rules.

• Reverse matching

Reverse matching uses the same matching rules to match tasks to a resource rather than
resources to a task.

Related Concepts

• Assignment rules module

Create a matching rule for case routing

Last updated: July 26, 2018
Last updated: July 26, 2018

Create a matching rule for a customer service case that identifies the case attributes as well
as the agent resources.

Before you begin

Role required: admin

Procedure

1. Navigate to Routing and Assignment > Matching Rules.
2. Click New.
3. Fill in the fields on the Matching Rule form.

This form contains the following sections:
• Basic rule information
• Applies to: use this section to create rule conditions
• Resource: use this section to create agent and agent group conditions

Matching Rule form
Field Description
Name The name of the matching rule.
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Field Description
Execution order The order in which this matching rule is to be

executed. Similar to business rules, matching
rules are processed based on execution order,
from the lowest to the highest.

Active Enable this check box to activate the matching
rule.

Applies To

Table The table that stores the task for which the
matching rule is being created. The default is
the Case [sn_customerservice_case] table.

Conditions Use the buttons in this field to build one or
more conditions on the selected table. A
condition is made up of a selected field, an
operator, and a value. Add conditions using the
AND and OR buttons. Delete conditions by
clicking the X to the right of a condition.

Resource

Matching The type of resource matching method to use
for this rule: Simple, Advanced, Scripted,
Selection Criteria.

Select Simple to assign a task to a specific user.
a. Click the lookup icon next to the Resource

field.
b. Select a Table name.
c. Select a Document from the table.
d. Click OK.

Select Advanced to create a specific set of
resource conditions. Then use the condition
builder in the Resource field to identify these
conditions.

Select Scripted to create a customized script
for identifying resources, with the goal of
returning a list of users that have the same
skills as the task. The task under consideration
is set in the context of the script. For example:

//current has the task record for which the rule is being executed.
var task = current;
var skills = task.getValue("skills");
var skillUtil = new global.SkillsUtils();
var skilledUsers = skillUtil.getAllSkilledUserIds(skills);
return skilledUsers;

Select Selection Criteria to create a matching
rule for use with the assignment workbench.
Create then rule and then add matching criteria
using the Select Criteria related list on the
Matching Rule form.

Resource This field changes depending on the resource
matching type selected in the Matching field.
For Simple matching, use this field to select a
table and a user.
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Field Description
For Advanced matching, use the condition
builder in this field to build one or more
conditions to identify a resource. These
conditions can be based on user role, agent
group, specific skills, work load, or agent
availability.

Schedule based filtering This field applies to Advanced matching.
Enable this check box to filter resources that
are in schedule (work hours) at the time of
routing.

Script For Scripted matching. use this field to create a
customized script for identifying resources. An
example script is included. The expected return
from a customized script is an array of resource
sys_ids.

4. Click Submit.
The rule appears in the Matching Rules list.

5. Open the newly created rule from the Matching Rules list and add the desired matching
criteria.

6. From the Select Criteria related list, click New.
7. Select a Criterion.
8. In the Use for field, specify how you want the matching criterion to be used.

Option Description

Ranking and display Use the criterion to determine agent ranking
and displays it in a column on the workbench.

Display only Displays the criterion in a column on the
workbench but does not use it to determine
agent ranking.

Ranking only Uses the criterion to determine agent ranking
but does not display it on the workbench.

9. Select a Ranking Method.

Option Description

More is better For example, more availability is better when
determining the agent ranking.

Less is better For example, fewer assigned cases are better
when determining agent ranking.

10. Click Submit.
The criterion appears on the Matching Rule form in the Select Criteria related list.

11. (Optional) From the Select Criteria related list, set a Threshold for the criterion.
A threshold sets a minimum requirement for a criterion. If necessary, personalize the list
and add the Threshold field.

Create an assignment rule for case routing

Last updated: July 26, 2018
Last updated: July 26, 2018
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Create a rule that assigns those cases that meet the matching rule criteria to a customer
service agent.

Before you begin

Role required: admin

Procedure

1. Open the desired matching rule.
2. Click the Create assignment rule related link.

You can also create an assignment rule by navigating to Routing and Assignment >
Assignment Rule and clicking New.

3. Fill in the fields on the Assignment Rule form.

Assignment Rule form
Field Description
Name The name of the assignment rule.

Application The name of the application to which this
assignment rule belongs. The default
application is Global.

Order The order in which this assignment rule is
executed. Similar to business rules, assignment
rules are processed based on execution order,
from the lowest to the highest.

Active Enable this check box to activate the matching
rule. Only active assignment rules take effect.

Applies To

Table The table that stores the task for which the
assignment rule is being created.
This list shows only those tables and database
views that are in the same scope as the
assignment rule. If you select a custom table
that extends the task table, you must clear the
instance cache by navigating to https://
<instance_name>.service-now.com/cache.do in
order for the assignment rule to work.

Conditions The conditions in which the assignment rule will
apply.
Use the buttons in this field to build one or
more conditions on the selected table. A
condition is made up of a selected field, an
operator, and a value. Add conditions using the
AND and OR buttons. Delete conditions by
clicking the X to the right of a condition.

Assign To

User The user to be assigned to the task.

Group The assignment group to be assigned to the
task.

Script
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Field Description
Script A script to determine advanced assignment

rule functionality. Scripts provide access to
current.variable_pool variables.

4. Click Update.

Related Concepts

• Define assignment rules

Invoke the MatchingRuleProcessor API

Last updated: July 26, 2018
Last updated: July 26, 2018

After you create one or more matching rules, you can invoke the MatchingRuleProcessor API
and run the rules.

Before you begin

Role required: sn_customerservice_agent, sn_customerservice_manager, admin

About this task

The matching engine can be invoked using the processAndGetCandidates method of the
matchingRuleProcessor class. Pass in the task record and the number of resources. The
result is an array of resource sys_ids.

The matching rules are processed based on the number stored in the Execution Order field
for each rule.

The result is a list of users (sys_ids), which you can use for case routing and assignment.

Reverse matching

Last updated: July 26, 2018
Last updated: July 26, 2018

Reverse matching uses the same matching rules to match tasks to a resource rather than
resources to a task.

Before you begin

Role required: sn_customerservice_agent, sn_customerservice_manager, admin

About this task

The resource matching engine can match resources and tasks in two ways:

• Forward: matches resources for a task
• Reverse: matches tasks for a resource

The same matching rule can be used for both forward and reverse matching. In the
customer service application, you can use reverse matching to determine which call the next
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available agent should take. Reverse matching returns a list of case sys_ids instead of user
sys_ids. When using reverse matching, you can also limit the cases returned to a specific set.

The following example shows how to use reverse matching.

MatchingRuleProcessor.processAndGetCandidates(resource, taskLimit, "sn_customerservice_case", "reverse", false, [<array of cases to consider>])

• Limit the number of task sys_ids returned for reverse matching rules

Reverse matching rules return a list of case sys_ids. Limit the number of cases returned
by configuring the number in the reverse.matchingrule.entity.limit system property.

Limit the number of task sys_ids returned for reverse matching rules

Last updated: July 26, 2018
Last updated: July 26, 2018

Reverse matching rules return a list of case sys_ids. Limit the number of cases returned by
configuring the number in the reverse.matchingrule.entity.limit system property.

Before you begin

Role required: admin

Procedure

1. In the navigation filter, type sys_properties.list.
2. Search for the reverse.matchingrule.entity.limit system property.
3. In the number field, change the number of cases returned. The default number is 30.

Result

If the number of cases returned is more than the value listed in the system property, the
reverse matching rule does not run for Scripted and Selection Criteria matching rules.

Track and analyze Customer Service case data
Last updated: July 26, 2018
Last updated: July 26, 2018

Use the Service Manager homepage to track and analyze customer service case data and
agent group activities.

The Service Manager homepage displays several case-related reports, which are created
using the Reports application. The customer service agent manager can drill down into
these reports for more information about the related cases.

To view the Service Manager homepage, navigate to Customer Service > Overview.

The Customer Service Performance Analytics feature adds two more reports to the Service
Manager homepage: Case Average Response Time and Number of Open Cases. These
reports use indicators as a way to collect and measure data and breakdowns to show
different views of this data.

August 6, 2018 ©2018 ServiceNow. All rights reserved. 88

ServiceNow | Customer Service Management



Note:  Customer Service Performance Analytics is an optional feature available with
the Customer Service Management application. To use this feature, activate
the Performance Analytics - Content Pack - Customer Service plugin
(com.sn_customerservice_pa). You can activate Performance Analytics
solutions on instances that do not have Performance Analytics to evaluate
the functionality. However, to collect scores for indicators you must license
Performance Analytics.

Report Figure Description
Case Average Response Time Displays the average case

response time in a line graph for
the selected time period. The
default time period is one
month.

• Point to any location along the
line to display a summary for a
specific date.

• Click any location along the
line to the line to drill down
and see additional information
for a specific date.

Number of Open Cases Displays the number of open
cases by day in a trend graph
for the selected time period.

• Point to any bar within the
graph to display a summary
for the specific date.

• Click any bar within the graph
to drill down and see
additional information for a
specific date.

Open Cases by Assignment
Group

Displays the number of open
cases by customer service agent
group.

Open Cases by Company Displays the number of open
cases by company.
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Report Figure Description
Cases by SLA Stage Displays the number of cases by

SLA stage.

Open Cases by Priority Displays the number of open
cases by priority.

• Click a priority to show the
case list.

• Click a case from the list to
view details.

Customer Satisfaction Displays the results of the
customer satisfaction survey
that a customer is asked to take
after a case is closed.

Cases by Product Displays the number of cases for
each product.

• Use Customer Service Performance Analytics reports

The Customer Service Performance Analytics feature adds reports to the Service Manager
homepage.

• View the Customer Service Executive dashboard

The Executive dashboard provides a view of the operation and trends of the Customer
Service function for your organization.

• View the Customer Service Manager dashboard

The Manager dashboard displays charts and summary data on metrics like backlog,
resolution rates, SLA, Customer Satisfaction ratings, and per-agent KPIs.

• View the Customer Service Agent dashboard

The Agent dashboard provides quick access to your cases based on criteria that help you
to prioritize your work. The dashboard also displays charts and summary data on metrics
for your group.
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Related Concepts

• Performance Analytics indicators

Use Customer Service Performance Analytics reports

Last updated: July 26, 2018
Last updated: July 26, 2018

The Customer Service Performance Analytics feature adds reports to the Service Manager
homepage.

Before you begin

Role required: sn_customerservice_manager

About this task

These reports, Case Average Response Time and Number of Open Cases, use indicators as a
way to collect and measure data. The indicators, in turn, use breakdowns to show different
views of the collected data.

Note:  Customer Service Performance Analytics is an optional feature available with
the Customer Service Management application. To use this feature, activate
the Performance Analytics - Content Pack - Customer Service plugin
(com.sn_customerservice_pa).

Procedure

1. Navigate to Customer Service > Overview.
2. Drill down into the Case Average Response Time or Number of Open Cases reports to

see detailed information for a specific day.
3. Click the Breakdowns tab.
4. Select one of the following breakdowns from the menu:

• Case.Asset
• Case.AssignedTo
• Case.AssignmentGroup
• Case.Company
• Case.Contact
• Case.Product
• Case.State

5. The displayed data changes to match the selected view. For example, selecting
Case.AssignedTo displays the data by customer service agent.

Related Concepts

• Performance Analytics indicators

View the Customer Service Executive dashboard

Last updated: July 26, 2018
Last updated: July 26, 2018

The Executive dashboard provides a view of the operation and trends of the Customer
Service function for your organization.
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Before you begin

Role required: pa_admin or pa_viewer

Procedure

Navigate to Performance Analytics > Dashboards and then click the Customer Service
Executive tile.

Tabs on the Executive dashboard
Overview Scorecards: On some scorecards, the percentage change in the

current period appears under the total. Click the value to view details
and underlying data.

• CSAT: Average Customer Satisfaction based on CSAT survey
results. See Customer service satisfaction surveys.

• Avg. Time to Resolution: Average time for a case to be marked as
resolved by a customer.

• Open Backlog: Number of cases that are currently not resolved.

Data Trends: Summary data appears for several metrics. Click a
metric to view the underlying data.

At-Risk Accounts Top-10 accounts ranked by worst CSAT, Time To Resolution, and
Open Case Backlog.

Product Overview Top-10 products ranked by worst CSAT, Time To Resolution, and
Open Case Backlog.

Cost Information
Note:  Install the Performance Analytics — Content Pack

— Customer Service plugin to view the Cost
Information tab.

• Total Cost:
• Total Cost:
• Cost per Case - by Channel:
• Cost per Case - by Product:
• Cost per Case - by Account:

Note:  The Cost Information tab appears only if the
"Performance Analytics - Content Pack - Financial
Management for Customer Service" plugin is
installed.

Word Cloud A word cloud of most frequently used words and phrases in the
short descriptions of open cases. It provides customer service
executives with an insight into the important words and phrases
emerging from issues reported by users.

• Drill down on one or more keywords to view other words
associated with cases that contain that keyword.

• Search the word cloud for specific terms.
• Filter the word cloud by the breakdowns to focus on a particular

aspect of the data. Some breakdowns enable a secondary
selection.

• Trend line: Trend line showing the frequency of the top keywords
over time. Click and move the cursor to view the data for any date.
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• Related Records: List of cases containing the keywords you
selected from the word cloud.

Note:  The Word Cloud tab appears only if the
Performance Analytics Premium plugin
(com.snc.pa.premium.cs) is installed.

On any scorecard or list, click an entry to view details and underlying data. For example, on
the Product Overview tab, click an entry in the CSAT list:

The detailed information page opens to the Chart tab.

Chart Values of the metric as a function of time.

Breakdowns Select a Breakdown to focus on a particular aspect of the data, for
example, the Account or AssignedTo setting (assigned CS Agent). Some
breakdowns enable a secondary selection (Select an Element). For
example, if you select AssignedTo, then you can select the CS Agent to
review.

Scores Values of the metric listed over time.

Comments Enter comments as needed.

More Info Information on the data source and method of computation for the metric.

View the Customer Service Manager dashboard

Last updated: July 26, 2018
Last updated: July 26, 2018
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The Manager dashboard displays charts and summary data on metrics like backlog,
resolution rates, SLA, Customer Satisfaction ratings, and per-agent KPIs.

Before you begin

Role required: pa_admin or pa_viewer

Procedure

1. Navigate to Performance Analytics > Dashboards and then click the Customer Service
Manager tile.

Overview Scorecards

On some scorecards, the percentage change in
the current period appears under the total.

• Open Backlog: Number of cases that are
currently not resolved.

• CSAT: Average Customer Satisfaction
based on survey results. See Customer
service satisfaction surveys.

• Open Cases with Breached SLAs:
Percentage of cases that have remained
open past the time that is required by the
SLA.

• Unassigned Open Cases: Number of open
cases that are currently not assigned to a
CS Agent.

• Avg. Time to Resolution: Average time for
a case to be marked as closed or resolved.

• First Call Resolution: Number of cases that
were resolved during first contact with the
customer.

Trend summaries

• Open Case Backlog: Chart of cumulative
open cases and case age over time.

• Backlog Growth: Number of backlogged
cases for each agent over time.

Analysis • Open Backlog section: Trend chart of
backlog over time. Click and move the
cursor to view the data for any date. The
following charts display the data for the
selected date:

% Not Updated in 5 Days: Percentage
of open cases that CS Agents have
not updated in the preceding five
days.
% with Breached SLAs: Percentage of

cases that have remained open past
the time that is required by the SLA.
Avg. Re-asssignment of Open Cases

Average number of times that a
backlogged case was assigned to a
different CS agent.

• Breakdowns:
• Records:
• Resolved/Closed Cases section: Trend

chart of resolved or closed cases over
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time. Click and move the cursor to view
the data for any date. The following charts
display the data for the selected date:

Closed in Same Day: Percentage of
open cases that CS Agents have not
updated in the preceding five days.
% Re-opened at Leaset Once:

Percentage of cases that have
remained open past the time that is
required by the SLA.
% Re-asssigned Average number of

times that a backlogged case was
assigned to a different CS agent.

• Breakdowns: Select a Breakdown to focus
on a particular aspect of the data, for
example, the Account or AssignedTo
setting (assigned CS Agent). Some
breakdowns enable a secondary selection
(Select an Element). For example, if you
select AssignedTo, then you can select the
CS Agent to review.

• Records: List of all cases.

Case Spotlight List of case with State = New, Open, or
Awaiting info.

Agent Analysis Each section is a list of all CS Agents ordered
from best to worst:

• Avg. Time to Resolution: Average time for
a case to be marked as closed or resolved.

• First Call Resolution: Number of cases that
were resolved during first contact with the
customer.

• CSAT: Customer Satisfaction based on
survey results. See Customer service
satisfaction surveys.

• Agent Efficiency: A line for each Agent
shows the average time to resolution over
time.

• Avg. Time to Resolution: Trend line for the
average time to resolution over time.

Word Cloud A word cloud of most frequently used words
and phrases in the short descriptions of open
cases. It provides customer service executives
with an insight into the important words and
phrases emerging from issues reported by
users.

• Drill down on one or more keywords to
view other words associated with cases
that contain that keyword.

• Search the word cloud for specific terms.
• Filter the word cloud by the breakdowns

to focus on a particular aspect of the data.
Some breakdowns enable a secondary
selection.

• Trend line: Trend line showing the
frequency of the top keywords over time.
Click and move the cursor to view the data
for any date.

• Related Records: List of cases containing
the keywords you selected from the word
cloud.
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Note:  The Word Cloud tab appears
only if the Performance
Analytics Premium plugin
(com.snc.pa.premium.cs) is
installed.

On any scorecard or list, click an entry to view details and underlying data. For example,
on the Product Overview tab, click an entry in the CSAT list:

The detailed information page opens to the Chart tab.

Chart Values of the metric as a function of time.

Breakdowns Select a Breakdown to focus on a particular aspect of the data, for
example, the Account or AssignedTo setting (assigned CS Agent).
Some breakdowns enable a secondary selection (Select an Element).
For example, if you select AssignedTo, then you can select the CS
Agent to review.

Scores Values of the metric listed over time.

Comments Enter comments as needed.

More Info Information on the data source and method of computation for the
metric.

2. Select one of the following breakdowns from the menu:
• Case.Asset
• Case.AssignedTo
• Case.AssignmentGroup
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• Case.Company
• Case.Contact
• Case.Product
• Case.State

View the Customer Service Agent dashboard

Last updated: July 26, 2018
Last updated: July 26, 2018

The Agent dashboard provides quick access to your cases based on criteria that help you to
prioritize your work. The dashboard also displays charts and summary data on metrics for
your group.

Before you begin

Role required: pa_admin or pa_viewer

Procedure

Navigate to Performance Analytics > Dashboards and then click the Customer Service
Agent tile.

My Work tab
My Open Cases Cases assigned to me that are not resolved,

closed or canceled.

My Cases With Problems Cases assigned to me that are part of a parent
case that is assigned to a system admin.

My New Cases Cases that I have not yet responded to.

My Group's P1 Cases P1 cases that are assigned to a member of my
group.

My Group's Open Cases Cases assigned o a member of my group that are
not resolved, closed or canceled.

My KBs Created List of all KB articles that I created.

Organizational Trends tab (combined data for all agents in my group)
CSAT Average Customer Satisfaction based on survey

results. See Customer service satisfaction
surveys.

First Call Resolution Percentage of cases that were resolved during
first contact with the customer.

Avg. Time to Resolution Average time for a case to be marked as closed
or resolved.

Backlog Growth Number of backlogged cases for each agent
group over time.

On any scorecard or list, click an entry to view details and underlying data. For example, on
the Product Overview tab, click an entry in the CSAT list:
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The detailed information page opens to the Chart tab.

Chart Values of the metric as a function of time.

Breakdowns Select a Breakdown to focus on a particular aspect of the data, for
example, the Account or AssignedTo setting (assigned CS Agent). Some
breakdowns enable a secondary selection (Select an Element). For
example, if you select AssignedTo, then you can select the CS Agent to
review.

Scores Values of the metric listed over time.

Comments Enter comments as needed.

More Info Information on the data source and method of computation for the metric.

Create and resolve customer service cases
Last updated: July 26, 2018
Last updated: July 26, 2018

Customer service agents perform a variety of tasks as they work to resolve issues or
problems for customers. A case is a record that a customer service agent uses to identify
and resolve a question or an issue for an external customer.

The customer service case is the primary entity of the customer service application. An
agent creates a new case to identify a customer's question or issue and to track the
activities related to resolving the issue. An agent also uses a case to track all of the
communication to and from the customer, including the communication channels being
used.
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Case activities include any action that is taken to resolve an issue. This can include phone
calls or emails, knowledge base research, conversations with subject matter experts, and
dispatch requests to field service agents, as well as other activities.

• Create a case from the Customer Service Management application

Customer service agents and agent managers can create a case from the Customer
Service Management application.

• Create a customer service case from associated entities

Create a new case from any of the entities that can be associated with a case.

• Assign a customer service case

Assign a case to yourself or to another customer service agent.

• Respond to a customer chat request

Select a chat request from the chat queue and respond to a customer's question or
comment.

• Create a customer service case from a chat

If a customer chat results in the need to open a case, create the case directly from the
conversation.

• Resolve cases with knowledge and community content

Enable agents to resolve a case more quickly by searching for information from the
knowledge base and community and, if helpful, associating it to the case.

• Create a work order for a customer service case

Create a work order as part of the case resolution process.

• Report a knowledge gap

If you cannot find relevant articles that could help resolve a case, you can report a
knowledge gap.

• Close a customer service case

Close a case at any time, except when it is in the Resolved state.

• Customer service case form

The Case form displays detailed information about a customer issue or problem.

Create a case from the Customer Service Management application

Last updated: July 26, 2018
Last updated: July 26, 2018

Customer service agents and agent managers can create a case from the Customer Service
Management application.

Before you begin

Role required: sn_customerservice_agent, sn_customerservice_manager, or admin
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About this task

Customer service agents and agent managers can create a case from the Customer Service
Management application.

Procedure

1. Navigate to Customer Service > Cases > Create New.
You can also click New from the Customer Service Cases list or click the Create New
Case related link on several of the entity forms.

2. Fill in as many fields on the Create Case form as you can.

Create Case form (Customer Service Management application)
Field Description
Number The automatically assigned case number.

Channel The method by which the customer initiated
contact and the case was opened.

• Web (default)
• Phone
• Email
• Chat
• Social

Contact Local Time The local time of the contact assigned to the
case.
It is automatically filled according to the time
zone set on the Contact form. If no time zone is
set on the Contact form, it is filled according to
the Contact Timezone set on the case itself.

If no time zone is set on the Contact form or in
the case, the field is left blank and is read-only.

If a case is closed or canceled, the Contact
Local Time field is hidden.

Note:  Configure the form layout to
add this field to the Case form.

Contact time zone The contact time zone if the customer is
working in a different time zone for the case. It
overrides the Contact form time zone.
If no contact local time or contact time zone is
set, the instance time zone is displayed.

Once the case is created, the field is read-only.

Note:  Configure the form layout to
add this field to the Case form.

Account The name of the company associated with this
case.
If you select a contact in the Contact field, this
field is auto-filled if the account information is
available in the contact record.
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Field Description
Contact The name of the customer contact for this

case.

Product The product model of the asset. A model is a
specific version or configuration of an asset (for
example, Apple Mac Book Pro).
If you select an asset in the Asset field, this field
is auto-filled if the associated product
information is available in the asset record. A
product may be associated with multiple
assets.

Asset The asset tag number or the serial number of
the asset associated with this case.

Partner Contact The name of the partner contact for this case.
If you select a partner in the Partner field, the
list of available partner contacts is based on
this selection.

Follow the sun A check box to indicate that a case should be
handed-off for global follow-up.
If a customer enters additional comments on a
Priority 1 - Critical or a Priority 2 - High case, or
if the case is escalated, the flag is automatically
selected.

You can also manually select the check box.

The activity stream on the case form is updated
with any changes.

Note:  Enable the Follow the sun check box
on the Customer Service case form by
setting the value of the property
sn_customerservice.FTS_flag_enabled
to true. Configure the form layout to
add this field to the Case form.

Short description A brief description of the customer question,
issue, or problem.

Opened The date and time that the case was opened.

Priority The assigned priority:
• 1 - Critical
• 2 - High
• 3 - Moderate
• 4 - Low (default)

Assignment group The assigned customer service agent group.

Assigned to The assigned agent. This field displays all users
with the sn_customerservice_manager and
sn_customerservice_agent roles.
If a group is selected in the Assignment group
field, the assigned agent must belong to this
group.

Contract The contract number associated with this case.
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Field Description
If you selected an asset in the Asset field, the
Contract field displays those contracts that
include a line item for that asset.

Entitlement The service entitlement associated with this
case.
The available entitlements are filtered by the
settings in the Account, Contract, Product,
Asset, and Channel fields.

If only one entitlement is available for this case,
it is automatically added to the Entitlement
field.

Partner The name of the partner for this case.

3. Click Submit.
If available, the following information is associated with a newly created case:

• The name of the contact and the contact's company
• The product and contract details
• The SLA and entitlements

Create a customer service case from associated entities

Last updated: July 26, 2018
Last updated: July 26, 2018

Create a new case from any of the entities that can be associated with a case.

Before you begin

Role required: sn_customerservice_agent, sn_customerservice_manager, or admin

About this task

Customer service agents and managers can create a new case from any of the entities that
can be associated with a customer service case, such as accounts, products, and contracts.
These cases are created by clicking a related link from the entity form.

Service contract Navigate to Customer Service > Contracts >
Service Contracts. Select a contract and then
click the Create New Case related link. A new
case is created with the contract information
automatically filled in. Fill in the remaining
information and click Submit.

Entitlement Navigate to Customer Service > Contracts >
Entitlements. Select an entitlement and then click
the Create New Case related link. A new case is
created with the company, contract, entitlement,
and channel information automatically filled in.
Fill in the remaining information and click Submit.

Account Navigate to Customer Service > Customer >
Accounts. Select an account and then click the
Create New Case related link. A new case is
created with the account information
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automatically filled in. Fill in the remaining
information and click Submit.

Contact Navigate to Customer Service > Customer >
Contacts. Select a contact and then click the
Create New Case related link. A new case is
created with the contact and account information
automatically filled in. Fill in the remaining
information and click Submit.

Product Navigate to Customer Service > Products >
Product Models. Select a product and then click
the Create New Case related link. A new case is
created with the product information
automatically filled in. Fill in the remaining
information and click Submit.

Asset Navigate to Customer Service > Products >
Assets. Select an asset and then click the Create
New Case related link. A new case is created with
the asset and product information automatically
filled in. Fill in the remaining information and click
Submit.

Related Concepts

• Set up associated entities

Assign a customer service case

Last updated: July 26, 2018
Last updated: July 26, 2018

Assign a case to yourself or to another customer service agent.

Before you begin

Role required: sn_customerservice_agent, sn_customerservice_manager, or admin

About this task

The Assign to me button is only visible if the current user has the customer service agent
role and is not already assigned to the case.

Procedure

1. Open the desired case.
2. Assign the case to an agent.

Option Description

Assign the case to yourself. Click Assign to me.

Assign the case to another agent. Select an agent in the Assigned to field.

The agent's name appears in the Assigned to field. If the agent also belongs to an agent
group, the group name appears in the Assignment group field.
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Respond to a customer chat request

Last updated: July 26, 2018
Last updated: July 26, 2018

Select a chat request from the chat queue and respond to a customer's question or
comment.

Before you begin

Role required: sn_customerservice_agent, sn_customerservice_manager, or admin

Procedure

1. Navigate to Collaborate > Connect Support.
The Connect workspace opens in a new tab.

2. Click the support tab of the Connect sidebar, indicated by a headset icon ( ).
The support tab displays Queues to which you belong. It also displays your open
support conversations under Cases. When a user starts a support conversation or an
agent transfers a conversation to a queue, any agent who belongs to the associated
queue can accept the conversation. An agent can also request to transfer a conversation
directly to you.

Support tab of Connect sidebar

3. Accept a conversation in one of the following ways.

Option Description

Accept a conversation from a queue Under Queues, click Accept by the queue.
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Option Description
The conversation opens in the conversation
pane and an entry appears in the Cases
section of the sidebar.

Accept a transfer request Under Cases, click Accept by a transfer
request.

Transfer request

The conversation opens in the conversation
pane. The agent who transferred the
conversation can stay in the conversation.

4. Respond to the user and help resolve the issue.
By default, your messages are added to the conversation record as comments and are
visible to the user.

What to do next

If necessary, you can open a new customer service case or incident from the conversation to
track the issue. You can also transfer the conversation to a different agent or queue, escalate
the conversation to a higher priority queue.

Related Tasks

• Create an incident from a Connect Support conversation

• Transfer a Connect Support conversation to a different agent or queue

• Escalate a Connect Support conversation

Related Concepts

• Connect workspace

Create a customer service case from a chat

Last updated: July 26, 2018
Last updated: July 26, 2018

If a customer chat results in the need to open a case, create the case directly from the
conversation.

Before you begin

Role required: sn_customerservice_agent or sn_customerservice_manager
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About this task

When you create a customer service case from a support conversation, the system copies
the conversation history to the case activity stream as comments and work notes. Future
messages are tracked in the case as well.

Procedure

1. Navigate to Collaborate > Connect Support.
The Connect workspace opens in a new tab.

2. Click the support tab of the Connect sidebar, indicated by a headset icon ( ).
3. Under Cases, open a customer service conversation.

4. At the bottom of the conversation, click the menu icon ( ) to open the Connect
actions menu.

5. In the Connect actions menu, select Create Case.
In the conversation tools area to the right of the conversation, a new case form opens in
a record tab. The system automatically sets certain fields based on conversation details.

6. Complete the form as necessary and click Submit.
Any comments or work notes in the record conversation appear as comments on the
incident form. Work notes do not appear in the chat for the ESS user. The chat agent
can select whether a message is a Comment or Work Note in the conversation.
a. In the record conversation, by the text entry field, click the message type icon

( ).
b. Select Comment or Work Note.
c. Enter a message.

By default, record conversation messages are added as comments.

Note:  If you add an attachment to a record conversation, it is attached to the
underlying record as well.

The system automatically shares the record in the conversation, copies the conversation
to the record activity stream, and references the record on the Chat Queue Entry
[chat_queue_entry] table. Any new journal fields added to the record do not appear in
the chat. The system also changes the document ID for the conversation to reference
the incident number instead of the entry in the Chat Queue Entry table.

Related Concepts

• Connect workspace

Resolve cases with knowledge and community content

Last updated: July 26, 2018
Last updated: July 26, 2018

Enable agents to resolve a case more quickly by searching for information from the
knowledge base and community and, if helpful, associating it to the case.

Before you begin

Role required: sn_customerservice_agent

About this task
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The Case form displays contextual search results based on text entered in the Short
Description field. These search results provide targeted knowledge articles, pinned articles,
and community content to customer service agents.

Customer service agents can search for information that is related to a case when opening a
case or in a case that is already open. If the search results in any related content, the agent
can preview the content. If the information is relevant, the agent can mark it as helpful.
Knowledge articles can be also attached to the case.

Note:  By default, search results include knowledge articles, solved community
questions and blogs, and pinned articles.

Procedure

1. Navigate to Customer Service > Cases.
2. Perform one of the following actions.

• Open a new case and start typing in the Short description field.
• Open an existing case and click Related Search Results.

Any matching search results are displayed in the Related Search Results section. The
content displayed depends on the permissions assigned to the agent in Knowledge and
Communities.

3. Click one of the results to open the content in a pop-up window.
4. Perform any of the following optional steps.

To Do this

Attach a knowledge article to the case a. Click Attach next to the knowledge article you
want to attach to the case.

b. If you opened the knowledge article, click
Attach to Case.
The knowledge article is displayed in Activities
as a work note and is visible only to customer
service agents. A link to the article is also
entered in the Additional comments field.

c. To make the article visible to customers, click
Post.

Note:  You cannot attach Social Q&A or
Communities content to the Case
form.

Mark the content as helpful for resolving
the associated case

Click This helped.

Scroll to previous or next result Use the arrow keys to scroll up to the previous or
down to the next result.

5. Perform one of the following actions.
• If you opened a case, click Submit.
• If you updated an existing case, click Update.

Create a work order for a customer service case

Last updated: July 26, 2018
Last updated: July 26, 2018

Create a work order as part of the case resolution process.

August 6, 2018 ©2018 ServiceNow. All rights reserved. 107

ServiceNow | Customer Service Management



Before you begin

sn_customerservice_agent, sn_customerservice_manager, or admin

About this task

After a work order is created, it appears in the Work Orders related list on the case form.
The case number is also referenced on the work order.

Procedure

1. Open the desired case.
2. From the Work Orders related list, click New.
3. Fill in the fields on the Work Order form.
4. Click Update.

Related Tasks

• Create a work order

Related Concepts

• Manage work orders

Report a knowledge gap

Last updated: July 26, 2018
Last updated: July 26, 2018

If you cannot find relevant articles that could help resolve a case, you can report a
knowledge gap.

Before you begin

Role required: sn_customerservice_agent, sn_customerservice_manager, or admin

About this task

You can search for and attach knowledge articles related to a case in a Case form. If you
cannot find the relevant articles, you can create a knowledge article that could help resolve
the case. If you do not have permissions to create an article, report a knowledge gap.

Procedure

1. Navigate to Customer Service > Cases.
2. Open a case.

You can search for existing knowledge articles or create a knowledge article to help
resolve a case.

3. In the Related Links section, click Report Knowledge Gap.
4. Provide details about the knowledge gap in the Description field.
5. Click Submit.

A knowledge feedback task is created and is added to the Knowledge Gaps related list.

What to do next
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Work on a feedback task

Related Tasks

• Resolve cases with knowledge and community content

Related Topics

• Create a knowledge article

Close a customer service case

Last updated: July 26, 2018
Last updated: July 26, 2018

Close a case at any time, except when it is in the Resolved state.

Before you begin

Role required: sn_customerservice_agent, sn_customerservice_manager, or admin

About this task

After an agent proposes a solution for a case, the state changes to Resolved and the
customer can either choose to accept or reject the solution. If accepted, the case is closed. If
rejected, the state reverts to Open.

An agent or agent manager can close a case at any time, except when it is in the Resolved
state, when only a customer can accept or reject the proposed solution. When an agent or
agent manager closes a case, details must be included in the Resolution notes field.

Procedure

1. Open the desired case.
2. Click the Resolution Information tab.
3. From the Resolution Code drop-down list, select the code that indicates the resolution

state of the case.
4. Enter any information related to the closure in the Resolution notes field.
5. Click Close Case.

• Customer service satisfaction surveys

Customers can complete a satisfaction survey when a case is closed.

Customer service satisfaction surveys

Last updated: July 26, 2018
Last updated: July 26, 2018

Customers can complete a satisfaction survey when a case is closed.

When a customer accepts a proposed solution for a case by clicking Accept Solution on the
case form or closes a case by clicking Close Case, a satisfaction survey is displayed in the
customer service portal. The customer has the option of completing or skipping the survey.
Either choice returns the customer to the list of cases on the portal.
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If a customer is using the email communication channel, an email that includes a link to a
customer satisfaction survey is sent when an agent closes a case. The customer can click on
this link to complete the survey.

Note:  One survey can be generated per case. If a survey has already been
generated for a case, a second survey cannot be generated even if a case is
reopened and closed again.

The Customer Service application includes a default survey that you can customize as
needed. To customize the default survey, navigate to Survey > View Surveys and select
Customer Service Satisfaction Survey from the list of assessment metric types. To edit the
default survey, open the survey and click the Survey Designer button.

You can also design your own survey using the survey designer tool. After designing a
survey, be sure to select a condition for triggering the survey.

The Customer Service dashboard includes a Customer Satisfaction report that displays the
survey results. You can also access the Customer Satisfaction report by navigating to
Reports > View/Run > Customer Satisfaction.

Related Concepts

• Get started with Survey Management

• Track and analyze Customer Service case data

Customer service case form

Last updated: July 26, 2018
Last updated: July 26, 2018

The Case form displays detailed information about a customer issue or problem.

There are two different versions of the Case form: A detailed view that is available to agents
and agent managers in the Customer Service Management application and a simplified view
that is available to external customers from the Customer Service Portal.

Agent view

The agent view of the Case form includes the following components:

• A timeline that provides a visual display of case activities.
• Referenced entities for the case including account and contact information, product and

asset information, service contract and service entitlement details, and any pertinent SLAs.
Except for SLAs, this information exists in the system and can be associated with the case
by the agent or agent manager.

• All communication about the case, both external and internal. This information is stored in
the Additional comments field (external communication), the Work notes field (internal
communication), the Resolution notes field. The Resolution notes field stores details about
the case resolution, and the Activity field, which stores all communication in a
chronological list.

Agents and managers can view a Case form by navigating to Customer Support > Cases
and selecting one of the following menu options:

• My Cases
• All
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• Open
• Unassigned

From the Case list, click a case number to display the Case form.

Customer Service Case form (agent view)
Field Description
Number The automatically assigned case number.

Channel The method by which the customer initiated
contact and the case was opened.

• Web (default)
• Phone
• Email
• Chat
• Social

Contact Local Time The local time of the contact assigned to the
case.
It is automatically filled according to the time
zone set on the Contact form. If no time zone is
set on the Contact form, it is filled according to
the Contact Timezone set on the case itself.

If no time zone is set on the Contact form or in
the case, the field is left blank and is read-only.

If a case is closed or canceled, the Contact Local
Time field is hidden.

Note:  Configure the form layout to add
this field to the Case form.

Contact time zone The contact time zone if the customer is working
in a different time zone for the case. It overrides
the Contact form time zone.
If no contact local time or contact time zone is
set, the instance time zone is displayed.

Once the case is created, the field is read-only.

Note:  Configure the form layout to add
this field to the Case form.

Account The name of the contact's company. This field is
filled in automatically if the information is
available in the contact record.

Contact The name of the customer contact for this case.

Product The product model of the asset. A model is a
specific version or configuration of an asset (for
example, Apple Mac Book Pro).
If you select an asset in the Asset field and the
asset has an associated product, the Product field
is automatically updated. A product can be
associated with multiple assets.
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Field Description
Asset The asset tag number or the serial number of the

asset involved in this case.

Partner Contact The name of the partner contact for this case.

Follow the sun A check box to indicate that a case should be
handed-off for global follow-up.
If a customer enters additional comments on a
Priority 1 - Critical or a Priority 2 - High case, or if
the case is escalated, the flag is automatically
selected.

You can also manually select the check box.

The activity stream on the case form is updated
with any changes.

Note:  Enable the Follow the sun check box
on the Customer Service case form by
setting the value of the property
sn_customerservice.FTS_flag_enabled
to true. Configure the form layout to
add this field to the Case form.

Short description A brief description of the issue or problem.

Opened The date and time that the case was opened.

Priority The assigned priority:

• 1 — Critical
• 2 — High
• 3 — Moderate
• 4 — Low (default)

State Customer service case states:

• New
• Open
• Awaiting Info
• Resolved
• Closed
• Canceled

Note:  Configure the form layout to add
this field to the Case form

Assignment group The assigned customer service agent group.

Assigned to The assigned agent. If a group is selected in the
Assignment group field, the assigned agent must
belong to this group.

Contract The contract number associated with this case.

Entitlement The entitlement associated with this case. The
entitlements available for selection in the
reference list channel matches the case creation
channel. The available entitlements are filtered by
the settings in the Account, Contract, Product,
Asset fields.
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Field Description
If only one entitlement is available for this case, it
is automatically added to the Entitlement field.

Partner The name of the partner company.

Notes

Watch list Users who receive notifications about this case
when additional comments are added or if the
state of a case is changed to Resolved or Closed.
Click the add me icon to add yourself to the
watch list.

Work notes list Internal users who receive a notification about
this case when work notes are added. You can
only add internal users to the work notes list.

Click the add me icon to add yourself to the work
notes list.

Additional comments Customer-viewable comments. Each comment is
inserted into the Activity field when the user
clicks the Post button.

Work notes Information about how to resolve the case, or
steps taken to resolve it, if applicable.

Internal users who have been added to the Work
notes list receive the Case work notes added
notification containing the work notes when
added.

You can configure the notification, as required.
The notes are viewable by the admin, agent, and
agent manager.

Activities Records all activity associated with this case.

Resolution Information

Resolved by The agent to whom the case is assigned when
the case is resolved.

Closed by The name of the user who closed the case.

Resolution Code Choice list indicating the resolution states for the
case.
This field is mandatory when an agent proposes a
solution for a case.

Cause Details about the cause of the resolution.

Resolution notes Details about how the case was closed. This field
is mandatory if a customer service agent or agent
manager closes a case. If a customer closes a
case, it is not mandatory.

Add resolution notes to comments A check box to determine if the resolution notes
are added to customer-viewable comments when
the case is resolved.
If selected, the resolution notes are added to the
Additional comments (customer-visible) field.
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Field Description
By default, the check box is cleared.

Resolved The date and time that the case was resolved.

Closed The date and time that the case was closed.

Customer view

Customers can view a Case form by clicking My Cases on the customer portal and then
clicking a case number from their Case list.

The customer view of the Case form includes the following components:

• A process flow formatter that indicates the current state of the case.
• The related entity information, including account and contact information, product and

asset information, and service contract information.
• An Activity field that stores all communication for the case in a chronological list.

• Customer service case timeline

The timeline provides a visual display of case activities. The timeline appears at the top of
the Case form when viewed by an agent or manager in the Customer Service
Management application.

• Customer service case process flow formatter

The process flow formatter indicates the current state of a case at the top of a Case form
that is viewed from the customer portal.

• Customer service case form related lists

The Case form includes related lists that store case information and that agents can use
to perform case-related tasks.

• Customer service case states

A customer service case can be in one of several states.

• Customer service cases list

The Cases list displays a list of customer service cases for the current user.

Customer service case timeline

Last updated: July 26, 2018
Last updated: July 26, 2018

The timeline provides a visual display of case activities. The timeline appears at the top of
the Case form when viewed by an agent or manager in the Customer Service Management
application.

The timeline uses blue circles to represent case state changes and markers to represent case
activities. The information included in the timeline is also shown on the Case form in the
Activity history.
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Customer Service Case Timeline

Header

The timeline header displays the time that the case began. It also displays the time that the
case was either last updated or closed.

State changes and case activities

Each state change for a case is represented by a blue circle on the timeline. Pointing to
these circles provides more information about the state change in a tooltip. For example,
pointing to the first blue circle that represents the New state displays the name of the user
who created the case and the approximate time that the case was created.

Activity lines above and below the timeline represent other case activities, including
comments, information requests, close notes, email, and phone calls. Activities performed by
an agent are shown above the timeline and activities performed by a customer are shown
below. Pointing to these activities on the timeline displays additional information.

Overlapping states and conversations are represented by thicker borders and thicker lines.
Pointing to overlapped states and conversations results in grouped tooltips.

If a case is ongoing, the end of the timeline shows the last updated activity or state change.
If a case is closed, the end of the timeline shows a blue circle that represents the Closed
state.

Time metric

The metric to the right of the timeline tracks the amount of time that a case is open. The
date and time that the case was opened is used as the start of the time calculation. When a
case is ongoing, the current time is used as the end time calculation. When a case is closed,
the close time is used as the end time calculation.

The metric breaks down the time by the number of minutes and hours that a case is with the
agent or with the customer. A case is considered to be with the agent when it is in the New,
Open, or Closed state.

When a case is in the Awaiting Info or Resolved state, it is considered to be with the
customer.

• Use the Customer Service case timeline with other applications

You can use the Customer Service case timeline with other ServiceNow applications by
creating a configuration for each application and adding the ResolutionShaper field to the
desired form.

Last updated: July 26, 2018
Last updated: July 26, 2018
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You can use the Customer Service case timeline with other ServiceNow applications by
creating a configuration for each application and adding the ResolutionShaper field to the
desired form.

Before you begin

Role required: admin

Procedure

1. Ensure that the Customer Service plugin (com.sn_customerservice) has been activated.
2. Navigate to the Resolution Shaper Configs page

(<instance>sys_resolutionshaper_config_list.do) and click New.
3. Select a table in the Task Table field.
4. Add the desired states in the Requestor States field using a comma-separated list. For

example, New,Active,Resolved,Closed.
5. Make any necessary changes to the remaining fields and click Submit.
6. Navigate to the desired form.
7. Right-click the form header and select Configure > Form Layout.
8. Using the slushbucket, select ResolutionShaper and move it to where you want the

timeline to appear.
9. Click Save.

Customer service case process flow formatter

Last updated: July 26, 2018
Last updated: July 26, 2018

The process flow formatter indicates the current state of a case at the top of a Case form
that is viewed from the customer portal.

The process flow formatter highlights the current state of the case with a blue line and
checks off the states that a case has passed through. For customers viewing a case from the
customer portal, the following states are displayed:

• New
• Open
• Resolved
• Closed

Process flow formatter

Customer service case form related lists

Last updated: July 26, 2018
Last updated: July 26, 2018

The Case form includes related lists that store case information and that agents can use to
perform case-related tasks.
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Customer service case form related lists
Related List Description
SLAs The service level agreements that are associated

with this case.

Tasks Tasks that have been created for this case by the
customer service agent or agent manager. When
you create a task or change the state of a task,
the information is recorded in the case Activity
field.

Phone The case phone log. A list of incoming or
outgoing phone calls associated with this case.

Appointments Appointments that the customer service agent
makes with the customer or others as part of
resolving this case.
When you create an appointment, an
appointment creation message is recorded in the
case Activity field. The user selected in the To
field on the appointment form receives an email
with the appointment details.

Emails The case email log. A list of the emails that are
sent or received as part of resolving this case.
The customer service agent or agent manager
can send email from within the case, such as
updates and inquiries to customers or other
employees. A change in the state of the case
triggers an automatic email to be sent to the
customer.

Customer contacts can create and update cases
by email as well as receive updates from
customer service agents.

Related Cases A list of cases created for the same account or
contact.

Problems A list of problems related to this case. If you
change the State of the problem, it is displayed as
an activity in the work notes in the case.

Work Orders A list of work orders created for this case.

Social Logs A list of the communication with customers or
consumers that takes place through social media
channels. The Social Log form includes the Social
Profile of the user that created the
communication and the Social URL for the
conversation. Click the URL to open the
conversation in a new tab.

Attached Knowledge Knowledge articles attached as a proposed
solution to the case.

Knowledge Gaps Feedback tasks created when a knowledge gap is
reported.

Customer service case states

Last updated: July 26, 2018
Last updated: July 26, 2018
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A customer service case can be in one of several states.

Customer service case states
Term Definition
New The initial state for a new case, which is created

through any one of the channels: customer portal,
email, chat, telephone, or from the Customer
Service application.

Actions the agent can take:

• Assign to me: The case is assigned to the agent
and the state changes to Open.

• Accept: If assigned by the customer service
manager, the agent accepts the case and the
state changes to Open.

• Update: updates the case.
• Close Case: Closes the case.
• Delete: Deletes the case.

Actions the customer can take:

• Update: updates the case.
• Close Case: Closes the case

Open The case is assigned to an agent and the agent
clicks Accept or an agent opens a case and clicks
Assign to me. Both of these actions change the
state from New to Open.

Actions the agent can take:

• Update: Updates the case.
• Request Info: The agent requests additional

information from the customer. The state
changes to Awaiting Info.

• Propose Solution: The agent proposes a
solution for the case.

Note:  The Resolution Code and
Resolution notes must be
entered in the Resolution
Information tab.

The state changes to Resolved.
• Close Case: Closes the case.
• Delete: Deletes the case.

Awaiting Info An agent clicks Request Info, changing the state
from Open to Awaiting Info.

Actions the agent can take:

• Open Case: Changes the state back to Open.
• Update: Updates the case
• Close Case: Closes the case.
• Delete: Deletes the case.

Actions the customer can take:
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Term Definition
• Update: Once the customer updates the case,

the state changes to Open.
• Close Case: Closes the case.

Resolved An agent provides a resolution code and enters
resolution notes in the Resolution Information tab
and clicks Propose Solution, changing the state
from Awaiting Info to Resolved.
The Resolution code and Resolution notes fields
are mandatory when an agent proposes a
solution for the case.

Actions the agent can take:

• Update: Updates the case
• Close Case: Closes the case.

Actions the customer can take:

• Accept Solution: The customer accepts the
solution proposed by the agent. The state
changes to Closed and a survey is displayed.

• Reject Solution: The customer rejects the
solution proposed by the agent and the state
changes to Open.

• Delete: Deletes the case.

Closed After proposing a solution, an agent waits for the
customer to respond.

• If the customer clicks Accept Solution, the state
changes from Resolved to Closed.

• If the customer clicks Reject Solution, the state
changes from Resolved to Open.

An agent, agent manager, or a customer can
close a case at any time, except when it is in the
Resolved state. When it is in the Resolved state,
only a customer can accept or reject the
proposed solution.

When an agent or agent manager closes a case,
details must be included in the Resolution notes.
This is not required when a customer closes a
case.

A case cannot be updated once it is closed.

Related Concepts

• State flows

Customer service cases list

Last updated: July 26, 2018
Last updated: July 26, 2018

The Cases list displays a list of customer service cases for the current user.
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Users with the sn_customerservice_agent or sn_customerservice_manager roles can view
the Cases list in the Customer Service Management application. The default view of the
Cases list includes the following columns:

• Number
• Short description
• Contact
• Account
• Channel
• State
• Priority
• Assigned to
• Updated
• Case Report (add a column to access this table if needed)

External customers can view a list of cases from the customer portal. For external users with
the sn_customerservice.customer or sn_customerservice.customer_admin roles, the Cases
list displays a subset of case information, including:

• Number
• Short description
• Product
• Priority
• State
• Updated

For external users with the sn_customerservice.partner or
sn_customerservice.partner_admin roles, the Account column is also displayed.

The cases included in this list are determined by user role.

User Role Cases Included in Case List
sn_customerservice_admin,
sn_customerservice_manager,
sn_customerservice_agent

All cases

sn_customerservice.customer
• Cases opened by the customer
• Cases opened by an agent for the customer
• Cases opened for the same account as the

customer's account

sn_customerservice.customer_admin Cases opened for the same account as the
customer admin's account

sn_customerservice.partner
• Cases opened by the partner
• Cases opened by an agent for the partner
• Cases opened for the same account
• Cases opened from a partner account

sn_customerservice.partner_admin
• Cases opened for the same account
• Cases opened for the partner admin's account
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Major issue management
Last updated: July 26, 2018
Last updated: July 26, 2018

Major issue management enables customer communication for issues that impact a wider
audience. Use this feature to proactively identify impacted customers, provide information
to these customers, and manage the resolution process.

This feature enables you to efficiently manage the communication and resolution process for
issues that impact multiple customers. With major issue management, you can identify
impacted customers who have not yet reported an issue and proactively create cases for
these customers.

Major issue management introduces the concept of a major case which contains the details
about a particular issue. Child cases can easily be created for a major case, with one child
case created for each customer affected by the issue. These child cases contain the
customer-specific information.

Identify affected customers by creating a recipients list of accounts or consumers and
attaching it to the major case. Create this list using the Targeted Communications
application. Build a recipients list by identifying dynamic conditions, running a script, or
importing customer information into a template. Once attached to a major case, use the
recipients list to create a child case for each customer included in the list.

A major case is created in one of two ways:

• A customer service manager can create a major case.
• A customer service manager or major issue manager can promote a major case candidate.

Major case candidates are created either by promoting an existing customer service case
(for customer reported issues) or by creating a candidate case directly (for non-customer
reported issues). Candidate cases require approval before being promoted to major cases.

Major issue management also provides properties that enable automatic synchronization
from a major case to the associated child cases. Use these properties to enable
synchronization and to identify the synchronized fields.

Identifying issues and creating major cases

Customer service agents, managers, and major issue managers can use the following
process to identify potential issues, create major cases, and identify impacted customers.

1. Create a major case candidate or flag an existing customer service case as a major case
candidate.

2. Review the major case candidate and either approve it as a major case or reject it.
• If approved, the candidate case becomes a child case of the major case.
• If rejected, the candidate case returns to a normal case.

3. Associate other cases reported for the same issue as child cases of the major case.
4. Identify other customers impacted by the issue by creating a recipients list and

attaching it to the major case.
5. Create child cases for the customers included in the recipients list.
6. Manage the issue to resolution using the major case.

• Update the major case as needed, which automatically updates the child cases.
• Close the major case when the issue is resolved. Closing the major case

automatically closes all the child cases.
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Activate Major Issue Management

Last updated: July 26, 2018
Last updated: July 26, 2018

You can activate the Major Issue Management plugin (com.sn_majorissue_mgt) if you have
the admin role.

Before you begin

Role required: admin

About this task

This plugin requires:

• Customer Service [com.sn_customerservice]
• Targeted Communications [com.sn_publications]
• Task Communications Management [com.snc.task_communication_management]

This plugin adds the Major Issue Management menu to the application navigator.

Procedure

1. Navigate to System Definition > Plugins.
2. Find and click the plugin name.
3. On the System Plugin form, review the plugin details and then click the Activate/

Upgrade related link.

If the plugin depends on other plugins, these plugins are listed along with their
activation status.

If the plugin has optional features that depend on other plugins, those plugins are listed
under Some files will not be loaded because these plugins are inactive. The optional
features are not installed until the listed plugins are installed (before or after the
installation of the current plugin).

4. (Optional) If available, select the Load demo data check box.

Some plugins include demo data—Sample records that are designed to illustrate plugin
features for common use cases. Loading demo data is a good practice when you first
activate the plugin on a development or test instance.

You can also load demo data after the plugin is activated by clicking the Load Demo
Data Only related link on the System Plugin form.

5. Click Activate.

Related Reference

• List of plugins (London)

Major, candidate, and child cases

Last updated: July 26, 2018
Last updated: July 26, 2018
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Major issue management uses major case candidates to identify potential customer issues.
Approved candidate cases become major cases, which you can use to manage issues to
resolution. Child cases are created for customers impacted by an issue and are associated
with a major case.

Major cases

A major case contains information about a specific issue that impacts customers. It is not
associated with any accounts, contacts, or consumers. This customer-specific information
resides in the associated child cases.

The recipients list associated with the major case identifies customers impacted by the issue.
Select a list in the Affected Customers field in the Major Case Information form section of
the Major Case form. After adding the list, you can automatically create child cases for all
customers on the list. These cases are added to the Child Cases related list on the major
case form.

With synchronization enabled, updates to a parent case are automatically synchronized to
the associated child cases. When a major case is closed, the associated child cases in the
following states are also closed: New, Open, Awaiting Customer Info.

To identify major cases in the list view, check the value in the Major case state field.

• Major cases have a state of Accepted.
• Major case candidates have a state of either Proposed or Rejected.
• Regular cases have a blank value.

In the form view, major cases and major case candidates display the Major Case Information
form section.

Note:  Related links on a major case form do not synchronize to associated child
cases.

Major case candidates

A customer service agent uses a candidate case to flag an issue that may be a wider
problem impacting multiple customers. An agent can create a major case candidate:

• By promoting an existing customer service case with a reported issue.
• By creating a major case candidate directly.

A major case candidate requires the approval of the customer service manager or major
case manager before being promoted to a major case. When a major case candidate is
approved, a major case is created.

• If the major case candidate was promoted from an existing case, a major case is created
and the candidate case becomes a child case of that parent.

• If the major case candidate was created directly, that same case becomes the major case.

If a major case candidate is rejected, it reverts to a regular case.

Child cases

Child cases are associated with a major case. One child case is created for each account
(B2B) or consumer (B2C) impacted by the major case issue. Child cases are created from
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the recipients list on the major case and can also be added manually by the major issue
manager.

When child cases are created, the short description from the major case is copied to each of
the child cases. Duplicate child cases are not created. If a child case already exists for an
account or consumer, it is not created again.

As child cases are created, you can enter text in a pop-up window that is added to the
Additional comments field on the child case form. These comments are added only to the
newly created child cases. The major case and any existing associated child cases are not
updated.

The primary contact for an account is the contact on the child case and is automatically
added to the child case watchlist.

Synchronization between major cases and associated child
cases

The system administrator can set system properties that enable or disable the
synchronization between the major case and associated child cases and also define the
fields to synchronize. Synchronization occurs from the major case to the child cases. If the
state of a child case is Resolved, Closed, or Canceled, the synchronization does not take
place.

A major case and the associated child cases maintain synchronization on the fields identified
by the sn_customerservice.case_fields_to_sync property. This property specifies the list of
fields to synchronize from the major case to the associated child cases. By default, these
fields include:

• Priority
• State
• Comments
• Work notes
• Close notes
• Resolution code

If the State field is synchronized from the major case to the child cases, the Close notes and
Resolution code fields must also be synchronized.

Note:  Child cases can be manually added to a major case at any time. There is no
retroactive synchronization for newly added child cases.

When synchronization is enabled, saving changes to a major case results in a pop-up
window. Verify the update by clicking OK.

Recipients lists

Last updated: July 26, 2018
Last updated: July 26, 2018

Use recipients lists that contain account or consumer information to create the child cases
for a major case.

Major issue managers and customer service managers can select the desired list in the
Affected Customers field on the Major Case form. Clicking Create Child Cases then creates a
child case for each account or consumer in the recipients list.
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Managers can change the recipients list before child cases are created. After child cases are
created, the Affected Customers field becomes read only.

Creating recipients lists

Recipients lists are created using the Targeted Communications application. With this
application, managers can select the type of list to create and the method used to create
the list: by uploading files, selecting dynamic conditions, or using scripts.

The Targeted Communications application creates several types of recipients lists, including
accounts, contacts, consumers, and internal users. The recipients list for a major case must
be of type accounts or consumers. Recipients lists are limited to one specific type and
cannot contain mixed types, for example accounts and consumers.

Note:  The Major Issue Management plugin is dependent on the Targeted
Communications plugin. If Targeted Communications is active, recipients lists
can be created for internal users. If Targeted Communications and Customer
Service Management are both active, recipients lists can also be created for
accounts, contacts, and consumers.

Manually editing a recipients list

Major issue managers and customer service managers can manually add or remove
accounts or consumers from a recipients list by navigating to the Recipients List form,
clicking Edit in the Recipients related list, and then using the arrows to add or remove
records.

The Recipients related list includes the Dynamically Added column which displays either
True or False, depending on how a record was added:

• True for records that are dynamically generated, either by using the condition builder or by
running a script.

• False for records that are added manually, either by using the Edit button on the
Recipients related list or by file upload.

The Active Communication column is set to True by default for both dynamically and
manually added records. This field indicates whether or not the recipient requires active
communication.

Refreshing a recipients list

Refresh a recipients list by clicking Refresh Recipient List on the Recipients List form. For
major issue management, the following guidelines apply to refreshing a recipients list:

• Refreshing a recipients list does not impact manually created records.
• If you remove a manually created record from a recipients list, it does not reappear when

the list is refreshed unless it meets the dynamic conditions used to filter the list.
• If you remove a dynamically generated record from a recipients list, it may reappear when

the list is refreshed if it meets the dynamic conditions used to filter the list.
• If the Active Communication field is set to false for a record, this setting does not change

when a recipients list is refreshed.
• If created using the Upload File method, you do not need to refresh the recipients list.
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Related Tasks

• Create a recipients list

Major Case form view

Last updated: July 26, 2018
Last updated: July 26, 2018

Major issue management provides the Major Case form view, which includes the Major Case
Information form section and the Child Cases related list.

The Major Case form view does not display account-related information because a major
case is not linked to a specific account, contact, or consumer. This information is stored in
the child cases associated with a major case.

Major Case Information form section

Major cases and major case candidates include the Major Case Information form section
which includes the following fields.

Field Description
Major case state A major case can be in one of these states:

• Proposed: the initial state when a candidate
case is created or proposed by an agent or
manager.

• Accepted: the Initial state when a major case is
created by a manager or when a candidate
case is promoted by a manager.

• Rejected: the candidate case is rejected by a
manager.

• Cancelled: the case is canceled.

Business impact The business impact of the issue identified in the
major case.

Probable cause The probable cause of the issue identified in the
major case.

Affected Customers The recipients list selected for the major case.
Child cases are created for the accounts or
consumers included in the recipients list. This
field is only visible when the major case state is
Accepted.

Customer service agents can update the Business impact and Probable cause fields as well
as add work notes. Major issue managers can update the Business Impact and Probable
Cause fields and attach a recipients list. The Affected Customers field is only visible when
the major case state is Accepted.

The Work notes field on the major case form is updated when a major case is proposed or a
candidate case is created manually. The Work notes field on associated child cases is
updated when a major case is accepted.

When a major issue manager rejects a candidate case, the Major Case State field is set to
Rejected and the Work notes field is updated with the case state. The candidate case reverts
to a regular case.
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Child Cases related list

Major issue management adds the Child Cases related list to the Customer Service Case
form. All child cases associated with a major case are added to this list. Child cases are
created automatically from the recipients list and can also be added or removed manually.

Configure case synchronization

Last updated: July 26, 2018
Last updated: July 26, 2018

Configure the major issue management system properties to enable synchronization
between major cases and associated child cases.

Before you begin

Role required: admin

Procedure

1. Navigate to Customer Service > Administration > Properties.
2. Enable the Synchronize fields from parent to child case property.
3. In the Comma separated list of fields that synchronize from parent to child cases

property, add a comma-separated list of fields that synchronize from the major case to
each of the associated child cases.

4. Click Save.

Propose a case as a major case candidate

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the customer service agent role can propose an existing customer service case
as a major case candidate.

Before you begin

Role required: sn_customerservice_agent, sn_customerservice_manager,
sn_majorissue_mgt.major_issue_manager

About this task

Cases in these states can be proposed as a major case candidate: New, Open, Awaiting Info.
Cases that are Resolved, Closed, or Canceled cannot be proposed.

Procedure

1. Navigate to the desired customer service case.
2. Click Propose Major Case on the Case form context menu.

An entry is added to the Work notes on the Case form that the case was proposed as a
major case candidate.

Create a major case candidate

Last updated: July 26, 2018
Last updated: July 26, 2018
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Users with the customer service agent role can create a major case candidate.

Before you begin

Role required: sn_customerservice_agent, sn_customerservice_manager,
sn_majorissue_mgt.major_issue_manager

Procedure

1. Navigate to Major Issue Management > Create Major Case Candidate.
2. Enter a description in the Short description field.
3. In the Major Case Information form section, enter the relevant information in the

Business impact and Probable cause fields.
4. Click Submit.

Approve or reject a major case candidate

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the major issue manager role can approve or reject a major case candidate.

Before you begin

Role required: sn_customerservice_manager, sn_majorissue_mgt.major_issue_manager

Procedure

1. Navigate to Major Issue Management > Candidates.
2. Select the desired candidate case.
3. Select one of the following from the Case form context menu.

Option Description

Approve Major Case Candidate Approves the current major case candidate as
a major case.

Upon approval:
• If the candidate case was proposed from

an existing case, a major case is created
and the candidate case becomes a child
case of that major case.

• If the candidate case was created directly,
the candidate case becomes the major
case.

Reject Major Case Candidate Rejects the current major case candidate as a
major case.
If rejected, provide a reason for rejecting the
case in the Rejection Reason pop-up window.
This information is added to the Work notes on
the Case form.

4. Click Update.

Create a major case

Last updated: July 26, 2018
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Last updated: July 26, 2018

Users with the customer service manager role can create a major case.

Before you begin

Role required: sn_customerservice_manager

Procedure

1. Navigate to Major Issue Management > Create Major Case.
2. Fill in the fields on the Case form.
3. In the Major Case Information form section, fill in the Business impact and Probable case

fields.
4. Click Submit.

Create child cases for a major case

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the customer service manager role can create a child case for each of the
customers included in the major case recipients list.

Before you begin

Role required: sn_majorissue_mgt.major_issue_manager, sn_customerservice_manager

About this task

The Create Child Cases button on the Major Case form creates a child case for each account
or consumer in the recipients list selected in the Affected Customers field. If a child case for
an account or consumer already exists, the system does not create a duplicate child case.

Note:  Use caution when selecting the recipients list for a major case. Selecting the
wrong recipients list can have a serious impact by creating a large number of
cases for incorrect accounts or consumers. Ensure that you have selected the
correct recipients list before clicking Create Child Cases.

Once child cases have been created, you cannot change the recipients list. Any additional
recipients must be added manually. After manually adding recipients to the list, click Create
Child Cases again to create child cases for these new recipients.

Creating child cases copies information from the major case to each of the child cases. The
field values that are copied to the child cases are identified by the
sn_customerservice.case_fields_to_sync system property.

Procedure

1. Open the desired major case.
2. In the Major Issue Management form section, select a recipients list in the Affected

Customers field.
3. Click Update.
4. Click Create Child Cases.
5. In the Create Child Cases pop-up window, enter information about the major case
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This information is added as additional comments to each of the newly created child
cases. If child cases for this major case already exist, these child cases are not updated.

6. Click Continue.
The child cases are created and added to the Child Cases related list.

Related Concepts

• Recipients lists

Components installed with Major Issue Management

Last updated: July 26, 2018
Last updated: July 26, 2018

Several types of components are installed with the major issue management feature.

Roles installed with Major Issue Management

Major Issue Management provides these roles.

Role title [name] Description Contains Roles
Major issue manager
[sn_majorissue_mgt.major_issue_manager]

Users with this role can:

• Create major cases
• Approve or reject major case

candidates
• Add or remove child cases

from major cases
• Add or remove impacted

accounts (B2B) or consumers
(B2C)

The customer service manager
role
[sn_customerservice_manager]
contains the major issue
manager role.

• sn_customerservice_agent
•

sn_customerservice_consumer_agent
•

sn_publications_recipients_user
•

sn_publications_recipients_list_user

Properties installed with Major Issue Management

Major Issue Management provides these properties.

To access these properties, navigate to Customer Service > Administration > Properties.

Note:  To open the System Property [sys_properties] table, enter sys_properties.list in
the navigation filter.

Property Description
Synchronize fields from parent to child case
sn_customerservice.parent_child_case_sync

Enable this property to synchronize fields from a
major, or parent, case to the associated child
cases.

• Type: true|false
• Default value: false
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Property Description
• Location: Customer Service > Administration >

Properties

Comma-separated list of fields that synchronize
from parent case to child cases
sn_customerservice.case_fields_to_sync

Specifies the list of fields to synchronize from the
major, or parent, case to the associated child
cases.

• Type: string
• Default value:

priority,state,comments,work_notes,assigned_to,close_notes,resolution_code
• Location: Customer Service > Administration >

Properties

Tables installed with Major Issue Management

Major Issue Management adds the following tables.

Table Description
Case Communication Task
[case_comm_task]

Stores details about case communication tasks.

Case Communication Plan
[case_comm_plan]

Stores details about case communication plans.

Special handling notes
Last updated: July 26, 2018
Last updated: July 26, 2018

Use the Special Handling Notes application to create notes that bring important information
about individual records to the user's attention.

Create special handling notes for specific records or for a set of records that meet one or
more conditions. You can also configure the Special Handling Notes application to display
any special handling notes from related records, such as the account or the product
associated with a customer service case.

Once created, special handling notes can be displayed in different ways: in an embedded list
or a related list on a record form or in a pop-up window that displays when you access a
form.

In addition to a message, a special handling note also has a status, an assigned priority, and
an expiration date.

The status of a note can be one of the following:
Status Definition
Active The note is active.

Active notes appear on the Special Handling Notes list or pop-up window.

Active notes remain on the list until they are set to Inactive or Expired.
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Status Definition
Active notes remain on the pop-up window until dismissed or until they are set to Inactive
or Expired.

Inactive The note is no longer active.
Users with the sn_shn.admin or sn_shn.editor role can set a note to Inactive if the
information in the note is no longer useful. When a note is set to Inactive, it is removed
from the Special Handling Notes list or pop-up window.

Inactive notes can be viewed by navigating to Special Handling Notes > Special Handling
Notes.

Expired The note has reached it's expiration date or it has been expired manually.
If a note is expired, the form becomes read-only for all user roles other than the system
administrator.

A note is expired automatically by a scheduled job when it reaches it's expiration date.
The scheduled job also sets any inactive notes to expired if the inactive notes have
reached their expiration date.

The expiration date for a note is set when the note is created. After a note reaches it's
expiration date, it is no longer displayed on the Special Handling Notes list or pop-up
window. The Deactivate Special Handling Notes scheduled job, which runs daily at midnight,
checks all active notes and sets the status to Expired for those that have reached their
expiration dates.

A note can be assigned one of the following priorities:

• 1 - Critical (red)
• 2 - High (orange)
• 3 - Moderate (light green)
• 4 - Low (light blue)

The associated priority color is displayed as a colored bar to the left of the note in the pop-
up window and as a colored circle to the left of the priority field in the embedded list.

Users with the sn_shn.admin role can configure the desired entity tables to use special
handling notes and then configure the corresponding forms to display either the list or pop-
up window. Users with the sn_shn.admin role can create, view, update, and delete notes.
Users with the sn_shn.editor role can view and update notes and users with the sn_shn.user
role can view notes.

Special handling notes list

Special handling notes can be displayed on a form in an embedded or related list. Users with
the sn_shn.admin role can configure a form to display the Special Handling Notes list. This
list appears on a form when there are one or more active notes for a record. The Special
Handling Notes list displays the following information for a note:

• Message
• Expiration date
• Priority
• Table

Special handling notes are displayed on the list unless you configure additional properties to
display notes in a pop-up window.
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Special handling notes pop-up window

Special handling notes can be displayed on a form in a pop-up window. Users with the
sn_shn.admin role can configure a form to display the Special Handling Notes pop-up
window. This window appears when you access a record that has one or more active notes.
The pop-up window displays the following information for each note:

• Message
• Priority

To dismiss a note, click OK. Once you dismiss a note, it no longer appears in the pop-up
window. To close the Special Handling Notes pop-up window, click X

To display special handling notes in a pop-up window, navigate to Special Handling Notes >
Properties and set the related properties.

• Configure special handling notes

Configure the desired entity tables to use special handling notes and then configure the
corresponding forms to display either the Special Handling Notes list or pop-up window.

• Create a special handling note

Create a special handling note for a record.

• Update a special handling note

Update a special handling note for a record.

• Delete a special handling note

Delete a special handling note for a record.

• Delete a special handling note from a form

Delete a special handling note for a record from the Special Handling Notes list on the
form.

Configure special handling notes

Last updated: July 26, 2018
Last updated: July 26, 2018

Configure the desired entity tables to use special handling notes and then configure the
corresponding forms to display either the Special Handling Notes list or pop-up window.

Before you begin

Role required: sn_shn.admin

Procedure

1. If necessary, activate the Customer Service Management plugin
(com.sn_customerservice).

2. Configure the desired entity tables to use special handling notes.
3. Configure the corresponding form to display special handling notes.
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You can display notes in an embedded or related list on a form with no additional
configuration. To display notes in a pop-up window, you must also enable the related
properties.

4. If desired, enable the properties necessary to display special handling notes in a pop-up
window.

• Configure an entity table to use special handling notes

Configure an entity table to use special handling notes.

• Configure a form to show special handling notes

Display special handling notes on a form in a list or pop-up window.

• Configure special handling notes properties

Configure the necessary properties to display special handling notes.

Configure an entity table to use special handling notes

Last updated: July 26, 2018
Last updated: July 26, 2018

Configure an entity table to use special handling notes.

Before you begin

Role required: sn_shn.admin

About this task

Configuring an entity to use special handling notes adds the Create Special Handling Notes
related link to the corresponding form.

Procedure

1. Navigate to Special Handling Notes > Configuration.
2. Click New.
3. Select a table in the Table name field.
4. If desired, select one or more Related Fields.

You can also display notes from related entities by including those fields in the
configuration. For example, you can display notes for the account and contact
associated with a customer service case by selecting the Account and Contact fields on
the Case form.

5. Click Submit.
The configuration is added to the Special Handling Configuration list.

Configure a form to show special handling notes

Last updated: July 26, 2018
Last updated: July 26, 2018

Display special handling notes on a form in a list or pop-up window.

Before you begin

Role required: sn_shn.admin
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Procedure

1. Navigate to a form.
2. Right-click the form header and select Configure > Form Layout.
3. Select one of the following from the Available column and move it to the Selected

column.
• Special Handling Notes List
• Special Handling Notes Pop Up

4. Click Save.

Configure special handling notes properties

Last updated: July 26, 2018
Last updated: July 26, 2018

Configure the necessary properties to display special handling notes.

Before you begin

Role required: sn_shn.admin

About this task

Procedure

1. Navigate to Special Handling Notes > Properties.
2. Configure the following properties.

Option Description

Display special handling notes only once per
session

Special handling notes are displayed each time
you access a record. Enable this property to
display special handling notes only once per
session.

Maximum number of notes displayed in the
Special Handling Notes pop-up window

Increase or decrease this number as desired.
The default is 20 alerts.

Width of the Special Handling Notes pop-up
window in pixels

The width of the pop-up window in pixels. The
default width is 500. If you specify less that
300, the window automatically uses the
default width.

3. Click Save.

Create a special handling note

Last updated: July 26, 2018
Last updated: July 26, 2018

Create a special handling note for a record.

Before you begin

Role required: sn_shn.admin or sn_customerservice_manager

About this task
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If users have the sn_customerservice_manager role, they can create a special handling note
for a record.

Procedure

1. Perform one of the following actions.
• Navigate to the desired form and click the Create Special Handling Note related link.
• Navigate to Special Handling Notes > Special Handling Notes and click New.

2. Fill in the fields, as necessary.

Special Handling Notes form fields
Field Description
Short Description A brief description of the note which is

displayed in the Special Handling Notes list.

Message The detailed content of the note.

Display as pop-up alert Displays this note in the Special Handling Notes
pop-up window.

Type The type of special handling note:
• Standard: Create a note for a specific

record, which you select in the Related
record field.

• Conditional: Create a note for multiple
records which meet certain conditions.
Select a Table name and then create
Conditions.

Priority The priority of the note:
• 1-Critical
• 2-High
• 3-Moderate
• 4-Low

Status The status of the special handling note:
• 1-Active: The note is active and appears in

the Notes list or pop-up window.
• 2-Inactive: The note is inactive and does

not appear in the Notes list or pop-up
window.
Inactive notes are removed from the Notes
list but can be seen by navigating to
Special Handling Notes > Special Handling
Notes.

• 3-Expired: The note has reached its
expiration date.

Effective immediately Check box to make the special notes effective
immediately. The status is set to 1 -Active.
Deselect this check box to display the Effective
on field.

Effective on The date on which the special notes become
effective.
Enter a date for the special notes to become
effective and click Update. The status is set to 2
- Inactive until the date is reached.

Expires on The date on which the note expires. Select a
date from the calendar and click Save.
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Field Description
The Deactivate Special Handling notes
scheduled job runs daily at midnight and
checks all active alerts. If the notes have
reached their expiration date, it sets the status
to Expired.

The Deactivate Special Handling notes
scheduled job also checks the Effective on
field. If the status is active or inactive and the
expiry date has been reached, it sets the status
to Expired. If the status is inactive and the
effective on date has been reached, it sets the
status to Active.

Related record The record for which this note is created. This
field appears when you select Standard in the
Type field.
If you access this form from the Create Special
Handling Notes related link, the record number
is automatically filled in.

To select a record, select a Table name and a
Document from the pop-up window. The tables
available for selection have been configured to
use special handling notes.

Table name The table that stores the entity for which the
note is being created. This field appears when
you select Conditional in the Type field.
The default is the first table which has been
configured to use special handling notes.

After you select a table, a link is displayed with
the number of matching records. This link is
updated after you select one or more
conditions. Click the link to display these
records in a list.

Conditions This field appears when you select Conditional
in the Type field.
Use the buttons in this field to build one or
more conditions on the selected table. A
condition is made up of a selected field, an
operator, and a value. Add conditions using the
AND and OR buttons. Delete conditions by
clicking the Delete button to the right of a
condition.

3. Click Submit.

Update a special handling note

Last updated: July 26, 2018
Last updated: July 26, 2018

Update a special handling note for a record.

Before you begin
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Role required: sn_customerservice_agent, sn_customerservice_manager, sn_shn.editor, or
sn_shn.admin

About this task

Users with the sn_customerservice_manager role can update a special handling note for a
record if they can update a record for the underlying table.

Procedure

1. Navigate to Special Handling Notes > Special Handling Notes.
You can also update a note from the Special Handling Notes list on a form.

2. In the Special Handling Notes list, click the note to be updated.
3. Make any necessary changes to the fields on the Special Handling Notes form.
4. Click Update.

Delete a special handling note

Last updated: July 26, 2018
Last updated: July 26, 2018

Delete a special handling note for a record.

Before you begin

Role required: sn_customerservice_manager or sn_shn.admin

About this task

Users with the sn_customerservice_manager role can delete a special handling note for a
record if they can delete a record for the underlying table.

Procedure

1. Navigate to Special Handling Notes > Special Handling Notes.
You can also delete a note from the Special Handling Notes list on a form.

2. In the Special Handling Notes list, click the note to be deleted.
3. Click Delete.

Delete a special handling note from a form

Last updated: July 26, 2018
Last updated: July 26, 2018

Delete a special handling note for a record from the Special Handling Notes list on the form.

Before you begin

Role required: sn_customerservice_manager or sn_shn.admin

About this task

Users with the sn_customerservice_manager role can delete a special handling note for a
record if they can delete a record for the underlying table.

Procedure
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1. Navigate to an entity form.
2. In the Special Handling Notes list, click the red X to the left of the desired note.

Initially, the note remains in the Special Handling Notes list and the text of the note is
crossed out. The note is removed from the list after the form is saved.

3. Click Update.

Agent calendar
Last updated: July 26, 2018
Last updated: July 26, 2018

Customer service agents and field service technicians can use the agent calendar to see
work schedules and assignments and also add personal events such as meetings or
appointments.

The agent calendar provides a tool for maintaining different work schedules or shifts and
assigning agents and technicians to shifts for specific time periods. The calendar has the
flexibility to accommodate work schedules that are fixed or varied and shifts that rotate by
week, month, or other patterns. The agent calendar administrator creates the calendar
configuration, including a schedule configuration for each calendar user and the types of
tasks to display on the calendar.

The schedule information stored in the agent calendar is used by other ServiceNow
applications and features, such as the assignment workbench, central dispatch, and auto
assignment. The assignment workbench uses agent availability, based on upcoming work
schedules and personal time off, when evaluating predefined criteria and recommending
agents for case assignment. Auto assignment in Service Management core applications,
such as Field Service Management and Facilities Service Management, evaluate agent work
schedules before assigning tasks.

The agent calendar administrator has access to the Agent Schedule menu in the application
navigator. This menu includes the following modules:

• Event Configuration: create a configuration for each type of task displayed on the agent
calendar.

• Work Schedule: create one or more work schedules for each calendar user.
• Agent Personal Events: create personal schedules for each agent and add events to those

schedules.
• Schedule: create or modify schedules. For more information, see Schedules.

Viewing the calendar

Customer service agents and field service technicians with the agent_schedule_user role
can access their personal calendars in the following ways:

• Customer Service > My Schedule
• Field Service > Agent > My Schedule

Note:  The agent calendar is supported in the mobile application and the mobile
web.
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Agent Calendar

The calendar can display a single day, a week, or a month. Buttons in the calendar header
allow you to switch views as well as go backward or forward in time. An agent's scheduled
work hours are highlighted in gray and the current day is highlighted in blue. The agent
calendar displays work or tasks assigned to the agent as well as personal events. Each type
of event is displayed on the calendar using a different color.

Agents can add events to their calendars by double-clicking a specific time slot and entering
the details in the New Event popup window or by clicking and dragging. Agents can also
move events by dragging and dropping. Click an event to display a popup with event details
and double-click an event to open the event record.

Plugins

The Agent Schedule plugin (com.snc.agent_schedule) is activated as part of the Customer
Service Management and Field Service Management plugins.

Tables

The Agent Schedule plugin adds the following tables.

Table Description
Agent Work Schedule
[agent_work_schedule]

Stores one or more work schedules for each
agent, including the date range for the schedule
and the schedule type.
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Table Description
Agent Personal Schedule
[agent_events]

Stores personal calendar events for each agent,
such as training, personal time off, or meetings.

Event Configuration
[agent_schedule_task_config]

Stores a configuration for each type of task
displayed on the agent calendar, such as case
tasks or work order tasks.

Agent Schedule User Config
[agent_schedule_user_pref]

Stores the agent’s personalization data for the
calendar. A user configuration is created
automatically when a user with the
agent_schedule_user role accesses their personal
calendar.

Agent Schedule Relationship
[agent_schedule_task_config_rel_user_pref]

Stores the relationships between agent
configurations and event configurations.
Relationship entries are created automatically
based on a user's read access to the task tables
selected in the event configurations.

Agent Schedule Definition Theme
[agent_schedule_definition_theme]

Stores the colors used to display different types
of tasks on the agent calendar.

User Roles

The Agent Schedule plugin adds the following user roles.

Role Description
Agent schedule administrator
[agent_schedule_admin]

Sets up the Agent Calendar configuration.
Contains roles:

• agent_schedule_user
• schedule_admin

Agent schedule user
[agent_schedule_user]

Allows customer service agents and field service
technicians to access and update their personal
calendars.

• Configure the agent calendar

Users with the agent calendar administrator role can perform several calendar
configuration tasks.

• Add an event to the agent calendar

Users with the agent schedule user role can add events to their personal calendar.

• Move an event on the agent calendar

Users with the agent schedule user role can move events on their personal calendar.

• Show or hide event types on the agent calendar

Users with the agent schedule user role can personalize their calendar and show or hide
different types of events.

• Use the agent calendar
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Users with the agent calendar user role can add events to their personal calendar and
configure the calendar to show or hide different types of events.

Related Concepts

• Schedules

Configure the agent calendar

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the agent calendar administrator role can perform several calendar configuration
tasks.

These tasks include:

• Creating one or more schedule configurations for each calender user.
• Creating an event configuration for each type of task to display on the calendar.
• Creating a work schedule to assign to an agent.

If necessary, agent calendar administrators can create personal events for a calendar user
although the users themselves typically perform these tasks.

• Create an event configuration for the agent calendar

Users with the agent schedule administrator role can create a configuration for each type
of task displayed on the agent calendar, such as case tasks or work order tasks.

• Create a work schedule for an agent or technician

Users with the agent schedule administrator role can create one or more work schedules
for a customer service agent or a field service technician.

• Create a personal event for an agent or technician

Users with the agent schedule administrator role can create personal events that appear
on an agent's personal calendar.

• Create a schedule to use with the agent calendar

Users with the agent calendar administrator role can create a schedule to use with the
agent calendar.

Create an event configuration for the agent calendar

Users with the agent schedule administrator role can create a configuration for each type of
task displayed on the agent calendar, such as case tasks or work order tasks.

Before you begin

Role required: agent_schedule_admin

About this task

Event configuration records are included for case tasks, work order tasks, and appointments.
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Procedure

1. Navigate to Agent Schedule > Event Configuration.
2. Click New.
3. Fill in the fields on the Event Configuration form, as necessary.

Field Description
Name A descriptive name for this configuration.

Task Table The table where the tasks for this type of
configuration are stored.

Task Filter Use the condition builder to create the desired
conditions for the selected task type.
For example, the event configuration for Case
Tasks includes a filter on the task State field to
display only those tasks that are open.

Task User Field Select a field from the Task Table that provides
the user assigned to the task.
For example, the event configuration for Case
Tasks uses the Assigned To field from the Task
table [sn_customerservice_task]. When a case
task is assigned, it appears on the agent
calendar for the user selected in this field.

Display Field Select a field from the Task Table that provides
the information to be displayed for this event
type on the agent calendar.
For example, the event configuration for Case
Tasks uses the Subject field from the Task table
[sn_customerservice_task]. When a case task is
assigned, the subject of the task appears on
the agent calendar.

Start Date Field Select a field from the Task Table that provides
the start date for the task.
For example, the event configuration for Case
Tasks uses the Expected start field from the
Task table [sn_customerservice_task]. When a
case task is assigned, it appears on the agent
calendar starting on the date and time
specified in this field.

End Date Field Select a field from the Task Table that provides
the start date for the task.

For example, the event configuration for Case
Tasks uses the Due date field from the Task
table [sn_customerservice_task]. When a case
task is assigned, it appears on the agent
calender it appears on the agent calendar
ending on the date and time specified in this
field.
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Field Description

Note:  Because the agent schedule
administrator can select any
fields from the Task Table for
the Start Date Field and the End
Date Field, it is possible that the
end date may be earlier than
the start date. In this event, the
task is displayed on the agent
calendar between the two
points in time.

Color theme Select the color used to display this type of
task on the agent calendar.

4. Click Submit.

Create a work schedule for an agent or technician

Users with the agent schedule administrator role can create one or more work schedules for
a customer service agent or a field service technician.

Before you begin

Role required: agent_schedule_admin

About this task

A work schedule includes a date range and a schedule type, such as day shift or evening
shift. Agents and technicians can have multiple work schedules.

Procedure

1. Navigate to Agent Schedule > Work Schedule.
2. Click New.
3. Fill in the fields on the Agent Work Schedule form, as necessary.

Agent Work Schedule form
Field Description
From Date The first day of the work schedule.

To Date The last day of the work schedule.

User The selected agent or technician.

Work Schedule The selected schedule from the Schedules list.

Type The type of work that the agent or technician is
performing during this schedule:

• Primary work
• Other

An agent can have only one primary schedule
for a specific range of dates. Primary schedules
cannot overlap.

4. Click Submit.

August 6, 2018 ©2018 ServiceNow. All rights reserved. 144

ServiceNow | Customer Service Management



Create a personal event for an agent or technician

Users with the agent schedule administrator role can create personal events that appear on
an agent's personal calendar.

Before you begin

Role required: agent_schedule_admin

About this task

Agents and technicians typically add personal events to their own calendars.

Procedure

1. Navigate to Agent Schedule > Agent Personal Events.
2. Select the personal schedule for the desired agent.
3. In the Schedule Entries related list, click New.
4. Fill in the fields on the Schedule Entry form, as necessary.

Schedule Entry form
Field Description
Name The name of the event.

Type The type of event:
• Time off
• Appointment
• Meeting
• Phone call
• Excluded
• On call
• Time off - in approval
• Time off - rejected

Show as Show this event on the agent's personal
calendar as one of the following:

• Busy
• Free
• Tentative
• On call

Select Busy to exclude the block of time from
agent availability calculations for the auto
assignment and the case assignment
workbench.

When The start date and time of the personal event.

To The end date and time of the personal event.

All day Enable this check box if the event lasts all day.

Repeats Create a repeating event by selecting the
frequency. Depending on the selection, other
fields are required to complete the frequency
information.

• Does not repeat
• Daily
• Every Weekday (Mon-Fri)
• Every Weekend (Sat, Sun)
• Every Mon, Wed, Fri
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Field Description
• Every Tue, Thu
• Weekly
• Monthly
• Yearly

Repeat every Enter a number for the frequency of the
repeated event.

Repeat on For weekly events, select a day of the week.

Monthly type For monthly events, select one of the following.
These selections use the day and date in the
When field as the basis for repetition.

• Day of the month
• Day of the week
• Last day of the month
• Last week of the month

Yearly type For monthly events, select one of the following:
• Day of the year: this selection uses the day

and date in the When field as the basis for
repetition.

• Floating: for this selection, complete the
Float week, Float day, and Float month
fields.

Repeat until Select a date for the end of the repeated event.

Float week For a floating yearly repeating event, select the
week.

Float day For a floating yearly repeating event, select the
day.

Float month For a floating yearly repeating event, select the
month.

5. Click Submit.

Create a schedule to use with the agent calendar

Users with the agent calendar administrator role can create a schedule to use with the agent
calendar.

Before you begin

Role required: agent_schedule_admin

About this task

Creating a schedule for the agent calendar uses the schedule feature. For more information,
see Schedules.

Schedules are configured with two types of records.

• Schedule records specify a time zone and a type of schedule and use one or more
schedule entries. Schedule records are saved in the Schedule [cmn_schedule] table.

• Schedule entry records specify the time periods that are included or excluded from a
schedule. Schedule entries are saved in the Schedule Entry [cmn_schedule_span] table.

Procedure
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1. Navigate to Agent Schedule > Schedule.
2. Click New.
3. Complete the fields on the Schedule form.

Field Description
Name Enter a unique name for the schedule.

Time Zone Select the time zone for the schedule. If you
select Floating, the time zone will be relative to
whatever is accessing the item at any given
time.

Parent Select a parent schedule to constrain the new
schedule.

Type Enter a label that describes the purpose of the
schedule. You can also use one of these system
terms to determine how to process certain
schedules:

• excluded: excludes time periods from SLA
counts.

• maintenance: specifies time periods where
change management activities are allowed.
A schedule containing maintenance
schedule entries cannot also contain
blackout schedule entries.

• blackout: excludes time periods from
change management schedules. A
schedule containing blackout schedule
entries cannot also contain maintenance
schedule entries.

Description [Optional] Describe the schedule.

Note:  The Schedule form displays a warning message if there are no active
entries defined for the current schedule. If your schedule is a child
schedule that only contains exclusions, ignore the message because
exclusions are non-active entries.

4. Right-click the header bar and click Save.

Note:  If you create a schedule of type maintenance and save the record, a UI
policy hides the Type field from the form. To view or change the value for
the Type field, view the list of schedules rather than the schedule form
and add the Type column if necessary. You can double-click the cell for
the value in the Type column and modify from the list view.

5. Configure one or more schedule entries.
6. Click Submit.

Add an event to the agent calendar

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the agent schedule user role can add events to their personal calendar.

Before you begin
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Role required: agent_schedule_user

Procedure

1. Navigate to your calendar.
• Customer Service > My Schedule
• Field Service > Agent > My Schedule

2. Double-click a timeslot or click and drag over a timeslot on the calendar to open the
New Event form.

3. Fill in the fields on the New Event form, as necessary.

Field Description
Name The name of the event.

Type The type of event:
• Time off
• Appointment
• Meeting
• Phone call
• Excluded
• On call
• Time off - in approval
• Time off - rejected

Show as Show this event on the agent's personal
calendar as one of the following:

• Busy
• Free
• Tentative
• On call

Select Busy to exclude the block of time from
agent availability calculations for the auto
assignment and the case assignment
workbench.

When The start date and time of the personal event.

To The end date and time of the personal event.

All day Enable this check box if the event lasts all day.

Time zone [Read only] If an agent has selected a specific
time zone in their user profile, that time zone is
displayed here and is used as the time zone for
this event. Subsequent changes to the Time
zone field in the user profile do not change the
time zone designation for this event.

Repeats Create a repeating event by selecting the
frequency. Depending on the selection, other
fields are required to complete the frequency
information.

• Does not repeat
• Daily
• Every Weekday (Mon-Fri)
• Every Weekend (Sat, Sun)
• Every Mon, Wed, Fri
• Every Tue, Thu
• Weekly
• Monthly
• Yearly
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Field Description
Repeat every Enter a number for the frequency of the

repeated event.

Repeat on For weekly events, select a day of the week.

Monthly type For monthly events, select one of the following.
These selections use the day and date in the
When field as the basis for repetition.

• Day of the month
• Day of the week
• Last day of the month
• Last week of the month

Yearly type For monthly events, select one of the following:
• Day of the year: this selection uses the day

and date in the When field as the basis for
repetition.

• Floating: for this selection, complete the
Float week, Float day, and Float month
fields.

Repeat until Select a date for the end of the repeated event.

Float week For a floating yearly repeating event, select the
week.

Float day For a floating yearly repeating event, select the
day.

Float month For a floating yearly repeating event, select the
month.

4. Click Submit.
The new event appears on the agent calendar and also in the Schedule Entries related
list on the Agent Personal Schedule form.

Move an event on the agent calendar

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the agent schedule user role can move events on their personal calendar.

Before you begin

Role required: agent_schedule_user

Procedure

1. Navigate to your calendar.
• Customer Service > My Schedule
• Field Service > Agent > My Schedule

2. Use one of the following methods to move an event.

Option Description

Click an event and drag it to a new day or time The When and To fields in the event record are
updated with the new information.

Double-click an event to open the event record Change the date and time information in the
When and To fields and click Submit. The event
appears on the calendar in the new location.
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Show or hide event types on the agent calendar

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the agent schedule user role can personalize their calendar and show or hide
different types of events.

Before you begin

Role required: agent_schedule_user

Procedure

1. Navigate to your calendar.
• Customer Service > My Schedule
• Field Service > Agent > My Schedule

2. Click the configuration icon in the calendar header to display the Schedule Configuration
menu.

3. Enable or disable the switches for the different types of events.
An option is enabled when the switch is moved to the right and appears with a green
background.

4. Click the configuration icon again to hide the Schedule Configuration menu.
The calendar displays the enabled task types.

Mandatory skills
Last updated: July 26, 2018
Last updated: July 26, 2018

Use the mandatory skills feature to identify any skills that are required for agents and
technicians to work on customer service cases and field service work orders and tasks. Then
assign cases and tasks to agents and technicians who have those required skills.

When assigning cases, work orders, and work order tasks, the assignment tools consider the
mandatory skills, filter out agents and technicians who do not have these skills, and then
rank the remaining agents.

• If agents with the mandatory skills are available, the cases and tasks are assigned to these
agents.

• If agents with the mandatory skills are not available, then agents with any other, non-
mandatory skills identified in the cases and tasks are ranked and assigned.

Field service dispatchers (wm_dispatcher), field service technicians (wm_agent), customer
service managers (sn_customerservice_manager), and customer service agents
(sn_customerservice_agent) can specify both skills and mandatory skills for cases and tasks.

Mandatory skills is an optional feature. Mandatory skills can be identified on the assignment
workbench. In addition to the Skills list, the assignment workbench includes a Mandatory
Skills Added list. Agents are ranked in the workbench based on the number of skills that
match the skills identified in the Skills list. If the mandatory skills feature is being used, then
the agents displayed are filtered by the skills listed in the Mandatory Skills Added list and
then ranked by the other matching criteria.
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Related Topics

• Use the assignment workbench

Configuring the mandatory skills feature

Last updated: July 26, 2018
Last updated: July 26, 2018

Configure the mandatory skills feature for use with the Customer Service Management and
Field Service Management applications.

Mandatory skills is an optional feature included with the Customer Service Management and
Field Service Management plugins. Use the steps below to configure this feature with the
desired application.

Customer Service Management configuration

To configure the mandatory skills feature for use with Customer Service Management:

• In the Case form:
Configure the form layout to use the Task Skills [task_m2m_skill] table.
In the Task Skills table, set the Mandatory field to True to identify skills that are

mandatory to complete a task.

Note:  The Case form should use either the Skills field or the Task Skills table, but
not both.

• [Optional] For existing cases that have data populated in the Skills field on the Case form,
run the Migrate Skills to Task Skill M2M script to move this data to the Task Skills table. By
default, this fix script migrates the skills from existing entries in the Case, Work Order, and
Work Order Task tables to the Task Skills table. For more information, see Migrate skills to
the Task Skill table.

• If you are using the assignment workbench, replace the Matching Skills matching criteria
with the Matching Skills - Mandatory Skills Support matching criteria. For more
information, see Matching rules for case assignment.

Field Service Management configuration

To configure the mandatory skills feature for use with Field Service Management:

• Enable the work.management.use.mandatory.skills system property.
• Configure the Work Order form and the Work Order Task form to use the Task Skills

[task_m2m_skill] table.

Note:  The Work Order and Work Order Task forms should use either the Skills
field or the Task Skills table, but not both.

• [Optional] For existing work orders and tasks that have data populated in the Skills field
on the Work Order and Work Order Task forms, run the Migrate Skills to Task Skill M2M
script to move this data to the Task Skills table. By default, this fix script migrates the skills
from existing entries in the Case, Work Order, and Work Order Task tables to the Task Skills
table. For more information, see Migrate skills to the Task Skill table.

• If you are using dynamic scheduling, update the task filter for the dynamic scheduling
configuration and replace the Matching Skills for Dynamic Scheduling matching criteria
with the Matching Mandatory Skills for Dynamic Scheduling matching criteria. For more
information, see Create a task filter.
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Mandatory Skills system properties

The Migrate Skills to Task Skill M2M script migrates skills from existing tasks to the Task Skills
[task_m2m_skill] table. Configure the task tables included in the migration using the
skills_management.migration system property.

The mandatory skills feature adds the following system properties.

Note:  To open the System Property [sys_properties] table, enter sys_properties.list in
the navigation filter.

System parameter Definition
work.management.use.mandatory.skills Enables the mandatory skills feature and indicates that

the Task Skills [task_m2m_skill] table is being used for
work orders and work order tasks.

• Type: true/false
• Default value: false

skills_management.migration Lists the task tables to migrate to the Task Skills
[task_m2m_skill] table when an admin runs the Migrate
Skills to Task Skill M2M script.

• Type: choice list
• Default value:

wm_task,customerservice_case,wm_order

com.snc.skills_management.task_skill_migrated_tablesContains a list of tables for which the Skills field has
already been migrated to the Task Skills
[task_m2m_skill] table. If the table name is listed in this
property, the data has been migrated and will not be
migrated again.

• Type: choice list
• Default value: none

Migrate skills to the Task Skill table

Last updated: July 26, 2018
Last updated: July 26, 2018

Migrate data from the Skills field to the Task Skills table to utilize mandatory skills support
for executing tasks in a case or work order.

Before you begin

Role required: wm_admin, admin

About this task

The Task Skills [task_m2m_skill] table stores skills and mandatory skills.

In the Customer Service Management application, the assignment workbench uses the Task
Skills table instead of the Skills field in the Case table to display agents based on the
evaluation criteria for task assignments.
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In the Field Service Management application, the work order task assignments done using
auto-assignment, dynamic scheduling, and central dispatch use the Task Skills table instead
of the Skills field in the Work Order and Work Order Task tables to assign agents for task
assignments.

Procedure

1. Add a system property with the following settings:

Option Description

Create a system property for a table in the
Customer Service Management application. Make sure that you are logged in to the

Customer Service Management application.

Note:  Configure the System
Properties form to display the
Suffix field.

In the Suffix field, enter the name of the system
property as follows:
com.snc.skills_management.<table_name>_migrate_skills,
where <table_name> is the name of a case
task table from which the skills need to be
copied.

Create a system property for a table in the
Field Service Management application.

Make sure that you are logged in to the Global
application.

In the Name field, enter the name of the
system property in the following format:
com.snc.skills_management.<table_name>_migrate_skills,
where <table name> is the name of a work
order or work order task table from which the
skills need to be copied.

2. In the Type field, set the value to true.
3. Click Update.
4. Navigate to System Definition > Fix Scripts and run the Migrate Skills to Task Skill M2M

fix script.
The skills are copied to the task_m2m_skill table. The name of the table from which the
skills are copied gets appended to the
com.snc.skills_management.task_skill_migrated_tables system property. When the
script is run again, it ignores all tables from which skills have already been migrated.

Assignment workbench
Last updated: July 26, 2018
Last updated: July 26, 2018

The assignment workbench enables customer service managers to assign tasks to agents
efficiently and intelligently. The workbench uses configurable criteria, such as skills and
availability, to evaluate the agents in a selected group and provide an overall ranking.
Managers can view these results and click one button to assign a task.

The assignment workbench displays all the relevant information for task assignment,
including:
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• A list of the agents in the task assignment group.
• The matching criteria used to evaluate the agents.
• An overall ranking for each agent in the assignment group.
• A filter with the current assignment group and the skills identified for the task, including

any mandatory skills.

Assignment Workbench

Agents are ranked from 1 to any number based on the criteria configured for the workbench.
The more criteria that matches, the higher an agent's rank. When the criteria for two agents
is the same, the agents have the same rank. Point to an agent's rank to display the details.

Use the filter to change the assignment group and to add or remove skills. Changes to the
assignment group or to the skills lists are reflected immediately in the workbench:

• Changing the assignment group displays a different list of agents.
• Adding or removing skills can change the agent ranking.

If you are using the mandatory skills feature, the agents displayed in the assignment
workbench are filtered by the skills in the Mandatory Skills Added list and then ranked by the
other matching criteria.

Note:  Agents cannot add or remove mandatory skills or make a skill not mandatory.

Configuring the assignment workbench

The assignment workbench configuration is stored in a matching rule that is based on the
Selection criteria matching type. The default configuration uses the Recommendation for
Case Assignment matching rule, which includes three of the four default matching criteria:

• Availability Today
• Matching Skills
• Assigned Cases
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Based on these matching criteria, the workbench calculates and displays an overall rank for
each agent in the group. You can modify or create matching criteria and the
Recommendation for Case Assignment matching rule as needed or you can create your own
configuration following these steps:

1. Create one or more matching criteria.
2. Create a matching rule with the Selection criteria matching type.
3. Open the matching rule and add the desired matching criteria.

If you are using mandatory skills, you must replace the Matching Skills criterion in this
matching rule with the Matching Skills - Mandatory Skills Support criterion to match agents
with mandatory skills required for a case.

Using the assignment workbench

Access the assignment workbench by clicking the Find Agents icon ( ) next to the
Assigned to field on the task form.

Note:  The state of the current record determines the availability of the Find Agents
icon. The icon is available for records in the Open, Awaiting, and Cancelled
states, and if the user has write access for the Assigned to field. The icon is
not available for records in the New or Closed states or when the Assigned to
field is read-only for the current user.

Sort the list of agents by any of the matching criteria by clicking the desired column header,
which reorders the suggested agents based on the selected criteria.

Select a different assignment group from the Group list in the filter. The list of agents is
updated based on the selection. If the selected group does not contain any agents, a
message is displayed to select another group.

Add or remove skills from the Skills list in the filter. These selections are reflected in the
Matching Skills column.

Skills that have been identified as mandatory for a task are displayed in the Mandatory Skills
Added list. These selections are also reflected in the Matching Skills column. You cannot add
or remove skills from this list.

Select an agent and click Assign to assign the task. The workbench closes and returns to the
Case form. The Assigned to field is updated with the selected agent. Click Save on Case
form to save this assignment.

Plugins

The Assignment Workbench plugin (com.snc.assignment_workbench) is activated as part of
Customer Service Management.

The Case Assignment Workbench Demo plugin
(com.snc.case_assignment_workbench_demo) provides demo data for the workbench.

Tables

Assignment Workbench adds the following tables.
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Table Description
Matching Criteria
[matching_dimension]

Stores the matching criteria that can be used to
create a configuration for the assignment
workbench.

Select Criteria
[matching_dimension_for_assignment]

Stores the matching criteria for an assignment
workbench configuration matching rules.

Matching Rule
[matching_rule]

Stores matching rules, including the matching
rules that configurations for the assignment
workbench.

User Roles

Assignment Workbench adds the following roles.

Role title [name] Description Contains roles
Assignment workbench
[assignment_workbench]

Provides access to the
assignment workbench for
customer service agents and
consumer service agents.

• skill_user

Properties

Assignment Workbench adds the following properties.

Property Description
assignment_workbench.find.agents.title Title for the macro button.

• Type: string
• Default value: Find Agents
• Location: Routing and Assignment > Properties

assignment_workbench.new.window When enabled, opens the assignment workbench
in a new window.

• Type: true | false
• Default value: false:
• Location: Routing and Assignment > Properties

assignment_workbench_no_of_agents Number of agents per page. (To get better
performance, do not use more than 50 agents
per page.)

• Type: choice list
• Default value: 30
• Location: Routing and Assignment > Properties

• Matching criteria for case assignment

The assignment workbench uses configurable matching criteria, such as skills and
availability, to evaluate the agents in a selected group and provide an overall ranking.

• Matching rules for case assignment
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Use a matching rule to create a configuration for the assignment workbench.

• Create assignment workbench matching criteria

Create one or more matching criteria that can be used in an assignment workbench
configuration.

• Create an assignment workbench configuration

Use a matching rule to create a configuration for the assignment workbench.

• Set assignment workbench properties

Set the properties related to the assignment workbench display.

• Assign a case from the workbench

Users with the customer service manager role can assign a case to an agent from the
assignment workbench.

Matching criteria for case assignment

Last updated: July 26, 2018
Last updated: July 26, 2018

The assignment workbench uses configurable matching criteria, such as skills and
availability, to evaluate the agents in a selected group and provide an overall ranking.

There are three types of matching criteria:

• Simple Match: creates one-to-one matching, such as matching the time zone of an agent
with the time zone of a task location.

• Aggregate: uses a simple query and returns an aggregate result. For an aggregate type,
select a table and create a filter, and then select an aggregate field such as the Assigned to
field. This type of query returns a set of users.

• Scripted: uses a scripted query which returns a list of users.

Several matching criteria are provided with the assignment workbench:

• Availability Today: Availability is calculated based on the agent's work schedule, assigned
work, and personal time off. The more availability an agent has, the higher the contribution
to the agent's overall rank.

• Matching Skills: The number of agent skills that match the skills required for the case. The
more skills that match, the higher the contribution to the agent's overall rank.

• Matching Skills - Mandatory Skills Support Calculates the number of agent skills that match
the mandatory skills. It does this by filtering out all agents who do not have the mandatory
skills and ranks the remaining agents. The more skills that match, the higher the
contribution to the agent's overall rank.

Note:  If using the mandatory skills feature, use the Matching Skills - Mandatory
Skills Support criterion to match agents with the mandatory skills identified
for a case.

• Assigned Cases: The number of cases already assigned to this agent. The more cases
assigned, the lower the contribution to the agent's overall rank.

• Last Assigned: For the sake of balancing assigned work, prioritized the agent based on the
last assigned work.
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To create matching criteria, select the type and use the fields related to that type to build
the query. After creating matching criteria, you can create a configuration for the
assignment workbench by creating a matching rule of the type Selection criteria and
selecting the desired matching criteria.

As part of selecting the matching criteria for the workbench configuration, you can specify
the following settings for each individual criterion:

• ranking and display usage
• ranking method
• ranking weight
• threshold
• active/inactive

Ranking and display usage

In the Use for field, specify how you want that matching criterion to be used:

• Ranking and display: uses the criterion to determine agent ranking and displays it in a
column on the workbench.

• Display only: displays the criterion in a column on the workbench but does not use it to
determine agent ranking.

• Ranking only: uses the criterion to determine agent ranking but does not display it on the
workbench.

Ranking method

There are two ranking methods:

• More is better: for example, more availability is better when determining the agent ranking.
• Less is better: for example, fewer assigned cases are better when determining agent

ranking.

Weight

Each matching criterion has an assigned weight. By default, the matching criteria in the
Recommendation for Case Assignment matching rule have an assigned weight of 10. You
can assign a higher weight to the criteria that are more important.

Threshold

A threshold sets a minimum requirement for a criterion. For example, set the threshold of
the Matching Skills criterion to 3 if you want to see only those agents who have at least
three of the required skills for a task. For availability, set the threshold to the desired number
of hours to display only those agents who have that minimum number of work hours
available. You can set the threshold in the Select Criteria related list on the Matching Rule
form. If necessary, personalize the list and add the Threshold column.

Active/Inactive

There can be several matching criteria associated with the matching rule that determines
the assignment workbench configuration. Each individual criterion can be set to active or
inactive. Changing this setting has an immediate impact on the agent ranking. You can make
this change in the Select Criteria related list on the Matching Rule form. If necessary,
personalize the list and add the Active column.
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Calculating the agent ranking

The assignment workbench adds the values of the matching criteria and their respective
weights and uses these values to determine the overall agent ranking.

1. Calculate a number for each criterion.
2. Multiply that number by the criterion weight.
3. Divide the result by the total of all criterion.
4. Repeat for each criterion and add the results.

The following example shows how the ranking is determined for an agent with these
matching criteria values:

• Matching Skills with Mandatory Skills Support: 5/6
• Availability Today: 7 hours
• Assigned Cases: 2

Calculations:

• Matching Skills - Mandatory Skills Support : 5 / 6 = 0.833 (with 5 being the maximum
number of skills that includes mandatory and rest of the skills)

• Availability Today: 7 / 8 = 0.875 (with 8 being the maximum number of hours)
• Assigned Cases: 2 / 26 = 0.0769 (with 26 being the total number of tasks in the table)
• Weight: each matching criteria has an equal weight of 10

((0.833 x 10) / Total of criterion weight (10+10+10)) + ((0.875 x 10) / Total of criterion weight (10+10+10)) + ((0.0769 x 10) / Total of criterion weight (10+10+10))

(8.33 / 30) + (8.75 / 30) + (0.769 / 30)

0.222 + 0.291 + 0.0256 = 0.5936

This calculation is performed for each agent in the assignment group. Agents are ranked
based on the value of this calculation, with the highest number earning the highest ranking.

Matching rules for case assignment

Last updated: July 26, 2018
Last updated: July 26, 2018

Use a matching rule to create a configuration for the assignment workbench.

The assignment workbench configuration is stored in a matching rule that is based on the
Selection criteria matching type.

The default configuration uses the Recommendation for Case Assignment matching rule,
which uses three of the four default matching criteria:

• Availability Today
• Matching Skills
• Assigned Cases

Note:  If using the mandatory skills feature, use the Matching Skills - Mandatory
Skills Support criterion to match agents with the mandatory skills identified
for a case.
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You can customize this matching rule to meet your specific need for calculating agent
recommendations. This matching rule can also be used for auto assignment if you create an
assignment rule.

Create assignment workbench matching criteria

Last updated: July 26, 2018
Last updated: July 26, 2018

Create one or more matching criteria that can be used in an assignment workbench
configuration.

Before you begin

Role required: admin

About this task

The assignment workbench uses configurable matching criteria, such as skills and
availability, to evaluate agents in a selected group and provide an overall ranking. The
Matching Criteria [matching_dimension] table stores the individual criterion that can be
added to a matching rule to create an assignment workbench configuration.

Procedure

1. Navigate to Routing and Assignment > Criteria.
2. Click New.
3. Enter a Name and a Description for the criterion.
4. Select the Type of matching criterion.

Option Description

Simple Match Creates a one-to-one match. For example,
match the time zone of an agent with the time
zone of a task location.

Aggregate Takes a simple query as an input and provides
aggregate results. The query returns a set of
users.

Scripted Includes a scripted query which returns a list of
users.

5. To create a Simple Match criterion, fill in the following fields.

Simple match criterion fields
Field Description
Applies to The type of task that this criterion applies to.

Field The field from the selected task table that you
want to match.

Resource Table The table that stores the resource to use for
this matching criterion.

Resource Matching Field The field from the resource table that you want
to match.
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Field Description
Resource Field The resource field to be displayed for the task

records that match the resource records.

6. To create an Aggregate criterion, fill in the following fields.

Aggregate criterion fields
Field Description
Aggregate Table The type of task that this criterion applies to.

Aggregate Filter Use the condition builder to create a query that
returns a set of users from the selected task
table.
For example, create a query that returns
customer service cases with the following
states: New, Open, Awaiting info.

Aggregate Field The field from the selected task table to be
displayed for the task records that match the
query conditions.

7. To create a Scripted criterion, fill in the following fields.

Scripted criterion fields
Field Description
Script Create a customized script which returns a list

of users. An example script is included. The
expected return from a customized script is an
array of resource sys_ids.

Aggregate Field The field from the selected task table to be
displayed for the task records that match the
query conditions.

8. (Optional) Enter a Display Name.
9. (Optional) Enable the Use Reference field.

If you use a reference field, fill in the following fields.

Reference fields
Field Description
Reference Table The table that stores the referenced

information.

Reference Filter Add filter conditions to return the desired
reference information.

Reference Field The field from the selected reference table to
be displayed for the records that match the
filter conditions.

UI Filter Label The label for this field that appears on the
assignment workbench

10. Click Submit.
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Create an assignment workbench configuration

Last updated: July 26, 2018
Last updated: July 26, 2018

Use a matching rule to create a configuration for the assignment workbench.

Before you begin

Role required: admin

About this task

The assignment workbench configuration is stored in a matching rule that is based on the
Selection criteria matching type. The default configuration uses the Recommendation for
Case Assignment matching rule, which includes three of the four default matching criteria:

• Availability Today
• Matching Skills
• Assigned Cases

You can modify or create matching criteria and then modify the Recommendation for Case
Assignment matching rule as needed or you can create your own configuration.

Procedure

1. Navigate to Routing and Assignment > Matching Rules to access the Matching Rules list.
2. Click New.
3. Enter a Name for the matching rule.
4. If desired, enter an Execution Order for the matching rule.

This is the order in which this matching rule is to be executed. Similar to business rules,
matching rules are processed based on execution order, from the lowest to the highest.

5. In the Applies To tab, select the Table that stores the task for which the matching rule is
being created.

6. Use the Conditions field to build one or more conditions on the selected table.
A condition is made up of a selected field, an operator, and a value. Add conditions
using the AND and OR buttons. Delete conditions by clicking the X to the right of a
condition.

7. In the Resource tab, select Selection Criteria in the Matching field.
8. Click Submit.
9. From the Matching Rules list, open the matching rule that you just created.

10. In the Select Criteria related list, click New.
This opens the Select Criterion form.

11. Select a Criterion from the Matching Criteria list.
12. Select how the criterion is to be used in the Use for field.

Option Description

Ranking and Display Uses the criterion to determine agent ranking
and displays it in a column on the workbench.

Display Only Displays the criterion in a column on the
workbench but does not use it to determine
agent ranking.

Ranking and No Display Uses the criterion to determine agent ranking
but does not display it on the workbench.
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13. Select a Ranking Method.

Option Description

More is better A higher value is better. For example, more
availability is better when determining the
agent ranking.

Less is better A lower value is better. For example, fewer
cases are better when determining the agent
ranking.

14. Click Submit.
15. Repeat steps 10 through 14 for each criterion to add to the matching rule.
16. If desired, change the weight of a criterion by double-clicking the Weight field in the

Select Criteria related list and entering a new weight.
Each matching criterion has an assigned weight. By default, the matching criteria in the
Recommendation for Case Assignment matching rule have an assigned weight of 10.
You can assign a higher weight to the criteria that are more important.

17. If desired, set the threshold for a criterion by double-clicking the Threshold field in the
Select Criteria related list and entering a threshold number.
A threshold sets a minimum requirement for a criterion. It may be necessary to
personalize the list and add the Threshold column.

18. If desired, set a criterion active or inactive by double-clicking the Active field in the
Select Criteria related list and selecting true or false.
Changing this setting has an immediate impact on the agent ranking. It may be
necessary to personalize the list and add the Active column.

Set assignment workbench properties

Last updated: July 26, 2018
Last updated: July 26, 2018

Set the properties related to the assignment workbench display.

Before you begin

Role required: admin

Procedure

1. Navigate to Routing and Assignment > Properties.
2. Set the following properties, as needed.

Option Description

Title for the macro button
[assignment_workbench.find.agents.title]

Creates the title for the macro button on the
task form. The default is Find Agents.

When enabled opens the assignment
workbench in a new window
[assignment_workbench.new.window]

Opens the assignment workbench in a new
window. The default is False.

Number of agents per page
)

Set this property to 20, 30, or 50 agents. To
get better performance, do not use more than
50 agents per page. The default is 30.

3. Click Save.
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Assign a case from the workbench

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the customer service manager role can assign a case to an agent from the
assignment workbench.

Before you begin

Role required: sn_customerservice_manager

Procedure

1. Open a customer service case.

2. Click the Find Agents icon ( ) next to the Assigned to field to open the assignment
workbench.
If the case has an Assignment group, the agents from that group are listed on the
workbench. If the case does not have an assigned group, no agents are displayed.

Note:  The state of the current record determines the availability of the Find
Agents icon. The icon is available for records in the Open, Awaiting, and
Cancelled states, and if the user has write access for the Assigned to field.
The icon is not available for records in the New or Closed states or when
the Assigned to field is read-only for the current user.

3. (Optional) Select an assignment group from the Group list.
The list of agents updates based on the selected group.

4. (Optional) Add or remove skills from the Skills list.
The selected skills appear in a list below this field. The Matching Skills column updates to
reflect the selected skills.

Note:  Mandatory skills cannot be changed.

5. (Optional) Sort the agents by clicking the column header for the desired matching
criteria.

6. Select an agent by enabling the check box by the agent's name and then click Assign.
The assignment workbench closes and the name of the selected agent appears in the
Assigned to field on the Case form.

7. Click Update to save the agent assignment.

Case and account escalation
Last updated: July 26, 2018
Last updated: July 26, 2018

Use the escalation feature to highlight specific cases or accounts and raise awareness of
important customer issues.

Escalating cases or accounts facilitates communication about an issue and enables users to
track progress toward a resolution. An escalation provides increased attention to a customer
issue and provides a way to track the progress made in resolving the issue. Escalation is an
internal process that is not exposed to customers.
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Users with the escalation requester role can escalate cases or accounts on behalf of
customers or for internal purposes. The escalation process can include an optional approval
step where approvers review the request and either approve or reject the escalation.

When an escalation is approved, an escalation record is created and is associated with the
case or account. Agents and escalation managers can manage the case or account through
the escalation process using the escalation record. Escalated cases and accounts are
identified on lists and forms with color indicators that correspond to the escalation severity.

Users with the de-escalation requester role can de-escalate cases or accounts when the
cause of the escalation is resolved.

While the escalation process is similar for cases and accounts, there are some important
differences to note between case escalations and account escalations. A customer service
agent typically manages a case escalation and works directly with the escalated case to
resolve the issue. An escalation manager typically manages an account escalation, which
can include multiple associated cases, and records details in the escalation record. See Case
and account escalation differences for more information.

• Case and account escalation differences

An overview of the differences between case escalations and account escalations.

• Case and account escalation process

The case and account escalation process follows several steps from request to
completion.

• Case and account escalation components

The roles, modules, and tables installed with the case and account escalation feature.

• Case and account escalation form

Customer service agents use the escalation form to manage escalations for cases and
accounts.

• Administer case and account escalation

The system administrator creates escalation templates and escalation severity definitions
that control the escalation process.

• Use case and account escalation

Users with the escalation requester role can request and manage case and account
escalations.

Case and account escalation differences

Last updated: July 26, 2018
Last updated: July 26, 2018

An overview of the differences between case escalations and account escalations.

• Case escalations: A customer service agent typically manages a case escalation and
performs most of the problem resolution work, which is recorded in the case record. For
case escalations, the escalation record is used primarily for status reporting purposes. The
escalation SLA is also associated with the case record rather than the escalation record
because that is where the agent provides regular updates.
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• Account escalations: An account escalation manager typically manages an account
escalation because it is associated with multiple underlying cases. An account manager
works with multiple case owners to resolve the customer escalation and uses the
escalation record to consolidate the status of the associated cases and provide regular
updates. Therefore, the SLA is associated with the escalation record.

Feature Case Escalation Account Escalation
Relationships Corresponds one-to-one to a

case.
Corresponds one-to-one to an
account. Users can link specific
cases to the escalation record to
indicate which cases are causing
the escalation.

Templates Uses case escalation templates. Uses account escalation
templates.

Approval workflow Includes an option to
automatically add the manager
of the case assignment group to
the approver list when using the
default approval workflow.

Does not include an option to
automatically add the manager
of the case assignment group to
the approver list because an
account escalation can be
associated with multiple cases.

Escalation assignment Does not include a separate
assignment. A case escalation
corresponds to an individual
case and the customer service
agent manages the escalation.

Includes a separate assignment.
An account escalation can have
multiple associated cases that
are assigned to different agents
so the escalation record includes
an Assigned to field. An account
escalation is typically assigned
to an escalation manager
because account escalations are
typically more serious than case
escalations.

Watch list Does not include an option to
automatically add an account
team to the escalation watch list.

Includes an option to
automatically add an account
team to the escalation watch list.

Escalation updates added to
case

Updates to the escalation record
are also added to the Work
notes field on the corresponding
case record.

Updates to the escalation record
are not added to the account
record.

SLAs The case escalation SLAs
provided with the escalation
feature are attached to the case.

The account escalation SLAs
provided with the escalation
feature are attached to the
account.

Case and account escalation process

Last updated: July 26, 2018
Last updated: July 26, 2018

The case and account escalation process follows several steps from request to completion.

1. A user with the escalation requester role requests an escalation for a case or account. As
part of the request, the user provides the following information:

• The reason for the request
• Justification for the escalation
• The escalation severity
• The escalation template
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• The watch list for the escalation
2. If approval is required, the approval workflow or approvers identified in the escalation

template review the request and accept or reject the escalation.
3. Following approval, the agent manages the escalation as it progresses using the

escalation form. For example, the agent can add users to the watch list and update the
escalation trend.

Note:  Updates to the escalation form send email notifications to the current
user and to users on the watch list.

4. When the issue has been resolved, a user with the de-escalation requester role can de-
escalate a case or an account.

Case and account escalation components

Last updated: July 26, 2018
Last updated: July 26, 2018

The roles, modules, and tables installed with the case and account escalation feature.

Roles

Roles included with the case and account escalation feature.

Role Description
Escalation requester
(sn_customerservice.escalation_requester)

Can request an escalation for a case or account.

De-escalation requester
(sn_customerservice.deescalation_requester)

Can de-escalate a case or account. This role
contains the
sn_customerservice.escalation_requester role.

Escalation modules

The case and account escalation feature adds the Escalations module to the Customer
Service menu:

• All: lists all escalation records for cases and accounts.
• Escalation Templates: lists the case and account escalation templates.
• Escalation Severity: lists the types of escalation severity.

This feature also adds a list of escalated cases to the Customer Service menu: Customer
Service > Cases > Escalated

Tables

Tables included with the case and account escalation feature:

Table Description
Escalation Templates
[sn_customerservice_escalation_template]

Stores escalation template records.

Escalations
[sn_customerservice_escalation]

Stores records created for escalated cases and
accounts.
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Table Description
Escalation Severities
[sn_customerservice_escalation_severity]

Stores escalation severity definition records.

Case and account escalation form

Last updated: July 26, 2018
Last updated: July 26, 2018

Customer service agents use the escalation form to manage escalations for cases and
accounts.

The escalation form includes information about the escalation, such as the associated case
or account, and the reason and justification for the escalation. It also includes information
about the escalation as it progresses, including the trend and notes about the work being
done to resolve the issue.

An escalation record can contain one or more associated cases. When updating escalation
records, customer service agents can enter comments or work notes. For case escalations,
updates are replicated to the case activity history as work notes so they are not visible to
the customer.

The escalation form has a Related Cases related list that includes the related cases for
account escalations. The user can associate specific cases using this related list to indicate
which cases are causing the escalation.

Escalation form fields
Field Description
Number The number automatically assigned to the

escalation request.

Source Record The case or account for which escalation is
requested.

Note:  The case or account form for the
source record includes an
Escalations related list.

State The current state of the escalation:

• Requested: an agent with the escalation
requester role has requested an escalation for
the case or account.

• Escalated: the escalation request has been
approved.

• Declined: the escalation request has been not
been approved.

• Closed: the reason for the escalation has been
resolved and the escalation has been closed.

• De-escalation Requested: an agent with the de-
escalation requester role has requested that an
escalation request be removed from the case or
account.

Request Source The source of the case escalation request:

• Customer requested
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Field Description
• Internally requested

Reason The reason for requesting the case escalation:

• Inactivity
• Lack of Progress
• Customer Imposed Deadline

Watch List The watch list for this particular escalation record.
For account escalations, you can Add account
team members to watch list.
Users added to the watch list for a case, account,
or escalation record receive email notification
when the case or account has been escalated and
when updates are made to the escalation record.

Assignment group For account escalations, the assignment group
for this account.

Assigned to For account escalations, the customer service
agent assigned to this account.

Request By The user who requested the escalation.

Approved By If approved, the user who approved the
escalation request.

Declined By If declined, the user who declined the escalation
request.

De-escalated By The user who de-escalated the case or account
escalation.

Escalation Type The escalation type selected by the user who
requested the escalation.

Escalation Severity The escalation severity associated with this
escalation, which defines the severity level for the
escalation and the color used to highlighted the
escalated record in the user interface.

• High Severity: escalated records are highlighted
in red.

• Medium Severity: escalated records are
highlighted in orange.

Escalation Trend The current state of the escalation:

• Improving
• Same
• Declining

Escalation Justification Additional information that explains why this
escalation is needed.

Administer case and account escalation

Last updated: July 26, 2018
Last updated: July 26, 2018
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The system administrator creates escalation templates and escalation severity definitions
that control the escalation process.

Escalation templates

An escalation template determines how an escalation request is processed. The escalation
feature provides two standard escalation templates, one for case escalation and one for
account escalation. If needed, the system administrator can modify these templates or
create new templates.

An escalation template defines the following information:

• The type of escalation (case or account)
• If approval is required

If no, the escalation request is automatically approved.
If yes, provide the approver list required by the default approval workflow or provide a

different approval workflow.
• The escalation watch list. Users added to the watch list receive email notifications when an

escalation record is updated.

Escalation severity

An escalation severity record defines the severity level for the escalation and the color that
is used to highlight the escalated case or account record in the user interface. This assigned
severity allows agents to easily identify escalated cases and accounts on lists and forms.
Escalated case and account numbers are indicated with a colored dot on a list and a colored
background on a form.

The escalation feature provides two escalation severity definitions:

• High Severity: escalated records are highlighted in red
• Medium Severity: escalated records are highlighted in orange

In addition to defining the field style of an escalated case or account, the severity can be
used when configuring SLAs. To configure additional escalation severity definitions, the
system administrator must configure a new style with the desired color. For more
information, see Define field styles.

Escalation SLAs

Escalation SLAs are typically used to govern the frequency of updates required for different
types and severities of escalations. An escalation SLA is associated with an escalation
severity in the SLA definition. When a user creates an escalation request, the selection in the
Escalation Severity field determines the SLA for the escalation record.

The escalation feature provides the following case escalation SLAs. On case escalations,
because the escalation corresponds one-to-one with a case, the default SLAs are associated
with the case:

• Escalated case response - 4 hours: update comments on the case escalation record every
four hours.

• Escalated case response - 8 hours: update comments on the case escalation record every
eight hours.
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The escalation feature provides the following account escalation SLAs. On account
escalations, because the escalation corresponds to an account which typically does not
support SLAs, the SLAs are associated with the escalation.

• Escalated account response - 4 hours: update comments on the account escalation record
every four hours.

• Escalated account response - 8 hours: update comments on the account escalation record
every eight hours.

The system administrator can configure case and account escalation SLAs that are based on
escalation attributes such as the escalation type, severity, and trend.

You can find escalation SLAs in these locations:

• For account records, on the Escalation form in the Task SLAs related list.
• For case records, on the Case form in the Task SLAs related list.

• Create a case or account escalation severity

Defines the type of escalation and the color used to represent the cases and accounts of
this escalation severity in the user interface.

• Create a case or account escalation template

Create a template for each type of case or account escalation.

Create a case or account escalation severity

Last updated: July 26, 2018
Last updated: July 26, 2018

Defines the type of escalation and the color used to represent the cases and accounts of
this escalation severity in the user interface.

Before you begin

Role required: admin

Procedure

1. Navigate to Customer Service > Escalation Severity.
2. Click New.
3. Enter a Name for the severity.
4. In the Style field, enter a color.

To configure additional escalation severity records, the system administrator must
configure a new style with the desired color. For more information, see Define field
styles.

5. Click Submit.

Create a case or account escalation template

Last updated: July 26, 2018
Last updated: July 26, 2018

Create a template for each type of case or account escalation.

Before you begin
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Role required: admin

Procedure

1. Navigate to Customer Service > Escalation Templates.
2. Click New.
3. Fill in the fields on the Escalation Template form, as needed.

Escalation Template form fields
Field Description
Name The name of the escalation template.

Skip Escalation Approval Enable this check box to skip the need for
approval. If skipped, escalations are
automatically approved.

Use Default Approval Workflow Enable this check box to use the default
approval workflow (Escalation - Approval)
provided with the escalation feature.
If using the default approval workflow, select an
Approval Group.

Add Case Assignment Group Manager to
Approvers

For case escalation, enable this check box to
add the manager of the case assignment group
to the list of approvers.

Approval Group If the Use Default Approval Workflow check
box is enabled:

• For the Case Escalation type, you can
select an additional approval group.

• For the Account Escalation type, you must
select an approval group.

Note:  If there are no approvers,
escalation requests are
automatically approved.

Escalation Approval Workflow The workflow used to approve escalation
requests. Use the default Escalation-Approval
workflow or select a different workflow.

Type The type of escalation:
• Case Escalation
• Account Escalation

Escalation Watch List Add users to the escalation template watch list.
These users receive notifications for all
escalations that use this escalation template.

For an account escalation, the account team is
automatically added to the watch list.

Note:  Users can also be added to the
watch list on the escalation
record.

4. Click Submit.
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Use case and account escalation

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the escalation requester role can request and manage case and account
escalations.

• Escalate a case or an account

Users with the escalation requester role can escalate a case or account.

• Manage an escalated case or account

Manage and document the progress for an escalation using the case or account
escalation record.

• De-escalate a case

Users with the de-escalation requester role can de-escalate cases or accounts when the
cause of the escalation is resolved.

Escalate a case or an account

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the escalation requester role can escalate a case or account.

Before you begin

Role required: sn_customerservice.escalation_requester or
sn_customerservice.deescalation_requester

Procedure

1. Navigate to the desired case or account.
2. Click the Escalate Case or the Escalate Account related link.
3. Fill in the fields on the Escalation form, as needed.

Escalation form fields
Field Description
Number The number automatically assigned to the

escalation request.

Source Record The case or account for which escalation is
requested.

Request Source The source of the case escalation request:
• Customer
• Internal

Reason The reason for requesting the case escalation:
• Inactivity
• Lack of Progress
• Customer Imposed Deadline

Escalation Severity The escalation severity associated with this
escalation, which defines the severity level for
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Field Description
the escalation and the color used to highlight
the escalated record in the user interface.

• High Severity: escalated records are
highlighted in red.

• Medium Severity: escalated records are
highlighted in orange.

Escalation Template The escalation template selected by the user
who requested the escalation.

Watch List The watch list for this escalation record. The
watch list includes users on the escalation
template and any users that you add for this
record.
For account escalations, you can Add account
team members to watch list.

Assignment group For account escalations, the assignment group
for this account escalation.

Assigned to For account escalations, the customer service
agent assigned to this account.

Request By The user who requested the escalation.

Escalation Justification Additional information that explains why this
escalation is needed.

4. Click Submit.
If the escalation template includes an approval workflow, the approvers review the
escalation request and either approve or deny the request (provide a reason).

Manage an escalated case or account

Last updated: July 26, 2018
Last updated: July 26, 2018

Manage and document the progress for an escalation using the case or account escalation
record.

Before you begin

Role required: sn_customerservice_agent or sn_customerservice.consumer_agent

About this task

Perform tasks such as changing the escalation severity (which may trigger a different SLA),
update the escalation trend, add or remove users from the watch list, and add comments.

• Case escalations: When managing a case escalation, the customer service agent typically
performs most of the problem resolution work directly in the case record and the
escalation record is primarily used for status reporting purposes. For example, updating
the escalation trend and comments to escalation stakeholders. All updates to the case
escalation record are automatically replicated to the case record as work notes. The
escalation SLA is also associated with the case record rather than the escalation record
because that is where the agent provides regular updates.

• Account escalations: For account escalations, the escalation record takes on a more
important role because account escalations are more serious and are often associated with
multiple underlying cases. An account escalation is typically assigned to an account

August 6, 2018 ©2018 ServiceNow. All rights reserved. 174

ServiceNow | Customer Service Management



escalation manager who works closely with multiple case owners to resolve the customer
escalation. The account escalation manager can consolidate the status across the
underlying cases and provide regular updates using the escalation record. Therefore, the
SLA is associated with the escalation record.

Procedure

1. Navigate to the desired case or account escalation record.
2. Update the fields on the escalation form as needed.
3. Click Update.

De-escalate a case

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the de-escalation requester role can de-escalate cases or accounts when the
cause of the escalation is resolved.

Before you begin

Role required: sn_customerservice.deescalation_requester

About this task

Procedure

1. Navigate to the desired escalation record.
2. Click De-escalate in the form header.

This opens the De-Escalate Case pop-up window.
3. Enter the necessary information in the De-cscalation Justification field.
4. Click De-escalate on the window.

The state of the escalation record changes to Closed.

Customer Service Management Flow Designer actions
Last updated: July 26, 2018
Last updated: July 26, 2018

Use Flow Designer actions as building blocks to create Customer Service Management
business processes.

Action Description
Get Case Retrieve a case record using the case number. If

multiple records are found, only the first record is
returned.

Create Case Create a case using one or more attributes. This
action mimics the structure of the Case table
(sn_customerservice_case) and exposes all of the
fields present on the Case table. 

Create Quick Case Create a case using the customer, description,
channel, priority, and category attributes.

Create Task on Case Create a case task and optionally associate it with
a case.
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Action Description
Update Case Update a case by providing the case reference

and the fields that you want to update. 

Assign Case Assign a case using matching rules. To use this
action, you must first define the matching rules
that match cases with resources (assignment
groups, agents).

Escalate Case Request case escalation. This action does not
automatically approve escalation. Approval is
based on the selected escalation template.

Escalate Account Request account escalation. This action does not
automatically approve escalation. Approval is
based on the selected escalation template. 

Add Work Note to Task Add a work note to a task or to task extended
objects (for example, a case or case task).

Add Comment to Task Add a comment to a task or to task extended
objects (for example, a case or case task).

Related Topics

• Flow Designer

• Actions

Domain separation in Customer Service Management
Last updated: July 26, 2018
Last updated: July 26, 2018

Domain separation in Customer Service Management enables you to separate data,
processes, and administrative tasks into logical groupings called domains. You can then
control several aspects of this separation, including which users can see and access data.

Overview

Support: Level 1

Domain separation is supported in this application. Not all ServiceNow applications support
domain separation; some include limitations on the data and administrative settings that can
be domain separated. To learn more, see Application support for domain separation.

Domain separation for Customer Service Management is designed for:

• Customers using the application in a domain-separated environment or in a hybrid
environment. With domain separation, a customer can grant access to end users (contacts
or consumers) to other entities in addition to customer service cases. For example,
contacts or consumers can access problems, changes, or projects. System administrators
can synchronize the CSM account model with the domain structure and maintain data
separation for entities that do not have account-based data separation enabled.

• Managed service providers (MSPs) using the application to provide customer support. In
this scenario, an MSP can provide support to multiple customers, where domains are
necessary to contain all relevant customer data and processes. For example, an MSP
providing support to customers related to billing questions, contract renewals, or other
non-service operations.
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• Managed service providers offering the application as a service that customers can
provide to their customers. In this scenario, an MSP can offer Customer Service
Management as a service to customers who, in turn, use the application to support their
end customers. This scenario requires additional configuration due to domain support for
some of the core entities in the platform such as Product Model.

How domain separation works in Customer Service
Management

Domain separation for Customer Service Management aligns each customer account to one
domain. To use domain separation with the application, all customer accounts must be
assigned to a domain.

The customer account is the main entity within Customer Service Management. All entities
related to the account, such as contacts and cases, are created in the same domain as the
account. This rule also applies for all entities on customer service cases, including addresses,
assets, and contacts.

When a new account is created, a domain of the same name is also created and assigned to
the account. All related entities for an account, such as contacts and cases, must reside in
the same domain. When a related entity for a domain separated account is created, the
entity is assigned to the account domain.

Setting up domain separation for Customer Service
Management

Domain separation for Customer Service Management requires the domain separation
plugin. Contact ServiceNow to activate domain separation.

Activating this plugin enables the csm_auto_account_domain_generation property, which
automates domain separation. This property is installed with Customer Service Management
and is available only after the domain separation plugin is active.

When the csm_auto_account_domain_generation property is enabled, the Customer
Service Management application automatically creates a domain of the same name when a
new account is created.

Note:  Enabling the csm_auto_account_domain_generation property does not add
domains for existing accounts. It only creates domains for newly created
accounts. Adding domains for existing accounts requires a migration script.

Changes to Customer Service Management tables

Domain separation for Customer Service Management adds the Domain and Domain Path
fields to the Account [customer_account] table. These fields are not exposed by default.
Customers can customize lists and forms to view these fields.

Account domains and related entities

When creating related entities for an account, the domain for the related entities is set to the
account domain. Related entities include:

• Contacts
• Cases
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• Assets
• Contracts
• Entitlements
• Addresses
• Social profiles
• Escalations

Changing the domain for an account also changes the domain for all the account’s related
entities.

Domain visibility for customer service agents and managers

Users with the customer service agent (sn_customerservice_agent) and customer service
manager (sn_customerservice_manager) roles must be manually assigned to the TOP/MSP/
Default domain. Agents and managers cannot see case or account details until they are
assigned to the TOP domain.

Domain separation for case and account escalation

Escalation template records and escalation severity records are domain separated. By
default, these records reside in the global domain. Users can configure the Escalation
Template and Escalation Severity forms to display the Domain field and set the domain as
needed.

When an escalation record is created from a case or account, it is created in the account
domain.

• Domain separation and entity relationships

With domain separation in Customer Service Management, you can further control
visibility and access to data by using contact, partner, and parent-child relationships.

Related Topics

• Domain separation

Domain separation and entity relationships

Last updated: July 26, 2018
Last updated: July 26, 2018

With domain separation in Customer Service Management, you can further control visibility
and access to data by using contact, partner, and parent-child relationships.

Partner-customer account relationships

In partner-customer account relationships, the partner account can see data in the customer
account’s domain. When setting up an account relationship, the domain visibility direction is
From > To. The account in the From field contains the domain of the account in the To field.

When a partner admin creates a case for a customer account, the case is created in the
customer account's domain so that all relevant parties can access the case.

In partner-customer account relationships where the customer account has child
relationships, the partner admin can create a case for the customer account but not for the
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child accounts. The partner admin can only create cases for the account with which the
relationship has been established.

Contact relationships

In contact relationships, the contact included in the relationship can see data for the
specified account domain.

Parent-child relationships

The account hierarchy feature creates a parent-child relationship between accounts. This
relationship is defined by selecting the parent in the Parent Account field on the Account
form for the child account. Domain hierarchy is also achieved using the Parent Account field.
In parent-child account relationships, parent domains can see data in child domains.

To provide access from the child account to the parent account, you need to set domain
visibility. Navigate to the child account and set visibility in the Visibility Domains related list
(sys_user_visibility) by connecting the user to the domain.

Agent intelligence for case management
Last updated: July 26, 2018
Last updated: July 26, 2018

Assist users with case creation by requesting a minimum of information, such as the product
and short description, and automatically determining the category, priority, and assignment
group.

Contacts, consumers, and agents can create cases by providing just the short description.
Based on that, the Agent Intelligence feature predicts the category, priority, and assignment
group, and routes the case to the correct queue.

Note:  If a contact or consumer provides information for the category, priority, or
assignment group when creating a case, the prediction skips these fields.

Customer service admins and agents can set the catgory, priority, and assignment group for
cases where Agent Intelligence has skipped prediction.

To use Agent Intelligence with Customer Service Management:

• Activate the Agent Intelligence plugin (com.glide.platform_ml)
• Enable the ML prediction for case property: Enable/Disable the prediction for case

(sn_customerservice.case.mlpredictor.enable)

Agent Intelligence includes solution definitions for Customer Service Management:

• CSM Case Categorization
• CSM Case Assignment
• CSM Case Prioritization

Agent Intelligence also includes business rules for Customer Service Management.

• Update cases with missing field predictions

View the list of open cases for which the prediction of category, priority, or assignment
group was skipped by the Agent Intelligence feature.
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Update cases with missing field predictions

Last updated: July 26, 2018
Last updated: July 26, 2018

View the list of open cases for which the prediction of category, priority, or assignment
group was skipped by the Agent Intelligence feature.

Before you begin

Role required: sn_customerservice_agent, sn_customerservice_manager or admin

About this task

In the event that Agent Intelligence cannot predict one or more case attributes for a case,
customer service agents and administrators can update this information after a case is
created. For example, the short description might not include enough detail to make a
prediction.

Procedure

1. Navigate to Customer Service > Cases > Cases Skipped by Agent Intelligence.
2. Select a case from the list.
3. Provide the missing information and click Update.

Time recording for Customer Service Management
Last updated: July 26, 2018
Last updated: July 26, 2018

Record time worked on cases and case tasks. Time worked entries automatically generate
time cards and time sheets for manager approval.

Customer service agents (users with the sn_customerservice_agent role) can record time
worked on case-related activities, create time cards and time sheets, and submit for
approval. Managers can approve time sheets, define cost rates for different types of
activities, and convert to expense lines.

The time recording feature extends the functionality of the Time Card Management
application to Customer Service Management. Agents can record time worked on cases and
tasks directly from the Case or Case Task form and time spent on other activities, such as
meetings or training, from the Time Worked form. Time worked entries automatically create
time cards for each task and selected work category. Time cards are automatically included
in a weekly time sheet.

The time recording feature also extends the functionality of the Cost Management
application to Customer Service Management. Customer service managers can create labor
rate cards, which define different cost rates for different activities. Time sheets use labor rate
cards to determine costs and to generate expense lines.

Agents can modify the hours recorded on time cards. Once a time sheet is approved and a
time card is processed, the agent can still go back and modify the time worked. The time
sheet reverts to the Pending state and new time cards are created. If an agent adds more
time worked records to an approved time sheet for the same week, a new time sheet record
is created for the current week.
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Managers can view time worked records, time cards, and time sheets for agents in their
assignment groups, as well as approve and reject time sheets. After a time sheet is
approved, the system processes the time cards and uses rate cards based on the time card
category to create expense lines.

Time recording plugin

The time recording feature requires the Customer Service Management plugin
(com.sn_customerservice) and the Time Recording for Customer Service plugin
(com.snc.csm_time_recording).

User roles

The time recording feature adds the following roles.

Role Description
Time card user
[timecard_user]

Record time worked on cases and tasks. View,
modify, and delete time worked entries on time
cards and submit time sheets for approval.
Users with the customer service agent
(sn_customerservice_agent) role inherit the
timecard_user role.

Note:  This role restricts access to the
time sheets, time cards, and time
worked records created by the
agent.

Time card administrator
[timecard_admin]

Review, approve, and reject time sheets for
customer service agents.
Users with the customer service manager role
(sn_customerservice_manager) inherit the
timecard_admin, timecard_approver, and
timecard_manager roles.

Note:  This role restricts access to the
time sheets, time cards, and time
worked records created by the
agents in a manager's assigned
groups.

System properties

The time recording feature adds the following properties.

Property Description
com.snc.time_card.time_worked Enables the time recording feature for Customer

Service Management. The default setting is false.

com.snc.time_card.default_rate The default hourly rate used when processing
time cards if a rate from a labor rate card is not
available.
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Time Sheet policy

The time recording feature uses the Default time sheet policy.

For users with the sn_customerservice_agent role, creating time worked records
automatically creates or modifies time cards regardless of the setting for the
com.snc.time_card.time_worked system property. The time sheet policy controls this
functionality. The system administrator can disable the auto-creation of time cards for a
specific user with the sn_customerservice_agent role by creating a separate time sheet
policy for that user.

Labor rate cards

The time recording feature provides one labor rate card: CSM Rate Card (Default).

If needed, system administrators can create additional labor rate cards. Navigate to Cost >
Costs > Labor Rate Cards and click New to create a labor rate card.

Record time worked for a case or activity

Last updated: July 26, 2018
Last updated: July 26, 2018

Customer service agents can record time worked on a case or case task as well as time
spent on other activities.

Before you begin

Role required: sn_customerservice_agent

About this task

An agent can record time worked directly from a case or case task by clicking Record Time
on the form. Time worked can be recorded regardless of the case or task state. An agent
can also record time spent on other activities from the Time Worked list by creating a new
time worked record, recording the time, and selecting a category.

When an agent creates a time worked record, a time card and time sheet are automatically
created for the week based on the work date. The time card is created for the task and the
category type. The total hours recorded on each time card are then recorded on the current
time sheet in the Time Cards related list.

Procedure

1. To record time worked for a task or an activity:
• Navigate to a case or case task and click Record Time. This action opens a Time

Worked form with the Task and User field already populated.
• Navigate to Time Sheets > My Time Worked and click New. This action opens a Time

Worked form with the User field already populated.
2. If necessary, select the case number in the Task field.
3. Select the Work Date.
4. Select a Category for the time being recorded.
5. Fill in the Time worked.
6. Provide any additional information in the Comments field and click Submit.

The Time Worked form is saved and added to the Time Worked list (Time Sheets > My
Time Worked) and to the Time Worked related list on the Case or Case Task form.
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• If this entry is the first time worked entry for the selected category, a time card is
created for that category. The time worked record is added to the time sheet (Time
Sheets > Current Time Sheet) in the Time Cards related list.

• If a time card for the category already exists, the time worked record is added to
that card.

Review time worked for a case or activity

Last updated: July 26, 2018
Last updated: July 26, 2018

Customer service agents can review time worked on cases and case tasks.

Before you begin

Role required: sn_customerservice_agent

About this task

The Time Worked related list on the Case and Case Task form displays the time worked
records that have been created for the case or task. From this related list, agents can review
their recorded time, add new time worked records, and also delete records.

Procedure

1. Navigate to the desired case or case task.
2. Go to the Time Worked related list.
3. To view a time worked record, click the Comments for that record.

Modify or delete time worked entries for cases or activities

Last updated: July 26, 2018
Last updated: July 26, 2018

Agents can modify and delete existing time worked entries and create new entries after a
time sheet has been approved.

Before you begin

Role required: sn_customerservice_agent

About this task

An agent can modify or delete time worked entries for an approved time sheet. Any
changes to these entries update existing time cards, creates new time cards if needed, and
generates an updated time sheet.

Note:  Do not manually edit time cards. Edit the original time worked entries, which
generate updated time cards and time sheets.

Procedure

1. To modify or delete a time worked entry:
• Navigate to the desired case or case task, click the Time Worked related list, and

click the desired entry.
• Navigate to Time Sheets > My Time Worked and click the desired entry.
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2. To modify the entry, change the desired fields and click Update.
3. To delete the entry, click Delete.

Review a time card

Last updated: July 26, 2018
Last updated: July 26, 2018

Customer service agents can review time cards created from time worked records.

Before you begin

Role required: sn_customerservice_agent

About this task

The Time Worked related list on the Case and Case Task form displays the time worked
records that have been created for the case or task. This list also displays the time cards
created from the time worked records.

Procedure

1. Navigate to the desired case or case task.
2. Go to the Time Worked related list.
3. To view a time card, click the Time Card for that record.

The time card provides a breakdown of the time worked for this case or case task by
day.

Review and submit a time sheet for a customer service agent

Last updated: July 26, 2018
Last updated: July 26, 2018

Agents can review and submit time sheets to managers for approval.

Before you begin

Role required: sn_customerservice_agent

About this task

The total hours worked for each category are recorded on the time card and on the time
sheet. From the time sheet, you can see total hours by day and by category.

Procedure

1. Navigate to Time Sheets > My Time Sheets > Current Time Sheet.
2. If desired, review the time cards associated with the time sheet in the Time Cards related

list.
3. Click Submit Time Sheet.

The time sheet is submitted to the manager for approval. The state of the time sheet
changes from Pending to Submitted and the form becomes read-only. The state of the
associated time cards also changes to Submitted.

Review and approve time sheets for customer service agents

Last updated: July 26, 2018
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Last updated: July 26, 2018

Managers can review time cards and time sheets for agents in their assignment groups.

Before you begin

Role required: sn_customerservice_manager

About this task

When a time sheet is approved, the time cards are processed and used to create expense
lines that reference the defined labor rate cards.

Procedure

1. Navigate to Customer Service > Manager > Time Sheets - Pending Approval.
2. Select a time sheet.
3. If necessary, review the time cards associated with this time sheet in the Time Cards

related list.
4. Click one of the available actions:

Option Description

Approve The state of the time sheet and the associated
time cards changes to Processed and these
records become read-only.

Reject The state of the time sheet and the associated
time cards changes to Rejected. The customer
service agent can modify the time sheet and
submit again for approval.

Review expense lines created from time cards

Last updated: July 26, 2018
Last updated: July 26, 2018

Review the expense lines created from the time cards and time sheets submitted by
customer service agents.

Before you begin

Role required: financial_mgmt_user

Procedure

1. Navigate to Cost > Costs > Expense Lines.
2. Select the desired expense from the Expense Lines list and view the details.

Customer Service optional features
Last updated: July 26, 2018
Last updated: July 26, 2018

There are several optional features available with the Customer Service Management
application. These features require separate plugins.

• Targeted communications
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The Targeted Communications application provides the ability to create and send articles
and emails to internal and external customers.

• Knowledge product entitlements

The Knowledge Product Entitlements application enables administrators to designate the
knowledge bases and knowledge articles that customers can view from the customer
portal.

• Anonymous chat

Consumers can chat with a consumer service agent without logging in to the Consumer
Service Portal.

Targeted communications

Last updated: July 26, 2018
Last updated: July 26, 2018

The Targeted Communications application provides the ability to create and send articles
and emails to internal and external customers.

Users with the publications author (sn_publications.author) and publications administrator
(sn_publications.admin) roles can use the Targeted Communications application to author
publication articles and emails for employees, customer contacts and accounts, and
consumers. Articles are available for viewing from the self-service portals and can also be
sent out as email notifications.

Each publication article includes content and a specified list of recipients and can also
include optional email notification. Recipients lists can be created dynamically by using a
condition builder to identify the desired conditions, by running scripts, or by manual file
upload. Recipients can be added to or removed from a list manually and lists can have both
dynamically generated and manually added records of the same type.

Publication authors specify a publish date and an expiration date when creating an article to
handle time-sensitive information. Authors can also request a review prior to publishing an
article.

The process of publishing articles is based on workflows and two default workflows are
provided: one to publish articles instantly and one that requires approval prior to publishing.
Publication administrators can update workflows and add users with the publications
approver (sn_publications.approver) role to perform reviews. Both authors and
administrators can monitor publications and see which users have received and viewed the
information.

Customer contacts and consumers can view publications by logging in to the Customer
Service Portal or the Consumer Service Portal and clicking the Publications link in the portal
header. Employees can view these publications by navigating to Targeted Communications >
Publications in the application navigator.

Note:  If the optional email notification is selected, all users receive the publication
in an email, including consumers who do not have a login ID for the
Consumer Service Portal.

August 6, 2018 ©2018 ServiceNow. All rights reserved. 186

ServiceNow | Customer Service Management



Publication article stages

Publication articles progress through several stages which are displayed in a process flow
formatter on the Publication form.

Publication stages
Stage Definition
Author The initial state of the publication creation

process.

Review Publications that are waiting for review. A
publication cannot be updated when it is in the
Review stage.

Ready To Publish Publications that have been reviewed and are
ready to be published.

Published Publications that that have reached their Publish
Date.

Expired Publications that have reached their Expiry Date
or that have been manually expired.

Cancelled Pending publications that have been cancelled.

States are shown in a process flow formatter at the top of the Publication form. The current
state is indicated by a blue underline. States that have been completed are indicated by a
blue check mark.

Publication lists

The Targeted Communications application menu includes several views of publication
records.

Publications lists
State Definition
Active Publications Includes publications in the following stages:

• Author
• Review
• Ready to Publish
• Published

Draft Publications Includes publications that have been created and
sent for review.

Expired Publications Includes publications that have reached their
Expiry Date or have been set to Expired.

• Recipients lists

Create recipients lists for active publications.

• Add or remove an approver

Add or remove an approver to a publication workflow.

• Create a recipients list
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Create and save a list of users to receive targeted communications.

• Edit a recipients list

Edit a list of users to receive targeted communications.

• Create a publication

Create a publication with optional email notification to send to customers.

• Create a recurring publication

Use an existing publication as a template to create multiple copies of a new publication.

• Preview an email notification

Preview an email notification for a publication before it is sent to customers.

• Update a publication

You can make changes to a publication that is in the Author or Review stages.

• Send a publication for review

You can send a publication for review if it is in the Author stage.

• Review a publication

Users with the publications approver role that have been added as approvers to the
publication workflow can review a publication.

• View the list of approvers for a publication

If a publication article has been sent for review, you can see the assigned approvers on
the Publication form.

• Track a publication

Access a list of recipients for a publication and see which recipients have viewed the
content.

• Expire a publication

Expire a published article before it reaches the Expiry Date.

• Cancel a publication

Cancel a pending publication before it reaches the publish date.

• View a publication

Internal customers can view the details of a publication from the Targeted
Communications menu.

Recipients lists

Last updated: July 26, 2018
Last updated: July 26, 2018

Create recipients lists for active publications.
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The list of recipients for an article can include internal users, accounts, contacts, and
consumers. When an article is published, the recipients on this list can view the article on the
Customer or Consumer Service Portal. Recipients can also receive optional email
notifications.

The Major Issue Management application uses recipients lists can also be used by the Major
Issue Management application to create child cases for a major case.

Recipients lists are created in the following ways:

• By creating a list of imported users.
• By creating a dynamic list based on selected conditions.
• By creating a script.

Recipients lists can have both dynamically generated and manually added records of the
same type.

The system administrator can manage a scheduled job to refresh recipient lists. This
scheduled job, Targeted Communications Refresh recipient list, adds new recipients to each
of the active published articles. The new recipients receive email notification of the article
and are granted access to view the article on the portal.

Create a recipient list by importing contact information

Create a recipient list by importing contact information. For contacts, supported file types
include xls and csv.

Multiple files can be imported into the same recipient list, with new recipients appended to
the recipient list file. The system checks that the accounts and contacts exist in the system
and only imports those that exist. Duplicate entries are not created. At the end of the import
process, the system displays a status with the number of records imported and rejected.

The system uses the sys_id and the email address attributes to match contacts. It first looks
for a matching sys_id match. If not found, it then looks for a matching email address. If
neither are found, the record is rejected.

Create a recipient list by importing account, consumer, or
internal user information

Create a recipient list by importing account, consumer, or internal user information. The
supported file type is xls.

The system uses the following attributes to match the imported records:

• Account: Uses the sys_id and the account number. Attempts to match the sys_id. If not
found, then attempts to match using the account number. If neither are found, the record
is rejected.

• Consumer and User: Uses the sys_id or the email address. Attempts to match the sys_id. If
not found, then attempts to match the email address. If neither are found, the record is
rejected.

Create a recipient list using a script

Create a recipient list using a script with these supported entities: contact, company/
account, consumer, and internal user. The output of the script is an array of sys_ids of the
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corresponding entity. After creating the recipient list, the system shows the total number of
records identified, added to the list, and rejected.

To create a recipient list using a script, select Dynamic Condition in the Method field on the
Recipients List form and enable the Show Script check box. Then create your script in the
Script field.

Add or remove an approver

Last updated: July 26, 2018
Last updated: July 26, 2018

Add or remove an approver to a publication workflow.

Before you begin

Role required: sn_publications.admin

Procedure

1. Navigate to Targeted Communications > Publication Workflow.
2. Select a Workflow.

The approvers assigned to the workflow are displayed in the Approvers field.
3. To add an approver, click the Edit Approvers button next to the Approvers field and

select an approver from the Users list.
This list includes users with the sn_publications.approver role. The selected user is added
to the Approvers field.

4. To remove an approver, click the Edit Approvers button next to the Approvers field and
select the approver's name. Then click the Remove button.
The approver's name is removed from the Approvers field.

5. Click Update.

Create a recipients list

Last updated: July 26, 2018
Last updated: July 26, 2018

Create and save a list of users to receive targeted communications.

Before you begin

Role required: sn_publications.author, sn_publications.admin, sn_customerservice_agent,
sn_customerservice_manager, sn_majorissue_mgt.major_issue_manager

About this task

A recipient list can include internal users, accounts, contacts, or consumers. Create a
recipient list using any of the following methods:

• By importing a list of users.
• By creating a dynamic list based on selected conditions.
• By creating a script.

Recipients lists can have both dynamically generated and manually added records of the
same type.

Note:  You must create at least one recipient list before creating a publication.
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Procedure

1. Navigate to Targeted Communications > Recipients Lists.
2. Click New.
3. Fill in the fields on the Recipients List form.

Recipients List form
Field Description
Name The name of the list.

Type The type of recipients to include in the list.
• Contacts (customer_contacts)
• Internal Users (sys_user)
• Consumers (csm_consumer)
• Accounts (customer_account)

State The state of the recipient list.
• New: the list has not yet been generated.

Click Refresh Recipient List.
• In Progress: the list is currently being

generated. (You may only see this state
when generating a very large list of
recipients.)

• Complete: the list has been generated.

Method The method used to generate the recipient list.
• Upload File: create a list by uploading user

information from a selected Excel .xlsx file.
• Dynamic Condition: create a list by

selecting conditions in the condition
builder or by adding a script.

Choose File If the Method is Upload file, download an Excel
template and then select an .xlsx file that
contains the user information.
The templates vary based on the entity
selected in the Type field. For accounts, the
template includes columns for sys_id and
account number values. For contacts,
consumers, and internal users, the template
includes columns for sys_id and email values.

Show Script If the Method is Dynamic Condition, enable this
check box to create a recipients list using a
script. Enabling this check box displays the
Script field.

Script The script used to create a recipients list.

Table The table that stores the user information.
Depending on the selection in the Type field,
this field displays:

• Contact [customer_contact]
• User [sys_user]
• Consumer [csm_consumer]
• Account [customer_account]

Account Field ???

User Field ???

Conditions Use the buttons in this field to build one or
more conditions on the selected table. A
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Field Description
condition is made up of a selected field, an
operator, and a value. Add conditions using the
AND and OR buttons. Delete conditions by
clicking the Delete button to the right of a
condition.

4. Click Submit.
For recipients lists created by file upload, clicking Submit validates the records in the
Excel file. Following validation, the system displays a pop-up window with the upload
results, including valid and invalid user records.

Edit a recipients list

Last updated: July 26, 2018
Last updated: July 26, 2018

Edit a list of users to receive targeted communications.

Before you begin

Role required: sn_publications.author, sn_publications.admin, sn_customerservice_agent,
sn_customerservice_manager, sn_majorissue_mgt.major_issue_manager

About this task

The Recipients related list includes the Dynamically Added column which displays either
True or False, depending on how a record was added:

• True for records that are dynamically generated, either by using the condition builder or by
running a script.

• False for records that are added manually, either by using the Edit button on the
Recipients related list or by file upload.

The Active Communication column is set to True by default for both dynamically and
manually added records. This field indicates whether or not the recipient requires active
communication.

Procedure

1. Navigate to Targeted Communications > Recipients Lists.
2. Select the desired list.
3. In the Recipients related list, click Edit.
4. Use the arrows to add or remove records.
5. Click Save.

Create a publication

Last updated: July 26, 2018
Last updated: July 26, 2018

Create a publication with optional email notification to send to customers.

Before you begin

Role required: sn_publications.author or sn_publications.admin
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About this task

Two options to consider when creating a publication:

• Include the optional email notification (default)
• Select the type of content: HTML or Wiki

After creating an article, there are two publishing options:

• Submit: sets the stage to Ready To Publish
• Send for review: sends the publication to the approver and sets the stage to Review

Procedure

1. Navigate to Targeted Communications > Create New Publication.
2. Fill in the fields on the Publication form.

Publication form
Field Description
Number The automatically generated publication

number.

Content Type The type of data included in the publication.
Select one of the following:

• HTML: this content can include Rich Text
formatted (RTF) text, images, attachments,
and links. Enter the publication data in the
Content field.

• Wiki: this content can include plain text.
Enter the publication data in the Wiki field.

The default selection is HTML.

Category If desired, select a category for the publication.
The following categories are available:

• Defect
• Outage
• Information
• IT
• HR
• Finance

Recipient Lists Select a predefined list to target specific
customers. Recipient lists are created by the
publication author or administrator.

Short Description A brief description or title of the publication.

Recurrence This field is displayed for recurring publications
and displays the short description entered on
the Recurrence form.

Publish Date Select the publication date. This date can be
the current date or any future date.
Publications are sent automatically when the
publish date and time are reached.

Expiry Date Select the expiration date. This date must be at
least one day after the Publish Date.
Publications are automatically expired when
the expiry date and time are reached.
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Field Description
Skip Notification Enable this check box if you do not want to use

email notification with this publication.
Enabling this check box disables the Email
Template field and hides the Include Attach
Links field.

Note:  If email notification is selected,
all users receive the publication
in an email, including consumers
who do not have a login ID for
the Consumer Service Portal.

Email Template Select a template to use for email notification.
The Publication Default email template is
provided with the Targeted Communications
application.

Users with the sn_publications_admin role can
create additional email templates.

Include Attach Links Include links to any attachments in the email
notification preview.

Content This field appears when you select HTML as the
Content Type.
Enter the text of the publication in this field.
HTML content can include Rich Text formatted
(RTF) text, images, attachments, and links.

Wiki This field appears when you select Wiki as the
Content Type.
Click the Wikitext button and enter the text of
the publication in this field. Wiki content can
include plain text.

3. Click one of the following:

Option Description

Submit The stage is set to Ready To Publish and the
publication is published on the Publish Date.

Send for Review The stage is set to Review and the publication
is sent to the approver for review.
Approvers can navigate to Self-Service > My
Approvals to see a list of review requests.

Create a recurring publication

Last updated: July 26, 2018
Last updated: July 26, 2018

Use an existing publication as a template to create multiple copies of a new publication.

Before you begin
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Role required: sn_publications.author or sn_publications.admin

About this task

You can specify the recurrence interval and the recurrence start and end date. The number
of copies that are created are based on these settings and appear in the Publications related
list on the original publication form. Each copy has a different publish date, which is based
on the interval. Each copy gets reset to the Author state and each one goes through its own
workflow.

Procedure

1. Do one of the following:
• Navigate to Targeted Communications > Active Publications , open the desired

publication, and click the Setup Recurrence related link.
• Navigate to Targeted Communications > Recurrences and click New.

2. Fill in the fields on the Recurrence form.

Recurrence form
Field Description
Short Description A brief description or title of the publication.

Publication Template The number of the publication being used as a
template.

• If you clicked the Setup Recurrence related
link, this field displays the original
publication number.

• If you clicked Recurrences in the Targeted
Communications menu, select a
publication from the Publications list.

Recurrence Start Select a date for the first occurrence of the
recurring publications.

Recurrence End Select a date for the last occurrence of the
recurring publications.

Recurrence Interval Select an interval for the recurring publications:
• Daily
• Weekly
• Biweekly
• Monthly
• Custom

Custom Interval in Days This field appears when you select Custom as
the Recurrence Interval. Enter the number of
days for the interval.

3. Click Submit.
The recurring publications are created based on the selected dates and the recurrence
interval and the stage for each copy is set to Author. The copies appear on the
Publications related list on the original publication form, as well as on the Active
Publications and the Draft Publications lists. From any of these lists you can open each
publication and change the information as necessary. Each copy lists the publication
template number in the Recurrence field.

A record of the recurrence appears on the Recurrences list.
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Preview an email notification

Last updated: July 26, 2018
Last updated: July 26, 2018

Preview an email notification for a publication before it is sent to customers.

Before you begin

Role required: sn_publications.author or sn_publications.admin

About this task

Preview the following information for an email notification:

• The recipient list
• The subject of the publication
• The text of the publication and any attachments.

Procedure

1. Navigate to one of the following:.
• Targeted Communications > Active Publications
• Targeted Communications > Draft Publications

2. Select the desired publication.
3. Click the Preview Target Email related link.
4. View the email notification in the Notification Preview window.
5. If desired, view the publication on the customer portal by clicking the link in the body of

the email.
6. Close the Notification Preview window.

Once the publication has been published, the customers in the recipient list should
receive the email.

Update a publication

Last updated: July 26, 2018
Last updated: July 26, 2018

You can make changes to a publication that is in the Author or Review stages.

Before you begin

Role required: sn_publications.author or sn_publications.admin

Procedure

1. Navigate to one of the following:
• Targeted Communications > Active Publications
• Targeted Communications > Draft Publications

2. Open the desired publication.
The stage of the publication must be either Author or Review.

3. Make the desired changes.
4. Click Update.

Send a publication for review

Last updated: July 26, 2018
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Last updated: July 26, 2018

You can send a publication for review if it is in the Author stage.

Before you begin

Role required: sn_publications.author or sn_publications.admin

Procedure

1. Navigate to one of the following:
• Targeted Communications > Active Publications
• Targeted Communications > Draft Publications

2. Select a publication in the Author stage.
3. Click Send For Review.

The publication stage is set to Review and the approvers are added to the Approvers
related list on the Publication form.

Approvers can navigate to Self-Service > My Approvals to see a list of review requests.
Approvers also receive an email notification about the review request.

Review a publication

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the publications approver role that have been added as approvers to the
publication workflow can review a publication.

Before you begin

Role required: sn_publications.approver or sn_customerservice_manager

About this task

After reviewing, an approver can either accept or reject a publication. If an approver does
not review a publication before the Publish Date, the publication cannot be approved. The
Approve button is not displayed and the approver sees a message that the publish date and
time has passed. The approver can only reject the publication, which returns it to the Author
stage.

The Approvers related list displays a list of approval tasks and includes most recent
comment from each approver.

Procedure

1. Navigate to Self-Service > My Approvals.
2. Select a publication for review from the Approvals list that has a state of Requested.
3. Review the publication summary at the bottom of the approval form.
4. Add review comments to the Comments field.
5. Click one of the following:

Option Description

Approve The review state changes to Approved on the
Approvals list and the publication stage is set
to Ready To Publish.
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Option Description
For other approvers of this article, the review
state changes to No Longer Required.

Reject The review state changes to Rejected on the
Approvals list and the publication stage is set
to Author.

View the list of approvers for a publication

Last updated: July 26, 2018
Last updated: July 26, 2018

If a publication article has been sent for review, you can see the assigned approvers on the
Publication form.

Before you begin

Role required: sn_publications.author or sn_publications.admin

Procedure

1. Navigate to one of the following:
• Targeted Communications > Active Publications
• Targeted Communications > Draft Publications

2. Open the desired publication.
3. Click the tab for the Approvers related list.

The Approvers list includes the users with the publications approver role that have been
added as approvers to the publication workflow.

Track a publication

Last updated: July 26, 2018
Last updated: July 26, 2018

Access a list of recipients for a publication and see which recipients have viewed the
content.

Before you begin

Role required: sn_publications.author or sn_publications.admin

About this task

Procedure

1. Navigate to Targeted Communications > Active Publications .
2. Open the desired publication.
3. Click the Publication Recipients related list.

For each recipient on this list, you can see if the email notification bounced and if the
customer viewed the article or any attachments.

Expire a publication

Last updated: July 26, 2018
Last updated: July 26, 2018
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Expire a published article before it reaches the Expiry Date.

Before you begin

Role required: sn_publications.author or sn_publications.admin

Procedure

1. Navigate to Targeted Communications > Active Publications .
2. Select an article that has been published.
3. Click Expire.

The publication Expiry Date is set to the current date. The publication is removed from
the Active Publications list and appears on the Expired Publications list.

Cancel a publication

Last updated: July 26, 2018
Last updated: July 26, 2018

Cancel a pending publication before it reaches the publish date.

Before you begin

Role required: sn_publications.author or sn_publications.admin

About this task

You can cancel a publication in any of the following stages: Author, Review, or Ready to
Publish.

Procedure

1. Navigate to one of the following:
• Targeted Communications > Active Publications
• Targeted Communications > Draft Publications

2. Select the desired publication.
3. Click Cancel.

The stage of the publication changes to Cancelled.

View a publication

Last updated: July 26, 2018
Last updated: July 26, 2018

Internal customers can view the details of a publication from the Targeted Communications
menu.

Before you begin

Role required: none

Procedure

1. Navigate to Targeted Communications > My Publications.
2. Select a publication from the Publications list.
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Knowledge product entitlements

Last updated: July 26, 2018
Last updated: July 26, 2018

The Knowledge Product Entitlements application enables administrators to designate the
knowledge bases and knowledge articles that customers can view from the customer portal.

Limit access on the customer portal to the following:

• The knowledge bases and articles for the products that a customer's company has
purchased.

• The knowledge bases and articles for which a customer's company has entitlements.

The Knowledge Product Entitlements plugin (com.snc.kb_product_entitlements) must be
activated to use this application. Installing this plugin adds the Related Products field to the
Knowledge Base form and to the Knowledge form. The knowledge information available on
the customer portal is limited to the products selected in this field.

Additional controls are available by enabling properties that allow you to:

• Limit access to knowledge bases based on product entitlements.
• Enable access if no products are specified in the Related Products fields.

• Add a related product to a knowledge base or knowledge article

Add a product to a knowledge base or knowledge article using the Related Products field
on the corresponding form.

• Set knowledge product entitlement properties

Set various properties to allow customers to access knowledge bases and knowledge
articles on the customer portal.

Add a related product to a knowledge base or knowledge article

Last updated: July 26, 2018
Last updated: July 26, 2018

Add a product to a knowledge base or knowledge article using the Related Products field
on the corresponding form.

Before you begin

Role required: admin

Procedure

1. Navigate to one of the following:
• Knowledge > Administration > Knowledge Bases
• Knowledge > Articles > All

2. Select the desired knowledge base or knowledge article.
3. Add one or more products in the Related Products field.
4. Click Update.

Set knowledge product entitlement properties

Last updated: July 26, 2018
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Last updated: July 26, 2018

Set various properties to allow customers to access knowledge bases and knowledge
articles on the customer portal.

Before you begin

Role required: admin

Procedure

1. Navigate to Knowledge Product Enhancements > Properties.
2. Set the following properties, as needed.

Option Description

Enable access control of Knowledge Bases
based on product entitlements

If enabled, customers can access all of the
knowledge bases related to the products for
which they have entitlements.

Allow access to Knowledge Bases with empty
related_products

If enabled, customers can access all knowledge
bases even if no products have been specified
in the Related Products field on the Knowledge
Base form.

Enable access control of Knowledge Articles
based on product entitlements

If enabled, customers can access all of the
knowledge articles related to the products for
which they have entitlements.

Allow access to Knowledge Articles with
empty related_products

If enabled, customers can access all knowledge
articles even if no products have been
specified in the Related Products field on the
Knowledge form.

3. Click Save.

Anonymous chat

Last updated: July 26, 2018
Last updated: July 26, 2018

Consumers can chat with a consumer service agent without logging in to the Consumer
Service Portal.

From the Consumer Service Portal, guest users can click the Live Chat link in the portal
header to initiate a chat session with a consumer service agent. Clicking this link opens a
form that requests some basic information, including the user's name, email address, and
type of issue. Completing and submitting the form creates a chat request that is routed to
the appropriate agent queue based on the selected issue type. Once the assigned agent
accepts the request, a chat session is established. If necessary, the agent can create a
consumer record or a case for the guest user, or transfer the chat to another agent.

Setting up anonymous chat

Setting up the anonymous chat feature involves the following steps.

1. Activate the Consumer Service Portal plugin (com.glide.service-portal.consumer-portal).
2. Modify the default anonymous chat record producer or create a new record producer.
3. Create one matching rule for each agent queue.
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4. Configure anonymous chat properties.
5. If necessary, modify the Connect actions to provide the desired functionality for

consumer service agents in chat conversations. The anonymous chat feature includes
these actions: Create Case for Guest and Create Consumer and Case for Guest. For more
information, see Administer Connect Actions.

Anonymous chat plugins

The anonymous chat feature requires two plugins which are activated as part of the
Consumer Service Portal plugin:

• Anonymous Connect Support (com.glide.connect.anonymous_support): enables the
anonymous chat feature for Connect.

• Connect Support Routing (com.glide.connect.support.routing): routes Connect Support
requests to the appropriate chat queue.

Anonymous chat record producer

The form used to request information from a guest user is a configurable record producer
based on the Consumer Interaction table (sn_customerservice_customer_interaction), which
is a new table in the Istanbul release. When a guest user submits the form, the information
provided is stored as a record in the Customer Interaction table. This record is used for
routing the chat request.

The default anonymous chat record producer, What can we help you with?, is located at
Service Catalog > Catalog Definition > Record Producers. This is a public record producer.
You can modify this record producer or create your own. If you choose to create your own,
see Section 3 in the Making a record producer and catalog item public on a CMS page
[KB0551300] article. You must also set the glide.sc.use_user_criteria property to false.

For more information, see Record Producer.

Anonymous chat routing

Information provided by the guest user assists with routing and also provides the conext of
the request to the consumer service agent. The chat request is routed to the appropriate
agent queue based on the type of issue selected. The routing for anonymous chat requests
uses matching rules. Create one matching rule for each queue and tie a chat request to a
chat queue based on the selected issue type. Matching rules for anonymous chat are based
on the Customer Interaction table.

The following matching rules are provided:

• Anonymous Connect - Billing Support
• Anonymous Connect - Order Support
• Anonymous Connect - Product Support

These rules are based on the selections in the Issue Type field on the default anonymous
chat record producer.

Anonymous chat properties

There are two properties related to the anonymous chat feature. Set these properties to limit
the number of chat requests created by guest users.
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Property Description
connect.support.max_guest_sessions_per_hour Limit maximum number of guest conversations

created in the last hour.

• Type: integer
• Default value: 200
• Location: Collaborate > Connect Support >

Support Administration > Properties

connect.support.guest_sessions_rate_limit_reached_messageMessage shown to user when rate limit for guest
conversations is breached.

• Type: string
• Default value: Guest Chat is currently not

available, please retry later.
• Location: Collaborate > Connect Support >

Support Administration > Properties

• Modify the anonymous chat record producer

Modify the default anonymous chat record producer to gather the desired information
from guest users.

• Create a matching rule for anonymous chat

Create one matching rule for each agent queue.

• Configure anonymous chat properties

Users with the system administrator role can set properties to limit the number of chat
requests created by guest users.

• Respond to an anonymous chat request

Select a chat request from the chat queue and respond to a guest user's question or
comment.

• Create a consumer case from an anonymous chat

If an anonymous chat results in the need to create a consumer case, create the case
directly from the conversation.

• Create a consumer record from an anonymous chat

If an anonymous chat results in the need to create a consumer record, create the record
directly from the conversation.

Related Concepts

• Record Producer

• Connect Support

Related Reference

• Create rules to route and assign customer service cases
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Modify the anonymous chat record producer

Last updated: July 26, 2018
Last updated: July 26, 2018

Modify the default anonymous chat record producer to gather the desired information from
guest users.

Before you begin

Role required: admin

About this task

This record producer requests information from a guest user on the Consumer Service
Portal and stores the information as a record in the Consumer Interaction table
(sn_customerservice_customer_interaction). The record is then used for routing the chat
request.

Procedure

1. Navigate to Service Catalog > Catalog Definition > Record Producers.
2. Click What can we help you with?.
3. Modify the record producer as necessary, including the variables in the Variables related

list.
For more information, see Create a record producer.

4. Click Update.

Create a matching rule for anonymous chat

Last updated: July 26, 2018
Last updated: July 26, 2018

Create one matching rule for each agent queue.

Before you begin

Role required: admin

About this task

A chat request is tied to a chat queue based on the selected issue type.

Procedure

1. Navigate to Routing and Assignment > Matching Rules.
2. Click New.
3. Enter a Name for the matching rule.
4. In the Table field, select Customer Interaction.
5. In the Conditions field, use the condition builder to create the following conditions.

Field Operator Value
Channel is Chat

Category is Select one of the categories
created for anonymous users
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Field Operator Value
to define an issue on the
record producer:

• Product Issue
• Billing Issue
• Order Issue

6. Click Submit.

Configure anonymous chat properties

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the system administrator role can set properties to limit the number of chat
requests created by guest users.

Before you begin

Role required: admin

Procedure

1. Navigate to Collaborate > Connect Support > Support Administration > Properties.
2. Set the following properties.

Option Description

Limit maximum number of guest conversations
created in the last hour.
[connect.support.max_guest_sessions_per_hour]

Limits the number of guest chat requests that
can be created in a one-hour timeframe. The
default value is 200.

Message shown to user when rate limit for
guest conversations is breached.
[connect.support.guest_sessions_rate_limit_reached_message]

The message that is displayed on the
Consumer Service Portal when the limit on the
number of guest chat requests has been
reached.

3. Click Save.

Respond to an anonymous chat request

Last updated: July 26, 2018
Last updated: July 26, 2018

Select a chat request from the chat queue and respond to a guest user's question or
comment.

Before you begin

Role required: sn_customerservice.consumer_agent, sn_customerservice_manager, or admin

Procedure

1. Navigate to Collaborate > Connect Chat.
The Connect workspace opens in a new tab.

2. Click the support tab of the Connect sidebar, indicated by a headset icon.
The support tab displays Queues to which you belong. It also displays your open
support conversations under Cases. When a consumer starts a support conversation or
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an agent transfers a conversation to a queue, any agent who belongs to the associated
queue has the option to accept the conversation. An agent can also request to transfer a
conversation directly to you.

3. Accept a conversation in one of the following ways.
• Accept a conversation from a queue
• Accept a transfer request

4. Respond to the guest user and help resolve the issue.
By default, your messages are added to the conversation record as comments and are
visible to the user.

What to do next

If necessary, you can create a consumer record for a guest user and create a consumer
service case from the conversation to track the issue. You can also transfer the conversation
to a different agent or queue, or escalate the conversation to a higher priority queue. For
more information, see Connect Support.

Create a consumer case from an anonymous chat

Last updated: July 26, 2018
Last updated: July 26, 2018

If an anonymous chat results in the need to create a consumer case, create the case directly
from the conversation.

Before you begin

Role required: sn_customerservice.consumer_agent, sn_customerservice_manager, or admin

About this task

When you create a case from a support conversation, the system copies the conversation
history to the case activity stream as comments and work notes. Future messages are
tracked in the case as well.

Procedure

1. Respond to an anonymous chat request.
2. Chat with the user to determine the issue.
3. At the bottom of the conversation, click the menu icon to open the Connect actions

menu.
4. In the Connect actions menu, select Create Case for Guest.

In the conversation tools area to the right of the conversation, a new case form opens in
a record tab. The system automatically sets certain fields based on conversation details.
For a case created from a guest user chat, the Short description field displays the initial
chat request from the user.

5. Complete the form as necessary and click Submit.
The system automatically shares the record in the conversation, copies the conversation
to the record activity stream, and references the record on the Chat Queue Entry
[chat_queue_entry] table.

Create a consumer record from an anonymous chat

Last updated: July 26, 2018
Last updated: July 26, 2018
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If an anonymous chat results in the need to create a consumer record, create the record
directly from the conversation.

Before you begin

Role required: sn_customerservice.consumer_agent, sn_customerservice_manager, or admin

About this task

Procedure

1. Respond to an anonymous chat request.
2. Chat with the user to determine the issue.
3. At the bottom of the conversation, click the menu icon to open the Connect actions

menu.
4. In the Connect actions menu, select Create Consumer and Case for Guest.

In the conversation tools area to the right of the conversation, a new consumer form
opens in a record tab. The system automatically sets certain fields based on
conversation details. For a consumer record created from a guest user chat, the First
name, Last name, and Email fields display information from the initial chat request.

Selecting this option creates a consumer record using the information provided on the
record producer and then associates the case with the newly created consumer. The
Case form is also populated with the information provided on the record producer.

5. Complete the form as necessary and click Submit.

Use the Customer Service Portal
Last updated: July 26, 2018
Last updated: July 26, 2018

Search for information about a question or an issue or request assistance from a customer
service agent.

The Customer Service Portal home page includes the following features:

• A header with buttons for creating and viewing cases, viewing assets, and managing users.
• A search feature that customers can use to search for information from several

repositories.
• Links to information sources, such as the knowledge base, the community, and customer

support cases.
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Customer Service Portal

Customers can use the portal to:

• Search the knowledge base for information that is relevant to an issue.
• Engage the community, reach out to other users, and ask questions.
• Create a case for an issue or a problem.
• View and manage current user-created cases.
• View asset and product information.
• View or update information in a user profile.
• Update notification preferences.

In addition, customer administrators can also use the portal to:

• Create a new contact.
• Create a login for a new contact.
• Enable or disable a contact login.
• Assign a user role to a contact.
• Assign a contact to an asset.
• View and update customer contact information.
• Approve registration requests.

• Customer Service Portal user roles

Several different roles allow customers to create and edit cases and manage users from
the customer portal.

• Limit access to product model data on the Customer Service Portal
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Use a system property to limit customer access to data in the Product Models table.

• Manage contacts from the customer portal

Users with the customer administrator role can create and update customer contacts;
assign roles to contacts; and create, enable, or disable contact logins from the customer
portal.

• Manage customer registration requests

Users with the customer administrator role can approve or reject registration requests
that customers submit from the Customer Service Portal.

• Assign a contact to an asset from the customer portal

Users with the customer administrator role can assign a contact to an asset from the
customer portal.

• Search for information using the customer portal

Use the search feature on the customer portal to find information about a question or an
issue.

• Deflect cases with knowledge and community content

Enable customers to search for information from the knowledge base and community and
find solutions to their issues.

• View asset and product information from the customer portal

View a list of assets and related product information for the current user's account.

• View or update customer contact information

View or update your contact information from the customer portal.

• Customer notification preferences

Customers can add devices and specify phone numbers and email addresses to be used
for notifications. Customers can also set preferences for email notifications.

• Change your password from the customer portal

Change your password from the customer portal.

• Contact self-registration

The self-registration feature enables new customer contacts to submit registration
requests from the customer portal.

• Create a customer service case from the customer portal

Create a case about a question or issue from the customer portal.

• Chat with an agent from the Customer Service Portal

Chat with a virtual agent or a customer service agent from the Customer Service Portal to
resolve issues quickly.

• View or modify a customer service case from the customer portal
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View or modify the information in a selected customer service case.

• View a publication on the Customer Service Portal

View the details of a publication on the Customer Service Portal and download any
attachments.

• Complete a customer service satisfaction survey

After accepting a proposed solution for a case, complete a customer service satisfaction
survey.

Customer Service Portal user roles

Last updated: July 26, 2018
Last updated: July 26, 2018

Several different roles allow customers to create and edit cases and manage users from the
customer portal.

Customer Service Portal user roles
User role What this user can do on the Customer Service

Portal
Customer
[sn_customerservice.customer] • Create a case for this user's account.

• View a list of cases created by this user.
• Edit cases created by this user.
• View a list of assets belonging to this user's

account.
• Search for information.

Customer case manager
[sn_customerservice.customer_case_manager] • Create a case for this user's account and for

child accounts.
• View a list of cases created by this user and

view cases for child accounts.
• Edit cases created by this user and edit cases

for child accounts.
• View a list of assets belonging to this user's

account and to child accounts.
• Search for information.
• Create a case on behalf of another contact in

this account.
• View a list of cases belonging to this account.
• Edit cases belonging to the account.

Note:  The customer case manager role is not
automatically added to the
sn_customerservice.contact_role_assignment
system property. To expose this role to
customer and partner administrators,
navigate to Customer Service >
Administration > Properties and add it to this
property.

Customer administrator
• Create a case for this user's account.
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User role What this user can do on the Customer Service
Portal

[sn_customerservice.customer_admin] • Create a case on behalf of another contact for
this account.

• View a list of cases belonging to this account.
• Edit cases belonging to this account.
• View a list of assets belong to this user's

account.
• Search for information.
• Manage users for this account.

Partner
[sn_customerservice.partner] • Create a case for this user's account.

• Create a case on behalf of customer accounts.
• View a list of cases belonging to this user.
• Edit cases belonging to this user.
• View a list of assets belong to this user's

account.
• Search for information.

Partner administrator
[sn_customerservice.partner_admin] • Create a case for this user's account.

• Create a case on behalf of customer accounts.
• View a list of cases belonging to this account

and to customer accounts.
• View a list of assets belong to this account and

to customer accounts.
• Edit cases belonging to this account and to

customer accounts.
• Manage users for this account and for customer

accounts.

Limit access to product model data on the Customer Service Portal

Last updated: July 26, 2018
Last updated: July 26, 2018

Use a system property to limit customer access to data in the Product Models table.

From the Customer Service Portal, product model data can be accessed by external users
with the sn_esm_user role. System administrators can use the
csm_cmdb_model.customer_visible_flag system property and the Customer Visible field on
the Product Models table (cmdb_model) and child tables to limit this access.

The csm_cmdb_model.customer_visible_flag system property enables the Customer Visible
field for the tables listed below. By default, this property is set to false. When set to true, the
system uses the setting in the Customer Visible field to determine access to product model
data on the Customer Service Portal.

• Product Models table (cmdb_model)
• Software Models table (cmdb_software_product_model)
• Application Models table (cmdb_application_product_model)
• Consumable Models table (cmdb_consumable_product_model)
• Facility Models table (cmdb_facility_product_model)
• Hardware Models table (cmdb_hardware_product_model)

The Model Categories table (cmdb_model_category) does not have a Customer Visible field.
Access to model categories data is restricted by using the Customer Visible field on the
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Product Model table. Only the categories for the products which are visible in the Product
Model table will be visible in the Model Categories table.

For upgrades from Jakarta to london, the Customer Visible field is added to each record in
the Product Models table and set to false.

To limit access:

1. Set the csm_cmdb_model.customer_visible_flag system property to true.
2. Customize the Product Models table (cmdb_model) and add the Customer Visible

column.
3. Set the value of the Customer Visible field to true for the product models that should be

visible to external customers.

External users can see these product using these product models if the products are linked
to the customer account.

Manage contacts from the customer portal

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the customer administrator role can create and update customer contacts; assign
roles to contacts; and create, enable, or disable contact logins from the customer portal.

Administrators can also reset a password for a contact from the customer portal based on
the Content Management System (CMS). The Customer Service Portal does not support the
password reset feature. The system administrator can change and reset passwords using the
ServiceNow Password Reset and Password Change applications.

Note:  The Related Links section at the bottom of the Contacts page includes
several Service Portal links that are not currently supported by the Customer
Service Portal.

Create a customer contact

Create a customer contact from the customer portal.

Before you begin

Role required: sn_customerservice.customer_admin, sn_customerservice.partner_admin, or
admin

Procedure

1. Click Manage Users in the portal header.
2. From the Contacts list, click New.
3. Fill in the fields on the Contact form, as appropriate.

Contact form
Field Description
First name Customer's first name.

Last name Customer's last name.

Title Customer's job title.
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Field Description
Language The language for this customer.

Time zone The time zone for this customer's location.

Account The user's account.

Email Customer's email address

Business phone Customer's business phone.

Mobile phone Customer's mobile phone.

Notification Enable or disable notifications for this
customer.
This field is displayed after you click Submit
and create the contact.

User ID A unique identifier for this user. The user ID
should follow the format firstname.lastname.
This field is displayed after you click Submit
and create the contact.

4. Click Submit.
After you create a new contact, you can create a login for the contact and enable or
disable notifications.

Create a login for a new contact

After creating a new contact, you can create a login for that contact.

Before you begin

Role required: sn_customerservice.customer_admin, sn_customerservice.partner_admin, or
admin

Procedure

1. Click Manage Users in the portal header.
2. Select the new contact from the Contacts list.
3. Click the Create Login related link.

The system creates a login for this contact and fills in the User ID field on the Contact
form with the user's first and last name in this format: firstname.lastname

In the event that you create a new contact with the same first and last name as an
existing contact, the User ID field is left blank and the Create Login related link does not
appear on the contact form.

To create a login for this contact, enter a unique login in the User ID field on the Contact
form and click Update.

Update contact information for a user

Update the contact information for a user from the customer portal.

Before you begin
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Role required: sn_customerservice.customer_admin, sn_customerservice.partner_admin, or
admin

Procedure

1. Click Manage Users in the portal header.
2. Select a user from the Contacts list.
3. Make the desired changes to the fields on the Contact form.

Contact form
Field Description
First name Customer's first name.

Last name Customer's last name.

Title Customer's job title.

Language The language for this customer.

Time zone The time zone for this customer's location.

Account The user's account.

Email Customer's email address

Business phone Customer's business phone.

Mobile phone Customer's mobile phone.

Notification Enable or disable notifications for this
customer.

User ID A unique identifier for this user. The user ID
should follow the format firstname.lastname.

4. Click Update.

Enable or disable the login for a contact

Enable or disable the login for a contact.

Before you begin

Role required: sn_customerservice.customer_admin, sn_customerservice.partner_admin, or
admin

Procedure

1. Click Manage Users in the portal header.
2. Select a contact from the Contacts list.
3. Click one of the following related links:

• Disable login
• Enable login

If the login for this contact is currently enabled, the Disable login related link is
displayed. If currently disabled, the Enable login related link is displayed.
The system enables or disables the login for this contact and returns you to the Contact
list. A disabled contact cannot access the customer portal.
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Assign a user role to a contact

Assign one or more user roles to a contact from the customer portal.

Before you begin

Role required: sn_customerservice.customer_admin, sn_customerservice.partner_admin, or
admin

Procedure

1. Click Manage Users in the portal header.
2. Select a user from the Contacts list.
3. Click the Assign Roles related link.
4. Select a role in the Available column and move it to the Selected column.
5. Click OK.
6. Click Update.

Reset a password for a contact

Reset a password for a contact from the customer portal.

Before you begin

Role required: admin

About this task

When you reset a password for a contact, the system sends an email to the contact that
includes a new temporary password. The customer is asked to change this temporary
password at the next login.

Note:  Administrators can reset a password for a contact from the customer portal
based on the Content Management System (CMS). The Customer Service
Portal does not support the password reset feature.

Procedure

1. Click Manage Users in the portal header.
2. Select a contact from the Contacts list.
3. Click the Reset a password related link.

This brings up the Password Reset Assistance dialog box.
4. Ensure that the correct user name is displayed in the Select User field.
5. Select a process in the Select process field.
6. Click Verify Identity.

Manage customer registration requests

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the customer administrator role can approve or reject registration requests that
customers submit from the Customer Service Portal.

• Approve a registration request with a valid registration code
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Approve a registration request from a user that was submitted from the Customer Service
Portal with a valid registration code.

• Approve a registration request with an invalid registration code

Approve a registration request from a user that was submitted from the Customer Service
Portal with an invalid registration code.

• Reject a registration request

Reject a registration request from a user that was submitted from the Customer Service
Portal.

Approve a registration request with a valid registration code

Last updated: July 26, 2018
Last updated: July 26, 2018

Approve a registration request from a user that was submitted from the Customer Service
Portal with a valid registration code.

Before you begin

Role required: sn_customerservice.customer_admin

Procedure

1. Navigate to the customer portal.
2. Click Approvals.

The Approvals list displays registration requests with these states: Requested and No
Longer Required.

3. Click a request in the Approvals list with a state of Requested.
4. If desired, add any Comments to this request.
5. Click Approve.

A user account is created and an email is sent to the contact’s email address with a user
ID and temporary password. The user is also assigned these roles: sn_esm_user and
snc_external.

Approve a registration request with an invalid registration code

Last updated: July 26, 2018
Last updated: July 26, 2018

Approve a registration request from a user that was submitted from the Customer Service
Portal with an invalid registration code.

Before you begin

Role required: sn_customerservice.customer_admin

Procedure

1. Navigate to Customer Service > Administration > Pending Contact Registrations.
2. Select a registration request with a state of Pending.
3. Select an Account for the requester.
4. Click Update.

The registration request is sent to the customer administrator of the assigned account.
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Reject a registration request

Last updated: July 26, 2018
Last updated: July 26, 2018

Reject a registration request from a user that was submitted from the Customer Service
Portal.

Before you begin

Role required: sn_customerservice.customer_admin

Procedure

1. Navigate to the customer portal.
2. Click My Approvals.
3. Click a request in the Approvals list with a state of Requested.
4. Click Reject.

An email regarding the rejection is sent to the requestor’s email address.

Assign a contact to an asset from the customer portal

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the customer administrator role can assign a contact to an asset from the
customer portal.

Before you begin

Role required: sn_customerservice.customer_admin

Procedure

1. Log in to the customer portal.
2. Click the Assets link at the top of the portal.
3. Click the desired asset.
4. Click New in the Asset Contacts related list.

This displays a new Asset Contact form. The Asset field displays the selected asset and
is read-only.

5. Select a Contact.
The contacts available for selection are the contacts from the asset's account.

6. Click Submit.
The contact is added to the Asset Contacts related list.

Search for information using the customer portal

Last updated: July 26, 2018
Last updated: July 26, 2018

Use the search feature on the customer portal to find information about a question or an
issue.

Before you begin

Role required: sn_customerservice.customer, sn_customerservice.customer_admin,
sn_customerservice.partner, or sn_customerservice.partner_admin
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About this task

The portal has a search feature that you can use to search for information across several
repositories. Enter a search term in the Search field and then click Search to display a list of
related articles.

The portal also displays information from the knowledge base, the community, and customer
support.

Procedure

1. Enter a search term into the Search field.
2. Click Search.

A list of articles related to the search term is displayed, with the results grouped into
three categories: Cases, Knowledge, Questions.

3. Click a link to view an article.

• Search the knowledge base

Use the customer portal to search the knowledge base or view a list of popular
knowledge base articles.

• Search the customer service community

Use the customer service portal to search the community site or view a list of recent
discussion topics.

Search the knowledge base

Last updated: July 26, 2018
Last updated: July 26, 2018

Use the customer portal to search the knowledge base or view a list of popular knowledge
base articles.

Before you begin

Role required: sn_customerservice.customer, sn_customerservice.customer_admin,
sn_customerservice.partner, or sn_customerservice.partner_admin

About this task

The customer service portal includes a link to the knowledge base that you can use to
search for information, read and rate articles, and submit feedback. Under this link, the
portal displays a list of popular knowledge base articles. If the information that you need is
not included in this list, you can search the knowledge base for the desired information.

Procedure

1. Navigate to the customer service portal.
2. Click Knowledge.

The knowledge page displays a separate category for each of the products purchased
by this customer. It also displays lists of articles by:

• Featured content
• Most useful
• Most viewed

3. Do one of the following:
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Option Description

Click a product to display more specific
information

Displays a list of categories on the left and
articles on the right. Click a category to drill
down even further.

Click a link from one of the lists Displays the article.

Type a topic in the Search field and press the
Enter key

Displays a list of related articles. Click a link to
display the desired article.

Search the customer service community

Last updated: July 26, 2018
Last updated: July 26, 2018

Use the customer service portal to search the community site or view a list of recent
discussion topics.

Before you begin

Role required: sn_customerservice.customer, sn_customerservice.customer_admin,
sn_customerservice.partner, or sn_customerservice.partner_admin

Procedure

1. Navigate to the customer service portal.
2. Click Ask the Community.

This brings up the Ask a Question page.
3. Enter a question in the Title field.
4. Select a knowledge base in the Knowledge Base field.
5. If desired, select a category in the Category field.
6. If desired, add one or more tags to your question in the Tags field.
7. Click Post Question.

The question appears on the search results page under the Questions category.

Deflect cases with knowledge and community content

Last updated: July 26, 2018
Last updated: July 26, 2018

Enable customers to search for information from the knowledge base and community and
find solutions to their issues.

Before you begin

Role required: sn_customerservice_customer or sn_customerservice_consumer

About this task

The Service Portal Case form displays contextual search results based on text entered in the
Subject field. These search results provide targeted solutions to customers. Customers can
search for information that is related to a case when opening a case. If the search results in
any related content, the customer can preview the content.

Note:  By default, search results include knowledge articles, solved community
questions and blogs, and pinned articles.
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Procedure

1. Navigate to the Customer Service Management Service Portal and then Support > New
Cases.

2. Click Product Case or Order Case.
3. Start typing in the Subject field.

If there are any search results that match, they are displayed in the Related Search
Results widget.

Note:  If embedded search has been enabled, the results are displayed inline in
the Case form in a Knowledge results section and are read-only.

4. Perform one of the following actions.
• Click one of the content links in the Related Search Results widget to enter the

content directly.
• Click one of the content links in the embedded Knowledge results section to open

the content inline as read-only.
5. Click This helped to mark the content as helpful for resolving the associated case.
6. Click Submit.

View asset and product information from the customer portal

Last updated: July 26, 2018
Last updated: July 26, 2018

View a list of assets and related product information for the current user's account.

Before you begin

Role required: sn_customerservice.customer, sn_customerservice.customer_admin,
sn_customerservice.partner, or sn_customerservice.partner_admin

Procedure

1. Click Assets in the portal header.
This displays a list of assets that belong to the current user's account, including the
name and serial number of the asset and the product model category and account to
which it belongs.

2. Click one of the following to view more information.

Option Description

Display name Displays the asset information.

Account Displays the account information.

Model category Displays the product model information for
this asset.

3. Click the Back button to return to the list of assets.

View or update customer contact information

Last updated: July 26, 2018
Last updated: July 26, 2018

View or update your contact information from the customer portal.
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Before you begin

Role required: sn_customerservice.customer, sn_customerservice.customer_admin,
sn_customerservice.partner,or sn_customerservice.partner_admin

Procedure

1. Click your user name in the portal header to display your contact information.
2. Make any desired changes to the fields on the Contact form.

Contact form
Field Description
First name Customer's first name.

Last name Customer's last name.

Title Customer's job title.

Language The language for this customer.

Time zone The time zone for this customer's location.

Account The user's account.

Email Customer's email address

Business phone Customer's business phone.

Mobile phone Customer's mobile phone.

Notification Enable or disable notifications for this
customer.

User ID A unique identifier for this user. The user ID
should follow the format firstname.lastname.

3. Click Update.

Customer notification preferences

Last updated: July 26, 2018
Last updated: July 26, 2018

Customers can add devices and specify phone numbers and email addresses to be used for
notifications. Customers can also set preferences for email notifications.

Customers can add the following types of devices:

• Email
• Push
• SMS
• Voice

After adding a new device, customers can configure the device to receive notifications.
Customers can also set several email notification preferences which control email
notifications that are sent to the customer when an agent performs one of the following
case activities:

• Opens a case for a customer
• Comments on a customer's case
• Provides a resolution for a customer's case
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• Closes a customer's case

• Add a device for customer notifications

Customers can add devices to be used for notifications.

• View or update notification preferences

Customers can add devices and specify email addresses to be used for notifications.

• Set email notification preferences

Customers can set preferences for email notifications that are sent when customer service
agents perform different actions on cases.

Add a device for customer notifications

Last updated: July 26, 2018
Last updated: July 26, 2018

Customers can add devices to be used for notifications.

Before you begin

Role required: sn_customerservice.customer, sn_customerservice.customer_admin,
sn_customerservice.partner, or sn_customerservice.partner_admin

Procedure

1. Click your user name in the portal header to display the user profile information.
2. Click the Notification Preferences related link to display the Notification Preferences

form.
3. Click the New Device button in the form header to display the New Device form.

New Device form
Field Description
Name The name of the device.

Type The type of notification device:
• Email
• Push
• SMS (default)
• Voice

Different fields are displayed depending on the
type of device selected.

Phone number The user's phone number.

Service provider The user's service provider.

Email address The user's email address.

Push application The push application to be used for
notifications.

User The user's name.

Order The order in which the selected device receives
notifications.
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Field Description
Active Enables this device to receive notifications.

4. Enter a name for the device in the Name field.
5. Select the type of device in the Type field.

The remaining fields displayed depend on the type of device selected.

• If Email, enter an address in the Email address field.
• If Push, select an application in the Push Application field.
• If SMS, enter a phone number in the Phone number field and select a provider in the

Service provider field.
• If Voice, enter a phone number in the Phone number field.

6. If desired, select a different user in the User field.
7. Enter a number in the Order field.
8. Enable the Active checkbox.
9. Click Submit.

View or update notification preferences

Last updated: July 26, 2018
Last updated: July 26, 2018

Customers can add devices and specify email addresses to be used for notifications.

Before you begin

Role required: sn_customerservice.customer, sn_customerservice.customer_admin,
sn_customerservice.partner, or sn_customerservice.partner_admin

Procedure

1. Click the user name in the portal header to display the user profile information.
2. Click the Notification Preferences related link to display the Notification Preferences

page.
3. Select a device from the Notification Preferences list.
4. Make any desired changes to the fields on the device form.
5. Click Update.

Set email notification preferences

Last updated: July 26, 2018
Last updated: July 26, 2018

Customers can set preferences for email notifications that are sent when customer service
agents perform different actions on cases.

Before you begin

Role required: sn_customerservice.customer, sn_customerservice.customer_admin,
sn_customerservice.partner, or sn_customerservice.partner_admin

Procedure

1. Navigate to the customer service portal.
2. Click your user name in the portal header to display your user profile information.
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3. Click the Notification Preferences related link to display the Notification Preferences
form.

4. Enable or disable the following email notifications for your primary email address. An
option is enabled when the switch appears green and is toggled to the right.

• Case closed
• Case commented
• Case opened for me
• Case resolved

5. Click Save.

Change your password from the customer portal

Last updated: July 26, 2018
Last updated: July 26, 2018

Change your password from the customer portal.

Before you begin

Role required: admin

Note:  Users with the required roles can change their passwords from the CMS
version of the customer portal. This functionality is not supported for the
Customer Service Portal. The system administrator can change and reset
passwords using the ServiceNow® Password Reset and Password Change
applications .

About this task

Procedure

1. Click your user name in the portal header to display the user profile information.
2. Click the Change password related link.
3. Fill in the fields on the Change Password form, as appropriate.

Change Password form fields
Field Description
Change password for

Old password The current password. This field is
automatically filled in.

New password The new password. This password must:
• Be a minimum of eight characters in length
• Include at least one uppercase and one

lowercase letter
• Include at least one number

Retype password The new password.

4. Click Change Password.

Contact self-registration

Last updated: July 26, 2018
Last updated: July 26, 2018
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The self-registration feature enables new customer contacts to submit registration requests
from the customer portal.

Once the request is submitted, it goes through an approval process and is either accepted
or rejected. If accepted, a user account is created and the contact receives an email with a
user ID and a temporary password. When logging in to the portal for the first time, the
contact is asked to change the temporary password. If rejected, the contact receives an
email with this information.

A customer contact can submit a registration request with or without a registration code:

• If a request is submitted with a valid registration code, the contact’s account information is
automatically detected and added to the contact record. The request is then sent to the
customer administrator of that account for approval. If an account has multiple customer
administrators, they all receive the registration request but only one is required to approve
it. After a request has been approved, the state of the request changes to No Longer
Required for the other customer administrators.

• If a request is submitted without a registration code or if the code is incorrect, the request
is sent to the system administrator, who fills in the account information. Once this
information is filled in, the request is sent to the customer administrator of that account for
approval.

The system administrator creates a unique registration code for each account and stores it in
the Registration Code field on the Account form. Once this code is created, customer
administrators can distribute the code to customers as needed.

• Submit a self-registration request

Submit a registration request from the Customer Service Portal.

• Request a password reset

If you forget your password, you can request a new password from the customer portal
login screen.

• Log in to the customer portal for the first time

After a registration request is approved, the customer contact receives an email with a
user ID and temporary password. When logging in for the first time, the contact is asked
to change the password.

Related Concepts

• Example: The default self-service Password Reset process

Submit a self-registration request

Last updated: July 26, 2018
Last updated: July 26, 2018

Submit a registration request from the Customer Service Portal.

Before you begin

Role required: none

Procedure
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1. Navigate to the customer portal login page.
2. Request a login by clicking the self-registration link.
3. Fill in your First Name, Last Name, and Business Email.
4. If you have a registration code, enter it in the Registration Code field.
5. Enable the check box to agree to the privacy policy and to the community terms and

conditions.
Click the links to access more information about these policies.

6. Enable the Security Code check box, complete the CAPTCHA validation, and click Verify.
The Customer Service application uses the Google re-CAPTCHA service.

7. Click Submit.
You are returned to the portal login page.

If you entered a valid registration code, you see this message: “Your request has been
submitted and is pending review. You will receive an email when your request is
processed.”

If you did not enter a registration code or if the code was incorrect, you see this
message: “Incorrect Registration Code.” Your request is submitted and is sent to the
system administrator to complete the account information.

Request a password reset

Last updated: July 26, 2018
Last updated: July 26, 2018

If you forget your password, you can request a new password from the customer portal
login screen.

Before you begin

Role required: none

Procedure

1. Navigate to the customer portal login page.
2. Click the reset your password here link.
3. Enter your User name and Email address.
4. Click Reset Password.

The user name and email address are validated. If they match, the system generates a
temporary password and sends it to the user's email address.

5. Log in to the customer portal using the temporary password.
You are required to create a new password before continuing.

6. Enter the new password in the Password field.
7. Enter the new password again in the Validate Password field.
8. Click Submit.

Log in to the customer portal for the first time

Last updated: July 26, 2018
Last updated: July 26, 2018

After a registration request is approved, the customer contact receives an email with a user
ID and temporary password. When logging in for the first time, the contact is asked to
change the password.
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Before you begin

Role required: none

Procedure

1. Navigate to the customer portal login page.
2. Enter your user ID in the User name.
3. Enter your temporary password in the Password field.
4. Click Login.

You are prompted to change your password.
5. Enter your temporary password in the Current Password field.
6. Enter your new password in the New Password field.
7. Re-enter your new password in the Confirm New Password field.
8. Click Submit.

Create a customer service case from the customer portal

Last updated: July 26, 2018
Last updated: July 26, 2018

Create a case about a question or issue from the customer portal.

Before you begin

Role required: sn_customerservice.customer, sn_customerservice.partner,
sn_customerservice.customer_admin, or sn_customerservice.partner_admin

About this task

Customers and partners can create a case from the customer portal.

Procedure

1. Navigate to the portal.
2. Click Create Case
3. Fill in as many fields on the Create Case form as you can.

Note:  Depending on your role, you may not see the Account and Contact fields.

Create Case form (customer portal)
Field Description
Account The account for which the case is being

created.

Contact The name of the customer contact for this
case.

Asset The asset tag number or the serial number of
the asset associated with this case.

Product The product model of the asset. A model is a
specific version or configuration of an asset (for
example, Apple Mac Book Pro).
If you select an asset in the Asset field, this field
is auto-filled if the associated product
information is available in the asset record. A
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Field Description
product may be associated with multiple
assets.

Priority The assigned priority:
• 1 - Critical
• 2 - High
• 3 - Moderate
• 4 - Low (default)

Subject A brief description of the customer question,
issue, or problem.

Description A more detailed description of the customer
question, issue, or problem.

4. Click Submit.
The case is created, assigned a case number, and added to the user's case list. Click My
Cases at the top of the customer portal to view the Cases list.

Chat with an agent from the Customer Service Portal

Last updated: July 26, 2018
Last updated: July 26, 2018

Chat with a virtual agent or a customer service agent from the Customer Service Portal to
resolve issues quickly.

Before you begin

Role required: sn_customerservice.customer, sn_customerservice.customer_admin,
sn_customerservice.partner, sn_customerservice.partner_admin

Procedure

1. Click the chat icon ( ) in the Customer Service Portal to start a conversation.
A virtual agent or a customer service agent responds.

2. To talk to a person instead of a virtual agent, click  and then Contact Support.
3. When you are finished with the chat, click End Conversation.

What to do next

If the agent creates a new case or links the discussion to an existing case, you can view
these cases from the customer portal by clicking on My Cases and displaying the case list.

View or modify a customer service case from the customer portal

Last updated: July 26, 2018
Last updated: July 26, 2018

View or modify the information in a selected customer service case.

Before you begin

Role required: sn_customerservice.customer, sn_customerservice.customer_admin,
sn_customerservice.partner, sn_customerservice.partner_admin
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About this task

Depending on the role of the current user, the Case list displays:

• Cases created by the current user (sn_customerservice.customer)
• Cases related to the current user's account (sn_customerservice.customer_admin)
• Cases related to the current user's account as well as partner accounts

(sn_customerservice.partner, sn_customerservice.partner_admin)

Procedure

1. Click Cases in the portal header.
Cases are ordered in the list with the most recently updated at the top.

2. Click the desired case number to open the Case form.
3. Make any necessary changes to the Short description or Additional comments fields.

All other fields on the form are read-only.
4. Click Update.

View a publication on the Customer Service Portal

Last updated: July 26, 2018
Last updated: July 26, 2018

View the details of a publication on the Customer Service Portal and download any
attachments.

Before you begin

Role required: sn_customerservice.customer

About this task

The Publications link on the customer service portal displays a list of current publications.
You can filter the publications on this list by category and you can further filter the list to
show all publications or only those that are unread. You can sort the list by publish date or
expiration date. You can also search for a specific term.

After a publication reaches its Expiry Date, it is automatically removed from the Publications
list.

Procedure

1. Navigate to the customer service portal.
2. Click Publications in the portal header.

This displays a list of current publications. The information displayed for each publication
includes the title, publish date, expiration date, and a brief description.

3. If desired, filter or sort the Publications list.
• Select a category in the upper-left corner or select All Categories.
• Select either All Publications or Unread Publications in the upper-right corner.
• Select either Publish Date or Expiry Date in the Sort by field.

4. If desired, search the Publications list by entering the search term in the Search
Publications field.

5. Click a publication name to open.
6. If the publication has attachments, click Attachments in the upper-right corner.
7. Select the attachments to download from the pop-up window.
8. Close the pop-up window.
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9. Click the return arrow at the top of the publication to return to the Publications list.

Complete a customer service satisfaction survey

Last updated: July 26, 2018
Last updated: July 26, 2018

After accepting a proposed solution for a case, complete a customer service satisfaction
survey.

Before you begin

When a customer accepts a proposed solution for a case by clicking Accept Solution on the
case form, a satisfaction survey is displayed in the portal. The customer has the option of
completing or skipping the survey. Either choice returns the customer to the list of cases on
the self-service portal.

To complete the survey:

Procedure

1. Answer each of the survey questions.
2. Click Submit.

Use the Consumer Service Portal
Last updated: July 26, 2018
Last updated: July 26, 2018

The Consumer Service Portal is a web interface that your company can use to provide
information and support to consumers.

The Consumer Service Portal is based on the ServiceNow Service Portal application.
Consumers can use the portal to search for information, get their questions answered by
other registered members, or request assistance from a customer service agent.
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Consumer Service Portal

From the Consumer Service Portal, consumers can:

• Search for information, browse knowledge articles, and engage with the community.
• Start a chat session with a customer service agent
• Register, create a login, and create a user profile.

After registering and logging in to the Consumer Service Portal, consumers can:

• Edit user profile information and change passwords.
• Register new products and view a list of currently registered products.
• Contact a consumer service agent about a question or issue.
• Create cases and view a list of current cases.
• Accept or reject proposed case solutions.

Customizing the Consumer Service Portal

To customize this portal, navigate to Service Portal > Portals and click Consumer Service
Portal. See Service Portal for more information about creating a custom interface.

• Consumer registration

Use the Consumer Service Portal to register and create a consumer profile.

• Log in to the Consumer Service Portal

Use the name and password that you created during the registration process to log in to
the Consumer Service Portal.
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• View or edit a consumer profile

Registered users with the consumer role can view their consumer profiles, edit the
information as needed, and change passwords.

• Register a product from the Consumer Service Portal

Users with the consumer role can register their products from the Consumer Service
Portal.

• View a list of products from the Consumer Service Portal

Users with the consumer role can view a list of their registered products from the
Consumer Service Portal.

• Create a case from the Consumer Service Portal

Users with the consumer role can create cases from the Consumer Service Portal.

• View a case from the Consumer Service Portal

Users with the consumer role can view a list of cases from the Consumer Service Portal
and select individual cases to see more detail.

• Accept or reject a case solution from the Consumer Service Portal

Users with the consumer role can accept or reject the proposed solution for a case from
the Consumer Service Portal.

• Chat with an agent from the Consumer Service Portal

Chat with a virtual agent or a customer service agent from the Consumer Service Portal
to resolve issues quickly.

• Chat anonymously with an agent from the Consumer Service Portal

Users that are not logged in can chat anonymously with an agent from the Consumer
Service Portal to resolve issues more quickly.

• Respond to a consumer chat request

Select a chat request from the chat queue and respond to a customer's question or
comment.

• Create a consumer case from a chat

If a consumer chat results in the need to open a case, create the case directly from the
conversation.

• Create a consumer record

Consumer service agents and managers can create a consumer record from the Customer
Service Management application.

• Create additional consumer addresses

Consumers can have multiple addresses, including one primary address.

• View a publication on the Consumer Service Portal
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View the details of a publication on the Consumer Service Portal and download any
attachments.

• Consumer form

The Consumer form stores information about a consumer, including the name, addresses,
and phone numbers.

• List and form views by agent role

Users with either the customer agent role or the consumer agent role can see attributes
specific to the end user on these Customer Service Management lists.

• Consumer Service Portal properties

Properties that the system administrator can set to limit the number of registered
products per consumer, the number of open cases per consumer, and the number of
attachments per consumer record.

Consumer registration

Last updated: July 26, 2018
Last updated: July 26, 2018

Use the Consumer Service Portal to register and create a consumer profile.

Before you begin

Role required: none

About this task

When a consumer successfully completes the self-registration process from the Consumer
Service Portal, a record of the consumer registration is created and stored in the Consumer
Users table [csm_consumer_user] and the Users table [sys_user]. The consumer is also
granted the consumer [sn_customerservice.consumer] role.

Procedure

1. Navigate to the Consumer Service Portal.
2. Click Register in the portal header.
3. Fill in the fields on the registration form.

Your email address must be unique. If you enter an address that is already in the system,
you receive an error message. You can try again with a different email address.

4. Enable the Security Code check box, complete the CAPTCHA validation, and click Verify.
The Consumer Service Portal uses the Google re-CAPTCHA service.

5. Enable the check box to agree to the privacy policy and to the community terms and
conditions.

6. Click Submit.
If the fields on the registration form are filled out correctly, your registration is
completed and you are logged in to the Consumer Service Portal.

Log in to the Consumer Service Portal

Last updated: July 26, 2018
Last updated: July 26, 2018
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Use the name and password that you created during the registration process to log in to the
Consumer Service Portal.

Before you begin

Role required: sn_customerservice.consumer

Procedure

1. Navigate to the Consumer Service Portal.
2. Click Login in the portal header.
3. Fill in the fields on the Login popup window.
4. Click Login.

You are logged in to the Customer Service Portal and your name appears in the portal
header.

View or edit a consumer profile

Last updated: July 26, 2018
Last updated: July 26, 2018

Registered users with the consumer role can view their consumer profiles, edit the
information as needed, and change passwords.

Before you begin

Role required: sn_customerservice.consumer

Procedure

1. Log in to the Consumer Service Portal.
2. Click your user name in the portal header and then click Profile.
3. To add a picture to your profile, click Upload Picture and select the desired image.
4. To update the personal information in your profile, including name, contact information,

and address:
a. Click the desired field.
b. Enter the new information in the popup window.
c. Click Save.

5. To change your password, click Change Password.
The Change Password link appears on the consumer profile when the Self Service
Password Reset plugin (com.snc.password_reset) is activated.

6. Fill in the fields on the Change Password popup window and click Update.

Register a product from the Consumer Service Portal

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the consumer role can register their products from the Consumer Service Portal.

Before you begin

Role required: sn_customerservice.consumer

Procedure
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1. Log in to the Consumer Service Portal.
2. Click Products in the portal header and then click Register Product.
3. Type a search term in the search field and press Enter to display a list of products.
4. Click the Select button on the card for the desired product.
5. Enter the Serial Number and the Purchase Date for the selected product.
6. Click Register.

After the product is successfully registered, it appears in the My Products list, which
includes the products registered to the current user.

View a list of products from the Consumer Service Portal

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the consumer role can view a list of their registered products from the Consumer
Service Portal.

Before you begin

Role required: sn_customerservice.consumer

Procedure

1. Log in to the Consumer Service Portal.
2. Click Products in the portal header and then click My Products.

This displays a list of products registered to the current user.
3. If desired, click a product to display more information about the product.

Create a case from the Consumer Service Portal

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the consumer role can create cases from the Consumer Service Portal.

Before you begin

Role required: sn_customerservice.consumer

Procedure

1. Log in to the Consumer Service Portal.
2. Click Get Help in the portal header.
3. Select a Product and enter a brief description in the Subject field.
4. If desired, add a more detailed Description and any attachments.
5. Click Submit.

The new case is created and added to the Cases list. To view the case, click the link in
the case creation message or click Cases in the portal header and then click the case
number.

View a case from the Consumer Service Portal

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the consumer role can view a list of cases from the Consumer Service Portal and
select individual cases to see more detail.
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Before you begin

Role required: sn_customerservice.consumer

About this task

Selecting a case opens a form with the following sections:

• A conversation that displays the interaction between the consumer and the customer
service agent.

• The action that needs to be taken on the consumer's part, such as accepting or rejecting a
solution.

• The case details, including the case number and current status.
• Any attached files.

Procedure

1. Log in to the Consumer Service Portal.
2. Click Cases in the portal header to view a list of cases related to the current user.
3. Click the case number to view more information about the case.
4. If desired, type a message to the agent and click Send.

Your message becomes part of the case conversation. All responses from the agent are
also included in the conversation.

Accept or reject a case solution from the Consumer Service Portal

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the consumer role can accept or reject the proposed solution for a case from the
Consumer Service Portal.

Before you begin

Role required: sn_customerservice.consumer

About this task

When an agent proposes a solution to a consumer's case, buttons for accepting or rejecting
the solution appear in the section of the form that shows the consumer actions.

Procedure

1. Log in to the Consumer Service Portal.
2. Click Cases in the portal header to view a list of cases related to the current user.
3. Click a case number to view more information about the case.
4. Click one of the following buttons:

Option Description

Accept Solution Accepts the solution proposed by the agent
and changes the case state to Closed.

Reject Solution Rejects the solution proposed by the agent
and changes the case state to Open.
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Chat with an agent from the Consumer Service Portal

Last updated: July 26, 2018
Last updated: July 26, 2018

Chat with a virtual agent or a customer service agent from the Consumer Service Portal to
resolve issues quickly.

Before you begin

Role required: sn_customerservice.consumer

Procedure

1. Click the chat icon ( ) in the Consumer Service Portal to start a conversation.
A form opens that requests the type of issue and a brief description of the issue.

2. Fill in the information and click Submit.
A virtual agent or a customer service agent responds.

3. To talk to a person instead of a virtual agent, click  and then Contact Support.
4. When you are finished with the chat, click End Conversation.

What to do next

If the agent creates a new case or links the discussion to an existing case, you can view
these cases from the Consumer Service Portal by clicking Cases and displaying the case list.

Chat anonymously with an agent from the Consumer Service Portal

Last updated: July 26, 2018
Last updated: July 26, 2018

Users that are not logged in can chat anonymously with an agent from the Consumer
Service Portal to resolve issues more quickly.

Before you begin

Role required: none

Procedure

1. Click the chat icon ( ) in the Consumer Service Portal to start a conversation.
A form opens that requests some basic user information.

2. Fill in the information and click Submit.
A virtual agent or a customer service agent responds.

3. To talk to a person instead of a virtual agent, click  and then Contact Support.
4. When you are finished with the chat, click End Conversation.

Respond to a consumer chat request

Last updated: July 26, 2018
Last updated: July 26, 2018

Select a chat request from the chat queue and respond to a customer's question or
comment.
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Before you begin

Role required: sn_customerservice_agent, sn_customerservice_manager, or admin

Procedure

1. Navigate to Collaborate > Connect Support.
The Connect workspace opens in a new tab.

2. Click the support tab of the Connect sidebar, indicated by a headset icon.
The support tab displays Queues to which you belong. It also displays your open
support conversations under Cases. When a consumer starts a support conversation or
an agent transfers a conversation to a queue, any agent who belongs to the associated
queue has the option to accept the conversation. An agent can also request to transfer a
conversation directly to you.

3. Accept a conversation in one of the following ways.
• Accept a conversation from a queue
• Accept a transfer request

4. Respond to the consumer and help resolve the issue.
By default, your messages are added to the conversation record as comments and are
visible to the user.

If necessary, you can open a new customer service case or incident from the
conversation to track the issue. You can also transfer the conversation to a different
agent or queue, escalate the conversation to a higher priority queue.

What to do next

If necessary, you can open a new customer service case or incident from the conversation to
track the issue. You can also transfer the conversation to a different agent or queue, or
escalate the conversation to a higher priority queue. For more information, see Connect
Support.

Create a consumer case from a chat

Last updated: July 26, 2018
Last updated: July 26, 2018

If a consumer chat results in the need to open a case, create the case directly from the
conversation.

Before you begin

Role required: sn_customerservice.agent

About this task

When you create a case from a support conversation, the system copies the conversation
history to the case activity stream as comments and work notes. Future messages are
tracked in the case as well.

Procedure

1. Navigate to Collaborate > Connect Support.
The Connect workspace opens in a new tab.

2. Click the support tab of the Connect sidebar, indicated by a headset icon.
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The support tab displays Queues to which you belong. It also displays your open
support conversations under Cases. When a consumer starts a support conversation or
an agent transfers a conversation to a queue, any agent who belongs to the associated
queue has the option to accept the conversation. An agent can also request to transfer a
conversation directly to you.

3. Under Cases, open a consumer conversation.
4. At the bottom of the conversation, click the menu icon to open the Connect actions

menu.
5. In the Connect actions menu, select Create Case.

In the conversation tools area to the right of the conversation, a new case form opens in
a record tab. The system automatically sets certain fields based on conversation details.
(For a case created from a consumer chat, the Consumer field is filled in and the Short
description field displays the initial chat request from the consumer.)

6. Complete the form as necessary and click Submit.
The system automatically shares the record in the conversation, copies the conversation
to the record activity stream, and references the record on the Chat Queue Entry
[chat_queue_entry] table.

Create a consumer record

Last updated: July 26, 2018
Last updated: July 26, 2018

Consumer service agents and managers can create a consumer record from the Customer
Service Management application.

Before you begin

Role required: sn_customerservice.consumer_agent, sn_customerservice_manager or admin

Procedure

1. Navigate to Customer Service > Customer > Consumers
2. Click New.
3. Fill in the fields on the Consumer form as necessary.
4. Fill in the fields on the Primary Address tab.

A consumer can have multiple addresses but only one primary address. The primary
address is stored in the Primary Address tab on the Consumer form and in the
Addresses related list.

5. If desired, set any of the fields on the Preferences tab.
6. Click Submit.

The record is added to the Consumers table (csm_consumer). The primary address is
added to the Addresses related list and the Primary field is set to true.

Create additional consumer addresses

Last updated: July 26, 2018
Last updated: July 26, 2018

Consumers can have multiple addresses, including one primary address.

Before you begin

Role required: sn_customerservice.consumer_agent, sn_customerservice_manager, or admin

About this task
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The primary address is stored in the Primary Address tab on the Consumer form and in the
Addresses related list. Additional addresses, such as billing and shipping addresses, are
created and stored in the Addresses related list.

When you fill in the fields in the Primary Address tab and click Submit, this information is
added to the Addresses related list as the primary address. Any changes made to the
primary address are updated in both places.

For the primary address, the Primary field is set to true. For other addresses in the list, this
field is set to false. A consumer can have only one primary address.

Procedure

1. Navigate to Customer Service > Customer > Consumers.
2. Click the number of the desired consumer.
3. In the Addresses related list, click New.
4. Fill in the fields on the Location form.
5. To denote this address as the primary address for the consumer, enable the Primary

check box.
A consumer can have multiple addresses but only one primary address.

6. Click Submit.

View a publication on the Consumer Service Portal

Last updated: July 26, 2018
Last updated: July 26, 2018

View the details of a publication on the Consumer Service Portal and download any
attachments.

Before you begin

Role required: sn_customerservice.consumer

About this task

The Publications link on the Consumer Service Portal displays a list of current publications.
You can filter the publications on this list by category and you can further filter the list to
show all publications or only those that are unread. You can sort the list by publish date or
expiration date. You can also search for a specific term.

After a publication reaches its Expiry Date, it is automatically removed from the Publications
list.

Procedure

1. Navigate to the Consumer Service Portal.
2. Click Publications in the portal header.

This displays a list of current publications. The information displayed for each publication
includes the title, publish date, expiration date, and a brief description.

3. If desired, filter or sort the Publications list.
• Select a category in the upper-left corner or select All Categories.
• Select either All Publications or Unread Publications in the upper-right corner.
• Select either Publish Date or Expiry Date in the Sort by field.

4. If desired, search the Publications list by entering the search term in the Search
Publications field.
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5. Click a publication name to open.
6. If the publication has attachments, click Attachments in the upper-right corner.
7. Select the attachments to download from the pop-up window.
8. Close the pop-up window.
9. Click the return arrow at the top of the publication to return to the Publications list.

Consumer form

Last updated: July 26, 2018
Last updated: July 26, 2018

The Consumer form stores information about a consumer, including the name, addresses,
and phone numbers.

Form Information

TBD

Addresses

A consumer can have multiple addresses. The primary address is stored in the Primary
Address tab on the Consumer form and in the Addresses related list. When you fill in the
fields in the Primary Address tab and click Submit, this information is added to the
Addresses related list as the primary address, with the Primary field set to true. Any changes
made to the Primary Address fields are also updated in the related list.

Note:  A consumer can have only one primary address.

Other addresses, such as billing or shipping addresses, can be created and stored in the
Addresses related list. For these other addresses, the Primary field is set to false.

All addresses for a consumer are stored in the Addresses related list. New addresses can be
created from this related list by clicking New and filling in the fields on the Location form,
including the address type.

Related lists

The Consumer form includes the following related lists:

• Addresses
• Cases
• Assets
• Contracts
• Entitlements
• Social Profiles

List and form views by agent role

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with either the customer agent role or the consumer agent role can see attributes
specific to the end user on these Customer Service Management lists.
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List view

List Columns displayed for
customer agent

Columns displayed for
consumer agent

Columns displayed for
agent with both roles

Customer
• Number
• Name
• Phone
• Primary Contact
• City
• Zip / Postal code
• Updated

Consumer
• Number
• Name
• Mobile phone
• City
• Zip / Postal code
• Updated

Case
• Number
• Short description
• Contact
• Account
• Channel
• State
• Priority
• Assigned to
• Updated

• Number
• Short description
• Consumer
• Channel
• State
• Priority
• Assigned to
• Updated

• Number
• Short description
• Contact
• Account
• Consumer
• Channel
• State
• Priority
• Assigned to
• Updated

Entitlement
• Name
• Contract
• Product
• Account
• Business Hours
• Remaining Units
• Start Date
• End Date

• Name
• Contract
• Product
• Consumer
• Business Hours
• Remaining Units
• Start Date
• End Date

• Name
• Contract
• Product
• Account
• Consumer
• Business Hours
• Remaining Units
• Start Date
• End Date

Asset
• Display name
• Account
• Primary Contact
• Serial number
• Model category

• Display name
• Consumer
• Serial number
• Model category

• Display name
• Account
• Primary Contact
• Consumer
• Serial number
• Model category

Form view

A user with either the customer agent role or the consumer agent role can see fields specific
to the end user on these forms. If an agent has both roles, all of the fields are shown.
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Form Fields displayed for customer
agent

Displayed for consumer agent

Case Account
Contact

Consumer

Entitlement Account
Contact

Consumer

Asset Account
Primary Contact

Consumer

Service Contract Account Consumer

Consumer Service Portal properties

Last updated: July 26, 2018
Last updated: July 26, 2018

Properties that the system administrator can set to limit the number of registered products
per consumer, the number of open cases per consumer, and the number of attachments per
consumer record.

Property Description
consumer_max_attachments_per_record Maximum consumer attachable items per record.

• Type: integer
• Default value: 5
• Location: Customer Service > Administration >

Properties

consumer_max_new_cases_daily Maximum new cases that a consumer can create
per day.

• Type: integer
• Default value: 10
• Location: Customer Service > Administration >

Properties

consumer_max_comments_per_case_daily Maximum comments that a consumer can post
per day on a case.

• Type: integer
• Default value: 25
• Location: Customer Service > Administration >

Properties

consumer_max_products Maximum registered products per consumer.

• Type: integer
• Default value: 25
• Location: Customer Service > Administration >

Properties

August 6, 2018 ©2018 ServiceNow. All rights reserved. 243

ServiceNow | Customer Service Management



Customer Service Performance Analytics Solutions in the base
system

Last updated: July 26, 2018
Last updated: July 26, 2018

Performance Analytics Solutions and in-form analytics contain preconfigured dashboards.
These dashboards contain actionable data visualizations that help you improve your
business processes and practices.

Note:  To evaluate the functionality, you can activate Performance Analytics
solutions and in-form analytics on instances that have not licensed
Performance Analytics. However, you have the following limitations:

• You cannot create new indicators.
• You cannot collect data older than 180 days.

For full functionality, license Performance Analytics. For more information,
see Get licensed Performance Analytics.

Performance Analytics Solutions

Use the Performance Analytics widgets on the dashboard to visualize data over time,
analyze your business processes, and identify areas of improvement. With solutions, you can
get value from Performance Analytics for your application with minimal setup.

Note:  Solutions include some dashboards that are inactive by default. You can
activate these dashboards to make them visible to end users according to
your business needs.

To enable the solution for Customer Service, an admin can navigate to Performance
Analytics > Guided Setup. Click Get Started then scroll to the section for Customer Service.
The guided setup takes you through the entire setup and configuration process.

In-form analytics

A dashboard with relevant visualizations appears as a pop-up window when a user clicks the

Analytics icon ( ) next to a field. For example, in-form analytics on an incident form
show the expected time to close that incident based on historical data, enabling support
engineers to set appropriate customer expectations.

To enable the in-form analytics plugin for Customer Service, an admin can navigate to
System Definitions > Plugins and activate the Performance Analytics - Context Sensitive
Analytics for Customer Service plugin.

Related Topics

• Available solutions

• Solutions and in-form analytics

• Performance Analytics
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Components installed with Customer Service Management
Last updated: July 26, 2018
Last updated: July 26, 2018

Several types of components are installed with the Customer Service Management
application.

• Tables installed with Customer Service Management

Tables are added with activation of Customer Service Management.

• Properties installed with Customer Service Management

Properties are added with activation of Customer Service Management.

• Roles installed with Customer Service Management

Roles are added with activation of Customer Service Management.

• Script includes installed with Customer Service Management

Script includes are added with activation of Customer Service Management.

• Client scripts installed with Customer Service Management

Client scripts are added with activation of Customer Service Management.

• Business rules installed with Customer Service Management

Business rules are added with activation of Customer Service Management.

Tables installed with Customer Service Management

Last updated: July 26, 2018
Last updated: July 26, 2018

Tables are added with activation of Customer Service Management.

Table Description
Account Relationship Access
[sn_customerservice_account_relationship_access]

Account Relationship Type
[sn_customerservice_account_relationship_type]

Stores the relationship types that are created for
bi-directional account relationships.

Account Team Member
[sn_customerservice_team_member]

Stores the team members that are assigned to
account teams.

Agent Token
[sn_customerservice_agent_token]

Appointment
[sn_customerservice_appointment]

Stores appointments that have been created for
customer service cases.

Asset Contact Stores asset contact relationship records.
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Table Description
[sn_customerservice_m2m_asset_contact]

Case
[sn_customerservice_case]

Stores customer service case records.

Channel Configurations
[sn_customerservice_channel_config]

Stores customer service email channel
configuration records.

Consumers
[csm_consumer]

Stores consumer records.

Consumer Users
[csm_consumer_user]

Stores consumer registration records that are
created when consumers complete the self-
registration process from the Consumer Service
Portal. This table extends the Users table
(sys_user).

Contact Relationship
[sn_customerservice_contact_relationship]

Stores contact relationship records.

Customer Interaction
[sn_customerservice_customer_interaction]

Customer Service Case Flow
[sn_customerservice_sf_case]

Stores customer service case state flows.

Registration Request
[sn_customerservice_registration]

Stores the customer portal self-registration
requests.

Responsibility Definition
[sn_customerservice_responsibility_def]

Stores the responsibility definitions that are
created to support customer accounts.

Task
[sn_customerservice_task]

Stores tasks that have been created for customer
service cases.

Properties installed with Customer Service Management

Last updated: July 26, 2018
Last updated: July 26, 2018

Properties are added with activation of Customer Service Management.

Note:  To open the System Property [sys_properties] table, enter sys_properties.list in
the navigation filter.
You can also navigate to Customer Service > Administration > Properties to
view a list of the most frequently used properties that you can configure for
Customer Service Management.

Property Description
glide.cs.email.case_queue_address Email case queue address.

• Type: string
• Default value: none
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Property Description
• Location: Customer Service > Administration >

Email Properties

glide.cs.email.new_case_prefix Email subject prefix format for new case.

• Type: string
• Default value: Case:
• Location: Customer Service > Administration >

Email Properties

sn_customerservice.email.create_case_for_non_matched_userCreate case for non matched user.

• Type: true | false
• Default value: false
• Location: Customer Service > Administration >

Email Properties

glide.cs.company_name Your company name.

• Type: string
• Default value: none
• Location: System Property [sys_properties]

table

glide.ui.activity.email_roles Roles that can view mail in the Activity formatter
when including "Sent/Received Emails"

• Type: string
• Default value: itil, sn_customerservice_agent
• Location: System Property [sys_properties]

table

glide.ui.sn_customerservice_case_activity.fields Case activity formatter fields

• Type: string
• Default value: assigned_to,asset,product,

state,priority,short_description,comments,entitlement,contract,*Email*,work_notes
• Location: System Property [sys_properties]

table

sn_customerservice.FTS_flag_enabled Enable the follow the sun flag on the Customer
Service Case form.

• Type: true | false
• Default value: false

sn_customerservice.glide.script.block.client.globals
• Type: true | false
• Default value:false
• Location: System Property [sys_properties]

table

sn_customerservice.shn_asset Special Handling Notes for assets

• Type: true | false
• Default value: false
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Property Description
• Location: Special Handling Notes > Properties

sn_customerservice.shn_contact Special Handling Notes for contacts

• Type: true | false
• Default value: false
• Location: Special Handling Notes > Properties

sn_customerservice.shn_product Special Handling Notes for products

• Type: true | false
• Default value: false
• Location: Special Handling Notes > Properties

sn_customerservice.shn_account Special Handling Notes for accounts

• Type: true | false
• Default value: false
• Location: Special Handling Notes > Properties

sn_customerservice.shn_case Special Handling Notes for cases

• Type: true | false
• Default value: false
• Location: Special Handling Notes > Properties

sn_customerservice.portal.chat_queue
• Type: string
• Default value: none
• Location: System Property [sys_properties]

table

csm.captcha.google.enabled Enable the Google Captcha tool on the customer
portal self-service portal self-registration form.

• Type: true | false
• Default value: true
• Location: System Property [sys_properties]

table

sn_customerservice.use_asset_contact_relationshipRestrict assets based on the contacts assigned to
the assets

• Type: true | false
• Default value: false
• Location: Customer Service > Administration >

Properties

sn_customerservice.account_relationship_access_rolesRoles which need to be shown in the reference
qualifier for the Account Relationship Access
table
[sn_customerservice_account_relationship_access].

• Type: string
• Default value: none
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Property Description
• Location: Customer Service > Administration >

Properties

sn_customerservice.contact_role_assignment External roles that can be assigned to contacts
from the customer self-service portal

• Type: string
• Default value:

sn_customerservice.partner_admin,sn_customerservice.partner,sn_customerservice.customer_admin,sn_customerservice.customer
• Location: Customer Service > Administration >

Properties

sn_customerservice.registration_workflow_id The default registration workflow sys_id.

• Type: string
• Default value:

9b6cf2dac31302003a657bfaa2d3aee8
• Location: System Property [sys_properties]

table

consumer_max_attachments_per_record Maximum consumer attachable items per record.

• Type: integer
• Default value: 5
• Location: Customer Service > Administration >

Email Properties

consumer_max_open_cases Maximum open cases per consumer.

• Type: integer
• Default value: 10
• Location: Customer Service > Administration >

Email Properties

consumer_max_products Maximum registered products per consumer.

• Type: integer
• Default value: 25
• Location: Customer Service > Administration >

Email Properties

consumer_max_new_cases_daily Maximum new cases per consumer per day.

• Type: integer
• Default value: 10
• Location: Customer Service > Administration >

Email Properties

consumer_max_comments_per_case_daily Maximum consumer comments per case per day.

• Type: integer
• Default value: 25
• Location: Customer Service > Administration >

Email Properties

com.snc.cs_base.last.generated.code.tree.path This property gets created by the system when
the first customer_account record is inserted into
an instance. It stores the Account Code value for
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Property Description
the most recently created customer account in
the Account (customer_account) table.
When a new customer account record is created,
the system uses this property to determine a
unique account code value for the account. The
property is then updated with this latest assigned
value so that the next account code value can be
set as a unique value for the next account record
insert. See Import customer account information
for more details.

• Type: string
• Default value: none
• Location: System Property [sys_properties]

table

sn_customerservice.enable_knowledge_kcs Enable Knowledge Centered Services (KCS) for
Customer Services Management

• Type: true | false
• Default value: false
• Location: Customer Service > Administration >

Properties

skills_management.migration Lists the task tables to migrate to the Task Skills
[task_m2m_skill] table when an admin runs the
Migrate Skills to Task Skill M2M script.

• Type: choice list
• Default value:

wm_task,customerservice_case,wm_order
• Location: System Property [sys_properties]

table

com.snc.skills_management.task_skill_migrated_tablesContains a list of tables for which the Skills field
has already been migrated to the Task Skills
[task_m2m_skill] table. If the table name is listed
in this property, the data has been migrated and
will not be migrated again.

• Type: choice list
• Default value: none
• Location: System Property [sys_properties]

table

case_fields_to_sync Comma-separated list of fields that synchronize
from parent case to child cases.

• Type: string
• Default value:

priority,state,comments,work_notes,
close_notes,resolution_code

• Location: Customer Service > Administration >
Properties

parent_child_case_sync Synchronize fields from parent to child cases.

• Type: true | false
• Default value: false
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Property Description
• Location: Customer Service > Administration >

Properties

glide.ui.sn_customerservice_escalation_activity.fieldsEscalation activity formatter fields.

• Type: true | false
• Default value: false
• Location: System Property [sys_properties]

table

Roles installed with Customer Service Management

Last updated: July 26, 2018
Last updated: July 26, 2018

Roles are added with activation of Customer Service Management.

Note:  Customer Service Management includes both internal and external user roles.
Internal user roles are for agents and agent managers using the Customer
Service Management application. External user roles are for customers and
partners using the customer portal.

Role title [name] Description Contains roles
Agent
[sn_customerservice_agent]

A customer service agent who
assists customers and partners
with questions, issues, and
problems. This user creates
cases, views and edits cases,
and works with customers and
subject matter experts to
resolve cases.
An agent typically supports a
specific set of products across
one or more communication
channels. An agent can belong
to one or more agent groups.

• knowledge
• chat_admin
•

sn_customerservice.deescalation_requester
• timecard_user
• template_editor
• sn_esm_agent
• sn_shn.editor
• domain_expand_scope

Agent manager
[sn_customerservice_manager]

A customer service agent with
the additional responsibility for
managing agents or agent
groups and overriding agent
actions.

• sn_customerservice_agent
• timecard_manager
• timecard_approver
• skill_admin
•

sn_app_cs_social_social_profile_user
• sam
• approval_admin
•

sn_customerservice.consumer_agent
• asset
• sn_shn.admin
• sn_publications.approver
• contract_manager
• sn_app_cs_social_log_user

Customer A customer role for researching
questions, issues, or problems. • sn_esm_user
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Role title [name] Description Contains roles
[sn_customerservice.customer] Customers can create cases and

view and edit existing cases for
their own accounts. They can
also view a list of assets
belonging to their accounts.

• snc_external

Customer case manager
[sn_customerservice.customer_case_manager]

A customer role for managing all
of the cases in an account and
any related child accounts. The
customer case manager role
includes the privileges of the
customer role and adds the
following privileges:

• Create a case on behalf of
another contact in the account

• View a list of cases belonging
to the account

• Edit cases belonging to the
account.

Note:  The customer case manager role is not
automatically added to the
sn_customerservice.contact_role_assignment
system property. To expose this role to
customer and partner administrators,
navigate to Customer Service >
Administration > Properties and add it to this
property.

• sn_customerservice.customer

Customer administrator
[sn_customerservice.customer_admin]

An administrator role for a
customer account. This user has
access to all the data within the
account.

• sn_customerservice.customer
• sn_esm_user_admin

Partner
[sn_customerservice.partner]

A partner who is serving
customer accounts. A partner
can create a case for their own
account or on behalf of a
customer account. A partner
can also view or edit existing
cases for their own account or
for customer accounts.

• sn_customerservice.customer
• sn_esm_partner

Partner administrator
[sn_customerservice.partner_admin]

An administrator role for a
partner account. This user has
access to all the data within the
partner account as well as the
customer accounts. This user
can also manage users for the
partner account and for
customer accounts.

• sn_customerservice.partner
•

sn_customerservice.customer_admin
• sn_esm_partner_admin

Consumer
[sn_customerservice.consumer]

A consumer role for researching
questions, issues, or problems.
Consumers can create cases and
view and edit existing cases for
products that they have
purchased. They can also view a
list of their products.

• sn_esm_user
• snc_external
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Role title [name] Description Contains roles
Consumer Agent
[sn_customerservice.consumer_agent]

A consumer service agent who
assists consumers with
questions, issues, and problems.
This user creates, views, and
edits cases and works with
consumers to resolve cases.
An agent typically supports a
specific set of products across
one or more communication
channels. An agent can belong
to one or more agent groups.

• sn_esm_agent
• chat_admin
• sn_shn.editor
• template_editor
• knowledge

Proxy case creator
[sn_customerservice.proxy_case_creator]

A user who can create a case
from a community discussion.

Escalation requester
(sn_customerservice.escalation_requester)

Can request an escalation for a
case or account. •

sn_customerservice.consumer_agent

De-escalation requester
(sn_customerservice.deescalation_requester)

Can de-escalate a case or
account. •

sn_customerservice.escalation_requester

• Explicit roles

You can give both internal users and external users access to your instance. However, you
might not want both types of users to have the same level of access. To provide added
security, every user must have at least one role so that the instance can distinguish
between internal and external users.

• Provide external users access to a table

To enable users with only the snc_external role to access the list view of a table, you must
create a series of ACLs.

• Creating custom user roles

System administrators can create custom roles or modify the access of existing roles by
using script includes and extension points/instances.

Explicit roles

Last updated: July 26, 2018
Last updated: July 26, 2018

You can give both internal users and external users access to your instance. However, you
might not want both types of users to have the same level of access. To provide added
security, every user must have at least one role so that the instance can distinguish between
internal and external users.

External users must obtain, at minimum, the snc_external role. The snc_external role
indicates that the user is external to your organization and should not have any access to
resources unless explicitly allowed through ACLs for the snc_external role or additional roles
that inherit the snc_external role. By default, users with the snc_external role cannot access:

• Scripted REST API resources that are not marked external
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• Tables without the role that inherits the snc_external role or the public role
• Non-record type resources, such as processors and UI pages without the snc_external role

or a role that inherits the snc_external role

Do not mark the snc_internal role as elevated. Otherwise, internal users cannot access the
instance.

Note:  You can Set up encryption contexts with the snc_internal and snc_external
roles. However, adding encryption contexts to more detailed roles is
recommended.

Explicit Roles plugin

The Explicit Roles plugin (com.glide.explicit_roles) provides the snc_external and
snc_internal roles. When the plugin is activated:

• All users must have the snc_internal role to access internal resources, the snc_external role
to access external resources, or both. Users without at least one of these roles cannot
access either internal or external resources, only public resources.

• All existing users are automatically assigned the snc_internal role. This role does not
change existing access levels or system behavior. Instead, it provides a category to
differentiate internal users from external users. All internal users maintain the same level of
access as before the plugin was activated.

Tip:  To prevent changing existing functionality for users, activating the Explicit
Roles plugin assigns the snc_internal user role to all existing users in the
instance, including any external users added before the Explicit Roles plugin
was activated. After the Explicit Roles plugin is activated, do the following for
all external users added before the Explicit Roles plugin was activated:

Remove the snc_internal role.
Add the snc_external role.

This ensures that external users added before activating the Explicit Roles
plugin do not have access to internal resource that should be available only
to internal users.

• Newly created users are automatically assigned the snc_internal role when they first
attempt to log in to the instance, unless they have been explicitly assigned the
snc_external role. You can add the snc_external role to a new user before they first log in
to the instance to provide external user rights.

Note:  The snc_internal and snc_external roles can be added or removed at any
time to change user rights.

• All existing ACLs that do not have a role requirement are automatically assigned the
snc_internal role. Because both existing ACLs and roles are assigned the snc_internal role,
existing access levels do not change.

• Newly created ACLs that do not have a role requirement are automatically assigned the
snc_internal role. This role assignment does not apply to a newly created ACL with a role
assigned.

• For all existing Processor [sys_processor] records or newly created Processor
[sys_processor] records with Type=script, the snc_internal role is automatically added to
the Roles field if the field is empty.

• To restrict access to UI pages to internal users, the plugin automatically assigns the
snc_internal role to the * ACL with a Type of ui_page.
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• To restrict access to processors to internal users, the plugin automatically assigns the
snc_internal role to the * ACL with a Type of processor.

• External users must obtain, at minimum, the snc_external role to access the instance. This
role is automatically assigned to external Customer Service Portal contacts. If the
Customer Service Portal is not activated, this role must be manually granted to external
users. Access to records is granted through ACLs.

• Content Management System site access is also affected. CMS is set up with Sites
(content_site), Pages (content_page), and other resources. Some of the sites may have
the Login page configured.

If CMS sites do not have the Login page configured, the public role is automatically
added to the Read Roles field on Pages (content_page) if the field is empty.
If CMS sites have the Login page configured, the snc_internal role is automatically

added to the Read Roles field on Pages (content_page) if the field is empty.

Note:  Do not move System update sets among instances with and without the
Explicit Roles plugin enabled.

Note:  This plugin also requires the Contextual Security Manager plugin.

Providing table access to external users

You can Provide external users access to a table by adding a role to the table that inherits
the snc_external role.

The hasRoles() method

The hasRoles() method is still available, but is deprecated in the Geneva release. Use the
hasRole(role name) method instead.

If you do use the hasRoles() method, note these changes:

• This method automatically excludes the default snc_internal role when it checks for roles.
This means that if a user has only the snc_internal role, the hasRoles() method still
returns false.

• If the user has the snc_external role, the method returns false because the instance
considers external users to be without a role.

Provide external users access to a table

Last updated: July 26, 2018
Last updated: July 26, 2018

To enable users with only the snc_external role to access the list view of a table, you must
create a series of ACLs.

Before you begin

Role required: security_admin

Procedure

1. Elevate to the security_admin role.
2. Create a new ACL with the following settings:

• Type: ui_page
• Operation: read
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• Name: {table_name}_list
• Required role: snc_external

3. On the default read ACL for the table, add snc_external in the Required role list. Create
the ACL if it does not already exist.

4. Use these settings to create another ACL:
• Type: ui_page
• Operation: read
• Name: {table_name}
• Required role: snc_external

5. Use these settings to create another ACL to give the user write access to a field in the
table:

• Type: record
• Operation: create
• Name: {table_name} {column_name}
• Required role: snc_external

Repeat this step for every field that you want to give the user write access to. Use an
asterisk * instead of the column name to provide access to all fields at once.

Creating custom user roles

Last updated: July 26, 2018
Last updated: July 26, 2018

System administrators can create custom roles or modify the access of existing roles by
using script includes and extension points/instances.

The Customer Service Management application utilizes platform ACLs and query business
rules to restrict data access based on user roles. If needed, users with the system
administrator role can create custom roles or modify the access of existing roles by using
script includes and extension points/instances.

• Script includes store JavaScript functions and classes to handle the role access control
logic.

• Extension points/instances designate places where custom scripts can be called and then
processed to extend base functionality.

The system administrator can use the extension points/instances to create their own role
access constants file similar to CSQueryBRUtilOOBConstants.

The system administrator can create a new extension instance for the existing extension
point and use it to define custom role configuration constants. The following are included
with Customer Service Management:

• global.CSQeryExtensionPoint: the provided extension point for CSM role configuration
• instance.CSQueryExtensioninstanceOOB: the provided extension instance for CSM role

configuration

To create a new role:

1. Create a new constant file to hold the configurations for the new role similar to
CSQueryBRUtilOOBConstants. For example:
CSQueryBRUtilOOBConstantstest.ROLE_PERMISSIONS_POOL = {
   ‘sn_customerservice.customer_new_role’:{ ‘sn_customerservice_case’:{‘condition’:[‘my_new_condition’]},
} ,

2. Create a new extension instance to hold the logic returning this new constant file to
CSQueryBRUtil.
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3. Make sure this role is on the instance and contains the sn_esm_user role.
4. Assign this new role to a contact.
5. Create or modify the ACLs and query business rules for this role as necessary.

For more information about modifying ACLs and query business rules, see KB0685767.

Script includes installed with Customer Service Management

Last updated: July 26, 2018
Last updated: July 26, 2018

Script includes are added with activation of Customer Service Management.

Script include Description
CSEMailUtil Used for customer service case email actions and

notifications.

CSPortalUtil Helper functions for the customer self-service
portal.

AccountTeamUtil Util APIs for the Customer Service Management
account team responsibility module.

AjaxCustomerServiceSearch Ajax class that provides the knowledge base
search results.

Client scripts installed with Customer Service Management

Last updated: July 26, 2018
Last updated: July 26, 2018

Client scripts are added with activation of Customer Service Management.

Client script Table Description
Channel and State readonly for
customer

Case
[sn_customerservice_case]

Sets the Channel and State
fields to read-only on the Case
form that the customer can view
from the customer portal.

Check Contextual Security
Installed

Contact
[customer_contact]

Checks if the Contextual
Security plugin
(com.glide.role_management) is
installed before creating a
customer contact.

Customer Case View Case
[sn_customerservice_case]

Hides certain elements in the
Case form for ESS view.

Empty Case form on Account
Change

Case
[sn_customerservice_case]

When a user makes a change to
the value in the Accountfield on
the Case form, the values in the
following fields are cleared:
Partner, Partner contact, Asset,
Entitlement, Contract, and
Contact.

Empty Partner Contact on
Partner Change

Case
[sn_customerservice_case]

When a user makes a change to
the value in the Partner field on
the Case form, the Partner
contact field is also cleared.
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Client script Table Description
Hide Activity Stream Contact

[customer_contact]
Hides the activity stream on top
of the form header.

Hide attachment icon Registration Request
[sn_customerservice_registration]

Hides the attachment icon on
top of the form header.

Hide Icons Form Header Case
[sn_customerservice_case]

Hides the email icon from the
more options menu and the
activity stream icon at the top of
the form header. Also hides the
book icon next to the Short
Description field on the form.

Hide Suggestion next to Short
Description

Case
[sn_customerservice_case]

Hides the suggestion icon next
to the Short description field.

Make field readonly Account Relationship Type
[sn_customerservice_account_relationship_type]

Sets the From and To fields to
read only once a record is
created in the Account
Relationship Type table
(sn_customerservice_account_relationship_type).

Open the glide list for new
appointment

Appointment
[sn_customerservice_appointment]

Opens the glide list to select the
user for an appointment for new
records.

Populate Contact Company Case
[sn_customerservice_case]

When a user name is selected in
the Contact field, the Account
field is populated with the
contact's account information.

Populate Contract Case
[sn_customerservice_case]

Populates the Contract field
when the Account field is filled.

Populate contract and
entitlement

Case
[sn_customerservice_case]

Populates the Contract and
Entitlement fields when the
Account field is filled.

Populate Entitlement Case
[sn_customerservice_case]

Populates the Entitlement field
when the Account field is filled.

Populate Product Case
[sn_customerservice_case]

When an asset is selected in the
Asset field, the Product field is
populated with the asset's
product model.

Registration code read-only Registration Request
[sn_customerservice_registration]

Sets the Registration code field
to read-only.

Set account read on load Account Team Member
[sn_customerservice_team_member]

Sets the Account field to read
only for a new record when the
account is not empty on form
load.

Set asset readonly Asset Contact
[sn_customerservice_m2m_asset_contact]

Set the Asset field to readonly
for a new form when the asset
value is not empty.

Show partner field Case
[sn_customerservice_case]

Shows the Opened by field on
the Case form.
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Client script Table Description
Special Handling Notes for Case Case

[sn_customerservice_case]
Shows all of the Special
Handling Notes with display
type alert related to the current
record.

Validate Product Entitlement Entitlement
[service_entitlement]

Displays a field warning
message for the Per unit field if
a product is selected but the
Asset, Contract, and Account
fields are empty.

Business rules installed with Customer Service Management

Last updated: July 26, 2018
Last updated: July 26, 2018

Business rules are added with activation of Customer Service Management.

Business rule Table Description
Account query for customer Account

[customer_account]
Queries the account for the
customer contact.

Account relationship display rule Account Relationship
[account_relationship]

Displays the correct values in
the bi-directional diagram on
the Account Relationship form.

Add customer role to contacts Contact
[customer_contact]

Adds the customer role
(sn_customerservice.customer)
to a customer contact after the
contact has been assigned a
user ID.

Add snc external role to
contacts

Contact
[customer_contact]

Adds the snc_external user role
to each contact.

Add Primary Contact to Asset
Contact

Asset
[alm_asset]

When an asset is assigned a new
primary contact, the primary
contact is added to the asset
contact.

Approver query for customer Approval
[sysapproval_approver]

Queries the approver for a
customer contact.

Asset query for customer Asset
[alm_asset]

Queries the assets for a
customer contact.

Auto assessment business rule Case
[sn_customerservice_case]

Triggers a customer satisfaction
survey when a case is set to
Closed.

Case query for customer Case
[sn_customerservice_case]

Queries the cases for a
customer contact.

Case display rule Case
[sn_customerservice_case]

A display business rule on the
Case form which passes some
values to the browser when a
case is displayed.
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Business rule Table Description
Change Awaiting to Open Case

[sn_customerservice_case]
Changes the case state from
Awaiting Info to Open.

Check duplicate Asset Contact
[sn_customerservice_m2m_asset_contact]

Checks for duplicate records
before creating a new asset
contact.

Check duplicate for
responsibility

Contact Relationship
[sn_customerservice_contact_relationship]

Checks for duplicate
responsibilities before creating a
new contact relationship.

Check duplicate for
responsibility

Asset Contact
[sn_customerservice_m2m_asset_contact]

Checks for duplicate
responsibilities before creating a
new asset contact.

Check snc_external roles exist Contact
[customer_contact]

Checks if the
com.glide.security_schema
plugin is activated.

Contact query for customer Contact
[customer_contact]

Queries the contacts for a
customer.

Contract query for customer Contract
[ast_contract]

Queries the contracts for a
customer.

Create bi-direction relationship Account Relationship
[account_relationship]

After an account relationship is
created, this business rule
creates the bi-directional
account relationship record.

Delete Account Contacts and
Assets

Account Relationship
[account_relationship]

When an account relationship is
deleted, this business rule
deletes the corresponding
account and asset contacts.

Delete relationship type label
[account_relationship_type]

Checks to see if any relationship
records are using a relationship
type before that relationship
type is deleted.

Delete responsibility definition Responsibility Definition
[sn_customerservice_responsibility_def]

Checks to see if any account
team members are using a
responsibility definition before
that responsibility definition is
deleted.

Display request message Registration Request
[sn_customerservice_registration]

After registration request
submittal, shows info message
to user

Display rule Registration Request
[sn_customerservice_registration]

Shows message to remind users
to enter a correct registration
code

Entitlement query for customer Entitlement
[service_entitlement]

Queries the entitlements for a
customer contact.

Insert Case Work Notes Appointment
[sn_customerservice_appointment]

Updates the case work notes
with the appointment details
when an an appointment is
created.
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Business rule Table Description
Populate company for case Case

[sn_customerservice_case]
Populates the Company field on
the Case form based on the
name entered in the Contact
field.

Set First Response Time Case
[sn_customerservice_case]

When a case is created or
updated, this rule sets the
current time in the
first_response_time field. Also
used when a case is set to
Resolved or Awaiting Info or
when comments or close notes
are added.

Note:  The
first_response_time
field is not used.

Update account based on reg
code

Registration Request
[sn_customerservice_registration]

Validates the registration
registration code and assigns
the account associated with the
registration code.

Update account relationship
labels

Account Relationship Type
[sn_customerservice_account_relationship_type]

When the labels for an account
relationship type are updated,
this business rule updates all of
the related account relationship
records.

Update case entitlement on
Close

Case
[sn_customerservice_case]

Updates the associated
entitlement when the state of a
case is set to Closed.

Update Case Work notes Appointment
[sn_customerservice_appointment]

Adds work notes to the case
when an appointment for the
case is updated.

Update Case Work Notes Knowledge
[kb_knowledge]

Adds work notes to the case
when a knowledge article
associated with the case gets
updated.

Update Parent Case for new
task

Task
[sn_customerservice_task]

Updates the case when a new
case task is created.

Update Parent case for state
change

Task
[sn_customerservice_task]

Updates the case when a new
case task is changed.

Update relationship label Account Relationship
[account_relationship]

Updates the relationship labels
for bi-directional account
relationships.

Update User Task State Case
[sn_customerservice_case]

Calculates the work load for the
agent based on the number of
cases assigned to the agent.
Also updates the last assigned
time. This rule is used by the
matching rule engine.

Validate registration Registration Request
[sn_customerservice_registration]

Checks if the registration is valid
based on the user’s email
address. If the user exists in the
system or a request has already
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Business rule Table Description
been submitted and is in the
pending state, the registration
request is not allowed.

Components installed with additional plugins for Customer Service
Management

Last updated: July 26, 2018
Last updated: July 26, 2018

Several types of components are installed with the additional plugins for the Customer
Service Management application.

• Components installed with Customer Service Management Demo Data

Several types of components are installed with Customer Service Management Demo
Data.

• Components installed with CTI Softphone

Several types of components are installed with CTI Softphone.

• Components installed with Customer Service CTI Demo Data

Several types of components are installed with Customer Service CTI Demo Data.

• Components installed with OpenFrame

Several types of components are installed with OpenFrame.

• Components installed with Special Handling Notes

Several types of components are installed with Special Handling Notes.

• Components installed with Targeted Communications

Several types of components are installed with the Targeted Communications application.

• Components installed with Knowledge Product Entitlements

Several types of components are installed with the Knowledge Product Entitlements
application.

• Components installed with Self Service Password Reset

Several types of components are installed with Self Service Password Reset.

Components installed with Customer Service Management Demo Data

Last updated: July 26, 2018
Last updated: July 26, 2018

Several types of components are installed with Customer Service Management Demo Data.
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Tables installed with Customer Service Management Demo
Data

Tables are added with activation of Customer Service Management Demo Data.

Table Description
Enterprise Software
[cmdb_ci_enterprise_software]

Enterprise Software Asset
[alm_application_software]

Business rules installed with Customer Service Management
Demo Data

Business rules are added with activation of Customer Service Management Demo Data.

Business rule Table Description
Demo-Add Support Manager to
watchlist

Case
[sn_customerservice_case]

Components installed with CTI Softphone

Last updated: July 26, 2018
Last updated: July 26, 2018

Several types of components are installed with CTI Softphone.

Tables installed with CTI Softphone

Tables are added with activation of CTI Softphone.

Table Description
User CTI Status Stores the agent's availability status.

Script includes installed with CTI Softphone

Script includes are added with activation of CTI Softphone.

Script include Description
CTIAjaxUtility Ajax class that provides helper functions to set

and get user states, get incoming call context, log
a call, and queue and dequeue a call.
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Business rules installed with CTI Softphone

Business rules are added with activation of CTI Softphone.

Business rule Table Description
Route available user for Incident
Task

User CTI Status
[user_cti_status]

Demo business rule to dequeue
a call based on matching rules
whenever an agent becomes
available.

UI macros installed with CTI Softphone

UI macros are added with activation of CTI Softphone.

Script include Description
show_phone A UI macro which can be used as a

ref_contributions on any field which references
the Users [sys_user] table. This macro displays a
phone icon next to the Contact (sys_user) field
on the Case form. The icon is shown only if the
phone field in the Users [sys_user] table is set.

This macro requires the activation of the
OpenFrame plugin and a default openframe
configuration to be configured. Also, this macro is
supported if:

• the doctype property is set and the device is
not a tablet or mobile.

• the web browser is Internet Explorer 10 or
above.

Components installed with Customer Service CTI Demo Data

Last updated: July 26, 2018
Last updated: July 26, 2018

Several types of components are installed with Customer Service CTI Demo Data.

Business rules installed with Customer Service CTI Demo
Data

Business rules are added with activation of Customer Service CTI Demo Data.

Business rule Table Description
Route available user for Case
Task

User CTI Status
[user_cti_status]

Used to dequeue a call
whenever an agent becomes
available.

Components installed with OpenFrame

Last updated: July 26, 2018
Last updated: July 26, 2018
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Several types of components are installed with OpenFrame.

Tables installed with OpenFrame

Tables are added with activation of OpenFrame.

Table Description
Phone Log
[sn_openframe_phone_log]

A log of the incoming and outgoing phone calls.
This table can be used to log any phone call
made or received.

OpenFrame Configuration
[sn_openframe_configuration]

Stores the OpenFrame configuration. This is the
configuration used to load the OpenFrame in the
TopFrame.

Roles installed with OpenFrame

Roles are added with activation of OpenFrame.

Role title [name] Description Contains roles
User
[sn_openframe_user]

The OpenFrame user role.
• None

Script includes installed with OpenFrame

Script includes are added with activation of OpenFrame.

Script include Description
OpenFrameAjaxUtility OpenFrame AJAX utility class providing functions

to get the OpenFrame configuration and also to
get and set the last opened frame location.

Business rules installed with OpenFrame

Business rules are added with activation of OpenFrame.

Business rule Table Description
Set Agent Phone Log

[sn_openframe_phone_log]
Sets the agent in the Phone Log
[sn_openframe_phone_log]
table as the current logged-in
user if a phone call is logged
without an agent.

One Default Configuration OpenFrame Configuration
[sn_openframe_configuration]

Checks that there is only one
default OpenFarme
configuration. You cannot have
two OpenFrame configurations
with the default flag set to true.

Update Task Work Notes Phone Log Updates the work notes for a
specific task whenever a phone
call is logged for that task.
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Business rule Table Description
[sn_openframe_phone_log]

Components installed with Special Handling Notes

Last updated: July 26, 2018
Last updated: July 26, 2018

Several types of components are installed with Special Handling Notes.

Tables installed with Special Handling Notes

The tables included with the Special Handling Notes plugin (com.sn_shn).

The Special Handling Notes plugin adds the following tables.

Table Description
Special Handling Notes
[sn_shn_notes]

Stores the special handling notes.

Special Handling Configuration
[sn_shn_configuration]

Stores the special handling notes table
configurations.

Roles installed with Special Handling Notes

The user roles included with the Special Handling Notes plugin (com.sn_shn).

Role Description
sn_shn.admin Can read, create, update, and delete special

handling notes.
This role contains the sn_shn.editor role.

The sn_customerservice_manager role contains
the sn_shn.admin role.

sn_shn.editor Can read and update special handling notes.
This role contains the sn_shn.user role.

The sn_customerservice_agent role contains the
sn_shn.editor role.

sn_shn.user Can read special handling notes.

Properties installed with Special Handling Notes

The properties included with the Special Handling Notes plugin (com.sn_shn).

The Special Handling Notes plugin adds the following properties.

Property Description
Maximum number of notes displayed in the
Special Handling Notes pop-up window • Type: integer
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Property Description
[sn_shn.max_num_alerts] • Default value: 20

• Location: Special Handling Notes > Properties
• Learn more: Configure special handling notes

properties

Display special handling notes only once per
session
[sn_shn.note_preferences]

Special handling notes are displayed each time
you access a record. Enable this property to
display special handling notes only once per
session.

• Type: true | false
• Default value: false
• Location: Special Handling Notes > Properties
• Learn more: Configure special handling notes

properties

Width of the Special Handling Notes pop-up
window in pixels
[sn_shn.popup_width]

The width of the Special Handling Notes pop-up
window in pixels. The default width is 500. If you
specify less that 300, the window automatically
uses the minimum width of 300 pixels.

• Type: integer
• Default value: 500
• Location: Special Handling Notes > Properties
• Learn more: Configure special handling notes

properties

Business rules installed with Special Handling Notes

The business rules included with the Special Handling Notes plugin (com.sn_shn).

The Special Handling Notes plugin adds the following business rules.

Business rule Table Description
Updating the table field Special Handling Notes

[sn_shn_notes]
Populates the Table field with
the table label rather than the
whole table name.

SHN Cache Table Entry Special Handling Notes
Configuration
[sn_shn_configuration]

Stores the entries in the
configuration table in a cache to
avoid repeated queries.

Client scripts installed with Special Handling Notes

The client scripts included with the Special Handling Notes plugin (com.sn_shn).

The Special Handling Notes plugin adds the following client scripts.

Client script Table Description
On Load Message Special Handling Notes

Configuration
[sn_shn_configuration]

On Load Message describing
what the Special Handling Notes
Configuration table is for.

Create a configuration by
selecting a table for which
special handling notes can be
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Client script Table Description
created and displayed. Include
notes for related entities by
selecting the desired fields and
adding them to the
configuration.

Script includes installed with Special Handling Notes

The script includes included with the Special Handling Notes plugin (com.sn_shn).

The Special Handling Notes plugin adds the following script includes.

Script include Description
SHNProcessor A collection of APIs for special handling notes.

SHNTable Provides a list of tables for which the user can
create special handling notes.

Components installed with Targeted Communications

Last updated: July 26, 2018
Last updated: July 26, 2018

Several types of components are installed with the Targeted Communications application.

Tables installed with Targeted Communications

Tables are added with activation of Targeted Communications.

Table Description
Recipients (Users)
[sn_publications_recipientslist_user_m2m]

Stores recipients lists of type Internal Users.

Recipients (Accounts)
[sn_publications_recipientslist_account_m2m]

Stores recipients lists of type Accounts.

Recipients (Consumers)
[sn_publications_recipientslist_consumer_m2m]

Stores recipients lists of type Consumers.

Publication Recipients
[sn_publications_publication_contact_m2m]

Stores recipients lists of type Contacts.

Workflow Config
[sn_publications_workflow_config]

Workflow configuration page.

Publication
[sn_publications_publication]

Stores all of the publications.

Recipients List
[sn_publications_recipients_list]

Stores the recipient lists.

Recurrence Stores all of the publication recurrences.
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Table Description
[sn_publications_recurrence]

Business rules installed with Targeted Communications

Business rules are added with activation of Targeted Communications.

Business rule Table Description
Create email notification Publication

[sn_publications_publication]
Generates the email notification
after a new publication is
created.

Create publication recipients Publication
[sn_publications_publication]

Builds the recipient list after the
state of a publication changes to
Published.

Create Recurrence Publications Recurrence
[sn_publications_recurrence]

Generates duplicate publications
from the original publication and
calculates the start and end
dates for each recurrence.

Date validation Publication
[sn_publications_publication]

Validates the publication and
expiration dates. Also validates
that the start and end dates for
a recurring publication is within
the range of the specified
recurrence.

Delete email notification Publication
[sn_publications_publication]

Deletes the email notification if a
publication is deleted, cancelled,
or expired.

Delete Recipients List Recipients List
[sn_publications_recipients_list]

Prevents a recipient list from
being deleted if the list has one
or more associated publications.

Fields validation Recurrence
[sn_publications_recurrence]

Initialize Publication Publication
[sn_publications_publication]

Changes the stage of a
publication to Author and the
visited_state field to empty
whenever a new publication is
created.

Make approver list required Workflow Config
[sn_publications_workflow_config]

Makes the Approver field
mandatory for articles that
require approval prior to
publishing.

Make recipient list required Publication
[sn_publications_publication]

Makes the Recipient list field
mandatory and ensures that the
recipient list is populated.

Reset error state Publication
[sn_publications_publication]

Resets the error_state field to
false when a publication is
updated.

Restrict User Access Publication
[sn_publications_publication]

Restricts access to published
articles to a targeted set of
users.
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Business rule Table Description
Show error state message: Publication

[sn_publications_publication]
Displays an error message at the
top of the form when a
publication's error_state field is
true.

Show state message Publication
[sn_publications_publication]

Displays a status message when
the recipient list is being
generated.

Start publication workflow Publication
[sn_publications_publication]

Starts the workflow after a
publication is generated.

Track Customer Publication
Views

Publication
[sn_publications_publication]

Updates when a user has viewed
the article.

Update Recipients Recipients List
[sn_publications_recipients_list]

Builds or updates a recipient list
for a publication.

Update Visited States on state
change

Publication
[sn_publications_publication]

Updates the stage changes as a
publication moves through the
creation, review, and approval
process.

Roles installed with Targeted Communications

Roles are added with activation of Targeted Communications.

Role title [name] Description Contains roles
Publications administrator
[sn_publications.admin]

The publications administrator
can:

• read all publications
• create, update, and delete

publications
• create recurring publications
• create recipient lists
• add or remove approvers to

workflows

• sn_publications.author
• sn_publications.approver
• workflow_publisher
• image_admin

Publications author
[sn_publications.author]

The publications author can:

• read all publications
• create, update, and delete

publications
• create recurring publications
• create recipient lists

•
sn_publications_recipients_list_user

•
sn_publications_recipients_user

• workflow_publisher
• image_admin
• sn_esm_agent

Publications approver
[sn_publications.approver]

The publications approver can
approve publications. • approver_user

Recipients list user
[sn_publications_recipients_list_user]

The recipients list user can
create and view recipient lists.

None

Recipients user The recipients user can view
recipient lists.

None

August 6, 2018 ©2018 ServiceNow. All rights reserved. 270

ServiceNow | Customer Service Management



Role title [name] Description Contains roles
[sn_publications_recipients_user]

Client scripts installed with Targeted Communications

Client scripts are added with activation of Targeted Communications.

Client script Table Description
Set Conditions Table/Field
onchange

Recipients List
[sn_publications_recipients_list]

For recipient lists:

• If the type is Internal Users,
nternal, this script assigns the
User [sys_user] table to the
Table field and sys_id to the
User Field field.

• If the type is Customers, this
script assigns the Customer
Product [customer_products]
table to the Table field sys_id
to the User Field field.

Set Conditions Table/Field
onload

Recipients List
[sn_publications_recipients_list]

For recipient lists:

• If the type is Internal Users,
nternal, this script assigns the
User [sys_user] table to the
Table field and sys_id to the
User Field field.

• If the type is Customers, this
script assigns the Customer
Product [customer_products]
table to the Table field sys_id
to the User Field field.

Switch Publication View Approval
[sysapproval_approver]

Validate start date Publication
[sn_publications_publication]

Validates that the start date of a
publication is after the current
date and before the end date.

Validate end date Publication
[sn_publications_publication]

Validates that the end date of a
publication is after the start
date.

Validate start date Recurrence
[sn_publications_recurrence]

Validates that the start date of a
recurrence publication is after
the current date and before the
end date.

Validate end date Recurrence
[sn_publications_recurrence]

Validates that the end date of a
recurrence publication is after
the start date.

Script includes installed with Targeted Communications

Script includes are added with activation of Targeted Communications.
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Script include Description
PublicationAjax

RecipientsListApi

RecipientsListApi.getRecipientsListCount Calculates the total number of recipients for a
publication.

RecipientsListApi.buildRecipientsList for
Publication

Builds the recipient list for a publication based on
the recipient list's type and condition.

PublicationsApi API functions for publications functionality

PublicationsQueryProcessor Ajax helper for showing publicaitons listing.

Properties installed with Targeted Communications

Properties are added with activation of Targeted Communications.

Note:  To open the System Property [sys_properties] table, enter sys_properties.list in
the navigation filter.

Property Description
sn_publications.max_email Limits the number of email recipients.

• Type: integer
• Default value: 100000
• Location: System Property [sys_properties]

table

Components installed with Knowledge Product Entitlements

Last updated: July 26, 2018
Last updated: July 26, 2018

Several types of components are installed with the Knowledge Product Entitlements
application.

Business rules installed with Knowledge Product Entitlements

Business rules are added with activation of Knowledge Product Entitlements.

Business rule Table Description
Knowledge Product Entitlement Knowledge

[kb_knowledge]
Implements the needed access
controls for users with the
sn_customerservice.customer
role.

KB Product Entitlements Knowledge Base
[kb_knowledge_base]

Properties installed with Knowledge Product Entitlements

Properties are added with activation of Knowledge Product Entitlements.
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Property Description
kb_product_entitlement.knowledge_base.enable Enable access control of Knowledge Bases based

on product entitlements.
If enabled, customers can access all of the
knowledge bases related to the products for
which they have entitlements.

• Type: true/false
• Default value: false
• Location: Knowledge Product Entitlements >

Properties

kb_product_entitlement.knowledge_base.allow_empty_productsAllow access to Knowledge Bases with empty
Related Products field.
If enabled, customers can access all knowledge
bases even if no products have been specified in
the Related Products field on the Knowledge
Base form.

• Type: true/false
• Default value: false
• Location: Knowledge Product Entitlements >

Properties

kb_product_entitlement.article.enable Enable access control of Knowledge Articles
based on product entitlements.
If enabled, customers can access all of the
knowledge articles related to the products for
which they have entitlements.

• Type: true/false
• Default value: false
• Location: Knowledge Product Entitlements >

Properties

kb_product_entitlement.article.allow_empty_productsAllow access to Knowledge Articles with empty
Related Products field.
If enabled, customers can access all knowledge
articles even if no products have been specified in
the Related Products field on the Knowledge
form.

• Type: true/false
• Default value: false
• Location: Knowledge Product Entitlements >

Properties

Components installed with Self Service Password Reset

Last updated: July 26, 2018
Last updated: July 26, 2018

Several types of components are installed with Self Service Password Reset.

Script includes installed with Self Service Password Reset

Script includes are added with activation of Self Service Password Reset.
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Script include Description
PasswordResetAJAX AJAX Script to process a password reset from a

UI Page as guest.

ResetPwdAjaxProcessor

Communities
Last updated: July 26, 2018
Last updated: July 26, 2018

With the ServiceNow® Communities application, connect, engage, and collaborate with your
employees, customers, partners, and prospects. Your users get quick responses to their
issues by posting questions, reviewing blogs or videos, and searching for previous
discussions. It is an essential component of your self-service strategy along with Knowledge
Base and Service Catalog.

Explore

• Communities roles
• Community content types
• Configure community forums
• Forum and user permissions

management
• Community subscriptions
• Gamification
• Domain separation in

Communities

Set up

• Activate Communities plugins
• Properties installed with

Communities
• Community setup guide for

admins

Administer

• Create a forum
• Create a forum user
• Create a forum permission
• Invite users to become

members of a forum
• Configure the community

profile
• Enable users to self-register to

a community
• Enable knowledge harvesting
• View the Communities

performance dashboard
• Make an announcement to

community members
• Moderate a community
• Administer gamification

Use

• Community homepage
features for logged in users

• Request membership to a
forum

• Search the community
• Subscribe to content
• Ask a question in the

community
• Post a blog
• Post a video
• Post a document in a forum
• Post a community event
• Bookmark community content
• Provide feedback on

community content
• Report inappropriate

community content
• Manage your community

profile
• Follow a community user

Develop

• Developer training
• Developer documentation

Troubleshoot and get help

• Search the HI Knowledge
Base for known error articles

• Contact ServiceNow Support
• Ask or answer questions in the

ServiceNow community.
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• Harvest knowledge from a
community

• View a list of questions and
create a case

• Moderate gamification

Activate Communities plugins
Last updated: July 26, 2018
Last updated: July 26, 2018

Activate the Customer Communities plugin to use the Communities application.

Before you begin

Role required: sn_communities.admin

About this task

Communities is only available for customers who are licensed for the Customer Service
Management application. To activate Communities, activate the Customer Communities
plugin (com.sn_customer_communities). This plugin is not active by default.

When you activate the Customer Communities plugin, the following plugins are
automatically activated.

• External User Registration plugin (com.sn_external_user_register)
• Communities plugin (com.sn_communities)
• Gamification plugin (com.snc.gamification)
• Subscriptions and Activity Feed Framework plugin (com.snc.activity_subscriptions)

Procedure

1. Navigate to System Definition > Plugins.
2. Search for the plugin com.sn_communities.
3. Click Activate.

Properties installed with Communities
Last updated: July 26, 2018
Last updated: July 26, 2018

Community administrators can use properties to configure Communities behavior.

The following properties are available for further configuration. To list the properties, enter
sys_properties.list in the filter navigator and search for the property to configure.

Note:  You can also view Community Properties and Forum Properties from the
application navigator. These modules contain a list of the most frequently
used properties that you can configure for your community.
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Communities properties
Property Description
sn_communities.adminNoReplyEmail Email address for community-related

notifications. When a notification for an activity is
sent, this email address is displayed.

• Type: string
• Default value:

communityadmin@servicenow.com

sn_communities.blog_count Number of blogs that a user can post per day.

• Type: integer
• Default value: 20

sn_communities.content.meta_description When generating SEO data for an entity, the
number of characters that are fetched from the
meta_description column of the record to
generate a portion of the SEO <description> tag
for the record.

Typically, the SEO <description> tag for a
Community entity is the combination of ‘forum
name’, ‘topics’ and ‘meta description’ of the
actual record in the following format: “<forum> -
<topics> - <sub string of configured length of the
actual description>".

• Type: integer
• Default value: 100

sn_communities.content.views.count.limit Number of views for content pages allowed per
session within a time window specified by
sn_communities.content.views.time.limit.

• Type: integer
• Default value: 50

sn_communities.content.views.time.limit Duration, in seconds, during which a specific
number of views are allowed. The number of
views allowed during this time is set by
sn_communities.content.views.count.limit

• Type: integer
• Default value: 3600

sn_communities.edit_content_explicit_role Comma-separated list of roles with permission to
edit existing content, but not to create content.

• Type: string
• Default value:

n_communities.community_moderator,
sn_communities.moderation_admin,
sn_communities.admin

sn_communities.enable_session_cache Enables or disables session caching.
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Property Description
True: The permissions of any non-admin users of
the community are stored as a part of the
session. They are used to determine access to the
various forums and community content. While the
user is active in that particular session, any
changes to the community permissions do not
take effect until the user logs out.

False: The permissions of any non-admin users of
the community are not stored as a part of the
session.

• Type: boolean
• Default value: false

sn_communities.enable_topics Enables or disables topics within a community.
If the property is set to false and gamification is
enabled, topic information does not appear on
the leaderboard page.

• Type: boolean
• Default value: true

sn_communities.glide.script.block.client.globals Set the value to true to re-enable most of the
inaccessible Client APIs in a scoped application.

• Type: boolean
• Default value: false

sn_communities.implicit_access_mapping Assign access implicitly to users based on the
permissions they have. For example:

• If a user is given forum_admin access, they can
automatically administer, read, write to, and
moderate the forum.

• If a user is given forum moderation rights, they
can read, write to, and moderate the forum for
all content types.

• Type: string
• Default value:

{"forum_admin": ["forum_read", "forum_write",
"forum_moderator", "forum_admin",
"content_write"],"forum_moderator":
["forum_read", "forum_write",
"forum_moderator", "content_write"],
"content_write": ["content_read",
"content_write"]}

sn_communities.instance_base_url Vanity URL for your instance to be used in email
notifications to redirect users to the community
pages. Set a value only if you want the URL to be
different to the instance name.

• Type: string
• Default value: none
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Property Description
sn_communities.is_content_write_allowed_for_guest_userDetermines whether Content_write access is

allowed for a public or a guest user.

False: Content_write access is not given to a
public or guest user.

True: Content_write access is given to a public or
guest user.

• Type: boolean
• Default value: false

sn_communities.knowledge_base_id All questions created in Communities are entered
in this knowledge base.

• Type: string
• Default value:

a4c9fb2e6703220071b89a6617415af9

sn_communities.logging.destination Location of the log messages.

• Type: string
• Default value: db

sn_communities.log.verbosity
Code Search log verbosity for the community. Set
the value as required.

• 0: Show information that may be useful while
debugging the application, such as the values
of queries run. It includes info, warning, and
error messages.

• 1: Show progress messages as the Code Search
application searches for results. It also shows
warnings and error messages.

• 2: Show warning which indicates possible
unexpected changes in behavior.

• 3: Show only critical errors which may prevent
the search from completing.

• Type: choice list
• Default value: 1

sn_communities.logging.verbosity Category for writing log messages: Debug (0),
Info (1), Warning (2), or Error (3).

• Type: choice list
• Default value: 1

sn_communities.max_topic_limit Maximum number of topics that can be
associated to any content type. The value of this
property should not be set to greater than five.

• Type: integer
• Default value: 5

sn_communities.minimum_activity Minimum number of activities required to make
the activity feed the preferred feed.

August 6, 2018 ©2018 ServiceNow. All rights reserved. 278

ServiceNow | Customer Service Management



Property Description
• Type: integer
• Default value: 5

sn_communities.portal_default_config Community portal default configuration. Used in
community-specific widgets. It is a JSON value.

• Type: string
• Default value: [{"uiPageMapping":

[{"contentTypeId":"5a2fcaa0dbd26600b1f6f78eaf9619a8","icon_class":"fa-
question-
circle","internalName":"question","contentArticle":"a","pageId":"community_question"},
{"contentTypeId":"57f785863b2b220085f76b4ee3efc449","icon_class":"fa-
video-
camera","internalName":"video","contentArticle":"a","pageId":"community_video"},
{"contentTypeId":"cc3fcaa0dbd26600b1f6f78eaf96192e","icon_class":"fa-
quote-
left","internalName":"blog","contentArticle":"a","pageId":"community_blog"},
{"contentTypeId":"0764c981dbde6600b1f6f78eaf961990","icon_class":"","internalName":"comment","contentArticle":"a","pageId":""},
{"contentTypeId":"8f0a215c6707220071b89a6617415aa7","icon_class":"fa-
question-
circle","internalName":"answer","contentArticle":"an","pageId":"community_question"},
{"contentTypeId":"3f86a8db971232007a97a23363ac4a27","icon_class":"fa-
file-
text","internalName":"document","contentArticle":"a","pageId":"community_document"},
{"contentTypeId":"4c3a995ac302320012e45cb981d3aee0","icon_class":"fa-
calendar","internalName":"event","contentArticle":"a","pageId":"community_event"}]}]

sn_communities.public_forum_user
sys_id of the public forum user. Used to calculate
access permissions to forums.

• Type: string
• Default value:

88ef2155931322005b963511e57ffba6

sn_communities.registered_forum_user
sys_id of the registered forum user. This value is
used to calculate access permissions to forums.

• Type: string
• Default value:

5dce996993232200dd773511e57ffbcc

sn_communities.video_count Number of videos a user can post per day.

• Type: integer
• Default value: 20

sn_communities.default_permission_for_forum_membershipsSets the default permission for forum
memberships. Specify a value to determine which
permission is used as the default.

• Type: string
• Default value:

ff73ee9893223200a8223511e57ffb0b

sn_communities.forumListBatchSize Default number of forums to show on the topics
list page on the community portal.
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Property Description
• Type: integer
• Default value: 12

sn_communities.topicListBatchSize Default number of topics to show on the topics
list page on the community portal.

• Type: integer
• Default value: 12

sn_communities.disableForumInvitesForExternalEmailsDetermines if forum invites from the forum page
can be sent to external users.

Note:  Do not change this value
manually because it may affect
forum email invite functionality.

• Type: boolean
• Default value: true

sn_communities.attachments.document.max_size Maximum attachment file size in MB. (1 MB = 1024
KB)

• string
• Default value: 5

sn_communities.attachments.file_extensions Supported file extensions for community
attachments.

• Type: string
• Default value:

PPT,PPTX,XLS,XLSX,DOC,DOCX,TXT,PDF,PNG,BMP,JPG,JPEG,GIF,ZIP

sn_communities.attachments.max_attachment_countMaximum number of attachments that can be
attached to community content.

• Type: string
• Default value: 3

sn_communities.attachments.max_file_size Maximum attachment file size in MB. The
maximum size is capped at 5 MB.

• Type: string
• Default value: 2

sn_communities.attachments.max_invalid_attemptsMaximum number of invalid attempts a user can
make to upload an attachment.

• Type: string
• Default value: 3

sn_communities.attachments.max_total_size Maximum total size (in GB) of attachments. (1 GB
= 1024 MB)

• Type: string
• Default value: 500
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Property Description
sn_communities.attachments.total_size Total size (in KB) of attachments in the

community until date. (1 MB = 1024 KB, 1 GB =
1024 MB)

• Type: string
• Default value: 3680.04

sn_communities.attachments.user.day_limit Maximum number of attachments that can be
attached to community content per user per day.

• Type: string
• Default value: 20

sn_communities.days_to_keep_search_logs Sets the number of days to keep the search log
on an instance.

• Type: integer
• Default value: 180

sn_communities.minimum_characters_to_search Number of characters before a search engine
starts working in a community. This number must
be greater than or equal to 3.

• Type: integer
• Default value: 3

sn_communities.search.blog.enable_acl Sets how permissions are evaluated for blog type
content.
True: Permission is evaluated for that specific
content type and user.

False: Permission is evaluated at the forum and
content level.

• Type: boolean
• Default value: false

sn_communities.search.discussion.enable_acl Sets how permissions are evaluated for question
and answer type content.
True: Permission is evaluated for that specific
content type and user.

False: Permission is evaluated at forum and
content level.

• Type: boolean
• Default value: false

sn_communities.search.document.enable_acl Sets how permissions are evaluated for document
type content.
True: Permission is evaluated for that specific
content type and user.

False: Permission is evaluated at the forum and
content level.

• Type: boolean
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Property Description
• Default value: false

sn_communities.search.event.enable_acl Sets how permissions are evaluated for event
type content.
True: Permission is evaluated for that specific
content type and user.

False: Permission is evaluated at the forum and
content level.

• Type: boolean
• Default value: false

sn_communities.search.video.enable_acl Sets how permissions are evaluated for video
type content.
True: Permission is evaluated for that specific
content type and user.

False: Permission is evaluated at the forum and
content level.

• Type: boolean
• Default value: false

sn_communities.user.document_count Number of documents a user can post per day.

• Type: integer
• Default value: 20

sn_communities.video_count Number of videos a user can post per day.

• Type: integer
• Default value: 20

sn_communities.view_log_sources JSON string that provides a mapping of view log
source to a static source type. This static string
stores the view source in the View Log
[sn_communities_view_log] table.

• Type: string
• Default value:

{"searchResult": "search_result", "contentFeed":
"content_feed", "activityFeed": "activity_feed"}

sn_communities.knowledge.enable_harvesting Enables knowledge harvesting from communities.

• Type: string
• Default value: true

Activity Subscription properties
Property Description
com.snc.actsub.activities.api.fetch.limit Number of activities in the activity feed.

• Type: integer
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Property Description
• Default value: 10

com.snc.actsub.activity.rate.count.limit Number of activities that can be created within a
certain time frame.

• Type: integer
• Default value: 100

com.snc.actsub.activity.rate.time.limit Duration, in seconds, during which activities can
be created. Activities are no longer created after
the limit.

• Type: integer
• Default value: 3600

com.snc.actsub.activity.stream.user.limit Enter the limit on number of activities stored for a
user in the activity feed.

The oldest activities are deleted when the limit is
reached.

• Type: integer
• Default value: 2000

com.snc.actsub.core.disable_plugin Enable (true) or disable (false) the plugin
functionality.

• Type: boolean
• Default value: false

External User Registration properties
Property Description
sn_ext_usr_reg.allowed_email_domains Comma-separated list of email domains that can

be used to register. By default, the value is empty,
indicating that all email domains are allowed.

• Type: string
• Default value: none

sn_ext_usr_reg.captchaEnabled Enables Google re-CAPTCHA on the self-
registration page.

• Type: boolean
• Default value: true

sn_ext_usr_reg.eur_user_role Adds a role when a sys_user record is created
through self-registration.

• Type: string
• Default value: sn_communities.community_user

sn_ext_usr_reg.Reg_link_expiration_days Number of days that the registration link remains
active. Links older than the specified number of
days are deactivated and cannot be used for
completing the registration process.
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Property Description
• Type: integer
• Default value: 3

sn_ext_usr_reg.request_count Maximum number of times a registration link can
be requested.

• Type: integer
• Default value: 3

sn_ext_usr_reg.Temp_user_record_purge_days Number of days that a registration record is
maintained in the User Registration Request
[user_registration_request] table. Records older
than the specified number of days are deleted.

• Type: integer
• Default value: 30

Gamification properties
Property Description
sn_communities.enable_gamification Enables or disables the gamification feature for

the community and controls the appearance of
gamification-related widgets on the Community
portal.
When set to false, no gamification components
are displayed. User point totals and badge
assignments are not affected.

• Type: boolean
• Default value: true

sn_communities.content.show_gamification_level Controls the gamification level that is displayed
next to the Community user's name on the
Content pages.

• Type: choice list
• Choices:

none: Do not display the user's level
sn_gamification_modules: Show the user's

level in the Community
sn_communities_forum: Show the user's

level for the forum to which the content
belongs

• Default value: sn_gamification_modules

sn_gamification.days_to_keep_activity_records Number of days to keep the gamification activity
records in the database. Records created or
updated prior to the specified number of days are
purged.

• Type: integer
• Default value: 180

sn_gamification.enable_debug_logs Enables the debug logs for the gamification
feature.

• Type: boolean
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Property Description
• Default value: false

sn_gamification.levels_limit Maximum number of levels that can be defined
for the gamification feature.

• Type: integer
• Default value: 10

Questions to case properties
Property Description
sn.communities.enable_csm_case_creation_from_questionThis property provides access to the “Create

Case” option on the Community Question widget
and the “Question to Case” option on the
Community header drop-down menu.

• Type: true | false
• Default value: true

Communities roles
Last updated: July 26, 2018
Last updated: July 26, 2018

Ensure that users can perform all necessary actions by assigning roles.

Roles
Role Description
Community administrator
[sn_communities.admin]

Administer and manage all sections in the
community.

Community moderator
[sn_communities.community_moderator]

Moderate content associated with the
community.

Forum administrator
[sn_communities.forum_admin]

Administer and manage forum permissions
content types, and topics associated to the
forum.

Forum moderator
[sn_communities.forum_moderator]

Moderate content within specified forums.

Moderation administrator
[sn_communities.moderation_admin]

Administer moderation settings and moderate
content associated forums.

Gamification administrator
[sn_gamification.admin]

Administer gamification settings and configure
gamification rules. Contains the
sn_gamification.moderator role.

Gamification moderator
[sn_gamification.moderator]

Review and edit the gamification points earned
by community users.

Community user Any user who has signed up and accepted the
community Terms & Conditions. Their access to
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Role Description
[sn_communities.community_user] forums depends on the permissions set up for

each specific forum.

Knowledge harvester
[sn_communities.knowledge_harvester]

A community user who can harvest knowledge
articles from a community. Community
administrators, and community moderators
inherit this role by default. The knowledge
harvester role must be granted to other users.

Proxy case creator
[sn_customerservice.proxy_case_creator]

A community user who can create a customer
service case from a community discussion.

Community setup guide for admins
Last updated: July 26, 2018
Last updated: July 26, 2018

Define your requirements with community and forum stakeholders and set up your forums
for community users to start creating content.

Requirements

Role required: sn_communities.admin or sn_communities.forum_admin

Before you begin

Meet with the stakeholders

Stakeholder Responsibilities
Forum administrators Define and oversee the forum processes for day-

to-day operations related to topic creation, user
management, and moderation.

Community administrators Configure advanced settings for Communities
features.

Community users Contribute content in the form of questions,
answers, blogs, and comments.

With stakeholders, determine your community requirements

• Who are the consumers of the community content?

• Which content types can users contribute?

• Who can contribute content and who should have read-only access?

• What should the names of the initial forums be?

• Within these forums, what should the names of the initial topics be?

• Which keywords should be banned?

• How should the system moderate content and users?
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• What should the default notifications that users receive for various community activities
be?

What to do

Use the following steps as guidance to setting up your community.

1. Create a forum user

Create a forum user to use to define memberships to a forum.

2. Create a permission

Create a permission to use to define a user's access to a forum and its content types.

3. Add access and content types to your permission

Add access types to a permission to determine the access that users have to certain forums
and content.

4. Create a forum

Create a forum to provide a place for users to share content and configure the forum to
allow registered users to request access to join.

5. Configure content types for a forum

Configure content types for a forum to define which types of content to use in a particular
forum.

6. Create a forum permission

Create a forum permission by adding a forum user and a permission to a forum.

If required, perform the following actions:

Invite users to join the forum

Invite users to become members of a forum to encourage greater community involvement.

Create permission exceptions

Create a permission exception for users who require specific permissions for a forum.

Copy permissions

• Copy permissions from a forum to copy all permissions and content types from one forum
to another.

• Copy permissions from a parent forum.

August 6, 2018 ©2018 ServiceNow. All rights reserved. 287

ServiceNow | Customer Service Management



Debug user permissions

Debug user permissions to investigate and diagnose problems with user access to forums.

Next steps

Create a topic for users to create and share content.

Add a topic to a forum so that users can associate content to that topic.

Moderate a community to set up how the system moderates content and users.

Using guided setup to implement Communities

Communities guided setup provides a sequence of tasks that help you configure
Communities on your ServiceNow instance. To open Communities guided setup, navigate to
Community > Administration > Guided Setup.

For more information about using the guided setup interface, see Using guided setup.

Domain separation in Communities
Last updated: July 26, 2018
Last updated: July 26, 2018

This is an overview of domain separation in Communities. Domain separation allows you to
separate data, processes, and administrative tasks into logical groupings called domains. You
can then control several aspects of this separation, including which users can see and access
data.

Overview

Domain separation in this application is supported at the Data only level, meaning it
supports the data security model of separating visibility of data from one domain to another.
To learn more, see Application support for domain separation.

Related Topics

• Domain separation

Configure a community
Last updated: July 26, 2018
Last updated: July 26, 2018

You can configure various aspects of Communities based on the specific requirements of
your organization.

Before you begin

Role required: sn_communities.admin or sn_communities.forum_admin

About this task
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Access the Community menus and use the modules to configure your community.

Procedure

1. Navigate to Community and choose the menu and module you require.
2. Configure one or more of the following aspects for your community.

• Community content types

There are seven supported content types: Answer, Blog, Comment, Document, Event,
Question, and Video.

• Community feedback types

There are two supported feedback types: Upvote and Helpful.

• Community access types

Access types are used to control access to a forum or a content type.

• Configure video sources for a community

Configure additional sources that can be used for uploading a video to the community.

• Configure community forums

A forum is a place for users to share content, exchange notes, ask and answer questions,
and so on. Before community users can contribute content, configure a forum with
content types and permissions, and create and add topics to one or more forums.

• Forum and user permissions management

Community and forum administrators can give users and groups of users different levels
of access to forums and forum content.

• Configure the community profile

Set up the community profile by configuring profile fields and deciding which fields to
display in the personal information section of the community profile.

• Enable users to self-register to a community

Once users have accessed public forums and decided they want to join the community,
they can self-register to the community. External user registration provides a way of
validating users and requires them to accept the community Terms and Conditions.

• Create community Terms and Conditions

Community members must follow the community rules of conduct. Create community
Terms and Conditions and them share to build a successful community. Every community
user must review and accept the Terms and Conditions before contributing to a
community.

• Community Service Portal

The Community Service Portal is a web interface that is based on the ServiceNow Service
Portal application.

• View the Communities performance dashboard
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The Communities dashboard displays up-to-date status on community usage,
membership, content type and activity, and trends by forum and by topic.

• Migrate Social Q&A data to Communities

If you want to migrate existing Social Q&A content to Communities, you can use a script
to migrate the data.

• View community logs

Community logs display information about who has viewed or searched for content in a
community. The list view displays all log entries, unless filtered.

• View community feedback and bookmarks tables

View feedback and bookmarks tables to view which community content was given
feedback or was bookmarked.

• Create a case from a discussion

In order to engage your internal experts to reply to discussion threads, you can create
cases directly from community questions.

• Enable knowledge harvesting

Configure knowledge harvesting from a community to convert unstructured
conversations to structured knowledge articles and make the information more
accessible.

Community content types

Last updated: July 26, 2018
Last updated: July 26, 2018

There are seven supported content types: Answer, Blog, Comment, Document, Event,
Question, and Video.

Community administrators and forum administrators can configure content types at the
community and forum levels.

User access to content is based on the permissions that users have. Community users can
add content to the different content types and provide feedback on the content.

Content types
Content type Description
Question Post a question about an issue or a challenge and

get answers from other users. You can submit
your question on the Community homepage and
choose a forum or a topic to post it in. A question
can be tagged to more than one topic.

Answer Reply to a user question or another answer with a
possible solution or statement.

Blog Post a blog on a topic of interest to share with
other users. You can include images and videos.

Comment Enter a comment to express an opinion or to
react to a video or a blog.
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Content type Description
Video Upload a video on a topic of interest for other

users. Videos appear as web URLs that link to the
most popular video sites. Communities supports
playback from:

• YouTube – youtube.com
• Vimeo – vimeo.com
• DailyMotion – dailymotion.com
• Facebook – facebook.com

Note:  Videos can be included in other
types of content, including
questions, answers, blogs, and
comments.

Document Post a document to share with other community
members. You can post your document from
within a forum, choose a topic to post it in, and
tag it to more than one topic.

Event Create an event that other community users can
register for and attend.

• Configure community content types

Configure content types, such as videos and blogs, for the community.

Configure community content types

Last updated: July 26, 2018
Last updated: July 26, 2018

Configure content types, such as videos and blogs, for the community.

Before you begin

Role required: sn_communities.admin

About this task

You can configure content types at both the community and forum level. At the community
level, content types are active by default. Based on your requirements, you can deactivate
content types.

Procedure

1. To configure content types at the community level, navigate to Community >
Administration > Content Types.

2. Click a content type.
3. To deactivate a content type, clear the Active check box.
4. Click Update.

The content type is no longer visible to the community.
5. To configure content types at the forum level, navigate to Community > Administration >

Forums.
6. Click a forum.
7. Click the Content Types related list.
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8. In the Active column, double-click a row.
9. To activate a content type, select True. To deactivate a content type, select False.

Community feedback types

Last updated: July 26, 2018
Last updated: July 26, 2018

There are two supported feedback types: Upvote and Helpful.

Community users can provide feedback on the content they have access to in the
community.

Feedback types
Feedback type Description
Helpful Helpful feedback is associated to the following

content types when a community users marks
content as helpful: Blog, Video, Documents,
Answer, Comment.

Upvote Upvote feedback is associated to the Question
content type when a community users marks a
question as helpful.

Community access types

Last updated: July 26, 2018
Last updated: July 26, 2018

Access types are used to control access to a forum or a content type.

You can define the access types for a forum and a content type in a permission. There are
four access types available by default.

Access types
Access type Description
Forum Admin Applies to forums.

Forum Moderator Applies to forums.

Content Read Applies to all content types.

Content Write Applies to all content types. Content Read access
is automatically included in Content Write.

Note:  It is not recommended that you create your own access types. Advanced
knowledge of Communities architecture and scripting code to support and
interpret the new access type is required.
Contact ServiceNow Customer Support for further information.

To see all available access types, navigate to Community > Administration > Access Types.

Configure video sources for a community

Last updated: July 26, 2018
Last updated: July 26, 2018

Configure additional sources that can be used for uploading a video to the community.
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Before you begin

Role required: sn_communities.admin

Procedure

1. Navigate to Community > Administration > Video Configuration.
2. Click New.
3. On the form, fill in the fields.

Video Configurations form
Field Description
Host A video source website, for example,

youtube.com.

Domain The domain is set to global by default.

Application The application for the video source.
It is recommended that you enter Community.

Widget A widget to render the videos from the source.
Enter Communities render video.

4. Click Submit.

Configure community forums

Last updated: July 26, 2018
Last updated: July 26, 2018

A forum is a place for users to share content, exchange notes, ask and answer questions,
and so on. Before community users can contribute content, configure a forum with content
types and permissions, and create and add topics to one or more forums.

Before you begin

Role required: sn_communities.admin or sn_communities.forum_admin

About this task

A forum is the container for user-created content. A forum must be configured with content
types and permissions before becoming available for users to contribute content. Forums
can be organized hierarchically using the Parent field. Once forums are set up, they are
visible on the Community homepage based on user permissions.

A topic is an area of interest that users can discuss. Topics are visible from the Community
homepage and also appear within forums. They can be organized hierarchically using the
Parent field.

• The community admin creates topics and can associate a topic with one or many forums.
• Forum admins can associate topics with their own forums.
• If a user has access to a particular forum, they also have access to all its topics.

Procedure

Configure one or more of the following for community forums and topics.

• Create a forum
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Create a forum to provide a place for users to share content. You can configure forums for
membership that registered community users request access to join. You can also
configure forums to convert unstructured conversations to structured knowledge articles.

• Configure content types for a forum

Define which types of content to use in a particular forum and associate a workflow so
that content is reviewed before becoming visible to other community users.

• Invite users to become members of a forum

Invite users to become members of a particular forum to encourage greater community
involvement.

• Approve forum memberships

Manage forum membership approvals when registered community users request
membership to a forum.

• Create a topic

Create a topic for users to create and share content.

• Add a topic to a forum

Add a topic to a forum so that users can associate content to that topic.

• Disable topics in a community

Disable the topics feature so that no topic information is visible in your community.

Create a forum

Last updated: July 26, 2018
Last updated: July 26, 2018

Create a forum to provide a place for users to share content. You can configure forums for
membership that registered community users request access to join. You can also configure
forums to convert unstructured conversations to structured knowledge articles.

Before you begin

Role required: sn_communities.admin or sn_communities.forum_admin

About this task

A forum can be configured in the following ways.

Public Visible to all users, including non-logged in users.
All users have content_read access to questions
and answers in public forums. Configure public
forms by adding a forum user of the type public.

Private Visible only to users who have been assigned the
required permissions in the forum. Configure
private forums by adding a forum user of the
type custom and adding specific users or user
groups to that forum user.

August 6, 2018 ©2018 ServiceNow. All rights reserved. 294

ServiceNow | Customer Service Management



Membership The forum title is visible to registered community
users. Community users must request
membership to get full access to the content in
the forum. Configure membership forums by
selecting the Enable Membership for this Forum
check box.

Procedure

1. Navigate to Community > Administration > Forums.
2. In the Forums list, click New.
3. Fill in the fields on the form as appropriate.

Forum form
Field Description
Name Name of the forum.

Description A short description that defines the forum.

Image An image that provides a visual reference to
describe the forum.

Order The order that forums are displayed in. By
default, the display is alphabetical. Enter a
numerical value to set the order that forums are
displayed in. You can combine both options.

Parent The parent forum, if required. This lists the
forum as a subforum of the parent forum.

Enable Membership for this Forum Check box to make the forum membership
only, and enable registered forum users to
request to join the forum. If you select this
check box, the forum title is visible to all
registered community users. Community users
must request access to join the forum to see
the content.

Note:  The Approval Workflow for
Membership field appears when
you select this check box.

Approval Workflow for Membership The workflow for approving new members of a
forum.

Knowledge Base used for harvesting The knowledge base used for harvesting
community discussions to knowledge articles.

4. To allow registered forum users to view and request to join a forum, select the Enable
Membership for this Forum check box and complete the following steps.
a. Right-click the form header and click Save.

Two default permissions are added to the forum in the Forum Permissions related
list.

• Default Permission for Memberships: Read and write access to questions and
answers for users who are forum members.

• Forum Visible: Read access to the name and description of the forum for
registered users. To access content, users must request forum membership.

b. If required, you can add a new forum permission and set it as the default using the
sn_communities.default_permission_for_forum_memberships property.
If you want public users to view content in the forum to attract them to become
members, create a forum permission as follows:
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• Forum User: Public.
• Permission: Question & Answer Read.

c. In the Approval Workflow for Membership field, perform one of the following
options.

Option Description

Leave the Approval Workflow for Membership
field blank.

Membership requests to the forum are
automatically approved.

Select the preconfigured approval workflow
Forum Membership Approval.

A task is created and sent to the community or
forum administrator for approval.

Select a workflow that you have created. A task is created and sent to the users defined
in your workflow for approval.

5. Click Update.

Related Tasks

• Add a topic to a forum

• Configure community content types

• Create a forum permission

Configure content types for a forum

Last updated: July 26, 2018
Last updated: July 26, 2018

Define which types of content to use in a particular forum and associate a workflow so that
content is reviewed before becoming visible to other community users.

Before you begin

Role required: sn_communities.forum_admin

Procedure

1. Navigate to Community > Administration > Forums.
2. Click a forum.
3. In the Content Types related list, click New.
4. In the Content Types list, select a Content Type.
5. Select an Approval Workflow.

You can select the Community - Content Approval workflow or a workflow that you
have created.

6. Click Submit.

Result

The selected content type is added to the Content Types related list in the forum. You can
use these content types in this forum.

Invite users to become members of a forum

Last updated: July 26, 2018
Last updated: July 26, 2018
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Invite users to become members of a particular forum to encourage greater community
involvement.

Before you begin

Role required: sn_communities.admin or sn_communities.forum_admin

Procedure

1. Navigate to Community > Forums.
2. Choose a forum from the list that has been configured for membership.
3. Select the Invite Users to Join this Forum related link.
4. Complete the following steps to invite internal and external users.

a. If the users to send the email invitation to are internal, click Edit Users.
b. If external user registration is enabled, the Enter email address field is shown. Enter

the email addresses of the external users to send the email invitation to.
You can enter both internal and external users to your email invitation.

5. Enter Comments to personalize the text in the email invitation.
6. Click Submit.

An email is generated and sent to the users in the list. The approval workflow set in the
forum determines the approval of membership from an email invitation. You can view all
email invitations in the forum on the Forum Email Invites related list.

Approve forum memberships

Last updated: July 26, 2018
Last updated: July 26, 2018

Manage forum membership approvals when registered community users request
membership to a forum.

Before you begin

Role required: sn_communities.admin or sn_communities.forum_admin

About this task

There are two ways of approving forum memberships.

Procedure

1. Perform one of the following actions.
• Navigate to Community > Forums.

a. Choose a forum from the list that has been configured for membership.
b. Click the Membership Approvals related list.

• Navigate to Self-Service > My Approvals.
2. Accept or reject the membership requests.

Only one approval is required for each task.
Once the task has been approved or rejected, an email notification is sent to the user.

Create a topic

Last updated: July 26, 2018
Last updated: July 26, 2018

Create a topic for users to create and share content.
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Before you begin

Role required: sn_communities.admin

Procedure

1. Navigate to Community > Administration > Topics.
2. Click New.
3. On the form, fill in the fields.

Topic form
Field Description
Name Name of the topic.

Description A short description to define what the topic is.

Parent The parent topic, if required. If you enter a
parent topic, the topic is listed as a subtopic of
the parent topic.

Image An image that provides a visual reference that
describes the topic.

Knowledge category used for harvesting The knowledge category used to categorize
community discussions harvested to
knowledge articles.

4. Click Submit.
The topic is created and added to the list of topics.

What to do next

Add a topic to a forum.

Add a topic to a forum

Last updated: July 26, 2018
Last updated: July 26, 2018

Add a topic to a forum so that users can associate content to that topic.

Before you begin

Role required: sn_communities.forum_admin

About this task

A topic can belong to more than one forum.

Procedure

1. Navigate to Community > Administration > Forums.
2. In the list, click the forum name.
3. Click the Forum Topics related list.
4. Click New.
5. From the Topic list, select a topic.
6. Click Submit.

The selected topic is added to the Forum Topics list in the forum. The topic is available
to users in this forum.
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Disable topics in a community

Last updated: July 26, 2018
Last updated: July 26, 2018

Disable the topics feature so that no topic information is visible in your community.

Before you begin

Role required: sn_communities.admin

About this task

The administrator can change the sn_communities.enable_topics property so that all topic
information is hidden in the community. The data is not deleted.

Procedure

1. Enter sys_properties.list in the filter navigator and search for the
sn_communities.enable_topics property.

2. In the Value field, enterfalse.
3. Click Update.

• No topic information is displayed in the Activity Feed or Notifications and
Subscriptions.

• No topic information is displayed on the Forums or Topics landing pages.
• No topic information is displayed on Gamification pages and widgets.
• Topic fields do not appear when creating, editing, or viewing content.
• Topics do not appear in the search results page.

Forum and user permissions management

Last updated: July 26, 2018
Last updated: July 26, 2018

Community and forum administrators can give users and groups of users different levels of
access to forums and forum content.

There are three components that make up the security settings for forums: forum users,
permissions, and forums.
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Forum users

A forum user is a logical group of users, user groups, or both. This group is used to define
memberships to a forum.

Permissions

A permission is a combination of:

• access types for a forum

• access types for a given content type

You can create your own permission or use one of the default permissions that the
Communities application delivers.

Default permissions
Permission Description
Blog Read Read access to blogs.

Blog Read and Comment Write Read access to blogs and write access to
comments.

Blog Write Write access to blogs.

Blog Write and Comment Write Write access to blogs and comments.

Default Permission for Memberships Default permissions for forums that are marked
as Enable Membership for this Forum.

Default permissions for public user Public access to forums.

Default permissions for registered user Permissions for registered and logged in users.

Document Read and Comment Write Read access to documents and write access to
comments.

Document Write and Comment Write Write access to documents and comments.

Event Read and Comment Write Read access to events and write access to
comments.

Event Write and Comment Write Write access to events and comments.

Forum Admin Full access to a forum.

Forum Moderator Moderation access to a forum.

Forum Name and Description Read Read access to the name and description of a
forum. To access content or topics, other
permissions are required.

Full Access Write and read access to all content types.

Question and Answer Read Read access to questions and answers.

Question and Answer Write Write access to questions and answers.

Question Write Write access to questions.

Video Read and Comment Write Read access to videos and write access to
comments.

Video Write and Comment Write Write access to videos and comments.
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Forums

A forum is the container for user-created content. A forum must be configured with
content types and permissions before becoming available for users to contribute content.

To assign permissions to users and user groups, create associations between forum users
and permissions for a specific forum.

Note:  Forum permissions are not inherited in the forum hierarchy. Each subforum
must be configured with its own set of permissions and content types.

• You can use forum users and permissions in multiple forums.
• You can add multiple forum users and permissions to one forum.
• You can copy permissions from a parent forum to a child forum or from another forum

altogether.
• You can also define user-specific permission exceptions and debug user permissions.

• Create a forum user

You can create forum users, which you then use to define memberships to a forum.

• Create a permission

Create a permission to use to define a user's access to a forum and the content in the
forum.

• Clone a permission

Clone a permission if an existing permission record cannot be modified and you require a
permission record with similar settings.

• Create a forum permission

Add a forum user and a permission to a forum to create a forum permission.

Create a forum user

Last updated: July 26, 2018
Last updated: July 26, 2018

You can create forum users, which you then use to define memberships to a forum.
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Before you begin

Role required: sn_communities.forum_admin

About this task

A forum user is a logical group of users, user groups, or both. Forum users are reusable.
Multiple forum users can be used in any given forum.

Note:  Before creating a forum user, check whether an existing forum user matches
your requirements.

Types of forum user
Public Public users can view the community without logging in. By

default, public users have content_read access to questions
and answers in public forums.

Registered Users who have signed up to the community and accepted the
Terms & Conditions. Once logged in, their access to forum
content depends on the permissions set up for each specific
forum.

Custom Specific users and user groups that are added as members to
the current forum user.

Membership A group of members who have joined a specific forum. Once
logged in, their access to forums depends on the permissions
set up for each specific forum.

Procedure

1. Navigate to Community > Administration > Forum Users.
2. Click New.
3. On the form, fill in the fields.

Forum User form
Field Description
Name Name of the user.

Description Description of the user.

User type Type of user.

4. Click Submit.
The forum user is created and added to the Forum Users list.

• Add members to a forum user

Add members to a forum user. Members can be individual users or user groups.

Last updated: July 26, 2018
Last updated: July 26, 2018

Add members to a forum user. Members can be individual users or user groups.

Before you begin

Role required: sn_communities.forum_admin
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Procedure

1. Navigate to Community > Administration > Forum Users.
2. Click the forum user to add members to.
3. In the Members related list, click New.
4. On the form, fill in the fields.

Members form
Field Description
Forum User Forum user name. The name is automatically

filled.

Membership Type Membership type. Choose either User or Group.

Member User or user group to add to the forum user.
If you selected Membership Type > User, the
Table name is automatically filled with sys_user.

If you selected Membership Type > Group, the
Table name is automatically filled with
sys_user_group.

Enter your user or user group in the Document
field.

5. Click Submit.

Create a permission

Last updated: July 26, 2018
Last updated: July 26, 2018

Create a permission to use to define a user's access to a forum and the content in the forum.

Before you begin

Role required: sn_communities.admin

About this task

Permissions are reusable. Before creating a permission, check if any existing permissions
match your requirements.

Procedure

1. Navigate to Community > Administration > Permissions.
2. Click New.
3. On the form, fill in the fields.

Permission form
Field Description
Name Name for the permission.

Description Description of the permission.

4.
5. Click Submit.

• Add access types to a permission
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Access types for a permission determine the access that users have to certain forums.

• Add content types to a permission

Content types for a permission determine the access that users have to certain content in
a forum.

• Create a permission exception

Create a permission exception for users who require specific permissions for a forum.

Last updated: July 26, 2018
Last updated: July 26, 2018

Access types for a permission determine the access that users have to certain forums.

Before you begin

Role required: sn_communities.forum_admin

Procedure

1. Navigate to Community > Administration > Permissions.
2. In the Permissions list, click the permission you created.
3. Click the Forum Access related list.
4. Click New.
5. Select an access type.
6. Click Submit.

What to do next

Create a forum permission.

Related Tasks

• Add content types to a permission

• Create a permission exception

Related Concepts

• Community content types

• Community access types

Last updated: July 26, 2018
Last updated: July 26, 2018

Content types for a permission determine the access that users have to certain content in a
forum.

Before you begin

Role required: sn_communities.forum_admin

Procedure
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1. Navigate to Community > Administration > Permissions.
2. In the Permissions list, click the permission you created.
3. Click the Content Type Access related list.
4. Click New.
5. Select a content type and an access type.
6. Click Submit.

Related Tasks

• Add access types to a permission

• Create a permission exception

Last updated: July 26, 2018
Last updated: July 26, 2018

Create a permission exception for users who require specific permissions for a forum.

Before you begin

Role required: sn_communities.forum_admin

About this task

Permission exception records are created for users who require specific permissions for a
particular forum, for example, a forum manager. Any other permissions that the user has are
no longer valid once an exception is created.

Procedure

1. Navigate to Community > Administration > Forums.
2. Click a forum.
3. Click the Permission Exceptions related list.

The list of users who have extra permissions for this forum is displayed.
4. Click New.
5. In the User field, enter the name of the user to create a permission exception for.
6. In the Permission field, enter a permission.
7. Click Submit.

A permission exception is created and added to the list of Permission Exceptions on the
forum.

Related Tasks

• Add access types to a permission

• Add content types to a permission

Clone a permission

Last updated: July 26, 2018
Last updated: July 26, 2018

Clone a permission if an existing permission record cannot be modified and you require a
permission record with similar settings.

Before you begin

August 6, 2018 ©2018 ServiceNow. All rights reserved. 305

ServiceNow | Customer Service Management



Role required: sn_communities.forum_admin

Procedure

1. Navigate to Community > Administration > Permissions.
2. Click the permission you want to clone.
3. Click the Clone related link.

A new permission with the same access types as the source permission is created. The
permission record name starts with Clone of.

Create a forum permission

Last updated: July 26, 2018
Last updated: July 26, 2018

Add a forum user and a permission to a forum to create a forum permission.

Before you begin

Role required: sn_communities.forum_admin

About this task

Forum permissions are a combination of a forum, forum users, and permissions. Associate
forum users and permissions within a specific forum. You can add multiple combinations of
forum users and permissions to a forum.

Procedure

1. Navigate to Community > Administration > Forums.
2. Click a forum.
3. In the Forum Permissions related list, click New.
4. On the form, fill in the fields.

Forum Permissions
Field Description
Forum Name of the forum.

Forum Users User or group of users to give access to the
forum.

Permission Permission to give to the forum users in the
forum.

5. Click Submit.

• Copy permissions from a parent forum

You can copy permissions from a parent forum to a child forum.

• Copy permissions from a forum

You can copy all permissions and content types from one forum to another.

• Debug user permissions

Investigate and diagnose problems with user access to forums.

Last updated: July 26, 2018
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Last updated: July 26, 2018

You can copy permissions from a parent forum to a child forum.

Before you begin

Role required: sn_communities.forum_admin

Procedure

1. Navigate to Community > Administration > Forums.
2. Click a forum.
3. Click the Copy Permissions from Parent Forum related link.

All permissions and content types are copied from the parent to the child forum. A
summary of the results is displayed at the top of the form.

What to do next

Configure the forum users and permissions as required.

Related Tasks

• Copy permissions from a forum

• Debug user permissions

Last updated: July 26, 2018
Last updated: July 26, 2018

You can copy all permissions and content types from one forum to another.

Before you begin

Role required: sn_communities.forum_admin

About this task

You can copy permissions from one source forum to multiple target forums.

Procedure

1. Navigate to Community > Administration > Forums.
2. Click the name of the forum that you want to copy permissions from.
3. Click the Copy Permissions to Forum(s) related link.
4. On the form, fill in the fields.

Copy Permissions
Field Description
Copy Permissions From Name of the forum you want to copy

permissions from. The name is automatically
filled.

Copy Permissions To Name of the forum you want to copy the
permissions to. You can enter more than one
forum.

5. Click Save.
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Related Tasks

• Copy permissions from a parent forum

• Debug user permissions

Last updated: July 26, 2018
Last updated: July 26, 2018

Investigate and diagnose problems with user access to forums.

Before you begin

Role required: sn_communities.forum_admin

Procedure

1. Navigate to Community > Administration > Forums.
2. Click the name of the forum to investigate.
3. Click the Debug Forum Permissions related link.
4. Enter the name of the user you want to check the permissions for.

The forum user permissions information indicates which content and access types the
user has for a particular forum.

Related Tasks

• Copy permissions from a parent forum

• Copy permissions from a forum

Configure the community profile

Last updated: July 26, 2018
Last updated: July 26, 2018

Set up the community profile by configuring profile fields and deciding which fields to
display in the personal information section of the community profile.

Before you begin

Role required: sn_communities.admin

Procedure

Configure one or more of the following for the community profile.

• Create a persona for the community profile

Create a persona and associate it to a role to manage which data users can modify.

• Create a community profile field

Create a field to display on the community profile.

• Configure persona field mapping for the community profile
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Configure which fields appear in the community profile and manage the settings
associated with those fields.

Create a persona for the community profile

Last updated: July 26, 2018
Last updated: July 26, 2018

Create a persona and associate it to a role to manage which data users can modify.

Before you begin

Role required: sn_communities.admin

About this task

A persona is associated to a user role and can be mapped to specific fields for display on
the community profile. The base system contains a default persona, which is not associated
to a role and is used for all community users. You can create a new persona or add a role to
the default persona.

Procedure

1. Navigate to Community > User Profile > Persona.
2. Click New and then complete the Persona form.

Field Description
Name A name for the persona.

Order The order, in numerical value, in which the
system should evaluate the roles for the
persona.

Associated Role The role to associate the persona to.

3. Click Submit.

Create a community profile field

Last updated: July 26, 2018
Last updated: July 26, 2018

Create a field to display on the community profile.

Before you begin

Role required: sn_communities.admin

Procedure

1. Navigate to Community > User Profile > Profile Fields.
2. Click Newand then complete the Profile Fields form.

Field Label A label for the field.

Field Name A name for the field.

3. Click Submit.
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Configure persona field mapping for the community profile

Last updated: July 26, 2018
Last updated: July 26, 2018

Configure which fields appear in the community profile and manage the settings associated
with those fields.

Before you begin

Role required: sn_communities.admin

Procedure

1. Navigate to Community > User Profile > Persona Field Mapping.
2. Click Newand then complete the Persona Field Mapping form.

Persona Field Mapping form
Field Description
Persona Name of the persona.

Source Value Table Source table of the field to be added to the
persona. Any table that is used as the Source
Value Table should have a reference to the
sys_user table.

Source User Field Field from the source value table.

Privacy Read Only Select the check box to allow the community
user to change the display settings for this field
in their community profile.

Profile Field Display name of the community profile field.

Source Value Field Name of the field from the source table.

Read Only Select the check box to not allow the
community user to edit the value of this field.

Privacy Default Privacy default setting for the field.

3. Click Submit.

Enable users to self-register to a community

Last updated: July 26, 2018
Last updated: July 26, 2018

Once users have accessed public forums and decided they want to join the community, they
can self-register to the community. External user registration provides a way of validating
users and requires them to accept the community Terms and Conditions.

Community administrators perform the following tasks to configure external user
registration.

• Configure the external user registration properties.
• Configure moderation filters to enter banned words for the user name.
• . Configure the required strength for passwords
• Change email templates and content. The email template that you can change is

confirmation.link.sent.html
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• If not already configured, create Terms and Conditions that each community user must
review and accept. Communities delivers preconfigured Terms and Conditions that you can
modify according to your needs.

Create community Terms and Conditions

Last updated: July 26, 2018
Last updated: July 26, 2018

Community members must follow the community rules of conduct. Create community
Terms and Conditions and them share to build a successful community. Every community
user must review and accept the Terms and Conditions before contributing to a community.

Before you begin

Role required: sn_communities.admin

About this task

The Communities application includes preconfigured Terms and Conditions that you can
modify according to your needs.

Procedure

1. Navigate to Community > Administration > Communities Terms and Conditions, click
New, and then fill in the fields.

Terms and Conditions form
Field Description
Number An automatically generated number for your

Terms and Conditions. If required, you can
change the number.

Short Description A short description for your Terms and
Conditions.

Content The content of your Terms and Conditions.

2. Complete one of the following actions to save the Terms and Conditions.

To Do this

Submit Click Submit to save your Terms and
Conditions.

Activate a. Click Activate. Your Terms and Conditions
are activated and any existing Terms and
Conditions are deactivated.

b. Select the check box on the warning
message if you want all community users
who log on to accept to the new Terms
and Conditions. The check box is selected
by default.

c. Deselect the check box if you want users
to accept the new Terms and Conditions
at a later point in time. You can then select
your Terms and Conditions and click
Prompt users to review and accept.

d. Click OK.
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You can view which community users have accepted the Terms and Conditions and
when. Navigate to Community > User Profile > Community Profiles. View or add, if
necessary, the Accepted TC, Accepted TC Date, and Accepted TC Number fields.

Community Service Portal

Last updated: July 26, 2018
Last updated: July 26, 2018

The Community Service Portal is a web interface that is based on the ServiceNow Service
Portal application.

The Community Service Portal is designed to allow you to have control over the behavior of
your portal and help create an attractive and engaging user experience.

To customize this portal, navigate to Service Portal > Portals and click Community.

• Configure Community Service Portal header menus

Configure Community Service Portal header menus to create a consistent user experience
across all your end-user facing service portals using a modern interface and a unified
navigation menu structure.

• Make an announcement to community members

Global announcements appear in the banner and broadcast messages to all community
members. Forum announcements appear in the Announcements section on the forum
page. You can also send the announcement by email.

• Community pages that support SEO data

To improve search results for community members using external search engines, the
Communities application generates SEO meta tags and injects the tags into questions,
topics, forums, and other page types.

Configure Community Service Portal header menus

Last updated: July 26, 2018
Last updated: July 26, 2018

Configure Community Service Portal header menus to create a consistent user experience
across all your end-user facing service portals using a modern interface and a unified
navigation menu structure.

Before you begin

Role required: The admin role for your service portal, for example, sn_communities.admin.

About this task

Add a theme and header menu to your service portal to define its look and behavior.

Procedure

1. Navigate to Service Portals > Portals and click the module for the portal you want to
modify.

2. You have to be in the Global application to edit. If a message appears, click here to edit.
3. In the Theme field, enter CSM Default.
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4. In the Main Menu field, enter CSM Unified Portal Header Menu.
5. Click the information icon next to the Main menu field and click Open Record.
6. Click the Settings icon and System Settings > Developer.
7. Change the Application to Customer Service Management Unified Theme and click the

Refresh icon.
You only have to change this setting once.
The New button is displayed next to Menu Item.

8. To display the names of the menu items, personalize the Menu Items related list and add
Display name.

9. Click New from the Menu Items related list.
10. Fill in the fields on the form.

Menu Item form
Field Description
Label Name that appears for the item in the menu.

Parent Menu This field should already contain the name of
the menu you are adding items to. You can
change the value as required to other menus.

Parent Menu Item Use this field to nest menu items within other
menu items.

Order Value that determines where the item appears
in the menu in relation to other menu items.

Type The kind of page the item links to. For example,
you can link to another page in the portal, or an
external URL. Form fields vary depending on
the option you select from this list.

Page Name of the portal page the item links to.

Condition Determines what conditions are required for
menu items to show in the header.

Glyph Icon that appears beside the menu item

11. Click Submit.

Make an announcement to community members

Last updated: July 26, 2018
Last updated: July 26, 2018

Global announcements appear in the banner and broadcast messages to all community
members. Forum announcements appear in the Announcements section on the forum page.
You can also send the announcement by email.

Before you begin

Role required:

• sn_communities.admin can manage Global announcements and Forum announcements
• sn_communities.forum_admin can manage Forum announcements for own forums only.

The announcement appears only in the forum that the admin owns.

About this task

This example shows how a community user experiences announcements and how you can
configure the appearance and operation of announcements.
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Procedure

Navigate to Community > Administration > Global Announcements or Forum
Announcements, click New, and then fill in the form.

Announcement type Read-only. Set to Global Announcement or
Forum Announcement, depending on what you
are working on.

Active Select the check box to publish the
announcement to members.

Clear the check box to cancel the announcement.

Title Display title of the announcement.

• The text appears above the Summary text.
• In email, the text is the subject of the message.

Summary Content of the announcement.

• The text appears below the Title text.
• In email, the text is the body of the message.
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From / To
• From: Date and time that the announcement

should appear.
• To: Date and time that the announcement

should no longer appear.

Send email notification Select the check box to send the announcement
to members as an email message in addition to
broadcasting the announcement.

Display first Select the check box to display the
announcement as the first announcement in the
list.

Public Select the check box to enable forum members
that are not logged in to view the announcement.

Portals Portals that display the announcement. Default:
Community.

Note:  If no value is specified, the
announcement does not appear
in any portal.

Click target The Click target setting creates a link for the
announcement.

• None: No link.
• Page: Opens a Service Portal page in the

current browser tab.
• URL in current browser tab: Opens the

specified URL in the current browser tab.
• URL in new browser tab: Opens the specified

URL in a new browser tab.

Details URL If you select a URL option for Click target, then
enter the URL in the Details URL field.

Details link text Appears only if Click target is not None.

• To display a link under the Summary text, enter
the text of the link in the Details link text field.

• To use the Title text of the announcement as
the link, leave Details link text blank.

Forums This setting appears for Forum announcements
only. Slushbucket of forums that you are admin
for.
Move a forum into the Selected list to display the
announcement on the forum.

Dismiss options This setting appears for Global announcements
only. Determines how the user can dismiss the
announcement.

What to do next
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• To update an announcement, update any setting as needed and then click Update. If you
specified Send email notification, then you are prompted to send the updated email
message.

• To cancel an announcement, clear the Active check box.

Community pages that support SEO data

Last updated: July 26, 2018
Last updated: July 26, 2018

To improve search results for community members using external search engines, the
Communities application generates SEO meta tags and injects the tags into questions,
topics, forums, and other page types.

Pages that include auto-generated SEO data

Note:  If the auto-generated SEO tags in a page does not meet your needs, you can
change the SEO tags. See Modify SEO in community pages.

The Communities application auto-generates SEO meta tags for the following pages in the
Community service portal. The table provides details on the data that is generated.

• community_question
• community_blog
• community_document
• community_video
• community_event
• community_forum
• community_topic

Auto-generated SEO tags
Searchable page type Auto-generated tags in the page
Question, Blog, Document, Video, and Event

• The title meta tag is populated with the text
“<forum name> - <content short description>"

• The description meta tag is populated with the
text “<forum name> - <topic names> - <first
100 characters of the body of the content>"

Forum
• The title meta tag is populated with the text

“<forum name>"
• The description meta tag is populated with the

text “<forum description>"

Topic
• The title meta tag is populated with the text

“<topic name>“
• The description meta tag is populated with the

text “<topic description>"

Leaderboard page The Title meta tag is populated with the text
“<community name>”

• Modify SEO in community pages
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If an auto-generated SEO meta tag does not meet your needs, you can modify or replace
the tag.

Last updated: July 26, 2018
Last updated: July 26, 2018

If an auto-generated SEO meta tag does not meet your needs, you can modify or replace
the tag.

Before you begin

Role required: sn_communities.admin

About this task

The source code for this example question page (ID community_question) shows the
description meta tag (highlighted in yellow) that the Communities application injected into
the page.
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• The description meta tag text is made up of three data fields that are taken from the
communitiy_question record. In the tag, the values are separated by a hyphen character.

The first portion of the description meta tag is the value of the forum name field in the
question record. In the example, the forum name is Routing and Switching.
The second portion of the tag is the value of the topic field in the record — Tomahawk
(5000 Series) in the example.
The third portion of the tag is generated from the first 100 characters of the body field

in the record — My 5000 series router has been overheating since I upgraded
the firware couple of days ago. Anybody.

In addition to the description meta tag for a question page, the Communities application
injects a title tag (highlighted in blue). The title is generated dynamically using two values
from the communitiy_question record:

• Forum name (Routing and Switching in the example)
• Short description (Router overheating after firmware upgrade in the example)

Procedure

1. Navigate to Service Portal > Pages.
2. In the list of portal pages, click the ID of the page to update (in the example,

community_question).

See the list of pages in Communities that support SEO data.

3. On the Page form:
• Modify or add meta tags in the Meta tags related list.
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• Modify the Dynamic page title by modifying the structure of the title text or by
modifying or replacing the variables that generate the text. The variable definitions
appear in the Dynamic page title variables related list.

View the Communities performance dashboard

Last updated: July 26, 2018
Last updated: July 26, 2018
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The Communities dashboard displays up-to-date status on community usage, membership,
content type and activity, and trends by forum and by topic.

Before you begin

Role required: pa_admin

Procedure

1. Navigate to Performance Analytics > Dashboards.
2. In the list, select Community > Communities Dashboard.

On dashboard tabs:
• Content types are question, answer, comment, blog, video, or document.
• "Social activity" is any response (answer, comment, blog, video, or document) to a

topic that is added by a user other than the originator.
• Content score data is for content created during the last 30 days.
• Click a scorecard to view detailed data or a trend chart.

Overview tab Scorecards

In each scorecard, the percentage change in the current period
appears under the total over the lifetime of the community.

• Number of current members and total number of questions.
• Percentage of questions that have been marked as Solved by

the user who asked the question.
• Percentage of questions that have not been answered.
• Total number of attachments (blogs, videos, and documents).

Charts

• Community Activity: new community members and total
sessions for the month.

• New content of any type.
• Top 3 Forums and Topics by Social Activity: Topics and

forums that have received responses from other members.
Hold the cursor over an area to view the count of activity.

Content Analytics tab For any chart, you can focus on the most popular content types,
forums, or topics by selecting a Breakdown.

• New content and count of active members who contributed
content for the most recent months for the selected
breakdown.

• The top 10 items with the highest number of views for the
selected breakdown.

Forum Analytics tab • Heat maps display data for Content (total current content
volume), Views (total unique user views), and Social Activity.
Forums are listed on the vertical axis and content types
appear on the horizontal axis.

• Additional KPIs: key performance indicator data for forums.

Topic Analytics tab • Heat maps display data for Content (total current content
volume), Views (total unique user views), and Social Activity.
Topics are listed on the vertical axis and content types appear
on the horizontal axis.

• Additional KPIs: key performance indicator data for topics.

August 6, 2018 ©2018 ServiceNow. All rights reserved. 320

ServiceNow | Customer Service Management



Related Topics

• Performance Analytics scorecards

• Performance Analytics widgets

Migrate Social Q&A data to Communities

Last updated: July 26, 2018
Last updated: July 26, 2018

If you want to migrate existing Social Q&A content to Communities, you can use a script to
migrate the data.

Before you begin

Role required: sn_communities.admin

The Customer Communities plugin (com.sn_customer_communities) must be activated.

Procedure

1. Navigate to System Definition > Fix Scripts.
2. Search for the script Migrate Social QA to Community and open it.
3. To enable the script, select the Active check box and click Update.

The script is deactivated by default.
4. Click Run Fix Script.

The Run Fix Script popup appears.
5. Click Proceed in Background.

Always use this option for long-running scripts, or if you do not know the expected
execution time.

6. Check the status of the fix script and review the results from the Show Progress Workers
related list.

What to do next

Verify the following information.

• A new forum is created for every knowledge base that has Social Q&A content.
• All questions, answers, comments, helpful votes, and upvotes are migrated.
• All view counts, answer counts, and comment counts are migrated.
• The accepted solution to a question in Social Q&A is Marked as Correct Answer in

Communities.
• Social Q&A is deactivated for every knowledge base that contained Social Q&A data.

Social Q&A content is no longer visible for these knowledge bases.

View community logs

Last updated: July 26, 2018
Last updated: July 26, 2018

Community logs display information about who has viewed or searched for content in a
community. The list view displays all log entries, unless filtered.

Before you begin

Role required: sn_communities.admin
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Procedure

1. Navigate to Community > Administration > Search Logs or View Logs.
2. View the logs.

Community logs
Log Description
Search Log View who has searched for what and where in

the community.

View Log View who has viewed what and where in the
community.

View community feedback and bookmarks tables

Last updated: July 26, 2018
Last updated: July 26, 2018

View feedback and bookmarks tables to view which community content was given feedback
or was bookmarked.

Before you begin

Role required: sn_communities.admin, sn_communities.community_moderator,
sn_communities.moderation_admin, sn_communities.forum_admin, or
sn_communities.forum_moderator

Procedure

1. Navigate to Community > Feedback.
2. Choose one of the following options.

• Click Feedback to view the content feedback was given for, the type of the
feedback, and who provided it.

• Click Bookmarks to view the content that was bookmarked and who added it.

Create a case from a discussion

Last updated: July 26, 2018
Last updated: July 26, 2018

In order to engage your internal experts to reply to discussion threads, you can create cases
directly from community questions.

Creating cases from community questions requires activation of the Customer Service
Management (com.sn_customerservice) plugin.

This feature is available for questions that have been posted by community users who are
also contacts or consumers in the Customer Service Management application. Questions can
be either answered or unanswered.

Note:  Cases can be created only from questions.

Two sets of users can create cases from questions:

• Customer service agents, consumer service agents, and customer service managers.
• Users with the sn_customerservice.proxy_case_creator role. Community administrators

and community moderators inherit this role.
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• Administer create case from discussion

Configure parameters for the case generated from the community discussion so that it
can be routed accordingly.

Administer create case from discussion

Last updated: July 26, 2018
Last updated: July 26, 2018

Configure parameters for the case generated from the community discussion so that it can
be routed accordingly.

Creating a case from a discussion requires a configuration that maps information from the
question in the community to fields on the Case form. The Create Case configuration is
included with the feature. This configuration defines the source and destination tables and
maps source fields to destination fields. This configuration is stored in the CSM Table Map
table [csm_table_map]. The system administrator can modify this configuration as needed.

The Create Case configuration uses the Social Q&A Question table [kb_social_qa_question]
as the source table and the Case table [sn_customerservice_case] as the destination table. It
includes the following mapping information.

Question information Case information
Question Short description

Question author Contact or consumer

Question author's account Account

Opened by Logged in community user

Priority Low (priority = 4)

Channel Community

To create additional mapping between these tables, add the additional fields to the Create
Case configuration in the CSM Table Map table. Include these fields as needed on the Create
case from question record producer.

Enable knowledge harvesting

Last updated: July 26, 2018
Last updated: July 26, 2018

Configure knowledge harvesting from a community to convert unstructured conversations
to structured knowledge articles and make the information more accessible.

Community administrators perform the following tasks to configure knowledge harvesting.

• Enable the Knowledge Management Service Portal plugin
(com.snc.knowledge_serviceportal).

• Add a knowledge base to a forum to store the knowledge article in a specific knowledge
base.

Note:  You can only add one knowledge base to a forum. The same knowledge
base can be used for multiple forums.

• Add a knowledge category to a forum topic to categorize the harvested content.
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Moderate a community
Last updated: July 26, 2018
Last updated: July 26, 2018

Community moderators can manage content quality by reducing the inappropriate content
that is posted on the community.

Before you begin

Role required: sn_communities.community_moderator, sn_communities.forum_moderator,
or sn_communities.moderation_admin

Procedure

1. Define your requirements for Community moderation.
• Should first-time posters receive automatic moderation?
• Which words should be banned from user content?
• Should the system prevent content containing banned words from being posted?
• Should users be able to report inappropriate content?
• How many offenses can a user commit before the system bans them automatically?

2. Navigate to Community and choose the Moderation or Moderation Tasks menu and the
module you require.

3. Configure one or more of the following aspects for your community.

• Configure general moderation settings

Configure when to moderate content for users and user groups.

• Configure moderation settings for a new user

Configure the system to prevent inappropriate user contributions.

• Configure abuse reporting

Configure whether users can report content and profile abuse, set an abuse reporting
threshold, and define reasons for abuse reporting.

• Configure user banning

Set the number of offenses a user can make before they are banned from creating or
editing content.

• Configure moderation filters

Create moderation filters to manage how content is moderated.

• Ban a user

You can ban a user from creating or editing content, for example, a user can be banned
for posting inappropriate content.

• Revoke a user ban

Revoke a user ban to allow a user to create and edit content again.

• Approve or reject content
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Approve or reject content that a user reported as inappropriate or that is associated with
a particular community profile.

• Remove content

Remove content that does not meet community standards.

Configure general moderation settings

Last updated: July 26, 2018
Last updated: July 26, 2018

Configure when to moderate content for users and user groups.

Before you begin

Role required: sn_communities.admin, or sn_communities.moderation_admin

Procedure

1. Navigate to Community > Moderation > Moderation Settings.
2. On the form, fill in the fields.

Moderation Settings form
Field Description
Users Never Moderated Content is never moderated for these users.

Users Always Moderated Content is always moderated for these users.

User Groups Never Moderated Content is never moderated for these user
groups.

User Groups Always Moderated Content is always moderated for these user
groups.

Hide content if user violates settings Check box to hide content written by a user
until a moderator approves it.

3. Click Update.

Configure moderation settings for a new user

Last updated: July 26, 2018
Last updated: July 26, 2018

Configure the system to prevent inappropriate user contributions.

Before you begin

Role required: sn_communities.admin or sn_communities.moderation_admin

Procedure

1. Navigate to Community > Moderation > Moderation Settings.
2. Click the New User related list.
3. On the form, fill in the fields.
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Moderation Settings form
Field Description
New User Content Threshold Number of user posts to be moderated.

User Exception List New users that are not included in the new user
content threshold for moderation.

User Group Exception List User groups that are not included in the new
user content threshold for moderation.

4. Click Update.

Configure abuse reporting

Last updated: July 26, 2018
Last updated: July 26, 2018

Configure whether users can report content and profile abuse, set an abuse reporting
threshold, and define reasons for abuse reporting.

Before you begin

Role required: sn_communities.admin or sn_communities.moderation_admin

Procedure

1. Navigate to Community > Moderation > Moderation Settings.
2. Click the Abuse related list.
3. On the form, fill in the fields.

Moderation Settings form
Field Description
Enable Content Abuse Reporting Check box to enable users to report

inappropriate content.

Enable Profile Abuse Reporting Check box to enable users to report
inappropriate profiles.

Abuse Reporting Threshold Number of abuse reports on a specific content
(question, blog, video, answer, comment) that
lead to the content being hidden from other
users.

Content Abuse Reporting Reasons List Phrases that are possible reasons for the user
to report inappropriate content contributions.
Separate each phrase using the pipe symbol|.
For example, This content is abusive|This
content used an offensive word|Spam|
Inappropriate media.

Profile Abuse Reporting Reasons List Phrases that are possible reasons for the user
to report an inappropriate user profile. Separate
each phrase using the pipe symbol|.

4. Click Update.

Configure user banning

Last updated: July 26, 2018
Last updated: July 26, 2018
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Set the number of offenses a user can make before they are banned from creating or editing
content.

Before you begin

Role required: sn_communities.admin or sn_communities.moderation_admin

Procedure

1. Navigate to Community > Moderation > Moderation Settings.
2. Click the User Banning related list.
3. On the form, fill in the fields.

Moderation Settings form
Field Description
Enable Banning Users Check box to enable the banning of users.

Offense Threshold Number of offenses a user can make before
being automatically banned.

4. Click Update.

Configure moderation filters

Last updated: July 26, 2018
Last updated: July 26, 2018

Create moderation filters to manage how content is moderated.

Before you begin

Role required: sn_communities.admin or sn_communities.moderation_admin

Procedure

1. Navigate to Community > Moderation > Moderation Filters.
2. Click New.
3. Click Banned Keyword Filter.
4. On the form, fill in the fields.

Moderation Banned Keyword Filter form
Field Description
Filter Name Name of the filter.

Active Check box to make the filter active.

Synchronous Check box to automatically moderate content
when it is submitted. Any content that includes
the banned words defined in the filter is not
posted.
If the check box is cleared, the system creates a
moderation task when banned words are used.
The content is visible until it is moderated.

5. Click Submit.
6. From the Moderation Filters list, click the name of your filter.
7. Add a banned keyword word to the list:

a. In the Keywords list, click New.
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b. In the Keyword field, enter your keyword.
c. Click Submit.
d. If required, repeat to add more keywords to the list.

8. Click Update.

Ban a user

Last updated: July 26, 2018
Last updated: July 26, 2018

You can ban a user from creating or editing content, for example, a user can be banned for
posting inappropriate content.

Before you begin

Role required: sn_communities.admin, sn_communities.moderation_admin, or
sn_communities.community_moderator

Procedure

1. Navigate to Community > User Profile > Community Profiles.
2. Click the Preview icon next to the user and then click Ban User.

The user is banned. In the Community Profiles list, the value in the Banned column is set
to true.

Revoke a user ban

Last updated: July 26, 2018
Last updated: July 26, 2018

Revoke a user ban to allow a user to create and edit content again.

Before you begin

Role required: sn_communities.admin, sn_communities.moderation_admin, or
sn_communities.community_moderator

Procedure

1. Perform either of the following actions.
• Navigate to Community > User Profile > Community Profiles.
• Navigate to Community > Moderation > Users Banned by Moderation.

2. Click the Preview icon next to the user and then select Revoke User Ban.
The user ban is revoked. In the Community Profiles list, the value in the Banned column
is set to false.

Approve or reject content

Last updated: July 26, 2018
Last updated: July 26, 2018

Approve or reject content that a user reported as inappropriate or that is associated with a
particular community profile.

Before you begin

Role required: sn_communities.community_moderator, sn_communities.moderation_admin
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About this task

A moderation task is generated when a community user reports inappropriate content or
community profiles. By default, the system assigns the task to the community moderator
group. You can also configure your system to always require content moderation for a
particular user or group.

Each task requires the moderator to approve or reject the reported item. If the moderator
rejects content, it is counted as an offense against the community user who contributed the
content.

Procedure

1. Navigate to Community > Moderation Tasks > Assigned to me.
2. Click a moderation task.
3. On the form, fill in the fields.

Moderation Task form
Field Description
Assigned to Person assigned to the task.

Moderation Notes Notes entered by the user when reporting the
content.

Resolution Notes Your comment as you moderate the content.

Work Notes Work notes entered by users working on the
task.

Approve Content Approve content that conforms to community
rules. The content state changes to Closed
Complete.

Reject Content Reject content or a profile. The content state
changes to Closed Complete and the content is
hidden in the community.

Note:  You can review the outcome of existing and past moderation tasks by
navigating to Community > Moderation > Moderation Outcomes. Click a
task to view the details of the moderation task.

Remove content

Last updated: July 26, 2018
Last updated: July 26, 2018

Remove content that does not meet community standards.

Before you begin

Role required: sn_communities.admin

Procedure

1. Navigate to Community > Content > Contents.
2. Click the content to remove.
3. Click Actions on selected rows > Delete and confirm that you want to delete the item.
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Use a community
Last updated: July 26, 2018
Last updated: July 26, 2018

Participate in your community by sharing content, asking and answering questions, creating
events, giving feedback, and so on.

Before you begin

Role required: sn_communities.community_user

Procedure

Use a community in one or more of the following ways.

• Community homepage features for logged in users

Your community activity usually begins on the community homepage. If you are a logged
in user, you see different information than non-logged in users. Your organization can
customize the homepage.

• Navigating the activity feed

The activity feed provides a central place for community users to view information and
interact. It lists the most recent activity in the community based on your network, posts,
and subscriptions. You can reply, comment, and give feedback directly from the activity
feed.

• Navigating the forum homepage

While in a forum, you can navigate the forum homepage and perform tasks, such as
posting content.

• Community homepage features for non-logged in users

Your community activity usually begins on the Community homepage. If you are a non-
logged in user, you see different information than logged in users. Your organization can
customize the homepage.

• Self-register to a community

Once you have accessed a public forum and decided to join the community, you can self-
register by signing up and accepting the community Terms and Conditions.

• Search the community

Enter a keyword to use the type-ahead search on the Community homepage or enter one
or more words to view all search results.

• Use a community profile

The community profile displays an overview of a user's personal information as well as
their contributions, network, achievements, expertise, and events they are attending. You
can view and edit your own profile. You can also view another user's profile and perform
actions, such as following them or reporting inappropriate content.

• Community subscriptions
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Using subscriptions, you can choose specific areas of interest. Your activity feed and
notifications are personalized according to your subscriptions.

• Request membership to a forum

You must be a registered member of the community to request membership to a forum
that is marked for membership only.

• Accept an invitation to join a forum

An invitation to join a forum is sent as an email message. The method that you use to
accept an invitation depends on whether you are a registered community user.

• Post and respond to content in the community

Post and respond to content in the community to get answers or share information.

• Report inappropriate community content

Report content to alert community moderators that the content is inappropriate or spam.

• Harvest knowledge from a community

Harvest knowledge from a community and create structured knowledge articles from
unstructured discussions around a question.

• View a list of questions and create a case

To easily view questions that can potentially be converted to cases, the community portal
provides a page with a list of questions created by contacts or consumers.

Community homepage features for logged in users

Last updated: July 26, 2018
Last updated: July 26, 2018

Your community activity usually begins on the community homepage. If you are a logged in
user, you see different information than non-logged in users. Your organization can
customize the homepage.

Note:  The screenshot shows the community homepage with the Community
Service Portal header menu configured. It is not enabled by default. For more
information, see Configure Community Service Portal header menus.
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Community homepage for logged in users
No. UI component Description
1 Community announcement View announcements targeted

to the entire community.

2 Community menu Navigate to all forums and all
topics and other quick links.

3 Community profile menu Click your profile photo and
choose from the following
options.

4 Search Enter a search term. You can
enter a keyword to use the type-
ahead search or enter one or
more words to view all search
results.

5 Browse community forums Click the + icon to view up to
eight available forums.
Click View all Forums to go to
the Forums list page and search
for the forum you require.

6 Have a question? Click here to
start typing

Contribute to the community by
posting a question.

7 Content List, Activity Feed Toggle between the Content List
and Activity Feed. You can filter
according to content type,
forum, and most recent or
popular.

• Content List: Lists all content
added to the community.
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No. UI component Description
• Activity Feed: Lists all activity

in the community based on
your posts and subscriptions.
All activities per content item
are grouped. Only the most
recent activity is listed per
content item. For example, an
upvote to a question.

• To view all activity associated
with a content item, click the
content item. All activities,
regardless of your
subscriptions, are displayed.

8 Question filter Filter by question to view
solved, unsolved, and unreplied
questions.

9 Post Content Click Question, Blog, Video,
Document, or Event to add your
content and assign it to a forum.

Note:  The content
options are
displayed according
to the permissions
you are assigned in
the forum.

10 View Leaderboard View the leaderboard to find
community experts on specific
forums or topics.

11 Topics Click a topic to navigate to a
particular topic.

12 Show More View more content or activity in
the community.

Navigating the activity feed

Last updated: July 26, 2018
Last updated: July 26, 2018

The activity feed provides a central place for community users to view information and
interact. It lists the most recent activity in the community based on your network, posts, and
subscriptions. You can reply, comment, and give feedback directly from the activity feed.
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Activity feed
No. UI component Description
1 Badges View the most recent badge you

have earned for your
achievements or areas of
expertise within the community.

2 Levels View the most recent reputation
level you have earned in the
community as a result of points
accumulated.

3 Content added by another user View the most recent
contributions by another user
that you are following or content
that you have subscribed to.

4 Reply Reply to a question or another
reply.

5 Content added by you View the most recent content
that you created in the
community.

6 Feedback Provide feedback on content
that you find useful. There are
four supported types of content
feedback: comment, upvote,
helpful, and mark as correct
answer.

Navigating the forum homepage

Last updated: July 26, 2018
Last updated: July 26, 2018

While in a forum, you can navigate the forum homepage and perform tasks, such as posting
content.
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Forum homepage
No. UI component Description
1 Forum name and description Displays the name and

description of the forum. Click
Show more to read more of the
description.

2 Subscribe Subscribe to content in the
community.

3 Post Content Click Question, Blog, Video,
Document, or Event to add your
content and assign it to a forum.

Note:  The content
options are
displayed according
to the permissions
you are assigned in
the forum.

4 Have a question? Click here to
start typing

Contribute to the community by
posting a question.

5 Question filter Filter by question to view
solved, unsolved, and unreplied
questions.

6 Content List View content posted in the
community. You can filter
according to content type and
most recent or popular.

7 Post Content Click Question, Blog, Video,
Document, or Event to add your
content.

8 Announcements View forum-specific
announcements.

9 Sub Forums Displays the subforums. The Sub
Forums widget is only visible if
the forum contains subforums.

10 Topics Click a topic to navigate to a
particular topic.

11 Leaderboard View the leaderboard to find
community experts for the
forum.

12 Featured Content Displays the top three posts
according to number of views.

Community homepage features for non-logged in users

Last updated: July 26, 2018
Last updated: July 26, 2018

Your community activity usually begins on the Community homepage. If you are a non-
logged in user, you see different information than logged in users. Your organization can
customize the homepage.

August 6, 2018 ©2018 ServiceNow. All rights reserved. 338

ServiceNow | Customer Service Management



August 6, 2018 ©2018 ServiceNow. All rights reserved. 339

ServiceNow | Customer Service Management



Community homepage for non-logged in users
No. UI component Description
1 Community announcement View announcements targeted

to the entire community.

2 Sign up/Login Sign up or log in to the
community.

3 Community menu Navigate to all forums, all topics,
and other quick links.

4 Search Enter a search term. You can
enter a keyword to use the type-
ahead search or enter one or
more words to view all search
results.

5 Browse community forums Click the + icon to view up to
eight available forums.
Click View all Forums to go to
the Forums list page and search
for the forum you require.

6 Question filter Filter by question to view
solved, unsolved, and unreplied
questions.

7 Content List View content posted in public
forums in the community. You
can filter according to content
type, forum, and most recent or
popular.

8 Why Join? View some of the advantages of
joining the community.

9 View Leaderboard View the leaderboard to find
community experts on specific
forums or topics.

10 Ask a Question Click Ask a Question and a
message appears indicating that
you must be a logged-in user to
perform this action. You can
Login/Sign Up directly from
here.

11 Topics Click a topic to navigate to a
particular topic.
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No. UI component Description
12 Show More View an expanded list of content

available in the community.

Self-register to a community

Last updated: July 26, 2018
Last updated: July 26, 2018

Once you have accessed a public forum and decided to join the community, you can self-
register by signing up and accepting the community Terms and Conditions.

Before you begin

Role required: none

About this task

Every community user has to have a community account. Existing users who access a
community for the first time have to accept the Terms and Conditions. An account is created
once the Terms and Conditions have been accepted. New users sign up to the community
and accept the Terms and Conditions.

If the community Terms and Conditions are updated, all community users are prompted to
review and accept them when they log in the next time.

Procedure

1. If you are a new user, navigate to the community homepage.
a. Click Sign up/Login.

The Sign Up screen opens.
b. Fill out the fields on the Sign Up form.

Sign Up form
Field Description
Email address The email address to send the email

validation to.

Username A user name for your account.

First Name Your first name.

Last Name Your last name.

Phone Number Your phone number.

Password A password for your account.

Confirm Password A confirmation of your password.

I agree to the Community Terms and
Conditions

A check box to agree to the community
Terms and Conditions.

c. Click Sign Up.
An email is sent to the email address you entered.

d. Open the email and click the validation link.
e. Click the Click here to login message.
f. Log in with your user name and password.

The Welcome pop-up opens.
g. Click one of the following options.
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Option Description

Set up Community Profile Edit your community profile.

Set up Preferences Edit your notification and subscription settings.

2. If you are an existing user, but visiting the community for the first time, click any
community page.
a. If required, change your Display Name on the Setting up your account pop-up.
b. Select the check box to agree to the community Terms and Conditions.

The Welcome pop-up opens.
c. Click one of the following options.

Option Description

Set up Community Profile Edit your community profile.

Set up Preferences Edit your notification and subscription settings.

Search the community

Last updated: July 26, 2018
Last updated: July 26, 2018

Enter a keyword to use the type-ahead search on the Community homepage or enter one or
more words to view all search results.

Before you begin

Role required: sn_communities.community_user

Procedure

1. Navigate to the community homepage.
2. Press the Space key to use the type-ahead search and enter a keyword in the Search

Community field.
3. Choose from the following options.

a. Click a content item that matches your search.
b. To enter your question, blog, or video if no matching content is displayed, click Ask

the Community.
c. To display all search results, click View all Results.

4. Alternatively, enter one or more keywords in the Search Community field and press the
Enter key.
A list of matching search results is displayed.

• Refine your search results

Refine your search results to narrow down the content displayed.

• Sort your search results

Sort your community search results to narrow down the content displayed.

Refine your search results

Last updated: July 26, 2018
Last updated: July 26, 2018

Refine your search results to narrow down the content displayed.
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Before you begin

Role required: sn_communities.community_user

Procedure

1. Navigate to the community homepage.
2. Enter a keyword in the Search field.
3. From the search results page, choose from the following options.

• To restrict results to one content type, click a Content Type. To reverse this action,
click the x icon of the corresponding item. To remove all restrictions, click Clear All.

• Select any item from the Forums, Topics, or Authors fields to filter by forum, topic,
or author. You can add multiple forums, topics, and authors and click anywhere on
the screen to display the results.

• To filter by the time period that the content was posted, click any Last Updated
item.

• Click the – icon of any category to collapse the category and save space. Click the +
icon to restore a collapsed category.

Sort your search results

Last updated: July 26, 2018
Last updated: July 26, 2018

Sort your community search results to narrow down the content displayed.

Before you begin

Role required: sn_communities.community_user

About this task

The search results are sorted according to Relevance by default.

Procedure

1. Navigate to the community homepage.
2. Enter a keyword in the Search field.
3. To display the most recent results, click Sort By: Newest.

The results are displayed in descending order.
4. To display the results in ascending order, click Newest.

Use a community profile

Last updated: July 26, 2018
Last updated: July 26, 2018

The community profile displays an overview of a user's personal information as well as their
contributions, network, achievements, expertise, and events they are attending. You can
view and edit your own profile. You can also view another user's profile and perform actions,
such as following them or reporting inappropriate content.

Before you begin

Role required: sn_communities.community_user
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Procedure

Perform one or more of the following tasks from the community profile.

• Manage your community profile

View and edit your own community profile, which displays your contributions, network,
achievements, expertise, and events you are attending.

• View another user's community profile

View another user's community profile to see their contributions, network, expertise, and
so on. You can also manage your network by following and unfollowing other community
users.

• Follow a community user

Manage your network by following other community users and tracking their activity in
the community.

• Edit your community profile photo and personal information

You can change your community profile photo and edit your personal information.

• Edit your community profile display settings

Edit your display settings to determine who can view each profile section.

• Report a community profile

Report a community profile to alert community moderators that there is offensive or
inaccurate information in the profile.

Manage your community profile

Last updated: July 26, 2018
Last updated: July 26, 2018

View and edit your own community profile, which displays your contributions, network,
achievements, expertise, and events you are attending.

Before you begin

Role required: sn_communities.community_user

About this task

There are two ways of accessing your community profile.

Procedure

1. From the Community homepage, perform one of the following actions.
• Click the Community menu and then Profile.
• Click your name or profile photo and then Community Profile.

2. View the sections on your community profile.
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Community profile
Section Description
Profile header An overview of your personal information.

• Click Edit Profile to change your profile
photo and edit your personal information.

• Click the ... icon and then Display Settings
to set your display settings and determine
who can view which sections of your
profile.

If the gamification feature is enabled, the profile
header includes your current gamification
achievements, including:

• The top three badges that you have been
awarded

• The total number of points that you have
earned

• The current level that you have achieved
based on your point total (for example,
Enthusiast or Champion)

Content tab An overview of the published and draft content
you have created and the content you have
bookmarked.

• Authored: Content you contributed. You
can select the content type and the forum,
and sort by state.

• Drafts: Content you contributed that is in
draft state. You can select the content type
and the forum. Open a draft to publish it.

Note:  You can only save content in
draft for blogs and events.

• Bookmarks: Content that you have
bookmarked. You can select the content
type, the forum, and sort by recent or
oldest. You can also remove bookmarks.

Activity tab The most recent actions performed by you in
the community, for example, commenting on a
post or providing feedback.

Network tab A record of your network in the community.
• Followers: The users that are following you.
• Following: The users that you are following.
• Click Follow to start following a user, who

is following you.
• Point to Following and click Unfollow to

stop following a user.

Achievements tab An overview of your gamification
achievements.

• Levels: A list of the available levels that you
can achieve, including the starting point
value, with your current level highlighted in
blue.

• Badges: A list of the badges that you have
been awarded as well as available badges.
Awarded badges appear at the top of the
list and available badges appear below.
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Section Description
You can filter this list to view awarded
badges or all badges.

• Points: A history of the points that you
have earned and the activities performed
that earned the points. This information
also includes the forum in which the
activity was performed. This list includes
your last 50 activities. Click Show more to
display additional pages.

Events tab A list of events that you created, are attending,
or past events you have attended. Click an
event to view the event details.

Forum Expertise A display of your expertise at forum level. You
can view your level within the forum and the
number of points you have gained through
contributing to that forum. Click the
information icon to view the point ranges
required to reach each forum level.

Topic Expertise A display of your expertise at topic level. You
can view your level within the topic and the
number of points you have gained through
contributing to that topic. Click the information
icon to view the point ranges required to reach
each topic level.

Contributions The number of correct answers, blog entries,
questions, and videos you contributed.

View another user's community profile

Last updated: July 26, 2018
Last updated: July 26, 2018

View another user's community profile to see their contributions, network, expertise, and so
on. You can also manage your network by following and unfollowing other community users.

Before you begin

Role required: sn_communities.community_user or sn_communities.admin

Procedure

1. Click the user's name or profile photo for the community profile that you want to view.
2. View the sections of the user's community profile.

Community profile
Section Description
Profile header The sections of the community profile that the

user has made visible.
• To start following the user, click Follow.
• To report any inappropriate content on the

user's community profile, click the ... icon
and then Report Profile.

• To assign a user points for a specific
contribution to the community as a
community administrator, click the ... icon
and then click Assign Points.

August 6, 2018 ©2018 ServiceNow. All rights reserved. 346

ServiceNow | Customer Service Management



Section Description
• To hide content from the community until

it is corrected as a community
administrator, click Display Settings You
can also click Ban User to ban a user from
creating or editing content.

Content • Authored: Content that the user
contributed.

• Drafts: Content the user contributed that is
in draft state.

Note:  Only community
administrators can view
draft content of another
user.

• Bookmarks: Content that the user has
bookmarked.

Activity The most recent actions performed by the user
in the community, for example, commenting on
a post or providing feedback.

Network • Followers: The users that are following the
user's community profile.

• Following: The users that the community
profile user is following.

• You can manage your own network from
another user's profile. To start following a
user, click Follow. To stop following a user,
point to Following and click Unfollow.

Achievements An overview of the user's gamification
achievements.

• Levels: A list of the available levels that the
user can achieve, including the starting
point value, with the user's current level
highlighted in blue.

• Badges: A list of the badges that have
been awarded to this user.

• Points: A history of the points that this user
has earned and the activities performed
that earned the points. If the user has
earned points in a forum that you do not
have access to, the name of the forum is
replaced with Private forum.

Events A list of events that the user has created, is
attending, or past events that the user has
attended. Click an event to view the event
details and respond.

Forum Expertise A display of the user's expertise at the forum
level. You can view their level within the forum
and the number of points they have gained
through contributing to that forum. To view the
point ranges required to reach each forum
level, click the information icon.

Topic Expertise A display of the user's expertise at the topic
level. You can view their level within the topic
and the number of points they have gained
through contributing to that topic. To view the
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Section Description
point ranges required to reach each forum
level, click the information icon.

Contributions The number of correct answers, blog entries,
questions, and videos that the user has
contributed.

Follow a community user

Last updated: July 26, 2018
Last updated: July 26, 2018

Manage your network by following other community users and tracking their activity in the
community.

Before you begin

Role required: sn_communities.community_user

About this task

There are several ways of following users in the community.

Procedure

1. From the Communities homepage, perform one of the following actions.
• Click your profile name or photo.
• Click your profile name or photo and then the Network tab.
• Click another user's profile name or photo and then the Network tab.

2. Click Follow for every user you want to follow.
The state changes to Following. Your Activity Feed is updated with the activity those
users have taken in the community.

3. (Optional) Point to Following and click Unfollow to stop following a user.

Edit your community profile photo and personal information

Last updated: July 26, 2018
Last updated: July 26, 2018

You can change your community profile photo and edit your personal information.

Before you begin

You can only edit your community profile if you are logged in to the community.

Role required: sn_communities.community_user

About this task

There are two ways of accessing your community profile.

Procedure

1. From the Community homepage, perform one of the following actions.
• Click the Community menu and then click Profile on the Community homepage.
• Click your name or profile photo and then click Profile.
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2. Click Edit Profile.
3. Click Change Profile Photo.

A file system upload is initiated. Choose an image in .png or .jpg format.
4. On the form, fill in the fields.

Profile Fields form
Field Description
Country The country in which you work or reside.

Title Your job title.

Phone The telephone number where people can reach
you.

Company Name of your employer.

Email Your email address.

Note:  Use the email address used in
your instance profile or the
reset password features cannot
be used.

State The state, province, or jurisdiction in which you
work or reside.

City The city in which you reside.

Display name Your name as you want others to see it.

Bio A short description about yourself.

5. Click Save.

Edit your community profile display settings

Last updated: July 26, 2018
Last updated: July 26, 2018

Edit your display settings to determine who can view each profile section.

Before you begin

Role required: sn_communities.community_user, sn_communities.admin or
sn_communities.moderation_admin

About this task

You can edit your own display settings for your community profile. If a community
administrator finds inappropriate content on your profile, they can edit your display settings
to hide the content from the community until it is corrected.

Procedure

1. On the community homepage, click the Community menu and then click Community
Profile.

2. Click the ... icon and then click Display Settings.
3. Open the choice lists and select display settings for any section.
4. Choose the privacy level to apply.
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Privacy levels
Privacy level Description
Everyone Visible to all users, including non-logged in

users.

Only me Visible to yourself and administrators.
If an administrator finds inappropriate content
on your profile, the administrator can change
the display settings to Only me until the
content is modified.

You receive an email notification detailing the
display settings that were modified for which
sections.

Update the content and adjust the display
settings accordingly.

Everyone after logging in Visible to all users who access the community
after logging in.

Followers Visible to users who are following your profile.

5. Click Save Settings.

Report a community profile

Last updated: July 26, 2018
Last updated: July 26, 2018

Report a community profile to alert community moderators that there is offensive or
inaccurate information in the profile.

Before you begin

Role required: sn_communities.community_user

Procedure

1. Click the name or photo of the user to report.
2. Click the ... icon and select Report Profile.
3. From the list, select the reason you are reporting the user and add Additional

Comments.
4. Click Submit.

• A confirmation message indicating that the abuse report has been received and will
be reviewed is displayed.

• A moderation task is created and assigned to a moderator for resolution.

Community subscriptions

Last updated: July 26, 2018
Last updated: July 26, 2018

Using subscriptions, you can choose specific areas of interest. Your activity feed and
notifications are personalized according to your subscriptions.
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Subscription types
Subscription type Description/Features
Subscription

• Subscribe or unsubscribe to forums, topics, and
community content (questions, answers, blogs,
and video).

• Auto-subscribe: Whenever you post content,
you are automatically subscribed to the content
itself. You are also automatically subscribed
when you post a reply or a comment.

Activity feed
• Displays activities based on your subscriptions

with the most recent at the top.

Notification settings
• Manage your subscriptions using Notification

Settings.
• For each of your subscriptions, set email

notifications using Notification Preferences.

• Subscribe to content

Subscribe to forums, topics, questions, blogs, and videos. You are automatically
subscribed to content that you create.

• Set notification preferences

Set notification preferences to receive updates via email on the content that you are
following.

Subscribe to content

Last updated: July 26, 2018
Last updated: July 26, 2018

Subscribe to forums, topics, questions, blogs, and videos. You are automatically subscribed
to content that you create.

Before you begin

Role required: sn_communities.community_user

Procedure

1. To find the content of interest, use the search field or navigation to find the content of
interest, such as a forum, topic blog, or video.

2. On the content page, click Subscribe.
• A confirmation message indicating that you have successfully subscribed to the

content is displayed at the top of the screen.
• You receive a notification whenever there is an update to this content, for example,

an answer to a question or a comment on a blog entry.
• You can view updates in your activity feed.

3. (Optional) To remove a subscription, return to the content and click Subscribed. When
you point to this option, it becomes Unsubscribed.
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You can also view your subscriptions and enable or disable them from the Community
homepage by clicking your photo or name and clicking Notification Settings. Toggle
Receive Notifications to turn all notifications on or off.

Related Tasks

• Set notification preferences

• Set notification preferences

Related Concepts

• Community subscriptions

Set notification preferences

Last updated: July 26, 2018
Last updated: July 26, 2018

Set notification preferences to receive updates via email on the content that you are
following.

Before you begin

Role required: sn_communities.community_user

About this task

The Communities application separates the notion of subscriptions from notifications. It is
possible to subscribe to an item and disable notifications. You can also turn off all
notifications.

Procedure

1. On the Community homepage, click Community > Notification Settings.
2. Click Notification Preferences.
3. To manage your notifications in those areas, choose your category, such as Forums,

Topics, Blogs, or Videos.
Choose the Network category and then choose View Network to view the community
users, who are following you, or the community users that you are following.

4. In the Email column, toggle any item that should or should not send updates.
5. (Optional) To turn all notifications on or off, toggle Receive Notifications.

Related Tasks

• Subscribe to content

Request membership to a forum

Last updated: July 26, 2018
Last updated: July 26, 2018

You must be a registered member of the community to request membership to a forum that
is marked for membership only.

Before you begin
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Role required: sn_communities.community_user

Procedure

1. Perform either one of the following actions:
• Navigate to Community > Homepage. Open Browse Community Forums and then

select the forum.
• Navigate to Community > All Forums and then select the forum in the list. If you

requested membership earlier, the status of your request appears.
2. Click Request Access.

If approval is required, Status changes to Requested. You receive an approval or
rejection email. If approved, you are immediately subscribed to the forum and Status
changes to Private Member.

If no approval is required, the request is auto-approved and Status changes to Private
Member.

3. To cancel a request, point to the Requested status and click Cancel.
4. To leave a forum, click ... within the forum and then select Leave Forum.

Status changes to Request Access.

Accept an invitation to join a forum

Last updated: July 26, 2018
Last updated: July 26, 2018

An invitation to join a forum is sent as an email message. The method that you use to accept
an invitation depends on whether you are a registered community user.

Before you begin

Role required: none

Procedure

1. Open the email invitation and click Join Forum.
• If you are a registered and logged-in community user, the forum opens.
• If you are a registered community user but have not accepted the community Terms

& Conditions, a message appears to accept the Terms & Conditions. The forum
opens after you accept the Term & Conditions.

2. If the login page appears, take one of the following actions:

Option Description

If you are a registered user and not logged in. Enter your login credentials to access the
forum.

If you are not a registered user. a. Click Sign Up on the login page.
b. Enter your email address, a user name, and

a password to create a community
account.

c. The system sends a verification email.
Click the verification link in the email to
confirm your credentials.

d. Reopen the email invitation and click Join
Forum.
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Forum membership is auto-approved and you are subscribed to the forum. Status
changes to Leave Forum.

Post and respond to content in the community

Last updated: July 26, 2018
Last updated: July 26, 2018

Post and respond to content in the community to get answers or share information.

Before you begin

Role required: sn_communities.community_user

Procedure

Perform one or more of the following tasks from the community homepage.

• Ask a question in the community

Ask a question in a forum to get an answer from other community users.

• Reply to a question

Reply to a question or another reply.

• Post a blog

Create a blog post and publish it immediately or save it as a draft.

• Post a video

Post a video in a forum.

• Comment on a blog or a video

Comment on a blog or a video or comment on another comment.

• Post a document in a forum

If you have the proper permissions in a forum, you can share a document with colleagues,
experts, or other community users. You can associate the document with as many topics
as needed.

• Community events

Create, manage, and participate in events to encourage engagement across the
community.

• Bookmark community content

You can bookmark your favorite questions, blogs, videos, documents, and events. You
cannot bookmark content in draft state or replies or comments.

• Provide feedback on community content

Provide feedback on content that you find useful.

Ask a question in the community

Last updated: July 26, 2018
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Last updated: July 26, 2018

Ask a question in a forum to get an answer from other community users.

Before you begin

You can only ask a question in a forum if you have been assigned the correct permissions in
the forum.

Role required: sn_communities.community_user

About this task

If you ask a question, you can edit or delete it. If you created the question and reply with an
answer, your answer is labeled Author.

There are three ways of asking questions in Communities.

Procedure

1. From the Communities homepage, perform one of the following actions.
• Locate the forum to ask a question in, click its name, and then click Have a question?

Click here to start typing. Type-ahead search shows related posts. Click to open a
related post in another page.

• Locate the forum to ask a question in and click Post > Question.
• If you do not see a forum, click Have a question? Click here to start typing.

2. Click Question.
3. On the form, fill in the fields.

Ask a question form
Field Description
Question Your question.

Forum Forum to add the question to.

Note:  If you created the question by
clicking a forum from the
Communities homepage, this
forum is automatically entered
in this field.

Topic (s) (optional) Topic to add the question to.

Note:  You can repeat this previous
step for as many topics as you
want. If you change your mind
about a particular topic, click its
corresponding xicon.

Description Content of the question.
To insert an image, click the Insert Image

button ( ), navigate to the .png or .jpg file,
and then click Open.
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Field Description
To insert a video, click the Insert Video button

( ), enter the video URL, and then click
Upload.

Add attachments To attach a file, click Add attachments and then
drag the file into the Attach Document box or
click the box and then navigate to the file.

• You can add up to three attachments.
• File types supported are PPT, PPTX, XLS,

XLSX, DOC, DOCX, TXT, PDF, PNG, BMP,
JPG, JPEG, GIF, ZIP.

• Maximum file size is 2 MB.
• Supported file types are listed.
• Click the X icon to delete an attached file.

Note:  Your system administrator may
have set a limit on the total
number of attachments allowed
across the community.

When you click Add, your attachments are
added and displayed in the question. If a user
attaches a file to your question, you receive an
email notification.

4. Click Post.
The question is added and is available to users in this forum. You are automatically
subscribed to this question. When there is a reply, you receive a notification.

Community users who are subscribed to the forum receive a notification that content
has been posted. Activity and content feeds are updated accordingly.

Note:  If you are a user whose content is due to be moderated, the content is
not posted until approved by a community moderator.

Reply to a question

Last updated: July 26, 2018
Last updated: July 26, 2018

Reply to a question or another reply.

Before you begin

You can only reply to a question or another reply in a forum if you have been assigned the
correct permissions in the forum.

Role required: sn_communities.community_user

Procedure

1. To find the question or a reply to respond to, use search or navigation from the
community homepage.
You can also reply to a question or a reply from the activity feed on the homepage.

2. Click Reply.
3. Enter your reply.
4. If required, you can add an image to your reply.
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a. Click the Insert image-editing control.
b. Choose your .png or .jpg format image file.
c. Click Open.

5. If required, you can add a video to your reply.
a. Click the Insert Video button ( )
b. Enter the video URL.
c. Click Upload.

6. You can add attachments to your post.
a. Click Add Attachments.
b. Drag your file into the Add Attachments box or click Click to Upload.
c. Click Add.

Your attachment is added and displayed in your post. If a user attaches a file to your
content, you receive an email notification.

Note:  • You can add up to three attachments per post.
• The maximum file size per attachment is 2 MB.
• Your system administrator may have set a limit on the total

number of attachments allowed across the community.
• File types supported are PPT, PPTX, XLS, XLSX, DOC, DOCX, TXT,

PDF, PNG, BMP, JPG, JPEG, GIF, ZIP.

7. Click Reply.
The reply is added below the question and any other replies. The reply is available to
users in this forum.

Community users who are subscribed to the forum receive a notification that content
has been posted. Activity and content feeds are updated accordingly.

Note:  If you are a user whose content is due to be moderated, the content is
not posted until approved by a community moderator.

Post a blog

Last updated: July 26, 2018
Last updated: July 26, 2018

Create a blog post and publish it immediately or save it as a draft.

Before you begin

You can only post a blog in a forum if you have been assigned the correct permissions in the
forum.

Role required: sn_communities.community_user

About this task

You can add attachments to your blog. If you create a blog, you can edit or delete it. If you
comment on the blog that you create, your answer is labeled Author.

Procedure

1. Locate the forum to create a blog in and click its name.
2. Click Post and then click Blog.
3. On the form, fill in the fields.
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Post a blog form
Field Description
Blog Title Title for your blog.

Forum The forum to add the blog to.

Note:  If you created the blog by
clicking a forum from the
Community homepage, this
forum is automatically entered
in this field.

Topic (s) (optional) Topic to add the blog to.

Note:  You can repeat this step for as
many topics as you want. If you
change your mind about a
particular topic, click its
corresponding xicon.

Description Content of the blog.
To insert an image, click the Insert Image

button ( ), navigate to the .png or .jpg file,
and then click Open.

To insert a video, click the Insert Video button

( ), enter the video URL, and then click
Upload.

Add attachments To attach a file, click Add attachments and then
drag the file into the Attach Document box, or
click the box and then navigate to the file.

• You can add up to three attachments.
• File types supported are PPT, PPTX, XLS,

XLSX, DOC, DOCX, TXT, PDF, PNG, BMP,
JPG, JPEG, GIF, ZIP.

• Maximum file size is 2 MB.
• Supported file types are listed.
• Click the X icon to delete an attached file.

Note:  Your system administrator may
have set a limit on the total
number of attachments allowed
across the community.

When you click Add, your attachments are
added and displayed in the blog. If a user
attaches a file to your blog, you receive an
email notification.

4. Complete one of the following actions to save your blog.

To Do this

Save as Draft Review and publish your blog later. The blog
appears as a draft on your profile page under
Content > Drafts.
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To Do this

Note:  Community and forum
administrators can edit, delete,
and publish drafts. If a
community or forum
administrator edits, deletes, or
publishes your draft, you
receive an email notification.

From your profile page, you have the following
options.

a. To review your blog before publishing,
click Edit.

b.
• Click the … icon (More options) and

then Publish.
• Click ... (More options) and then

Delete.

Post Publish your blog directly.

Community users who are subscribed to the
forum receive a notification that content has
been posted. Activity and content feeds are
updated accordingly.

Note:  If you are a user whose content
is due to be moderated, the
content is not posted until
approved by a community
moderator.

Post a video

Last updated: July 26, 2018
Last updated: July 26, 2018

Post a video in a forum.

Before you begin

You can only post a video in a forum if you have been assigned the correct permissions in
the forum.

Role required: sn_communities.community_user

About this task

You can post videos on their own or add them to a question or a blog. If you are the creator
of the video or a community administrator, forum administrator, forum moderator, or
community moderator, you can edit the videos once posted.

Procedure

1. While in a forum, click Post > Video.
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2. On the form, fill in the fields.

Post a video form
Field Description
Click here to Insert a Video • URL of your video.

• Click Upload. The video is added to your
post.

• To edit and replace the current video with
another one, click Select a different Video.

Video Title Title for the video.

Forum Read-only. The forum is automatically entered
in this field.

Topic (s) (optional) Topic to add the video to.

Note:  You can repeat this step for as
many topics as you want. If you
change your mind about a
particular topic, click its
corresponding xicon.

Description (optional) Description for your video.

3. Click Post.
4. (Optional) If you have permission to edit or delete the video, click a video, click the ...

icon, and then click Edit or Delete.
Once a video is uploaded, other community users can comment on it, give feedback,
subscribe to the video, bookmark it, and report any inappropriate content in the video.

Comment on a blog or a video

Last updated: July 26, 2018
Last updated: July 26, 2018

Comment on a blog or a video or comment on another comment.

Before you begin

You can only comment in a forum if you have been assigned the correct permissions in the
forum.

Role required: sn_communities.community_user

About this task

If you create a comment, you can edit or delete it. If you created the blog or video and add a
comment, your comments are labeled Author.

Procedure

1. To find the blog or video entry to comment on, use the search field or navigation
2. Click Comment, and enter your answer.
3. You can add attachments to your post.

a. Click Add Attachments.
b. Drag your file into the Add Attachments box or Click to Upload.
c. Click Add.
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Your attachment is added and displayed in your post. If a user attaches a file to your
comment, you receive an email notification.

Note:  • You can add up to three attachments per post.
• The maximum file size per attachment is 2 MB.
• Your system administrator may have set a limit on the total

number of attachments allowed across the community.
• File types supported are PPT, PPTX, XLS, XLSX, DOC, DOCX, TXT,

PDF, PNG, BMP, JPG, JPEG, GIF, ZIP.
• If the attachment size is large or you have a slow connection, a

progress indicator is displayed.

4. Click Comment.
The comment is added below the blog or video entry and any other comments. The
answer is available to users in this forum.

Community users who are subscribed to the forum receive a notification that content
has been posted. Activity and content feeds are updated accordingly.

Note:  If you are a user whose content is due to be moderated, the content is
not posted until approved by a community moderator.

Post a document in a forum

Last updated: July 26, 2018
Last updated: July 26, 2018

If you have the proper permissions in a forum, you can share a document with colleagues,
experts, or other community users. You can associate the document with as many topics as
needed.

Before you begin

Role required: sn_communities.community_user

Procedure

1. While in a forum, click Post > Document and then fill in the form:

Document title Enter a descriptive title for the document.

Forum Read-only. The current forum is selected.

Topics Select a topic from the list. Repeat for as many
topics as needed.

Attach document To attach a file, drag the file into the Attach
Document box or click the box and then
navigate to the file.

• You can attach only one document.
• Maximum file size is 5 MB.
• File types supported are PPT, PPTX, XLS,

XLSX, DOC, DOCX, TXT, PDF, PNG, BMP,
JPG, JPEG, GIF, ZIP.

• Click the X to delete an attached file.
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Note:  Your system administrator may
have set a limit on the total
number of attachments allowed
across the community.

Description Enter a useful description for the document.

2. Click Post.
The document appears in the forum. The author of a document can edit or delete the
post.

Community users who are subscribed to the forum receive a notification that content
has been posted. Activity and content feeds are updated accordingly.

Note:  If you are a user whose content is due to be moderated, the content is
not posted until approved by a community moderator.

Community events

Last updated: July 26, 2018
Last updated: July 26, 2018

Create, manage, and participate in events to encourage engagement across the community.

Before you begin

Role required: sn_communities.admin or sn_communities.community_user

Procedure

Perform one or more of the following tasks.

• Post a community event

You can create a community event that other community users, colleagues, or experts can
register for and attend.

• View and participate in a community event

You can view details for published events and perform tasks such as responding to the
event or adding it to your calendar.

• View the community events landing page

The Events landing page provides an overview of all events that you have access to in the
community. You can filter events, view your status for the event, see how many other
community users are attending an event, and so on.

• Manage a community event

View additional response information on the event, edit or delete events, and download a
guest list.

Last updated: July 26, 2018
Last updated: July 26, 2018

You can create a community event that other community users, colleagues, or experts can
register for and attend.
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Before you begin

You must have permission to create events (Event Write and Comment Write) and be a
member of the forum to create the event in. The Event content type must be active in the
forum for the event.

Role required: sn_communities.community_user

Procedure

1. While in a forum, click Post > Event and then fill in the form.

Create an event
Field Description
Event title A title for your event.

Forum Read-only. The forum is automatically entered
in this field.

Topic(s) optional A topic to add the event to.

Note:  You can add as many topics as
needed. To remove a topic, click
the x.

Set guest limit / Total allowed Select the check box to specify the maximum
number of guests that can attend in the Total
allowed field.
When the limit is reached, additional users are
added to the wait list.

Display guest list to the public Select the check box to enable forum members
to view the guest list for the event.

This is an online event Select the check box to specify the Web URL
for an online event.

Clear the check box to specify the Name of
location, Address, City, State, Zip/Postal Code,
and Country for the event.

Date and time The date and time of the event. Date must be in
the future.

Note:  If you change the Duration, the
End Time is auto-updated.

Click Change time zone to set the time zone for
the event. Default: Your local time zone. The
time zone changes according to the time zone
of the user viewing the event.

Duration The duration of the event.

Note:  If you change the End Time, the
Duration is auto-updated.

Default: 30 minutes
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Field Description
Send reminder to guests one day before the
event

Select the check box to send an email reminder
one day before the event to all users that
responded Attend.

Description The description of the event.
To insert an image, click the Insert Image

button ( ), navigate to the .png or .jpg file,
and then click Open.

To insert a video, click the Insert Video button

( ), enter the video URL, and then click
Upload.

Add attachments To attach a file, click Add attachments and then
drag the file into the Attach Document box or
click the box and then navigate to the file.

• You can add up to three attachments.
• File types supported are PPT, PPTX, XLS,

XLSX, DOC, DOCX, TXT, PDF, PNG, BMP,
JPG, JPEG, GIF, ZIP.

• Maximum file size is 2 MB.
• Supported file types are listed.
• Click the X to delete an attached file.

Note:  Your system administrator may
have set a limit on the total
number of attachments allowed
across the community.

When you click Add, your attachments are
added and displayed in the event. If a user
attaches a file to your event, you receive an
email notification.

2. Perform one of the following actions:

To Do this

Save as Draft Click Save as Draft to save the event as a draft
on your profile page under Content > Drafts.

Note:  Community and forum admins
can edit and publish drafts. If a
community or forum admin
edits, deletes, or publishes the
draft, you receive an email
notification.

From your profile page, you have the following
options.

a. Click Edit to review the event before
publishing.

b.
• Click … and then click Publish.
• Click ... and then click Delete.

Publish Click Publish to publish the event directly. As
the author, you can edit or delete the event.
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To Do this
Community users who are subscribed to the
forum receive a notification that content has
been posted. Activity and content feeds are
updated accordingly.

Note:  If you are a user whose content
is due to be moderated, the
content is not posted until
approved by a community
moderator.

Last updated: July 26, 2018
Last updated: July 26, 2018

You can view details for published events and perform tasks such as responding to the event
or adding it to your calendar.

Before you begin

You must be a registered member of the community and have permission to read events
(Event Read and Comment Write) to be able to respond to events.

Role required: sn_communities.community_user

Procedure

1. From the community homepage, perform one of the following actions:
• Navigate to the Content List.
• Navigate to the Activity Feed.
• Navigate to a forum or topic.
• Navigate to the community profile of another user and click the Events tab.
• Click Community > Events.

2. Click an event.
The Event details page displays the following information.

Event header • View the name of the event, who created
it, and when.

• If the event organizer chose to display the
guest list to the public, you can view how
many community users have responded
Attending or Maybe and click the numbers
to see the names.

• If the guest list is private, you can view
how many community users have
responded Attending or Maybe, but you
cannot see the names.

• View the number of spots still available in
the event or your position on the waitlist.

Event overview • When and where the event is taking place.
• Description of the event.
• Topics associated with the event.
• Comments on the event.
• Number of times the event has been

viewed.
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Upcoming Events Next five upcoming events.

Popular Past Events Top five most popular past events and the
number of community users that were
interested in the event. Interested community
users include users who either attended or
were waitlisted for the event.

3. (Optional) Click Attending, Maybe, or Declined to view or search the guest list and their
responses.

4. (Optional) Click Subscribe to subscribe to the event and receive notifications when the
event is updated.
If your response is Attending or Maybe, you are auto-subscribed to the event.

5. (Optional) Click Respond to indicate whether you are attending or maybe attending the
event, to decline, or to add yourself to the waitlist.

• You can also respond to an event directly from the Activity Feed.
• If the event is full, a message stating that you can join the waitlist is displayed. The

Attend option replaces Waitlist. If you are waitlisted, your position on the waitlist is
displayed. Once a position becomes available in the event, you move up in the list.

Depending on your selection, the status changes to either Attending, Maybe, Declined,
or Waitlisted. You can update your response as needed.

• If an event creator or community admin deletes an event and you responded Yes,
Waitlist, or Maybe, you receive an email notification based on your notification
preferences.

• If an event is updated, and you responded Yes, Waitlist, or Maybe, you receive an
email notification based on your notification preferences.

6. (Optional) Click ... to perform one of the following actions.

Option Description

Add to calendar Downloads an .ics file that you can add to your
calendar. The file includes the title and
description of the event, the event location,
start and end dates, the event time, and any
attachments. If guests have chosen not to
share details, the information is not displayed
in the file.

Bookmark The event appears in your bookmarks list on
your profile page. Click Remove Bookmark to
delete a bookmark.

Report content Click Report content to report inappropriate
content in the event.

Last updated: July 26, 2018
Last updated: July 26, 2018

The Events landing page provides an overview of all events that you have access to in the
community. You can filter events, view your status for the event, see how many other
community users are attending an event, and so on.

Before you begin

Community users must have permission to view events (Event Read).

Role required: sn_communities.community_user

Procedure
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1. Navigate to Community > Events.
The Events landing page displays a list of all events that you have access to and a list of
the five most popular past events.

2. Filter the list for events that you created or according to attendance status, by forum,
and by date.
The list displays the following information.

• The event creator, last update, and location.
• Your status, if you have already responded to the event.
• The number of community users who are interested in the event. Interested

community users include users who are attending or have been waitlisted for the
event.

• The number of community users who have viewed the event.
3. Click an event to perform tasks related to the event.

Last updated: July 26, 2018
Last updated: July 26, 2018

View additional response information on the event, edit or delete events, and download a
guest list.

Before you begin

You must be a registered member of the community and have permission to read events
(Event Read and Comment Write) to be able to respond to events.

Role required: sn_communities.community_user who created the event or
sn_communities.admin.

About this task

You can access published events from several places within the community.

Procedure

1. From the community homepage, perform one of the following actions.
• Navigate to the Content List.
• Navigate to the Activity Feed.
• Navigate to a forum or a topic.
• Navigate to another user's community profile and click the Events tab.
• Click Community > Events.

2. Click an event.
The Event details page displays the following information.

Event header • View the name of the event, who created
it, and when.

• View how many community users are
attending or maybe attending.

• View how many community users declined
the event.

• View the number of spots still available in
the event or your position on the waitlist.

Event overview • When and where the event is taking place.
• The description of the event.
• The topics associated with the event.
• Comments on the event.

August 6, 2018 ©2018 ServiceNow. All rights reserved. 367

ServiceNow | Customer Service Management



• The number of times the event has been
viewed.

Upcoming Events Shows the next five upcoming events.

Popular Past Events Shows the top five most popular past events
and the number of community users that were
interested in the event. Interested community
users include users who either attended or
were waitlisted for the event.

3. (Optional) Click the ... icon.
4. You have the following options.

Option Description

Edit Click Edit. The Update Event page opens. An
email notification is sent to all community
users who responded Yes, Maybe, or Waitlist.

Delete Click Delete. A warning message appears
asking if you are sure that to delete the event.
An email notification is sent to all community
users who responded Yes, Maybe, or Waitlist.

Add to calendar An .ics file is downloaded that you can add to
your calendar. The file includes the title and
description of the event, the event location,
start and end dates, the event time, and any
attachments. If guests have chosen not to
share their details, the information is not
displayed in the file download.

Bookmark The event appears in your bookmarks list on
your profile page. If you have already
bookmarked the event, you can click Remove
Bookmark.

Report content As a community admin, click Report content to
report inappropriate content in the event.

Download Guest List Download a .csv file of the guest list. View the
file to see the list of community users
attending the event, their RSVP status, and
email address.

Bookmark community content

Last updated: July 26, 2018
Last updated: July 26, 2018

You can bookmark your favorite questions, blogs, videos, documents, and events. You
cannot bookmark content in draft state or replies or comments.

Before you begin

Role required: sn_communities.community_user

Procedure

1. Click the content to bookmark.
2. Click the ... icon and then select Bookmark.

The bookmarked content is added to the Bookmarks tab on your community profile.
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3. To view your bookmarks, perform one of the following actions.
• Navigate to your community profile and then click Content > Bookmarks.
• Click your name or profile photo and then click My Bookmarks.

4. You can search for bookmarks and, if required, select a bookmark and then click Remove
Bookmark.

Provide feedback on community content

Last updated: July 26, 2018
Last updated: July 26, 2018

Provide feedback on content that you find useful.

Before you begin

Role required: sn_communities.community_user

About this task

There are four supported types of content feedback: comment, upvote, helpful, and mark as
correct answer. You can enter feedback directly in the Activity Feed on the Community
homepage or navigate to the content you want to provide feedback on.

Content Feedback
Content feedback Description
Comment Comment on blogs and videos. You can also

comment on a comment. The count of comments
is displayed.

Upvote Upvote questions. The count of upvotes is
displayed.

Helpful Mark answers, blogs, comments, and videos as
Helpful. The count of helpful marks is displayed.

Mark as Correct Answer If you are a community or forum administrator,
community or forum moderator, or the author of
the question, you can mark one answer as Mark
as Correct Answer. There is only one correct
answer for each question. If you later mark a
different answer as correct, the current answer
loses this status.

Procedure

1. From the Community homepage, perform one of the following actions.
• Click a forum and then click the content, for example, a blog or a question.
• Use search and then click the content.
• Navigate to the content on the homepage Activity Feed and provide your feedback

directly from here.
2. Enter your feedback.

The following feedback is displayed.

Community homepage > Activity Feed Feedback on any content that users are
subscribed to.

Community homepage > Content List Feedback entered by other users.

Your Community Profile > Activity tab. Feedback entered by you.
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Note:  The homepage activity feed is not automatically refreshed. If updates
occur while viewing the activity feed, a New Updates Available message
appears. You can click and view all new updates. If you are in the middle
of making a comment and you click New Updates Available, a warning
message appears asking if you want to continue.

Report inappropriate community content

Last updated: July 26, 2018
Last updated: July 26, 2018

Report content to alert community moderators that the content is inappropriate or spam.

Before you begin

Role required: sn_communities.community_user

Procedure

1. Use the search field or navigation to find the content to report.
2. Click the ... icon and then click Report Content.
3. From the list, select the reason you are reporting the content from the list and add

Additional Comments.
4. Click Submit.

A moderation task is created and assigned to a moderator for resolution. Depending on
the moderation settings created for your community, the content may be hidden until a
moderator has reviewed it.

Harvest knowledge from a community

Last updated: July 26, 2018
Last updated: July 26, 2018

Harvest knowledge from a community and create structured knowledge articles from
unstructured discussions around a question.

Before you begin

Knowledge harvesting must be enabled.

Role required: sn_communities.knowledge_harvester, sn_communities.admin, or
sn_communities.moderation_admin

About this task

You can only harvest solved questions with accepted solutions into a knowledge article.

Procedure

1. From the Communities homepage, perform one of the following actions.
• Go to the Content List.
• Click a forum.
• Search for a discussion thread (Question and Answer).

2. Click Question State > Solved to filter for all discussions that can be converted into
knowledge articles.

3. Click a question.
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4. Click the ... icon and then Harvest Knowledge.
5. Fill in the fields on the Harvest Knowledge form.

Harvest Knowledge form
Field Description
Short description The original question is automatically entered in

the Short description field. You can edit the
short description, as required.

Attachments All attachments associated with the question
and accepted solution are automatically added
to the knowledge article. You can add and
remove attachments.

Text The body of the original question and accepted
solution is automatically entered in the Text
field. You can edit the text, as required.

Knowledge base The knowledge base to which the knowledge
article has been added. It is added by default
based on the knowledge base associated to the
forum from which article was harvested. If
required, you can change the knowledge base.

Category The category of the knowledge article. It is
entered by default based on the category
associated to the topic from which the article
was harvested. If required, you can change the
category.

Number A KB (Knowledge Base) number is
automatically assigned to the article. You
cannot edit the Number field.

6. Perform one of the following actions:

To Do this

Publish Click Publish to initiate the workflow
associated with the knowledge base.
A link to the knowledge article is displayed on
the community question from which it was
harvested.

A link to the community question and to the
community profile of the person who
answered the question is displayed in the
knowledge article.

Note:  You can only see the links if you
are a logged-in community user
and have been assigned the
correct permissions in the
forum.

Save Click Save to save the knowledge article as a
draft. To publish the knowledge article at a
later point in time, navigate to the platform UI
and then Knowledge > Articles > Unpublished.

Delete Click Delete to delete the knowledge article
and all records associated with the KB number.
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View a list of questions and create a case

Last updated: July 26, 2018
Last updated: July 26, 2018

To easily view questions that can potentially be converted to cases, the community portal
provides a page with a list of questions created by contacts or consumers.

Before you begin

Role required: sn_customerservice_manager, sn_customerservice_agent,
sn_customerservice.consumer_agent, sn_communities.admin, or a user with the
proxy_case_creator role

About this task

This page displays questions from the forums to which the user has access.

Procedure

1. From the community portal, click Community > Questions to Case to open the list of
questions.
This list includes questions that have been posted by a contact or a consumer and for
which a case has not yet been created.

2. Use the filters on this page to filter the question list:
• View questions for all forums or for the selected forum
• View questions posted within the selected time frame: 7, 15, or 30 days
• Sort by the most recent questions or older questions
• Sort by the question status: all, solved, unsolved, or unreplied

3. To create a case from one of the questions in the list, click a question to open the
question page.

4. Click the overflow icon (...) and then click Create Case to open a Create Case form.
The Create Case action is available if a case has not yet been created from a question.
Once a case has been created, this action is no longer available.
Information from the question is mapped to the fields on the case.

5. Enter any additional information in the fields on the Create Case form. For example, add
Description for the case.

6. If necessary, attach a file to the case.
7. Click Submit.

You are returned to the question content page. The case number appears in the
question header after the case is created. The question author, the customer service
agent or consumer service agent, or any user with the proxy_case_creator role can see
the case number.

The contact or consumer who posted the question can also view the case by navigating
to My Cases on the Customer Service Portal or Consumer Service Portal.

Gamification
Last updated: July 26, 2018
Last updated: July 26, 2018

Encourage users to participate and contribute content in the community by providing
incentives in the form of points, achievement levels, and badges.
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Use the gamification framework to:

• Configure point values associated with specific user activities.
• Define achievement levels based on earned points.
• Create and assign badges to recognize users.

Community administrators can:

• Create rules and configure points that users receive for activities on the community.
• Create tracks to logically separate points assigned in the communities into different areas.
• Create levels in the community where users can achieve expertise or a reputation and then

configure level ranges within each level definition.
• Create badges to award to users for different achievements.

Community users can:

• Perform activities and accrue points.
• Achieve levels based on point totals.
• View leaderboards to find community experts on specific forums or topics.
• See their own standing within the community.
• See gamification achievements on their user profiles.

• Gamification components

The gamification feature includes several components, such as rules, levels, and tracks,
that enable users to earn points and badges for community activities.

• Gamification user interface components

Gamification information appears on leaderboards, the user profile page, and content
pages.

• Administer gamification

Users with the gamification administrator role can create the rules and other entities that
award points to users based on their participation within the community.

• Moderate gamification

Monitor points earned by users and award points and badges to users based on their
participation within the community.

Gamification components

Last updated: July 26, 2018
Last updated: July 26, 2018

The gamification feature includes several components, such as rules, levels, and tracks, that
enable users to earn points and badges for community activities.

• Rules

Gamification rules allow you to configure points that users receive for activities on the
community.

• Tracks

Tracks provide a way to logically separate points assigned in the communities into
different areas.
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• Levels and level ranges

Points accumulated by community users can help them achieve different reputation
levels.

• Badges

Users can earn badges for achievements or areas of expertise within the community.
Gamification moderators manually assign badges to users.

• Points

Users earn gamification points by performing activities in the community.

Rules

Last updated: July 26, 2018
Last updated: July 26, 2018

Gamification rules allow you to configure points that users receive for activities on the
community.

Gamification includes several pre-defined rules. The gamification administrator can use these
rules, modify them as needed, or create new rules. These pre-defined rules include:

• Comment marked as helpful: 5 points
• Document marked as helpful: 5 points
• Video marked as helpful: 5 points
• Blog marked as helpful: 5 points
• Answer marked as helpful: 20 points
• Document bookmarked: 20 points
• Blog bookmarked: 20 points
• Video bookmarked: 20 points
• Answer marked correct for a question: 40 points

When a user performs an activity that has a gamification rule, the user profile identified in
the rule receives points. Points received through a gamification rule can be configured to
accumulate toward:

• Overall points across the entire community
• Points in forums associated with the activity
• Points in topics associated with the activity
• Points in a track
• Points assigned for a combination of forums, topics, and tracks

If users revert previous activities, the points associated with these activities are removed. As
an example, if a rule has been defined and a user creates a blog, they are awarded points.
The points are deducted when the blog is deleted. If a rule has not been defined and a user
creates a blog, no points are awarded. If the user removes it once a rule has been defined,
points are deducted even though none were awarded in the first place.

Related Tasks

• Create a gamification rule
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Tracks

Last updated: July 26, 2018
Last updated: July 26, 2018

Tracks provide a way to logically separate points assigned in the communities into different
areas.

Gamification includes two pre-configured tracks:

• Community Expertise
• Community Participation

While the application is configured to accumulate points by tracks, gamification does not
currently display tracks in the community portal.

Related Tasks

• Create a gamification track

Levels and level ranges

Last updated: July 26, 2018
Last updated: July 26, 2018

Points accumulated by community users can help them achieve different reputation levels.

The system is pre-configured with levels where community users can earn points and
achieve expertise or a reputation:

• Global: overall points accumulated across the entire community
• Forum: points accumulated in forums associated with the activity
• Topic: points accumulated in topics associated with the activity

Gamification administrators can configure level ranges within each level. These level ranges
progress from a starting point value to a higher value (point ranges do not overlap) and
have unique, configurable names. For example, in the Global level, a user that has earned
100–499 points is a Newbie while a user that has earned 500–999 points is an Enthusiast.
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Gamification Level Definition form

In the community portal, users can see level range names and point totals in the
gamification user interface components.

• On the leaderboard page and leaderboard widgets
• At the top of a user's profile below the user name and title
• On the user profile page in the Achievements tab
• On content pages

Related Tasks

• Manage gamification levels

• Manage gamification level ranges

Badges

Last updated: July 26, 2018
Last updated: July 26, 2018

Users can earn badges for achievements or areas of expertise within the community.
Gamification moderators manually assign badges to users.

Gamification includes several predefined badges. Each badge includes:

• A name
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• An icon
• A brief description

Gamification administrators and moderators can award badges to community users and also
remove badges. A badge can be awarded to a user one time. If a badge is removed from a
user, it can be awarded to that user again.

Earned badges are visible in the community portal in the gamification user interface
components. Community users can see earned badges and available badges on their own
user profile page in the Achievements tab.

Related Tasks

• Create a gamification badge

Points

Last updated: July 26, 2018
Last updated: July 26, 2018

Users earn gamification points by performing activities in the community.

Users can earn points within a community, a forum, or a topic. As users accrue points, they
achieve level ranges. Point totals appear on leaderboards and on user profiles, in the profile
header, and in the Achievement tab. After points are awarded to a user, an entry appears at
the top of the Points list and the user's point total is updated.

The Points list has a widget instance option to Show points for private forum.

• When set to true, the point record displayed in the user profile does not show the forum
name if the user performing the action does not have forum access. It displays "Private
Forum" in place of the forum name.

• When set to false, the point record does not display in the user profile.

The Points list also has a widget instance options for the Page size, which determines the
number of results displayed in the list. If there are more results than the number specified in
this option, a button to show additional results appears at the bottom of the points page.

Gamification user interface components

Last updated: July 26, 2018
Last updated: July 26, 2018

Gamification information appears on leaderboards, the user profile page, and content pages.

• Leaderboard page

The leaderboard page displays the top contributors in the community, in a forum, or in a
topic.

• Leaderboard widgets

Leaderboard widgets appear on the Community homepage and on forum and topic
landing pages. These widgets display the users with the highest point totals within the
community, forum, or topic.

• User profile page
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The user profile page displays gamification information that showcases the user's
expertise.

• Community content pages

The user's gamification level and badges are displayed on the content pages, so that
other community users can view the reputation of the content contributor.

• Gamification notifications

Community users receive notifications about badge assignments and levels achieved
through the activity feed.

• How to earn points

In order to be transparent to your users about gamification rules, you can share the points
received for community activities.

Leaderboard page

Last updated: July 26, 2018
Last updated: July 26, 2018

The leaderboard page displays the top contributors in the community, in a forum, or in a
topic.

Users appear on the leaderboard based on the number of earned points and are ranked in
descending order. You can filter the leaderboard to display information for the current
month or all-time and by a specific forum or topic.

To display the leaderboard, navigate to Community > Leaderboard. You can also click Show
Leaderboard on the leaderboard widget. When navigating to the leaderboard from a
leaderboard widget on a forum/topic landing page, the leaderboard shows the top point
earners for that forum/topic.
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Community leaderboard

For each user, the leaderboard displays:

• Rank: shows the rank depending upon the selected filters (time, forum or topic)
• Name
• Profile photo (if available) or initials
• Current level: shows global, forum, or topic level depending upon the selected filter

By default, the leaderboard displays 10 users per page. Users can use the pagination
controls to view additional pages. Pointing to a user name in the leaderboard displays a
pop-up window with more information about the user.

Leaderboard widgets

Last updated: July 26, 2018
Last updated: July 26, 2018

Leaderboard widgets appear on the Community homepage and on forum and topic landing
pages. These widgets display the users with the highest point totals within the community,
forum, or topic.

The leaderboard widget shows the top five users. If there are more than five users that have
earned points within the community, forum, or topic, Show Leaderboard appears at the
bottom. Click this button to display all of the users on the leaderboard page.
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Community forum leaderboard widget

For forums and topics, the leaderboard widget header displays the forum or topic name.
When navigating to the leaderboard page from a forum/topic, the leaderboard shows the
top point earners for that forum/topic.

System administrators can configure settings for the leaderboard widget:

• The number of users displayed in the widget (default is 5, maximum is 10)
• The time period (overall or current month)
• The leaderboard type (community, forum, or topic)
• Anchor to a specific forum or topic (not recommended)

User profile page

Last updated: July 26, 2018
Last updated: July 26, 2018

The user profile page displays gamification information that showcases the user's expertise.

The gamification information is shown in three sections of the user profile page:

• In the header area
• In the Achievements tab
• In the forum and topic expertise widgets

User profile header area

When the gamification feature is enabled, the user profile header area includes the user's
current gamification achievements. This information appears just below the user name and
title:

• The top three badges that have been awarded to the user. Pointing to a badge displays the
badge name.

• The total number of points earned by the user.
• The current global level achieved.

Achievements tab

Users can view details about gamification levels, badges, and points on the user profile page
in the Achievements tab.
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Levels A list of the levels available to the user, with the
current level highlighted.
This tab includes a link to the Community page
How to Earn Points.

Badges A list of the earned badges and available badges
for the user. Earned badges appear at the top of
the list. Earned badges are sorted by the most
recently earned. Available badges appear below
earned badges. Users can filter this list to view all
badges or earned badges.
When viewing another user's profile, only the
earned badges are displayed and are sorted by
the most recently earned.

Points A history of the points earned and the activities
performed by the user. This list includes the last
10 activities. Click Show more to display
additional pages.
Gamification moderators can award and remove
points for community users.

This tab includes a link to the Community page
How to Earn Points.

Forum and topic expertise widgets

The forum and topic expertise widgets on the user profile page provide a visual
representation of the user's top areas of expertise.

The number within the circle and the blue highlight around the circle represent the number
of levels completed. For example, 2 of 5. The number below the circle indicates the total
number of points that the user has earned within the forum or topic. The widget displays up
to five items and the system administrator can configure the widget to show up to a
maximum number of 10 items.

Clicking the info icon displays the forum or topic levels and the point ranges.
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Forum and topic expertise widgets

Community content pages

Last updated: July 26, 2018
Last updated: July 26, 2018

The user's gamification level and badges are displayed on the content pages, so that other
community users can view the reputation of the content contributor.

Pointing to a user name on content pages such as questions, blogs, and videos displays a
pop-up window with gamification information including badges earned, point total, and level
name. This information is available for the author or a user who has replied or commented
on that content.

The community administrator can change the displayed level to show either the global level
or the forum level. This display can be controlled by the
sn_communities.content.show_gamification_level property.

Depending upon the information available, there can be three different versions for the pop-
up:

• Profile photo and name
• Profile photo and name with global points
• Profile photo and name with global points and badges
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User profile pop-up window with gamification information

Gamification notifications

Last updated: July 26, 2018
Last updated: July 26, 2018

Community users receive notifications about badge assignments and levels achieved
through the activity feed.

This includes global, forum, and topic levels achieved. A user, or any of their followers, are
notified through an activity feed update in the following scenarios:

• When a user advances a level (global, forum, or topic)
• When a user earns a badge

How to earn points

Last updated: July 26, 2018
Last updated: July 26, 2018

In order to be transparent to your users about gamification rules, you can share the points
received for community activities.

Navigate to Community > How to Earn Points for a description of the activities that users
can perform to earn points. This page has links to the user's profile page. If gamification
rules are modified, then this page shows the updated information.

Administer gamification

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the gamification administrator role can create the rules and other entities that
award points to users based on their participation within the community.

• Configure gamification properties

Configure gamification properties to meet your company's needs.
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• Create a gamification rule

Create gamification rules so that users can earn points for community activities.

• Create a gamification track

Create tracks to provide a logical way to separate points assigned in the communities into
different areas.

• Create a gamification badge

Create gamification badges that users can earn for achievements within the community.

• Manage gamification levels

Manage the predefined levels for global, forum, and topic expertise.

• Manage gamification level ranges

Manage level ranges for a gamification level definition, to recognize the expertise level of
your community users.

Configure gamification properties

Last updated: July 26, 2018
Last updated: July 26, 2018

Configure gamification properties to meet your company's needs.

Before you begin

Role required: sn_gamification.admin

Procedure

1. Navigate to Community > Gamification Administration > Gamification Properties.
2. Enter the number of days to store the gamification activity history.

The default is 180 days. A scheduled job purges the points history that is older than 180
days. This purge does not delete the aggregated data.

3. Enter the maximum number of levels that can be defined.
4. Click Save.

Additional properties can be configured for the gamification feature. For more
information, see Gamification properties.

Create a gamification rule

Last updated: July 26, 2018
Last updated: July 26, 2018

Create gamification rules so that users can earn points for community activities.

Before you begin

Role required: sn_gamification.admin

Procedure
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1. Navigate to Community > Gamification Administration > Rules.
2. Click New.
3. Fill in the fields on the Gamification Rule form as necessary.

Field Description
Rule Name A descriptive name for the gamification rule.

Gamification Module The application to which this rule applies. Click
the lookup icon to select a module from the
Gamification Modules list. The default is
Community.

Activity Type The user activity for which this rule applies.
Click the lookup icon to select one of the
available types from the Activity Types list.

Profile Receiving Points The type of user profile that earns points for
performing the activity defined in this rule.
Click the lookup icon to select a profile
corresponding to the activity.

Active Enable this check box to activate the rule. The
default is set to active.

Gamification Track The gamification track to which this rule
belongs. Click the lookup icon to select one of
the available tracks from the Gamification
Tracks list. By default, two tracks are available:

• Community Expertise
• Community Participation

Points The number of points earned by performing
the activity defined in this rule.

Points for Areas of Expertise The points accrued can be used towards a
forum or topic level expertise. Click the lock
icon to expand the field and configure if the
points should accrue towards a forum and/or
topic.

4. Click Submit.
The newly created rule appears on the Gamification Rules list. This rule appears on the
How to Earn Points page.

Create a gamification track

Last updated: July 26, 2018
Last updated: July 26, 2018

Create tracks to provide a logical way to separate points assigned in the communities into
different areas.

Before you begin

Role required: sn_gamification.admin

Procedure

1. Navigate to Community > Gamification Administration > Tracks.
2. Click New.
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3. Fill in the fields on the Gamification Track form as necessary.

Field Description
Track Name A descriptive name for the gamification track.

Gamification Module The module to which this track applies. Click
the lookup icon to select a module from the
Gamification Modules list. By default the
module is set to Community.

Active Enable this check box to activate the track. By
default this field is set to active.

Application The application to which this track applies. By
default the module is set to Community.

Track Display Order The order in which the track appears.

4. Click Submit.
The newly created track appears on the Gamification Tracks list.

Note:  While tracks can be configured, it is not currently displayed anywhere on
the Community portal.

Create a gamification badge

Last updated: July 26, 2018
Last updated: July 26, 2018

Create gamification badges that users can earn for achievements within the community.

Before you begin

Role required: sn_gamification.admin

About this task

The gamification feature includes several predefined badges.

Procedure

1. Navigate to Community > Gamification Administration > Badges.
2. Click New.
3. Fill in the fields on the Gamification Badge form as necessary.

Field Description
Gamification Module The application to which the badge applies.

The default module is Community.

Badge Name The name of the badge as it appears on the
Community portal.

Badge Display Order The order of the badge indicates the rank. If a
community user has multiple badges assigned
to them, this field determines the sequence in
which the badges are displayed.

Active Enable this check box to activate the badge.
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Field Description
Description A brief description of the badge as it appears

on the Community portal.

Badge Icon The image file for the badge. Click to add the
icon, choose the desired image file, and then
click OK.

Note:  The recommended image size
for ideal performance is 50
pixels by 50 pixels and less than
500KB.

4. Click Submit.
The newly created badge appears on the Gamification Badges list.

Manage gamification levels

Last updated: July 26, 2018
Last updated: July 26, 2018

Manage the predefined levels for global, forum, and topic expertise.

Before you begin

Role required: sn_gamification.admin

About this task

Gamification includes predefined global, forum, and topic levels.

Procedure

1. Navigate to Gamification > Configuration > Levels.
2. View the existing definitions for global, forum, and topic levels.
3. Change the Level Name if required.
4. Click Submit.

Adding new level definitions is not recommended unless there is a strong use case. If
you need to add or modify level ranges in existing level definitions, see Manage
gamification level ranges.

Manage gamification level ranges

Last updated: July 26, 2018
Last updated: July 26, 2018

Manage level ranges for a gamification level definition, to recognize the expertise level of
your community users.

Before you begin

Role required: sn_gamification.admin

About this task

August 6, 2018 ©2018 ServiceNow. All rights reserved. 387

ServiceNow | Customer Service Management



Gamification includes predefined global, forum, and topic levels. Each level definition can
have several level ranges and the system is predefined with 10 ranges for global level and
five ranges each for the forum and topic levels. Each range should not overlap and must
have a unique start value.

Procedure

1. Navigate to Gamification > Levels.
2. Select the desired level (global, forum, or topic).
3. Modify the Level Range Name.
4. Modify the Points Start field.

Each range should not overlap and must have a unique start value.
5. Click Submit.

Level ranges are updated on the Community portal.

Moderate gamification

Last updated: July 26, 2018
Last updated: July 26, 2018

Monitor points earned by users and award points and badges to users based on their
participation within the community.

• Award or remove points for a community user

Award points to a user to recognize their contributions to the community. Remove points
for a user if you observe that they are cheating the gamification system.

• Award a badge to a user

Award gamification badges to community users to recognize their community activities.

• Remove a badge from a user

Remove a gamification badge from a community user if it is no longer relevant for that
user.

Award or remove points for a community user

Last updated: July 26, 2018
Last updated: July 26, 2018

Award points to a user to recognize their contributions to the community. Remove points for
a user if you observe that they are cheating the gamification system.

Before you begin

Role required: sn_gamification.moderator

Procedure

1. Navigate to the Community homepage.
2. Go to Community > Leaderboard.
3. Click the name of the user on the leaderboard to open the user profile.
4. Click the profile overflow icon (...) and select Assign Points.
5. In the Assign Points pop-up window, enter the number of Points, a Reason for awarding

the points, and select a Track.
a. To assign points, the points entered should be a positive value. For example, 100.
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b. To remove points, the points entered should be a negative value. For example, -100.
The maximum number of points that can be awarded or removed at one time is 1000.

6. Click Assign Points.
An entry for the point assignment activity shows at the top of the Points list and the
user's point total is updated.

Award a badge to a user

Last updated: July 26, 2018
Last updated: July 26, 2018

Award gamification badges to community users to recognize their community activities.

Before you begin

Role required: sn_gamification.moderator, sn_gamification.admin

About this task

A badge can be awarded to a user only once. If a badge is removed from a user, it can then
be awarded to that user again.

Procedure

1. Navigate to Community > Gamification Data > Profile Badges.
2. Click New.
3. Select a Badge from the Gamification Badges list.
4. In the Live Profile field, add the name of the user.
5. Click Submit.

The badge is assigned to the user and it appears on the community portal.

Remove a badge from a user

Last updated: July 26, 2018
Last updated: July 26, 2018

Remove a gamification badge from a community user if it is no longer relevant for that user.

Before you begin

Role required: sn_gamification.moderator, sn_gamification.admin

Procedure

1. Navigate to Community > Gamification Data > Profile Badges.
2. Select the Active field for the desired user and badge.
3. Change the Active field to false.
4. Click Update.

The badge is removed for that user and is no longer visible on the community portal.

Field Service Management
Last updated: July 26, 2018
Last updated: July 26, 2018
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The ServiceNow® Field Service Management application helps organizations manage work
tasks of any kind that need to be performed on location. Use Field Service Management to
match tasks to agents based on agent skills, geographic territory assignments, and available
inventory. Agents complete assigned tasks and then record the details, including travel and
work time.

Explore

• Field Service Management
overview

• Field service process
• Field Service Management

integrations
• Field Service Manager

module
• Flow Designer actions
• Domain separation

Set up

• Activate Field Service
Management

• Activate additional plugins
for Field Service
Management

• Configure Field Service
Management

• Create field service groups
• Configure central dispatch

Administer

• Manage work order SLAs
• Create work order templates
• Administer central dispatch
• Configure dynamic scheduling
• Administer appointment booking

Use

• Manage work orders
• Manage work order tasks
• Manage part requirements
• Execute work order tasks
• Agent calendar
• Central dispatch
• Field service manager

module
• Appointment booking
• Time recording

Develop

• Components installed with
Field Service Management

• State flow customization
• Out-of-the-box Field Service

Management Performance
Analytics Solutions

Troubleshoot and get help

• Ask or answer questions in the
Service Management community

• Search the HI knowledge base
for known error articles

• Contact ServiceNow Support

Field Service Management overview
Last updated: July 26, 2018
Last updated: July 26, 2018

Use the Field Service Management application to manage work requests that are performed
on location by field service agents.

Use Field Service Management to record details such as necessary skills and required parts
in work orders and work order tasks and then match tasks to agents based on skill, location,
and inventory. Field service agents perform the assigned tasks and track their travel and
work time, part requirements, and asset usage.

Integration with Service Management

Field Service Management is integrated with the Service Management (SM) application. This
integration helps you manage settings for all of the Service Management-based applications
such as Facilities Service Management and Finance Service Management.

Field Service Management user roles

Several different roles are used to manage the field service process. The following list
provides a brief description of the key roles and what they do.
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User role Description
Administrator
[wm_admin]

Manages data and performs setup and
configuration tasks. Users with this role can also
create, approve, qualify, and dispatch work orders
and tasks.

Initiator
[wm_initiator]

Creates work orders and assigns qualification
groups.

Approver user
[wm_approver_user]

Approves work orders before they are qualified or
assigned to field service agents.

Qualifier
[wm_qualifier]

Qualifies work orders by assigning dispatch
groups, creating work order tasks, and adding
part requirements.

Dispatcher
[wm_dispatcher]

Schedules tasks, adds necessary parts, and
assigns tasks to field service agents. Users with
this role can also create tasks and add and source
parts as needed.

Agent
[wm_agent]

Performs work at customer locations and records
details in the work order form, including parts
used and incidental expenses.

Two combination roles can also be used:

• wm_initiator_qualifier
• wm_initiator_qualifier_dispatcher

For a more detailed description, see User roles installed with Field Service Management.

Work orders and work order tasks

Work orders are records that store information about requested work, including customer
names and addresses, locations where work is to be performed, and any associated
configuration items (CIs). Work orders can include one or more tasks that contain specific
details about the work to be performed, such as required agent skills and part requirements.

Work order and work order task states

Work orders and work order tasks move through several states from creation to completion.
Different user roles are required to move work orders from one state to the next, with each
role providing an important part of the process. These roles work together to define work
orders, add the necessary technical information, break the work down into specific tasks,
and assign tasks to dispatch groups and field service agents. After accepting assigned tasks,
agents order and pick up parts, perform the work, and record the details.

The state of a work order is displayed on the work order and task forms in the process flow
formatter and also in the State field.
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Work order states
Work order state Description
Draft The initiator (wm_initiator) creates a work order

and adds information to the work order form
about the work to be done.

Awaiting Qualification The work order is ready to be reviewed by the
qualifier (wm_qualifier).

Qualified The qualifier (wm_qualifier) has added any
necessary technical information to the work
order, created tasks, added part requirements,
and assigned a dispatch group.

Assigned The dispatcher (wm_dispatcher) assigns one or
more of the work order tasks to a field service
agent.

Work in Progress The agent (wm_agent) accepts the assigned
work order task and begins work.

Closed Complete The agent completes the work in the assigned
task. Once all of the tasks for a work order are
complete, the state of the work order is set to
complete.

Closed Incomplete The agent does not complete the work in the
assigned task. If one or more tasks for a work
order are closed incomplete, the state of the work
order is closed incomplete.

Cancelled The work is no longer necessary or the work
order is a duplicate. A reason for cancelling the
work order must be added to the Work notes
field.

Work order task states
Work order task state Description
Draft The qualifier (wm_qualifier) creates a task for a

work order.

Pending Dispatch The qualifier (wm_qualifier) assigns a dispatch
group to the work order task.

Assigned The dispatcher (wm_dispatcher) assigns the work
order tasks to a field service agent.

Accepted The field service agent (wm_agent) accepts the
assigned task. The agent can also reject a task. If
rejected, the task state returns to Pending
Dispatch.

Work in Progress The field service agent (wm_agent) clicks Start
Travel on the Work Order Task form, followed by
Start Work, and begins the work described in the
task.

Closed Complete The field service agent (wm_agent) completes
the work for the assigned task, adds a description
in the Work notes field, and clicks Close Complete
on the Work Order Task form. The agent can also
click Close Incomplete and add a reason for the
incomplete closure.
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Work order task state Description
Closed Incomplete The field service agent (wm_agent) cannot

complete the work for the assigned task, adds a
reason for the incomplete closure in the Work
notes field, and clicks Close Incomplete.

Cancelled The work order task is no longer necessary or is a
duplicate of another task. The field service agent
(wm_agent) adds a reason for the cancellation in
the Work notes field and clicks Cancel.

Work locations

Field Service Management relies on defined locations for qualifying work orders and tasks
and assigning dispatchers and agents. As part of setting up the application, you can define
your locations and then create qualification, dispatch, and assignment groups based on
those locations.

Using guided setup to implement Field Service Management

Field Service Management guided setup provides a sequence of tasks that help you to
configure Field Service Management on your ServiceNow instance. To open Field Service
Management guided setup, navigate to Field Service > Administration > Guided Setup. For
more information about using the guided setup interface, see Using guided setup.

Section 508 compliance features

Users can view and interact with the following Field Service Management features using
Section 508 compliance features:

• Central Dispatch
• Manager Calendar
• Agent Calendar

Related Topics

• Accessibility features

Field service process
Last updated: July 26, 2018
Last updated: July 26, 2018

The Field Service Management application streamlines the way that tasks are qualified and
dispatched and how parts are sourced.

About this task

Additional automated features enable dispatchers to route and dispatch tasks quickly, using
precise geolocation to create schedules. These features are explained where they occur in
the following flow:

Procedure
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1. Create qualification, dispatch, and assignment groups. These groups are sets of users or
agents, filtered by location, who can perform specific field service tasks.

2. Establish service level agreement (SLAs).
3. Activate the Field Service Management Geolocation Demo Data plugin

(com.snc.work_management_geolocation.demo).
Geolocation allows dispatchers to track agents with greater accuracy. Only users with
the admin role can activate this plugin.

4. Create and qualify work orders. Qualifying a work order is the process of checking that
work order information is complete so work order tasks can be assigned.

5. Organize work into tasks that must be done to complete the work order.
6. Source parts and dispatch work order tasks to agents based on criteria such as skills and

location.
7. Have agents execute the work order tasks assigned to them and track the task

completion.
8. Access and perform work order tasks from a mobile device.

Agents can accept and reject tasks, track travel and work time, and access all the
information they need about the work to perform and assets to pick up.

Related Tasks

• Activate Field Service Management

Domain separation in Field Service Management
Last updated: July 26, 2018
Last updated: July 26, 2018

Domain separation in Field Service Management enables you to separate data, processes,
and administrative tasks into logical groupings called domains. You can then control several
aspects of this separation, including which users can see and access data.

Overview

Support: Level 1

Domain separation is supported in this application. Not all ServiceNow applications support
domain separation; some include limitations on the data and administrative settings that can
be domain separated. To learn more, see Application support for domain separation.

In the Field Service Management application, you can use the Company entity to drive
domain separation. Assign a domain to each company and then any work orders and tasks
created for a company are created within the company domain. Other entities and tasks
related to work orders, such as dispatcher and assignment groups, part requirements, and
transfer orders, are driven by the company and work order domains.

How domain separation works in Field Service Management

Domain separation for Field Service Management uses the Company entity to drive the
domain structure. To use domain separation, all companies must be assigned to a domain.

When using Field Service Management in a domain separated instance, the Company field is
a mandatory field on the Work Order form. When you create a work order for a company,
the work order is created in the company domain. Any tasks created for the work order are
also created in the company domain.

August 6, 2018 ©2018 ServiceNow. All rights reserved. 394

ServiceNow | Customer Service Management

https://docs.servicenow.com/bundle/london-customer-service-management/page/product/planning-and-policy/task/../../../administer/navigation-and-ui/concept/c_MapPages.html
https://docs.servicenow.com/bundle/london-platform-administration/page/administer/company-and-domain-separation/reference/domain-separated-apps.html


When using Field Service Management integrated with Customer Service Management in a
domain separated instance, the Account field is a mandatory field on the Work Order form.
When you create a work order for an account through a customer service case, the work
order is created in the account domain. Any tasks created for the work order are created in
the same domain as the work order. In the event that the domain of the work order changes,
the domain of the work order tasks is also updated.

Modifying the company or account on a work order also modifies the domain of the work
order and work order tasks. The domains of other related entities are not automatically
updated. The company or account can be changed until the work order is qualified.

Note:  Field Service Management is configured at the application level and does not
support domain-specific configuration. For example, if you select use
dynamic scheduling as your task assignment method, this method is used to
assign tasks in all domains.

Setting up domain separation in Field Service Management

To set up domain separation for Field Service Management, contact ServiceNow, Inc.

Work orders created from Incident, Problem, or Change

For work orders created from an incident, problem, or change request:

• The company on the work order is inherited from the original record.
• The domain of the work order is inherited from the company.
• If the original record does not include a company, the Company field is still a required field

on the Work Order form.

Groups

Qualification, dispatcher, and assignment groups are filtered based on the domain of the
work order and work order tasks. The group domain must match the work order or work
order task domain.

Parts process

The parts process, which includes sourcing and using assets, is also domain separated.

• Part requirements are created in the work order domain.
• Transfer orders and transfer order lines created for a part requirement are created in the

part requirement’s domain.
• Assets are available for a work order or work order task based on the part requirement

domain.
• When sourcing a part:

Assets are available based on the part requirement domain.
Stockrooms are available based on available assets.

Related Topics

• Domain separation
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Activate Field Service Management
Last updated: July 26, 2018
Last updated: July 26, 2018

The Field Service Management (com.snc.work_management) plugin is available as a
separate subscription. This plugin activates related plugins if they are not already active.
After Field Service Management is activated, you can also activate additional plugins that
provide demo data and enable a variety of features.

Before you begin

Role required: admin

About this task

The Field Service Management plugin activates these related plugins if they are not already
active.

Plugins for Field Service Management
Plugin Description
Agent Schedule
[com.snc.agent_schedule]

Enables customer service agents and field service
technicians to see work schedules and
assignments and also add personal events such
as meetings or appointments.

Appointment Booking
[com.snc.appointment_booking]

Enables setup and configuration for the
appointment booking feature

Assignment Workbench
[com.snc.assignment_workbench]

Workbench to assign work to individual agents
easily so that work gets done efficiently and
effectively.

Central Dispatch
[com.snc.central_dispatch]

Installs the core Service Management items used
to allow other service-related plugins to work,
such as Field Service Management and Facilities
Service Management.

Dynamic Scheduling
[com.snc.dynamic_scheduling]

Enables dynamic scheduling for Service
Management applications, which supports bulk
task recommendations and interval-based auto
assignment.

Field Service – Questionnaire
[com.snc.wm_questionnaire]

Enables the system administrator to create
questionnaires for work orders and work order
tasks.

Field Service – Signature Pad
[com.snc.wo_signature_pad]

Captures a customer signature for closed work
orders. Creates a PDF of the work order that
includes a summary of the completed work and
the name and signature of the customer.

Field Service Management Mobile
[com.snc.work_management_m]

Adds the Field Service Management menu to the
mobile user interface.

Service Management Core
[com.snc.service_management.core]

Adds the core Service Management items that
enable other service-related plugins to work, such
as Field Service Management, Facilities Service
Management, and the custom-app creator.
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Plugin Description
Special Handling Notes
[com.sn_shn]

Enables users to quickly view important
information about records.

You can add Field Service Management to the Service Management Content Management
System (CMS) portal by activating the following plugins:

• CMS User Interface - Service Management Core [com.snc.service_management.core.cms]
• Field Service Management CMS Portal [com.snc.work_management.cms]

Procedure

1. Navigate to System Definition > Plugins.
2. Find and click the plugin name.
3. On the System Plugin form, review the plugin details and then click the Activate/

Upgrade related link.

If the plugin depends on other plugins, these plugins are listed along with their
activation status.

If the plugin has optional features that depend on other plugins, those plugins are listed
under Some files will not be loaded because these plugins are inactive. The optional
features are not installed until the listed plugins are installed (before or after the
installation of the current plugin).

4. (Optional) If available, select the Load demo data check box.

Some plugins include demo data—Sample records that are designed to illustrate plugin
features for common use cases. Loading demo data is a good practice when you first
activate the plugin on a development or test instance.

You can also load demo data after the plugin is activated by clicking the Load Demo
Data Only related link on the System Plugin form.

5. Click Activate.

Additional plugins for Field Service Management

After Field Service Management is activated, you can activate additional plugins that
provide demo data and enable a variety of features.

You must have the admin role to activate these additional plugins. For details, see Activate a
plugin.

Plugin Description
Field Service Management Geolocation Demo
Data
[com.snc.work_management_geolocation.demo]

Enables the Field Service Management
application to use Google Maps travel times when
auto-dispatching work order tasks. Activating the
Field Service Automation Geolocation plugin
automatically activates the Field Service
Management plugin.

Field Service Management Demo Data
[com.snc.work_management.demo]

Adds demonstration data for the Field Service
Management application covering the medical
and telecommunication domains.
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Plugin Description

Note:  Installing this plugin adds new
Configuration Item tables and
relationships to the database.

Field Service Management Mobile
[com.snc.work_management_m]

Adds the Field Service Management menu to the
mobile user interface. Activating this plugin
automatically activates or upgrades the Field
Service Management and Mobile UI plugins.

Customer Service with Field Service Management
(com.snc.csm_fsm_integration)

This plugin provides an integration between the
Customer Service Management and Field Service
Management applications. Customers and
consumers can view case-related work orders
from the Customer Service and Consumer Service
Portals. In the Field Service Management
application, users can view account and contact
information on work orders and work order tasks.

Performance Analytics - Content Pack - Field
Service Management
[com.snc.work_management_pa]

Enables Performance Analytics for Field Service
Management. Activation of this plugin on
production instances may require a separate
license. Contact ServiceNow for details.

Note:  If you have Performance Analytics
installed, the Field Service
Management Performance
Analytics plugin
(com.snc.work_management_pa)
is automatically activated as part
of the Field Service Management
plugin.

Field Service with Project Management
[com.snc.wm_ppm]

Field Services Integration with Project
Management. This plugin activates the Project
Management application and may require
additional licenses.

Field Service with Project Management Demo
Data
[com.snc.wm_ppm_demo]

Demo plugin for the Field Services Integration
with Project Management.

Field Service - Questionnaire
[com.snc.wm_questionnaire]

Enables the work order questionnaire feature,
which enables users with the system
administrator role to create questionnaire records
and associate those records with work orders or
work order tasks.

Field Service Management integrations
Last updated: July 26, 2018
Last updated: July 26, 2018

Integrations with Customer Service Management, Financial Management, and Project
Portfolio Management are available to enhance the capabilities of Field Service
Management.

• Integration with Customer Service Management
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Provides an integration between the Customer Service Management and Field Service
Management applications.

• Integration with Financial Management

Plugins for Customer Service Management and Field Service Management provide an
integration with the Financial Management application as well as dashboards and reports.

• Integration with Project Portfolio Management

Link project tasks to work orders to assist with managing installation or deployment
projects in the field.

Integration with Customer Service Management

Last updated: July 26, 2018
Last updated: July 26, 2018

Provides an integration between the Customer Service Management and Field Service
Management applications.

Users can view account and contact information on work orders and work order tasks in the
Field Service Management application. Customers and consumers can view case-related
work orders from the Customer Service and Consumer Service Portals.

When an agent creates a work order from a customer service case, the work order and task
forms include case-related information such as the account and contact.

When a customer or a consumer views a case from either the Customer or Consumer
Service Portals, they can view the details of any work orders and tasks related to the case.

Customer Service with Field Service Management plugin

The Customer Service with Field Service Management plugin
(com.snc.csm_fsm_integration) integrates the Field Service Management and Customer
Service Management applications. This plugin requires:

• Field Service Management
• Customer Service Management
• Customer Service Portal

Changes to the Field Service Management application

In the Field Service Management application, this integration adds the following fields to the
Work Order form. These fields are visible in the Case view. To display these fields, right-click
the Work Order form header and select View > Case.

• Account
• Consumer
• Contact
• Asset
• Partner
• Partner Contact

Updating the Account field on the Work Order form also updates the Company field.

Updating the Contact field on the Work Order form updates the Caller field.
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Changes to the Customer Service Management application

In the Customer Service Management application, this integration adds the Work Orders link
to the Customer Service Portal and Consumer Service Portal headers. Click this link to view
a list of work orders, including the work order number, priority, state, and short description.
The work orders displayed in this list on the Customer Service Portal depend on the
customer role: customer, customer admin, partner, or partner admin.

Click a work order in this list to display the work order details.

Known limitations

There is no synchronization between the Work Order form and the associated Case form. If
information changes on the Case form, it does not get updated on the Work Order form.

Integration with Financial Management

Last updated: July 26, 2018
Last updated: July 26, 2018

Plugins for Customer Service Management and Field Service Management provide an
integration with the Financial Management application as well as dashboards and reports.

The Financial Management application enables you to allocate, track, and report on
expenses in your organization. When the Financial Management application allocates an
expense, it breaks down the expense into detailed amounts of money called allocations.
These allocations can be associated with specific segments and accounts for a specific cost
model. The integration with Financial Management provides cost allocations for Customer
Service Management and Field Service Management.

Use these cost allocations on the Financial Management workbench, which provides
financial administrators with a graphical interface to allocate expenses. Access the
workbench through the Cost Transparency > Workbench module.

Plugins

Two different plugins, one for Customer Service Management and one for Field Service
Management, enable the integration with Financial Management. These plugins also add
dashboards based on cost allocations.

• Performance Analytics - Content Pack - Financial Management for Customer Service
plugin (com.snc.pa.fm.csm).

• Performance Analytics - Content Pack - Financial Management for Field Service
Management plugin (com.snc.pa.fm.fsm)

Note:  The Performance Analytics - Content Pack - Financial Management for
Customer Service plugin includes demo data for FY16: Q1 through FY17: Q2.
The Performance Analytics - Content Pack - Financial Management for Field
Service Management plugin does not include demo data.

Cost models

A cost model is a set of rules, methods, and metrics that determines the allocation of
expenses. Select cost models on the Data Definitions tab of the Financial Management
workbench.
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For Customer Service Management, the integration with Financial Management provides
these cost models:

• CSM Allocation Model for Cust Account: allocates expenses for individual B2B customer
accounts.

• CSM Allocation Model for Channels: allocates expenses for communication channels.

For Field Service Management, the integration with Financial Management provides this cost
model:

• FSM Allocation Model for Company: allocates expenses for companies.

Segment hierarchy

All accounts in the chart of accounts belong to segments which are structured in a hierarchy.
This hierarchy enables the roll-up of expenses from lower-level accounts and segments to
higher-level accounts and segments.

• CSM Allocation Model for Cust Account uses this segment hierarchy: Assignment Group >
Product > Customer Account.

• CSM Allocation Model for Channels uses this segment hierarchy: Assignment Group >
Product > Channels.

• FSM Allocation Model for Company uses this segment hierarchy: Assignment Group >
Product > Company.

Account buckets

Use account buckets to categorize cleansed expenses before assigning them to accounts
and segments. Account buckets can be organized in parent-child relationships so that
several child buckets can refer to a single parent bucket.

The Customer Support and Field Service Support account buckets include:

• Facilities
• IT Chargeback
• Payroll and Labor Expenses
• Professional Fees & Services
• Supplies
• Training
• Other expenses

Allocation metrics

Allocation metrics are rules that you can create and use to split an allocation based on
dimensions such as:

• Number of Customer Service cases: allocate expenses to a product based on the number
of cases closed in a fiscal period.

• Total Customer Service case resolution time: allocate expenses to a product based on the
total hours worked on cases closed in a fiscal period.

• Number of Field Service work order tasks: allocates expenses to a product based on the
number of work order tasks completed in a fiscal period.

• Total work order completion time: allocates expenses to a product based on the total
hours worked on tasks completed in a fiscal period.
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For Customer Service Management, the integration with Financial Management provides
these allocation metrics:

• CSM Allocate to Assignment Groups by Headcount
• CSM Allocate to Product by # Cases
• CSM Allocate to Product by Case Time Worked Duration
• CSM Rollup from AssgGrp to Product by # Cases
• CSM Rollup from AssgGrp to Product by Case Time Worked Duration
• CSM Rollup from Product to Account by # Cases
• CSM Rollup from Product to Account by Case Time Worked Duration

For Field Service Management, the integration with Financial Management provides these
allocation metrics:

• FSM Allocate to Assignment Groups by Headcount
• FSM Allocate to Product by # Work Orders
• FSM Rollup from Product to Company by # Work Orders

User roles

These roles can access the Financial Management workbench (Cost Transparency >
Workbench):

• cost_transparency_analyst
• cost_transparency_admin
• financial_mgmt_user
• financial_mgmt_admin

Dashboards and reports

The Performance Analytics - Content Pack - Financial Management for Customer Service
and Performance Analytics - Content Pack - Financial Management for Field Service
Management plugins provide the following dashboards:

• CSM Financials Dashboard
• FSM Financials Dashboard

Navigate to Performance Analytics > Dashboards and select the desired dashboard from the
Dashboard menu.

Related Topics

• Financial Management

• Financial Management Workbench

Integration with Project Portfolio Management

Last updated: July 26, 2018
Last updated: July 26, 2018

Link project tasks to work orders to assist with managing installation or deployment projects
in the field.
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A project can have multiple tasks that are assigned to field service agents. Using the Field
Service Management integration with Project Portfolio Management, you can create work
orders directly from project tasks. Linking project tasks to work orders in this way:

• Synchronizes the planned and actual dates between the project task and the work order.
• Synchronizes the states between the project task and the work order.

To create a work order from a project task, click the Create Work Order related link on the
Project Task form. To view an active linked work order, click the View Work Order related link
on the Project Task form. Project tasks can have more than one linked work order, but only
one work order can be active at a time.

Dates

Dates are synchronized in one direction, from the project task to the linked work order and
to any work order tasks.

• Work order tasks created for a linked work order have fixed Window start and Window
end dates that are based on the planned start and end dates of the project task.

• Updates to project task dates are also updated in the linked work order tasks for tasks that
are not in the Work In Progress or Closed states.

Note:  Changes to the dates on a work order task do not change the dates on the
linked project task.

States

State changes are synchronized in one direction, from the work order to the project task.

• Updating the work order state also updates the state of the linked project task.
• Updating the state of a project task add a note to the Work Notes field on the linked work

order.
• Closing a work order also closes the project tasks.

If an update to the state of a project task fails, a note is added to the project task Work
notes field about the corresponding work order update. Updates can fail with project tasks
that have dependencies.

Work order and project task states are updated as follows.

Work Order State Project Task State
Work In Progress Work In Progress

Close Complete Close Complete

Close Incomplete Close Incomplete

Canceled Close Skipped

Plugins

Activate the Field Service with Project Management plugin (com.snc.wm_ppm) to use this
feature. This plugin requires the Field Service Management plugin
(com.snc.work_management) and the Project Portfolio Suite with Financials plugin
(com.snc.financial_planning_pmo).

• Customize the work order state transition map
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Users with the system administrator role can customize the work order state transition
map, which maps work order states to project task states.

Customize the work order state transition map

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the system administrator role can customize the work order state transition map,
which maps work order states to project task states.

Updating the state of a work order also updates the state of the linked project task. The
FieldServicesProjectTaskStateHandler script maps the work order states to the project task
states. Users with the system administrator role can customize this state transition map as
needed based on the following examples.

Examples

Setting the status of a work order to Close complete should not close the project task. To
make this change, remove the following line in the initialize() function:
this.workOrderProjectTaskStateMap[FieldServiceProjectTaskStateHandler.WORK_ORDER_STATE_CLOSE_COMPLETE] =
      FieldServiceProjectTaskStateHandler.PROJECT_TASK_STATE_CLOSE_COMPLETE;
    

To map the work order Pending dispatch state to the project task Open state, add the
following line to the initialize() function:
    this.workOrderProjectTaskStateMap[FieldServiceProjectTaskStateHandler.WORK_ORDER_STATE_PENDING_DISPATCH] = FieldServiceProjectTaskStateHandler.PROJECT_TASK_STATE_OPEN;
    

To qualify a task automatically once the project task is changed to Open, change the
FieldServiceProjectUpdateHandler process function that listens on project task updates and
change the linked work order to Qualified. Add the following line after this section:

if(taskJSON.change_map && taskJSON.change_map.state){
    If(taskJSON.change_map.state == FieldServiceProjectTaskStateHandler.PROJECT_TASK_STATE_OPEN
    workOrder.state = FieldServiceProjectTaskStateHandler. WORK_ORDER_STATE_PENDING_DISPATCH
    workOrder.update();
    

Configure Field Service Management
Last updated: July 26, 2018
Last updated: July 26, 2018

Administrators in the global domain can select configuration settings that determine how
Field Service Management handles daily operations.

About this task

Administrators in the global domain can set Field Service Management configurations to:

• Include or exclude portions of the request process. For example, you can require a work
order to be approved before continuing to the next stage.

• Automatically assign tasks using SM Auto-Assignment, a custom-defined workflow, or
leave it up to dispatchers to manually assign tasks.

• Track agent travel time.
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Procedure

1. Navigate to Field Service > Administration > Configuration.

Note:  Administrators in domains lower than the global domain can view the
Field Service Configuration screen but cannot modify the settings.

The options on the Field Service Configuration screen are arranged in a multiple-tabbed
layout, as follows:

• The Business Process tab contains options for setting up the request life cycle,
creating catalogs and requests, and configuring notifications.

• The Assignment tab contains options for setting up manual and auto-assignment.
• The Add-ons tab contains options for enabling the knowledge base, managed

documents, and task activities.
2. Fill in the fields on the Business Process tab.

Note:  The Field Service Configuration screen contains many configuration
options. An option is enabled when the switch appears green and is
toggled to the right. All configuration options listed in the Dependency
must be enabled in order for the option to be displayed.

Field Service Configuration screen - Business Process tab
Field Description Dependency
Lifecycle
Process life cycle Select request driven (subtasks

are optional) if you do not
want to require tasks to fulfill
requests. When the request life
cycle is request driven,
requests can be directly
assigned to users in an
assignment group. Users can
still add tasks to requests.
However, closing all tasks does
not automatically close the
request.

Note:  If the Enable state
flows option is not
selected, the
process life cycle
becomes request-
driven and this
field is not
displayed.

• Enable state flows is
turned on.

Approval for new request
required

When disabled, all requests in
the Awaiting Approval state
are automatically approved.

• Enable state flows is
turned on.

Qualification is required for
new requests

Enable to require work orders
to be qualified before moving
to the next state.
If this option is not enabled,
any work orders in the

• Enable state flows is
turned on.

• Process life cycle: task
driven (subtasks are
optional)
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Field Description Dependency
Lifecycle

Awaiting Qualification state are
automatically qualified.

Agent must accept or reject
the assigned task

Enable to require the assigned
agent to accept or reject the
task.

• Enable state flows is
turned on.

Track agent travel time Enable to use time cards for
agent travel for a task.

Work notes are required to
close or cancel a request or
task

Enable if work notes are
required when closing,
completing, or canceling
requests and tasks. If it is
disabled, work notes are not
needed when closing,
completing, or canceling.

Copy task work notes to
request

Enable to synchronize task
work notes with the work
notes on the order or request.
When work notes are added in
the task, the same work notes
appear in the order or request.

• Enable state flows is
turned on.

Catalog and Request Creation

Create or update requests by
inbound email.

Enable this option to allow
inbound email messages to
create or update requests. This
option must be enabled to
allow requests to be marked as
spam.

Requests are created using Select catalog or regular form
to install the catalog and
enable automatic publishing of
request templates to the
catalog.
Select regular form only to
uninstall the catalog and
disable automatic publishing of
request templates to the
catalog.

Templates create a dedicated
catalog item

Enable this option to allow
automatic publishing of
catalog items for the
application.

Notification

Send a notification when a
field changes for a task or
request.

Configure notifications to be
sent to specific recipients
when selected fields in
requests and/or tasks change.

a. From Table, select Request
or Task.

b. From Field, select the field
to use for generating
notifications. When a
change is made to the
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Field Description Dependency
Lifecycle

selected field, a
notification is sent to the
recipients identified.

c. From Recipients, select
one or more recipients

d. If a specific user or a
specific group, is selected,
the user is prompted to
select a user or group.

e. To define more
notifications using other
fields or recipients, repeat
the steps on the next line.

f. To remove a notification,

click the  symbol to
the right of the
notification.

3. Click the Assignment tab and fill in the fields.

Field Service Configuration screen - Assignment tab
Field Description Dependency
Assignment method for tasks Select one of the following

task assignment options:
• Select using auto-

assignment to
automatically assign work
order tasks to field service
agents.

• Select using a workflow to
assign work order tasks
using a custom-designed
workflow.

• Select manually to allow
dispatchers to manually
assign work order tasks.

• Select using dynamic
scheduling to use the
dynamic scheduling
feature.

Assign requests or tasks based
on assignment group coverage
areas

Enable this option to limit the
selection of groups from the
Dispatch group and
Assignment group fields to
groups that cover the location
of the task.

Use dispatch queue Enable this option to use the
dispatch group for manual
assignment.

• Enable state flows is
turned on.

• Process life cycle: Life
cycle is task driven

Scheduling

Use agent or task scheduling Enable this option to allow
agent auto-assignment and
agent auto-selection.

• Assignment method for
tasks is set to using a
workflow.
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Field Description Dependency
Auto-selection of agents will
consider time zone for tasks

Enable this option to consider
the time zone of the agent
when assigning a task.

• Enable state flows is
turned on.

Enable priority assignment Enable this option to use
priority assignment for auto-
assigning agents.

• Enable state flows is
turned on.

• Process life cycle: Life
cycle is task driven

• Auto-selection of agents
will consider agent or task
schedules

Note:  The Process life
cycle option is not
available in all
service
management
applications.

Additional Factors

Auto-selection of agents will
consider location of agents

Enable this option to use the
agent and location when
determining who to assign the
task to. Agents closer to the
task location receive
preference.

• Enable state flows is
turned on.

• If using Process life cycle:
Life cycle is task driven,
then

Assignment method
for tasks: using auto-
assignment

• If using Process life cycle:
Life cycle is request driven,
then

Assignment method
for requests: using
auto-assignment

Auto-selection of agents for
tasks requires them to have
skills

This option determines the
degree to which skills must be
matched to a task when
determining auto-assignment.

• Select all to require that an
assigned agent has all the
skills to perform the task.
An agent who lacks one
skill is eliminated.

• Select some if you want
agents who have most of
the skills to perform the
task.

• Select none if you want to
auto-assign agents
without considering skills.

• Enable state flows is
turned on.

• If using Process life cycle:
Life cycle is task driven,
then

Assignment method
for tasks: using auto-
assignment

• If using Process life cycle:
Life cycle is request driven,
then

Assignment method
for requests: using
auto-assignment

4. Click the Add-ons tab and fill in the fields.
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Field Service Configuration screen - Add-ons tab
Field Description Dependency
Part Requirements
Part requirements are needed
by agents

Enable this option to require
agents to specify parts for the
task.

Select models Click add and select the part
model to be used for this task.
Click more to select more part
models.

Part requirements are needed
by agents

Documentation

Enable a dedicated knowledge
base

Enable this option to install the
knowledge base for the
application.

Enable managed documents Enable this option to add a
related list to managed
documents.

Enable task activities Enable this option to log the
task interactions and
communications, such as
phone calls and email
messages.

Associated Task Tables

Select associated tables Click Add to select more
tables.

Maps

Enable maps Enable this option to use
maps.

Signature Capture and PDF Order Summary

Signature Capture Enable this option to include
the name and electronic
signature of the customer in
the PDF work order summary.

PDF Order Summary Enable this option to create a
PDF summary for a work order
that includes completed tasks,
parts used and returned,
incidental expenses, and the
time required to complete the
work.

5. Click Save.

Warning:  If you clicked the Enable state flows option to disable it, a
confirmation box appears, along with a link to documentation that
explains the consequences of disabling state flows. It is highly
recommended that you read the documentation before proceeding.
The action of disabling service management state flows cannot be
reversed.

• Task vs request driven processing
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All SM applications use either task-driven or request-driven processes for handling tasks.
Field Service Management defaults to the request-driven method for handling work order
tasks.

• Auto assignment

The auto assignment feature can be enabled for requests or tasks, depending on the
Service Management (SM) application's configuration settings.

Task vs request driven processing

Last updated: July 26, 2018
Last updated: July 26, 2018

All SM applications use either task-driven or request-driven processes for handling tasks.
Field Service Management defaults to the request-driven method for handling work order
tasks.

Each application defaults to one or the other of these processing types, but you can switch
between them as needed.

Task-driven processing means that the work order or request simply contains a list of tasks
necessary for completing the overall work. When a work order record is created, an
associated task record is automatically created. A request must have at least one task, and
more tasks can be defined to handle all aspects of the request. As tasks are performed and
completed, the request transitions through a series of states. After the last task is closed, the
request automatically transitions to closed.

Request-driven processing means that tasks are assigned to a request, but closing all the
tasks does not automatically close the request. A request does not require any tasks and
can be opened and closed independently. Any tasks can be transitioned and assigned
independently and to different agents than specified on the request. Even if all tasks are
closed, the request can remain open and continue to be worked on. However, the request
cannot be closed until all tasks are also closed. In request-driven processing, state transitions
are based solely on the request.

Auto assignment

Last updated: July 26, 2018
Last updated: July 26, 2018

The auto assignment feature can be enabled for requests or tasks, depending on the Service
Management (SM) application's configuration settings.

• If the Requests are assigned via auto-assignment option is enabled, requests are
automatically assigned.

• If the Tasks are assigned via auto-assignment option is enabled, the tasks in a request are
automatically assigned.

When auto assignment is enabled and a task is qualified or marked as Ready for Work, an
appropriate agent is automatically assigned to the task and it is moved to the Assigned
state. If the task cannot be auto-assigned, a user with the dispatcher role must adjust the
values in the request or task form and then save the record.

The system uses these criteria to assign agents automatically.
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Auto assignment criteria
Option Description
Geolocation The system uses geolocation to find available

agents when auto-assigning a task.

Skills You can configure whether an agent's skills
should be considered when auto-assigning a task.
If you are assigning tasks to agents based on
mandatory skills requirements, you cannot auto-
assign tasks if the agent does not have the
mandatory skills required to perform the task.

Note:  The
work.management.use.mandatory.skills
system property must be enabled to
configure the agent's skills.

Availability Auto-assignment considers an agent's existing
schedule when auto-assigning additional tasks.

Task windows Auto-assignment attempts to schedule within any
configured task windows. If a window cannot be
scheduled for any available agents, auto-
assignment fails.

Task dependencies Auto-assignment considers any upstream task
dependencies when auto-assigning a task.

• Auto assignment of a request and a task

Automatically assign a task to a dispatch group when the Requests are assigned using
auto-assignment option is set in the SM application's configuration.

Auto assignment of a request and a task

Last updated: July 26, 2018
Last updated: July 26, 2018

Automatically assign a task to a dispatch group when the Requests are assigned using auto-
assignment option is set in the SM application's configuration.

Before you begin

Role required: wm_qualifier, wm_initiator

Procedure

1. In any SM application, do one of the following:
• Open a request in the Awaiting Qualification state or one that has been qualified

automatically, and then open a task in the Draft state.
• Open a task in the Ready for Work state.

2. Select an Assignment group.
3. If the Tasks are assigned via auto-assignment and Auto-selection of agents will consider

location of agents configuration options are set, enter a location.

Auto-dispatch will fail unless the task contains a valid location.
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4. If the Tasks are assigned via auto-assignment option is enabled, create a schedule for
this task in the Planned section, or let the system determine the times. For instructions,
see Creating Work Order Tasks.

By default, ServiceNow enters the current date and time in the Window start field. If you
do not create a schedule or a fixed window, ServiceNow uses the start value to look for
an agent who has that time slot open.

5. Click Qualified or Ready for Work.

The view returns to the previous page, and a success message appears. The system
assigns an agent to the task, enters the agent's assignment group in the task record, and
moves the state to Assigned.

If auto-assignment fails, the message indicates either that no agent was available or that
the task did not specify a location. The system moves tasks that fail auto-assignment to
the Remain in the Pending Dispatch state.

6. To auto-assign a task that failed previously, enter any missing information or change the
schedule, and save the record.

Service management states
Last updated: July 26, 2018
Last updated: July 26, 2018

From creation until closure, SM application requests for work (for example, work orders and
facilities requests), and their respective tasks follow a life cycle tracked by the State field in
Field Service Management and Facilities Service Management.

The life cycle is controlled through business rules and UI actions that are updated by the
system automatically.

Note:  The State field on the record is always read-only.

• Request states

Service Management requests follow a specific life cycle and move through a series of
states, which are displayed in the State field on the request record.

• Request task states

Like requests, the associated request tasks follow a specific life cycle and move through a
series of states, which are displayed in the State field on the task record.

• State flow customization

State flows control the sequence in which records transition between states in Service
Management applications.

• Customize a state flow

You can customize state flows to control the sequence in which records transition
between states in Service Management applications.

Request states

Last updated: July 26, 2018
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Last updated: July 26, 2018

Service Management requests follow a specific life cycle and move through a series of
states, which are displayed in the State field on the request record.

The request states displayed depend on the SM application, as indicated in the table.

Note:  The State field on the request record is always read-only.

Service management request states
State Description
Draft Request initiator adds information about the work

to be done.

Awaiting Qualification Initiator fully describes the request, and qualifier
can process the request. This state is valid only
for the following SM applications:

• Field Service Management

Qualified Request is fully qualified, meaning that all
technical information to complete the request
tasks has been added, but work has not started.
This state is valid only for the following SM
applications:

• Field Service Management

Awaiting Approval When the information is complete enough for
review by an approver, the request is marked
ready for approval. This state is valid only for the
following SM applications:

• Facilities Service Management
• Finance Service Management
• Legal Service Management
• Marketing Service Management

Approved The appropriate approver approves the request.
This state is valid only for the following SM
applications:

• Facilities Service Management
• Finance Service Management
• Legal Service Management
• Marketing Service Management

Work In Progress Work has started.

Closed Complete Request was completed to specification.

Closed Incomplete Request could not be completed as specified.

Canceled Request was canceled.

In addition to the State field, the different request task states are also shown visually at the
top of each task record with the process flow formatter.
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Process flow formatter

Note:  If the State flows are enabled option in the configuration screen is not
selected, the process flow formatter is removed. If you added states to the
request and task tables, those states are visible on the request form.

Request task states

Last updated: July 26, 2018
Last updated: July 26, 2018

Like requests, the associated request tasks follow a specific life cycle and move through a
series of states, which are displayed in the State field on the task record.

The request task states displayed depend on the SM application, as indicated in the table.

Note:  The State field on the request task record is always read-only.

Service management request task states
State Description
Draft Qualifier is not done describing the work.

Pending Dispatch Request task is ready to be assigned. The parent
request state changes to Qualified if all
associated tasks are in Pending Dispatch or a
later state.

Assigned Request task is pending acceptance from the
assigned agent.

Accepted Agent accepts the request task and is ready to be
done. This state is valid only for Marketing Service
Management.

Work In Progress Work on the request task has started. The parent
request state changes to Work In Progress if no
associated tasks are in Draft state.

Closed Complete Request task was completed to specification.

Closed Incomplete Request task could not be completed as
specified.

Canceled Request task was canceled.

In addition to the State field, the different request task states are also shown visually at the
top of each task record with the process flow formatter.

Note:  If the State flows are enabled option in the configuration screen is not
selected, the process flow formatter is removed.

State flow customization

Last updated: July 26, 2018
Last updated: July 26, 2018

State flows control the sequence in which records transition between states in Service
Management applications.

An administrator can perform the following tasks:
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• Add or delete states.
• Trigger events on particular state transitions.
• Transition to another state automatically when data in a request or its task changes, or

change states manually when the user clicks a button.
• Limit the choice list for the State field to those end states that are valid transitions from

the given start state.
• Control the visibility and behavior of selected fields on a target table when records in that

table change states.
• Create custom state flows. Turn off the State flows are enabled option on the configuration

screen. Creating custom state flows requires scripting knowledge.

Note:  Users with the wm_admin role can create, read, update, and delete only work
order flows and work task flows. Users with the facilities_admin role can
create, read, update, and delete only facilities request flows and request task
flows. Users with the wm_admin role cannot manipulate facilities records,
and users with the facilities_admin role cannot manipulate work order
records.

How SM request and task state flows work

State flows replace the standard process that controls how requests and their associated
tasks move between states. The ServiceNow system creates business rules, client scripts,
and UI actions that perform the transitions and field controls you specify. These
programming elements remain in use while the state flow records that use them are present.
When state flows on an SM application table are deleted, the system attempts to delete any
unnecessary programming elements that were created on that table. You can limit the
selections for the State field to valid states for the transition, based on the starting state.

State flows provide the following controls:

• Manual transitions: A UI action, created automatically by the system when you provide a
condition or a script, initiates a transition.

• Automatic transitions: A business rule, created automatically by the system when you
provide a condition and a script, initiates a transition when changes are made to a request
or task.

Features available with state flows

• Custom transitions: Customize the order in which states can change for requests and task
records.

• Field controls: Control the behavior and visibility of specific fields when a task changes
states or reaches a specified end state.

• State choice list: Limit the values offered in a task record State field to valid states for that
transition. This is the same client script that the system creates to manage field controls
for state transitions.

• Events: Trigger events when a state transition occurs or when a record reaches a specific
end state.

Start and end states

You can create a custom state flow for processing that must occur when a task record
makes a specific transition from one state to another. These records require a starting state
and an ending state, and processing occurs during the transition between states. To perform
some processing when a task record reaches a particular end state, you only need to define
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the end state. In some cases a state flow can have a starting state only, such as when you
need to perform some type of cleanup after a task is canceled. A state flow might have no
starting or ending state if the processing in the record applies to more than one state
transition.

The solution is to store the business rule or client script in a state flow record and create a
condition to trigger processing for any state change that requires it. An example of this in
field service management is the Roll Up Changes business rule on the Work Order Task
[wm_task] table. This business rule rolls up state changes that occur in tasks to the parent
work order.

Customize a state flow

Last updated: July 26, 2018
Last updated: July 26, 2018

You can customize state flows to control the sequence in which records transition between
states in Service Management applications.

About this task

Customizing state flows requires scripting knowledge.

Procedure

1. Before customizing a state flow, make a copy of the state flow record for the transition
you want to change and do all your customizations in the copied record.

This allows the system to update the default state flow record automatically during an
upgrade and enables you to revert to the default record if necessary.

2. Make sure to deactivate the original record so the system cannot use it.
3. Navigate to the class of state flows you want to customize.

• State Flows > Work Order Flows
• State Flows > Work Task Flows

4. Open the record for the transition you want to customize.
5. Right-click the form header and select Insert and Stay.

The system clears any values from the Business rule and UI action fields. A notification
appears at the top of the form describing the action taken.

6. Ensure that the Active check box is selected.
7. In the appropriate section, configure a transition method:

• Manual: Click Create UI Action to create a button on the form that enables users to
execute the transition manually. The system uses the value in the Name field as the
label for the UI action. The UI action executes the script in the Manual Script field
when the conditions are true

• Automatic: Click Create Business Rule to create the business rule. The business rule
executes the script in the Automatic Script field when the conditions are true

8. Click Create Client Script to create the script that limits the values available a record's
State field choice list to valid states for that transition

9. Complete the Field Controls section to control how specific fields appear when a record
changes states. The system enforces the field controls with the same client script you
created to filter the choice list for the State field.

10. Click Update
11. Reopen the source record you copied and clear the Active check box

Deactivating the original record allows the system to upgrade it normally when the
instance is upgraded and prevents the system from using the record rather than your
custom state flow.
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12. Open the copied state flow record you want to customize.
13. Fill in the fields, as needed.

Work task flow

Work task flow
Field Description
Number Record number automatically generated by the

ServiceNow system.

[Required] Table Table on which the state flow record runs. The
possible tables are:

• Work Order Task [wm_task]
• Work Order [wm_order]

Starting state Name of the state at the beginning of the
transition.

Ending state Name of the state at the end of the transition.

Client script Client script to run for this transition. The client
script controls the available starting and ending
states you can select by limiting the contents of
the State choice list to valid states.

Event Name of an existing event to trigger when this
transition occurs.

Name [Required] State name as it appears in the
choice list.

Roles Roles required to configure the State field that
uses the custom transition.

Active Switch for enabling or disabling this state flow
record.

Class Available state flow classes:
• State Flow: Records created for state flows

in all task-based tables except those in
Field Service Management.
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Field Description
• Work Order Flow: Records created for

state flows in the Work Order [wm_order]
table.

• Work Task Flow: Records created for state
flows in the Work Order Task [wm_task]
table.

This field is required for users with the admin
role. Users with the wm_admin role can only
create state flow records in the Work Order
Flow and Work Task Flow classes and cannot
edit this field in the record.

Override Default starting value for the State field on all
new records for the table named in the state
flow record.

Work notes Comments about this state flow transition.

Comment Details about the customized record.

Manual (Runs scripts from a UI action that requires the user to click a button or related link.)

Manual condition string Conditions for enabling a UI action that cannot
be defined with the condition builder . For
example, you can use this string to define UI
actions for mobile devices. This condition has
an [and] relationship with the condition in the
Manual condition field.

Manual condition Condition builder for enabling a UI action that
can be defined for fields in the target table.
This condition has an [and] relationship with
the condition in the Manual condition string
field.

Manual script Script that defines what the UI action does
when the conditions are true. This script runs
when the user clicks a button or a related link.

UI action [Read-only] Names the UI action to enable for
this transition. By default, this UI action creates
a button on the task form. Click Create UI
Action to create the button. The button inherits
the name of the state flow record in which it
was created.

Automatic (Runs a business rule automatically when a task record is changed and updated.)

Automatic condition string Conditions for running the business rule that
cannot be defined with the condition builder.
For example, use this condition to evaluate if
the proposed transition is a valid flow. This
condition has an [and] relationship with the
condition in the Automatic condition field.

Automatic condition Conditions for running the business rule that
can be defined for fields in the target table.
This condition has an [and] relationship with
the condition in the Automatic condition string
field.

Automatic script Script that performs additional work when the
condition is true. This script can do tasks such
as update the date and time the transition
occurred or notify someone of a milestone.
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Field Description
Business rule Name of the business rule created for this

transition. The business rule has a condition to
ensure the validity of the flow. If that condition
is true, the business rule performs the transition
requested, using the starting and ending states
from the Work Order Flow or Work Task Flow
form.

Field Controls (Determines field properties when a record transitions between states.)

Mandatory fields Fields required when this transition occurs or
when the Ending state is the current state of a
work order or work order task.

Read only fields Fields set as read-only when this transition
occurs or when the Ending state is the current
state of a work order or work order task.

Visible fields Fields made visible when this transition occurs
or when the Ending state is the current state of
a work order or work order task.

Not mandatory Fields set as optional when this transition
occurs or when the Ending state is the current
state of a work order or work order task.

Not read only Fields that can be edited when this transition
occurs or when the Ending state is the current
state of a work order or work order task.

Not visible Fields hidden when this transition occurs or
when the Ending state is the current state of a
work order or work order task.

• State flow dictionary overrides

A dictionary override in a state flow defines the starting state for all new records in a
specific table. You set an override in tables that extend a base table only, so that your
customizations are applied only to the extended table.

• Work notes in state flows

Work notes are an important part of the state flow process and are used to communicate
information about state transitions.

• Field controls in state flows

You can define controls for individual fields that are enforced when a record transitions
between states.

• Trigger events on state changes

You can configure a state flow to trigger a registered system event when a task transitions
from a starting state to a specified end state. For example, you can use events to trigger
email notifications and create script actions.

• Rebuild state flows

You can rebuild state flows when a mismatch between existing and new sys_ids occurs.

• State flow cleanup
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The business rules, client scripts, and UI actions that the system creates automatically to
perform custom transitions exist only while the state flow records that use them are
present.

• State flow example

Your business processes might require work order tasks to be accepted automatically
when dispatched to an agent.

Related Concepts

• Service Management

Related Reference

• Request states

State flow dictionary overrides

Last updated: July 26, 2018
Last updated: July 26, 2018

A dictionary override in a state flow defines the starting state for all new records in a specific
table. You set an override in tables that extend a base table only, so that your customizations
are applied only to the extended table.

1. In a state flow record, select an Ending state.

This is the override value which becomes the starting state for all new records in the
table named.

2. Click Create Default Value.
The system populates the Dictionary override field with a value of state, which is the
field in the task table affected by the override. The Dictionary override field is read-only.
After the override is created, the system hides the Create Default Value button on all
subsequent state flow forms for that table.

Work notes in state flows

Last updated: July 26, 2018
Last updated: July 26, 2018

Work notes are an important part of the state flow process and are used to communicate
information about state transitions.

The state flow adds work notes into the Work notes field of any task making this transition.
For example, you might include the note, "Task rejected by agent" in the Reject state flow,
which occurs when the task moves from Assigned to Pending Dispatch. If an agent rejects
the task and fails to enter a work note, this note tells the dispatcher why the task reappeared
in the dispatch queue. Work notes added by an agent rejecting the task are appended to the
work notes that are inherited from the state flow.

These rules apply to state flow work notes:

• For a state flow with no Starting state, the work note is added every time the task
transitions to the Ending state.
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• For a state flow with a Starting state and an Ending state, the work note is added only
when the task transitions from that starting state to that ending state.

• If two state flows with work notes have the same Ending state, but only one has a Starting
state, the system adds the work notes from the state flow with the starting state. This
better matches the state flow work note to the more important transition between specific
starting and ending states. In the example here, the work note information is more
pertinent to a task moving from Assigned to Pending Dispatch than to a task that reaches
the Pending Dispatch state from an undetermined beginning state.

Related Concepts

• State flow customization

Related Reference

• Request states

• Request task states

Field controls in state flows

Last updated: July 26, 2018
Last updated: July 26, 2018

You can define controls for individual fields that are enforced when a record transitions
between states.

Settings in the Field Controls section of the State Flow form enable you to apply field
controls when the system detects a specified state transition or when the end state is the
current state when the form is opened. The control is applied only to existing fields on the
form. State flows cannot add fields to the form.

For example, you might want the Problem field to be visible when an incident moves to the
Awaiting Problem state. If the incident state changes to Awaiting User Info, you hide the
Problem field and make the Caller field mandatory.

Configure state flow records with an ending state only and create the correct behavior for
every ending state you want to control. This ensures that the field controls are set properly
when the user selects a new state, and also when the user returns a record's State field to
the original state. Only specify a full state transition, with both a starting and ending state,
when you want a particular behavior for that precise state transition.

Note:  State flows use client scripts to enforce field controls. It is possible that your
settings can be changed by existing UI policies, which execute after client
scripts.

Related Reference

• Request states

• Request task states

Trigger events on state changes

Last updated: July 26, 2018
Last updated: July 26, 2018
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You can configure a state flow to trigger a registered system event when a task transitions
from a starting state to a specified end state. For example, you can use events to trigger
email notifications and create script actions.

About this task

You can configure a state flow to trigger a registered system event when a task transitions
from a starting state to a specified end state. For example, you can use events to trigger
email notifications and create script actions. When you attach an event to a state flow, the
ServiceNow system creates a business rule called State Flow Events for <table name> for
the table specified in the state flow. If you specify a start and end state, the business rule
executes when the record transitions from the start state to the end state. If the state flow
only specifies an end state, the business rule executes whenever that end state is reached.
The system creates one business rule for all state flows containing events on a single table.
When all events or all state flows on a table are deleted, the system deletes the business
rule.

To create an event that fires when a work order task moves from a starting state of Work in
Progress to an end state of Closed Complete:

Procedure

1. Register a new event on the Work Order Task [wm_task] table called task.closed.
2. Navigate to State FlowsWork Task Flows.
3. Open the state flow record Close Complete.
4. Select task.closed in the Event field and save your changes.

The ServiceNow system automatically creates a business rule called State Flow Events
for wm_task.
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Rebuild state flows

Last updated: July 26, 2018
Last updated: July 26, 2018

You can rebuild state flows when a mismatch between existing and new sys_ids occurs.

When you use an XML file to import a state flow record into an instance, the system
attempts to match the incoming states with existing states by comparing sys_ids. Because
the sys_ids of items in a choice list can vary between instances, the system can fail to match
the states, even though they are otherwise identical.

When matching fails, the start and end states of affected records are left blank or contain
numeric values. To repair these records navigate to State Flows > Admin > Rebuild State
Flows. This module runs a script that compares the numerical value of each item in the State
field choice list until it finds a match in the imported state flow record.

State flow cleanup

Last updated: July 26, 2018
Last updated: July 26, 2018

The business rules, client scripts, and UI actions that the system creates automatically to
perform custom transitions exist only while the state flow records that use them are present.

When all the state flows on a table are deleted, the system attempts to delete any
unnecessary programming elements that were created on that table, using these criteria:
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State Flow Elements Deleted in Cleanup
Element Deleted When
UI action

Business rule

Dictionary override

The state flow that created it is deleted.

Business rule that processes events triggered by
a state flow

All state flows for the table specified that have
events configured are deleted.

Client script (onLoad) All state flows for the table are deleted.

Client script (onChange) All state flows with field controls are deleted.

Work notes business rule All state flows with field controls or work notes
are deleted.

State flow example

Last updated: July 26, 2018
Last updated: July 26, 2018

Your business processes might require work order tasks to be accepted automatically when
dispatched to an agent.

About this task

Create a new state flow record that automates the transition from Pending Dispatch to
Accepted and bypasses the Assigned state in which agents can reject tasks. This prevents
the system from running the manual script associated with UI actions. The automatic script
performs the jobs that the manual script performed, such as updating the date and time the
task was dispatched, or to do additional work such as sending a notification.

Procedure

1. Navigate to State Flows > Service Management > Service Order Flows.
2. Open the Assigned record that defines a task transition from a starting state of Pending

Dispatch to an ending state of Assigned.

This is an automatic state change that occurs when an agent's name is added to the
Assigned to field and the task is updated.
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3. Change the name of the state flow.

In this example, change the name to Skip Agent Acceptance.

4. Change the value in the Ending state field to Accepted.

This transition allows you to bypass the Accept state flow record that enables agents to
reject tasks.

5. Do not change the settings in these fields:
• Automatic condition string: This condition ensures that the current state is at

Pending Dispatch and the value in the Assigned to field changes: current.state
== 10 && current.assigned_to.changes()

• Automatic condition: The condition [Assigned to] [is not empty] ensures that all
dispatched tasks are accepted automatically.

Note:  The previous two condition statements have an [and] relationship. In this
example, the business rule runs when a task in a state of Pending
Dispatch is assigned to any agent.

• Automatic script: The automatic script sets the time the task was dispatched, using
the method: current.dispatched_on = gs.nowDateTime();.

6. Copy the record using the Insert and Stay command.

This action increments the record number and clears the Business rule field. The system
automatically creates a new business rule, using the name of the new state flow record.
The Skip Agent Acceptance business rule moves the task from Pending Dispatch to
Accepted automatically when a dispatcher enters a user name in the Assigned to field.
Note that any changes you make to this state flow record in the future are executed by
this business rule.

7. Ensure that the Active check box is selected.

August 6, 2018 ©2018 ServiceNow. All rights reserved. 425

ServiceNow | Customer Service Management



8. In the Work Task Flows list, locate the Accept state flow record and change the Active
status to false.

This action deactivates the transition that allows agents to accept tasks and moves the
state flow directly from Pending Dispatch to Accepted.

Field service groups
Last updated: July 26, 2018
Last updated: July 26, 2018

Field service groups are sets of users or agents, filtered by location, who can perform
specific field service tasks.

Work orders and work order tasks use several different types of groups, including
qualification, dispatch, and assignment groups. Administrators should set up an
administrator group and one or more of each type of field service group, then assign the
appropriate roles and users to those groups.

Before using the Field Service Management application in a production environment, create
at least one group of each type to cover all locations. Field service group information can be
found in User Administration > Groups and Field Service > Group Management.

Qualification groups

A qualification group is a set of users who can provide technical information regarding the
work to be performed to fulfill a work order or work order task.

If one qualification group covers the location specified on the work order, the group name is
automatically added to the Qualification group field on the work order when the work order
state changes to Awaiting Qualification. If no qualification group or more than one
qualification group covers the specified location, the Qualification group field is not
automatically populated; information can be added manually. If no qualification group is
assigned, the work order can remain without a qualification group and proceed through the
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work order life cycle. However, it is good practice to set up location coverage and
qualification groups.

Note:  The Qualification group field is hidden in the Work Order form when Field
Service Management is configured for automatic qualification.

Dispatch groups

A dispatch group is a set of users who can select an agent to complete a work order task.

Dispatch groups are filtered based on location coverage. If only one dispatch group covers
the location specified on a work order task, that group is added to the Dispatch Group field
on the work order task record automatically. If multiple dispatch groups cover the specified
location, use the lookup list to select a dispatch group. If no dispatch group is assigned, the
work order task cannot progress to the Pending Dispatch state.

Assignment groups and vendor groups

An assignment group is a set of agents or vendors, filtered by location, from which an
individual agent or vendor should be selected to complete a work order task.

If a dispatch group has been identified and the dispatch group only covers one assignment
group, that assignment group is added to the Assignment Group field on the work order
task record automatically. If the identified dispatch group covers multiple assignment
groups, use the Assignment Group field lookup list to select an assignment group. If the
Assignment Group field is empty, the system searches for assignment groups covering the
territory that includes the work order task's location.

Note:  When an assignment group of type Vendor is created, be sure to assign a
manager to the group who has the vendor manager role for assigning and
controlling vendor tasks. Also be sure to add vendors to the group.

• Create a group

Set up groups and assign the necessary roles and users. The users in the group inherit the
roles of the group, so you do not have to assign roles to each user separately.

• Groups in Field Service Management example

An example of how locations, qualification groups, dispatch groups, and assignment
groups can be created and used together for Field Service Management. The best
approach is to create locations first, then create the different types of groups and
associate locations to the groups.

Create field service groups

Last updated: July 26, 2018
Last updated: July 26, 2018

Set up groups and assign the necessary roles and users. The users in the group inherit the
roles of the group, so you do not have to assign roles to each user separately.

Before you begin

Role required: admin
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About this task

There are a few good practices when creating groups:

• Create one group for administrators and assign the admin role to this group only.
• Create as many groups as needed in your organization. For example, create a staff group

for each geographic location or function, such as building maintenance or building
security. Assign the necessary users to those groups, and then assign the staff role to
those groups.

Procedure

1. Navigate to User Administration > Groups.
2. Click New.
3. Fill in the fields on the form, as appropriate. See for an explanation of each field.
4. Click the lock icon beside the Type field. If the field is not visible, configure the form to

add it.
The Type field expands.

5. Click the reference lookup ( ) icon and select the [application] type.
6. Right-click the form header and select Save.
7. Add the [application]_admin or [application]_staff role to the Roles related list.
8. Add users to the Group Members related list.
9. Click Update.

Groups in Field Service Management example

Last updated: July 26, 2018
Last updated: July 26, 2018

An example of how locations, qualification groups, dispatch groups, and assignment groups
can be created and used together for Field Service Management. The best approach is to
create locations first, then create the different types of groups and associate locations to the
groups.

Company ZYX has a group of field service automation agents that cover four locations:

• San Diego
• Los Angeles
• San Jose
• San Francisco
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Group locations

There are two qualification groups that qualify work orders and work order tasks:

• Southern California
• Northern California

The Southern California qualification group covers the San Diego and Los Angeles locations.
The Northern California qualification group covers the San Jose and San Francisco locations.

Qualification group

There are four dispatch groups that select agents to complete work order tasks:

• San Diego
• Los Angeles
• San Jose
• San Francisco

Each dispatch group covers their corresponding location.
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Dispatch group

There are four assignment groups of agents that complete work order tasks:

• San Diego
• Los Angeles
• San Jose
• San Francisco

Each assignment group covers their corresponding location.

Assignment group

Using the four locations and the different groups, field service tasks can follow a logical flow
based on location. The work is qualified, dispatched, and then performed by people who are
as close to the work site as possible for maximum efficiency. For example, a work order with
San Francisco specified in the Location field is created. A member of the Northern California
qualification group qualifies the work order by adding detailed information. A member of
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the San Francisco dispatch group selects an agent from the San Francisco assignment
group to perform the tasks.

Field Service Management SLAs
Last updated: July 26, 2018
Last updated: July 26, 2018

ServiceNow SLAs track the service level provided by groups and individuals.

When you create a work order, the system automatically assigns it a default service level
agreement (SLA) based on priority level. If you change the priority of the work order, the
system cancels the current SLA and applies the SLA appropriate for the new priority. The
SLA timer continues to run even if the priority is changed. The three default SLAs used for
work orders are:

Default SLAs
SLA Description
WM - 5 business days Assigned to work orders with a priority level of 4

(Low)

WM - Next business day Assigned to work orders with a priority level of 3
(Moderate)

WM - Same business day Assigned to work orders with a priority level of 2
(High) or 1 (Critical)

Users with the wm_admin role can create and edit SLAs or delete them from work orders.
Changes to an SLA are used in new work orders, but they do not affect existing work orders
that use the SLA.

Note:  The SLA applies to the work order. All associated work order tasks must be
completed within the SLA time period to meet the SLA.

• Manage a work order SLA

View and manage work order SLAs from the Work Order form or the Work Order Task
form.

• Use the SLA map

View open work order tasks and their SLA status.

Manage a work order SLA

Last updated: July 26, 2018
Last updated: July 26, 2018

View and manage work order SLAs from the Work Order form or the Work Order Task form.

Before you begin

Role required: wm_admin, wm_dispatcher

About this task

Activities include suspending and resuming SLAs and deleting SLAs from a work order.

August 6, 2018 ©2018 ServiceNow. All rights reserved. 431

ServiceNow | Customer Service Management

https://docs.servicenow.com/bundle/london-customer-service-management/page/product/planning-and-policy/concept/../../service-level-management/concept/c_ServiceLevelAgreements.html
https://docs.servicenow.com/bundle/london-customer-service-management/page/product/planning-and-policy/concept/../../service-level-management/concept/c_ServiceLevelAgreements.html


Procedure

To view the list of work orders with SLAs, navigate to Field Service > Work Order > Work
Order SLAs.

Work order SLA form

• View a task with a SLA

View all work order tasks associated with work orders that have SLAs.

• Suspend and resume SLA timing from a work order

Pause and resume the timing on a work order SLA from the work order.

• Suspend and resume SLA timing from a work order task

Pause and resume the timing on a work order SLA from a work order task.

• Delete an SLA from a work order

Remove an SLA from a work order but leave it available for use with other work orders.

View a task with a SLA

Last updated: July 26, 2018
Last updated: July 26, 2018

View all work order tasks associated with work orders that have SLAs.

Before you begin

Role required: wm_admin, wm_dispatcher

Procedure

1. Navigate to Field Service > Work Order > Work Order Tasks With SLAs.

Tasks that are behind schedule are highlighted according to how delinquent they are.
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2. To view SLAs for a work order, select the Task SLAs related list in the Work Order form.

The information in this list includes:

Work order form
Information Description
Actual elapsed time Total running time of the SLA since it started,

including any time that has passed since a
breach.

Actual elapsed percentage Total percentage of the SLA time period that
has elapsed. This value can rise above 100%
after a breach and increases until the task is
completed.

Actual time left Total time remaining until this SLA breaches.
When the Actual elapsed percentage reaches
100%, this value is set to 0 seconds.

Business elapsed time Amount of time that has elapsed for this SLA
within the business calendar. For example, if the
business calendar for this SLA is from 8am to
5pm on weekdays, then the running time for
the SLA is computed between these hours only
and not on weekends. If no business calendar is
in effect, the business elapsed time is the same
as the actual elapsed time.

Business elapsed percentage Percentage of the SLA time period that has
elapsed on the business calendar for this SLA.
If no business calendar is in effect, the business
elapsed percentage is the same as the actual
elapsed percentage.

Business time left Time remaining on the business calendar until
this SLA is breached. If no business calendar is
in effect, the business time left is the same as
the actual time left. When the Business elapsed
percentage reaches 100%, this value is set to 0
seconds.

Suspend and resume SLA timing from a work order

Last updated: July 26, 2018
Last updated: July 26, 2018

Pause and resume the timing on a work order SLA from the work order.

Before you begin

Role required: wm_admin, wm_initiator, wm_qualifier, wm_dispatcher, or a combination role

About this task

This is useful if a qualifier or dispatcher is waiting for information from the caller or for other
actions to take place before continuing the work order.

Note:  Initiators cannot view the SLAs attached to the work orders they suspend or
resume.
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Procedure

1. Navigate to a work order with an SLA using the path visible to your role:

• Field Service > Work Order > Work Order SLAs
• Field Service > Work Order > Awaiting Qualification
• Field Service > Work Order > Draft Work Orders

2. Select an active work order.
3. On the work order record, add a work note explaining why the work order is suspended.
4. Click Suspend.

The system sets the Stage of the SLA to Paused.

5. Click Resume to restart the SLA.

The system resets the SLA to its previous stage.

Suspend and resume SLA timing from a work order task

Last updated: July 26, 2018
Last updated: July 26, 2018

Pause and resume the timing on a work order SLA from a work order task.

Before you begin

Role required: wm_admin, wm_qualifier, wm_dispatcher, wm_agent, or a combination role

About this task

This is particularly useful for agents because it enables them to suspend the timing on the
parent work order if they are waiting for information or for others to perform actions.

Procedure

1. Navigate to a work order task with an SLA using the path visible to your role:

• Field Service > Work Order > Work Order Tasks with SLAs
• Field Service > Work Order > My Work Order Tasks
• Field Service > Work Order > Assigned to me

2. Select an active work order task.
3. Add a work note explaining why you are suspending the work order.
4. Under Related Links, click Suspend Work Order.

The system sets the Stage of the SLA to Paused.

5. Click Resume Work Order to restart the SLA.

The system resets the SLA to its previous stage.

Delete an SLA from a work order

Last updated: July 26, 2018
Last updated: July 26, 2018

Remove an SLA from a work order but leave it available for use with other work orders.
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Before you begin

Role required: wm_admin

Procedure

1. Navigate to Field Service > Work Order > Work Order SLAs.
2. Open a work order.
3. In the Task SLAs related list, select the check box beside the SLA name.
4. In the Actions choice list, select Delete.

Use the SLA map

Last updated: July 26, 2018
Last updated: July 26, 2018

View open work order tasks and their SLA status.

The SLA map view allows users with the wm_admin, wm_dispatcher, or dispatcher
combination role to quickly see open work order tasks that are in danger of breaching their
SLAs.

When the SLA map appears, the view is centered on the logged in user's location, from the
Location field on the user record. Each task's icon color indicates the level of the SLA's
Business elapsed percentage. This is the percentage of the SLA duration that has expired on
the applicable business calendar, if one exists.

For example, a work order with an SLA of 5 business days starts on a Friday. On Tuesday the
actual elapsed percentage for the SLA reaches 100%. However, the business elapsed
percentage does not reach 100% until Thursday, because the business calendar shows that a
business day runs from 8am to 5pm on weekdays. If the SLA breaches on Thursday, the
business elapsed percentage continues upward from 100% until the task is completed. If no
business calendar is in use, the business elapsed percentage equals the actual elapsed
percentage.

• Access the map

How to access the SLA map.

• SLA map symbols

Icons in the SLA map and what they represent.

• Filter the SLA map

How to filter the SLA map.

• Manage a task with an SLA

How to access and manage tasks with SLAs.

Access the map

Last updated: July 26, 2018
Last updated: July 26, 2018

How to access the SLA map.

Before you begin
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Role required: wm_admin, wm_dispatcher, or dispatcher combination role

Procedure

To access the SLA map, navigate to Field Service > Dispatching > My SLA Map.

The map opens in the geographical area containing work orders with SLAs that are assigned
to your dispatch group.

Related Concepts

• Dispatch map

SLA map symbols

Last updated: July 26, 2018
Last updated: July 26, 2018

Icons in the SLA map and what they represent.

SLA map symbols
Icon Title Description

Agent on schedule Current location of an agent
selected in the filter. Agents with
this icon are on time or ahead of
schedule.

Agent behind less than 30
minutes

Current location of an agent
who is less than 30 minutes
behind schedule.

Agent behind less than 60
minutes

Current location of an agent
who is between 30 and 60
minutes behind schedule.

Agent behind more than 60
minutes

Current location of an agent
who is at least one hour behind
schedule.

Agent off the schedule Last known location of an agent
who is not currently on the
schedule or working on any
tasks.

Green Tasks with a business elapsed
percentage from 0 to less than
25.

Yellow Tasks with a business elapsed
percentage from 25 to less than
50.

Orange Tasks with a business elapsed
percentage from 50 to less than
75.

Red Tasks with a business elapsed
percentage over 100.

Multiple tasks Multiple active tasks with SLAs,
clustered by proximity.
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Icon Title Description
Multiple agents Multiple agents, clustered by

proximity.

Agent/Tasks Combination of agents and
tasks with SLAs, clustered by
proximity.

Filter the SLA map

Last updated: July 26, 2018
Last updated: July 26, 2018

How to filter the SLA map.

Before you begin

Role required: wm_admin, wm_dispatcher, or dispatcher combination role

Procedure

1. Click View Filter.

These filters are available:
• Date: Select the date you want to search.
• Show agents current location: Show or hide agent locations on the map. By default,

all agents are shown.

2. Select the desired filters.
3. Click Apply Filter to apply your changes to the map.

SLA map filter

Manage a task with an SLA

Last updated: July 26, 2018
Last updated: July 26, 2018

How to access and manage tasks with SLAs.

Before you begin

Role required: wm_admin, wm_dispatcher, or dispatcher combination role

Procedure

1. Click the task icon to display a pop-up window with these SLA details:

SLA details
Title Description
SLA Name of the SLA.
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Title Description
Time left Business elapsed time remaining on the SLA.

Priority Task priority by number, where 1 is the highest
and 5 the lowest.

Skills Needed Skills needed to perform the work.

Parts Needed Parts needed to perform the work.

SLA map detail

2. Click the task number link to display the record in a pop-up window in the map.
3. Select the Task SLAs related list to view the SLA details.
4. The list shows the following SLA values:

SLA values
Title Description
SLA Name of the SLA. Click this link to view the SLA

definition and its schedule.

Start time Time the SLA started.

Stage Status of this SLA, such as In progress,
Completed, or Breached.

Business elapsed percentage Percentage of time that has elapsed for this
SLA on the business calendar. If no business
calendar exists, then this value is the same as
the actual elapsed percentage.

Business time left Amount of time remaining for this SLA on the
business calendar. If no business calendar
exists, then this value is the same as the actual
time remaining.

Field Service Management overview module
Last updated: July 26, 2018
Last updated: July 26, 2018

The Field Service Management overview module is a homepage that displays various field
service reports.
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The widgets on this page help users track and manage aspects of the Field Service
Management processes, such as work orders, work order tasks, and dispatch locations.

Note:  If you have tasks defined with assignment groups of the type Vendor,
additional reports display useful information for tracking vendor tasks and
performance.

Access to the Field Service Management overview module is granted to a specific set of
user roles. Access is limited for users with non-administrative roles. The different levels of
access include:

• View: the user can view the overview page and refresh reports.
• Customize: the user can refresh, add, delete, and rearrange reports and other widgets.

Field Service Management overview module roles
Role Access
admin View, customize

sm_admin View, customize

sm_agent View

wm_basic View

wm_dispatcher View

wm_initiator View

wm_qualifier View

wm_initiator_qualifier View

wm_initiator_qualifier_dispatcher View

• Use the Field Service Management overview module

The Field Service Management overview module provides a dispatch map that displays
tasks and links to the related task records.

Use the Field Service Management overview module

Last updated: July 26, 2018
Last updated: July 26, 2018

The Field Service Management overview module provides a dispatch map that displays tasks
and links to the related task records.

Navigate to Field Service > Overview.

The map view depends on whether or not the Field Service Management Geolocation Demo
Data plugin (com.snc.work_management_geolocation.demo)is activated.

The dispatch map view with geolocation enabled groups tasks and agents by proximity and
displays related records in pop-up windows on the map.
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Dispatch map with geolocation
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The dispatch map view without geolocation enabled shows individual tasks by state and
displays related records in a separate window.

Dispatch map without geolocation

You can click elements within the reports to obtain more information without leaving the
overview page.

Work order templates
Last updated: July 26, 2018
Last updated: July 26, 2018

Work order templates allow you to quickly create well-defined work orders.

These templates automatically create tasks and part requirements on work orders for
common activities, such as password reset or memory upgrades. Work order templates and
work order task templates are added to the product catalog when the Field Service
Management plugin is activated.

Users with the wm_admin or model_manager role can create, edit, and delete work order
templates and work order task templates.

• Create a work order template
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Field Service Management uses the work order template as a source of information for
populating fields in a work order.

• Create a knowledge article for a work order template

You can add knowledge articles and guides (such as installation guides, maintenance
procedures, and checklists) to the default knowledge base for hardware, software, and
consumable templates.

• Use the work order template

Work order templates enable users with the proper roles to automatically create work
orders, tasks, and part requirements.

Create a work order template

Last updated: July 26, 2018
Last updated: July 26, 2018

Field Service Management uses the work order template as a source of information for
populating fields in a work order.

Before you begin

Role required: wm_admin or model_manager

About this task

Some of the predefined fields specific to the Work Order Templates table
(cmdb_workorder_product_model) have been removed from the template form. This
change enables the template form to be used with other tables, such as the table selected in
the Task Type field. Add fields to the template form as needed, such as the Assignment
group field, as part of template creation process.

Procedure

1. Navigate to one of the following:
• Product Catalog > Templates > Work Order Templates
• Field Service > Catalog & Knowledge > Work Order Templates

2. Click New.
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Work Order Template form

3. Fill out the fields on the Work Order Template form, as appropriate.
For fields in the Task Information section of the form, you can click Copy Task Template
and add the information from a task template if desired.

Work Order Template form fields
Field Description
Request information

Name [Required] Unique and descriptive name for
this template.

Short description [Required] Content that is copied into the
Short description field of a work order when
this work order template is used. The exception
to this is a work order created from an incident,
problem, or change request, which always uses
the short description of the source task, even
when a template is applied.

Description More in-depth description of the purpose of
the template.
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Field Description
Checklist template Select a checklist template to add a checklist to

the work orders created from this work order
template.

Workflow The workflow for work orders created from this
template.

Qualification group The qualification group for work orders created
from this template.

Task information

Task type The type of task to create. The default is Work
Order Task.

Name Unique and descriptive name for this task. As
you start to type the description of the task,
fields for your next task appear.

Description A description of this task.

Parts and quantities Parts requirements and quantities, as needed. If
you selected Part requirements are not needed
by agents on the Field Service Configuration
screen, the Parts and quantities fields are not
displayed.

Dispatch group The dispatch group used to select the
individuals who will fulfill the task. By default,
ServiceNow filters the list of available dispatch
groups by their proximity to the work order
task location. When the
work.management.limit.location property is set
to false, the system displays all dispatch groups
for selection, without any consideration of
location. If only one dispatch group is available
for a work order task in any location,
ServiceNow automatically enters that group in
this field. If the Field Service will not use the
dispatch queue option is selected in the Field
Service Configuration screen, this field is not
displayed.

Depends on Identifies the task of tasks that must be
completed before this task can be performed.
You cannot make an entry in the first task until
you have created subsequent tasks.

Checklist template Select a checklist template to add a checklist to
the tasks created from this work order
template.

4. If desired, add a field to the Request Information section of the template:
a. Click Edit fields and select the field from the choice list.
b. Add a value to the field.
c. Click the gear icon next to the field and enable the Show option if you want this field

to be displayed when this template is selected from the Field Service Catalog. If
desired, enable the Mandatory option to make this a mandatory field.

5. If desired, add one or more fields to the Task Information section of the template from
the table selected in the Task type field.
a. Click Edit fields and select the field from the choice list.
b. Add a value to the field.
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6. As you work with tasks, you can click the min and max buttons to expand and collapse
task information. If needed, you can also change the order of tasks using drag-and-drop.

7. If you set the Templates will not create a dedicated catalog item option on the Field
Service Configuration screen, the template screen includes a Publish button. You can
click this button if you want to manually publish a template as an item in the catalog. If
the option is set to Templates will create a dedicated catalog item, the Publish button
will not be displayed and the template will be automatically added to the catalog.

8. When you have completed your entries, click Submit.

Create a knowledge article for a work order template

Last updated: July 26, 2018
Last updated: July 26, 2018

You can add knowledge articles and guides (such as installation guides, maintenance
procedures, and checklists) to the default knowledge base for hardware, software, and
consumable templates.

Before you begin

Role required: wm_admin or model_manager

Procedure

1. Navigate to one of the following:
• Product Catalog > Templates > Work Order Templates
• Field Service > Catalog & Knowledge > Work Order Templates

2. Click New.
3. Fill in the fields on the Work Order Template form, as appropriate.

Work Order Template form fields
Field Description
Request information

Name [Required] Unique and descriptive name for
this template.

Short description [Required] Content that is copied into the
Short description field of a work order when
this work order template is used. The exception
to this is a work order created from an incident,
problem, or change request, which always uses
the short description of the source task, even
when a template is applied.

Description More in-depth description of the purpose of
the template.

Checklist template Select a checklist template to add a checklist to
the work orders created from this work order
template.

Workflow The workflow for work orders created from this
template.

Qualification group The qualification group for work orders created
from this template.

Task information

Task type The type of task to create. The default is Work
Order Task.
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Field Description
Name Unique and descriptive name for this task. As

you start to type the description of the task,
fields for your next task appear.

Description A description of this task.

Parts and quantities Parts requirements and quantities, as needed. If
you selected Part requirements are not needed
by agents on the Field Service Configuration
screen, the Parts and quantities fields are not
displayed.

Dispatch group The dispatch group used to select the
individuals who will fulfill the task. By default,
ServiceNow filters the list of available dispatch
groups by their proximity to the work order
task location. When the
work.management.limit.location property is set
to false, the system displays all dispatch groups
for selection, without any consideration of
location. If only one dispatch group is available
for a work order task in any location,
ServiceNow automatically enters that group in
this field. If the Field Service will not use the
dispatch queue option is selected in the Field
Service Configuration screen, this field is not
displayed.

Depends on Identifies the task of tasks that must be
completed before this task can be performed.
You cannot make an entry in the first task until
you have created subsequent tasks.

Checklist template Select a checklist template to add a checklist to
the tasks created from this work order
template.

Any hardware, software, and consumable assets you create and assign to the new
template are displayed in the Knowledge related list on the template record.

Use the work order template

Last updated: July 26, 2018
Last updated: July 26, 2018

Work order templates enable users with the proper roles to automatically create work
orders, tasks, and part requirements.

Before you begin

Role required: wm_admin or model_manager

Procedure

1. Navigate to Field Service > Work Order > Create New.
2. Select the desired work order template from the Template field and save the form.

The template information is used to:
• Copy the short description, priority, and billable status to the work order. The system

also copies the qualification group to the work order form if this field is present.
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Qualification groups are not required when automatic qualification is configured.
Work orders created from an incident, problem, or change request display the short
description from the source task, even when a template is selected. Tasks for work
orders created from templates always display the short description from the task
template.

• Create any tasks, using the information from the work task templates.
• Create the parts requirements. If a part specified is out of stock, the system displays

a message naming the part.

Manage work orders
Last updated: July 26, 2018
Last updated: July 26, 2018

Work orders are requests for off-site work. Users with the appropriate roles create the work
orders and provide the necessary information needed for the work order tasks. Then other
users qualify those work orders and create the tasks necessary to complete the work order.

For instructions on how to dispatch tasks using geolocation with Google Maps, see Using
the dispatch map.

Creating work orders

If you have the wm_initiator or wm_initiator_qualifier role, you can create work orders. You
can create entirely new work orders, or you can create a work order from another record.

Work orders can be created from these other record types: problem, incident, change, or
project task. They can also be created from another existing work order. For each record,
you can create only one work order.

Work orders created from another existing work order

If the scope of an existing work order changes during the execution phase, you can create
another work order from it. Analyze whether the scope change can be managed by adding
additional tasks instead of creating another work order.

When you create a work order from an existing work order, the following information is
copied from the original work order:

• Work order record reference (in the Initiated from field)

• Affected CI

• Caller

• Location

• Priority

• Short description

• Description

Because some information is copied from the original record, an existing work order can be
used as a template to create new work orders.
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Work orders created from an incident, problem, change, or project task record

If an incident, problem, change record, or project task must be assigned to an off-site agent
and tracked, you can create a work order from it. Some information from the original record
is copied automatically into the new work order.

Record type Fields copied to the work order
Incident

• Incident record reference (in the Initiated from
field)

• Caller

• Location

• Priority

• Short description

• Description

Problem
• Problem record reference (in the Initiated from

field)

• Affected CI

• Priority

• Short description

• Description

Change
• Change record reference (in the Initiated from

field)

• Affected CI

• Priority

• Short description

• Description

Project task

Note:  Before work orders can be
created from project tasks, Field
Service Management must be
integrated with Project Portfolio
Management

• Short Description

• Location

These work order fields are synchronized with
the project task

•
State

Scheduled start

Estimated end
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Record type Fields copied to the work order
For more details on the synchronized fields, see
Integration with Project Portfolio Management.

• Create a work order

When off-site work is requested, create a work order to provide information for the
agents who fulfill the request. You can create an entirely new work order, or you can
create a work order from these other record types: problem, incident, change, or project
task. You can also create a work order from another existing work order.

• Approve or reject a work order

When a work order is assigned to you for approval, review it to determine if the work is
required. You can also request more information for the work order before you decide
what to do with it. Work order approvals are mandatory only when Field Service
Management is configured to request them.

• Qualifying work orders

Work orders must be qualified to ensure that work order tasks are created and assigned.
The qualifying process can be automatic or manual.

• Closing work orders

In Field Service Management, work orders are closed automatically depending on the
states of the associated work order tasks.

• Cancel a work order

Cancel a work order if the work is no longer necessary or if it is a duplicate of another
work order.

• Delete a work order

For tracking purposes, you should close or cancel an existing work order that is no longer
in use. Closed and canceled work orders are inactive and do not appear on work order
lists. Avoid deleting a work order unless you are cleaning up errors, such as duplicate
work orders.

• Signed PDF summaries for closed work orders

In Field Service Management, customers can digitally sign and confirm work orders that
are closed with the Closed Complete or Closed Incomplete state. A PDF summary of the
signed work order is then created.

• Work order questionnaires

Create questionnaires and associate them with work orders and work order tasks.

Create a work order

Last updated: July 26, 2018
Last updated: July 26, 2018

When off-site work is requested, create a work order to provide information for the agents
who fulfill the request. You can create an entirely new work order, or you can create a work
order from these other record types: problem, incident, change, or project task. You can also
create a work order from another existing work order.
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Before you begin

Role required: wm_initiator, wm_initiator_qualifier, or admin

About this task

In the work order, specify the nature of the work required and identify the configuration
items (CI) affected.

To create work orders for common tasks such as the onboarding of new employees, you can
use work order model templates to create all the necessary records automatically.

Procedure

1. Create the work order.

Option Steps

Create a new work order a. Navigate to Field Service > Work Order >
Create New.

b. Enter a Short description.
Optionally, you can click the search

knowledge icon ( ) to view articles in
the knowledge base relating to this
product model, plan, or CI. Doing so could
provide a solution related to the reason
you are submitting a work order.

c. Click Submit.

Create a work order from an incident, problem,
change, project task, or another work order.

a. Open the record that you want to create
the work order from.

Note:  Before work orders can be
created from project tasks,
Field Service Management
must be integrated with
Project Portfolio
Management.

b. Right-click the form title bar and select
Create Work Order.

The work order is created in the Draft stage.

If you created the work order from another record, the short description of the original
record is copied as the short description of the work order. Some of the work order
fields are auto-filled with information from the original record. For details, see Creating
work orders.

2. Fill in the fields on the Work Order form, as appropriate.

Work Order form fields
Field Description
Number Auto-generated identification number for the

work order.
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Field Description
Company Company for which the work order was

opened. The lookup list shows only those
companies designated as Customers in their
company record.

Caller Person that requires the work. The lookup list
shows only users associated with the selected
Company.

Affected CI Primary item that requires work, such as a
broken laptop or a printer that needs ink.
Configuration Item lookup lists are based on
the selected Company. If more than one item
requires work, add them to the Affected CIs
related list.

When assigning CIs to individual tasks, the
qualifier and dispatcher can choose only from
the CIs in the Work Order Affected CIs related
list. The same CI in a work order can be applied
to multiple work order tasks.

Location Geographical area where the work must be
done. If not entered manually, the field is filled
automatically based first on the Affected CI
field and then, if no affected CI or location is
provided, on the Caller.

Template Template for creating this work order
(optional). Click the lookup icon and select a
template. The description of the selected
template will populate the Description field. If
you selected Tasks will be dispatched manually
in the Field Service Configuration screen, work
order tasks that were created for orders that
use templates are automatically transitioned to
Pending dispatch. For more information on
templates, see Creating Service Order
Templates.

Note:  If defined in advance, the
template may contain task
dependencies, which the tasks
in your work order will inherit.

Opened Date and time the work order was opened.

Priority Precedence of the work order, based on
severity of the impact, number of users
affected, or other factors. The SLA applied to
this work order is determined by the priority
selected in this field.

State Current stage of the work order in the work
order life cycle.

Qualification group Group that can specify the technical details of
the work order. The lookup list shows only the
qualification groups associated with the
selected Location. If no qualification groups
exist for the location, all qualifications groups
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Field Description
are listed and any can be selected. This field is
hidden when Field Service Management is
configured for automatic qualification.

Initiated from Record number of the original problem,
incident, change request, or other work order
from which the work order was created.

Billable Option for issuing a statement of fees or
charges for the work order. This is useful for
running reports on billable work orders.

Short description Brief explanation of the work order.

Description Detailed information describing the work to be
performed.
Initiators create work orders, but qualifiers
should add as much detail about the work to
be performed as possible to avoid extra
communication with the caller .

Work Notes Information about the work order and how it
was completed. This field is not visible to
customers. Work notes are added throughout
the work order life cycle to help users who
work on it to communicate useful information.

Scheduling

Scheduled start Date and time when the earliest task is
scheduled to start.

Estimated end Estimated date when all tasks will be
completed.

Actual work start Date and time when the earliest task actually
started.

Actual work end Date and time when the last task actually
ended.

Requested due by Estimated date when the latest task will be
completed. The Lead Time for the maintenance
schedule is subtracted from the Required Due
by date for the work order to determine this
date.

3. Click Submit or Update to save your changes.

What to do next

After you complete the Work Order form, move it to the next state that is configured for
Field Service Management. In the next state, other users with appropriate roles for the state
will process the work order.

On the Work Order form, click whichever of the following options is available:

Option Description
Ready for Approval Click Ready for Approval to move the work order

to the Waiting for Approval state.
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Option Description
This option appears only when Approval for new
request required is enabled in the configuration
for Field Service Management.

Ready for Qualification Click Ready for Qualification to move the work
order to the Awaiting Qualification state.

A work order task is automatically created if one
does not exist. The short description, description,
and location of the work order are copied into the
task.

The Ready for Qualification option is available
only when Qualification is required for new
requests is enabled in the configuration for Field
Service Management.

Ready for Dispatch Click Ready for Dispatch to move the work order
to the Ready for Dispatch state.
The Ready for Dispatch option is available only
when Approval for new request required and
Qualification is required for new requests are
disabled in the configuration for Field Service
Management.

Approve or reject a work order

Last updated: July 26, 2018
Last updated: July 26, 2018

When a work order is assigned to you for approval, review it to determine if the work is
required. You can also request more information for the work order before you decide what
to do with it. Work order approvals are mandatory only when Field Service Management is
configured to request them.

Before you begin

Role required: wm_approver_user or admin

About this task

Approvals are required only when Approval for new request required is enabled in the
configuration of Field Service Management. You can view all the work orders awaiting your
approval from the Field Service > Work Order > My Approval module. If you do not see this
module, Approval for new request required is disabled and you do not need to complete this
task.

Procedure

1. Navigate to Field Service > Work Order > My Approval, and click a work order that is in
the Requested state.

2. Review the work order, and then process it with one of the following options.

Option Description

Approve the work order Click Approve.
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Option Description
The work order is then moved to the next
state. Depending on the configuration of Field
Service Management, it is moved to the
qualification or dispatching state. In the next
state, other users with appropriate roles for the
state will process the work order.

Reject the work order a. From the State list, select Rejected.
b. In the Comment field, explain why this

work order is rejected.
c. Click Update.

The work order is then closed.

Cancel the work order because it is no longer
required

a. From the State list, select No Longer
Required.

b. Click Update.
The work order is then closed.

Request more information about the work
order

a. From the State list, select More
Information Required.

b. In the Comment field, ask for the
information that you need.

c. Click Update.
The work order reverts back to the Draft state
and the following work note is added to the
order: The order needs more information for
further approval.

Close the work order because it duplicates
another work order

a. From the State list, select Duplicate.
b. Click Update.

The order is moved to the Cancelled state and
the following work note is added to the order:
The order already exists.

Qualifying work orders

Last updated: July 26, 2018
Last updated: July 26, 2018

Work orders must be qualified to ensure that work order tasks are created and assigned. The
qualifying process can be automatic or manual.

Depending on how the Qualification is required for new requests option is set in the Field
Service Management configuration, the qualifying process is manual or automatic.

Manual qualification

When Qualification is required for new requests is enabled, the qualifying process is manual.
Each work order must go through these states of the process:

Awaiting Qualification > Qualified

In the Awaiting Qualification state, all the work order tasks must be qualified by a user with
the appropriate role.

August 6, 2018 ©2018 ServiceNow. All rights reserved. 454

ServiceNow | Customer Service Management



Qualifiers, who are users with the wm_qualifier role, select the dispatch group, add work
order tasks, and define part requirements. Qualifiers can also edit the affected CI, short
description, and description for work orders.

After all the tasks are qualified, the work order is moved to the Qualified state.

Work orders tasks can be qualified individually or in bulk.

Automatic qualification

When Qualification is required for new requests is disabled, the qualifying process is
automatic. The work order is automatically qualified and moved directly to the next state
that is configured for Field Service Management.

A task is also automatically created for each qualified work order. These work order tasks
are automatically qualified but must still be manually moved to the dispatch queue. Users
with the wm_initiator_qualifier or wm_admin roles can move the work order tasks.

Filtering available dispatch groups

The work.management.limit.location property controls whether the choice list of available
dispatch groups is filtered by proximity to the task location.

• Qualify work order tasks

When a work order is assigned to you for qualification, review and qualify its tasks to
ensure that they contain enough information for the groups that are dispatched to work
on them. Qualifying work order tasks is required only when Field Service Management is
configured for manual qualification.

• Move a work order task to the dispatch queue

If Field Service Management is configured to automatically qualify work orders, tasks are
also automatically created for the orders. When one of these automatically created tasks
is assigned to you, select a dispatch group for it and move it to the dispatch queue.

Qualify work order tasks

Last updated: July 26, 2018
Last updated: July 26, 2018

When a work order is assigned to you for qualification, review and qualify its tasks to ensure
that they contain enough information for the groups that are dispatched to work on them.
Qualifying work order tasks is required only when Field Service Management is configured
for manual qualification.

Before you begin

Role required: wm_qualifier

About this task

If Field Service Management is configured for automatic qualification, you do not need to
complete this process. Work orders are automatically qualified and tasks are automatically
created for them. For details on manual and automatic qualification, see Qualifying work
orders.
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On the Work Order form, you can qualify tasks from the Work Order Tasks related list. You
can qualify a single task or multiple tasks at the same time. While you qualify a single task,
you can also qualify any sibling tasks, which are different tasks that are related to the same
order.

Note:  If Field Service Management is configured to automatically assign tasks, you
must also select a dispatch group for each work order task. If you do not
select a dispatch group, you are prompted to select one before you can
qualify the task.

Procedure

1. Navigate to Field Service > Work Order > Awaiting Qualification, and click a work order.
If you do not see the Awaiting Qualification module, Field Service Management is
configured for automatic qualification.

2. To qualify a single work order task and any of its sibling tasks:
a. In the Work Order Tasks related list, click the task.
b. On the Work Order Task form, click Qualified.
c. From the Sibling Tasks related list, qualify any sibling tasks.

You can either click a single sibling task to qualify, or select multiple sibling tasks
from the list to qualify. After you select multiple tasks, select Qualified from the
Actions choice list.

3. To qualify multiple work order tasks:
a. In the Work Order Tasks related list, select the check box next to each task.
b. From the Actions choice list, select Qualified.

Move a work order task to the dispatch queue

Last updated: July 26, 2018
Last updated: July 26, 2018

If Field Service Management is configured to automatically qualify work orders, tasks are
also automatically created for the orders. When one of these automatically created tasks is
assigned to you, select a dispatch group for it and move it to the dispatch queue.

Before you begin

Role required: wm_initiator_qualifier, wm_admin, or admin

About this task

Procedure

1. Navigate to Field Service > Work Order > My Work Order Tasks.
2. Click a task in the Draft state.
3. On the Work Order Task form, make sure that a Dispatch group is selected.
4. Click Ready for Dispatch.

Closing work orders

Last updated: July 26, 2018
Last updated: July 26, 2018

In Field Service Management, work orders are closed automatically depending on the states
of the associated work order tasks.
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Work orders are closed in the following scenarios:

• If all work order tasks are marked Closed Complete, the work order state changes to
Closed Complete.

• If at least one work order task is marked Closed Incomplete, the work order state changes
to Closed Incomplete.

After a work order is closed, the time and effort for it are calculated automatically. The work
order also becomes inactive and is removed from the list of work orders.

After an order has been assigned to an agent, that agent can complete and close the order
under two conditions:

• When the Request lifecycle is task driven configuration option is enabled, all states of the
work order are driven by the task. The agent can click the Close Complete button on the
Work Order Task form to close any tasks that need to be closed manually. After all of the
work order's tasks are closed, the work order is closed automatically.

• When the Request lifecycle is request driven configuration option is set and all of the work
order's tasks are closed, the agent can click the Close Complete button on the Request
form to close and complete the order.

Cancel a work order

Last updated: July 26, 2018
Last updated: July 26, 2018

Cancel a work order if the work is no longer necessary or if it is a duplicate of another work
order.

Before you begin

Role required: Work orders can be canceled by users with different roles during specific
states in the work order life cycle.

About this task

When you cancel a work order, all associated work order tasks are also canceled.

Procedure

1. Navigate to Field Service > All Work Orders.
2. Click the work order.
3. In the Work notes field, enter a reason for canceling the work order.

A reason is required for canceling work orders. If you do not provide a reason, an error
message prompts you to enter one in the Work notes field.

4. Click Cancel.

Delete a work order

Last updated: July 26, 2018
Last updated: July 26, 2018

For tracking purposes, you should close or cancel an existing work order that is no longer in
use. Closed and canceled work orders are inactive and do not appear on work order lists.
Avoid deleting a work order unless you are cleaning up errors, such as duplicate work
orders.
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Before you begin

Role required: wm_admin

About this task

Deleting a work order automatically deletes all associated work order tasks, so agents are
not assigned work order tasks that are part of a deleted work order.

Procedure

1. Navigate to Field Service > All Work Orders.
2. Click the work order.
3. Click Delete.
4. Confirm the action when prompted.

Signed PDF summaries for closed work orders

Last updated: July 26, 2018
Last updated: July 26, 2018

In Field Service Management, customers can digitally sign and confirm work orders that are
closed with the Closed Complete or Closed Incomplete state. A PDF summary of the signed
work order is then created.

The summary includes the completed tasks, parts used and returned, incidental expenses,
and the time required to complete the work. The PDF also includes the name and signature
of the customer.

Enabling signed PDF summaries for work orders

Before PDF summaries for work orders can be generated, an administrator must complete
the following tasks:

1. Activate the Field Service – Signature Pad plugin (com.snc.wo_signature_pad). The
plugin installs the following table and script include.

Table

Table Description
Signature Images
[signature_image]

Stores images of customer signatures for work
orders.

Script include

Script include Description
GeneralWOForm Creates a PDF of the work order form.

2. In the Field Service Management configuration, enable Signature Capture and PDF
Order Summary.
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Create a signed PDF summary for a work order

If PDF summaries are enabled for Field Service Management, you can request that
customers digitally sign and confirm a closed work order. A PDF summary of the signed
work order is then created.

Before you begin

Role required: wm_agent

About this task

When a work order is closed, you are notified with a link to the work order. Open the work
order to request a signature from the customer.

Procedure

1. When you receive a message about the completed work order, click the link in the
message to open the Work Order form.
You can also find closed work orders by navigating to Field Service > Work Order > All
Work Orders.

2. In the title bar of the Work Order form, click Sign & Confirm.
You can also click the Sign & Confirm related link.

3. In the Signature Pad window, ask the customer to enter their name in the Name field and
sign their name in the Signature field.

4. Click Accept.

Result

The signed PDF summary is generated and attached to the Work Order form.

Work order questionnaires

Last updated: July 26, 2018
Last updated: July 26, 2018

Create questionnaires and associate them with work orders and work order tasks.

As part of completing some work orders and tasks, field service agents fill out
questionnaires or complete checklists. For example, an agent might need to complete a
safety checklist before starting work on a task or fill out an inspection questionnaire before
completing a work order.

The work order questionnaire feature enables users with the system administrator role to
create questionnaire records and associate those records with work orders or work order
tasks. Questionnaire records include some configuration information, such as the condition
or event that triggers the questionnaire, as well as the list of questions included in the
questionnaire. The Survey Designer tool is used to create the questionnaires.

When a work order or task has an associated questionnaire, the Questionnaires button
appears at the top of the form. Clicking this button displays the Questionnaires page, where
the agent can complete the questionnaire or checklist.

Enable the work order questionnaire feature by activating the Field Service - Questionnaire
plugin (com.snc.wm_questionnaire). This plugin requires the following plugins:
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• Customer Service (com.sn_customerservice)
• Customer Service Management Demo Data (com.snc.customerservice.demo)
• Field Service Management (com.snc.work_management)

The Field Service - Questionnaire plugin adds the Questionnaire module to the Field Service
menu (Field Service > Administration > Questionnaire).

Demo questionnaire

One demo questionnaire record, Inspection Questionnaire, is included with the Field Service
- Questionnaire plugin. This questionnaire record has a trigger condition that adds a
questionnaire to a work order task when the task state changes to Work in Progress.

Questionnaire form

This demo questionnaire works as follows:

1. The dispatcher assigns a work order task to an agent.
2. The agent accepts the task and clicks Start Work on the task form.
3. The task state changes to Work in Progress and the Questionnaires button appears in

the task form header.
4. The agent clicks Questionnaires to display one or more available questionnaires for the

task.
5. The agent clicks Start on the desired questionnaire.
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6. The agent completes the questionnaire and clicks Submit Save
7. The agent returns to the work order task, completes the work, and closes the task.

Note:  Questionnaires are not editable after the associated work order or task is
closed.

Troubleshooting the questionnaire feature

If a trigger condition is defined for the task state as Work in progress rather than when the
task state changes to Work in progress, every update of the work order task creates a
questionnaire.

When a task gets reassigned to another agent, the existing questionnaires do not get
reassigned.

Configure the form layout and add the Assigned to field to ensure that a questionnaire does
not get created without an assigned agent.

• Create a questionnaire for a work order or task

Create a questionnaire record and then associate it with a table such as the Work Order
or Work Order Task tables.

• Complete a questionnaire for a work order or task

Field service agents can access and complete questionnaires from the Work Order or
Work Order Task forms.

Create a questionnaire for a work order or task

Last updated: July 26, 2018
Last updated: July 26, 2018

Create a questionnaire record and then associate it with a table such as the Work Order or
Work Order Task tables.

Before you begin

Role required: admin

About this task

The system administrator can view questionnaire records from the Questionnaire list and
questionnaires by navigating to Surveys > View Surveys.

Procedure

1. Navigate to Field Service > Administration > Questionnaire.
2. Click New.
3. Fill in the fields on the Questionnaire form to create a new questionnaire record.

This record stores the basic information for the questionnaire.

Questionnaire form fields (new record)
Field Description
Name The name of the questionnaire.
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Field Description
Active Enable this check box to make the

questionnaire record active. The system
administrator can attach active questionnaires
to work orders and work order tasks.

Description A brief description of the questionnaire record.

Introduction Text that appears at the beginning of the
questionnaire.

End note Text that appears at the end of the
questionnaire.

Table The table with which this questionnaire record
is associated.

Trigger condition The trigger condition determines when the
questionnaire is applicable. Use the condition
builder to create a trigger condition that adds
the questionnaire to the work order or work
order task.

Mandatory Enable this check box to make the
questionnaire mandatory. When enabled, the
agent must complete the questionnaire before
closing the work order or work order task.
If you enable the Mandatory check box, you
must also select a state in the Close before
field.

Close before If the questionnaire record is mandatory, select
one or more states by which the questionnaire
must be completed. The questionnaire must be
completed before the agent can set the work
order or work order task to the selected states.

4. Click Submit.
The system creates the record, displays the Questionnaire form, and adds the
Questionnaire Designer button.

5. If desired, make changes to the fields on the Questionnaire form and click Update.
6. Click Questionnaire Designer to create the text of the questionnaire.

The Survey Designer tool opens in a new window.
7. Use the Survey Designer tool to create the questions or checklist items that appear on

the questionnaire.
8. Click Save.
9. Close the Survey Designer window and return to the Questionnaire form.

Complete a questionnaire for a work order or task

Last updated: July 26, 2018
Last updated: July 26, 2018

Field service agents can access and complete questionnaires from the Work Order or Work
Order Task forms.

Before you begin

Role required: wm_agent

About this task
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If one or more questionnaires are available for a work order or work order task, the
Questionnaires button appears at the top of the form. Clicking this button displays the
questionnaires.

Agents can also navigate to Self-Service > My Assessments & Surveys to see questionnaires
for work orders and work order tasks.

Note:  Users who can view a work order or task can also view associated
questionnaires. Users who are assigned to a work order or task can complete
associated questionnaires.

Procedure

1. Open a work order or work order task.
2. Click Questionnaires.

The Questionnaires page opens and displays the questionnaires associated with the task
record. Each questionnaire is listed as an individual tile and displays the associated work
order or task number.

3. Click Start on the questionnaire tile.
The questionnaire opens in the window. A message at the top displays the related work
order or task number.

4. Complete the questionnaire.
5. Click Submit or Save.

Option Description

Submit Submits the questionnaire and returns to the
work order or task form. Once submitted, an
agent cannot make changes to the
questionnaire. Upon returning to the
questionnaire list, an agent can only view the
responses. (Tile displays View.)

Save Saves the questionnaire and returns to the
work order or task form. Once saved, an agent
can return to the questionnaire and make
changes or add information. (Tile displays
Start.)

6. Complete any remaining work and then close the task.

Note:  If mandatory, you must complete the questionnaire before closing the
task.

Manage work order tasks
Last updated: July 26, 2018
Last updated: July 26, 2018

Use work order tasks to define separate activities that must be done to complete a work
order.

A work order contains one or more work order tasks. These tasks allow qualifiers to define
separate activities that must be done to complete a work order.

When a user with the wm_qualifier role or a qualifier combination role moves a work order
from Draft to Awaiting Qualification, a work order task is automatically created and
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populated with information from the work order. This user can edit existing tasks or create
new tasks at any time.

A key feature in Field Service Management is the ability to create multiple work order tasks
under a single work order. Splitting a work order into separate tasks, when necessary,
enables qualifiers to:

• Assign different aspects of a single work order to different agents.
• Assign work to agents with different skill sets.
• Assign work to agents in different locations.
• Schedule parts of the work at different times.
• Schedule tasks so they are done one after another.
• Schedule tasks so they are done at the same time by different agents.
• Schedule additional tasks, if necessary, to complete the work order.
• Coordinate the arrival and usage of the parts required to complete a work order.

• Create a work order task

Create a work order task from a work order.

• Clone a work order task

Clone existing tasks to quickly create new tasks.

• Delete a work order task

Work order tasks can be deleted by users with the wm_admin role.

• Create dependencies between work order tasks

If a work order contains multiple tasks, you can create dependencies between the tasks
that determine the order in which tasks are performed.

• Create a work order task dependency using a work order template

In addition to creating work order task dependencies that are inherited from the
associated work orders, you can also create work order templates that contain task
dependencies.

Create a work order task

Last updated: July 26, 2018
Last updated: July 26, 2018

Create a work order task from a work order.

Before you begin

Role required: wm_qualifier or qualifier combination role

About this task

A task window is the time period, bordered by start and end times, in which a task should be
performed. It can be flexible or fixed and is used by the auto-routing and auto-assignment
features to determine an agent's daily schedule.

• A flexible window has start and end times that the Field Service Management application
attempts to respect when dispatching or routing a task automatically. The system can
reschedule a flexible task window if necessary to make it fit into an agent's schedule.
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• A fixed task window cannot be rescheduled. If the auto-router or auto-dispatcher cannot
schedule the task for the fixed window time period, that task is not scheduled at all. The
time interval configured for a window cannot be less than the time required to perform the
task.

These users can edit schedule times, including task windows and planned durations. The
Estimated end time is calculated from the expected start time and the work duration and is
read-only.

Schedule task roles
Role Edit capabilities
wm_qualifier Tasks in the Draft state.

wm_dispatcher Tasks in the Pending Dispatch state.

wm_admin Tasks in Draft or Pending Dispatch state.

Procedure

1. Open a work order.
2. Click the Work Order Tasks related list and then click New.

Note:  If the Approval for new request required configuration option is enabled,
the New button in the Work Order Tasks related list does not appear until
the work order has been approved. Also, if you are attempting to create a
work order task using a template, the task is not be created until the work
order has been approved.

3. Fill in the fields on the Work Order Task form, as appropriate.

Work Order Task form fields
Field Description
Number Auto-generated identification number for the

task.

Parent Work order this task is assigned to.

Cloned from Record number of the work order task this task
was cloned from, if any.

Priority Priority of this task.

Location Geographical area where the work needs to be
done. The location is critical for determining
the agent assigned to the task.

Skills Abilities necessary to execute the task.
ServiceNow automatically completes the Skills
field based on the selection in the Affected CI
field on the associated work order. If you
change the affected CI on the work order, the
system adds any skills required by the new CI
to the skills already listed here.
If you want to identify mandatory skills for
agents executing the tasks, you must configure
this form to display the Task-Skill table.
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Field Description
Under warranty Indicator of an existing warranty for one or

more configuration items associated with the
task. Qualifiers can select and clear this option.

State Current state of the task, such as Accepted or
Closed Complete. ServiceNow advances the
state automatically as users complete the work
for each successive state.

Dispatch Group Group that can select an agent to complete the
task. By default, a Field Service Management
property is enabled to limit the dispatch groups
that you can select to those groups that belong
to the location that you selected. If no dispatch
groups exist for the location, all dispatch
groups are listed for assignment of the tasks.

Assignment group Group from which an individual agent or
vendor should be selected to complete the
task. The lookup list shows only the assignment
groups associated with the selected Location. If
the Assignment Group field is empty, the
system searches for the group covering the
territory that includes the location of the task.

Assigned to Individual agent or vendor who should
complete the task, selected from the
Assignment group. If you have defined skills
and assigned them to agents, the Assigned to
field lookup list shows only those agents in the
assignment group who have all the Skills
required. If no exact match of skills is found, the
lookup list shows all assignment group
members. If an assignment group of type
Vendor is selected, this field defaults to the
vendor manager assigned to the selected
vendor group. If the vendor group does not
have a manager, the Assigned to field is left
blank.

Assigned vendor Individual vendor who should complete the
task, selected from the Assignment group. This
field displays only when an assignment group
of type Vendor is selected.

Vendor reference A reference number for tracking the selected
vendor's work activities. This field displays only
when an assignment group of type Vendor is
selected.

Short Description Brief explanation of the task.

Description Exact technical description of the unit of work
to be performed. Qualifiers should provide as
much detail about the problem as possible to
avoid extra communication with the caller in
later stages of the work order life cycle.

Work notes Information about the task as it progresses
through each state. Work notes are not visible
to customers.

Planned

Window start Start of the time window established for this
task. Auto-routing and auto-dispatch use this
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Field Description
time when calculating the agent's daily
schedule.

Window end End of the time window established for this
task. The elapsed time of the window cannot
exceed the value in the Estimated work
duration field. Auto-routing and auto-dispatch
use this time when calculating the agent's daily
schedule.

Scheduled travel start Date and time when the agent expects to travel
to the site. In versions at Eureka or later, the
travel start time is automatically set to one
hour from the current time. In versions prior to
Eureka, the travel start time is set to the
beginning of the next hour. For example, if you
save the Work Order Task record at 9:35 am,
the scheduled travel start is automatically set
to 10:00am. When the task reaches the
Pending Dispatch stage, the default value can
be edited. An agent cannot be scheduled for
two tasks at the same time. If a specified time
is already allocated to another task, an error
message is displayed.

This field is required when the task is assigned
or when the state is Assigned, Accepted,
Pending Dispatch, or Work In Progress.

Scheduled start
Date and time that work on the task is
expected to begin.

• The scheduled start date is pre-filled with
the date calculated by subtracting the
number of days entered in the Lead Time
field for the maintenance schedule from
the Required Due by date for the work
order.

This field is required when the task is assigned
or when the state is Assigned, Accepted,
Pending Dispatch, or Work In Progress.

Estimated end [Read-only] Date on which work on the task
will end. The date is automatically calculated
based on the Scheduled start and Estimated
work duration.

Is fixed window Indicator of a fixed service window that cannot
be shortened or extended to accommodate
other tasks in an agent's daily schedule. If this
checkbox is not selected, the service window is
considered flexible. A flexible task window can
be rescheduled by auto-routing and auto-
assignment, but a fixed window cannot. If a
fixed window task does not fit into the agent's
schedule, the task is not routed or dispatched.

Estimated travel duration Estimated amount of time to be spent traveling
to the site. A time of one hour is set by default.
When the task reaches the Pending Dispatch
stage, the default value can be edited.
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Field Description
Estimated work duration Estimated amount of work time. One hour is

set by default. The default value can be edited
during the Draft or Pending Dispatch stage.
The estimated work duration cannot exceed
the total time of the window, if one is defined
for this task.

Actual

Actual travel start Date and time agent traveled to the site.

Actual work start Time when work began. This field is not
available until Actual travel start time is added
manually or the Start Travel button is clicked.

Actual work end Time when work on the task was completed.

Actual travel duration Amount of time spent traveling to the site.

Actual duration [Read-only] Total amount of time spent
traveling to the site and completing the task.
This value is automatically calculated based on
the Actual work start and Actual work end
times.

Related Lists

Task SLA SLAs associated with the parent work order.

Work Order Task Affected CIs Configuration items (CIs) associated with the
task. CIs are items that requires work, such as a
broken laptop or a printer that needs ink

Part Requirements Part requirements associated with the task.

Transfer Orders Orders for transferring the necessary parts
between stockrooms for this task.

Asset Usages Records indicating if the parts requested for
this task were used, not used, or removed
because they were defective.

Depends on Upstream dependencies associated with the
task.

Dependents Downstream dependencies associated with the
task.

Incidentals Incidental expenses associated with this task.

Clone a work order task

Last updated: July 26, 2018
Last updated: July 26, 2018

Clone existing tasks to quickly create new tasks.

Before you begin

Role required: wm_qualifier or qualifier combination role

About this task

In the cloning process, the following information is copied from the source task:
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• Parent work order reference
• Short description
• Description
• Dispatch group
• Assignment group
• Location
• Planned information (scheduled and estimated, no actuals)
• Required skills

Procedure

1. Open the task from the related list in a work order.
2. Select the Clone Task related link.

This creates a new task in Draft state.

An entry in the Work Notes field contains the original task number and text stating that
the task is a clone.

Delete a work order task

Last updated: July 26, 2018
Last updated: July 26, 2018

Work order tasks can be deleted by users with the wm_admin role.

Before you begin

Role required: wm_admin

About this task

A task cannot be deleted if it has a part requirement with a transfer order. To delete the task
in this case, you must first delete the transfer order.

Procedure

1. Navigate to a work order.
2. In the Work Order Tasks related list, select the check box beside the task Number.
3. Select Delete from the Actions choice list.

Create dependencies between work order tasks

Last updated: July 26, 2018
Last updated: July 26, 2018

If a work order contains multiple tasks, you can create dependencies between the tasks that
determine the order in which tasks are performed.

Before you begin

Role required: wm_qualifier or qualifier combination role

About this task

These dependencies set and enforce the order in which a single agent or multiple agents
perform the tasks. For example, on a work order for a new server, one agent might install the
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server, the upstream task, and a different agent might configure the server after installation
is complete, the downstream task.

You can specify multiple dependencies, both upstream and downstream, for a single task.
The system prevents circular relationships where two tasks are dependent on each other by
considering all upstream dependencies when deciding if a task can be auto-assigned.

• Setting a work order task as an upstream task means that this task must be completed
before any downstream tasks can be started.

• Setting a work order task as a downstream task means that this task cannot be started
until any upstream tasks have been completed.

Note:  Dependencies can only be set for work order tasks in the Draft state.

Procedure

1. Navigate to a work order.
2. Open a work order task in the Draft state.
3. In the Depends on related list, click New.
4. Select either Upstream task or Downstream task.

Only tasks for the same work order are listed.
5. Click Submit.

Create a work order task dependency using a work order template

Last updated: July 26, 2018
Last updated: July 26, 2018

In addition to creating work order task dependencies that are inherited from the associated
work orders, you can also create work order templates that contain task dependencies.

Before you begin

Role required: wm_qualifier or qualifier combination role

About this task

Like work order tasks created from work orders, the dependencies inherited from the
template enforce the order in which a single agent or multiple agents perform the tasks.

Procedure

1. Navigate to Product Catalog > Templates > Work Order Template.
2. Create a new work order template.
3. Create the work order tasks.
4. Open one of the tasks.

• If other tasks are dependent on this task; that is, this task must be completed before
other tasks can be completed, click Dependents > New and select the dependent
tasks.

• If this task is dependent on other tasks; that is, other tasks must be completed
before this task can be completed, click Depends on > New and select the tasks to
which this task is dependent.

5. Repeat this process for the remaining tasks.
6. When you have defined the dependencies for all tasks, click Update.
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After the work order task dependencies are defined, you can select the template when
creating a new work order, and the tasks, along with the defined dependencies, will be
inherited by the work order.

Part requirements
Last updated: July 26, 2018
Last updated: July 26, 2018

After all work order tasks are qualified and the parent work order state automatically
changes to Qualified, you can request more information from the qualifier, if necessary, and
source any parts required for the tasks.

If a work order was created from a work order template, the part requirements are
automatically added to the work order task.

The examples included in this topic illustrate the use of part requirements with work orders;
however, part requirements can be used with any Service Management application.

To create part requirements and source parts, the Part requirements are needed by agents
configuration option must be enabled on the Field Service Configuration screen.

• Request additional information

Transfer orders move necessary parts to the location where the agent can receive them. If
there is not enough information to create a transfer order, the dispatcher can request
more details from the qualifier.

• Source parts

Sourcing a part is the process of reserving and obtaining an asset described in a part
requirement record, either by ordering it from a vendor or transferring it from one
stockroom to another.

• Manage part requirements

Create, copy, and delete part requirements as required for work order tasks.

• Transfer orders

Use a transfer order to move necessary parts between company stockrooms or to a
location where an agent can recieve them.

• Transfer parts

Agents, dispatchers, and users with combined roles can transfer parts.

Request additional information

Last updated: July 26, 2018
Last updated: July 26, 2018

Transfer orders move necessary parts to the location where the agent can receive them. If
there is not enough information to create a transfer order, the dispatcher can request more
details from the qualifier.

Before you begin
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Role required: wm_dispatcher or wm_admin

Procedure

1. Navigate to Field Service > Dispatching > Dispatch Queue.
2. Open a work order task in Pending Dispatch state.
3. In the Work Notes field, enter a reason for returning the work order.
4. Click Request more information.

The task state changes to Draft and the work order state changes to Awaiting
Qualification. If Field Service Management is configured for automatic qualification, the
work order state remains at Qualified.

Source parts

Last updated: July 26, 2018
Last updated: July 26, 2018

Sourcing a part is the process of reserving and obtaining an asset described in a part
requirement record, either by ordering it from a vendor or transferring it from one
stockroom to another.

Users who can create work orders can create part requirements by using work order
templates or by manually using the procedures on this page. Agents, qualifiers, and
dispatchers, including users with the combination roles, can create and source a part
requirement.

• A qualifier determines if parts are necessary to execute work order tasks.
• A dispatcher sources the part requirements and creates transfer order lines.
• A dispatcher or agent moves the parts through the transfer process.
• An agent accepts delivery of the parts and records part usage.

Part requirements must be associated with a work order task. After parts are identified, a
transfer order is created to move the parts from the stockroom where they are located to a
different stockroom or directly to an agent. Agents can be selected based on skills and the
availability of parts in their personal stockrooms. One work order task can have multiple part
requirements and multiple transfer orders.

• In one work order task, multiple part requirements may require different items that can all
be found in one stockroom. One transfer order can satisfy the part requirements. The
transfer order will have multiple transfer order lines, each specifying a different item based
on the part requirements.

• When one stockroom has all required items, a single transfer order line can fulfill the order
when moving consumable assets. One or more transfer order lines may need to be created
when moving non-consumable assets. (For more information about consumable and non-
consumable assets, see Managing Assets.)

• If a single stockroom does not contain all the items needed for the part requirement,
create an additional transfer order line to a different stockroom. Because the new transfer
order line specifies a different stockroom, a separate transfer order is automatically
created. One part requirement is then fulfilled by two separate transfer orders to two
different stockrooms.

When a technician/agent is working on a task, and requires a part, she should be able to use
the part from her personal stock room, when available, without going through the sourcing
process.
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With simplified part sourcing, an agent can create a part requirement and use a part from
their personal stockroom without going through the sourcing process. This is helpful for
agents who are already working on tasks and have access to the necessary parts. The Use
Asset and Remove Asset buttons are available on the Asset Usages related list on the Work
Order Task form.

Simplified part sourcing

With simplified part sourcing, an agent can create a part requirement and use a part from
their personal stockroom without going through the sourcing process. This is helpful for
agents who are already working on tasks and have access to the necessary parts. To use
simplified part sourcing, click the Use Asset button on the Asset Usages related list on the
Work Order Task form.

Related Tasks

• Record asset usage

Manage part requirements

Last updated: July 26, 2018
Last updated: July 26, 2018

Create, copy, and delete part requirements as required for work order tasks.

If the agent assigned to the task does not have the skills or parts required, the dispatcher
can select an agent who is better equipped to complete the task.

• Create a part requirement

Create a part requirement for a work order task.

• Copy a part requirement

Copy a part requirement to quickly create another, similar part requirement.

• Delete a part requirement

Delete a part requirement from a work order task.

• Source a part and assign an agent

The work order sourcing option is useful when you want to assign a work order task to
agents who already have the required parts in their stockroom or to a specific agent who
needs you to obtain the parts for them.

Create a part requirement

Last updated: July 26, 2018
Last updated: July 26, 2018

Create a part requirement for a work order task.

Before you begin

Role required: wm_agent, wm_qualifier, wm_dispatcher, wm_admin, or qualifier combination
role
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Procedure

1. Navigate to Field Service > Work Order > All Work Orders.
2. Open a work order.
3. Open a work order task that is not in the Closed or Cancelled state.
4. Do one of the following:

Option Description

Click Source. All tasks and part requirements are listed on
the left. Point to any task or part requirement
icon to obtain more information. Right-click a
work order task and select Create Part
Requirement. This method is useful if you are
sourcing multiple parts for a work order task.

In the Part Requirements related list, click New. This method is useful if you are sourcing a
single part for a work order task.

5. Fill in the fields, as appropriate.

Part Requirement form fields
Field Description
Number Auto-generated number for the part

requirement.

Work order task Number assigned to the work order task.

Model Description of the part model needed to
complete the work order task.

Required by date Date by which all parts should be delivered.
The date is filled in automatically based on the
task's expected travel start time. If necessary,
change the date manually.

Required quantity Total quantity necessary to complete the part
requirement. This field becomes read-only
when the full number of required parts has
been sourced.

Reserved quantity Total quantity that has been sourced already.

Sourced Indicator for whether the required quantity for
this part requirement has been reserved and
transfer requested from one stockroom to
another.

Delivered Indicator for whether the transfer order lines
under this part requirement have been
delivered or not.

Short description Contents of the Short description field from the
parent work order. If the work order was
created from an incident, problem, or change
request, the short description of the part
requirement is inherited from that record. If the
work order was created automatically from a
work order model, the short description is from
model template. This field is not visible by
default.

6. Click Submit.
If the part is out of stock, a message appears at the top of the form naming the part.
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7. If someone other than the qualifier will source the part requirement, create transfer
order lines, move the part from a stockroom to an agent, and click Qualified.

Note:  Part requirement record numbers start with an SOPR prefix and the
records are stored in the [sm_part_requirement] table in the Service
Order Management application. Part requirements created in prior
releases start with an WOPR prefix.

Copy a part requirement

Last updated: July 26, 2018
Last updated: July 26, 2018

Copy a part requirement to quickly create another, similar part requirement.

Before you begin

Role required: wm_agent, wm_qualifier, wm_dispatcher, wm_admin, or qualifier combination
role

Procedure

1. Navigate to Field Service > Work Order > All Work Orders.
2. Open a work order.
3. Open a work order task that is not in Closed or Cancelled state.
4. Click Source.
5. In the Source Work Order list, right-click on a work order part number and select Copy

Part Requirement.

This action copies the part requirement information to the clipboard.

6. In the Source Work Order list, right-click on a work order task number and select Paste
Part Requirement.

Delete a part requirement

Last updated: July 26, 2018
Last updated: July 26, 2018

Delete a part requirement from a work order task.

Before you begin

Role required: wm_qualifier or qualifier combination role

Procedure

1. Navigate to Field Service > Work Order > All Work Orders.
2. Open a work order.
3. Open a work order task that is not in Closed or Cancelled state.
4. Click Source.

The Source Work Order list appears, showing the part requirement records in a tree
structure.

5. Right-click on a part requirement number and select Delete Part Requirement from the
context menu.
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The system deletes the part requirement without displaying a confirmation message.

Source a part and assign an agent

Last updated: July 26, 2018
Last updated: July 26, 2018

The work order sourcing option is useful when you want to assign a work order task to
agents who already have the required parts in their stockroom or to a specific agent who
needs you to obtain the parts for them.

Before you begin

Role required: wm_agent, wm_qualifier, wm_dispatcher, wm_admin, or qualifier combination
role

About this task

The sourcing option shows the full list of tasks and part requirements to source for a work
order or task. For each task, the agents and stockrooms that have the required parts are
listed. Also, the skills and parts required for each task are displayed. Select an agent to see if
the agent has the skills and parts required for the task. The time slots during which the
agent is available within the work order window are shown to help you schedule task work
efficiently.

Procedure

1. Navigate to Field Service > Work Order > All Work Orders.
2. Open a work order.
3. Open a work order task that is not in Closed or Cancelled state.
4. Click Source.
5. In the Source Work Order list, click a work order task.

Work Order Task Sourcing screen
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The Agent field under Agent info is populated automatically based on information
provided in the work order task.

6. To specify a different agent, click the reference lookup icon ( ).

Only agents that meet the criteria in the work order task are available for selection. The
system populates the Skills and Parts fields automatically, based on the agent specified.

If a not available icon ( ) appears next to a part, the specified agent either does not
have the part or does not have enough units of the part to complete the task.

7. Point to the icon to obtain information about how many units of the part are needed
and how many units the agent has in their stockroom.

8. To filter agents and reserve parts, click the arrow next to Agent info to expand the
section.

Expanded sourcing screen

• Select the skills and parts options to filter the agents.
• Select Reserve parts in agent stockroom to reserve parts located in the specified

agent's stockroom. This automatically sources the parts already present.

Filter agents

9. In the Date field, select the date on which the work should take place.

If the agent is available on the date specified, the Assign button appears in the Schedule
field.

10. If necessary, you can update the Scheduled start and Scheduled end fields in the Task
info section.

• If you change the Scheduled start and Scheduled end fields in the Part
Requirements section at the top of the screen, the corresponding fields in Task info
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are also changed. If you make changes to the fields in the Task info section, the
corresponding fields in the Part Requirements section are not changed.

• Any edits to the Estimated travel duration, Estimated work duration, or Scheduled
start time fields on the Task form appear automatically in Task info.

11. Click Assign.
12. To revert your changes to Agent Info, click Refresh.

You cannot use Refresh after you have saved the record.

13. Click Save.

The agent is not assigned until you save the record.

14. Source any parts the specified agent does not yet have reserved. In the left pane, select
a part from the list of part requirements under the task.

Source part

15. Click Source Part and complete the transfer order.

Transfer orders

Last updated: July 26, 2018
Last updated: July 26, 2018

Use a transfer order to move necessary parts between company stockrooms or to a location
where an agent can recieve them.

The transfer order defines delivery dates, the stockrooms involved in the transfer, and the
general status of the order. A transfer order contains one or more transfer order lines which
allow the transfer of multiple parts or assets on one transfer order. A transfer order line
describes the part, the quantity required, and the status of the part in the transfer process.

The system creates a transfer order automatically when you create a transfer order line. You
can add additional transfer order lines to a transfer order as long as the transfer order is in
the Draft stage. When any of the transfer order lines advance to the next stage, the transfer
order stage also advances, and can no longer accept additional transfer order lines.
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• Consumable and non-consumable models

The transfer process is slightly different for consumables than it is for non-consumables.

• Create a transfer order

Create a transfer order that moves the necessary parts or assets to the correct stockroom
or agent location.

• Merge transfer orders

After you submit a new transfer order, the system examines all existing transfer orders
attached to the current work order task to determine if the new transfer order can be
merged with any of the existing orders.

Consumable and non-consumable models

Last updated: July 26, 2018
Last updated: July 26, 2018

The transfer process is slightly different for consumables than it is for non-consumables.

Consumable assets, such as computer keyboards, are not tracked individually in transfer
orders. Non-consumable assets, such as network routers, are configuration items that are
tracked individually in transfer orders.

Consumable models

If the model being transferred is a consumable, the system can order all the items at once if
you specify a Requested quantity on a single transfer order line. After the quantity is
specified, the system determines whether the selected stockroom has enough quantity to
fulfill the part requirement. If the stockroom cannot fill the entire part requirement, the
system enters the quantity available in the stockroom automatically. For example, if the
requirement is for 25 keyboards and the selected stockroom only contains 10, the available
quantity of 10 is added. The user must create another transfer order line manually to order
the remaining 15 keyboards from another stockroom.

Non-consumable models

If the model being transferred is a non-consumable asset, create one transfer order line per
asset. The system creates as many transfer order lines as the required quantity. This
approach is used so that each configuration item can change its status and stockroom
location independently. For example, if the part requirement specifies two Canon i960
Photo printers, and printers are managed as configuration items, then the system generates
two transfer orders lines - one per configuration item. After the agent receives the part
(item state changes to In Stock and substate changes to Reserved) and uses it, the asset is
listed as In Use by the caller who originated the work order.

Create a transfer order

Last updated: July 26, 2018
Last updated: July 26, 2018

Create a transfer order that moves the necessary parts or assets to the correct stockroom or
agent location.

Before you begin

August 6, 2018 ©2018 ServiceNow. All rights reserved. 479

ServiceNow | Customer Service Management



Role required: wm_agent, wm_qualifier, wm_dispatcher, wm_admin, or qualifier combination
role

Procedure

1. Navigate to Field Service > Work Order > All Work Orders.
2. Open a work order.
3. Open a work order task.
4. In the Part Requirements related list, click a Number.
5. Click Source Part.

A new Transfer Order Line form appears. The system completes the Model field
automatically with information from the part requirement. You can select a different
model, but it must be a substitute for the requested model. If you click the reference

lookup icon ( ) beside the Model field, only the selected model and any substitute
models that are in stock are listed.

6. Select a From stockroom.

Only stockrooms that have the model specified are included in the list. If no stockrooms
are listed, the part is considered out of stock.

7. Select a To stockroom.

• To deliver the items to an agent directly and skip the Received stage, select a
personal stockroom as the destination. If no agent is assigned to the work order
task, the transfer order line waits in the Received stage until an agent has been
assigned.

• To use a part without transferring it, select the same non-personal stockroom for
both the source and destination stockroom. This action moves the transfer order
directly to the Received stage and sets the asset state and substate to In stock -
Pending transfer.

Note:  An error occurs if the same personal stockroom is selected for both the
source and destination stockroom. In this case, the transfer order line
automatically moves to the Delivered stage even if no agent is assigned
to the work order task.

8. Specify the Quantity requested.

If the first stockroom you select does not contain sufficient quantity, then repeat steps
2-5 until the entire quantity required is ordered. As you order from stockrooms, the
number in the Reserved quantity field is updated automatically. When the numbers in
the Reserved quantity and Requested quantity fields on the Part Requirement form
match, the system selects the Sourced check box. After one transfer order line is
requested from the part requirement, you cannot change the part requirement.

9. Select a Delivery method.

Qualifiers, dispatchers, agents and users with combined roles can specify a delivery
method for parts while a transfer order is in the Draft stage. The possible delivery
options are:

• Standard
• Overnight
• Courier
• Agent Pickup
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10. Click Submit.

Merge transfer orders

Last updated: July 26, 2018
Last updated: July 26, 2018

After you submit a new transfer order, the system examines all existing transfer orders
attached to the current work order task to determine if the new transfer order can be
merged with any of the existing orders.

The system uses these criteria to merge transfer orders:

• Created from the Field Service Management application. (Configure the transfer order
record to add the Type field.)

• In the Draft stage.
• Same From Stockroom.
• Same Destination Stockroom.

If an existing transfer order matches these criteria, the new transfer order line is placed
under the existing transfer order. If no existing transfer order matches these criteria, a new
transfer order is created and the transfer order line is added. It is good practice to view the
transfer order and ensure that all information is correct. For example, check that the Delivery
by date on the transfer order is appropriate for the Required by date on the part
requirement. Transfer orders created in the Field Service Management application are not
merged or combined with transfer orders created from any other application, such as
Procurement.

When all the transfer order lines under a part requirement are delivered to the assigned
agent's personal stockroom, the part requirement is marked Delivered. When both the
consumable and non-consumable assets are delivered, the system changes their State to In
stock and their Substate to Reserved (in Asset Management).

Transfer parts

Last updated: July 26, 2018
Last updated: July 26, 2018

Agents, dispatchers, and users with combined roles can transfer parts.

Open a work order task in the Pending Dispatch state, and then open a transfer order from
the Transfer Orders related list. Transfer the parts using the procedure in Move an asset
through the transfer process.

• Move an asset through the transfer process

The transfer order itself and each individual transfer order line have a separate stage. The
overall stage of the transfer order is calculated cumulatively based on the stages of the
individual transfer order lines.

Move an asset through the transfer process

Last updated: July 26, 2018
Last updated: July 26, 2018

The transfer order itself and each individual transfer order line have a separate stage. The
overall stage of the transfer order is calculated cumulatively based on the stages of the
individual transfer order lines.
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About this task

For example, after all transfer order lines are changed to Received, the transfer order is
marked Received. The transfer order line stages are visible in the Transfer Order Lines
related list.

Procedure

1. Click the plus icon to expand the stage information.
After creating transfer order lines, the transfer order and all of the transfer order lines
are in the Draft stage. Transfer orders and transfer order lines always start in Draft. While
a transfer order or a transfer order line is in the Draft stage, it can be deleted.

Note:  When an asset is part of a transfer order set to Draft, the asset record
updates to show the asset as reserved. No one else can request or
transfer the asset while it is reserved.

2. After all information has been added to the transfer order and the transfer order lines,
click Ready for Fulfillment on the transfer order.

Transfer order ready for fulfillment

This moves the transfer order and all transfer order lines to the Requested stage. At this
point in the process, the transfer order can continue to move forward as a unit or the
transfer order lines can be moved forward separately.

3. To move the transfer order, ready all assets for shipment and click Prepare for shipment
on the transfer order.
The transfer order and all transfer order lines move to the Shipment Preparation stage.
You can also click Prepare for shipment on a transfer order line to move only that
transfer order line to the Shipment Preparation stage. The transfer order stage is set to
Shipment Preparation as soon as the first transfer order line is set to Shipment
preparation.

While an asset is in the Shipment Preparation (or earlier) stage, the transfer order line
can be cancelled by opening the transfer order line record and clicking Cancel. The
stage changes to Cancelled (Closed Complete).

When all transfer order lines reach the Shipment preparation stage, the Ship button is
available on the transfer order.

4. Click Ship on the transfer order to move all transfer order lines to the In Transit stage.
In the case that assets ship at different times, transfer order lines can move individually.
For example, assume a transfer order is comprised of three assets: a laptop, a printer,
and a keyboard. All three assets have been prepared for shipment and the laptop is
ready to ship.

August 6, 2018 ©2018 ServiceNow. All rights reserved. 482

ServiceNow | Customer Service Management



5. Click the transfer order line Number next to the laptop. Now, on the transfer order line
record for the laptop, click Ship.

Ship Transfer Order

The laptop moves to the In Transit stage, but the printer and keyboard remain in the
Shipment Preparation stage. Because at least one of the transfer order lines is now in
transit, the overall transfer order is moved to the Partially Shipped stage. Once all
transfer order lines are shipped, the transfer order moves to the Fully Shipped stage.

Transfer Order in transit

After all transfer order lines are shipped, the next step is to receive the assets. Assets are
always received at the transfer order line level.

6. Click the transfer order line Number next to the asset.
7. On the asset record, click Receive.

Receive Transfer Order
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After all transfer order lines are received, the transfer order moves to the Received stage.

Note:  It may be necessary to return items, such as when they are defective. To
return items, receive the items, then follow the return process.

Dispatching work order tasks
Last updated: July 26, 2018
Last updated: July 26, 2018

When all of the work order tasks associated with a work order are qualified, you can
dispatch the work order tasks from the task form or task map, or by using central dispatch.

When all of the associated tasks are qualified, the state of the parent work order changes to
Qualified. If you have already sourced parts and created transfer order lines, you are ready to
begin dispatching the work order tasks to agents. Users with the following roles can
dispatch work order tasks: wm_dispatcher, wm_initiator_qualifier_dispatcher, or wm_admin.

You can dispatch work order tasks to qualified work agents from these locations:

• Dispatch queue: Dispatch tasks to agents from task records.
• Task map: Dispatch tasks to agents using a Google map with geolocation.
• Central Dispatch: Dispatch tasks to agents using the Central Dispatch board, which

provides drag-and-drop capabilities to assign and dispatch tasks.

Note:  Central Dispatch replaces Visual Dispatch in the Helsinki release.

Dispatch a work order task from the dispatch queue

You can dispatch a work order task from the dispatch queue.

Before you begin

Role required: wm_dispatcher, wm_initiator_qualifier_dispatcher, or wm_admin

Procedure

1. Navigate to Field Service > Dispatching > My Dispatch Queue.
2. Open a work order task.
3. Select an Assignment group.
4. Select an individual agent in the Assigned to field.

The lookup list displays all of the agents in the selected assignment group.
5. Click Update.

Dispatch a work order task from the task map

You can dispatch a work order task from the task map.

Before you begin

Role required: wm_dispatcher, wm_initiator_qualifier_dispatcher, or wm_admin

About this task
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In some cases, you might need to dispatch an urgent task or reassign a task to an alternate
agent if the assigned agent is delayed or otherwise unable to perform the task. Only users
with the wm_dispatcher or wm_initiator_qualifier_dispatcher role can display their tasks on
the dispatch map directly from a task record and see the available agents nearby who have
the skills to perform the task.

Note:  A task cannot be displayed on the dispatch map without a location that has
latitude and longitude defined.

Procedure

1. Navigate to Field Service > Dispatching > My Dispatch Queue.
2. Open the work order task that you want to dispatch or reassign.
3. Click View Task on Map.

This button is only visible if the task contains a location with a defined latitude and
longitude. The map that appears displays a red task icon with a black spot for the task,
and shows icons for all nearby agents.

4. Click View Filter.
5. Select a skill level for the agents to display in the map.

• Match all needed skills
• Match some needed skills
• Match none of skills

6. Click Apply Filter.

The resulting list shows the agents on the map who match the skills selection.

7. Click an agent icon to show the agent's name, skills, and schedule.
8. Click the icon beside the agent's name to assign the task to that agent.

Assign single task

If the task can fit within the agent's schedule, the task is assigned to the agent and a
confirmation message is displayed. If the agent's schedule cannot accommodate the
task, the system displays a failure message and allows you to select a different agent.

Auto-dispatch a work order task

Automatically match a task to a nearby agent who has the necessary skills and a schedule
that can accommodate the task.

Before you begin

Role required: wm_dispatcher, wm_initiator_qualifier_dispatcher, or wm_admin

About this task
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Auto-dispatch evaluates an agent's dispatch group, assignment group, location, or skills
before assigning a task.

Procedure

1. Open a task.
2. Click Auto-Dispatch.

The system assigns the work order task to the selected agent. If the system cannot find
an appropriate agent, it displays a failure message and leaves the task in the Pending
Dispatch state.

Request additional work order task information

If there is not enough information in the task record to dispatch a work order task, you can
request more details from the qualifier.

Before you begin

Role required: wm_dispatcher, wm_initiator_qualifier_dispatcher, or wm_admin

Procedure

1. Navigate to Field Service > Dispatching > Dispatch Queue.
2. Open a work order task in Pending Dispatch state.
3. In the Work Notes field, enter a reason for returning the work order task.
4. Click Request more information.

The work order task state changes to Draft and the work order state changes to
Awaiting Qualification. If Field Service Management is configured for automatic
qualification, the work order state remains at Qualified.

Central dispatch
Last updated: July 26, 2018
Last updated: July 26, 2018

Use the central dispatch calendar view to evaluate work order tasks and available agents
and assign tasks by dragging and dropping to the desired agent schedule and time slot.

Central dispatch provides both a list and calendar view of unassigned tasks. Configure the
list to display tasks that meet certain conditions or search the list for specific information.
Task bars in the calendar provide a visual representation of the scheduled start and end time
as well as the task window.

Central dispatch also provides a list of the field service agents in a dispatch group and a
calendar view of their assignments. Assign tasks by dragging them from the task calendar
above to the desired agent schedule below and then confirming the assignment.

Note:  Central dispatch uses the settings on the Field Service Configuration page
when assigning tasks, even if the Assignment method for tasks configuration
option is set to manually.
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Supported browser versions

Central dispatch is supported on the following browsers:

• The latest public release of Firefox
• The latest public release of Chrome
• Safari version 6 and up
• Internet Explorer version 10 and up

Task SLA indicators

Display task SLA information in central dispatch in the following ways:

• The system administrator can configure the Tasks list and task tooltips to display SLA
information by adding the SLA due field to the Task Fields and Task Tooltip Fields on the
Personalize Central Dispatch window.

• Task bars: The system administrator can configure the colors for SLA visual indicators on
the Personalize Central Dispatch window. Dispatchers can configure central dispatch to
display these color indicators under task bars in the calendar.

• Central dispatch components

Central dispatch includes work order task and agent information and a calendar view of
assigned and unassigned tasks.

• Central dispatch integration with dynamic scheduling

Drag and drop a task over an assigned task in the agent calendar. Dynamic scheduling
determines the best way to unassign or reassign the original task to make room for the
new task.

• Working with tasks in the central dispatch calendar

Display task and SLA information and use the drag and drop feature to assign, unassign,
and reassign tasks in the central dispatch calendar.

• Configure central dispatch

Each dispatcher can create their own central dispatch configuration, including the task
and agent information that is displayed.

• Administer central dispatch

The system administrator can configure several settings that control the information
displayed on the central dispatch board.

• Display a task form

Display a work order task form from central dispatch.

• Display a user form

Display user information for a field service agent from central dispatch.

• Assign a work order task using central dispatch

Assign a work order task to a field service agent from central dispatch.

• Search work order tasks

August 6, 2018 ©2018 ServiceNow. All rights reserved. 487

ServiceNow | Customer Service Management



Search the tasks in the central dispatch Tasks list.

• Search field service agents

Search the agents in the central dispatch Team list.

Central dispatch components

Last updated: July 26, 2018
Last updated: July 26, 2018

Central dispatch includes work order task and agent information and a calendar view of
assigned and unassigned tasks.

Central dispatch is comprised of these main areas:

Header

Displays notifications and error messages about configuration changes, task assignment
issues, and other usage tips. Includes buttons for calendar display options.

Calendar

Displays scheduled and unscheduled work order tasks in a calendar view, either by day or
by week depending on options selected in the header.

Tasks

Displays unassigned work order tasks, with a list of tasks on one side and the tasks
represented in a calendar view on the other side.

Team

Displays the field service agents in the dispatch group, with a list of team members on one
side and the assigned work order tasks in a calendar view on the other side.

Note:  You can resize the task and team areas by dragging the gray bar on the
board.
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Central dispatch

Central dispatch header and calendar

Central dispatch displays assigned and unassigned tasks in a calendar. View tasks in the
calendar by day or by week. Use these options in the header to change the calendar view.
The current date or range of dates for the selected view is displayed in the header.

• Day: Displays 24 hours starting at midnight.
• Week: Displays seven days starting with Sunday.

View different dates in the calendar by clicking the arrows in the header.

• Previous week: Displays the previous week in the Week calendar view.
• Previous day: Displays the previous day in both the Day and the Week calendar view.
• Today: Displays the current date.
• Next day: Displays the next day in both the Day and the Week calendar view.
• Next week: Displays the next week in the Week calendar view.

In Week view, you can also click a day at the top of the calendar to move that day to the first
day of the displayed week. A blue vertical line in the calendar denotes the current date and
time.

Tasks section

The Tasks section displays unscheduled work order tasks in both a list view and a calendar
view.

The Tasks list shows the unassigned tasks that meet the conditions configured by the
dispatcher in the Configuration Settings menu. By default, this list displays the Short
description and Number for each task. The dispatcher can configure this list to display
additional task fields, such as the location and assignment group. The system administrator
configures the task fields that are available for selection by the dispatcher.

When you navigate to central dispatch, the first task in the list is selected. When you select a
task in the Tasks list:
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• An auto assign icon appears, which can be used to assign the task to an available agent.
• The Team list updates to show all of the agents available for this task.

Scroll through the Tasks list to display additional tasks. If not automatically displayed, click
Show more tasks at the bottom of the list.

The Tasks calendar displays unassigned work order tasks using these types of bars:

• A solid bar that extends from the task's scheduled start time to the estimated end time.
• A dashed bar that indicates the window of time in which the task can be completed. This

bar is displayed if the task's scheduled start and estimated end fall within the task window.

Team section

The Team section displays the field service agents in the dispatcher's group and the tasks
assigned to each agent.

The Team list displays the names of the agents. The dispatcher can configure this list to
display additional information for each agent, such as the agent's location, matching skills,
and parts required. The system administrator can configure the fields that are available for
selection by the dispatcher. To see more details about an agent, click the agent name in the
Team list to open the user form on top of central dispatch.

When you select a task from the Tasks list, the Team list updates to show all of the agents
available for this task. To show all team members, click the Show all Team members link at
the bottom of the Team list. Scroll through this list to display additional agents. As you scroll,
more agents appear at the bottom.

Assigned tasks are represented in the team calendar by colored bars, with the color of the
bar indicating the task state. The default colors for the task states are:

• Blue: accepted
• Yellow: assigned
• Gray: pending dispatch
• Green: work in progress
• Black: other states

The length of the task bar indicates the estimated work duration. The colored task bar is
preceded by a thinner gray bar that represents estimated travel time.

Central dispatch integration with dynamic scheduling

Last updated: July 26, 2018
Last updated: July 26, 2018

Drag and drop a task over an assigned task in the agent calendar. Dynamic scheduling
determines the best way to unassign or reassign the original task to make room for the new
task.

The central dispatch integration with dynamic scheduling enables a dispatcher to drag and
drop a task (either assigned or unassigned) to an agent's timeline where another task is
already assigned. When the dispatcher attempts to assign the new task at this position,
dynamic scheduling unassigns or reassigns one or more tasks and assigns the new task. In
the Confirm Assignment pop-up window, the dispatcher can confirm or cancel the proposed
schedule changes.
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Note:  Tasks that are already work in progress cannot be unassigned. Only tasks
which are scheduled but not started can be reassigned or unassigned.

If the dispatcher drags a higher priority task on top of a lower priority task, dynamic
scheduling assigns the higher priority task and attempts to reassign the lower priority task. If
the dispatcher drags a lower priority task over a higher priority task, central dispatch
displays a warning and the dispatcher must acknowledge to continue.

The system administrator can enable the integration with dynamic scheduling by navigating
to Field Service > Configuration, clicking the Assignments tab, and selecting using dynamic
scheduling in the Assignment method for tasks field.

Working with tasks in the central dispatch calendar

Last updated: July 26, 2018
Last updated: July 26, 2018

Display task and SLA information and use the drag and drop feature to assign, unassign, and
reassign tasks in the central dispatch calendar.

Display task information:

• Point to a task in the calendar to display a tooltip with task information, including the
number and short description. For assigned tasks, the initials of the assigned agent are
also displayed. The system administrator can configure the information included in task
tooltips.

• Click the task number in the Tasks list or double-click the task in the calendar to open the
Work Order Task form on top of central dispatch. This allows the dispatcher to view task
details without navigating away from central dispatch.

Assign, unassign, and reassign tasks using drag and drop.

• Assign a task by clicking the task bar in the task calendar and dragging it to an agent and
time slot in the team calendar. After assigning a task, confirm the assignment information
in the work order task window, including the agent in the Assigned to field.

Note:  You can also select a task in the Tasks list and click the auto assign icon

( ).

• Unassign an assigned or accepted task by dragging it from the agent calendar to the task
calendar. Work in progress tasks cannot be unassigned.

• If dynamic scheduling is enabled, a dispatcher can drag an unassigned task on top of an
already assigned task. This results in the unassigned task taking priority over the assigned
task, and dynamic scheduling attempts to re-assign the already assigned task.

• When dragging a task, a tooltip shows the scheduled start time at the current position in
the team calendar. The agent row is also highlighted.

A dispatcher can display SLA indicators for assigned and unassigned tasks by enabling the
Show SLA indicator toggle button on the Tasks tab in the Configuration Settings window.
These indicators appear as colored horizontal lines below each task bar. The system
administrator configures the colors used to display the different task SLAs.

When navigating from a Work Order Task form to central dispatch by clicking Central
Dispatch in the task header or the Central Dispatch related link, the content in the Tasks list
is filtered to display only that task.
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Configure central dispatch

Last updated: July 26, 2018
Last updated: July 26, 2018

Each dispatcher can create their own central dispatch configuration, including the task and
agent information that is displayed.

Before you begin

Role required: wm_dispatcher or admin

About this task

A dispatcher can configure several options for central dispatch. These configuration settings
are saved for each dispatcher and are available the next time the dispatcher logs in. If the
system administrator makes changes to the central dispatch advanced configuration
settings, the dispatcher sees a message about the changes the next time they log in.

Procedure

1. Navigate to Field Service > Dispatching > Central Dispatch.

2. Click the configuration settings icon ( ) in the upper corner to display the
Configuration Settings window.

3. Configure the following information.

Option Description

Select the fields that are displayed for each
task in the Tasks list.

Click the Tasks button at the top of the
window. In the Task Display Fields section,
enable the fields that you want to display and
disable the fields that you want to hide.
The Number and Short description fields are
displayed by default. The remaining fields
available for selection are configured by the
system administrator.

Select the fields that are displayed for each
agent in the Team list.

Click the Team button at the top of the
window. In the Team Display Fields section,
enable the fields that you want to display and
disable the fields that you want to hide.
The Name field is displayed by default. The
fields available for selection are configured by
the system administrator.

Select one or more conditions to filter the
tasks displayed in the Tasks list.

Click the Advanced Configuration link to
display the Personalize Central Dispatch
window. In the Task condition field, use the
condition builder to construct one or more
condition statements to filter the tasks in the
Tasks list.

Show task windows. Click the Tasks button at the top of the
window. In the Settings section, enable Show
Task Window to display the window of time in
which a task can be completed.
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Option Description

Show task SLA indicators. Click the Tasks button at the top of the
window. In the Settings section, enable Show
SLA Indicator to display a visual SLA indicator
under a task bar in the calendar.

4. Click the configuration icon again to close the Configuration Settings window.

Administer central dispatch

Last updated: July 26, 2018
Last updated: July 26, 2018

The system administrator can configure several settings that control the information
displayed on the central dispatch board.

Before you begin

Role required: admin

About this task

The system administrator can set the following advanced configuration settings:

• The task fields displayed in the Tasks section.
• The task fields displayed in task tooltips.
• The user fields displayed in the Team section.
• The colors assigned to the different task states.

These configuration settings are saved for each dispatcher and are available the next time
the dispatcher logs in. If the system administrator makes changes to the central dispatch
advanced configuration settings, the dispatcher sees a message about the changes the next
time they log in.

The configuration settings can be accessed in two different ways:

• From the Central Dispatch window by clicking the configuration settings icon.
• From the Field Service menu by navigating to Field Service > Administration > Central

Dispatch Configuration.

Procedure

1. Navigate to Field Service > Dispatching > Central Dispatch.

2. Click the configuration settings icon ( ) in the upper corner to display the
Configuration Settings window.

3. Click the Advanced Configuration link to display the Personalize Central Dispatch
window.

4. Configure the following information.

Option Description

Select the fields that can be displayed for a
task in the Tasks list.

The selected fields appear on the Tasks tab of
the Configuration Settings window and the
dispatcher can enable or disable these fields as
desired.
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Option Description
In the Task Fields section, select the desired
fields and move them to the Selected list.

Select the fields displayed in the task tooltips. The selected fields appear in the tooltip when
the dispatcher points to a task in the calendar.
In the Task Tooltip Fields section, select the
desired fields and move them to the Selected
list.

Select the fields that can be displayed for an
agent in the Team list.

The selected fields appear on the Team tab of
the Configuration Settings window and the
dispatcher can enable or disable these fields as
desired.
Click the Team Display tab. Select the desired
fields and move them to the Selected list.

Select the colors that represent the different
task states.

Assigned tasks are represented on the
calendar by colored bars, with the color of the
bar indicating the task state.
Click the State Colors tab. For each task state,
enter the name or HTML hex number for the
desired color.

Select the colors for the task SLA indicators. SLA indicators appear as thin colored bars
under assigned and unassigned tasks.
Click the SLA Color tab and modify the SLA
color codes as needed.

5. Click Update.

Display a task form

Last updated: July 26, 2018
Last updated: July 26, 2018

Display a work order task form from central dispatch.

Before you begin

Role required: wm_dispatcher or admin

Procedure

1. Navigate to Field Service > Dispatching > Central Dispatch.
2. Click a task number in the Tasks list or double-click a task bar in the calendar view.

The task form opens on top of central dispatch.
3. If necessary, make any changes to the task form.
4. Click Update.

Display a user form

Last updated: July 26, 2018
Last updated: July 26, 2018
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Display user information for a field service agent from central dispatch.

Before you begin

Role required: wm_dispatcher or admin

Procedure

1. Navigate to Field Service > Dispatching > Central Dispatch.
2. Click an agent name in the Team list.

The User form opens on top of central dispatch. This form includes information about
the agent, including current schedule status.

3. If necessary, make any changes to the task form.
4. Click Update.

Assign a work order task using central dispatch

Last updated: July 26, 2018
Last updated: July 26, 2018

Assign a work order task to a field service agent from central dispatch.

Before you begin

Role required: wm_dispatcher or admin

About this task

You can assign tasks that have a state of Pending Dispatch. You can also reassign tasks.

When assigning and dispatching work order tasks, consider the following:

• The length of time required to complete a task
• The window of time in which a task must be completed
• The schedule and availability of the agents with the necessary skill sets
• The availability of required parts
• The impact on other tasks

Procedure

1. Navigate to Field Service > Dispatching > Central Dispatch.
2. Do one of the following:

• Click a task bar in the calendar and drag it to an agent in the Team list.

• Select a task in the Tasks list and click the auto assign icon ( ).
3. Confirm the assignment information in the work order task window, including the agent

in the Assigned to field.
4. Click Update.

The task is displayed on the calendar next to the agent's name and the task bar color
indicates that the task has been assigned.

Search work order tasks

Last updated: July 26, 2018
Last updated: July 26, 2018

Search the tasks in the central dispatch Tasks list.
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Before you begin

Role required: wm_dispatcher or admin

About this task

You can search on the following fields:

• Task number
• Short description
• Assignment group
• Dispatch group
• Assigned agent
• Location

Procedure

1. Navigate to Field Service > Dispatching > Central Dispatch.
2. Click the search icon in the Tasks list header to expand the search field.
3. Type the search term in the search field and press the Enter key.

The tasks that meet the search requirements are displayed in the Tasks list.
4. To clear the search and display all of the tasks, delete the search term and press the

Enter key.

Search field service agents

Last updated: July 26, 2018
Last updated: July 26, 2018

Search the agents in the central dispatch Team list.

Before you begin

Role required: wm_dispatcher or admin

About this task

You can search on the following fields:

• Agent name
• Assignment group
• Assignment group manager
• Location

Procedure

1. Navigate to Field Service > Dispatching > Central Dispatch.
2. Click the search icon in the Team list header to expand the search field.
3. Type the search term in the search field and press the Enter key.

The agents that meet the search requirements are displayed.
4. To clear the search and display all of the agents, delete the search term and press the

Enter key.

Dispatch map
Last updated: July 26, 2018
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Last updated: July 26, 2018

The Field Service Management dispatch map uses geolocation data to show tasks and
agents in the field.

Users with the wm_dispatcher role or the dispatcher combination role can use the dispatch
map to schedule and assign work order tasks. When the dispatch map opens, the view
centers on the logged in user's location, as defined on the user record. Icons for tasks and
agents provide access to scheduling information and links to related records.

An administrator must activate the Field Service Management Geolocation Demo Data
plugin (com.snc.work_management_geolocation.demo) to enable the dispatch map.

• Agent starting position and time

You can set the starting position and time for each agent on the dispatch map.

• Agent work and schedule status

View an agent's work status and schedule status as they complete their tasks.

• Dispatcher view

The icons in the dispatch map mark the location of tasks and agents in the dispatcher's
area and serve as access points to various records.

• Auto-routing

Auto-routing reorders agent tasks for the day as efficiently as possible using either
geolocation or straight line estimation.

• Assign a work order task

Assign agents to unassigned work order tasks using the dispatch map.

• Assign a single task

In some cases, you might need to dispatch an urgent task or reassign one to an alternate
agent if the assigned agent is delayed or otherwise unable to perform the task.

Agent starting position and time

Last updated: July 26, 2018
Last updated: July 26, 2018

You can set the starting position and time for each agent on the dispatch map.

Agent starting position

The starting position for each agent is determined by the geographic coordinates returned
from the agent's mobile device, assuming geolocation is enabled. If geolocation is not
enabled, the starting position defaults to the agent's home office The Field Service
Management application uses these criteria to locate work agents at the beginning of the
day:

• If the agent is routed for a future date, the system calculates the route from the home
office.
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• If current geolocation data for the agent is available at the start of the day, the system
uses those geographical coordinates instead of the home office as the starting point for
the agent's routing.

• If current geolocation data for the agent is not available for an agent at the start of the
day or if geolocation tracking is disabled, the system uses the home office as the starting
point.

• If the agent has a task that is still Work in Progress at the start of the current day, the
system starts the agent's route for that day at the location of the unfinished task. The start
time is set to the time of the scheduled completion of the unfinished task or the current
time, whichever is later.

To enable geolocation tracking:

In the default view of the User form, select the Geolocation tracked check box to enable
agent location tracking.

Note:  The system can update geographic coordinates only for users who have
location services enabled in their browsers. Even users who have the
Geolocation tracked check box selected may be prompted by their browsers
to share or withhold their location.

When the ServiceNow system tracks an agent, it updates the geographic coordinates
whenever the agent loads a record on the Task [task] table or on a table that extends Task.
After the initial update, the system continues to update the agent's geographic coordinates
at recurring intervals if the agent does not close or reload the record.

Administrators can set the length of this interval by editing the Minimum amount of time
between updating the user's location (in seconds) system property. The default geolocation
update interval value is 300 seconds, or 5 minutes.

To change the default geolocation update interval, navigate to Geolocation > Administration
> Geolocation Properties.

Agent starting time

The starting time for each agent is determined by the Default start time for all work agents
when no schedule is set, formatted as 08:00 property, unless the agent has another
schedule or task continued from the previous day. The default starting time value is 8:00.

To change the default starting time, navigate to Field Service > Administration > Properties.

Agent work and schedule status

Last updated: July 26, 2018
Last updated: July 26, 2018

View an agent's work status and schedule status as they complete their tasks.

Work status

To evaluate the agent's work status, the system checks the action that the agent takes when
updating a task and interprets it as a status.

An agent's work status can be one of the following:

• On route
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• On site
• On break
• Off work

For example, when the agent starts travel to a task, the system considers the agent's status
as On route. When the agent starts to work on a task, the agent's status is updated to On
site. When an agent closes or cancels a task, the agent's status is updated to None in
preparation for travel to the next task.

You can view an agent's work status in the information box that opens when you click the
agent's icon in the dispatch map or in an agent's user record. To display agent work status in
the user record, navigate to User Administration > Users and configure the User form to
show the Work agent status field. This action puts the status field on all user records.

Schedule status

View an agent's schedule status in the information box that opens when you click the
agent's icon in the dispatch map or in an agent's user record.

A green icon indicates that the agent is ahead of schedule. If the agent is behind schedule,
the icon in the map appears in red. Possible statuses are:

• Ahead of schedule
• On time
• Behind schedule, less than 30 minutes
• Behind schedule, between 30 to 60 minutes
• Behind schedule, more that an hour

To display the agent schedule status in the user lists and records, navigate to User
Administration > Users and configure the User list and form to show the On schedule field.
This action puts the schedule status field on all user records.

Tasks that are behind schedule appear highlighted in lists and forms.

• Red: Tasks that are more than one hour behind.
• Orange: Tasks that are between 30 and 60 minutes behind.
• Yellow: Tasks that are only 30 minutes behind.

Dispatcher view

Last updated: July 26, 2018
Last updated: July 26, 2018

The icons in the dispatch map mark the location of tasks and agents in the dispatcher's area
and serve as access points to various records.

Users with the wm_dispatcher, wm_admin, or wm_initiator_qualifier_dispatcher roles can
manage tasks and routing from the map, filter the view, and determine at a glance what
agents are on time or behind schedule.

To access the dispatch map, navigate to Field Service > Dispatching > My Dispatch Map.

The dispatch map opens in the geographical area containing the agents from any
assignment group that is part of your dispatch group. These icons indicate the location of
agents and tasks:
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Dispatch map symbols
Image Title Description

Green truck
Agent on schedule Current location of an agent

selected in the filter. Agents with
this icon are on time or ahead of
schedule.

Blue truck
Agent behind less than 30
minutes

Current location of an agent
who is less than 30 minutes
behind schedule.

Yellow truck
Agent behind less than 60
minutes

Current location of an agent
who is between 30 and 60
minutes behind schedule.

Red truck
Agent behind more than 60
minutes

Current location of an agent
who is at least one hour behind
schedule.

Gray truck
Agent off the schedule Last known location of an agent

who is not currently on the
schedule or working on any
tasks.

Red marker
Unassigned Unassigned tasks that are

awaiting dispatch.

Blue marker
Assigned Assigned tasks that have not yet

been accepted.

Green marker
Accepted Tasks that have been accepted

or tasks that are in progress.

Multi task
Multiple tasks Multiple active tasks clustered

by proximity.

Multi agent
Multiple agents Multiple agents clustered by

proximity.
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Image Title Description

Agent-task combo
Agent/Tasks Combination of agents and

tasks clustered by proximity.

Dispatch map

• Clusters

Tasks and agents are gathered together by proximity into clusters as you increase the
altitude of the dispatch map view.

• View task information

View task information by clicking the task icon on the dispatch map.

• View agent information

View details about an agent at a particular location by clicking the agent icon on the
dispatch map.

• Filter the dispatch map

Filter the items that are visible on the dispatch map.

Clusters

Last updated: July 26, 2018
Last updated: July 26, 2018
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Tasks and agents are gathered together by proximity into clusters as you increase the
altitude of the dispatch map view.

Tasks are gathered into red clusters and agents are gathered into blue clusters. Counters in
each cluster icon indicate the number of agents or tasks rolled up as the perspective
changes.

When multiple agents and tasks are in one location, they can be gathered into purple
clusters. This icon is created by a system property called Merge the task and agent markers
on the geolocation maps with a purple marker. This property is found in Field Service >
Administration > Properties and is disabled by default.

Dispatch map cluster

Task cluster

View task information

Last updated: July 26, 2018
Last updated: July 26, 2018

View task information by clicking the task icon on the dispatch map.

A pop-up window shows the task number, the name of the agent if one is assigned to the
task, and the task description. By default, the system closes one pop-up window before
opening another. To allow multiple pop-up windows to remain open, navigate to System
Properties > Google Maps and edit the If true, automatically closes a dispatch map
information window before opening a new one property.

The following information is included in a task pop-up window:

• SLA: Time remaining on an SLA, if one is affected by this task.
• Priority: Task priority by number, 1 being the highest and 5 the lowest.
• Skills Needed: Skills needed to perform the work.
• Parts Needed: Parts needed to perform the work.
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Dispatch map task pop-up window

If multiple tasks exist in the same location, click the cluster icon to display the list of tasks by
status. Click any entry to display summaries for all the tasks in a pane beside the map. You
can access individual task records from this list.

Dispatch map task pane

Click the task number link to display the record in a pop-up window. You can reassign a task
to another agent using these fields:

• Dispatch group
• Assignment group
• Assigned to

Note:  If a task has transfer orders that have shipped and are in transit, the system
displays a warning and blocks any attempt to reassign the task or to clear
the Assigned to field. If the transfer orders have been received or delivered,
reassignment is permitted, and the assets are moved to a state of In Stock /
Available.

For an unassigned task, click the Auto-Dispatch related link to let the system dispatch the
task automatically. You can edit the task schedule in this record or create a task window.
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Dispatch map task detail

View agent information

Last updated: July 26, 2018
Last updated: July 26, 2018

View details about an agent at a particular location by clicking the agent icon on the
dispatch map.

A pop-up window shows the agent's schedule and these additional details:

• Status: Possible values are On route, On site, On break, Off work.
• Last login: Time the agent last logged in to the instance. This field is updated automatically

each time a user with geolocation tracking enabled views a task.
• On schedule: Possible values are On time, Behind schedule, and Ahead. The icon for an

agent who is behind schedule appears in red on the map. The system highlights in red the
name of the agent who is behind schedule in the Map View of all user records and lists.

• Assignment groups: All assignment groups this agent belongs to.

Click the agent's name to open the user record. Only the Location field can be edited in this
record. Click a task number in the schedule list to display the task record. Tasks that are
behind schedule are marked in red.

If more than one agent is in a location, the map gathers them together in a blue cluster icon.
Click the cluster to display a summary pop-up window showing the agents at that location
by dispatch group. Click any link in this list to display a detailed list of agents in a panel
beside the map. You can open user records and tasks using the links in this list.
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Dispatch map agent detail

Filter the dispatch map

Last updated: July 26, 2018
Last updated: July 26, 2018

Filter the items that are visible on the dispatch map.

To change the items visible in the map, click View Filter. These filters are available:

Dispatch map filters
Title Description
Show unassigned tasks All unassigned tasks are displayed by default.

Clear the check box to hide unassigned tasks.

Show assigned tasks All assigned tasks are displayed by default. Clear
the check box to hide assigned tasks.

On The current date is selected by default. You can
change the date to view tasks for that day.

Show my agent's work group All assignment groups are selected by default.
You can select any assignment group in your
dispatch group.

Show agent All agents are displayed by default. When you
select a specific assignment group, the choice list
for agents shows only the agents in that
assignment group.

August 6, 2018 ©2018 ServiceNow. All rights reserved. 505

ServiceNow | Customer Service Management



Dispatch map filter

Click Apply Filter to apply your changes to the map. The view displays all tasks assigned to
the agent selected in the filter. The icons are all numbered to show the sequence of the
agent's route. Click Apply auto-routing to let ServiceNow decide the most efficient route to
the agent's tasks.

Auto-routing

Last updated: July 26, 2018
Last updated: July 26, 2018

Auto-routing reorders agent tasks for the day as efficiently as possible using either
geolocation or straight line estimation.

Properties are used to configure system estimates by adjusting:

• Travel time between tasks.
• Task windows that are either fixed or flexible.
• Task dependencies that require the completion of a prerequisite task.
• Toll road routing that is either enabled or disabled.
• Rush hour and other specified time buffers.

If a task cannot be auto-routed because of an impractical or missing location or because the
task window cannot be scheduled, the system displays a message advising that the
unroutable task was not included in the new sequence. Dependent tasks cannot be auto-
routed if the routing produces a circular relationship. The system returns any unroutable task
to the Pending Dispatch state.

Google Maps API for Business

Geolocation uses Google Maps API for Business to calculate the most efficient route
between tasks, using real-time positioning.

To use geolocation, you must provide a Google Key and client ID. For more information, go
to Google Maps API for Business.

Straight line estimates

If you do not have Google Maps API for Business, the system uses built-in time and distance
estimates based on latitude and longitude to determine the best route for the agent.

Routing restrictions

Certain general restrictions apply to auto-routing.

• If you attempt to auto-route more than 200 tasks, routing fails and the system displays a
message describing the error.
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• If a task cannot be auto-routed because of an impractical or missing location, or because
the task window cannot be scheduled, a message is displayed advising that the unroutable
task was not included in the new sequence.

• Dependent tasks cannot be auto-routed if the routing would produce a circular
relationship.

Note:  The system returns any unroutable task to the Pending Dispatch state.

Related Concepts

• Geolocation

Assign a work order task

Last updated: July 26, 2018
Last updated: July 26, 2018

Assign agents to unassigned work order tasks using the dispatch map.

Before you begin

Role required: wm_dispatcher, wm_initiator_qualifier_dispatcher

Procedure

1. Navigate to Field Service > Dispatching > My Dispatch Map.
2. Select a filter view for the day and the assignment group you want to see.
3. Click an unassigned task in the map, marked by a red icon.

A pop-up window shows the unassigned task and a description.

4. Click the icons of nearby agents and examine their schedules.

An agent's schedule shows each assigned task and its work duration. The tasks appear
in the sequence defined manually by the dispatcher or by the agent using the auto-
routing feature.

5. Locate an appropriate agent with available time to perform the unassigned task.
6. Click the number of the unassigned task to display the record in a pop-up on the map.
7. Select the available agent in the Assigned to field.

Only agents from the current assignment group are available for selection.

8. Click Update.

The red icon on the map turns blue, indicating that the task is assigned but not yet
accepted by the agent. The icon turns green when the agent accepts the task.

Assign a single task

Last updated: July 26, 2018
Last updated: July 26, 2018

In some cases, you might need to dispatch an urgent task or reassign one to an alternate
agent if the assigned agent is delayed or otherwise unable to perform the task.

Before you begin
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Role required: wm_dispatcher, wm_initiator_qualifier_dispatcher

About this task

Only users with the wm_dispatcher or wm_initiator_qualifier_dispatcher role can display
their tasks on the dispatch map directly from a task record and see the available agents
nearby who have the skills to perform the task. A task cannot be displayed on the dispatch
map without a location that has latitude and longitude defined. A task assigned in this
manner can be accepted or rejected by the agent.

Procedure

1. Navigate to Field Service > Dispatching > My Dispatch Queue.
2. Open the task you want to dispatch or reassign.
3. Click the View Task on Map.

The task is not visible in the Draft, Closed Complete, Closed Incomplete, or Cancelled
state. The map that appears displays a red task icon with a black spot for the task, and
shows icons for all nearby agents.

4. Click View Filter.
5. Select a skill level for the agents to display in the map.

The default filter selects all agents in the vicinity. The icons in the map indicate agents
with these skill combinations:

• Match all needed skills
• Match some needed skills
• Match none of skills

Single task filter

6. Click Apply Filter.

The system displays the agents on the map who match the skills selection.

7. Click an agent icon to show the agent's name, skills, and schedule.
8. Click the icon beside the agent's name to assign the task to that agent.

If the task can fit within the agent's schedule, the system assigns the task and displays a
confirmation message. If the agent's schedule cannot accommodate the task, the
system displays a failure message and allows you to select a different agent.

Dynamic scheduling
Last updated: July 26, 2018
Last updated: July 26, 2018
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Use dynamic scheduling to assign tasks to field service agents. Select and prioritize a list of
tasks, provide assignment recommendations based on selected criteria, and auto assign
tasks.

Dynamic scheduling provides schedule optimization, allowing dispatchers to auto assign
tasks and adapt to changing conditions, as well as to focus only on exception cases. Using
this advanced tool for task assignment, you can:

• Select a set of tasks for scheduling.
• Prioritize the tasks in the set based on ordering rules (for example, assign P1 tasks first).
• Use ordering rules and unassignment constraints to unassign previously assigned tasks in

order to allow the assignment of higher priority tasks.
• Use selection criteria, such as agent skills and travel time, to select agents.
• Re-assign tasks for agent time off

System administrators can configure task filters and ordering rules to specify how and when
tasks are assigned and unassigned. Dispatchers can use dynamic scheduing to automatically
assign tasks as they are created and unassign tasks as needed to accommodate higher
priority tasks. Dispatchers can also select multiple tasks and use dynamic scheduling to
optimize the task assignment.

Dynamic scheduling can run in one of two modes: manually or automatically. For manual
operation, dispatchers select a set of tasks and then click Auto Assign to prioritize and
assign the tasks. For automatic operation, dispatchers can choose to run dynamic
scheduling immediately upon task creation or at a specified interval. Using task filters you
can identify some tasks to be assigned manually while others can be set up for auto
assignment.

Agent schedules

When an agent creates a time-off event in the agent calendar, the tasks assigned to the
agent during the time-off event are reassigned to other agents based on availability.

Configure dynamic scheduling

Follow these steps to configure the dynamic scheduling feature.

1. Configure the Field Service Management application to use dynamic scheduling.
2. Create or modify a dynamic scheduling configuration.

a. Select the task table on which to run dynamic scheduling and enable or disable the
task unassignment option.

b. Create a task filter.
c. Create one or more task ordering rules.
d. If needed, define any task unassignment constraints.

• Activate dynamic scheduling

Activate the dynamic scheduling feature by activating the Field Service Management
plugin (com.snc.work_management).

• Dynamic scheduling system properties

Dynamic scheduling uses the following system properties.

• Dynamic scheduling task dependencies
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Dynamic scheduling uses task ordering rules to prioritize the list of tasks to be assigned.
Where applicable, task dependencies override the task ordering rules.

• Configure Field Service Management to use dynamic scheduling

Configure the Field Service Management application to use dynamic scheduling as the
task assignment method.

• Create a dynamic scheduling configuration

Create a new dynamic scheduling configuration or modify the configuration provided with
the Field Service Management application.

• Select and assign multiple tasks

Dispatchers can manually select multiple tasks on which to run dynamic scheduling.

• Display the task assignment debug log

Display information from the task assignment debug log in the Confirm Assignment pop-
up window.

• View an agent's status in Central Dispatch

Use Central Dispatch to see if an agent is ahead of schedule, behind schedule, or on time.

• Set agent status from the mobile UI

Field service agents can indicate their status from the mobile UI and let dispatchers know
if they are ahead of schedule, behind schedule, or on time.

• Set agent status from the desktop

Field service agents can indicate their status from the desktop and let dispatchers know if
they are ahead of schedule, behind schedule, or on time.

• Work order task start and end dates

Dynamic scheduling uses work order task Window start and Window end dates to
schedule tasks.

Activate dynamic scheduling

Last updated: July 18, 2018
Last updated: July 18, 2018

Activate the dynamic scheduling feature by activating the Field Service Management plugin
(com.snc.work_management).

Before you begin

Role required: admin

About this task

The Field Service Management plugin activates the Dynamic Scheduling plugin
(com.snc.dynamic_scheduling) and adds the following module to the Field Service menu in
the application navigator: Field Service > Administration > Dynamic Scheduling
Configuration.
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The following tables are installed with dynamic scheduling:

Table Description
Constraint
[scheduling_constraint]

Stores the unassignment constraints for the
dynamic scheduling feature.

Dynamic Scheduling Configuration
[dynamic_scheduling_config]

Stores the configurations for the dynamic
scheduling feature. Configurations include the
selected task table, task filters, task ordering
rules, and task unassignment constraints.

Task Filter
[dynamic_schedule_task_filter]

Stores the task filters for a dynamic scheduing
configuration. Filters identify a list of tasks to be
assigned using dynamic scheduling.

Task Ordering Rule
[task_ordering_rule]

Stores the task ordering rules for a dynamic
scheduling configuration. Ordering rules prioritize
the list of tasks identified by the task filters.

Un-Assignment Constraint
[unassignment_rule]

Stores the task unassignment constraints for a
dynamic scheduling configuration. Constraints
prevent a task from being unassigned even if it is
of lower importance based on the task ordering
rules.

Dynamic scheduling system properties

Last updated: July 26, 2018
Last updated: July 26, 2018

Dynamic scheduling uses the following system properties.

Property Definition
com.snc.dynamic.scheduling.showlogs Controls the display of logs on the Confirm

Assignment pop-up window.

com.snc.dynamic.scheduling.maxtasks Controls the maximum number of tasks that can
be selected when manually running dynamic
scheduling. The default value for this property is
50 tasks.

Dynamic scheduling task dependencies

Last updated: July 26, 2018
Last updated: July 26, 2018

Dynamic scheduling uses task ordering rules to prioritize the list of tasks to be assigned.
Where applicable, task dependencies override the task ordering rules.

• A task with one or more downstream tasks cannot be unassigned.
• If a downstream task is assigned and the upstream task gets reassigned, dynamic

scheduling attempts assign the upstream task before the start of the downstream task.
• If a task has an upstream task that is unassigned, the downstream task does not get

assigned.
• If a task has an upstream task that is assigned, the downstream task does not start until

the upstream task is completed.
• If a task has an upstream task that is assigned a lower priority, the downstream task is not

assigned until the upstream task is assigned.
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Configure Field Service Management to use dynamic scheduling

Last updated: July 26, 2018
Last updated: July 26, 2018

Configure the Field Service Management application to use dynamic scheduling as the task
assignment method.

Before you begin

Role required: admin

About this task

For more information, see Configure Field Service Management.

Procedure

1. Navigate to Field Service > Administration > Configuration.
2. Click the Assignment tab.
3. In the Assignment method for tasks field, select using dynamic scheduling.
4. Click Save.

Create a dynamic scheduling configuration

Last updated: July 18, 2018
Last updated: July 18, 2018

Create a new dynamic scheduling configuration or modify the configuration provided with
the Field Service Management application.

Before you begin

Role required: admin

About this task

Dynamic scheduling works with one selected task table, such as the Work Order Task
[wm_task] table, which you select on the Dynamic Scheduling Configuration form. As part
of the configuration, create task filters to identify specific lists of tasks, create task ordering
rules, and define any task unassignment constraints.

Note:  To use dynamic scheduling, select this task assignment method on the Field
Service Configuration screen.

The Dynamic Scheduling Config for Work Order configuration is provided with the Dynamic
Scheduling plugin. Modify this configuration to meet your needs or use it as an example for
creating your own configuration.

Procedure

1. Navigate to Field Service > Administration > Dynamic Scheduling Configuration.
The Dynamic Scheduling Config For Work Order form is displayed.

2. Select a table in the Task Table field.
By default, this configuration uses the Work Order Task [wm_task] table. For Field
Service Management, you can also select the Work Order [wm_order] table.
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Note:  Dynamic scheduling can have only one configuration for each task table.

3. If desired, disable the Un-assignment check box.
When the unassignment option is enabled, dynamic scheduling can unassign a
previously assigned task in order to complete the assignment of a more important task.
Task importance is determined by task ordering rules. This field is enabled by default.

Note:  If you disable the Un-assignment check box, the Un-Assignment
Constraints related list is removed from the form.

4. (Optional) Enable the Use Google for travel time and traffic data check box to use the
Google Maps API to calculate travel time. If necessary configure the form and add this
field.
If not enabled, travel time is calculated using straight line estimates.

Note:  The Field Service Management geolocation property Geolocation should
be used to update estimated travel time via Google Maps API must also
be enabled to use the Google Maps API.

5. Click Update.

• Create a task filter

Create one or more task filters to identify a list of tasks to be assigned using dynamic
scheduling.

• Create a task ordering rule

Create one or more task ordering rules to prioritize the list of tasks identified by the task
filters.

• Create a task unassignment constraint

Define the constraints that prevent a task from being unassigned even if it is of lower
importance based on the task ordering rules.

• Validate the dynamic scheduling configuration

After creating a dynamic scheduling configuration, validate the configuration to ensure
that works as intended.

Related Tasks

• Create a task filter

• Create a task ordering rule

• Create a task unassignment constraint

• Validate the dynamic scheduling configuration

Create a task filter

Last updated: July 18, 2018
Last updated: July 18, 2018

Create one or more task filters to identify a list of tasks to be assigned using dynamic
scheduling.

Before you begin
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Role required: admin

About this task

For example, create a task filter to identify tasks of a specific priority or tasks with expiring
SLAs. Also define criteria to evaluate and identify suitable agents for each task. If desired,
enable auto assignment and select the frequency for assigning tasks.

You can create multiple task filters. The filter with the lowest Execution Order value defines
the initial task list. Filters with higher values further filter the initial task list.

The All Work Order tasks filter is provided with the Dynamic Scheduling plugin. This filter
identifies all active work order tasks.

If desired, you can also enable auto assignment and select the frequency for assigning tasks.
Dynamic scheduling can run on the tasks returned from a task filter automatically as soon as
the tasks are ready to be assigned or at a specified interval. Dynamic scheduling can also be
run manually by a dispatcher.

Procedure

1. Navigate to Field Service > Administration > Dynamic Scheduling Configuration.
2. In the Task Filters related list, click New.
3. Fill in the fields on the Task Filter form, as necessary.

Task Filter form
Field Description
Name The task filter name.

Active Denotes this filter as active.

Execution Order The order in which this filter is evaluated. The
filter with the lowest Execution Order value
defines the initial task list.

Table The task table selected for this dynamic
scheduling configuration.

Conditions Define the conditions that identify the specific
list of tasks.

Auto Assign Enable this check box to auto assign tasks.
Enabling Auto Assign displays the Auto
Assignment Frequency field.

Auto Assignment Frequency The frequency with which tasks are auto
assigned.

• Immediate: tasks are assigned as soon as
they are ready to be assigned.

• Interval: tasks which are ready to be
assigned are selected at the defined
interval and assigned.

Selecting Interval displays the Auto Assignment
Interval field.

Auto Assignment Interval The interval, in minutes, at which tasks are
selected for auto assignment.
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Field Description

Note:  A task filter with a higher
Execution Order value must
have an interval that is greater
than the interval for a task filter
with a lower Execution Order
value.

4. In the Select Criteria related list, select the criteria used to evaluate and identify suitable
agents for each task.
Select criteria from the Matching Criteria list. For more information, see Matching criteria
for case assignment.

Note:  If you are using mandatory skills for dynamic scheduling, you must
replace the Matching Skills For Dynamic Scheduling criterion with the
Matching Mandatory Skills for Dynamic Scheduling criterion to match
agents with mandatory skills required for the task.

5. If necessary, adjust the Weight for the selected criteria.
By default, each matching criterion has an assigned weight of 10. You can assign a
higher weight to the criteria that are more important.

6. If necessary, select a different Ranking Method for the selected criteria.

Option Description

More is better A higher value is preferred. For example, more
availability is better when determining the
agent ranking.

Less is better A lower value is preferred. For example, fewer
assigned cases are better when determining
agent ranking.

7. Click Save.

Create a task ordering rule

Last updated: July 18, 2018
Last updated: July 18, 2018

Create one or more task ordering rules to prioritize the list of tasks identified by the task
filters.

Before you begin

Role required: admin

About this task

Dynamic scheduling evaluates the task ordering rules based on the values in the Execution
Order field. The ordering rule with the lowest value determines the initial task order. For
example, you can create a task ordering rule that sorts tasks based on the assigned Priority
and orders the P1 tasks first followed by P2 tasks, P3 tasks, and so on. The ordering rule with
the next lowest value determines an additional order for a subset of tasks within the initial
task list. For example, sort all P1 tasks by SLA due date. Create any number of task ordering
rules to determine how tasks are ordered for dynamic scheduling.
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Rules are evaluated in the execution order. Dynamic scheduling goes to the rule with the
next highest execution order only when task values are equal for the current rule.

You can create two types of task ordering rules: simple and advanced.

• A simple rule sorts tasks based on one selected field from the task table and either an
ascending or descending sort order

• An advanced rule sorts tasks based on selections from two different tables, the task table
and any other table that contains the desired information. Connecting Task Field?

The Priority Based Ordering rule is provided with the Dynamic Scheduling plugin. This rule
uses the Priority field and the a to z sort order to determine the order of the tasks to be
scheduled. You can modify this task and create additional tasks as needed.

Procedure

1. Navigate to Field Service > Administration > Dynamic Scheduling Configuration.
2. In the Task Ordering Rules related list, click New.
3. Fill in the fields on the Task Ordering Rule form, as necessary.

Task Ordering Rule form
Field Description
Name The task ordering rule name.

Execution Order The order in which this rule is evaluated.

Dynamic Scheduling Config The dynamic scheduling configuration to which
this ordering rule applies.

Advanced Enable this check box to create an advanced
task ordering rule. When enabled, the Task
Field, Task Table, Connecting Task Field, and
Aggregate Function fields are displayed.

Sort Table The table that contains the tasks to be sorted.

Sort Field The field on which the tasks are sorted.

Sort Order The order in which the tasks are sorted, either
ascending (a to z) or descending (z to a).

Task Field The field on which the tasks are sorted.

Task Table For an advanced ordering rule, this field
displays the table that contains the tasks to be
sorted.

Connecting Task Field

Aggregate Function The aggregate function to apply when there
are multiple rows for a task.

• MIN
• MAX
• COUNT
• SUM

4. Click Submit.

Related Reference

• Dynamic scheduling task dependencies
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Create a task unassignment constraint

Last updated: July 18, 2018
Last updated: July 18, 2018

Define the constraints that prevent a task from being unassigned even if it is of lower
importance based on the task ordering rules.

Before you begin

Role required: admin

About this task

Three task unassignment constraints are provided with the Dynamic Scheduling plugin.

• Task with downstream: prevents a task from being unassigned if it has a downstream task.
• Would breach SLA in the next 5 hours: prevents a task from being unassigned if the task

SLA is due to expire within five hours.
• Part sourced: prevents a task from being unassigned if one or more parts required for the

task have already been sourced.

When the unassignment option is enabled, dynamic scheduling can unassign a previously
assigned task in order to complete the assignment of a more important task. Task
importance is determined by task ordering rules. If an unassigned task has downstream
tasks, the downstream tasks are also unassigned and added to the queue. The system will
take care of assignments correctly, as long as ordering rules are not defined in a way that
conflicts with the task dependencies.

Procedure

1. Navigate to Field Service > Administration > Dynamic Scheduling Configuration.
2. In the Un-Assignment Constraints related list, click New.
3. Click the lookup icon next to the Constraint field.
4. In the Constraints list, click New.
5. Fill in the fields on the Constraint form, as necessary.

Constraint form
Field Description
Name The constraint name.

Task Table The task table to which this constraint applies.

Type The type of constraint.
• Simple: define a simple constraint by

selecting a table, a task field, and one or
more filter conditions.

• Advanced: define an advanced constraint
by creating a script.

Constraint Table The table used to define a constraint on a task.

Task Field The task field to which this constraint applies

Constraint Condition When true, the selected condition prevents a
task from being reassigned or unassigned.

Constraint Script For an advanced constraint, create a script to
define the constraint details.
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6. Click Submit.
Returns you to the Un-Assignment Constraint form.

7. Click Submit.
Returns you to the configuration form and adds the constraint to the Un-Assignment
Constraints related list.

Validate the dynamic scheduling configuration

Last updated: July 26, 2018
Last updated: July 26, 2018

After creating a dynamic scheduling configuration, validate the configuration to ensure that
works as intended.

Before you begin

Role required: admin

About this task

After creating or modifying a dynamic scheduling configuration, click the Validate config
related link to validate the settings. If the configuration is valid, an informational message
appears at the top of the Dynamic Scheduling Configuration form.

Select and assign multiple tasks

Last updated: July 18, 2018
Last updated: July 18, 2018

Dispatchers can manually select multiple tasks on which to run dynamic scheduling.

Before you begin

Role required: wm_dispatcher or wm_admin

About this task

Users with the dispatcher role can select multiple tasks for assignment. Clicking Auto Assign
creates assignment recommendations for the selected tasks which the dispatcher can view
in the Confirm Assignment pop-up window. The dispatcher can then cancel or confirm the
task assignments.

If there has been an update to any of the selected tasks, an informational message notifies
the dispatcher to run the recommendations again.

Procedure

1. Navigate to a list of work order tasks.
2. Select the desired tasks for assignment. Tasks must be in the Pending Dispatch state.
3. From the Actions menu at the bottom of the list, select Auto Assign.

The Confirm Assignment pop-up window displays a list of the selected tasks in the
following categories: Assigned, Not Assigned, Reassigned, and Unassigned.

Note:  If there has been an update to any of the selected tasks, an informational
message notifies the dispatcher to run the recommendations again.
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Note:  If more tasks are selected than dynamic scheduling can handle, the pop-
up window displays a message to reduce the number of tasks.

4. Click Confirm to approve the recommendations on the Confirm Assignment pop-up
window.

• Confirm Assignment pop-up window

When using the dynamic scheduling feature, the Confirm Assignment pop-up window
displays the task assignment recommendations.

Confirm Assignment pop-up window

Last updated: July 18, 2018
Last updated: July 18, 2018

When using the dynamic scheduling feature, the Confirm Assignment pop-up window
displays the task assignment recommendations.

When a dispatcher selects multiple tasks for assignment and clicks Auto Assign, the results
of the task assignment process are displayed in the Confirm Assignment pop-up window.
Information about the selected tasks, including the Short Description, Scheduled Start, and
Estimated End, is displayed in the following categories.

Category Definition
Assigned Dynamic scheduling is able to find a suitable

agent and recommends the task for assignment.

Unassigned Dynamic scheduling is not able to find a suitable
agent and the task remains unassigned.

Reassigned Tasks that were previously assigned and have
been reassigned to a different agent or time slot
to allow for the assignment of the selected tasks.

Not Assigned Tasks that were previously assigned, have been
unassigned to allow for the assignment of the
selected tasks, and have not yet been reassigned.
Selected tasks that do not match the task filter
also appear in the Not Assigned category.

The information icon next to each task displays additional information about the task in a
tool tip, such as required skills and parts. For unassigned and reassigned tasks, this
information also includes the previous agent and schedule start time.

If more tasks are selected than dynamic scheduling can handle, the pop-up window displays
a message to reduce the number of tasks.

If there has been an update to any of the selected tasks, an informational message notifies
the dispatcher to run the recommendations again.

Clicking Save confirms the task assignment recommendations listed in the Confirm
Assignment pop-up window.

Task assignment debug log

System administrators can also view task assignment debug logs in the Confirm Assignment
pop-up window by enabling the com.snc.dynamic.scheduling.showlogs system property.
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This information is displayed below each task in the pop-up window. Collapse or expand the
debug log by clicking on the task.

Display the task assignment debug log

Last updated: July 18, 2018
Last updated: July 18, 2018

Display information from the task assignment debug log in the Confirm Assignment pop-up
window.

Before you begin

Role required: admin

About this task

System administrators can enable the com.snc.dynamic.scheduling.showlogs system
property to display debug logs in the Confirm Assignment pop-up window. This information
is displayed below each task. Collapse or expand the debug log by clicking on the task.

The task assignment debug log information is stored in the Log [syslog] table.

Procedure

1. Navigate to System Properties > All Properties.
2. Go to the com.snc.dynamic.scheduling.showlogs property.
3. Set the Value to true.
4. Click Update.

The Confirm Assignment pop-up window displays the debug logs for each of the
selected tasks. Click the task to collapse or expand this information.

View an agent's status in Central Dispatch

Last updated: July 18, 2018
Last updated: July 18, 2018

Use Central Dispatch to see if an agent is ahead of schedule, behind schedule, or on time.

Agents are responsible for updating their schedule status. An agent can update this
information from the mobile UI by navigating to the Field Service menu and selecting the
Schedule Status option, then selecting the desired status in the On schedule field.

After updating, there are two ways for a dispatcher to view an agent's status:

• Adding the status to the display fields in the Team list.
• Viewing the status on the User form for a selected agent.

In Central Dispatch, the Team list displays the agents in a dispatch group. The dispatcher can
configure the information displayed for each agent in this list, including the agent's status.
See Configure central dispatch for more information about displaying the Schedule Status
field in the Team list.

Click an agent name in the Team list to display the agent's User form. The On schedule field
displays the agent's current status:

• On time
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• Behind schedule, less than 30 minutes
• Behind schedule, between 30-60 minutes
• Behind schedule, more than an hour
• Ahead of schedule

Set agent status from the mobile UI

Last updated: July 18, 2018
Last updated: July 18, 2018

Field service agents can indicate their status from the mobile UI and let dispatchers know if
they are ahead of schedule, behind schedule, or on time.

Before you begin

Role required: wm_agent

Procedure

1. In the mobile UI, navigate to Field Service > Schedule Status.
2. Select the desired status in the On schedule field.

• On time
• Behind schedule, less than 30 minutes
• Behind schedule, between 30 to 60 minutes
• Behind schedule, more than an hour
• Ahead of schedule

3. Click Save.
The status is updated on the agent's User form. The dispatcher can see this status
update in Central Dispatch.

Set agent status from the desktop

Last updated: July 18, 2018
Last updated: July 18, 2018

Field service agents can indicate their status from the desktop and let dispatchers know if
they are ahead of schedule, behind schedule, or on time.

Before you begin

Role required: wm_agent

About this task

The system administrator must enable the FSM Profile view before field service agents can
update their schedule status from the desktop.

Procedure

1. Click your user name in the banner frame and then click Profile.
2. Select the desired status in the On schedule field.

• On time
• Behind schedule, less than 30 minutes
• Behind schedule, between 30 to 60 minutes
• Behind schedule, more than an hour
• Ahead of schedule

3. Click Update.
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The status is updated on the agent's User form. The dispatcher can see this status
update in Central Dispatch.

Work order task start and end dates

Last updated: July 26, 2018
Last updated: July 26, 2018

Dynamic scheduling uses work order task Window start and Window end dates to schedule
tasks.

If both the Window start and Window end dates are present in the work order tasks,
dynamic scheduling uses these dates.

If the task has a Window start date but the date has passed, dynamic scheduling uses the
current date and time for this value.

If the task has a Window start date but no Window end date, dynamic scheduling uses the
com.snc.wm.wo.task_window_day property to determine this value.

If the task has no Window start date but has a Window end date, dynamic scheduling uses
the current time for this value.

If the task has neither a Window start nor a Window end date, dynamic scheduling uses the
current time and date for the Window start and the com.snc.wm.wo.task_window_day
property for the Window end.

Mandatory skills
Last updated: July 26, 2018
Last updated: July 26, 2018

Use the mandatory skills feature to identify any skills that are required for agents and
technicians to work on customer service cases and field service work orders and tasks. Then
assign cases and tasks to agents and technicians who have those required skills.

When assigning cases, work orders, and work order tasks, the assignment tools consider the
mandatory skills, filter out agents and technicians who do not have these skills, and then
rank the remaining agents.

• If agents with the mandatory skills are available, the cases and tasks are assigned to these
agents.

• If agents with the mandatory skills are not available, then agents with any other, non-
mandatory skills identified in the cases and tasks are ranked and assigned.

Field service dispatchers (wm_dispatcher), field service technicians (wm_agent), customer
service managers (sn_customerservice_manager), and customer service agents
(sn_customerservice_agent) can specify both skills and mandatory skills for cases and tasks.

Mandatory skills is an optional feature. Mandatory skills can be identified on the assignment
workbench. In addition to the Skills list, the assignment workbench includes a Mandatory
Skills Added list. Agents are ranked in the workbench based on the number of skills that
match the skills identified in the Skills list. If the mandatory skills feature is being used, then
the agents displayed are filtered by the skills listed in the Mandatory Skills Added list and
then ranked by the other matching criteria.
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Related Topics

• Use the assignment workbench

Configuring the mandatory skills feature

Last updated: July 26, 2018
Last updated: July 26, 2018

Configure the mandatory skills feature for use with the Customer Service Management and
Field Service Management applications.

Mandatory skills is an optional feature included with the Customer Service Management and
Field Service Management plugins. Use the steps below to configure this feature with the
desired application.

Customer Service Management configuration

To configure the mandatory skills feature for use with Customer Service Management:

• In the Case form:
Configure the form layout to use the Task Skills [task_m2m_skill] table.
In the Task Skills table, set the Mandatory field to True to identify skills that are

mandatory to complete a task.

Note:  The Case form should use either the Skills field or the Task Skills table, but
not both.

• [Optional] For existing cases that have data populated in the Skills field on the Case form,
run the Migrate Skills to Task Skill M2M script to move this data to the Task Skills table. By
default, this fix script migrates the skills from existing entries in the Case, Work Order, and
Work Order Task tables to the Task Skills table. For more information, see Migrate skills to
the Task Skill table.

• If you are using the assignment workbench, replace the Matching Skills matching criteria
with the Matching Skills - Mandatory Skills Support matching criteria. For more
information, see Matching rules for case assignment.

Field Service Management configuration

To configure the mandatory skills feature for use with Field Service Management:

• Enable the work.management.use.mandatory.skills system property.
• Configure the Work Order form and the Work Order Task form to use the Task Skills

[task_m2m_skill] table.

Note:  The Work Order and Work Order Task forms should use either the Skills
field or the Task Skills table, but not both.

• [Optional] For existing work orders and tasks that have data populated in the Skills field
on the Work Order and Work Order Task forms, run the Migrate Skills to Task Skill M2M
script to move this data to the Task Skills table. By default, this fix script migrates the skills
from existing entries in the Case, Work Order, and Work Order Task tables to the Task Skills
table. For more information, see Migrate skills to the Task Skill table.

• If you are using dynamic scheduling, update the task filter for the dynamic scheduling
configuration and replace the Matching Skills for Dynamic Scheduling matching criteria
with the Matching Mandatory Skills for Dynamic Scheduling matching criteria. For more
information, see Create a task filter.
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Mandatory Skills system properties

The Migrate Skills to Task Skill M2M script migrates skills from existing tasks to the Task Skills
[task_m2m_skill] table. Configure the task tables included in the migration using the
skills_management.migration system property.

The mandatory skills feature adds the following system properties.

Note:  To open the System Property [sys_properties] table, enter sys_properties.list in
the navigation filter.

System parameter Definition
work.management.use.mandatory.skills Enables the mandatory skills feature and indicates that

the Task Skills [task_m2m_skill] table is being used for
work orders and work order tasks.

• Type: true/false
• Default value: false

skills_management.migration Lists the task tables to migrate to the Task Skills
[task_m2m_skill] table when an admin runs the Migrate
Skills to Task Skill M2M script.

• Type: choice list
• Default value:

wm_task,customerservice_case,wm_order

com.snc.skills_management.task_skill_migrated_tablesContains a list of tables for which the Skills field has
already been migrated to the Task Skills
[task_m2m_skill] table. If the table name is listed in this
property, the data has been migrated and will not be
migrated again.

• Type: choice list
• Default value: none

Migrate skills to the Task Skill table

Last updated: July 26, 2018
Last updated: July 26, 2018

Migrate data from the Skills field to the Task Skills table to utilize mandatory skills support
for executing tasks in a case or work order.

Before you begin

Role required: wm_admin, admin

About this task

The Task Skills [task_m2m_skill] table stores skills and mandatory skills.

In the Customer Service Management application, the assignment workbench uses the Task
Skills table instead of the Skills field in the Case table to display agents based on the
evaluation criteria for task assignments.
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In the Field Service Management application, the work order task assignments done using
auto-assignment, dynamic scheduling, and central dispatch use the Task Skills table instead
of the Skills field in the Work Order and Work Order Task tables to assign agents for task
assignments.

Procedure

1. Add a system property with the following settings:

Option Description

Create a system property for a table in the
Customer Service Management application. Make sure that you are logged in to the

Customer Service Management application.

Note:  Configure the System
Properties form to display the
Suffix field.

In the Suffix field, enter the name of the system
property as follows:
com.snc.skills_management.<table_name>_migrate_skills,
where <table_name> is the name of a case
task table from which the skills need to be
copied.

Create a system property for a table in the
Field Service Management application.

Make sure that you are logged in to the Global
application.

In the Name field, enter the name of the
system property in the following format:
com.snc.skills_management.<table_name>_migrate_skills,
where <table name> is the name of a work
order or work order task table from which the
skills need to be copied.

2. In the Type field, set the value to true.
3. Click Update.
4. Navigate to System Definition > Fix Scripts and run the Migrate Skills to Task Skill M2M

fix script.
The skills are copied to the task_m2m_skill table. The name of the table from which the
skills are copied gets appended to the
com.snc.skills_management.task_skill_migrated_tables system property. When the
script is run again, it ignores all tables from which skills have already been migrated.

Execute work order tasks
Last updated: July 26, 2018
Last updated: July 26, 2018

After the dispatcher dispatches work order tasks, the ServiceNow system automatically
sends the tasks to the assigned agent's queue.

The agent has the option to accept or reject the work order task. If the agent accepts the
task, the task state automatically changes to Accepted. If the agent who accepts assignment
of a work order task does not yet have a personal stockroom, the system creates a personal
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stockroom automatically with the name Personal stockroom - <first and last name of agent>.
If the wm_agent role is ever removed from the user, the personal stockroom is deleted.

The examples in this page illustrate the use of tasks with work orders; however, tasks can be
used with any Service Management application. The ServiceNow system provides an agent
with these methods for managing work order tasks:

• Agent task map: The agent task map displays an agent's location and the location of that
agent's tasks for the day in a familiar Google Map. The agent map is available when the
Service Management Geolocation plugin (com.snc.service_management.geolocation) is
active. This map allows for the general scheduling of tasks and provides estimates of an
agent's location. Precise agent locations and some automatic features are available when
your organization purchases a Google Maps API for Business key and enters it into the
system.

• Task queue: It the task map is not available, an agent can manage assigned tasks and their
schedule directly from a queue accessed from the application navigator.

• Accept or reject a work order task

How to accept or reject a work order task.

• Execute a task from the agent map

As an agent, you can accept or reject tasks assigned to you using features in the agent
task map, or take on unassigned tasks near you if your schedule permits.

• Execute a task from the queue

If the agent task map is not used in your organization, you can manage assigned tasks
from the task queue.

• Pick up an asset

Agents can view a consolidated list, grouped by stockroom, of all their assets that are
waiting to be picked up.

• Use drop off lists

Agents use drop off lists to return items that are in their personal stockroom.

• Record asset usage

The Field Service Management application tracks the consumable and non-consumable
parts that are used or changed during the execution of work order tasks.

• Record an incidental expense

Agents can track incidental expenses required to complete a work order task.

• Close a work order task as complete

Only agents can close work order tasks assigned to them.

• Close a work order task as incomplete

Only agents can close work order tasks assigned to them.

• Cancel a work order task
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The Cancel Task option is appropriate if a work order task is no longer necessary or is a
duplicate of another work order task.

Accept or reject a work order task

Last updated: July 26, 2018
Last updated: July 26, 2018

How to accept or reject a work order task.

1. Navigate to Field Service Automation > Work Order > My Work Order Tasks.
2. Open a work order task.
3. Click Accept or Reject.

Note:  You can also accept multiple tasks from the list by selecting the
appropriate check boxes and then selecting Accept from the Actions
choice list.

• Reasons for rejecting tasks

An agent can reject a work order task for reasons such as being unavailable at the
appropriate time or not having the skills required for the task.

• Task dependencies

When an agent accepts a downstream task that is dependent on another task, the
downstream task can be started before the upstream task is complete.

Reasons for rejecting tasks

Last updated: July 26, 2018
Last updated: July 26, 2018

An agent can reject a work order task for reasons such as being unavailable at the
appropriate time or not having the skills required for the task.

A work order task can only be rejected if the agent has not started travel or work for the
task. If you reject the task, you must include a reason in the Work Notes field. A rejected
work order task returns to the Pending Dispatch state so the dispatcher can assign the task
to a different agent.

Task dependencies

Last updated: July 26, 2018
Last updated: July 26, 2018

When an agent accepts a downstream task that is dependent on another task, the
downstream task can be started before the upstream task is complete.

When the agent clicks Start Work, a message states that open task dependencies exist and
asks if the agent wants to start work. If the agent clicks OK, the task state changes to Work
in Progress. If the agent clicks Cancel, no change occurs and the task remains in the
Accepted state.

Execute a task from the agent map

Last updated: July 26, 2018
Last updated: July 26, 2018
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As an agent, you can accept or reject tasks assigned to you using features in the agent task
map, or take on unassigned tasks near you if your schedule permits.

About this task

You can use the auto-routing feature in the map to have the system determine the most
efficient route. Initial routing shows the sequence established when the dispatcher assigned
the tasks. Auto-routing locates you using your mobile device and creates an ideal schedule
based on variables such as location, task duration, travel time, or any task windows. The
agent map, which displays color-coded icons for the tasks and your current location, is
updated as you complete each task.

Procedure

To access the map, users with the wm_agent role navigate to Field Service > Agent > My
Map.
Tasks that are in one of these states are visible on the map:

• Assigned
• Accepted
• Pending Dispatch
• Work in Progress

Note:  These procedures assume that the Service Management Geolocation plugin
(com.snc.service_management.geolocation) is active, and the Google Maps
API for Business key has been entered into the appropriate Google Maps
property.

• Agent map symbols

The agent map shows your location, the tasks assigned to you for the current day, tasks
that have been accepted, and other tasks that have not yet been assigned.

• Agent location

The Field Service Management application calculates your location from a set of
geographical coordinates.

• Manage tasks on the map

The icons in the task map mark the location of tasks assigned to you and any unassigned
tasks in your area.

• Pick up an unassigned task

Agents can assign themselves nearby unassigned tasks directly from the agent task map.

Agent map symbols

Last updated: July 26, 2018
Last updated: July 26, 2018

The agent map shows your location, the tasks assigned to you for the current day, tasks that
have been accepted, and other tasks that have not yet been assigned.

Task icons are color coded and display automatic sequence numbers indicating the order in
which the dispatcher has scheduled the tasks initially.
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Task icons
Icon Title Description

Agent Your current location on the
map.

Assigned Assigned tasks that have not yet
been accepted.

Accepted Tasks that have been accepted
or tasks that are in progress.

Unassigned Unassigned tasks that are
awaiting dispatch. These tasks
are available for an agent to
accept to fill gaps in a schedule.

Multiple tasks Multiple tasks clustered by
proximity. the ServiceNow
system gathers tasks together
by proximity into a cluster as
you increase the altitude of the
map view. Counters in the
cluster icon indicate the number
of tasks rolled up as the
perspective changes.

Agent map

Agent location

Last updated: July 26, 2018
Last updated: July 26, 2018

The Field Service Management application calculates your location from a set of
geographical coordinates.
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These coordinates are updated at a predefined interval based on geolocation data returned
by your mobile device. Your position at the beginning of the day might be calculated from
mobile device coordinates or from the location of the home office, whichever is more
current. If you are starting the day completing a task that carried over from the previous day,
the system uses the location of that task as your starting position. The system uses your
precise location throughout the day to calculate accurate travel times, route your tasks
automatically, and schedule fixed time windows.

Manage tasks on the map

Last updated: July 26, 2018
Last updated: July 26, 2018

The icons in the task map mark the location of tasks assigned to you and any unassigned
tasks in your area.

You can manage your tasks and routing from the map, filter the view, and accept unassigned
tasks.

• View work order task information

Click the task icon on the agent map to view task details.

• Use the filter

Use the filter to change the items visible on the agent map.

• Auto-routing

Auto-routing reorders agent tasks for the day as efficiently as possible using either
geolocation or straight line estimation.

• Start work

What to do when you are ready to begin travelling to the first task.

• View task information on the mobile UI map

The agent map on the mobile interface displays the agent's location, tasks assigned to the
agent for the current day, accepted tasks, and unassigned tasks.

Last updated: July 26, 2018
Last updated: July 26, 2018

Click the task icon on the agent map to view task details.

A summary pop-up window shows the task number and description, the name of the agent
if one is assigned to the task, and other important information.

Click a cluster icon to display a summary pop-up listing the number of tasks at that location
by State. Click any entry to display detailed summaries for all the tasks in a pane beside the
map. You can access individual task records from this list.

The following information is included in a summary pop-up window for a single task and in
the summary pane for a task cluster:

• SLA: the time remaining on an SLA, if one is affected by this task.
• Priority: the task priority by number, with 1 being the highest priority and 5 being the

lowest.
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• Skills needed: the agent skills needed to perform the work.
• Parts needed: the parts needed to perform the work.

Agent map with task popup

Click the task number link in the summary pop-up or in the summary pane to display the
task in a record pop-up. Use the controls under Related Links to accept or reject a task and
to update your work status by starting or completing a task.

Agent map with task details

Last updated: July 26, 2018
Last updated: July 26, 2018

Use the filter to change the items visible on the agent map.

• To change the items visible in the map, click View Filter.
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Use the filter to show and hide tasks, the routing sequence numbers, or your location, and
to change the date to view another day's tasks. You can also let the system choose your
route for you.

Filters
Filter Description
Show unassigned tasks All unassigned tasks are displayed by default.

Clear the check box to hide unassigned tasks.

Show assigned tasks All assigned tasks are displayed by default. Clear
the check box to hide assigned tasks.

Show my location Your current position. If the system cannot
locate you automatically by mobile device, the
location is the site of a continuing task or the
home office.

Show routing numbers Show or hide routing numbers on tasks
dispatched for that day.

On The current date is selected by default. You can
change the date to view tasks for that day.

Agent map filter

• Click Apply Filter to apply your changes to the map.
• Click Apply auto-routing to let the system decide the most efficient route for your tasks.

Last updated: July 26, 2018
Last updated: July 26, 2018

Auto-routing reorders agent tasks for the day as efficiently as possible using either
geolocation or straight line estimation.

Properties are used to configure system estimates by adjusting:

• Travel time between tasks.
• Task windows that are either fixed or flexible.
• Task dependencies that require the completion of a prerequisite task.
• Toll road routing that is either enabled or disabled.
• Rush hour and other specified time buffers.

If a task cannot be auto-routed because of an impractical or missing location or because the
task window cannot be scheduled, the system displays a message advising that the
unroutable task was not included in the new sequence. Dependent tasks cannot be auto-
routed if the routing produces a circular relationship. The system returns any unroutable task
to the Pending Dispatch state.
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Google Maps API for Business

Geolocation uses Google Maps API for Business to calculate the most efficient route
between tasks, using real-time positioning.

To use geolocation, you must provide a Google Key and client ID. For more information, go
to Google Maps API for Business.

Straight line estimates

If you do not have Google Maps API for Business, the system uses built-in time and distance
estimates based on latitude and longitude to determine the best route for the agent.

Routing restrictions

Certain general restrictions apply to auto-routing.

• If you attempt to auto-route more than 200 tasks, routing fails and the system displays a
message describing the error.

• If a task cannot be auto-routed because of an impractical or missing location, or because
the task window cannot be scheduled, a message is displayed advising that the unroutable
task was not included in the new sequence.

• Dependent tasks cannot be auto-routed if the routing would produce a circular
relationship.

Note:  The system returns any unroutable task to the Pending Dispatch state.

Related Concepts

• Geolocation

Last updated: July 26, 2018
Last updated: July 26, 2018

What to do when you are ready to begin travelling to the first task.

1. Open the task record from the map, and click Start Travel under Related Links.

The system enters the time in the Actual travel start field.

2. When you arrive at the job site and begin the task, open the task record, and click Start
Work under Related Links.

The system enters the time in the Actual work start field.

3. When the work is done, open the task record and add a work note describing what you
did to complete the task.

4. Click Close Complete under Related Links.

The system redraws the map and removes the icon for the completed task. The next
accepted task in the route is relabeled as number 1. The agent icon appears at the site of
the last location update.
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Agent map with next task

Last updated: July 26, 2018
Last updated: July 26, 2018

The agent map on the mobile interface displays the agent's location, tasks assigned to the
agent for the current day, accepted tasks, and unassigned tasks.

Before you begin

Role required: wm_agent

About this task

Use the filter to change the items visible on the agent map. Show and hide tasks or routing
sequence numbers, change the location, or change the date to view the tasks for a different
day.

Procedure

1. In the mobile interface, navigate to Field Service > My Map.
2. Click the gear icon in the map header to display the filter settings.
3. Change the filter settings as needed.

Option Description

On Displays the current date. Click the arrow to
display the calendar and select a different
date.

Show Assigned Tasks All assigned tasks are displayed by default.
Disable the switch to hide assigned tasks.

Show My Location Displays your current position on the map with
the agent location icon. Disable the switch to
remove this icon from the map.
If the system cannot locate you automatically
by mobile device, it uses the location of a
continuing task or the home office.
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Option Description

Show Routing Numbers Displays the routing numbers on tasks
dispatched for the date selected in the
calendar. Disable the switch to hide the routing
numbers.

Show Unassigned Tasks All unassigned tasks are displayed by default.
Disable the switch to hide unassigned tasks.

4. Click Save and then click the left arrow to return to the map.

Pick up an unassigned task

Last updated: July 26, 2018
Last updated: July 26, 2018

Agents can assign themselves nearby unassigned tasks directly from the agent task map.

About this task

Agents can assign themselves nearby unassigned tasks directly from the agent task map.
This might be necessary to complete a schedule when a another task is cancelled or a fixed
task window cannot be met. Make sure the task's scheduled start time and duration fit into
your route and that the travel time is realistic. If the task does not fit into the available time
slot in your schedule, the ServiceNow system blocks the assignment and displays a warning.

Procedure

1. To pick up an unassigned task, click a red icon near you and open the task record.
2. Under Related Links, click Assign to me. If the task can be assigned to you, one of the

following occurs:

• If you belong to more than one assignment group, you are asked to select a group.
Only the assignment groups that belong to the dispatch group of the task are
displayed.

• If you belong to only one assignment group, the system assigns the task to you and
enters your assignment group in the Work Order Task form.

3. If the assignment is allowed, the task state changes to Accepted, and the icon on the
map turns green. In the task form, the Start Travel and Start Work links appear under
Related Links.

Execute a task from the queue

Last updated: July 26, 2018
Last updated: July 26, 2018

If the agent task map is not used in your organization, you can manage assigned tasks from
the task queue.

1. Navigate to Field Service > Agent > Assigned to me.
2. Open a work order task.
3. When parts are delivered or picked up from a stockroom, acknowledge the delivery.

a. In the Transfer Orders related list, open the transfer order.
b. In the Transfer Order form, open a record from the Transfer Order Lines related list.
c. Click Receive to acknowledge delivery from an external stockroom, or click Deliver if

the part is located in your personal stockroom.
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Transfer order lines form

4. Click Start Travel when you begin travel to the remote site.

This is mandatory if the Scheduled travel start field is completed.

5. Click Start Work when you begin working on the task.
6. When work is complete, record any asset usage.
7. Add a description of the work you did to the Work notes field.

This is required to close the task.

8. Close the task.

Note:  The Start Work and Start Travel buttons appear together on the form.
When you click Start Travel, that button disappears. If no travel is
scheduled, and you click Start Work, both buttons disappear.

Pick up an asset

Last updated: July 26, 2018
Last updated: July 26, 2018

Agents can view a consolidated list, grouped by stockroom, of all their assets that are
waiting to be picked up.

About this task

The agents can physically pick up the assets and then record them as delivered. The list
contains transfer order lines in the Received or In Transit stage with a work order task that
meets the following criteria:

• Assigned to the agent
• In the Accepted or Work in Progress state

Procedure

1. Navigate to Field Service > Pick Up/Drop Off > My Pick Up List.
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The Transfer Order Lines list is displayed in PickUpList view.

Pickup list

2. (Optional) Click text in any column to obtain more information about, for example, the
transfer order, the transfer order line, or the asset.

3. After physically picking up the items, select a check box next to the transfer order
column, then go to the Actions choice list and select Deliver.

Pickup list marked as delivered

Use drop off lists

Last updated: July 26, 2018
Last updated: July 26, 2018

Agents use drop off lists to return items that are in their personal stockroom.

An item may need to be returned because it is defective or not needed to complete a work
order task. Agents can create a drop off list of items to send the items to a different
stockroom using a transfer order. Agents also have the option to physically drop items off at
a stockroom and note the drop off in the Field Service Management application.

Agents using the mobile interface can also ship drop off lists to a remote location using the
Prepare for shipment and Ship buttons.

An asset must meet the following criteria to be added to an agent's drop off list:

• Located in the agent's personal stockroom
• Drop Off check box selected on the transfer order record
• One of the following:

Substate is Defective
Asset was not used and the work order task is in Closed Complete state

• Create a drop off list

Agents can create a drop off list of assets at any time.

• View a drop off list
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Agents can view a consolidated list, grouped by stockroom, of all items that have been
added to drop off lists by all agents.

• Drop off an asset

Agents can physically drop assets off at a stockroom.

Create a drop off list

Last updated: July 26, 2018
Last updated: July 26, 2018

Agents can create a drop off list of assets at any time.

About this task

As an example, the agent might have several assets that were removed when completing a
work order task and all of the assets need to be returned to a different stockroom.

After creating a drop-off list, there are two ways to add items to the list.

• Use the Add Defective button to add items that are in their personal stockroom with a
substate of Defective. For more information about defective items, see Recording Asset
Usage.

• Create a transfer order line for an item in the personal stockroom.

The item cannot have a substate of Reserved or Defective, and cannot already be included
on another drop off list.

Procedure

1. Navigate to Field Service > Pick Up/Drop Off > Create Drop Off List.
2. Select a To stockroom.
3. Click Submit.
4. Do one or both of the following:

• Click Add Defective to add all defective items in your personal stockroom to the
drop off list.

• In the Transfer Order Lines related list, click New, select a Model, and click Submit.

Only items in an agent's personal stockroom that are not reserved, not defective,
and not included on another drop off list are available for selection.

View a drop off list

Last updated: July 26, 2018
Last updated: July 26, 2018

Agents can view a consolidated list, grouped by stockroom, of all items that have been
added to drop off lists by all agents.

1. Navigate to Field Service > Pick Up/Drop Off > All Drop Off Lists.
2. Expand a group by clicking the arrow beside the group name.

Drop off an asset

Last updated: July 26, 2018
Last updated: July 26, 2018
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Agents can physically drop assets off at a stockroom.

About this task

If a dropped-off item was not used, it is automatically placed in In Stock - Available state. If a
dropped off item is defective, it is automatically placed in In Stock - Defective state.

Procedure

1. Navigate to Field Service > Pick Up/Drop Off > My Drop Off List.

The Transfer Order Lines list is displayed in DropOffList view.

2. (Optional) Click text in any column to obtain more information about, for example, the
transfer order or stockrooms.

3. After physically dropping off the items, select the check box beside the item, then go to
the Actions choice list and select Drop Off.

Drop off an asset

Record asset usage

Last updated: July 26, 2018
Last updated: July 26, 2018

The Field Service Management application tracks the consumable and non-consumable
parts that are used or changed during the execution of work order tasks.

About this task

The Asset Usages related list on the Work Order Task form displays the assets that are used
during the execution of a task and also any existing assets that are removed from the task
location. The field service agent adds records to the Asset Usages related list by clicking the
Remove Asset and Use Asset buttons and filling in the details on the Asset Usage form.

The status of an asset can be one of the following:

Asset status settings
Setting Description
Used When an agent records the use of an asset, the

asset is added to the Asset Usages related list
with a status of Used.
If the asset is a non-consumable, it is marked as
being In Use and assigned to the caller identified
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Setting Description
on the work order. If the asset is a consumable, it
is marked as Consumed.

Not used When a transfer order line is delivered to an
agent, the system creates a new asset usage
record with a status of Not Used.
If the agent does not use the asset and the work
order task is closed, the asset usage record
remains Not Used. The asset is marked as In
Stock Available in the agent's personal
stockroom.

Removed When an agent records the removal of an asset,
the asset is added to the Asset Usages related list
with a status of Removed.
Assets are most often removed because they are
not working. These assets are marked as
Defective.

• Remove an asset

If you remove an existing asset from a task location during the execution of a task, record
the asset on the Asset Usages related list on the Work Order Task form.

• Use an asset

If you use an asset during the execution of a task, record the asset on the Asset Usages
related list on the Work Order Task form.

Remove an asset

Last updated: July 26, 2018
Last updated: July 26, 2018

If you remove an existing asset from a task location during the execution of a task, record
the asset on the Asset Usages related list on the Work Order Task form.

Before you begin

Role required: wm_agent

Procedure

1. Navigate to Field Service > Agent > Assigned to me.
2. Open a work order task.
3. View the Asset Usages related list.
4. Click Remove Asset to display the Asset Usage form.

The Service order task field displays the work order task number and the Status of the
asset is set to Removed.

5. Select a Model.
The Quantity and Asset fields are enabled or disabled depending on the selection in the
Model field.

6. Do one of the following:
• If the selected model is consumable, enter the Quantity removed.
• If the selected model is non-consumable, select the specific Asset.
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7. Click Submit.
The removed asset is added to the Asset Usages related list.

Use an asset

Last updated: July 26, 2018
Last updated: July 26, 2018

If you use an asset during the execution of a task, record the asset on the Asset Usages
related list on the Work Order Task form.

Before you begin

Role required: wm_agent

Procedure

1. Navigate to Field Service > Agent > Assigned to me.
2. Open a work order task.
3. View the Asset Usages related list.
4. Click Use Asset to display the Asset Usage form.

The Service order task field displays the work order task number and the Status of the
asset is set to Used.

5. Select the model of the asset in the Model field.
If the selected model is a consumable, the Asset field becomes read-only.

6. Select the asset in the Asset field.
7. If the asset is a consumable, enter the Quantity used.
8. Click Submit.

The used asset is added to the Asset Usages related list.

Record an incidental expense

Last updated: July 26, 2018
Last updated: July 26, 2018

Agents can track incidental expenses required to complete a work order task.

About this task

Agents can track incidental expenses required to complete a work order task. Incidental
expenses, or incidentals, are distinct from other expenses related to work orders, such as
part requirements. Incidentals represent expenses that arise during the execution of a task
or that are otherwise related to the task. Incidentals are classified by type. Field Service
Management provides incidental types to track the costs of car rentals and miles traveled.
An organization can create additional types to meet their needs.

You can generate incidentals for a task at any point during the task life cycle. For example,
field service administrators might create an incidental in the Pending state before an agent
begins work, based on an anticipated expense. Agents might create incidentals in the
Incurred state as expenses arise during work. Field service administrators and agents can
view all incidentals by navigating to Field Service > Agent > Incidentals.

When an incidental record is created, the system generates an expense line if the following
conditions are met:

• The state is Incurred.
• The type is not None.
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• The cost is greater than zero.

The expense line is deleted if any of these conditions change.

Role required: wm_admin or wm_agent role.

Procedure

1. Open a work order task.
2. In the Incidentals related list, click New.
3. Fill in the fields as appropriate (see table).

Incidental expense form

Incidental expense form fields
Field Description
Work order task [Read-only] Task from which the incidental was

created.

Type Kind of incidental: Mileage and Car Rental.

Cost Total cost of the incidental. If the type is
Mileage, the cost is read-only and is
automatically calculated by multiplying
Quantity and Cost per mile. If the type is Car
Rental, enter the total cost of rental expenses.

Quantity Number of units for the incidental. This field is
required if the type is Mileage; enter the
number of miles traveled. This field is hidden if
the type is Car Rental.

State Status of the expense: Pending or Incurred.

Cost per mile Average cost of transportation per mile. This
field is visible only if the type is Mileage.

Description Helpful information about the incidental
expense.

Close a work order task as complete

Last updated: July 26, 2018
Last updated: July 26, 2018

Only agents can close work order tasks assigned to them.

About this task
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If the caller's problem was fixed or resolved, use the Close Complete option.

Procedure

1. Navigate to Field Service > Agent > Assigned to me.
2. Open a work order task.
3. Add information to the Work notes field. The notes should include a description of the

work done and any other helpful information.
4. (Optional) Enter a date and time earlier than the current date and time in the Actual

Work End field.

You cannot add a date and time later than the current date and time.

If you do not enter a date and time, the ServiceNow system adds the current date and
time automatically when you click Closed Complete.

5. Click Close Complete.

• The status of all unused parts automatically changes to In-Stock.
• The state of the parent work order automatically changes to Closed - Complete if all

work order tasks on the work order have a state of Closed - Complete or Canceled.

Close a work order task as incomplete

Last updated: July 26, 2018
Last updated: July 26, 2018

Only agents can close work order tasks assigned to them.

About this task

If the problem was only partially fixed or resolved, use the Close Incomplete option.

Procedure

1. Navigate to Field Service > Agent > Assigned to me.
2. Open a work order task.
3. Click Close Incomplete.
4. In the Create a follow on task field, do one of the following:

• Select Yes to have a new work order task cloned and, if this task is the last remaining
task to complete, prevent the work order from closing. After the follow on task is
done and marked Closed Complete, the status of the work order changes to Closed
Complete even though the task that generated the follow on task was marked
Closed Incomplete.

• Select No to close the work order task.

5. In the Reason for the incomplete closure field, enter information about why the task
could not be completed. The information entered is added to the Work Notes field on
the work order task form.

• The status of all unused parts automatically changes to In-Stock.
• The state of the parent work order automatically changes to Closed - Incomplete if

all work order tasks have a state of Closed - Complete or Canceled and at least one
task has a state of Closed - Incomplete.
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Cancel a work order task

Last updated: July 26, 2018
Last updated: July 26, 2018

The Cancel Task option is appropriate if a work order task is no longer necessary or is a
duplicate of another work order task.

About this task

Work orders and work order tasks cannot be canceled while in Closed Complete or Closed
Incomplete state. When you cancel a work order task, the ServiceNow system automatically:

• Cancels all associated transfer orders if the items have not already shipped. If the items
have shipped, the system blocks the cancellation of the task until the parts are delivered.

• Removes all upstream and downstream dependencies.
• Changes the state of the parent work order to Canceled if all associated work order tasks

are Canceled.
• Removes all part requirements without a transfer order line.
• Retains all asset usage information.

Work order tasks can be canceled by users with these roles:

User roles
Role Description
Initiator Can cancel a work order, which automatically

cancels all associated work order tasks.

Qualifier Can cancel work orders and work order tasks.

Dispatcher Can cancel work orders and work order tasks.

Agent Can cancel work order tasks assigned to them.

Field Service Management Administrator Can cancel any active work order or work order
task at any time.

Procedure

1. Navigate to Field Service > Work Order > All Work Orders.
2. Open a work order.
3. Open a work order task.
4. In Work notes, enter a cancellation reason.
5. Click Cancel Task. An error message appears if text is not entered into the Work Notes

field.
For traceability, auditing, and possible deletion, field service administrators need to
know the reason why a work order or work order task was canceled.

Agent calendar
Last updated: July 26, 2018
Last updated: July 26, 2018

Customer service agents and field service technicians can use the agent calendar to see
work schedules and assignments and also add personal events such as meetings or
appointments.
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The agent calendar provides a tool for maintaining different work schedules or shifts and
assigning agents and technicians to shifts for specific time periods. The calendar has the
flexibility to accommodate work schedules that are fixed or varied and shifts that rotate by
week, month, or other patterns. The agent calendar administrator creates the calendar
configuration, including a schedule configuration for each calendar user and the types of
tasks to display on the calendar.

The schedule information stored in the agent calendar is used by other ServiceNow
applications and features, such as the assignment workbench, central dispatch, and auto
assignment. The assignment workbench uses agent availability, based on upcoming work
schedules and personal time off, when evaluating predefined criteria and recommending
agents for case assignment. Auto assignment in Service Management core applications,
such as Field Service Management and Facilities Service Management, evaluate agent work
schedules before assigning tasks.

The agent calendar administrator has access to the Agent Schedule menu in the application
navigator. This menu includes the following modules:

• Event Configuration: create a configuration for each type of task displayed on the agent
calendar.

• Work Schedule: create one or more work schedules for each calendar user.
• Agent Personal Events: create personal schedules for each agent and add events to those

schedules.
• Schedule: create or modify schedules. For more information, see Schedules.

Viewing the calendar

Customer service agents and field service technicians with the agent_schedule_user role
can access their personal calendars in the following ways:

• Customer Service > My Schedule
• Field Service > Agent > My Schedule

Note:  The agent calendar is supported in the mobile application and the mobile
web.
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Agent Calendar

The calendar can display a single day, a week, or a month. Buttons in the calendar header
allow you to switch views as well as go backward or forward in time. An agent's scheduled
work hours are highlighted in gray and the current day is highlighted in blue. The agent
calendar displays work or tasks assigned to the agent as well as personal events. Each type
of event is displayed on the calendar using a different color.

Agents can add events to their calendars by double-clicking a specific time slot and entering
the details in the New Event popup window or by clicking and dragging. Agents can also
move events by dragging and dropping. Click an event to display a popup with event details
and double-click an event to open the event record.

Plugins

The Agent Schedule plugin (com.snc.agent_schedule) is activated as part of the Customer
Service Management and Field Service Management plugins.

Tables

The Agent Schedule plugin adds the following tables.

Table Description
Agent Work Schedule
[agent_work_schedule]

Stores one or more work schedules for each
agent, including the date range for the schedule
and the schedule type.
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Table Description
Agent Personal Schedule
[agent_events]

Stores personal calendar events for each agent,
such as training, personal time off, or meetings.

Event Configuration
[agent_schedule_task_config]

Stores a configuration for each type of task
displayed on the agent calendar, such as case
tasks or work order tasks.

Agent Schedule User Config
[agent_schedule_user_pref]

Stores the agent’s personalization data for the
calendar. A user configuration is created
automatically when a user with the
agent_schedule_user role accesses their personal
calendar.

Agent Schedule Relationship
[agent_schedule_task_config_rel_user_pref]

Stores the relationships between agent
configurations and event configurations.
Relationship entries are created automatically
based on a user's read access to the task tables
selected in the event configurations.

Agent Schedule Definition Theme
[agent_schedule_definition_theme]

Stores the colors used to display different types
of tasks on the agent calendar.

User Roles

The Agent Schedule plugin adds the following user roles.

Role Description
Agent schedule administrator
[agent_schedule_admin]

Sets up the Agent Calendar configuration.
Contains roles:

• agent_schedule_user
• schedule_admin

Agent schedule user
[agent_schedule_user]

Allows customer service agents and field service
technicians to access and update their personal
calendars.

• Configure the agent calendar

Users with the agent calendar administrator role can perform several calendar
configuration tasks.

• Add an event to the agent calendar

Users with the agent schedule user role can add events to their personal calendar.

• Move an event on the agent calendar

Users with the agent schedule user role can move events on their personal calendar.

• Show or hide event types on the agent calendar

Users with the agent schedule user role can personalize their calendar and show or hide
different types of events.

• Use the agent calendar
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Users with the agent calendar user role can add events to their personal calendar and
configure the calendar to show or hide different types of events.

Related Concepts

• Schedules

Configure the agent calendar

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the agent calendar administrator role can perform several calendar configuration
tasks.

These tasks include:

• Creating one or more schedule configurations for each calender user.
• Creating an event configuration for each type of task to display on the calendar.
• Creating a work schedule to assign to an agent.

If necessary, agent calendar administrators can create personal events for a calendar user
although the users themselves typically perform these tasks.

• Create an event configuration for the agent calendar

Users with the agent schedule administrator role can create a configuration for each type
of task displayed on the agent calendar, such as case tasks or work order tasks.

• Create a work schedule for an agent or technician

Users with the agent schedule administrator role can create one or more work schedules
for a customer service agent or a field service technician.

• Create a personal event for an agent or technician

Users with the agent schedule administrator role can create personal events that appear
on an agent's personal calendar.

• Create a schedule to use with the agent calendar

Users with the agent calendar administrator role can create a schedule to use with the
agent calendar.

Create an event configuration for the agent calendar

Users with the agent schedule administrator role can create a configuration for each type of
task displayed on the agent calendar, such as case tasks or work order tasks.

Before you begin

Role required: agent_schedule_admin

About this task

Event configuration records are included for case tasks, work order tasks, and appointments.
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Procedure

1. Navigate to Agent Schedule > Event Configuration.
2. Click New.
3. Fill in the fields on the Event Configuration form, as necessary.

Field Description
Name A descriptive name for this configuration.

Task Table The table where the tasks for this type of
configuration are stored.

Task Filter Use the condition builder to create the desired
conditions for the selected task type.
For example, the event configuration for Case
Tasks includes a filter on the task State field to
display only those tasks that are open.

Task User Field Select a field from the Task Table that provides
the user assigned to the task.
For example, the event configuration for Case
Tasks uses the Assigned To field from the Task
table [sn_customerservice_task]. When a case
task is assigned, it appears on the agent
calendar for the user selected in this field.

Display Field Select a field from the Task Table that provides
the information to be displayed for this event
type on the agent calendar.
For example, the event configuration for Case
Tasks uses the Subject field from the Task table
[sn_customerservice_task]. When a case task is
assigned, the subject of the task appears on
the agent calendar.

Start Date Field Select a field from the Task Table that provides
the start date for the task.
For example, the event configuration for Case
Tasks uses the Expected start field from the
Task table [sn_customerservice_task]. When a
case task is assigned, it appears on the agent
calendar starting on the date and time
specified in this field.

End Date Field Select a field from the Task Table that provides
the start date for the task.

For example, the event configuration for Case
Tasks uses the Due date field from the Task
table [sn_customerservice_task]. When a case
task is assigned, it appears on the agent
calender it appears on the agent calendar
ending on the date and time specified in this
field.
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Field Description

Note:  Because the agent schedule
administrator can select any
fields from the Task Table for
the Start Date Field and the End
Date Field, it is possible that the
end date may be earlier than
the start date. In this event, the
task is displayed on the agent
calendar between the two
points in time.

Color theme Select the color used to display this type of
task on the agent calendar.

4. Click Submit.

Create a work schedule for an agent or technician

Users with the agent schedule administrator role can create one or more work schedules for
a customer service agent or a field service technician.

Before you begin

Role required: agent_schedule_admin

About this task

A work schedule includes a date range and a schedule type, such as day shift or evening
shift. Agents and technicians can have multiple work schedules.

Procedure

1. Navigate to Agent Schedule > Work Schedule.
2. Click New.
3. Fill in the fields on the Agent Work Schedule form, as necessary.

Agent Work Schedule form
Field Description
From Date The first day of the work schedule.

To Date The last day of the work schedule.

User The selected agent or technician.

Work Schedule The selected schedule from the Schedules list.

Type The type of work that the agent or technician is
performing during this schedule:

• Primary work
• Other

An agent can have only one primary schedule
for a specific range of dates. Primary schedules
cannot overlap.

4. Click Submit.
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Create a personal event for an agent or technician

Users with the agent schedule administrator role can create personal events that appear on
an agent's personal calendar.

Before you begin

Role required: agent_schedule_admin

About this task

Agents and technicians typically add personal events to their own calendars.

Procedure

1. Navigate to Agent Schedule > Agent Personal Events.
2. Select the personal schedule for the desired agent.
3. In the Schedule Entries related list, click New.
4. Fill in the fields on the Schedule Entry form, as necessary.

Schedule Entry form
Field Description
Name The name of the event.

Type The type of event:
• Time off
• Appointment
• Meeting
• Phone call
• Excluded
• On call
• Time off - in approval
• Time off - rejected

Show as Show this event on the agent's personal
calendar as one of the following:

• Busy
• Free
• Tentative
• On call

Select Busy to exclude the block of time from
agent availability calculations for the auto
assignment and the case assignment
workbench.

When The start date and time of the personal event.

To The end date and time of the personal event.

All day Enable this check box if the event lasts all day.

Repeats Create a repeating event by selecting the
frequency. Depending on the selection, other
fields are required to complete the frequency
information.

• Does not repeat
• Daily
• Every Weekday (Mon-Fri)
• Every Weekend (Sat, Sun)
• Every Mon, Wed, Fri
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Field Description
• Every Tue, Thu
• Weekly
• Monthly
• Yearly

Repeat every Enter a number for the frequency of the
repeated event.

Repeat on For weekly events, select a day of the week.

Monthly type For monthly events, select one of the following.
These selections use the day and date in the
When field as the basis for repetition.

• Day of the month
• Day of the week
• Last day of the month
• Last week of the month

Yearly type For monthly events, select one of the following:
• Day of the year: this selection uses the day

and date in the When field as the basis for
repetition.

• Floating: for this selection, complete the
Float week, Float day, and Float month
fields.

Repeat until Select a date for the end of the repeated event.

Float week For a floating yearly repeating event, select the
week.

Float day For a floating yearly repeating event, select the
day.

Float month For a floating yearly repeating event, select the
month.

5. Click Submit.

Create a schedule to use with the agent calendar

Users with the agent calendar administrator role can create a schedule to use with the agent
calendar.

Before you begin

Role required: agent_schedule_admin

About this task

Creating a schedule for the agent calendar uses the schedule feature. For more information,
see Schedules.

Schedules are configured with two types of records.

• Schedule records specify a time zone and a type of schedule and use one or more
schedule entries. Schedule records are saved in the Schedule [cmn_schedule] table.

• Schedule entry records specify the time periods that are included or excluded from a
schedule. Schedule entries are saved in the Schedule Entry [cmn_schedule_span] table.

Procedure
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1. Navigate to Agent Schedule > Schedule.
2. Click New.
3. Complete the fields on the Schedule form.

Field Description
Name Enter a unique name for the schedule.

Time Zone Select the time zone for the schedule. If you
select Floating, the time zone will be relative to
whatever is accessing the item at any given
time.

Parent Select a parent schedule to constrain the new
schedule.

Type Enter a label that describes the purpose of the
schedule. You can also use one of these system
terms to determine how to process certain
schedules:

• excluded: excludes time periods from SLA
counts.

• maintenance: specifies time periods where
change management activities are allowed.
A schedule containing maintenance
schedule entries cannot also contain
blackout schedule entries.

• blackout: excludes time periods from
change management schedules. A
schedule containing blackout schedule
entries cannot also contain maintenance
schedule entries.

Description [Optional] Describe the schedule.

Note:  The Schedule form displays a warning message if there are no active
entries defined for the current schedule. If your schedule is a child
schedule that only contains exclusions, ignore the message because
exclusions are non-active entries.

4. Right-click the header bar and click Save.

Note:  If you create a schedule of type maintenance and save the record, a UI
policy hides the Type field from the form. To view or change the value for
the Type field, view the list of schedules rather than the schedule form
and add the Type column if necessary. You can double-click the cell for
the value in the Type column and modify from the list view.

5. Configure one or more schedule entries.
6. Click Submit.

Use the agent calendar

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the agent calendar user role can add events to their personal calendar and
configure the calendar to show or hide different types of events.

• Add an event to the agent calendar
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Users with the agent schedule user role can add events to their personal calendar.

• Move an event on the agent calendar

Users with the agent schedule user role can move events on their personal calendar.

• Show or hide event types on the agent calendar

Users with the agent schedule user role can personalize their calendar and show or hide
different types of events.

Add an event to the agent calendar

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the agent schedule user role can add events to their personal calendar.

Before you begin

Role required: agent_schedule_user

Procedure

1. Navigate to your calendar.
• Customer Service > My Schedule
• Field Service > Agent > My Schedule

2. Double-click a timeslot or click and drag over a timeslot on the calendar to open the
New Event form.

3. Fill in the fields on the New Event form, as necessary.

Field Description
Name The name of the event.

Type The type of event:
• Time off
• Appointment
• Meeting
• Phone call
• Excluded
• On call
• Time off - in approval
• Time off - rejected

Show as Show this event on the agent's personal
calendar as one of the following:

• Busy
• Free
• Tentative
• On call

Select Busy to exclude the block of time from
agent availability calculations for the auto
assignment and the case assignment
workbench.

When The start date and time of the personal event.

To The end date and time of the personal event.

All day Enable this check box if the event lasts all day.
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Field Description
Time zone [Read only] If an agent has selected a specific

time zone in their user profile, that time zone is
displayed here and is used as the time zone for
this event. Subsequent changes to the Time
zone field in the user profile do not change the
time zone designation for this event.

Repeats Create a repeating event by selecting the
frequency. Depending on the selection, other
fields are required to complete the frequency
information.

• Does not repeat
• Daily
• Every Weekday (Mon-Fri)
• Every Weekend (Sat, Sun)
• Every Mon, Wed, Fri
• Every Tue, Thu
• Weekly
• Monthly
• Yearly

Repeat every Enter a number for the frequency of the
repeated event.

Repeat on For weekly events, select a day of the week.

Monthly type For monthly events, select one of the following.
These selections use the day and date in the
When field as the basis for repetition.

• Day of the month
• Day of the week
• Last day of the month
• Last week of the month

Yearly type For monthly events, select one of the following:
• Day of the year: this selection uses the day

and date in the When field as the basis for
repetition.

• Floating: for this selection, complete the
Float week, Float day, and Float month
fields.

Repeat until Select a date for the end of the repeated event.

Float week For a floating yearly repeating event, select the
week.

Float day For a floating yearly repeating event, select the
day.

Float month For a floating yearly repeating event, select the
month.

4. Click Submit.
The new event appears on the agent calendar and also in the Schedule Entries related
list on the Agent Personal Schedule form.

Move an event on the agent calendar

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the agent schedule user role can move events on their personal calendar.
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Before you begin

Role required: agent_schedule_user

Procedure

1. Navigate to your calendar.
• Customer Service > My Schedule
• Field Service > Agent > My Schedule

2. Use one of the following methods to move an event.

Option Description

Click an event and drag it to a new day or time The When and To fields in the event record are
updated with the new information.

Double-click an event to open the event record Change the date and time information in the
When and To fields and click Submit. The event
appears on the calendar in the new location.

Show or hide event types on the agent calendar

Last updated: July 26, 2018
Last updated: July 26, 2018

Users with the agent schedule user role can personalize their calendar and show or hide
different types of events.

Before you begin

Role required: agent_schedule_user

Procedure

1. Navigate to your calendar.
• Customer Service > My Schedule
• Field Service > Agent > My Schedule

2. Click the configuration icon in the calendar header to display the Schedule Configuration
menu.

3. Enable or disable the switches for the different types of events.
An option is enabled when the switch is moved to the right and appears with a green
background.

4. Click the configuration icon again to hide the Schedule Configuration menu.
The calendar displays the enabled task types.

Field Service manager module
Last updated: July 18, 2018
Last updated: July 18, 2018

The Field Service Manager module provides enhanced management capabilities for Field
Service managers.

The Field Service > Manager module provides the following capabilities for users with the
wm_manager role.
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Module Description
My Team Provides a list of agents in the manager's

assignment groups.

Team Calendar Provides a calendar view of the agents in the
manager's assignment groups and their assigned
work order tasks and events.

Manage Skills Provides a list of the current skills and the agents
in the manager's assignment groups. Managers
can create or edit skills, assign skills to agents,
and view agents with a specific skill.

Note:  In the Customer Service
Management application, users
with the
sn_customerservice_manager
role can access the Manage Skills
module.

Manager Map Provides a map view of the agents in the
manager's assignment groups and their locations.

Work Order Task Open work order tasks assigned to the manager's
agents and groups.

Recent Work Order Tasks Work order tasks created for the manager's
agents and groups within the last 30 days. This
list includes open and closed work order tasks.

Time Sheets - Pending Approval Time sheets for the agents in the manager's
assignment group that are pending manager
approval.

• Field service manager map

The Field Service manager map shows the locations of the agents in the manager's
assignment groups as well as nearby tasks.

• Field service manager team calendar

Field service managers can use the team calendar to view a list of agents in their
assignment groups and the work order tasks and events that are assigned to the agents.

• Manage Field Service and Customer Service skills

Field Service and Customer Service managers can create or edit skills, assign skills to
agents, and view agents with a specific skill.

Field service manager map

Last updated: July 18, 2018
Last updated: July 18, 2018

The Field Service manager map shows the locations of the agents in the manager's
assignment groups as well as nearby tasks.

Users with the wm_manager role can use the manager map to view agents and tasks and
assign agents to task. The manager map is available for both the desktop interface and the
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mobile interface. For the mobile manager map, users can also open the map legend. The
manager map uses icons to display:

• Accepted, assigned, and unassigned tasks
• Agent status, including on schedule, off schedule, and delayed
• Multiple tasks
• Multiple agents

Field Service Manager Map mobile interface legend

To filter the information displayed on the manager map, click the filter icon in the map
header and select the desired work group or agent and assigned or unassigned tasks.

From the manager map, managers can:

• Assign or reassign a work order task by opening the task and selecting a user in the
Assigned to field.

• View task information by clicking a task icon.
• View details about an agent at a particular location by clicking the agent icon.

Field service manager team calendar

Last updated: July 18, 2018
Last updated: July 18, 2018
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Field service managers can use the team calendar to view a list of agents in their assignment
groups and the work order tasks and events that are assigned to the agents.

Navigate to Field Service > Manager > Team Calendar to view the calendar.

The calendar displays information for a single day or a week. In the week view, the current
day is highlighted in blue. Buttons in the calendar header enable you to switch views as well
as go backward or forward in time. Use the calendar icon to select a specific date or date
range or click Today to select the current date.

The team calendar lists the agents in the selected group and displays the work order tasks
assigned to each agent. It also displays other events such as case tasks, appointments, and
personal time-off. Each type of event is displayed on the calendar using a different color.
Click the schedule configuration icon in the calendar header to select the types of events
displayed in the calendar.

Search the agent list

Search for agents in the team calendar by entering the first or last name of an agent in the
search bar. Search for multiple agents by entering the first or last names separated by a
comma.

Work with tasks

To work with tasks in the team calendar:

• Click an event in the calendar to display overview information in a pop-up window.
• Double-click an event in the calendar to open the event record or click Open in the pop-up

window.
• Update an event from the event record.

Set team calendar properties

The team_calendar.max_calendar_display system property controls the number of agents
displayed per page on the team calendar. The default value for this property is 25 agents per
page.

• Team calendar visibility

Increase the visibility of the group members in a team calendar to other members within
the group as well as to other groups.

Team calendar visibility

Last updated: July 26, 2018
Last updated: July 26, 2018

Increase the visibility of the group members in a team calendar to other members within the
group as well as to other groups.

The team calendar includes a list of the members in an assignment group and their current
assignments. Increasing the visibility to this information enables teams to better coordinate
meetings, events, and tasks.
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Modules

The team calendar is available in the following modules:

• Field Service > Manager > Team Calendar
• Field Service > Agent > Team Calendar
• Agent Schedule > Team Calendar

A system property and assigned group types determine what users can see in these
modules.

Enable the calendar visibility property

The team_calendar.enable_for_grpmember system property controls the calendar visibility
feature. Enable this property to use calendar visibility. By default, this property is set to false.
To access this property, enter sys_properties.list in the application navigator text box and
search for the property name.

Set the group types

The calendar visibility feature provides two group types to control the visibility of group
members in a team calendar.

• schedule_visible_internally: All members in the group are visible to other members in the
group.

• schedule_visible_externally: All members in the group are visible to all groups.

To add these types to the desired groups:

1. Navigate to the group record.
2. Select the group type in the Type field.
3. Click Update.

User roles

The assigned role determines what information a user can view in the team calendar.

Role Visibility with feature enabled Visibility with feature disabled
Field service manager

[wm_manager]

Note:  This role includes the
agent_schedule_manager
role.

Field service managers can see:

• Members in my groups.
• Members in groups that are

visible externally.
• Members in groups to which I

belong and that are also
visible internally.

Field service managers can see:

• Members in my groups.

Field service agent
[wm_agent]

Note:  This role includes the
agent_schedule_user
role.

Field service agents can see:

• Members in groups that are
visible externally.

• Members in groups to which I
belong and that are also
visible internally.

No visibility

Schedule manager Schedule managers can see: No visibility
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Role Visibility with feature enabled Visibility with feature disabled
[agent_schedule_manager] • Members in my groups.

• Members in groups that are
visible externally.

• Members in groups to which I
belong and that are also
visible internally.

Schedule user
[agent_schedule_user]

Schedule users can see:

• Members in groups that are
visible externally.

• Members in groups to which I
belong and that are also
visible internally.

No visibility

Manage Field Service and Customer Service skills

Last updated: July 18, 2018
Last updated: July 18, 2018

Field Service and Customer Service managers can create or edit skills, assign skills to agents,
and view agents with a specific skill.

Users with the wm_manager role (Field Service Management) or
sn_customerservice_manager (Customer Service Management) can manage agent skills.

Navigate to Field Service > Manager > Manage Skills or Customer Service > Manage Skills to
access the Manage Skills form. This form displays a list of the available skills and the agents
in the manager's assignment groups.

Each skill in the All Skills list on the left side of the screen includes the skill name and the
number of users who are assigned that skill. Each user in the user section on the right side
of the screen is represented by a tile that includes the user's name, assignment group,
address, and a list of the skills currently assigned.

From this form, managers can:

• Create new skills by clicking New Skill and adding the skill name and description.
• Edit existing skills by clicking the pencil icon to the left of the skill name.
• View all agents by clicking All Users.
• View the agents who are assigned a specific skill by clicking the skill name.
• Assign a skill to an agent using the following methods:

Click a skill in the skills list and then click Assign/Remove Users. To add a skill, click the
desired user. The tile for the selected user turns blue. To remove a skill, click a user who
has the skill already assigned. If the skill is assigned, the user's tile is blue.
In the user's tile, click the down arrow on the Skills button. Assign multiple skills to a

single user by checking the boxes for the desired skills.

There are two default skills: Field Service Skill and Customer Service Skill. These are parent
skills; other skills created by the manager are stored under these parent skills.

• Migrate skills to the Task Skill table

Migrate data from the Skills field to the Task Skills table to utilize mandatory skills support
for executing tasks in a case or work order.
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Migrate skills to the Task Skill table

Last updated: July 26, 2018
Last updated: July 26, 2018

Migrate data from the Skills field to the Task Skills table to utilize mandatory skills support
for executing tasks in a case or work order.

Before you begin

Role required: wm_admin, admin

About this task

The Task Skills [task_m2m_skill] table stores skills and mandatory skills.

In the Customer Service Management application, the assignment workbench uses the Task
Skills table instead of the Skills field in the Case table to display agents based on the
evaluation criteria for task assignments.

In the Field Service Management application, the work order task assignments done using
auto-assignment, dynamic scheduling, and central dispatch use the Task Skills table instead
of the Skills field in the Work Order and Work Order Task tables to assign agents for task
assignments.

Procedure

1. Add a system property with the following settings:

Option Description

Create a system property for a table in the
Customer Service Management application. Make sure that you are logged in to the

Customer Service Management application.

Note:  Configure the System
Properties form to display the
Suffix field.

In the Suffix field, enter the name of the system
property as follows:
com.snc.skills_management.<table_name>_migrate_skills,
where <table_name> is the name of a case
task table from which the skills need to be
copied.

Create a system property for a table in the
Field Service Management application.

Make sure that you are logged in to the Global
application.

In the Name field, enter the name of the
system property in the following format:
com.snc.skills_management.<table_name>_migrate_skills,
where <table name> is the name of a work
order or work order task table from which the
skills need to be copied.

2. In the Type field, set the value to true.
3. Click Update.
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4. Navigate to System Definition > Fix Scripts and run the Migrate Skills to Task Skill M2M
fix script.
The skills are copied to the task_m2m_skill table. The name of the table from which the
skills are copied gets appended to the
com.snc.skills_management.task_skill_migrated_tables system property. When the
script is run again, it ignores all tables from which skills have already been migrated.

Appointment booking
Last updated: July 26, 2018
Last updated: July 26, 2018

Create time windows for offered services that customers and employees can use to book
service appointments.

With the appointment booking feature, customers can view available appointment windows,
make a selection, and book a service appointment from the service portal. Agents and
dispatchers can also book appointments on behalf of customers. Booking an appointment
creates a work order and one or more work order tasks, depending on the type of service.
Booked appointments can be rescheduled and cancelled within time constraints identified in
the configuration.

Appointment booking requires configuration at both the application level and the service
level. One configuration is required for the application, which is provided for Field Service
Management. This configuration contains settings that apply to all of the services within the
application that support appointment booking.

A separate configuration is required for each of the services within the application that offer
scheduled appointments. A service configuration includes settings that apply only to that
specific service. Both the application configuration and the service configuration must be
active to book appointments.

• Appointment booking components

The roles, properties, and tables for the appointment booking feature.

• Administer appointment booking

Create or modify and enable the application configuration and the individual service
configurations for the appointment booking feature.

• Use appointment booking

Book, reschedule, and cancel appointments for available services.

Appointment booking components

Last updated: July 26, 2018
Last updated: July 26, 2018

The roles, properties, and tables for the appointment booking feature.

The Appointment Booking plugin (com.snc.appointment_booking) is activated
automatically when you activate the Field Service Management plugin. A demo data plugin,
Appointment Booking Demo Data (com.snc.appointment_booking_demo), is also available.

Appointment booking adds the Appointment Booking menu to the application navigator
and the following modules:
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• Appointment Booking Configuration: Use this module to create an appointment booking
configuration for an application and then configurations for each service within that
application.

• Appointment Bookings: Use this module to view a list of appointments that have been
booked for services. This list includes the work orders associated with each appointment.

Roles

Appointment booking adds the following roles.

Role Description
Appointment booking admin
[sn_apptmnt_booking.appointment_booking_admin]

Creates appointment booking configurations for
services within an application.

Appointment booking manager
[sn_apptmnt_booking.appointment_booking_manager]

Creates and updates appointment booking
records.

Appointment booking user
[sn_apptmnt_booking.appointment_booking_user]

Books appointments for services from the
Customer or Consumer Service Portal. This user
can also reschedule or cancel appointments and
view appointment details.

Properties

Appointment booking adds the following properties.

Property Description
sn_apptmnt_booking.max_new_appointments_dailyThe maximum number of appointments that a

user can create daily. The upper limit is 100
appointments per day.

sn_apptmnt_booking.max_appointments_returnedThe maximum number of appointment availability
windows displayed in the Select Appointment
window.

Tables

Appointment booking adds the following tables.

Table Description
Appointment Booking Service Configuration
[sn_apptmnt_booking_service_config]

Stores service configuration records for
appointment booking.

Appointment Booking Configuration
[sn_apptmnt_booking_config]

Stores application configurations records for
appointment booking.

Appointment Bookings
[sn_apptmnt_booking_appointment_booking]

Stores records for all appointments, including
booked, rescheduled, and canceled
appointments.

Administer appointment booking

Last updated: July 26, 2018
Last updated: July 26, 2018

August 6, 2018 ©2018 ServiceNow. All rights reserved. 564

ServiceNow | Customer Service Management



Create or modify and enable the application configuration and the individual service
configurations for the appointment booking feature.

The system administrator can create, modify, and enable an application configuration.
Appointment booking administrators (appointment_booking_admin) can create, modify,
and enable configurations for services within an application.

The Field Service Configuration is an application level configuration provided with the
appointment booking feature, which includes several service level configurations.
Administrators can modify these configurations as needed or use them as examples to
create new configurations.

• Appointment availability

Settings in the application configuration determine how the appointment booking feature
determines availability.

• Task assignment

The application configuration works with the Field Service Management configuration for
task assignment.

• Appointment booking email notifications

The system administrator can create email notifications for appointment confirmation and
cancellation notices and appointment reminders.

• Enable or disable appointment booking

Enable or disable the appointment booking feature for an application as well as for
services within the application that are provided to customers.

• Create or modify an appointment booking application configuration

Create or modify an appointment booking configuration for an application. The
information stored in this configuration applies to all the services within that application.

• Create or modify an appointment booking service configuration

Create or modify an appointment booking configuration for a service within an
application that is provided to customers.

• Configure an appointment booking record producer

Configure an appointment booking record producer and enable the appointment booking
variable set to display the correct fields in that record producer.

Appointment availability

Last updated: July 26, 2018
Last updated: July 26, 2018

Settings in the application configuration determine how the appointment booking feature
determines availability.

Two different methods are provided for determining availability:

August 6, 2018 ©2018 ServiceNow. All rights reserved. 565

ServiceNow | Customer Service Management



Number of appointments per slot

This method uses a specified number of available appointments per time window. The
actual number of appointments is specified in the service configuration. For example, if the
administrator specifies 10 appointments per window, then each appointment window will
have 10 available appointments. The number of available appointments for an appointment
window decreases by one each time an appointment within that window is booked.

Scripted

This method uses a script to determine the number of available appointments per time
window. The default script included with the Field Service Management application
configuration uses the task assignment method set in the Field Service configuration to
determine availability. If the task assignment method is set to manual, the availability
defaults to the Number of appointments per slot availability method. If the task assignment
is set to auto-assignment or dynamic scheduling, the configurations associated with these
task assignment methods are considered while calculating availability.

Excluding days from appointment availability

In the service configuration, the appointment booking administrator can select a schedule of
days that are excluded from appointment availability. The Holiday Schedule field is a
reference field that points to the Schedules table [cmn_schedule]. Selecting a schedule from
the Schedules list defines the days and times to exclude from appointment availability. In the
schedule selected, those days must be set to Excluded.

Related Tasks

• Configure Field Service Management

Related Topics

• Schedules

Task assignment

Last updated: July 26, 2018
Last updated: July 26, 2018

The application configuration works with the Field Service Management configuration for
task assignment.

Appointment booking works with the task-driven process life cycle and the following task
assignment methods:

• Auto-assignment
• Dynamic scheduling
• Manual

Auto-assignment and dynamic scheduling include enhancements that support appointment
booking:

• Identifying the best dispatch group for task assignment.
• Preventing tasks with appointment windows from being unassigned.
• Calculating availability for agents and groups.
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Dynamic scheduling

Appointment booking adds unassignment criteria to the dynamic scheduling configuration
that prevents work orders and work order tasks with appointment windows from being
unassigned. It also adds criteria that prioritizes work orders and tasks with appointment
windows.

Navigate to Field Service > Administration > Dynamic Scheduling Configuration.

• The Task Filters related list includes an Appointment Tasks filter for tasks that have an
appointment window and are in the Pending Dispatch state.

• The Un-Assignment Constraints related list includes the Has Appointment constraint that
prevents tasks with appointment windows from being unassigned.

Central dispatch

When using central dispatch to assign a task with an appointment window, the Window
start and Window end fields for the task use the scheduled appointment date and the
appointment window start and end times.

When a task with an appointment window is assigned to a time that is outside of the
appointment window, the system displays a warning message. The dispatcher can ignore the
warning and assign the task outside of the appointment window.

Rescheduling work start and work end times

When a work order is created for a booked appointment, or when an appointment is booked
for an existing work order, the appointment window start and end times are used for the
work order task Window start and Window end times.

For work order tasks that have scheduled appointments, dispatchers receive warning
messages if they change any of the following fields:

• Window start
• Window end
• Scheduled start
• Scheduled travel start

Related Tasks

• Configure Field Service Management

Related Topics

• Schedules

Appointment booking email notifications

Last updated: July 26, 2018
Last updated: July 26, 2018

The system administrator can create email notifications for appointment confirmation and
cancellation notices and appointment reminders.
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An email notification for an appointment includes task information, such as the task number
and description, as well as the appointment time. It can also include a link that enables the
user to reschedule or cancel the appointment.

System administrators can configure notifications using these appointment booking email
templates:

• appointment.confirmed
• appointment.cancel
• appointment.reschedule

Appointment booking email notifications are active for all services using the appointment
booking feature. The following email notifications are included with the appointment
booking feature:

• Appointment Confirmation: Sent to the customer once the task for an appointment has
been assigned to and accepted by a technician. If acceptance by the technician is not
required, the notification is sent to the customer when the task is assigned.

• Appointment Cancel: Sent to the customer when an appointment is canceled. Can include
task information and also a reason for the cancellation.

Enable or disable appointment booking

Last updated: July 26, 2018
Last updated: July 26, 2018

Enable or disable the appointment booking feature for an application as well as for services
within the application that are provided to customers.

Before you begin

Role required: admin

Procedure

1. Navigate to Appointment Booking > Appointment Booking Configuration.
2. Click the desired configuration.

For Field Service Management, the Field Service Configuration is provided with the
appointment booking feature.

3. Enable or disable the Active check box.
4. In the Appointment Booking Service Configuration related list, click the name of a

service.
This action opens the Appointment Booking Service Configuration form for the selected
service.

5. Set the Active field to true.
6. Click Update.

Create or modify an appointment booking application configuration

Last updated: July 26, 2018
Last updated: July 26, 2018

Create or modify an appointment booking configuration for an application. The information
stored in this configuration applies to all the services within that application.

Before you begin
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Role required: admin

About this task

The Field Service Configuration is provided with the appointment booking feature.

Procedure

1. Navigate to Appointment Booking > Appointment Booking Configuration.
2. To create a new configuration, click New. To modify a configuration, click the

configuration name.
3. In the Appointment Booking Configuration form, fill in or modify the following fields as

needed.

Appointment booking application configuration fields
Field Description
Name The name of the application configuration.

Task Table Appointments are created for the tasks in the
selected table. The Work Order [work_order]
table is the default table for the Field Service
Configuration.

Availability Method Use one of two methods to determine
appointment availability. The selection depends
on the Field Service Management configuration
setting in the Assignment method for tasks
field:

• Number of appointments per slot: Define a
specific number of appointments per time
slot. Use this availability method if the task
assignment method is set to manually.

• Scripted: Use the Field Service
Management configuration setting to
determine availability if the task
assignment method is set to using auto
assignment or dynamic scheduling. This is
the default setting.

Active Activates the application configuration and
enables appointment booking.

Auto acceptance If the Field Service Management configuration
setting for Process lifecycle is set to task-
driven, an agent must accept or reject an
assigned task. Enable the Auto acceptance
check box to override this configuration setting
for appointment booking.

Portal View Display available appointments in the Select
Appointment window on the Customer or
Consumer Service Portal for a single day or for
a week.

Script The script used to determine the number of
available appointments.

4. Click Submit.

Create or modify an appointment booking service configuration

Last updated: July 26, 2018
Last updated: July 26, 2018
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Create or modify an appointment booking configuration for a service within an application
that is provided to customers.

Before you begin

Role required: appointment_booking_admin, admin

About this task

To use the appointment booking feature, administrators must create a configuration for each
service that is available to customers. Service configurations are created within an
application configuration, such as the Field Service Configuration, which is provided with the
appointment booking feature.

Procedure

1. Navigate to Appointment Booking > Appointment Booking Configuration.
2. Click Field Service Configuration.
3. In the Appointment Booking Service Configuration related list, click New.
4. In the Appointment Booking Service Configuration form, fill in the following fields as

needed.

Appointment booking service configuration fields
Field Description
Active Activates appointment booking for the service.

Note:  If deactivated, customers
cannot schedule appointments
for the service but can still
create work orders.

General Information

Name The name of the service configuration.

Appointment Booking Configuration The name of the appointment booking
configuration to which this service belongs.

Availability Table The table that is used to calculate appointment
availability. The default is the Work Order Task
[wm_task] table.

Holiday Schedule The holiday schedule to use when determining
availability. Appointment booking evaluates the
holiday schedule when determining the number
of available appointments and excludes any
day in the schedule that is set to Exclude. Click
the lookup icon and select a schedule from the
Schedules list.

Note:  Holiday schedules are useful
when the assignment method
for tasks is set to manually,
which does not consider agent
schedules.

Catalog Information
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Field Description
Catalog Item The service in the service catalog for which this

appointment booking configuration is being
created. Click the lookup icon and select a
service from the Record Producers list.

Note:  The catalog item must exist in
the service catalog.

Note:  If you are using appointment
booking with work orders,
create a work order template
before you configure
appointment booking.

Location The field on the record provider that
determines the appointment location.

Appointment is mandatory Enable this check box if it is mandatory that a
customer create an appointment when
requesting this service.

• If enabled, the Appointment field appears
on the record producer and the user must
select an available appointment on the
Select Appointment window before
submitting the service request.

• If disabled, the user can submit the service
request without selecting an appointment.

User contact The field on the record provider that
determines who the appointment is being
created for. This is a reference field that looks
for a sys_user variable on the record producer,
for example, Contact.

Booking

Appointments per window The number of available appointments for each
configured appointment time slot. This number
determines the number of available
appointments that are displayed on the Select
Appointment window. Enter a number in this
field if the assignment method for tasks is set
to manually. If set to either using auto-
assignment or using dynamic scheduling, this
setting does not apply, unless a location is not
provided. Then the configuration defaults to
the number of appointments per window.

Lead Time The number of hours or days from the current
time after which an appointment can be
booked for this service. Define the lead time in
hours or days. The default is 4 hours.

Future Bookable Max Days The number of days in advance of the current
day for which an appointment can be booked
for this service. The default is 14 days.

Reschedule / Cancel By Time The number of hours or days prior to an
appointment start time that are required for an
appointment to be canceled or rescheduled. If
a user attempts to cancel or reschedule an
appointment within this number of hours, the
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Field Description
Cancel button is not available. Define the time
in hours or days. The default is 4 hours.

Appointments

Appointment Window The length or duration of the appointment
window.

Note:  Allow enough time for the work
to be started and completed
within this window.

Work Duration The amount of time required to complete all
tasks created by the record producer. This
duration is set for a task when it is created.
Used to determine availability. The default is 1
hour.

Average Travel Duration An estimated value of the average travel time
required (round trip) for the agent performing
the task. Used to determine availability. The
default is 15 minutes.

Daily Schedule

Bookable Days The days of the week for which appointments
can be booked. The default is Monday through
Friday.

Daily Start Time The start of the work day and the earliest start
time for an appointment window. The default is
9:00.

Daily End Time The end of the work day and the latest end
time for an appointment window. The default is
18:00.

Include Daily Break Enable this check box to schedule a break for
each bookable day, then select the break start
and end times. Can define one break which
applies to all days.

Appointment booking preview Provides a preview of the appointment
windows and times based on the selected start
and end times, break time, and appointment
window.

5. Click Submit.

Configure an appointment booking record producer

Last updated: July 26, 2018
Last updated: July 26, 2018

Configure an appointment booking record producer and enable the appointment booking
variable set to display the correct fields in that record producer.

Before you begin

Role required: appointment_booking_admin, admin

About this task
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The appointment booking variable set must be enabled in order to display the appointment
selection widget on the record producer.

Procedure

1. Navigate to Service Catalog > Catalog Definitions > Record Producers.
2. Click the desired record producer.
3. In the Variable Sets related list, click Edit.
4. Select sn_appointment_variable_set and move it to the Variable Sets list.
5. Click Save.

Use appointment booking

Last updated: July 26, 2018
Last updated: July 26, 2018

Book, reschedule, and cancel appointments for available services.

• Select Appointment window

When booking or rescheduling an appointment for a service, use the Select Appointment
pop-up window to view available appointment time slots, select the desired day and time,
and submit the appointment request.

• Book an appointment for a customer

Dispatchers and agents can book appointments for customers.

• Reschedule an appointment for a customer

Dispatchers and agents can reschedule appointments for customers.

• Cancel an appointment for a customer

Dispatchers and agents can cancel appointments for customers.

• Cancel or delete a work order with an appointment

The dispatcher or agent can delete a work order that has a booked appointment.

• Book an appointment from the portal

Book an appointment for a service from either the Customer or the Consumer Service
Portal.

• Book an appointment from an existing work order

Book an appointment for an existing work order from either the Customer or the
Consumer Service Portal.

• Reschedule an appointment from the portal

Reschedule a service appointment from either the Customer or the Consumer Service
Portal.

• Cancel an appointment from the portal

Cancel a service appointment from either the Customer or the Consumer Service Portal.

• View work order and appointment details on the portal
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View a list of appointments for the current user on the Customer or the Consumer Service
Portal and select an appointment to view the work order details.

Select Appointment window

Last updated: July 26, 2018
Last updated: July 26, 2018

When booking or rescheduling an appointment for a service, use the Select Appointment
pop-up window to view available appointment time slots, select the desired day and time,
and submit the appointment request.

In the Select Appointment pop-up window, users see appointment availability based on the
configurations created for the application and the selected service. This configuration can
include:

• Whether the window shows available appointments in a day or week view
• The length of the appointment windows (for example, 2 hours)
• The start and end times for the appointment windows
• The number of appointments available per day

Select Appointment pop-up window

A read-only field at the top of the window displays the currently selected day or week. Use
the arrows or the calendar icon at the top of the window to display different dates.
Unavailable appointment windows are grayed out and not selectable.

The time zone used for appointment is displayed in the lower corner of the window.

• If the selected location for the service has an associated time zone, that time zone is used.
• If the location does not have an associated time zone and the current user does, the user's

time zone is used.
• If neither the location nor the current user have an associated time zone, the system time

zone is used.
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Book an appointment for a customer

Last updated: July 26, 2018
Last updated: July 26, 2018

Dispatchers and agents can book appointments for customers.

Before you begin

Role required: wm_dispatch, sn_customerservice_agent,
sn_customerservice.consumer_agent

About this task

Dispatchers and agents can click Book Appointment on the work order form. This button
appears on the form after the work order is qualified.

Procedure

1. Open a work order form.
The Template field displays the template for the service for which the appointment is
being booked. A service must have an active service configuration in order to book an
appointment.

2. Click Book Appointment in the work order header to display the Select Appointment
pop-up window.
This window displays available appointments for either a single day or for a week. If no
appointments are available, select a different day or week.

3. Use the left and right arrows or the calendar icon to display the desired day or week.
Available appointment time slots for the selected day or week are displayed.

4. Click the desired time slot and then click Select.
Click the link in the information message to view the appointment details. The
appointment is added to the Appointment Bookings related list. If necessary, configure
the Work Order form to display this list.

The appointment is created for the selected date and time. The Window start and
Window end fields on the work order task are updated with the selected appointment
start and end times. The Estimated work duration field is updated with the duration of
the selected appointment time slot.

Reschedule an appointment for a customer

Last updated: July 26, 2018
Last updated: July 26, 2018

Dispatchers and agents can reschedule appointments for customers.

Before you begin

Role required: wm_dispatch, sn_customerservice_agent,
sn_customerservice.consumer_agent

About this task

A dispatcher or an agent can reschedule an appointment for a customer from a work order.

Procedure
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1. Open the work order form.
2. Click Reschedule Appointment to open the Select Appointment pop-up window.

The Select Appointment pop-up window displays the selected day and time of the
current appointment.

3. Select a different day and appointment time slot and then click Select.
The date and time for the appointment are updated. Click the link in the information
message to view the appointment details.

Rescheduling an appointment triggers an appointment rescheduled email to the
customer.

Cancel an appointment for a customer

Last updated: July 26, 2018
Last updated: July 26, 2018

Dispatchers and agents can cancel appointments for customers.

Before you begin

Role required: wm_dispatch, sn_customerservice_agent,
sn_customerservice.consumer_agent

About this task

A dispatcher or an agent can cancel an appointment for a customer from a work order.

Procedure

1. Open the work order form.
2. Click Cancel Appointment.

Note:  If necessary, configure the work order form and add the Cancel
Appointment button.

The appointment is cancelled and an appointment cancelled email is sent to the
customer.

Cancel or delete a work order with an appointment

Last updated: July 26, 2018
Last updated: July 26, 2018

The dispatcher or agent can delete a work order that has a booked appointment.

Before you begin

Role required: wm_dispatch, sn_customerservice_agent,
sn_customerservice.consumer_agent

About this task

• If a work order with an appointment is cancelled, the associated appointment is cancelled.
• If the appointment booking configuration uses the number of appointments per slot as the

availability method, the number of remaining available slots for that appointment window
is incremented when a work order is cancelled or deleted.
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• When a work order is cancelled or deleted, the customer receives a message that the
associated appointment is also cancelled or deleted.

Related Tasks

• Cancel a work order

• Delete a work order

Book an appointment from the portal

Last updated: July 26, 2018
Last updated: July 26, 2018

Book an appointment for a service from either the Customer or the Consumer Service
Portal.

Before you begin

Role required: appointment_booking_user

About this task

Booking an appointment creates a work order for the selected service. After the
appointment is confirmed and the work order scheduled, the customer receives a
confirmation email with the appointment details.

Procedure

1. From the portal, select a service that requires an appointment.
2. If necessary, enter a detailed description.
3. Click the calendar icon in the Appointment field to open the Select Appointment pop-up

window.
This window displays available appointments by day or by week.

4. Use the left and right arrows or the calendar icon to display a different day or week.
Available appointment time slots for the selected day or week are displayed. Unavailable
dates are grayed out and not selectable. If you do not see any available appointments,
select a different day.

5. Click the desired time slot and then click Select.

The Appointment field on the record producer displays the selected appointment
window day and time.

6. Click Submit in the record producer.
The appointment request is submitted and the work order created for the appointment
is displayed. The appointment details appear on the work order page in the
Appointment widget.

Information about the scheduled appointment is noted in the Activities field on the work
order. This information includes the appointment day and time and the time zone for the
selected location.

When the work order is assigned and accepted by a technician, the customer receives a
confirmation email.
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Book an appointment from an existing work order

Last updated: July 26, 2018
Last updated: July 26, 2018

Book an appointment for an existing work order from either the Customer or the Consumer
Service Portal.

Before you begin

Role required: appointment_booking_user

About this task

Procedure

1. In the portal header, click Support > Work Orders.
2. Select the desired work order from the work order list.
3. Use the appointment booking widget to schedule an appointment.

Reschedule an appointment from the portal

Last updated: July 26, 2018
Last updated: July 26, 2018

Reschedule a service appointment from either the Customer or the Consumer Service
Portal.

Before you begin

Role required:

About this task

The details for the scheduled appointment appear on the work order form. Access the
appointment information by selecting the appointment from the list of upcoming
appointments or by going directly to the work order.

Note:  An appointment cannot be rescheduled if the current time is within the
reschedule/cancel window specified in the service configuration.

Procedure

1. In the portal header, click Support > Appointments to display the Appointment Listing
page.

2. Click Upcoming to view a list of upcoming appointments.
3. Select the appointment to reschedule.

This opens the work order for the selected appointment.
4. Click the Appointment field to open the Select Appointment pop-up window.

The Select Appointment pop-up window displays the day or week of the current
appointment and highlights the selected time slot.

5. Select a different day and appointment time slot and then click Select.
The Appointment field displays the new date and time.

August 6, 2018 ©2018 ServiceNow. All rights reserved. 578

ServiceNow | Customer Service Management



Information about the rescheduled appointment is noted in the Activities field on the
work order. This information includes the original appointment window, the rescheduled
appointment window, and the user who made the change.

The user receives a confirmation email that the appointment has been rescheduled.

Cancel an appointment from the portal

Last updated: July 26, 2018
Last updated: July 26, 2018

Cancel a service appointment from either the Customer or the Consumer Service Portal.

Before you begin

Role required:

About this task

An appointment cannot be cancelled if the current time is within the cancellation time
window specified in the service configuration. If within this cancellation time window, the
Cancel button does not appear in the Appointment field on the work order.

Note:  Cancelling an appointment also cancels the associated work order and work
order tasks.

Procedure

1. In the portal header, click Support > Appointments to display the Appointment Listing
page.

2. Click Upcoming to view a list of upcoming appointments.
3. Select the appointment to reschedule.

This opens the work order for the selected appointment.
4. Below the Appointment field, click Cancel.

The system displays a warning that the appointment and the associated work order will
be cancelled.

5. Click Continue to cancel the work order.
The appointment and work order are cancelled. The Appointment field no longer
appears on the work order form and the customer should receive a confirmation email
regarding the cancellation.

Information about the cancelled appointment is noted in the Activities field on the work
order. This information includes the original appointment window, an appointment
cancellation message, and the user who made the change.

View work order and appointment details on the portal

Last updated: July 26, 2018
Last updated: July 26, 2018

View a list of appointments for the current user on the Customer or the Consumer Service
Portal and select an appointment to view the work order details.

Before you begin

Role required: appointment_booking_user
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Procedure

1. In the portal portal header, click Support > Appointments to display the Appointment
Listing page.

2. Click Upcoming to view a list of upcoming appointments.
3. Click an upcoming appointment to view the details on the associated work order.

If necessary, use the Appointment field to reschedule or cancel the appointment.

Time recording for Field Service Management
Last updated: July 26, 2018
Last updated: July 26, 2018

Agents record time worked on tasks and activities. Time recorded entries automatically
generate time cards and time sheets for approval by managers.

The time recording feature extends the functionality of the Time Card Management
application to Field Service Management. Agents can record time worked on tasks from the
Work Order Task form and time spent on other activities, such as meetings or training, from
the Time Worked form. Time worked entries automatically create time cards for each
selected work category. Time cards are automatically included in a weekly time sheet.

The time recording feature also extends the functionality of the Cost Management
application to Field Service Management. Managers can view and create rate types and
labor rate cards and also view expense lines. Time sheets use labor rate cards to determine
costs.

Agents can modify the hours recorded on time cards. Once a time sheet is approved and a
time card is processed, the agent can still go back and modify the time worked. The time
sheet reverts to the Pending state and new time cards are created. If an agent adds more
time worked records to an approved time sheet for the same week, a new time sheet record
is created for the current week.

Managers can view time worked records, time cards, and time sheets for agents in their
assignment groups, as well as approve and reject time sheets. After a time sheet is
approved, the system processes the time cards and uses rate cards based on the time card
category to create expense lines.

Time recording plugin

The time recording feature requires the Field Service Management plugin and the Time
Recording for Field Service plugin (com.snc.wm_time_recording).

The Time Recording for Field Service plugin activates the Time Card Management
(com.snc.time_card) and the Cost Management (com.snc.cost_management) plugins.

User roles

The time recording feature for Field Service Management adds these user roles.

Role Description
Time card user
timecard_user

Create time worked records, time cards, and time
sheets. Users with the wm_agent role inherit the
timecard_user role.
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Role Description

Note:  This role restricts access to the
time sheets, time cards, and time
worked records created by the
agent.

Time card admin
timecard_admin

View, approve, and reject time cards and time
sheets. Users with the wm_manager role inherit
the timecard_admin role.

Note:  This role restricts access to the
time sheets, time cards, and time
worked records created by the
agents in the groups assigned to
the manager.

Time Sheet policy

For users with the wm_agent role, creating time worked records automatically creates or
modifies time cards regardless of the setting for the com.snc.time_card.time_worked system
property. The Time Sheet policy controls this functionality. The system administrator can
disable the auto creation of time cards for a specific user with the wm_agent role by
creating a separate Time Sheet policy for that user.

Field Service view

The Time Card form and the Time Sheet form have a Field Service view. For users with the
wm_agent and wm_manger roles, this view:

• Removes the Generate Time Cards UI action.
• Displays the Time Worked related list on the Time Card form.

• Using rate types and labor rate cards

Use rate types and labor rate cards to define different cost rates for different activities
recorded by field service agents.

• Record time worked for a task or activity

Agents can record time worked on a work order task as well as time spent on other
activities.

• Review time recorded for a task

Agents can review the time recorded for work order tasks.

• Modify or delete time worked entries

Agents can modify and delete existing time worked entries and create new entries after a
time sheet has been approved.

• Review and submit a time sheet

Agents can review and submit time sheets to managers for review and approval.

• Review and approve time sheets
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Managers can review time cards and time sheets for agents in their assignment groups.

Using rate types and labor rate cards

Last updated: July 26, 2018
Last updated: July 26, 2018

Use rate types and labor rate cards to define different cost rates for different activities
recorded by field service agents.

Rate types

When multiple rate types are enabled for Field Service Management, agents can select
active rate types when creating time worked entries. Active rate types can be selected in the
Rate Type field on:

• Time worked records
• Time cards
• Labor rate cards
• The Worker Portal

The Standard rate type is the default value for the Rate Type field.

The time recording feature provides the following rate types:

• FSM Billable Overtime
• FSM Billable Standard

System administrators can create additional rate types by navigating to Time Sheets >
Administration > Rate Types and clicking New.

Labor rate cards

The time recording feature provides the following labor rate cards:

• FSM Rate Card Task Work (Billable)
• FSM Rate Card Task Work OT (Billable)
• FSM Rate Card (Default)

System administrators can create additional labor rate cards using rate types. Navigate to
Cost > Costs > Labor Rate Cards and click New.

Enable multiple rate types

To enable multiple rate types for Field Service Management:

1. Navigate to Time Sheets > Administration > Time Sheet Policies.
2. Click the desired time sheet policy. By default, the system uses the Default time sheet

policy.
3. Enable the Allow multiple rate types field.
4. Select a Default rate type. The default value for this field is the Standard rate type.
5. Enable the Auto create time card on planned task update field.
6. Enable the Auto fill time card with time worked entries field.
7. Click Update.
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Record time worked for a task or activity

Last updated: July 26, 2018
Last updated: July 26, 2018

Agents can record time worked on a work order task as well as time spent on other
activities.

Before you begin

Role required: wm_agent

About this task

An agent can record time worked directly from a work order task by clicking Record Time
on the Work Order Task form. An agent can record time regardless of the work order task
state. An agent can also record time spent on other activities from the Time Worked list by
creating a new time worked record, recording the time, and selecting a category.

Note:  If multiple rate cards are enabled, agents can also select rate types when
creating time worked entries.

A time card is created for each category type and work order task. The total hours recorded
on each time card are then recorded on the current time sheet in the Time Cards related list.

Procedure

1. To record time worked for a task or an activity:
• Navigate to a work order task and click Record Time. This opens a Time Worked

form with the Task and User field already populated.
• Navigate to Time Sheets > My Time Worked and click New. This opens a Time

Worked form with the User field already populated.
2. If necessary, select the work order task in the Task field.
3. If necessary, select the Work Date. This field defaults to the current date.
4. Select a Category for the time being recorded.
5. Select a Rate type for the time being recorded.

When multiple rate types are enabled for Field Service Management, agents can specify
multiple rate types for time worked against a task.

6. Fill in the Time worked.
7. Provide any additional information in the Comments field and click Submit.

The Time Worked form is saved and added to the Time Worked list. If this is the first
time worked entry for the selected category, a time card is created for that category and
the time worked record is added to the card. If a time card for the category already
exists, the time worked record is added to that card.

Review time recorded for a task

Last updated: July 26, 2018
Last updated: July 26, 2018

Agents can review the time recorded for work order tasks.

Before you begin

Role required: wm_agent

About this task
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The Time Worked related list on the Work Order Task form displays the Time Worked
records that have been created for the work order task. From this related list, field service
agents can review their recorded time and also delete records.

Procedure

1. Navigate to the desired work order task.
2. Go to the Time Worked related list.

This list displays the Time Worked records that have been created for this work order
task.

3. To view a record, click the Category.

Modify or delete time worked entries

Last updated: July 26, 2018
Last updated: July 26, 2018

Agents can modify and delete existing time worked entries and create new entries after a
time sheet has been approved.

Before you begin

Role required: wm_agent

About this task

An agent can add, modify, or delete time worked entries for an approved time sheet.
Adding, modifying, or deleting these entries creates new time cards or updates existing time
cards and generates an updated time sheet.

Note:  Do not manually edit time cards. Instead, edit the original time worked
entries, which generates updated time cards and time sheets.

Procedure

1. To modify or delete a time worked entry:
• Navigate to the desired work order task, click the Time Worked related list, and click

the desired entry.
• Navigate to Time Sheets > My Time Worked and click the desired entry.

2. To modify the entry, make changes to the desired fields and click Update.
3. To delete the entry, click Delete.

Review and submit a time sheet

Last updated: July 26, 2018
Last updated: July 26, 2018

Agents can review and submit time sheets to managers for review and approval.

Before you begin

Role required: wm_agent

About this task
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The total hours worked for each category are recorded on the time card and on the time
sheet. From the time sheet, you can see total hours by day and by category.

Procedure

1. Navigate to Time Sheets > My Time Sheets > Current Time Sheet.
2. If desired, review the time cards associated with the time sheet in the Time Cards list.
3. Click Submit Time Sheet.

The time sheet is submitted to the manager for approval. The state of the time sheet
changes from Pending to Submitted and the form becomes read-only.

Review and approve time sheets

Last updated: July 26, 2018
Last updated: July 26, 2018

Managers can review time cards and time sheets for agents in their assignment groups.

Before you begin

Role required: wm_manager

Procedure

1. Navigate to Field Service > Manager > Time Sheets - Pending Approval.
2. Select a time sheet.
3. If necessary, review the time cards associated with this time sheet in the Time Cards

related list.
4. Click one of the following:

Option Description

Approve The state of the time sheet and the associated
time cards changes to Approved and becomes
read-only. Time cards for any work order tasks
that are in the Work in process state are
marked as Processed. Once the work order
task is Complete, the time cards are marked as
Approved.

Reject The state of the time sheet and the associated
time cards changes to Rejected. The field
service agent can make changes to the time
sheet and submit again for approval.

If rate cards are applicable for the time worked, expense lines are generated as part of
the time sheets. Users with the financial_mgmt_user role can view these expense lines.

Field Service Management Flow Designer actions
Last updated: July 26, 2018
Last updated: July 26, 2018

Use Flow Designer actions as building blocks to create Field Service Management business
processes.
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Action Description
Get Work Order Retrieve a work order record using the work

order number. If multiple records are found, only
the first record is returned. 

Create Work Order Create a work order and optionally associate it
with a case. 

Update Work Order Update a work order by providing the work order
reference and the fields to update. 

Get Work Order Task Retrieve a work order task record using the work
order task number. If multiple records are found,
only the first record is returned.

Create Work Order Task Create a work order task and optionally associate
it with a work order. 

Update Work Order Task Update a work order task by providing the work
order task reference and the fields to update.

Add Work Note to Task Add a work note to a task or to task extended
objects (for example, a work order or work order
task).

Related Topics

• Flow Designer

• Actions

Field Service Management mobile interface
Last updated: July 18, 2018
Last updated: July 18, 2018

Use the enhanced agent map and dispatcher map on the mobile user interface.

Several enhancements improve the Field Service Management experience with the mobile
user interface. In addition to push notifications for task assignment, enhancements include
upgrades to the agent map, the dispatch map, and the agent and manager calendars.

For the dispatch map, users access My Dispatch Map in the desktop interface and
Dispatcher Map in the mobile interface. The functionality of these two modules is the same.

• The map centers on the position defined in the user profile.
• Users can turn on and off the Dispatcher Map legend.
• The system stores map filter preferences in the wm_dispatcher_map_filter table.
• The Apply button replaces the Search button.
• If there are more than 99 agents or tasks, 99+ appears in the icon labels.

For the agent map:

• The Assigned to me module replaces the WO tasks assigned to me module.
• The Apply button replaces the Search button.
• The Search button replaces the Save button.

Manager calendar and agent calendar functionality are also available with the mobile user
interface. Agents can create and edit personal events and view tasks. Managers can query
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for team events such as cases, tasks, and personal time-off. Managers can also create and
update time-off events for team members.

• Mobile interface offline support

Field service agents can access read-only task lists and tasks when no internet connection
is available.

Mobile interface offline support

Last updated: July 26, 2018
Last updated: July 26, 2018

Field service agents can access read-only task lists and tasks when no internet connection is
available.

Field service agents sometimes need to work offline at customer locations. The mobile
offline support feature enables agents to download work order tasks ahead of time and
store this task data in a cache on their mobile devices.

Agents can use a data synchronization capability that downloads assigned work order tasks
that have a Scheduled Start date of today and tomorrow. There is no limit on quantity of
tasks that can be downloaded.

When working in offline mode, agents can access My Upcoming Tasks in the mobile
interface and view work order task details. Within a work order task, agents can view related
lists one level deep.

Mobile offline properties

The mobile offline support feature includes these system properties.

Property Description
glide.ui.m.offline.enabled Enables the mobile offline support feature.

• Type: true | false
• Default value: false

glide.ui.m.offline.roles A comma-separated list of roles that can access
mobile offline syncing. Use an empty value to
allow all roles.

• Type: string
• Default value: wm_read

glide.ui.m.offline.cache_ttl Sets the global mobile offline cache time to live,
in minutes.

• Type: integer
• Default value: 2880

glide.ui.m.offline.view_name The default view name to use for lists and forms
when in offline mode on mobile.

• Type: string
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Property Description
• Default value: mobile_offline

Configure mobile offline support

Field Service Management includes two modules for mobile offline support, one for tasks
and one for work orders:

• My Upcoming WO Tasks — Offline Support
• My upcoming WOs — Offline Support

By default, mobile offline support uses the My Upcoming WO Tasks — Offline Support
module. This module includes conditions that must be met for a task to be cached in a
mobile device:

• The task is active.
• The task is assigned to the agent.
• The task Scheduled Start date is between today and tomorrow. The task list is sorted by

the scheduled start day and time.

The mobile offline support module is configured as part of the My Work Area mobile home
page:

1. Navigate to System Mobile UI > Home Page Collections.
2. Click Target Collection.
3. Click Field Service in the Pages related list.
4. Click My Work Area in the Sections related list to open the page form.

The Modules related list includes the My Upcoming WO Tasks — Offline Support module.
This module includes conditions that must be met for a task to be cached in a mobile
device:

Use mobile offline support

To use the mobile offline support feature, agents should synchronize their work order task
data while they have a valid internet connection. The synchronization process stores this
data in a cache on the mobile device.

Note:  The glide.ui.m.offline.enabled property must be enabled for agents to use this
feature.

1. Navigate to User Profile > Offline and press Sync Now. The synchronization process pulls
the tasks assigned to the agent that have a Scheduled Start date of today and
tomorrow.

2. Enable Offline Mode.

Note:  Agents must synchronize at least once and store data in the cache before
switching to offline mode.

3. Navigate to Field Service > My Upcoming Tasks. By default, the task list shows the short
description, task number, and contact information.

4. Select a task and view the task information in read-only mode.
5. When finished, disable Offline Mode.

August 6, 2018 ©2018 ServiceNow. All rights reserved. 588

ServiceNow | Customer Service Management



Push notifications for task assignment
Last updated: July 18, 2018
Last updated: July 18, 2018

Assign tasks and send reminders to customer service agents and field technicians using
push notifications.

Agents and technicians can receive push notifications about tasks on their mobile devices.
Dispatchers and managers can use push notifications to assign tasks to groups or to
individual agents and to send reminders. Agents and technicians can accept or reject tasks
from their mobile devices depending on the configuration.

Push notifications for work order tasks use the ServiceNow Mobile Application push
application. Use this application to send notifications to both individual users and
assignment groups.

Users with the system administrator role can enable and configure push notifications. See
Push notifications for more information.

Push notifications for task assignment

When a dispatcher or manager assigns a task to an individual user:

• The user receives a notification with an Approve or Reject action. Approving the
notification assigns the task to the user. Rejecting the notification unassigns the task and
returns it to the Pending Dispatch state.

• With auto assignment enabled, the user receives a notification about the assigned task
and no further action is required.

Note:  This behavior depends on the setting for the Agent must accept or reject the
assigned task configuration option. If disabled, the agent does not have the
option to reject a task.

When a dispatcher or manager assigns a task to an assignment group, all users in the group
receive a notification with an Approve or Reject action. Agents receive the notification and
can accept or reject the task. When an agent clicks Assign to me, the state of the task
changes to Assigned.

Push notifications as reminders

Notifications can be sent as reminders about upcoming tasks and about SLAs coming due.
These notifications are sent to the agent assigned to the task.

Send notifications as upcoming task reminders. Reminders can be set at 15-minute intervals
up to one hour. These reminders require the
wm_notification.upcoming.task.reminder.minutes.before system property to be set. The
default setting is 45 minutes before the task start time. If the value for this property is not
defined, the agent does not receive reminders.

Send notifications to the assigned agents and agent managers for the following SLAs:

• SLA warning
• SLA breached
• SLA repair complete
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• Push notifications, actions, and messages

Push notifications, actions, and messages for work order task assignments and reminders.

Push notifications, actions, and messages

Last updated: July 18, 2018
Last updated: July 18, 2018

Push notifications, actions, and messages for work order task assignments and reminders.

Push notifications

Adds the following notifications to System Notification > Push > Push Notifications:

• WorkOrderTaskUpcomingReminder: sends a notification to the assigned agent as a
reminder about an upcoming task.

• WorkOrderTaskAcceptanceNotification: sends a notification when a task needs to be
accepted by an agent.

• WorkOrderTaskGrpAssignmentNotification: sends a notification when a dispatcher assigns
a task to an assignment group.

• WorkOrderTaskAutoAcceptanceNotification: when auto assignment is enabled, sends a
notification when a task is auto accepted by an agent.

Push notification actions

Adds the following actions to System Notification > Push > Push Action:

• WO Task-Accept Action
• WO Task-Reject Action
• WO Task-Running Late Action

Push notification messages

Adds the following messages to System Notification > Push > Push Messages:

• WO Task Acceptance Message
• WO Task Auto Acceptance Message
• WO Task Group Assignment Message
• WO Task Upcoming Reminder Message

Turn on notification preferences

Field service agents need to turn on the following notification preferences:

1. Navigate to Self Service > My Notifications.
2. Turn on the work order task notifications:

• WO Task Acceptance Notification
• WO Task Auto Acceptance Notification
• WO Task Group Assignment Notification
• WO Task Upcoming Reminder

3. Ensure that notifications are set to ON on the user profile.
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Request Management
Last updated: July 26, 2018
Last updated: July 26, 2018

Agents regularly access request records as they resolve requests and correspond with the
submitters. They can also access built-in reports to see information like the number of active
or unassigned requests for an SM application.

• Request creation

Requests are created differently based on the role that has been granted to the user.
Department administrators can create requests differently than an employee can.

• Request approvals

Approving a request in an SM application means that the request is ready for task
creation and assignment.

• Agent assignment methods

Depending on your settings in the SM application configuration screen, you can assign
agents manually or using auto-assignment.

• Collaborate on a request

Within a request, you can enter comments that are visible to the submitter, allowing for
collaboration between the two of you. For collaboration with other agents, you can enter
comments that are not visible to the submitter.

• Close a request

When you close a request, you can add details that you want the submitter to be aware
of.

Request creation

Last updated: July 26, 2018
Last updated: July 26, 2018

Requests are created differently based on the role that has been granted to the user.
Department administrators can create requests differently than an employee can.

• Create a request through the catalog

The catalog provides several different categories so users can choose the one that closely
relates to their request.

• Create a request using the request form

The request form allows you to associate a request with a configuration item that is
affected by the request in an SM application.

• Clone a request

To save time, an existing request can be cloned to create a new request.

• Request creation using inbound email actions
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Requests can be automatically created or updated from the information in inbound emails
as long as the functionality has been enabled on the configuration screen of SM
application. The emails are also to be sent to a mailbox defined by criteria in the
appropriate inbound email action.

Create a request through the catalog

Last updated: July 26, 2018
Last updated: July 26, 2018

The catalog provides several different categories so users can choose the one that closely
relates to their request.

1. Navigate to Self-Service > [SM application] Catalog.
2. Choose from the displayed categories.
3. Select a subcategory, if necessary.
4. Fill in the fields on the form.

Note:  Each service management application displays different fields.

Catalog fields
Field Description
Opened for The name of the person submitting this

request. Select a new name if you are opening
this request on behalf of another user.

Location The location for this request.

Priority The priority that describes the importance of
this request.

Short Description A brief summary of the request.

Detailed Description A detailed description of the request.

5. Click Submit.

Note:  If the catalog fields do not appear on the request form, you can configure
the form and add the SM Variable Editor related list.

Create a request using the request form

Last updated: July 26, 2018
Last updated: July 26, 2018

The request form allows you to associate a request with a configuration item that is affected
by the request in an SM application.

About this task

Associating a CI to a request helps your configuration management team understand which
services could be negatively impacted by the request issue. You can also use this form when
you want to include additional comments and work notes for the request.

Procedure

1. Navigate to [SM application] > Requests > Create New.
2. Fill in the fields on the form, as appropriate.
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Request form fields
Field Description
Number An auto-generated number that identifies the

request record.

Company The name of the company from which the
request initiated.

Caller The name of the requester.

Affected CI A CI affected by this request.

Location The location associated with this request. Verify
that the location is correct. If it is not, you can
select another location record.

Template The template for creating this request
(optional). Click the reference lookup icon and
select a template. The request is populated
with all fields in the selected template including
all subtasks and part requirements (if
applicable).

Opened Auto-filled with the date and time the request
was opened.

Priority The priority that describes the importance of
this request. By default, all requests are set to
4-Low.

State The state that describes what work stage this
request is in. By default, all requests are set to
Open.

Assignment group Select the group from which an agent is
assigned to the request. You can select only
assignment groups associated with the service
management application you are using.

Note: If you selected the [SM application name]
will use the dispatch queue option on the
Configuration screen, only users with the
Dispatcher role can edit this field. If you
selected the [SM application name] will not use
the dispatch queue option, all users except
those users with the Basic and Initiator roles
can edit this field.

Assigned to Select the agent to assign the request to. If you
already selected an assignment group, you can
only select agents who belong to that group. If
email notifications are enabled on your
instance, a built-in email notification
automatically sends an email to this user when
you save the request record.

Notes:

• If you selected the [SM application name]
will use the dispatch queue option on the
Configuration screen, only users with the
Dispatcher and Agent roles can edit this
field. If you selected the [SM application
name] will not use the dispatch queue
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Field Description
option, all users except those users with
the Basic and Initiator roles can edit this
field.

• If you selected an assignment group and
want to assign the work to a new user, click
the reference lookup icon next to Assigned
to, click New, and create a new user. Be
aware, however, that you must navigate to
User Administration > Groups and add the
user to the assignment group before the
request can be assigned.

Initiated from Specify the incident or task from which this
request was created.

Billable Select this check box if the request is billable.

Short description [Required] A brief summary of the request.
Optionally, you can click the search knowledge
icon to view articles in the knowledge base
relating to this product model, plan, or CI.
Doing so could provide a solution related to the
reason you are submitting this request.

Description A detailed description of the request. The
description is always visible to the submitter.
Therefore, if you add or modify the description
for a request that another user submitted, the
user is able to see the changes.

Work notes Additional notes that you want to share
between users who can access the request
form. A user who submits the request through
the service catalog cannot see the work notes.

Note:  If you specify an Assignment group and you want to assign the work to a
user who is not already in your user table, click the magnifying glass icon
in the Assigned to field. Then click New and create the user record. Be
aware, however, that the new user is not recognized.

3. Click Submit

Clone a request

Last updated: July 26, 2018
Last updated: July 26, 2018

To save time, an existing request can be cloned to create a new request.

About this task

In the cloning process, the following information is copied from the source task:

• Parent request reference
• Short description
• Description
• Dispatch group
• Assignment group
• Location
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• Planned information (scheduled and estimated, not actuals)
• Required skills

Procedure

Open the task and select Clone Task under Related Links.
New tasks are created in Draft state. The Work Notes field contains the original task number
and text stating that the task is a clone.

Request creation using inbound email actions

Last updated: July 26, 2018
Last updated: July 26, 2018

Requests can be automatically created or updated from the information in inbound emails
as long as the functionality has been enabled on the configuration screen of SM application.
The emails are also to be sent to a mailbox defined by criteria in the appropriate inbound
email action.

After the functionality has been enabled by selecting the Requests can be created and
updated by inbound email option on the application configuration screen, three inbound
email actions are available for the SM applications available in the base system. These
inbound email actions are also available for new applications created using the SM
application creator.

• Create a request from an inbound email

Requests can be automatically created from the information in inbound emails as long the
functionality has been enabled on the configuration screen of SM application. The emails
are also to be sent to a mailbox defined by criteria in the appropriate inbound email
action.

• Create a request from a forwarded inbound email

Requests can be automatically created from the information in forwarded inbound emails
as long the functionality has been enabled on the configuration screen of SM application.
The emails are also to be sent to a mailbox defined by criteria in the appropriate inbound
email action.

• Update a request from an inbound email

Requests can be automatically updated from the information in inbound email replies as
long the functionality has been enabled on the SM application's configuration screen. The
emails must also be sent to a mailbox defined by criteria in the appropriate inbound email
action.

Related Topics

• Email and SMS notifications

• Inbound email actions

Last updated: July 26, 2018
Last updated: July 26, 2018

Requests can be automatically created from the information in inbound emails as long the
functionality has been enabled on the configuration screen of SM application. The emails are
also to be sent to a mailbox defined by criteria in the appropriate inbound email action.
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1. Navigate to System Policy > Email > Inbound Actions.
2. Select the inbound email action called Create [application name] Request.

The inbound email action record opens and displays the default conditions that trigger
the inbound email action.

When an email is sent to the mail list defined by the criteria in Actions, a request is
created with the following information:

• The Contact type is set to Email.
• The email sender (if found) populates the opened_by and Caller fields for a newly

created sm_order based item.
• The email subject populates the Short description field.
• The email body populates the Description field.
• The email senders company (Sender->Company) populates the Company field.
• The email senders location (Sender->Location) populates the Location field.
• The entire email is copied into the Work notes field.

3. You can use the email action as it is or modify it to meet the needs of your organization.

Last updated: July 26, 2018
Last updated: July 26, 2018

Requests can be automatically created from the information in forwarded inbound emails as
long the functionality has been enabled on the configuration screen of SM application. The
emails are also to be sent to a mailbox defined by criteria in the appropriate inbound email
action.

1. Navigate to System Policy > Email > Inbound Actions.
2. Select the inbound email action called Create [application name] Request (Forwarded).

The forwarded inbound email action record opens and displays the default conditions
that trigger the inbound email action.

When an email is forwarded to the mail list defined by the criteria in Action, a request is
created with the following information:

• The Contact type is set to Email.
• The email sender (if found) populates the opened_by and Caller fields for a newly

created sm_order based item.
• The email subject populates the Short description field.
• The email body populates the Description field.
• The email senders company (Sender->Company) populates the Company field.
• The email senders location (Sender->Location) populates the Location field.
• The entire email is copied into the Work notes field.

3. You can use the email action as it is or modify it to meet the needs of your organization.

Last updated: July 26, 2018
Last updated: July 26, 2018

Requests can be automatically updated from the information in inbound email replies as
long the functionality has been enabled on the SM application's configuration screen. The
emails must also be sent to a mailbox defined by criteria in the appropriate inbound email
action.

1. Navigate to System Policy > Email > Inbound Actions.
2. Navigate to the inbound email action called Update [application name] Request and

click its Name.
The update inbound email action record opens and displays the default conditions that
trigger the inbound email action.
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When an email reply is received in the mail list defined by the criteria in the email action,
the associated request is opened and update information is added to the Work notes
field.

3. You can use the email action as is or modify it to meet the needs of your organization.

Request approvals

Last updated: July 26, 2018
Last updated: July 26, 2018

Approving a request in an SM application means that the request is ready for task creation
and assignment.

When a request is sent to a user with the [SM application]_approver_user role, the approver
has several choices. If you select Approval is required for new requests in the applications
Configuration screen, a newly created request automatically moves to the Awaiting Approval
state. Otherwise, the request moves to the next configured state.

Request approval states
Approval Choice Description
Approved The request is approved.

Rejected The request is not qualified and it is moved to the
canceled state. Also, the following work note is
added to the request:

The [SM application] request is rejected.

More information required The request does not contain enough
information. It reverts to the Draft state and the
following work note is added to the request:

The [SM application] request needs more
information for further approval.

Duplicate The request is no longer required, because
another request has already performed the work.
The request is moved to the Cancelled state and
the following work note is added to the request:

This is a duplicate [SM application] request.

Agent assignment methods

Last updated: July 26, 2018
Last updated: July 26, 2018

Depending on your settings in the SM application configuration screen, you can assign
agents manually or using auto-assignment.

If you have a limited number of agents for completing requests or you simply do not want to
auto-assign agents, you can use manual assignment.

Auto-assignment enables you to define criteria by which agents can be automatically
selected to satisfy requests entered in service management applications. Based on the
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needs of your organization, you can configure the criteria for agent auto-assignment in the
following ways.

When auto-assignment is enabled and a task is qualified or marked as Ready for Work, the
following actions occur:

• Available agents are evaluated based on the criteria defined in the configuration.
• An appropriate agent is automatically assigned to the task.
• The task is moved to the Assigned state.

If the configuration is set up to consider more than one set of criteria, such as location and
skills, the agents are evaluated based on the weighting property settings in addition to other
criteria.

If the task cannot be auto-assigned, a user with the dispatcher role must adjust the values in
the request or task form and then save the record.

• Manually assign agents to active requests

Use this procedure to assign agents to active requests in service management (SM)
applications.

• Agent auto assignment using rating-based criteria

Rating-based methods, such as location, skills, and time zones, help to auto assign agents
based on configuration settings and optional properties. The calculated ratings are used
to determine the best agent to perform the task.

• Agent auto assignment using time-based criteria

Time-based methods, such as schedules and priority assignment, help you auto assign
agents based on configuration settings and optional properties. The calculated ratings are
used to determine the best agent to perform the task.

• Agent auto assignment using multiple selection criteria

At its simplest, auto assignment involves identifying a set of selection criteria and
automatically assigning the task to the agent who most closely meets the criteria. You
can, however, select multiple sets of criteria, including both rating-based and time-based
criteria.

Manually assign agents to active requests

Last updated: July 26, 2018
Last updated: July 26, 2018

Use this procedure to assign agents to active requests in service management (SM)
applications.

1. Navigate to one of the following modules:
• SM application] > Open - Unassigned for a list of requests that no one is assigned to.
• [SM application] > All [SM application] Requests for a list of all open requests,

regardless of their current assignment.
2. Open the request you want to assign.
3. In the Assignment group field, enter the group that handles this kind of request. If no

groups are available, leave this field blank.
To look up the assignment group, click the reference lookup icon ( ) beside the
Assignment group field.
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Note:  You do not have to select an assignment group, but doing so limits the
users you can assign the request to.

4. In the Assigned to field, enter the agent to handle this request.
To look up an agent, click the reference lookup icon ( ) beside the Assigned to field.

Note:  If one was selected, the users in the search results are limited to the users
in the Assignment group.

5. Click Update.
An email notification is automatically sent to the assigned agent when email
notifications are set up for the instance.

Agent auto assignment using rating-based criteria

Last updated: July 26, 2018
Last updated: July 26, 2018

Rating-based methods, such as location, skills, and time zones, help to auto assign agents
based on configuration settings and optional properties. The calculated ratings are used to
determine the best agent to perform the task.

Any combination of rating-based methods can be enabled in configuration screen of the
application.

When a task is created, a rating for each type of enabled selection criteria is calculated for
each available agent. The agent whose average rating is highest is considered for auto-
assignment. The settings for the auto-assignment weighting properties, found in [SM
application] > Administration > Properties, are included in the rating calculations.

These values help you prioritize which auto-assignment selection criteria is more important
to your organization. The priority values should be [1, 10] and they are factored between 1
and 0. That is, 10 is a factor of 1, 5 is a factor of 0.5, and so on. For an example of how the
weighting properties affect agent ratings, see Agent auto assignment using multiple
selection criteria.

• Agent auto assignment using location

Agents can be auto assigned based on the location defined in their user record and the
location of the tasks.

• Agent auto assignment using skills

Agents can be auto assigned based on the skills of an agent, and the skills required to
perform the task. Assign skills to an agent user records using Skills > Users.

• Agent auto assignment using time zones

Agents can be auto assigned based on the time zone defined in their user records and the
time zone of the tasks.

Last updated: July 26, 2018
Last updated: July 26, 2018

Agents can be auto assigned based on the location defined in their user record and the
location of the tasks.
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Auto assignment by location can be performed in a task- or request-driven processing
environment when the Auto-selection of agents will consider location of agents
configuration is enabled.

When a task is created, agent locations are compared to the following ranges to determine a
location rating for each agent.

Location rating calculation
Distance (mi.) from agent to task Rating
0–0.1 1

0.11–0.5 0.9

0.51–5 0.7

5.1–10 0.5

10.1–20 0.4

20.1–30 0.3

30.1–40 0.2

40.1–100 0.1

>100 0

When a task is qualified or marked as Ready for Work, the agent closest to the task location
is considered for the task. If the application is configured so that only location is considered,
the closest agent is auto-assigned to the task.

If the application is configured to use other selection criteria—such as skills, time zone, or
schedule—the ratings of all selection criteria are averaged, and the agent with the highest
overall rating is auto-assigned for the task. See Agent auto assignment using multiple
selection criteria for details.

Last updated: July 26, 2018
Last updated: July 26, 2018

Agents can be auto assigned based on the skills of an agent, and the skills required to
perform the task. Assign skills to an agent user records using Skills > Users.

Auto assignment by skills can be performed in either a task- or request-driven processing
environment when the Auto-selection of agents for tasks requires them to have skills
configuration option must be set to all or some for the application.

When a task that includes skills is qualified or marked as Ready for Work, skills of each agent
are compared with the skills required to perform the task, and a rating is calculated based
on the skills configuration option. If the option is set to some, the agent with the closest
skills match is auto-assigned the task. If the option is set to all, only agents who possess all
the required skills are considered. If no agents possess all the skills required to perform the
task, none are auto-assigned.

Skills rating of an agent is calculated as:

Skills_agent/Skills_task

When:

• Skills_agent is the number of skills possessed by the agent that match the skills required
for the task.
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• Skills_task is the total number of skills required for the task.

For example, if a task requires four skills, and Agent A possesses three of them and Agent B
possesses two of them:

• Skill rating of Agent A = 3/4 or 0.75
• Skill rating of Agent B = 2/4 or 0.5

If the application is configured to use other selection criteria, such as location or time zone,
the ratings of all selection criteria are averaged, and the agent with the highest overall rating
is auto-selected for the task. See Agent auto assignment using multiple selection criteria for
details.

Last updated: July 26, 2018
Last updated: July 26, 2018

Agents can be auto assigned based on the time zone defined in their user records and the
time zone of the tasks.

Auto assignment by time zone can be performed in either a task- or request-driven
processing environment when the Auto-selection of agents will consider time zone for the
task configuration option must be enabled for the application.

When a task is qualified or marked as Ready for Work, agents in the time zone closest to the
task time zone are considered for the task. If the application is configured so that only time
zone is considered, an agent in the same time zone is auto-assigned the task.

Note:  It is important that the time zones for the agent and the task are set
correctly.

When a task is created, agents are rated based on the time zones of both task and agent
using the following formula:

1 - [abs(Task_tz – Agent_tz) ÷ 12]

Where:

• abs is the mathematical function to compute the absolute value.
• Task_tz is the offset between the time zone of the task and GMT.
• Agent_tz is the offset between the time zone of the agent and GMT.

For example, a task is created in New York City (GMT-4), and two agents are available to
perform the task, one in Los Angeles (GMT-7) and one in Paris, France (GMT+1).

The rating of the agent in Los Angeles is calculated as:

1 - abs((-4) - (-7)) ÷ 12 or 0.75

The rating of the agent in Paris is calculated as:

1 - abs((-4) - (+1)) ÷ 12 or 0.58

So if the auto assignment of the task is based on the time zone alone, it is assigned to the
agent from Los Angeles.

If the application is configured to use other selection criteria, such as skills or location, the
ratings of all selection criteria are averaged, and the agent with the highest overall rating is
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auto-selected for the task. See Agent auto assignment using multiple selection criteria for
details.

Agent auto assignment using time-based criteria

Last updated: July 26, 2018
Last updated: July 26, 2018

Time-based methods, such as schedules and priority assignment, help you auto assign
agents based on configuration settings and optional properties. The calculated ratings are
used to determine the best agent to perform the task.

Any combination of time-based methods can be enabled in the application configuration
screen.

When a task is created, the schedule of the agent and the task to be performed are
combined with rating-based criteria to auto-assign an agent.

• Agent auto assignment using schedules

Agents can be auto assigned based on the agent or the task schedule.

• Agent auto assignment using priority assignment

The priority assignment feature enables you to configure auto assignment so that agents
can be assigned to perform tasks or provide services on a continual, 24x7x365 basis.
Priority assignment is triggered when the priority of a task matches the priority set in the
application configuration page.

Last updated: July 26, 2018
Last updated: July 26, 2018

Agents can be auto assigned based on the agent or the task schedule.

Auto assignment by schedule can be performed only in a task-driven processing
environment, and the Auto-selection of agents will consider agent or task schedules
configuration option must be enabled for the application. If this option is turned off, only the
agent ratings are used for auto-assignment.

When a task is qualified or marked as Ready for Work, agents ratings are evaluated, and the
schedules of qualified agents are compared against the schedule of the task to determine
the agent with the best matching schedule.

Note:  If the task includes specific time entries in the Window start and Window end
fields, and no schedule of an agent falls within that task window, no agents
are assigned. Also if the customer wants a task to be performed at or near a
specific time, the Window start time should be set as close to that time as
possible. For example, the Window start and Window end fields are set to
1:00 pm and 8:00 pm respectively. The customer prefers the job to be started
at 4:00 pm. It is possible that an agent is dispatched at 13:00. So, setting the
Window start closer to 4:00 can help ensure that the work is performed
when the customer prefers it to be done.

If the application is configured to use other selection criteria, such as skills or time zone, the
ratings of all selection criteria are averaged, and the agent with the highest overall rating is
auto-selected for the task. See Agent auto assignment using multiple selection criteria for
details.
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Last updated: July 26, 2018
Last updated: July 26, 2018

The priority assignment feature enables you to configure auto assignment so that agents
can be assigned to perform tasks or provide services on a continual, 24x7x365 basis. Priority
assignment is triggered when the priority of a task matches the priority set in the
application configuration page.

Priority assignment can be used with location and skills settings. However, it can also
operate independently.

To use priority assignment, you must set the following configuration options for the
application.

Priority auto-assignment configuration options
Field Description
Process life cycle Set to task driven (subtasks are required).

Assignment method for tasks Set to auto-assignment.

Auto-selection of agents considers agent or task
schedules

Enabled.

Enable priority assignment Enabled.

Select priorities for assignment Select one or more priorities.

Only tasks of the selected priority or priorities trigger auto-assignment based on priority
assignment.

When a task is qualified or marked as Ready for Work, and the priority of the task matches a
priority selected for the application, the agent that best matches the schedule of the task is
auto-assigned. If the location and skills options are enabled, agents are first evaluated on
their physical proximity to the location of the task, and then on how their skills match the
skills required to perform the task. The agent whose location, availability, and skills best
match the requirements of the task is auto-assigned.

When a task has a priority that matches a priority in the priority assignment list, the
Location Rating and Timezone Rating are ignored, even if they have been enabled.

If the priority of a task matches a priority selected in the Select priorities for assignment
option, and no agents in the assignment group are available to be auto-assigned, the task is
assigned to the group manager, regardless of whether the manager is available. It is the
responsibility of the manager to locate an agent to perform the task.

Note:  If no agent is located in the same time zone as the task, priority assignment
fails.

Agent auto assignment using multiple selection criteria

Last updated: July 26, 2018
Last updated: July 26, 2018

At its simplest, auto assignment involves identifying a set of selection criteria and
automatically assigning the task to the agent who most closely meets the criteria. You can,
however, select multiple sets of criteria, including both rating-based and time-based criteria.
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When a task is qualified or marked as Ready for Work, the following evaluations are
performed:

1. The ratings of an agent are calculated. If the Auto-selection of agents will consider agent
or task schedules configuration option is disabled for the application, the ratings of an
agent are used exclusively for auto-assigning an agent.

For more information on how the ratings are calculated, see:

• Agent auto assignment using location
• Agent auto assignment using skills
• Agent auto assignment using time zones

2. If the Auto-selection of agents will consider agent or task schedules configuration
option is enabled, the schedules of the agents whose ratings are acceptable for auto-
assignment are compared to the schedule for the task, and the agent with the best
match is auto-assigned. For more information on time-based methods for auto-
assigning agents, see:

• Agent auto assignment using schedules
• Agent auto assignment using priority assignment

Auto assignment is based on the following calculation:

(Criteria_1 rating x Criteria_1 weight) + (Criteria_2 rating x Criteria_2
weight) + (Criteria_3 rating x Criteria_3 weight) / Number of criteria
types used

Where:

• Number of criteria types used = 1, 2, or 3 depending on the location, skill, and time zone
settings used.

This example calculates agent auto-assignment based on location and skills. The example is
based on the following assumptions.

• The Auto-selection of agents will consider location of agents configuration option is
enabled for the application.

• The Auto-selection of agents requires them to have some of the required skills for the task
configuration option is enabled for the application.

• The Skills Weight property is set to 10 for the application.
• The Location Weight property is set to 5 for the application.
• Agents A and B are available to perform a task, and the task requires four specific skills.
• The location of Agent A is 5 miles from the site of the task. Agent A possesses three of the

four required skills.
• The location of Agent B is one-quarter mile from the site. Agent B possesses two of the

required skills.

Auto assignment for the agents uses this calculation:

[(Location rating x Location weight) + (Skills rating x Skills weight)]/ 2

• The auto assignment calculation for Agent A is: [(0.7 x 0.5) + (0.75 x 1)]/ 2 =
0.55

• The auto assignment calculation for Agent B is: [(0.9 x 0.5) + (0.5 x 1)]/ 2 =
0.475

In this example, Agent A is auto assigned the task.
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Collaborate on a request

Last updated: July 26, 2018
Last updated: July 26, 2018

Within a request, you can enter comments that are visible to the submitter, allowing for
collaboration between the two of you. For collaboration with other agents, you can enter
comments that are not visible to the submitter.

1. Navigate to [SM application] > All [SM application] Requests.
2. Open the request you want to collaborate on.
3. In the Additional comments (Customer visible) field, enter the comments that you want

the person who submitted the request to see. The submitter can see the comments in
this field and add more comments as necessary. Update this field as many times as
necessary to correspond with the submitter.

4. To correspond with other agents, enter content that you do not want the submitter to
see in the Work notes field.

Close a request

Last updated: July 26, 2018
Last updated: July 26, 2018

When you close a request, you can add details that you want the submitter to be aware of.

1. Navigate to [SM application] > Assigned to me.
2. Click the request number.
3. In the Additional comments field, enter any final notes or comments.
4. Change the State field to the appropriate closed state.
5. Click Update.

• Closed and completed requests

When the Request lifecycle option is set to request-driven, the assigned agent can
complete and close the request once all the tasks in the request are complete.

• Close an SM request as spam

Mark any open request as spam; that is, the request has no value and should be closed.

Closed and completed requests

Last updated: July 26, 2018
Last updated: July 26, 2018

When the Request lifecycle option is set to request-driven, the assigned agent can complete
and close the request once all the tasks in the request are complete.

A Close Complete button is visible to the agent assigned to the request. The agent enters
work notes before clicking Close Complete. When the button is clicked, the open task is
automatically completed (if applicable) and the request transitions to the Complete state.

Close an SM request as spam

Last updated: July 26, 2018
Last updated: July 26, 2018

Mark any open request as spam; that is, the request has no value and should be closed.
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Before you begin

Role required: admin

Procedure

1. In the SM application, open the request you want to mark as spam.
2. In the header bar, click Spam.

The state of the request is changed to Closed and the Work notes indicate that the
request was closed as spam.

If the State flows are enabled option on the configuration screen is not selected, the
state is not changed, but the Work notes indicate that the request was closed as spam.

Territory management
Last updated: July 26, 2018
Last updated: July 26, 2018

Territory management determines, by geographical location, the individual or group best
positioned to execute a service call.

Territory management allows the assignment of a set of geographical locations to an
individual or group. This assignment creates a territory. Territory management is based on a
hierarchy where all locations are attached to a parent location. Top-level locations do not
have a parent location. Territory Management is activated automatically with Field Service
Management.

• Assign a location to a user

Territory management allows field service management administrators to assign locations
to users.

• Assign a location to a group

Territory management allows field service management administrators to assign locations
to groups of users.

Assign a location to a user

Last updated: July 26, 2018
Last updated: July 26, 2018

Territory management allows field service management administrators to assign locations to
users.

About this task

This creates a territory, or set of locations covered by a given user. The association helps the
system to determine which users can fix problems in particular locations.

Procedure

1. Navigate to Territories > Users.
2. Open a user record.
3. In the Locations Covered related list:

• Click Edit to add an existing location to the user.
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• Click New to create a new location to associate to the user.
Territory management at the user level is not used for automations.

Assign a location to a group

Last updated: July 26, 2018
Last updated: July 26, 2018

Territory management allows field service management administrators to assign locations to
groups of users.

About this task

This creates a territory, or set of locations covered by a given group. The association helps
the system to determine which groups can fix problems in particular locations.

Procedure

1. Navigate to Territories > Groups.
2. Open a group record.
3. In the Locations Covered related list:

• Click Edit to add an existing location to the group.
• Click New to create a new location to associate to the group.

Note:  To determine which group covers a given location, the system checks the
location hierarchy to see if there are any groups assigned to the location.
If not, the system checks the upper level of hierarchy.

Request task management
Last updated: July 26, 2018
Last updated: July 26, 2018

A request contains one or more tasks. These tasks allow qualifiers to define activities that
must be done to complete a request.

Administrators can create multiple tasks under a single request.

Splitting a request into separate tasks, when necessary, enables qualifiers to:

• Assign different aspects of a request to different staff members.
• Assign tasks to staff members who have different set of skills or are in different locations.
• Schedule tasks so they are either done one after another, or at the same time by different

staff members.
• Schedule additional tasks, if necessary, to complete the request.

Note:  If you have the Request life cycle is request driven configuration option
activated, you can manually add tasks as needed. If you have Request life
cycle is task driven activated, an initial task is automatically created when the
request record is created.

• Create request tasks

Tasks are created in support of requests.

• Task windows
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A task window is the time period, bordered by start and end times, in which a task is
performed.

• Use a task template for multiple request templates

If you have tasks that are often repeated across multiple jobs, you can create a task
template and reuse it in multiple request templates. You can also use it on a Facilities
request to pull common and repeatable information into a request.

• Clone a request task

Existing tasks can be cloned to create tasks with the same populated fields.

Related Tasks

• Collaborate on a request

• Change the location of a request

• Close a request

Related Concepts

• Task vs request driven processing

• Request approvals

Create request tasks

Last updated: July 26, 2018
Last updated: July 26, 2018

Tasks are created in support of requests.

Before you begin

Role required: [SM application]_admin or [SM application]_qualifier

Procedure

1. Navigate to [SM Application] > Requests > All [SM Application] Requests.
2. Open the request for which you want to create tasks.
3. Click the Add Task related link.

The Task screen for the SM application opens.
4. Fill in the fields on the form.

Note:  Not all fields display for all SM applications.

Request task fields
Field Description
Number Auto-generated identification number for the

task.

Parent Request that this task is associated with.

Cloned from Record number of the task this task was cloned
from, if any.
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Field Description
Location Geographical area where the work must be

done. The location is critical for determining
the staff member who is assigned to the task.

Template Template for creating this request (optional).
Click the lookup icon and select a template. The
description of the selected template populates
the Description field.

Skills Abilities necessary to execute the task. This
field is automatically completed based on the
selection in the Affected CI field on the
associated request. If you change the affected
CI on the request, the system adds any skills
required by the new CI to the skills already
listed here.

State Current state of the task, such as Accepted or
Closed Complete. The ServiceNow advances
the state automatically as users complete the
work for each successive state.

Assignment group Group from which an individual legal staff
member is selected to complete the task. The
lookup list shows only the assignment groups
associated with the selected Location. If the
Assignment Group field is empty, the system
searches for the group covering the territory
that includes the location of the task.

Assigned to Individual staff members who should complete
the task, selected from the Assignment group.
If you defined skills and assigned them to staff
members, the Assigned to field lookup list
shows only those staff members in the
assignment group who have all the Skills
required. If no exact match of skills is found, the
lookup list shows all assignment group
members.

Note:  If state flows are disabled, this
field is not mandatory.

Short description Brief explanation of the task.

Description Exact technical description of the unit of work
to be performed. Qualifiers should provide as
much detail about the problem as possible to
avoid extra communication with the caller in
later stages of the request.

Work notes Information about the task as it progresses
through each state. Work notes are not visible
to customers.

Scheduling - These fields display for Finance Service Management and Marketing Service
Management.

Scheduled start Date and time when the earliest task is
scheduled to start.

Note:  If state flows are disabled, this
field is not mandatory.
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Field Description
Estimated end Estimated work end date. The estimated date

when the latest task is completed.

Actual work start Date and time when the earliest task actually
started.

Actual work end Date and time when the latest task ended.

Requested due by Estimated date when the latest task is
completed.

Note:  The workflow appears at the top of the form, with the completed states
shown in green.

Task windows

Last updated: July 26, 2018
Last updated: July 26, 2018

A task window is the time period, bordered by start and end times, in which a task is
performed.

Task windows can be flexible or fixed and are used by the auto-routing and auto-dispatch
features when determining the daily schedule of staff members. A flexible window has start
and end times that the application attempts to respect when dispatching or routing a task
automatically. The system can reschedule a flexible task window if necessary, to make it fit
into the schedule of a staff member. A fixed task window cannot be rescheduled. If the auto-
router or auto-dispatcher cannot schedule the task for the fixed window time period, that
task is not scheduled at all. The time interval configured for a window cannot be less than
the time required to perform the task.

Use a task template for multiple request templates

Last updated: July 26, 2018
Last updated: July 26, 2018

If you have tasks that are often repeated across multiple jobs, you can create a task template
and reuse it in multiple request templates. You can also use it on a Facilities request to pull
common and repeatable information into a request.

Before you begin

Role required: facilities_admin

Create a request template and an associated task template that contains the information
you want to reuse.

Note:  Checklist templates are a way to populate a checklist of tasks to be
completed. Checklist templates are created on a Facilities request or on a
Facilities task. After being created, they can be saved as a template and be
reused. See Create a request with the facilities request form.

When you create subsequent request templates, you can select the task template from the
Task Template field and save the file.

Procedure
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1. Navigate to Facilities > Catalog & Knowledges > Facilities Request Templates.

Field Description

Name A descriptive name for the Facilities Request
Template.

Short description A short description of the template.

Description A detailed description of the template.

Checklist template A Checklist template saved from the Facilities
Request Form.

2. Under Task information, create a task template.
3. Click Copy Task Template to use a previously created template. Information pre-fills the

fields.

Field Description

Task type The type of task being requested. Select:
• Facilities Request Task
• Move Task

Name Descriptive name of the task.

Description Detailed description of the task.

Depends on Indicates if the task depends on another task.
For example, if you have two tasks, you can
make task 2 dependent on task 1 completing
before task 2 can start.
After a task and task type are defined, you can
select it in the next task in the Depends on
choice list.

Checklist template A Checklist template saved from the Facilities
Request Form.

Assignment group The group assigned to the task.

Skills The skills required to be assigned to the
request.

Estimated work duration An estimation of the number of days, hours, or
minutes to complete the request.

4. Click Submit or Save.

Clone a request task

Last updated: July 26, 2018
Last updated: July 26, 2018

Existing tasks can be cloned to create tasks with the same populated fields.

Before you begin

Role required: admin, ITIL, creator, or catalog admin

About this task
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In the cloning process, the following information is copied from the source task:

• Parent request reference
• Short description
• Description
• Assignment group
• Location
• Required skills

Procedure

Open the request task and select Clone Task under Related Links.
The application creates a task in Draft state. The Work Notes field contains the original task
number and text stating that the task is a clone.

Performance Analytics reports
Last updated: July 26, 2018
Last updated: July 26, 2018

Performance Analytics reports are available for the Field Service Management application
with the activation of the Performance Analytics - Content Pack - Field Service Management
plugin (com.snc.work_management_pa).

Activating this plugin adds the Performance Analytics option to the Field Service menu.
Click this option to view the Field Service Performance Analytics homepage, which includes
the following reports:

• Percent productive agent time for work order tasks
• Percent utilization of agents for work order task
• Percent actual duration to planned duration for work order tasks
• Average closing time for work orders
• Number of new work orders
• Number of open work orders
• Number of closed work orders

Note:  If you have Performance Analytics installed, the Field Service Management
Performance Analytics plugin (com.snc.work_management_pa) is
automatically activated as part of the Field Service Management plugin.

Related Tasks

• Activate Field Service Management

Related Concepts

• Performance Analytics concepts

Out-of-the-box Field Service Management Performance Analytics
Solutions

Last updated: July 26, 2018
Last updated: July 26, 2018
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Performance Analytics Solutions contain preconfigured best practice dashboards. These
dashboards contain actionable data visualizations that help you improve your business
processes and practices.

Note:  To evaluate the functionality, you can activate Performance Analytics
solutions and in-form analytics on instances that have not licensed
Performance Analytics. However, you have the following limitations:

• You cannot create new indicators.
• You cannot collect data older than 180 days.

For full functionality, license Performance Analytics. For more information,
see Get licensed Performance Analytics.

Performance Analytics Solutions

Use the Performance Analytics widgets on the dashboard to visualize data over time,
analyze your business processes, and identify areas of improvement. With solutions, you can
get value from Performance Analytics for your application with minimal setup.

Note:  Solutions include some dashboards that are inactive by default. You can
activate these dashboards to make them visible to end users according to
your business needs.

To enable the solution plugin for Field Service Management, an admin can navigate to
System Definitions > Plugins and activate the Performance Analytics - Content Pack - Field
Service Management plugin.

Related Topics

• Available solutions

• Solutions and in-form analytics

• Performance Analytics

Components installed with Field Service Management
Last updated: July 26, 2018
Last updated: July 26, 2018

Several types of components are installed with Field Service Management.

Demo data for the Field Service Management application is a separate plugin. The Field
Service Management Demo Data plugin (com.snc.work_management.demo) provides
sample qualifiers, dispatchers, agents, work orders, work order tasks, stockrooms, and asset
information.

Tables installed with Field Service Management

Tables are added with Field Service Management.
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Table Description
Work Order
[wm_order]

Stores work order records.

Work Order Flow
[sf_work_order]

Stores the work order state flow records.

Work Order Model
[cmdb_workorder_product_model]

Stores the Product Catalog work order model
records. This table was modified by the Field
Service Management plugin. This table is
renamed and part of Service Order Management.

Work Order Task
[wm_task]

Unit of work performed by one person, in one
session (one location and one time).

Work Task Flow
[sf_work_task]

Stores the work task state flow records.

Work Task Model
[cmdb_servicetask_product_model]

Stores the Product Catalog work task model
records. This table was modified by the Field
Service Management plugin. This table is
renamed and part of Service Order Management.

WM Map Filters Config
[wm_map_filters_config]

Stores filter configurations for the agent map on
the mobile UI.

Questionnaire
[wm_questionnaire]

Stores questionnaires created for work orders
and work order tasks.

Properties installed with Field Service Management

Properties are added with Field Service Management.

Properties for Field Service Management
Property Description
glide.ui.wm_order_activity.fields Determines which fields are tracked in the

activities list for work orders. The system
automatically synchronizes the values in this
property and the selections made by
personalizing activities.

• Type: String
• Default value: opened_by,work_notes
• Location: System Properties [sys_properties]

table

glide.ui.wm_task_activity.fields Determines which fields are tracked in the
activities list for work order tasks. The system
automatically synchronizes the values in this
property and the selections made by
personalizing activities.

• Type: String
• Default value: work_notes,assigned_to
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Property Description
• Location: System Properties [sys_properties]

table

work.management.default.end.time Default end time for all work agents when no
schedule is set, formatted in a 24 hour clock.

• Type: String
• Default value: 17:00
• Location: Field Service > Administration >

Properties

work.management.default.start.time Default start time for all work agents when no
schedule is set. This value sets the start time for a
day other than the current day, when no
scheduled task exists or is continued from the
previous day. This property uses a 24 hour clock.

• Type: String
• Default value: 08:00
• Location: Field Service > Administration >

Properties

work.management.limit.location Field Service Management should limit the
dispatch groups available to choose by the
location of the task. By default, the list of
available dispatch groups is filtered by their
proximity to the work order task location. When
this property is set to false, the system displays all
dispatch groups for selection, without any
consideration of location. If only one dispatch
group is available for a work order task in any
location, that group is automatically entered in
the Dispatch group field.

• Type: true/false
• Default value: true
• Location: Field Service > Administration >

Properties > Dispatch Properties for Field
Service

work.management.max.agents.processed Sets the maximum number of agents that will be
processed by auto-dispatch at a time. The system
has an absolute limit of 300 agents and sets the
value at that level if you specify more than 300.
The system cannot auto-dispatch a task for a
dispatch group that contains more agents than
the value configured.

• Type: Integer
• Default value: 100
• Location: Field Service > Administration >

Properties

work.management.work.spacing Amount of time (in minutes) to add between the
end of a task and the travel start of the next. An
example of a valid time value is 10.

• Type: Integer
• Default value: 0
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Property Description
• Location: Field Service > Administration >

Properties

com.snc.wm.wo.task_window_days Default days for a window of a task.

• Type: Integer
• Default value: 14
• Location: Field Service > Administration >

Properties

work.management.use.mandatory.skills Enables the mandatory skills feature and
indicates that the Task Skills [task_m2m_skill]
table is being used for work orders and work
order tasks.

• Type: true/false
• Default value: false
• Location: System Properties list

skills_management.migration Lists the task tables to migrate to the Task Skills
[task_m2m_skill] table when an admin runs the
Migrate Skills to Task Skill M2M script.

• Type: choice list
• Default value:

wm_task,customerservice_case,wm_order
• Location: System Property [sys_properties]

table

com.snc.skills_management.task_skill_migrated_tablesContains a list of tables for which the Skills field
has already been migrated to the Task Skills
[task_m2m_skill] table. If the table name is listed
in this property, the data has been migrated and
will not be migrated again.

• Type: choice list
• Default value: none
• Location: System Property [sys_properties]

table

Geolocation properties

Field Service Management adds the following geolocation properties.

Geolocation properties for Field Service Management
Property Description
glide.geolocation.map.merge.task.agent.markers Merge the task and agent markers on the

geolocation maps with a new purple marker.
When this property is true, agent and task
markers that are close together are merged into a
purple cluster that displays the count of both
marker types. The pop-up information window for
the purple marker displays the items for all agents
and tasks. If this property is false, agents and
tasks will only be gathered into their own clusters
and not into the single, purple cluster.
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Property Description
• Type: true/false
• Default value: false
• Location: Field Service > Administration >

Properties

work.management.allow.toll.roads Allow toll roads to be used. Allows the system to
use toll roads when auto-routing an agent's tasks.

• Type: True/false
• Default value: True
• Location: Field Service > Administration >

Properties

work.management.autodispatch.geolocation Geolocation should be used to update estimated
travel time using the Google Maps API.

• Type: true/false
• Default value: true
• Location: Field Service > Administration >

Properties > Dispatch Properties for Field
Service Management

Note:  To use the Google Maps API with
dynamic scheduling, you must
also enable the Use Google for
travel time and traffic data check
box on the Dynamic Scheduling
Configuration form.

work.management.evening.rush.hours Evening rush hour span, formatted as 14:30-16:00.
This property uses a 24 hour clock. All times are
expressed as a range, separated by a dash with
no spaces. Times not using this format are
ignored. This property must be used with the
work.management.morning.rush.hours and
work.management.rush.travel.buffer properties.

• Type: String
• Default: 0
• Location: Field Service > Administration >

Properties

work.management.morning.rush.hours Morning rush hour span, formatted as
06:30-08:00. This property uses a 24 hour clock.
All times are expressed as a range, separated by a
dash with no spaces. Times not using this format
are ignored. This property must be used with the
work.management.evening.rush.hours and
work.management.rush.travel.buffer properties.

• Type: String
• Default: 0
• Location: Field Service > Administration >

Properties

work.management.rush.travel.buffer Percentage to add to all rush hour travel times.
The system uses this percentage to calculate
schedules when auto-routing an agent. Use this
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Property Description
property when both morning and evening rush
hour times are defined. An example of a valid
time buffer percentage is 15.

• Type: Integer
• Default value: 0
• Location: Field Service > Administration >

Properties

work.management.travel.buffer Percentage to add to all travel times. An example
of a valid percentage value is 15.

• Type: Integer
• Default value: 0
• Location: Field Service > Administration >

Properties

Roles installed with Field Service Management

Roles are added with Field Service Management.

Role title [name] Description Contains Roles
Field Service Management
Administrator
[wm_admin]

Manages data related to field
service management. Field
service management
administrators also can:

• Control and override all
information in the Field
Service Management
application.

• Delete work orders and tasks.
• Create tasks using the Clone

Task feature.
• Create, edit, and delete work

order models and work task
models.

• Create, edit, and delete
incidentals.

• View expense lines.
• View certain fields in non-

subscription-based contracts.

• catalog_admin
• knowledge_manager
• skill_admin
• skill_model_admin
• template_admin
• territory_admin
• wm_agent
• wm_approver_user
• wm_dispatcher
• wm_qualifier

Field Service Management
Agent
[wm_agent]

Manages actual task time and
performs work on site. Agents
also can:

• Accept or reject tasks
assigned to them.

• Add parts requirements.
• Source parts.
• Create tasks using the Clone

Task feature.
• Add work notes to work

orders and work order tasks.
• Create, edit, and delete

incidentals.

• document_management_user
• inventory_user
• skill_user
• territory_user
• wm_basic
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• View expense lines.
• View certain fields in non-

subscription-based contracts.

Agents cannot update schedule
or task window times or toggle
the window control.

Field Service Management
Approver User
[wm_approver_user]

Responsible for approving work
orders before they are qualified
or assigned.

• approver_user

Field Service Management Basic
[wm_basic]

Common data access shared by
all field service roles. • wm_read

Field Service Management
Dispatcher
[wm_dispatcher]

Schedules tasks, adds parts, and
assigns tasks to work agents.
Dispatchers also can:

• Create tasks.
• Add part requirements.
• Source parts.
• Edit all work order task fields

and manage tasks from Draft
to Assigned status.

• Edit the Assigned to field until
work starts.

• Create tasks using the Clone
Task feature.

• Set actual travel time and
work start and end times if
needed.

• Add work notes to any field
service record.

• Create, edit, and delete
incidentals.

• View expense lines.
• View certain fields in non-

subscription-based contracts.

• document_management_user
• inventory_user
• skill_model_user
• territory_user
• wm_basic

Field Service Management
Initiator
[wm_initiator]

Creates work orders and assigns
qualification group. Initiators
also can:

• Edit work orders they create
that are in the Draft state.

• Add work notes to any field
service record.

• View work order tasks and
part requirements.

• wm_basic

Field Service Management
Initiator Qualifier
[wm_initiator_qualifier]

Initiator-qualifiers can:

• Create work orders.
• Create tasks.
• Add part requirements.
• Source parts.
• Assign skills to agents.

• wm_initiator
• wm_qualifier
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• View incidentals.

Field Service Management
Initiator Qualifier Dispatcher
[wm_initiator_qualifier_dispatcher]

Initiator-qualifier-dispatchers
can:

• Create work orders.
• Create tasks.
• Add parts requirements.
• Source parts.
• Assign skills to agents.
• Assign work to agents.
• Manage agent tasks.
• View incidentals.

• wm_initiator
• wm_qualifier
• wm_dispatcher

Field Service Management
Qualifier
[wm_qualifier]

Qualifies work orders and
creates work order tasks.
Qualifiers also can:

• Edit work orders in the
Qualified state.

• Edit work orders in the
Awaiting Qualification state.

• Edit tasks that are in the Draft
state to provide technical
details, such as information
about CIs involved or parts
needed.

• Create tasks using the Clone
Task feature.

• Change the qualification
group.

• Set the dispatch group.
• Add part requirements.
• Source parts
• Add work notes to any field

service record.
• View incidentals.

• document_management_user
• inventory_user
• skill_model_user
• territory_user
• wm_basic

Field Service Management Read
[wm_read]

Capable of reading work orders
and work order tasks.

None

Script includes installed with Field Service Management

Script includes are added with Field Service Management.

Script include Description
WMTimelineGroupSchedulePage Schedules page script include for the field service

resource chart.

WorkManagementInitiation Links to a newly created work order and transfers
any relevant information.

FSMQuestionnaireHelper
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Geolocation script includes

Field Service Management adds the following geolocation script includes.

Script includes for Field Service Management geolocation
Script include Description
WMGeolocationAJAX Automatically routes tasks from the Field Service

Management mobile dispatch map.

WMGeolocationUtils Provides utilities for Field Service Management
geolocation maps.

WorkTaskRouting Routing functionality for work order tasks.

Client scripts installed with Field Service Management

Client scripts are added with Field Service Management.

Client script Table Description
Populate Short Description Expense Line

[fm_expense_line]
Automatically populates the
short description of expense
lines with the work order short
description when expense lines
are manually created from work
orders. Cost Management must
be activated.

Hide End Date Fields Work Order
[wm_order]

Hide estimated_end when the
request-driven process is used
and hide expected_end when
task-driven is used.

Update UI on load and model
change

Asset Usage
[sm_asset_usage]

Show/Hide Task Map section Work Order Task
[wm_task]

This section of the map displays
the location of the task and also
shows the agents in the vicinity.
This section needs to be visible
only when the task is in the
Pending Dispatch state.

Part requirement activation Work Order
[wm_order]

Hides part requirements on the
Work Order form if part
requirements are not activated
in Field Service Configuration.

Update Model and Quantity
based on Asset

Asset Usage
[sm_asset_usage]

Business rules installed with Field Service Management

Business rules are added with Field Service Management.
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Business rule Table Description
Accept Work Order Task

[wm_task]
Automatically moves a task from
the Assigned state to Accepted
if the Accept/Reject option is
selected in Field Service
Configuration.

Assigned Work Order Task
[wm_task]

Sets a task in the Draft state to
the Assigned state if the
Assigned to field is populated.
This business rule is associated
with the "Assigned (Draft to
Assigned)" State flow.

Assigned(state flow business
rule)

Work Order
[wm_order]

Automatically moves an order to
the Assigned state if the
Assignment group or Assigned
to are populated. ServiceNow
recommends not editing this
business rule.

Cancel Work Task Work Order Task
[wm_task]

Cancels any transfer orders for a
work order task, via State Flows,
when the task is cancelled.

Create First Work Order Task Work Order
[wm_order]

Creates the first task for a newly
qualified work order.

Field Service Automation Group
Types

Group
[sys_user_group]

Ensures data integrity for
dispatch group coverage
information.

Field Service Automation
Qualification

System Property
[sys_properties]

Turns off the qualification stage
whenever the
work.management.qualification
system property is set to No.
This business rule turns on the
qualification stage when the
property is set to Yes.

Populate Skills - Update Child
Tasks

Work Order
[wm_order]

When the CI is changed,
updates the skills required in
tasks for the order to contain
those skills.

Populate Work Order from
Template

Work Order
[wm_order]

Populates a new work order
from the work order model
selected as a template.

Ready for Qualification
(approval off qu)

Work Order
[wm_order]

Automatically moves a work
order from the Draft state to
Ready for Qualification when
the Template field is populated.

Reassign Work Order Task
[wm_task]

Prevents task reassignment if
the task has part requirements
that are in a state of In transit.

RFD (approval qual both off) Work Order
[wm_order]

Automatically moves a work
order from the Draft state to
Ready when the Assigned to or
Template field is populated.
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Business rule Table Description
Roll Up Changes Work Order Task

[wm_task]
Updates the work order status
based on changes to the work
order task.

Start Work Work Order
[wm_order]

Automatically moves a work
order from the Ready state to
Work In Progress.

Start Work(state flow business
rule)

Work Order Task
[wm_task]

Automatically moves a task to
the Work in process state if the
Actual Start Work field is
populated.

State Change - After -
Deprecated

Work Order Task
[wm_task]

Ensures that the field service life
cycle is followed. ServiceNow
recommends not editing this
business rule. This business rule
is deprecated and is marked
inactive for instances that are
upgraded. This business rule is
not installed for new instances.

State Change - Before Work Order Task
[wm_task]

Ensures that the field service life
cycle is followed. ServiceNow
recommends not editing this
business rule. This business rule
is deprecated and is marked
inactive for instances that are
upgraded. This business rule is
not installed for new instances.

Transition - Cancel Work Order
[wm_order]

Ensures that the field service life
cycle is followed. ServiceNow
recommends not editing this
business rule.

Transition -
PendingDispatchToAssign

Work Order Task
[wm_task]

Ensures that the field service life
cycle is followed.

Transition - StateChange -
Deprecated

Work Order
[wm_order]

Ensures that the field service life
cycle is followed. ServiceNow
recommends not editing this
business rule. This business rule
is deprecated and is marked
inactive for instances that are
upgraded. This business rule is
not installed for new instances.

Update questionnaires state to
complete business rule

Work Order Task
[wm_task]

check active questionnaires Work Order
[wm_order]

Check active questionnaires Work Order Task
[wm_task]
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